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Notices

Patent Information
This product may be protected by one or more patents.

For further information, please visit: www.grassvalley.com/patents/

Copyright and Trademark Notice
Grass Valley®, GV® and the Grass Valley logo and/or any of the Grass Valley products listed 
in this document are trademarks or registered trademarks of GVBB Holdings SARL, Grass 
Valley USA, LLC, or one of its affiliates or subsidiaries. All other intellectual property rights 
are owned by GVBB Holdings SARL, Grass Valley USA, LLC, or one of its affiliates or 
subsidiaries. All third party intellectual property rights (including logos or icons) remain the 
property of their respective owners.

Copyright © 2018 - 2021 GVBB Holdings SARL and Grass Valley USA, LLC. All rights reserved.

Specifications are subject to change without notice.

Terms and Conditions
Please read the following terms and conditions carefully. By using GV Orbit documentation, 
you agree to the following terms and conditions.

Grass Valley hereby grants permission and license to owners of GV Orbit to use their 
product manuals for their own internal business use. Manuals for Grass Valley products may 
not be reproduced or transmitted in any form or by any means, electronic or mechanical, 
including photocopying and recording, for any purpose unless specifically authorized in 
writing by Grass Valley.

A Grass Valley manual may have been revised to reflect changes made to the product 
during its manufacturing life. Thus, different versions of a manual may exist for any given 
product. Care should be taken to ensure that one obtains the proper manual version for a 
specific product serial number.

Information in this document is subject to change without notice and does not represent a 
commitment on the part of Grass Valley.

Warranty information is available from the Legal Terms and Conditions section of Grass 
Valley’s website (www.grassvalley.com).
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1Introduction

Welcome to the GV Orbit Software User Guide
In this first chapter, there is a GV Orbit Product Introduction and GV Orbit Introduction. The 
next chapter contains Getting Started Steps and subsequent chapters provide additional 
information and feature descriptions. 

See In This Document, on page 23, for a document overview.

The purpose of this guide is to provide a brief introduction to GV Orbit Client and GV Orbit 
Control and its features. 

When you log in to GV Orbit Client you open the Stage.

The GV Orbit Client Stage presents a series of tiles, which are arranged in the order you 
would perform the tasks if you were to configure a GV Orbit system from start to finish. 
Each task builds on the last. It all begins by defining one or more areas. Once you have area, 
you can add logical levels. Then, you can create a topology. 

These tasks are described in the chapters that follow.

Related Documentation
Use the following related documentation to configure GV Orbit and to better understand 
the available features. You can obtain the latest product documentation from the 
Documentation Library section of Grass Valley’s website 
(www.grassvalley.com/docs/gvorbit). 

Latest Software

You can obtain the latest GV Orbit software from Grass Valley Technical Support. See Grass 
Valley Technical Support, on page 862.

Part Number Document Title

GVB-2-0860A-EN-DS GV Orbit Datasheet

13-03082-020 GV Orbit Welcome

13-03082-010 GV Orbit Release Notes 

13-03082-090 GV Orbit Admin Guide

13-03082-110 GV Orbit MapView User Guide

13-03082-170 GV Orbit Client User Guide (this document)

Dell 09K9WX Dell EMC PowerEdge XR2 Getting Started Guide

– Dell EMC PowerEdge XR2 Installation and Service Manual

www.grassvalley.com/docs/gvorbit
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GV Orbit Product Introduction
GV Orbit is a single, consolidated, overarching configuration, control and monitoring 
package specifically designed for the dynamic orchestration of broadcast media networks, 
whether they be SDI, hybrid or pure IP. The underlying client-server architecture is targeted 
at open standards-based IP systems with many features and functions specifically crafted to 
make IP easy.

‘Dynamic Orchestration’ is GV Orbit’s core strength that differentiates it from competitive 
systems. The ability to build, configure and change systems on-the-fly is hugely powerful, 
whether it is the adding/removing of devices or simply changing a name. In today’s cost-
conscious world, fast and efficient deployment and re-purposing of systems for alternative 
scenarios or productions is a key requirement.

GV Orbit uses one or more GV Orbit Servers running the GV Orbit services and one or more 
client computers running GV Orbit Introduction application(s), which provide the user 
interface(s) to a GV Orbit system.

GV Orbit Products
The product is offered in the following basic forms:

• GV Orbit Lite 
• GV Orbit Professional
• GV Orbit Enterprise

The GV Orbit Professional and Enterprise products require a GV Orbit Server (GVO-HW) 
and are shipped with various software license options preinstalled. The options purchased 
determine the overall functionality and feature set available in a GV Orbit deployment.

The GV Orbit Lite product is a free-of-charge download from the Grass Valley website; it 
operates without a GV Orbit Server and has basic functionality.

Options Codes
The following table outlines the GV Orbit option codes and the related feature availability.

 Table 1-1: GV Orbit Products - Functionality and Options Codes

Functionality

 Lite Professional Enterpri
se

(Free of 
charge)

GVO-
CFG-PRO

GVO-
MON-PRO

GVO-
CTL-PRO

GVO-
CTL-ENT

Uses GV Orbit Client     

Requires GV Orbit Control    

Requires min. one GV Orbit Server a    

Functionality:

Device Configuration     

Device Upgrade     
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Sections and/or sub-sections of this guide are marked accordingly as being applicable to 
Lite, and/or Professional (Pro), and/or Enterprise (Ent) users.

GV Orbit Introduction
GV Orbit comprises two client applications: 

1 GV Orbit Client.
2 GV Orbit Control, launched from within the GV Orbit Client.

Both client applications are installable on PCs running Microsoft WindowsTM. All the steps 
required to download, install and get started are covered in this guide. 

GV Orbit and Existing Orbit
GV Orbit Client may be installed on the same client PC as the older Orbit client application. 

Legacy Orbit projects can be opened and run by GV Orbit Client. However, any new features 
offered by GV Orbit will not be available in legacy Orbit projects run in GV Orbit Client.

Design MV-8 Series Video Wall     

Design MV Cluster Video Walls    

Client Real-Time Video Wall b     

1 Seat GV Orbit Client/GV Orbit 
Control

   

Advanced Configuration 

Bulk Upgrade 

Custom Screens 

Custom Screens in Web View 

Alarm Logging 

Routing Configuration  

Hardware Panel Support  

Simple Routing  

Advanced Routing 

Third-party Device Routing Control 

Channel Manager 

a. For system redundancy, purchase two Professional or Enterprise systems.
b. Displays H.264 video streams from compatible multiviewers (for example, MV-8 series 
multiviewers).

 Table 1-1: GV Orbit Products - Functionality and Options Codes (continued)

Functionality

 Lite Professional Enterpri
se

(Free of 
charge)

GVO-
CFG-PRO

GVO-
MON-PRO

GVO-
CTL-PRO

GVO-
CTL-ENT
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GV Orbit Project Types 
GV Orbit uses a project-based workflow. 

The Control and Monitoring project (C&M project) is the main GV Orbit project type and is 
used for control and monitoring, and for routing control applications in GV Orbit 
Professional and Enterprise.

Requirements
For a full list of requirements for running GV Orbit, refer to the GV Orbit Release Notes, see 
Related Documentation, on page 19. 

Domain IDs and IP Ports
A GV Orbit system employs ‘domains’ to segregate internal communications. Domains are 
specified with a Domain ID number (1 to 252) and each Domain uses separate IP ports. 
(For further information about IP Ports and Domain IDs for the GV Orbit Client and GV Orbit 
Server, refer to the GV Orbit Release Notes see Related Documentation, on page 19.) 

Note: GV Orbit projects cannot be opened by a legacy Orbit client.

 Table 1-2: GV Orbit Project Types

Project Type
Product

Description Supported Devices
Lite Pro Ent

Multiviewer Project   
Defines a video wall targeted at 
MV-8 series multiviewers.

MV-8 Series multiviewer 
devices.

IQ Multiviewer Project   
Defines a video wall targeted at 
IQ-MV multiviewers.

IQ-MV multiviewer devices, 
for example, IQUCP-MV.

Connected Multiviewer 
Project   

Pulls a Multiviewer project from 
a multiviewer into GV Orbit 
Client for video wall editing.

MV-8 Series and IQ-MV 
multiviewers.

Clustered Multiviewer -  
Defines video walls that are 
served by a cluster of MV-8 
series multiviewer devices.

MV-8 Series multiviewer 
devices.

Control and Monitoring 
Project

(C&M project)
-  

Main project type. Includes:
• Design and deployment of 

custom graphical operator 
screens. 

• Device configuration, control 
and monitoring. 

• Device routing control. 
Uses services/applications 
running on GV Orbit Server(s).

Densité-protocol and RollCall-
protocol devices.
Routing control:
• IP end-points 

(Grass Valley and NMOS).
• Traditional/SDI 

(NP-0017 and SW-P-08 
protocols).
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GV Orbit Services Requirements

Lite:

There are no GV Orbit Servers in a GV Orbit Lite installation and, as a result, no GV Orbit 
services in a GV Orbit Lite system.

Professional and Enterprise:

GV Orbit requires at least one GV Orbit Server running configured GV Orbit Services. Refer 
to related GV Orbit documentation, see Related Documentation, on page 19. Specifically, 
for information on GV Orbit services, refer to the GV Orbit Admin Guide.

In This Document
This document describes some steps for getting started with GV Orbit Client and then 
proceeds to describe other features.

• Chapter 2, Getting Started Steps, on page 25.
• Chapter 3, Home Screen, on page 77.
• Chapter 4, Manage Users, on page 141.
• Chapter 5, Getting Started With GV Orbit Control, on page 169.
• Chapter 6, Configuration Tasks, on page 175
• Chapter 7, Special Device Configuration Tasks, on page 331
• Chapter 8, Monitoring Tasks, on page 449
• Chapter 9, Control Tasks, on page 465
• Chapter 10, Administration Tasks, on page 477
• Routing control panels:

• Chapter 12, Routing Control - Bulk Routing Panel, on page 505.
• Chapter 13, Routing Control - XY Routing Panel, on page 591.

• Clustered multiviewers (applications with multiple multiviewers):
• Chapter 14, Multiviewer Cluster, on page 653.
• Chapter 15, MV Cluster - Room Editor, on page 675.
• Chapter 16, MV Cluster - TSL Tally Configuration, on page 757.
• Chapter 17, Audio Bars Configuration, on page 783.

• IP configuration for IP routing:
• Chapter 18, IP Configuration, on page 793.

At the end of the document there is a handy Glossary of Terms.

Note:
You can change the Domain ID numbers. When using changed Domain ID 
numbers, recalculate the IP port numbers; refer to the GV Orbit Release Notes 
in Related Documentation, on page 19. 
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2Getting Started Steps
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The purpose of this chapter is to provide the minimum steps required to install, configure 
and get started with the GV Orbit Client application. 
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Step 1: Download, Install and Launch

This section describes how to download/install client installers and launch GV Orbit Client.
• Step 1.1: Download Client Installers, on page 26.
• Step 1.2: Installation of GV Orbit Client, on page 27.
• Step 1.3: Installation of GV Orbit Control, on page 30.
• Step 1.4: Launch GV Orbit Client, on page 32.

Step 1.1: Download Client Installers

Download Installer for GV Orbit Lite
On the client PC:

1 Go to https://community.grassvalley.com/support/s/productdownloads 

The Grass Valley product downloads login web page is shown.
2 If you already have a Grass Valley support login user name and password, 

then click Login and login here.
3 If you require a Grass Valley support user name and password, 

then click Request Portal Access, fill in your details and click Send Request to request 
Grass Valley portal access. 

Login information will subsequently be sent to you.

The GV Orbit Lite client installer has been downloaded.

Download Installers for GV Orbit Professional and Enterprise 
GV Orbit Professional and Enterprise use one or more GV Orbit Servers which are the 
source of client installers in GV Orbit Professional and Enterprise systems. 

Download both the GV Orbit Client and the GV Orbit Control installer from the GV Orbit 
Server’s admin page. (Thus, client versions are kept compatible.) 

For full download instructions, refer to the GV Orbit Admin Guide, see Related 
Documentation, on page 19.

On the client PC: 
1 Enter the GV Orbit Server‘s IP address into a browser. (Chrome recommended.)

The GV Orbit Server Admin Login screen appears. (See Figure 2-1.)
2 Click on each of the client installer download links to download the installers.

Lite Professional Enterprise

  

Note:
Downloading of the GV Orbit Client installer is separate from the 
downloading of the GV Orbit Control installer.

https://community.grassvalley.com/support/s/productdownloads
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Fig. 2-1: GV Orbit Server Admin Login Screen

Step 1.2: Installation of GV Orbit Client

Installation of GV Orbit Client and of GV Orbit Control is done separately. 
This section covers GV Orbit Client installation, including some information about any 
existing, legacy Orbit installs. 
(For GV Orbit Control installation, see Step 1.3: Installation of GV Orbit Control, on page 30.)

Legacy Orbit Client Users
For users with the older, legacy ‘Orbit’ client already installed on the client PC, the following 
applies:

• GV Orbit Client may be installed on the same client PC as the legacy ‘Orbit’ client 
application.

• GV Orbit Client and the legacy ‘Orbit’ client must not be run together.
• At installation, GV Orbit Client inherits registry settings from any already-installed 

legacy ‘Orbit’ client (for example, multicast/unicast discovery setting, and ‘recent 
projects’ list).

Install GV Orbit Client 

1 Run the downloaded installer file on the client PC. 

Note:
Client installers on the GV Orbit Server are updated with a server update. 
After a server update, download and reinstall the clients (recommended).

Client installer download links

Lite Professional Enterprise

  

Note: GV Orbit Client installs into client PC’s ‘Program Files’ folder by 
default.
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Allow the installer to run by 
responding to any WindowsTM dialogs 
accordingly.

The GV Orbit Client installer ‘Setup GV 
Orbit’ screen is then shown.

2 Click Next> to begin the installation.

3 Accept the License Agreement in the 
following dialog and click Next>.

The installer will install into the folder 
of an existing installation of GV Orbit 
Client.

4 If no previous GV Orbit Client is found, then an installation folder is prompted for. 
(Default folder location is C:\Program Files\Grass Valley\GV Orbit .) 

5 Select a new folder, if required. 
Click Next.

6 At the next dialog, click Install.

GV Orbit Client installation begins 
and a progress bar is shown.

7 When GV Orbit Client installation is 
complete, the GV Orbit Client setup 
‘Completing’ screen is shown.

Fig. 2-2: GV Orbit Client’s Setup Screen

Fig. 2-3: GV Orbit Client’s Setup Screen

Fig. 2-4: GV Orbit Client Setup ‘Completing’ Screen 
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8 Click Finish and the GV Orbit Client application launches and shows its initial screen. 
See Figure 2-6.

9 Close the GV Orbit Client application.GV Orbit Client is installed. 

Fig. 2-6: GV Orbit Client Initial Screen

Firewall
1 Check that the GV Orbit Client application is not blocked by your client PC’s firewall. 

Note:
A shortcut is available from the Microsoft WindowsTM Start menu: Start 
-> Grass Valley -> GV Orbit.

Fig. 2-5: GV Orbit Client Setup ‘Completing’ Screen 
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Step 1.3: Installation of GV Orbit Control

This sub-section is applicable to GV Orbit Professional and Enterprise product versions.

1 Log into the client PC under the username / password of the person who will be 
operating the GV Orbit clients.

2 Run the downloaded GV Orbit Control 
installer file. 

Allow the file to run on the client PC by 
responding to any dialogs accordingly.

A splash screen is shown during installation:

3 When the installation is complete, the GV Orbit Control login screen appears.

Fig. 2-7: GV Orbit Control Login Screen 

Note: Firewall:
‘orbit.exe’ should be on a list of allowed apps (or programs) that can 
communicate through the client PC’s firewall. 
These PC settings may be controlled by your network administrator.

Lite Professional Enterprise

 

Note:
The GV Orbit Control installs into a user folder on the client PC. Thus it is 
normally only available to the person installing the software on that PC.
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4 Enter ‘admin’ for both the User name and the Password.
5 Enter the IP address of the GV Orbit Server in the Server text box.
6 Click Log in.

A blank GV Orbit Control screen appears.

Fig. 2-8: GV Orbit Control Screen Example

7 Close GV Orbit Control.

GV Orbit Control installation is complete.

The installation folder is in the user folder, for example:
 C:\Users\A_User\AppData\Roaming\JWrapper-GVOrbitControlClient\

Firewall
1 Check that the installed application is not blocked by your client PC’s firewall. 

Note:
The GV Orbit Control installs into a user folder on the client PC. Thus it is 
normally only available to the person installing the software on that PC.

Note:
You can launch GV Orbit Control manually from Microsoft Windows Start 
menu or through GV Orbit Client application.
A shortcut is available on the client PC desktop and from the WindowsTM 
Start menu: Start -> Grass Valley -> GV Orbit Control.

Note: Firewall:
‘GVOrbitControlClient.exe’ should be on a list of allowed apps (or 
programs) that can communicate through the client PC’s firewall. 
These PC settings may be controlled by your network administrator.
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Step 1.4: Launch GV Orbit Client
1 GV Orbit Client may be launched from the WindowsTM ‘Start’ button. (“GV Orbit”)

A splash screen is shown during start up:

And then the GV Orbit Client initial 
screen is shown. See Figure 2-9.

Fig. 2-9: GV Orbit Client Initial Screen

To GV Orbit 
documentation

Open a Network
Tree View

Create New Project

Information about
the GV Orbit Client

To Grass Valley web site

Access a RollCall
device control

screen

Open existing Project

Open a Project 
recently-opened by 
GV Orbit Client 
(Initially grayed-out)

Options
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Step 2: GV Orbit Projects

Introduction
This section describes how to open a project. GV Orbit project types are listed in Table 1-2 
on page 22. Once a project is created in GV Orbit Client, it can be saved locally on the client 
PC but it needs to be deployed for use by saving it (pushing it) to either:

• a multiviewer device (multiviewer projects; GV Orbit Lite, Enterprise and 
Professional); or to 

• a GV Orbit Server (C&M projects; GV Orbit Professional and Enterprise only).

Multiviewer project types are used to define a compatible multiviewer’s video wall. These 
are applicable to GV Orbit Lite, Enterprise and Professional. 

The main project type for GV Orbit is a ‘Control and Monitoring’ project (C&M project) 
which is used for control and monitoring applications, and for routing control. This project 
type uses services running on a GV Orbit Server and is applicable to GV Orbit Professional 
and Enterprise only. 

• Step 2.1: New Project, on page 33.
• Project Home Screens in GV Orbit Client, on page 38.
• Step 2.2: Save, Push, and Close a Project, on page 40.
• Open and Pull a Project, on page 41.

Step 2.1: New Project 

To Open a Project from the Initial Screen
1 Click New Project.

The New Project dialog is shown.
2 Select a project type. 

Lite Professional Enterprise
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Fig. 2-10: New Project Dialogs 

3 Click Browse and browse to a local folder on the client PC (or to a network folder 
accessible from the client PC) where the new project files will be placed. 
Click Choose.

4 Enter a name for the new project.
5 Click OK / Next. 

A sub-folder is created with the name of the project. It contains the new project files.
6 If prompted, answer Yes to create a directory (sub-folder).

• For a Multiviewer project, see
For a Multiviewer Project (GV Orbit Lite, Enterprise and Professional), on page 34.

• For a C&M project, see
For a C&M Project (GV Orbit Enterprise and Professional), on page 35.

For a Multiviewer Project (GV Orbit Lite, Enterprise and Professional)

A dialog is shown for setting up the resolution of the multiviewer head display outputs.
1 Select the Output Size (1920x1080 or 1280x720).
2 Click OK.

The new multiviewer project is created and its GV Orbit Client project Home Screen is 
shown. See Project Home Screens in GV Orbit Client, on page 38.

Entered project name. Path to chosen folder. 

b) Multiviewer project type selecteda) C&M project type selected

Note: The chosen folder is not on a GV Orbit Server.
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For a C&M Project (GV Orbit Enterprise and Professional)

For a Control and Monitoring (C&M) project, a Setup dialog is shown. 
(For more information about setting up a C&M project, see Step 7: Control and 
Monitoring Project Setup (Professional/Enterprise), on page 64.)

Fig. 2-11: C&M Project Setup Dialog 

For the C&M project, in the Setup dialog:
1 Set Server 1 IP to the IP address of the GV Orbit Server. For a GV Orbit Server Cluster, 

still just enter the IP address of one server. The second server will be discovered 
automatically in the steps below.

After the IP address is entered, GV Orbit Client carries out some basic system tests; it 
uses the current Setup dialog settings. System connectivity is checked and some basic 
system information is discovered from the GV Orbit Server.

2 After these system tests are done, the results are listed in the dialog in a console pane. 
See Figure 2-12.

Server 1 IP
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Fig. 2-12: Example Basic System Test Results (Single Server Shown)

Repository in Setup Dialog

For deployment, a C&M project is saved to the GV Orbit Server in a Repository, one project 
per Repository. This setting selects which Repository is used by the project.

1 For the Repository setting, click New.

The Create Repository dialog is shown:
2 Enter a name for the new repository and click OK.

System Re-Test

A system re-test will now remove any red items in the console pane. In the Setup dialog:
1 Click System Test.

This forces the GV Orbit Client to redo its basic system tests. The results are shown in 
the console. Any ‘red’ items from before should now be cleared.

Server 1 IP

Green indicating GV Orbit Client’s server connection is OK.

(For more information, see Step 7: Control and Monitoring Project Setup (Professional/Enterprise), on 
page 64.)

Results of basic system 
tests in console pane.

Repository setting

Note:
Some system test console items may be shown in ‘red’, indicating where 
discovered information disagrees with settings in the Setup dialog. In this 
case, settings in the dialog are then filled out automatically to be consistent 
with discovered settings. 
A subsequent system re-test (performed below) will clear these red items. 
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Fig. 2-13: System Test Console Output:
a) Single GV Orbit Server. 
b) GV Orbit Server Cluster.

2 Click Apply.

The settings are 
applied to the 
project and a 
progress bar appears in the dialog.

3 A pop-up dialog may appear, asking if the local 
project should be updated from the chosen 
repository. 

• Click Yes to update the local project (and 
lose any local changes made).

• Click No to keep the local project changes 
(and not pull the project from the repository on the server).

The applying of settings continues and progress is shown in the progress bar:

4 A pop-up dialog box confirms when the ‘Applying’ is all done. 

Click OK in the pop-up to proceed.

System Test clear output

Single GV Orbit Server

a) Single GV Orbit Server b) GV Orbit Server Cluster

 GV Orbit Server Cluster 
and Virtual IP Address
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5 In the Setup dialog, 
click Close.

The new C&M project is created in GV Orbit Client and its Home Screen is shown.
(See Project Home Screens in GV Orbit Client, on page 38.)

Project Home Screens in GV Orbit Client
The project’s Home Screen is shown and a new GV Orbit project has been created.

Note:
The Setup dialog can also be viewed when a C&M project is open by clicking 
Connections -> GV Server in the main menu of GV Orbit Client.

Note:
Setting up and applying the GV Orbit Server IP address for a project will 
automatically set up other comms settings for the project.

Note:
The Home Screen appearance varies according to project type and which 
GV Orbit Client windows are enabled and being shown.
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Fig. 2-14: GV Orbit Client Home Screen Examples: a) Multiviewer Project; b) C&M Project.

a) Example New Multiviewer Project Home Screen

b) Example New C&M Project Home Screen (See Project Home Screen for Information)

Click icons to 
hide/show windows 
of project Home 
Screen

Workflow Window

Project Window

Network Window

Note: A GV Orbit ‘Multiviewer’ project type is typically for single-
multiviewer designs. 
For video walls designs that are served by a cluster of multiviewers 
(MV Cluster), then use the GV Orbit ‘Clustered Multiviewer’ project 
type (described in Chapter 14, Multiviewer Cluster, on page 653).

Note: A C&M project type is for GV Orbit Professional and Enterprise only. 
A C&M project can be created in GV Orbit Lite, but may not be used. 
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Step 2.2: Save, Push, and Close a Project

Step 2.2.1: Save a Project Locally
To locally save a project from GV Orbit Client:

1 Click Project -> Save Project in the main menu to save the project into the local folder 
on the client PC.

Step 2.2.2: Push Project (Save to Server)
To push an open project back into a repository (on the GV Orbit Server, or on a multiviewer 
device):

1 Click Project -> Push in the main menu.

A Choose Projects dialog is shown. Projects are listed that have been opened by the 
GV Orbit Client before. These appear in the Project window on the client. 

Fig. 2-15: Choose Projects Dialog

2 Select the project to be pushed. More than one may be selected. Click OK.

The project is pushed to the repository.

Once a project is in a repository, it is deployed for use:
• Multiviewer project - A project is pushed to a multiviewer which can then adopt the 

project’s video wall design.
• C&M project - A project is pushed to the GV Orbit Server. Applications/services etc. on 

the server can then access the project. For example, the Web Renderer service can read 
the project and render its custom operator screens for viewing in a web browser.

Step 2.2.3: Close a Project
To close a project in GV Orbit Client:

• Click Project -> Close Project to close the project.
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Open and Pull a Project

Open Existing Local Project
To open an existing local project from the GV Orbit Initial Screen:

1 Click the Open Project icon.

The Open dialog is shown:
2 Browse into the local project 

folder required and select the 
‘configuration.prj’ file within it.

3 Click Open.

A login screen is shown.
4 For a new project, enter 

User name ‘admin’ and 
Password ‘admin’ 
and click Login. 

The project’s Home Screen is 
shown.

Pull a Project (Load from Server)
To pull a project from a repository (on the GV Orbit Server, or on a compatible multiviewer):

1 Click Project -> Pull in the main menu.

A Choose Projects dialog is shown. (See Figure 2-15.)
2 Select the project to pull.
3 Click OK.

The project is pulled from the repository, stored locally on the client PC, and is opened 
by the GV Orbit Client.

Exit GV Orbit Client
Save the project locally and push it to be deployed, as required, before exiting GV Orbit 
Client.

To exit and close the GV Orbit Client application:
1 Click Project -> Exit.

Note: New GV Orbit projects have User name ‘admin’ , Password ‘admin.

Note: Pull and Push:
When connecting to a repository, you may be prompted to Pull a project 
from a Repository. Pull a project in order to either:
• edit the project locally (any local project is overwritten); or 
• run the project locally (for example, to run operator screens).

Do not Pull:
• if a local project has all been created or changed and which needs to be 

put into a Repository. (This requires a Push.)
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The application shuts down and exits.

Step 3: Device Configuration

Introduction
This section describes how to access device control screens with GV Orbit Client. Devices 
can then be configured as required. RollCall- and Densité-protocol devices are covered.

• Step 3.1: Direct Configuration of RollCall-protocol Devices, on page 42.
• Step 3.2: Configuration of Densité and RollCall Devices, on page 43.

To configure a device (or unit), you must have the Device control permission assigned to 
your user profile otherwise you will not see this menu option. See Manage Users, on 
page 141.

Step 3.1: Direct Configuration of RollCall-protocol Devices
RollCall-protocol devices can be configured directly from GV Orbit Client with the device’s 
IP address from the GV Orbit Client Initial Screen:

1 Click the RollCall Control Screen icon, (or, with a project open, in the main menu
click Connections -> RollCall -> RollCall Control Screen).

The Open Template dialog is shown: 

2 Enter the IP address of the target device. 
3 Click OK.

The control screen is shown in a tab. Click on x on 
tab to close device control screen.

Lite Professional Enterprise
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Fig. 2-16: Example Device Control Screen (RollCall-protocol Device shown)

4 When all device configuration changes are complete, 
close the control screen tab.

Step 3.2: Configuration of Densité and RollCall Devices
With a GV Orbit project open in GV Orbit Client, GV Orbit Professional and Enterprise can 
show RollCall-protocol and Densité-protocol devices with full status indication listed in a 
Network window. 

However, GV Orbit Lite can only list RollCall-protocol device items in the Network window 
and without any status indication.

Network Window Views
The Network window can show devices either in a tree-view or in a list-view. Toggle 
between these views with the tool bar controls shown in Figure 2-17. 
See Network Window, on page 84 for a description of the Network window.
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Fig. 2-17: Network Window Views

Initial set up of the Network window can be done in a project; this is done differently for 
RollCall-protocol devices than for Densité-protocol devices and each is described below:

• Step 3.2.1: Network Window Setup For RollCall-protocol Devices
• Step 3.2.2: View a Device Control Screen - RollCall Devices
• Step 3.2.3: Network Window Setup For Densité Devices
• Step 3.2.4: View a Device Control Screen - Densité Devices

Step 3.2.1: Network Window Setup For RollCall-protocol Devices
RollCall device control screens can be viewed with GV Orbit Client via a GV Orbit Server 
(which runs a GV Orbit IP Proxy service). 

To set up the Network window:
1 For GV Orbit:

• Lite - From the GV Orbit Client Initial Screen, click the Network Map icon. 
• Professional and Enterprise and with a C&M project open - 

Click Connections -> RollCall -> Network Map  in the main menu.

An Open Network dialog is shown. (See Figure 2-18.)

Note: The Network window may already be showing system devices etc. 
for a C&M project open in GV Orbit Client if the GV Orbit services 
have been set up on the GV Orbit Server, so no set up may be 
required here.

Click to show List-View Click to show Tree-View

b) List-Viewa) Tree-View
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Fig. 2-18: Open Network Dialogs:
a) After clicking Network Map icon in GV Orbit Client Initial Screen.
b) After clicking RollCall -> Network Map in GV Orbit Client main menu.
c) Redundant server case.

2 Select Enable Network Map Connection, if available in the dialog.
3 Enter an IP address for the Primary Address:

• GV Orbit Lite:
Enter the address of an IQ frame controller to be able to access all devices in the 
frame.

• GV Orbit Professional and Enterprise:
Enter the IP address of a GV Orbit Server.

This will connect to the IP Proxy service running on the server and allow access to 
all devices connected to the IP Proxy service.

4 For redundant GV Orbit systems, 
select Enable Redundancy and enter the IP address of a second GV Orbit Server.

a) Open Network Dialog 

(after clicking on 
Network Map in the GV Orbit 
Client Initial Screen).

b) Open Network dialog 
(after clicking on RollCall -> Network Map in GV Orbit Client’s main menu).

c) Redundant server case.

Note:
The IP address entered in the Open Network dialog may be for either:

• a GV Orbit Server, which runs a IP Proxy service; or for
• a single device. 
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5 Click OK. 

A Network window appears in the GV Orbit 
Client:

This can be re-sized. It can show an expandable 
tree-view of all devices attached to the IP Proxy 
service. 

Step 3.2.2: View a Device Control Screen - RollCall Devices
To view a RollCall device control screen from the Network window:

1 Locate the target device in the Network window (tree-view or list-view).
Right-click on the item and select ‘Control’.

The control screen and its sub-menus are loaded and are then shown in a tab. 

Fig. 2-19: Example Device Control Screen (RollCall-protocol Device Shown)

2 When all required user device configuration changes are done,
close the control screen tab.

Right-click on any other device in the Network window to display/edit its control screen, as 
required.

Click to close the device control screen tab
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Step 3.2.3: Network Window Setup For Densité Devices
Densité device control screens (card control panels) can be viewed with GV Orbit Client 
from the Network window via a GV Orbit Server (which runs a GV Orbit Densité service). 
GV Orbit Client must be configured to connect to the Densité server/service. 

In a C&M project open in GV Orbit Client:
1 Click Connections -> Densité in the main menu.

The Densité Configuration dialog is 
shown:

2 Enter the GV Orbit Server IP address.
3 Select:

• ‘Lookup Service’; and 
• ‘Densité REST’. 

4 Enter the Username and Password (if 
not already set up) to access the 
GV Orbit Server (and hence the Densité 
service). 

Note: These are not the same login 
credentials as those used when opening 
a GV Orbit project with GV Orbit Client.

5 Click OK.

GV Orbit Client connects to the Densité service on the GV Orbit Server.
6 Add all Densité frames to the Densité service. Refer to the Densité Manager Service in 

the GV Orbit Admin Guide in the Related Documentation, on page 19. 

Added Densité frames become visible in the Network window.

This has set up the Network window in GV Orbit Client to show Densité frames and to show 
fitted cards supported by the GV Orbit Server. 

If a Densité card is still not shown in the window, support for it may need to be added to the 
GV Orbit Server. To add support for other Densité cards, if required, see Step 5: Adding 
Support for Further Densité Cards.

Note: Densité service credentials are set up automatically if the Setup 
dialog (Connections -> GV Server in main menu) was used when 
creating the C&M project. 

Note: Densité cards can appear in the Network window if the card is:
• present in a Densité frame that has been added into the GV Orbit 

Densité Manager service on the GV Orbit Server; and is
• supported by the GV Orbit Server; and is 
• accessible by the GV Orbit Server over the network.
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Step 3.2.4: View a Device Control Screen - Densité Devices
You must have the Device control permission assigned to your user profile otherwise you 
will not see this option. See Manage Users, on page 141.

This step assumes that the Densité card is shown in the Network window (see Step 3.2.3: 
Network Window Setup For Densité Devices).

To access a Densité device control screen (device control panel) from the Network window:
1 Locate the target device in the Network window.
2 Right-click on the device and select ‘Control’.

The Densité-protocol device’s control screen 
opens in a separate window (that is, not in 
the GV Orbit Client’s overall window) and 
may be obscured on your client PC’s screen. Check that this window is not behind the 
GV Orbit Client window or other windows.

Note: GV Orbit Professional and Enterprise ship with native support for 
some Densité cards. Refer to the GV Orbit release notes for a list of 
natively-supported Densité cards. See Related Documentation, on 
page 19.

Note: Densité cards can appear in the GV Orbit Client Network window 
if the card is:

• present in a Densité frame that has been added into the GV Orbit 
Densité Manager service;

• supported by the GV Orbit Server; and is 
• accessible by the GV Orbit Server over the network.

To add support for a card, see Step 5: Adding Support for Further 
Densité Cards.

Note: An informative message 
appears (bottom left of 
GV Orbit Client) while the 
control screen is being 
accessed.
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Fig. 2-20: Example Densité Device Control Panel

3 When all the required user device configuration is complete,
close the control panel.

Right-click on any other device in the Network window to open its control screen, as 
required.

Step 3.3: Configuration of Other Devices
Devices in a GV Orbit system which may be configured via GV Orbit appear in the GV Orbit 
Client Network window and present a ‘Control’ drop-down menu option: 

• Right-click on such a device and select ‘Control’ to open their web page in GV Orbit.

Click to close the 
Densité device 
control panel.
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Fig. 2-21: Example GV Fabric Device Control Panel

Step 4: Device Upgrade

Introduction
This section describes how to upgrade software/firmware on a device using GV Orbit Client.

Upgrade packages for RollCall or Densité cards comprise a version of software and a version 
of firmware bundled together in a .zip file. 

To upgrade a device (or unit):
• You must have the Device upgrade permission assigned to your user profile otherwise 

you will not see this menu option. See Manage Users, on page 141.

• The Network window must be open and showing the system device to be upgraded. 
(See Network Window Views, on page 43.)

Right-click on device and select ‘Control’

Lite Professional Enterprise
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• Step 4.1: Upgrade RollCall-protocol Devices, on page 51.
• Step 4.2: Upgrade Densité-protocol Devices, on page 53.

Also see Change Functionality of a ‘Software-Defined Core’ Card, on page 57.

Step 4.1: Upgrade RollCall-protocol Devices 
• Lite - Simple device upgrade is possible directly from GV Orbit Client.
• Professional and Enterprise - Simple device upgrade and advanced device upgrades 

are possible with the GVO-CFG-PRO option.

Simple Upgrade

Check the Current Software/Firmware Version
1 Open the Network window. 
2 Locate the device to be upgraded, right-click on it and select Info.

A Details window is shown for the unit, displaying unit information which includes the 
device’s current version of software/firmware.

Fig. 2-22: Unit Information in Details Window

3 Close the Details window.

Import Upgrade Packages
4 Right-click on the tree-view device item and select ‘Upgrade’.

The RollCall Upgrade window is shown. Any software/firmware upgrade packages 

Note:
Before starting, ensure that the upgrade package file is: 
• accessible; 
• for the correct RollCall or Densité card model; and is 
• the correct version required. 
Contact Grass Valley customer support for advice about upgrade packages.
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that have been previously uploaded to the GV Orbit Client are shown listed on the left 
hand side. For a fresh install of GV Orbit Client, no packages are listed.

Fig. 2-23: RollCall Upgrade Window

5 Click Import Upgrade Package(s) and browse to the upgrade package to be 
uploaded. Select the package and click Open.

The package is imported into the GV Orbit Client.

After the package has been imported, it is listed under ‘Available Packages’ in the 
RollCall Upgrade window.

Upgrade the Device
6 Select a package in the ‘Available Packages’ list of the RollCall Upgrade window.
7 Select Upgrade All Files in the ‘Options’ pane to upgrade all files on the device, 

regardless of whether a file is the same on the device and in the upgrade package.
(Deselect Upgrade All Files for a quicker upgrade.)

Fig. 2-24: RollCall Upgrade Window

8 Click the Upgrade button to start the upgrade of the device.

A message box appears informing you 
that the upgrade has started and will 
proceed in the background. 
Click OK.
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The progress of the upgrade is reported bottom left in the GV Orbit Client window.

Fig. 2-25: Upgrade Progress Messages (Bottom left in GV Orbit Client window)

9 When the device has been upgraded, this is indicated by:
• a final message at the bottom of the GV Orbit Client window; and also by
• a pop-up notification message in the WindowsTM system tray.

Check the Upgraded Software/Firmware Version
1 Right-click on the Network window upgraded-device item and select Info.

A Details window is shown displaying unit information. 
2 Check that the device’s current (upgraded) version of software/firmware is correct.

Step 4.2: Upgrade Densité-protocol Devices 
• Lite - Simple device upgrade of Densité devices is not possible via the GV Orbit Client. 

Note:
You can continue using the GV Orbit Client project while the upgrade 
proceeds.
However, only one RollCall upgrade can be running at any one time.

Final message

Messages 
as 

upgrade 
progresses

Bottom left 

Note:
If the Network window is being presented through an IP Proxy then a 
GV Orbit Server fail-over (in a GV Orbit Server cluster system) during an 
upgrade will cause a failed upgrade.
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• Professional and Enterprise - Densité device upgrade is possible via GV Orbit Client
with the GVO-CFG-PRO option, including upgrade of single and multiple Densité 
devices.

Device Upgrade (GV Orbit Professional and Enterprise only)
This sub-section assumes that the Densité card is shown in the Network window (see Step 
3.2.3: Network Window Setup For Densité Devices).

Check Current Device Software/Firmware Version
1 Open the Network window and locate the device to be upgraded.
2 Right-click on the device item to be upgraded and select Info.

A Details window is shown for the unit, displaying unit information which includes the 
device’s current version of software/firmware.

Fig. 2-26: Unit Information in Details Window

3 Close the Details window.

Import Upgrade Packages
4 Right-click on the tree-view device item and select ‘Upgrade’.

Note:
Densité modular devices may still be upgraded independently of GV Orbit 
Client using Grass Valley’s iControl Solo product. 

Note: Densité cards can appear in the GV Orbit Client Network window 
if the card is:

• present in a Densité frame that has been added into the GV Orbit 
Densité Manager service;

• supported by the GV Orbit Server; and is 
• accessible by the GV Orbit Server over the network.

To add support for a card, see Step 5: Adding Support for Further 
Densité Cards to be able to see the card to upgrade.
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The Densité Upgrade Manager window is shown. 

Fig. 2-27: Densité Upgrade Manager 

5 Click Upload Files... and browse to the upgrade package to be uploaded. 
Select the package and click Open.

A message window appears prompting you to start the upload.
6 Click Upload in the Progress window.

Progress of the upload is 
shown in the window and the 
package is uploaded to the 
Densité Upgrade Manager.

7 When complete, the Progress 
window shows 100% done, 
‘Operation finished’:

Click Close.
8 Verify the uploaded package 

is present in the Densité 
Upgrade Manager window by clicking in the ‘Available package’ column and looking 
in the drop-down list.

Upgrade the Device

In the Densité Upgrade Manager window, in the row for the device to be upgraded:

Note: After an upgrade package has been uploaded, it is available in a drop-
down box in the ‘Available Package’ column, in all rows for Densité 
devices compatible with the newly-uploaded package. 
For example, for an IPG-3901 package, check in any IPG-3901 device 
row.

Fig. 2-28: Progress Window - Upgrade Package 100% 
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9 Select an upgrade package in the ‘Available Package’ column’s drop-down list.

Fig. 2-29: Upgrade Window with Selected Upgrade Package

10 Click the Upgrade button to start 
the upgrade of the device.

An Upgrade Confirmation 
message box appears. 

11 Click Yes to start the upgrade.

 Progress is reported in the ‘Install 
Progress’ column as a progress bar and a percentage (%): 
When done, a ‘Finished 100%’ message appears in the ‘Install progress’ column.

Fig. 2-30: Upgrade ‘Finished 100%’

12 Close the Densité Upgrade Manager window.

Check Software/Firmware Version on Upgraded Device
13 In the Network window, right-click on the upgraded-device item and select Info.

A Details window is shown for the device/unit.
14 Check that the newly-upgraded device software/firmware version is correct.

Upgraded software/firmware version on device is shown

Note: The Densité Upgrade Manager can upgrade multiple devices.



57

GV Orbit Version 2.3.0 Getting Started Steps
User Guide Change Functionality of a ‘Software-Defined Core’ Card

Change Functionality of a ‘Software-Defined Core’ Card
Grass Valley offer a range of cards which have a software-defined core, enabling a user to 
change the functionality of a card with core packages and licenses. GV Orbit Client enables a 
user to change such a ‘software-defined core’ card’s functionality. 

To change a card’s functionality, use the ‘upgrade’ mechanism in GV Orbit Client:
1 Locate the software-defined core card in the Network window.

Fig. 2-31: Software-Defined Core Device in Network Window

2 Right-click on the card item in the tree-view and select ‘Upgrade’.

The RollCall Upgrade window is shown for the card. The window shows:
• the core package currently in use by the card; and 
• all available (imported) core packages.

See Figure 2-32.

Note: Supported software-defined core cards include:

• UCP-3901 and IQ-UCP cards, with various core packages, 
including Essence Processing (EP) cores and Multiviewer 
(MV) cores. 

See the documentation on the respective cards for further information 
and instructions on how to add licenses etc.

Note: License a card first before loading a core package into the card. 
If a core package is loaded but a card is not licensed, then default, 
‘base’ functionality results. See the documentation on the respective 
card for information.
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Fig. 2-32: RollCall Upgrade Window - Available Cores

To import further core packages: 
3 Import the core package in a similar way to an upgrade package (see Step 4.1: Upgrade 

RollCall-protocol Devices, on page 51).

To load an available (already-imported) core package into the card and change card 
functionality:

4 Select an available core package and click Upgrade. The procedure is similar to 
upgrading a card (see Step 4.1: Upgrade RollCall-protocol Devices, on page 51).

The new core package is placed on the card; the card reboots and then adopts the 
functionality of the new core package if the card is licensed.

Step 5: Adding Support for Further Densité Cards

Introduction
GV Orbit fully supports all Densité cards. GV Orbit Professional and Enterprise ship with 
native support for many Densité cards; for other cards, support needs to be added to your 
GV Orbit Server. This section describes how to add support for Densité cards to your 
GV Orbit Server. 

Current software-defined core being used by the card.Available core packages

Lite Professional Enterprise
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Support is added by uploading the requisite Densité card software package. Once 
uploaded, the GV Orbit Server can recognize the cards and they may be integrated into the 
Network window.

Carry out this procedure to add or to update support of a Densité card.

Add or Update Densité Card Support
Many Densité cards are automatically recognized by GV Orbit. However, some Densité cards 
may not show in the Network window, even though they are physically installed in a 
Densité frame. For example, a frame’s controller card may be shown but one or more cards 
in the same frame are not shown (in the tree-view nor list-view). To make such cards 
available, the corresponding card software packages must be uploaded through the 
Densité Upgrade Manager tool.

Prerequisite:
• All Densité frames are added to the Densité Manager service on the GV Orbit Server. 

Refer to the Densité Manager service in the GV Orbit Admin Guide. See Related 
Documentation, on page 19.)

• Software package are available for each Densité card type to be added/updated. 
(See each separate card documentation for how to obtain each software package.) 

The procedure is similar to upgrading Densité cards (see Step 4.2: Upgrade Densité-
protocol Devices):

1 Locate a Densité frame item in the Network window tree-view and expand it to show 
all available cards.

2 If one or more cards are not shown in the Network window tree-view, 
right-click on a fitted card item (for example, on the frame controller card item) and 
select ‘Upgrade’.

The Densité Upgrade Manager tool is opened showing all the cards in the Densité 
frame. Some cards may be grayed-out.

For each Densité card type for which support is to be added/updated: 
3 Import the card’s software package. 

(See Import Upgrade Packages for how to do this.)
4 Upgrade each card. 

(See Upgrade the Device for how to do this).

After a card type has been upgraded, it should appear in the Densité Upgrade Manager 
tool and not be grayed-out. 
Support for the card has now been added to the GV Orbit Server.

When the support for all cards has been added:
5 Close the Densité Upgrade Manager window.

Support for the Densité cards has now been added to the GV Orbit Server and the cards are 
displayed in the GV Orbit Client’s Network window. 

Note: Refer to GV Orbit release notes documentation for a list of natively 
supported Densité cards. See Related Documentation, on page 19.
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Step 6: Multiviewer Project 

Introduction
This section is applicable to GV Orbit Client and multiviewer applications with single 
multiviewers that use the GV Orbit ‘Multiviewer’ project type. 

This section describes a simple edit to a GV Orbit (single-multiviewer) ‘Multiviewer’ project 
pulled from a multiviewer (MV-8 series or IQ-MV series multiviewer). The simple edit 
changes the appearance of the video wall and the project is pushed back to the device.

Simple Multiviewer Project Editing Example

Pull Project and Open
1 Open GV Orbit Client at the 

initial screen and 
click New Project.

The New Project dialog is 
shown.

2 Select Connected 
Multiviewer Project type.

3 Browse into a new, empty 
folder (into which project 
information will be placed). 

4 Click Choose.
5 Click Next.

A list of available 
multiviewers is shown.

Lite Professional Enterprise

  

Note: A GV Orbit ‘Multiviewer’ project type is typically for single-
multiviewer designs. 
For video walls designs that are served by a cluster of multiviewers 
(MV Cluster), then use the GV Orbit ‘Clustered Multiviewer’ project 
type (described in Chapter 14, Multiviewer Cluster, on page 653 
onwards).

Note: GV Orbit ‘Multiviewer’ projects are pushed/pulled to/from a 
compatible (single) multiviewer device rather than to/from a GV Orbit 
Server.
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Fig. 2-33: Select Multiviewer to Connect To

6 Select the multiviewer to connect to and click OK.

GV Orbit Client connects to the multiviewer, pulls the GV Orbit project from it, attempts 
to open the project, and shows the login screen.

7 Enter the correct User name and Password for the accessing the GV Orbit project.

8 Click Login. 

The project is opened and the multiviewer project Home Screen is shown.

Fig. 2-34: Multiviewer Project Home Screen

Note: The IP network used needs to support multicast for automatic 
discovery of devices to occur (for example, for listing available 
multiviewers).

Note: The default login for new projects is ‘admin’ ‘admin’.

Name of GV Orbit project (pulled from multiviewer)
Folder path where project is stored on the client PC.
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The GV Orbit multiviewer project has been pulled from the target multiviewer device, 
locally stored on the client PC, and opened in GV Orbit Client. 

The multiviewer video wall design may now be edited in GV Orbit Client.

Edit the Multiviewer Project
1 Click on the large Walls icon, and select one of the wall items that is shown listed. 

The multiviewer video wall design is opened in a tab in the overall GV Orbit Client 
window. See Figure 2-35. 

Fig. 2-35: Example Video Wall Tab in Wall Editor

The Wall tab is the stage on which a Wall is:
• designed and edited (in GV Orbit Client Design mode); and
• may be run and viewed (in GV Orbit Client Run mode). 

Although a video wall is fully deployed when running on a compatible multiviewer 
device.

2 Click the Run Mode / Design Mode tool bar icon to select ‘Design Mode’.

Run Mode / Design Mode icon (GV Orbit Client is shown in Design Mode)

Wall tab

Properties Box

Video Wall design

Video tiles

Note:
Clicking the Run Mode / Design Mode tool bar icon toggles between ‘Run’ 
and ‘Design’ modes of GV Orbit Client.
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Fig. 2-36: Run Mode / Design Mode Tool Bar Icon

This example edit will do a simple change to the video wall:
3 Click on one of the video tiles on the wall to select it. For example, the top-left video 

tile.
4 In the Properties Box, change the Preferences -> Type property value to ‘Analogue 

Clock’ via the drop-down menu.

The selected tile changes to a round-faced clock within the Wall tab.

Fig. 2-37: Edited Wall Design

5 Click Project -> Save Project to save the whole project locally, including the video wall 
design.

Push Project Back to Multiviewer
1 Click Project -> Push in the main menu.

The Choose Projects dialog is shown.

b) Icon appearance when in Design Mode 

a) Icon appearance when in Run Mode

Click to exit Run Mode

Click to enter Run Mode

Note: 
• In Design Mode, a project may be 

edited (for example, a video wall may 
be modified). 

• In Run Mode, a project monitors log 
and alarm data and generates 
display screens in real-time.

Round-faced, analogue clock tile Analogue clock typeSelected video tile



64

Getting Started Steps GV Orbit Version 2.3.0
Step 7: Control and Monitoring Project Setup (Professional/Enterprise) User Guide

Fig. 2-38: Choose Projects Dialog

2 Select just the project to push to the multiviewer. 
3 Click OK.

The selected project is pushed back to the multiviewer.
The edited video wall is then used and shown by the multiviewer device.

Step 7: Control and Monitoring Project Setup (Professional/Enterprise)

Introduction
This section is applicable to GV Orbit Professional and Enterprise only. It describes setting 
up a new ‘Control and Monitoring’ project (C&M project), which is the main project type 
applicable to GV Orbit Professional and Enterprise. Following its setting up, a C&M project 
is ready for use. For example, custom graphical operator screens etc. can be designed, 
created and used.

All C&M projects are centrally stored in and used from repositories on the GV Orbit Server 
(one project per repository). The GV Orbit Client application needs to be configured to 
communicate with the GV Orbit Server(s) (see Step 7.2: C&M Setup Dialog, on page 65). A 
project is loaded by GV Orbit Client from a server repository and stored locally on the client 
PC. 

• Step 7.1: New C&M Project, on page 65.

Hint: 
Hover on a Project item to see local folder path

Project selected

Lite Professional Enterprise

 

Note:
GV Orbit Client requires network access to one or more GV Orbit 
Servers running configured GV Orbit services.
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• Step 7.2: C&M Setup Dialog, on page 65.
• Step 7.3: Further Setup, on page 70.
• Step 7.4: Saving and Pushing a Project, on page 74.

Step 7.1: New C&M Project 
From the GV Orbit Client Initial Screen:

1 Click New Project.

The New Project dialog is shown.
2 Select the C&M project type. 
3 Click Browse and browse to a folder 

where the project will be placed. 
Click Choose.

4 Enter a name for the new project.
5 Click OK. 

And, if prompted, answer Yes to 
create a directory.

The Setup dialog is shown. See Step 
7.2: C&M Setup Dialog, on page 65.

Step 7.2: C&M Setup Dialog 

Fig. 2-39: C&M Project Setup Dialog 

The C&M Setup dialog provides a quick way to enter key project parameters for a project.

The dialog is shown automatically when creating a new C&M project. And it can be 
accessed when an existing C&M project is open by clicking Connections -> GV Server in 
the main menu.
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Server IP Address(es)
1 Enter the IP address of the GV Orbit Server into the Server 1 IP text box. 

For a GV Orbit Server Cluster, enter the IP address of one server. The second server’s 
address will be discovered automatically in the steps below.

Check the address is correct.

The GV Orbit Client attempts to connect to the server and performs some basic system 
tests. 

The resulting connection status from the basic system tests is indicated in a console 
pane showing any system messages issued. See Figure 2-40a.

Note:
Some key project parameters are entered in the Setup dialog and used for 
the project settings. Some settings may be subsequently edited by you if 
required. Refer to Step 7.3.1: Project Variables (Project -> Edit Variables), on 
page 70.

Note: Basic System Tests:

1. Connect to the GV Orbit Server. 

A good connection status is shown with a green light indicator. 
2. Find out other GV Orbit system information from the server.
3. Fill out settings in the Setup dialog. 

For example: 
• Client Domain number being used (default is 100). 
• Available Repositories on the server.
• IP address of any second GV Orbit Server; and any IP address 

being commonly used by the servers (‘Virtual IP’).
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Fig. 2-40: C&M Project Setup Dialog:
a) Single GV Orbit Server;
b) GV Orbit Server Cluster

Green indicates 
GV Orbit Client 
successfully 
connected to the 
GV Orbit Server.

System messages 
from basic system 
tests.

a) Single GV Orbit Server

IP addresses 
automatically 
added

b) GV Orbit Server Cluster

Green indicates 
GV Orbit Client 
successfully 
connected to the 
GV Orbit Servers 
and virtual IP 
address detected.

Console pane
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Select a Repository

1 In the Setup dialog, click New.

The Create Repository dialog is shown:
2 Enter a name for the new repository and click OK.

Alternatively, to select an existing repository: 
3 Select a Repository in the ‘Repository’ drop-down list in 

the Setup dialog.

The C&M project will use the project from this Repository.

Fig. 2-41: Select a Repository in Setup Dialog

System Re-Test
1 Click System Test to redo the basic system tests. 

For the basic system test, GV Orbit Client performs a:

Note: Repository:
Projects may be locally stored on the client PC but, for deployment, a C&M 
project must be saved to the GV Orbit Server (Pushed) into a Repository, one 
project per Repository. Multiple clients can access the same project.

Note:
The Repository Manager service, running on the GV Orbit Server, can be 
configured on the server and each repository may be set up from there. 
Alternatively, 
a New repository may be created from the C&M Project’s Setup dialog.
Available Repositories are listed in a drop-down box in the Setup dialog.

Note:
Pull a project from a Repository to load the project from a server.
Push a project to a Repository to save it back to the GV Orbit Server.

Click New to 
create a new 
Repository
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• ping to each server;
• client-server communication check; 
• services check on the server; and 
• check of service Domain configurations (Monitoring and Log Server services).

The console pane in the Setup dialog may have shown some red messages which 
highlight differences between entered dialog settings and those of the GV Orbit 
system connected to. (For example, a Client Domain number difference.)
Re-do the basic system tests and the red messages should clear.

Fig. 2-42: System Test Re-done and Console Output OK:
a) Single GV Orbit Server. 
b) GV Orbit Server Cluster.

Apply Settings
1 In the Setup dialog, click Apply to apply these settings to the project.

Click OK to any pop-up message.
2 Click Close to close the dialog.

The GV Orbit pulls the project etc. from the repository and shows the Home Screen.

System Test clear console output

Single GV Orbit Server

a) Single GV Orbit Server b) GV Orbit Server Cluster

 GV Orbit Servers and Virtual IP Address

Note:
When connecting to a Repository, you may be prompted to Pull a project 
from a Repository, so as to retrieve a project from the server.
Pull a project in order to either:

• edit the project locally (any existing local project is overwritten); or
• run the project locally (for example, to run operator screens).

Do not Pull if a local project has been created/changed and it needs to 
be put into a Repository. This requires a Push to a repository.
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Step 7.3: Further Setup 
Following initial set up, a C&M project is ready for use. Project settings and variables are set 
up from the settings in a C&M Project’s Setup window.

This sub-section describes how to adjust the project settings (including project variables) 
further, if any parameters need changing for some reason. 

Step 7.3.1: Project Variables (Project -> Edit Variables)
C&M projects have a set of project variables that are set up when using the C&M Project 
Setup window to establish connection to a GV Orbit Server. This done as part of creating a 
new C&M Project. (The Setup window is also accessed by selecting Connections -> GV 
Server in the main menu.)

The Project Variables enable GV Orbit Client workflows, and other user graphical screens, 
to communicate with GV Orbit services and Server(s). 

To access the project variables from the project Home Screen:
1 Click Project -> Edit Variables... in the main menu.

A Variables window is shown for the C&M project.

Fig. 2-43: C&M Project Variables Window

Note:
Most Project Variables hold default values consistent with the default 
GV Orbit Server and GV Orbit services settings. Do not change the values of 
these variables unless the items have been changed from their default. 

Parameter Description

GVOC IP Virtual IP address of the GV Orbit Server cluster.

GVOC Launcher Path to launcher for GV Orbit Control Client.
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2 Click OK when project-variable value changes have been done.
3 Click Project -> Save Project in the main menu to save the project locally to disk.
4 Push the project to the repository when all changes are done.

Custom Project Variables

The Variables window also allows a user to create custom project variables for their own 
use. For example, the RollCall addresses of system devices, a company name, the TV 
channel/studio name, etc. These may each be set up as custom project variables and used 
in custom control and monitoring screens. Custom project variables can be created and 
deleted.

IP Network Network file name for IP endpoint configuration.

Routing Address RollCall ‘Control’ address of Routing Service on GV Orbit Server(s).

Server IP 1 GV Orbit Server 1 IP address.

Server IP 2 GV Orbit Server 2 IP address.

Show External IDs The GV Orbit Client uses the External IDs set in GV Orbit Control for 
router control. Certain control protocols require that the numbering of 
external IDs must be contiguous. 
False: GV Orbit Client remaps the External ID's used by GV Orbit 
Control into its own list of contiguous internal ID's. GV Orbit Client 
follows name changes to existing External ID's, however adding 
devices to GV Orbit or removing devices from GV Orbit may cause a 
shift in the internal ID numbering which can result in incorrect routing. 
When this occurs, the ID shown in GV Orbit Client Routing Behaviors 
will no longer match those used in GV Orbit Client as there are two 
separate ID lists which are no longer coherent.
This is the default for a project migrated to GV Orbit version 2.0.0 and 
above, for backwards compatibility.
True: GV Orbit Client uses the GV Orbit Control External ID's. You can 
insert or remove devices without any impact on existing IDs. The 
GV Orbit Client will follow name changes associated with External IDs.
See also About External IDs and Northbound Control Interfaces, on 
page 467. 

XEdit Launcher When you have added one or more Kaleido multiviewers to GV Orbit, 
you can launch XEdit for those multiviewers from the Network 
Window, in order to configure them. 
In this variables window, you can specify which version of XEdit to 
open. 
Auto: GV Orbit auto selects an installed XEdit version. 
[path]: Define the path to the required version of XEdit to use that 
specific version. 
See also Step 7.3.3: Configure Network Window for Kaleido 
Multiviewers, on page 73.

Note: For a multiviewer project there are fewer variables.

Parameter Description
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Step 7.3.2: Client Domain Number (Connections -> GVOP)
To configure the Client Domain for the GV Orbit Client to use for the project:

1 Click Connections -> GVOP in the main menu. 

The GV Orchestration Protocol dialog is shown.

Fig. 2-44: GV Orchestration Protocol Dialog 

2 Set the Domain number of the Client Domain that the C&M project will use. (Default is 
100.)

3 Other project parameters can be changed in the dialog, see Figure 2-44.
4 Click OK to finish and close the dialog.

Step 7.3.3: Configure Network Window for Densité-protocol Devices
1 Click Connections -> Densité in the main menu.

The iControl/Densité Configuration dialog is shown.

CAUTION
Do not delete any of the C&M project variables presented here.

Set the Client Domain number for 
the project to use. (Default is100.)

Select for multicast discovery of 
server IP addresses. 
(Default is unicast discovery.)

Click to add a new IP address (for 
unicast discovery). 

Select/deselect IP interfaces of the 
client PC to be used by GV Orbit 
Client.

Set multicast packet ‘Time to Live’ 
(TTL) - defines the number of “hops” 
that a network multicast message is 
allowed to do between IP network 
routers. The TTL value can limit the 
distance these messages travel within 
a network.
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Fig. 2-45: iControl/Densité Configuration Dialog

2 Click Add and enter the IP address(es) of GV Orbit Server(s) (which run a Densité 
Manager service), or add the IP address of a server.

3 Select ‘Lookup Service’  and ‘Densité REST’.
4 Enter the Username and Password to access the Densité Manager service.
5 Click OK to finish and close the dialog.

Finally:
6 Click Project -> Save Project in the main menu to save the project locally.
7 Push the project to the repository when all changes are done. See Step 7.4: Saving and 

Pushing a Project, on page 74.

Step 7.3.3: Configure Network Window for Kaleido Multiviewers
By adding one or more Kaleido multiviewers to GV Orbit, you can launch XEdit for those 
multiviewers, including their Rooms and Layouts, from the Network Window, in order to 
configure them. See also Network Window, on page 84.

You can specify which version of XEdit to open through the Project > Edit variables > 
XEdit Launcher. See Step 7.3.1: Project Variables (Project -> Edit Variables), on page 70

PREREQUISITE: XEdit needs to be pre-installed on the same PC as GV Orbit. Either use the 
online installer by connecting to a Kaleido multiviewer in a web browser or obtain an 
offline installer from Grass Valley Support.

1 Click Connections -> Kaleido in the main menu.

The Kaleido Configuration dialog is shown.

IP address(es) of a server running a 
Densité Manager service, typically, a 
GV Orbit Server.

Click Add to add a new IP address.
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2 Click Add and enter the IP address(es) of one or more Kaleido Multiviewers.
3 Click OK to finish and close the dialog.

The Kaliedo Multiviewer(s) are added to the the Network Window from which you can 
launch XEdit for those multiviewers.

4 Click Project -> Save Project in the main menu to save the project locally.
5 Push the project to the repository when all changes are done. See Step 7.4: Saving and 

Pushing a Project, on page 74.
6 Right-click the multiviewer’s IP address in the Network Window to launch XEdit for that 

multiviewer in order to configure it. Expand the IP to show the list of rooms, then 
expand a room to show the list of layouts for that room. You can right-click on any one 
of the Rooms or Layouts in order to configure it. See also Network Window, on page 84. 

Connecting to another Kaleido will switch the running instance of XEdit to the newly-
requested Kaleido.

Step 7.4: Saving and Pushing a Project 

Save Project (Locally)
To save a project locally to the folder on the client PC:

• Click Project -> Save Project in the main menu.

2. Set the IP address(es) of one or 
more Kaleido Multiviewers.

1. Click Add to add a new IP address.

Expand the multiviewer to view and then right-
click to edit the available Rooms and Layouts
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Push Project (Save to Server)
To push a project back into a repository (on the GV Orbit Server):

• Click Project -> Push. (See Step 2.2.2: Push Project (Save to Server), on page 40.)
In the Choose Project dialog, select the project to be pushed and click OK.

Pull Project (Load from Server)
To pull a project from a repository (on the GV Orbit Server):

• Click Project -> Pull in the main menu.

Close Project
To close a project that is open in GV Orbit Client:

• Click Project -> Close Project in the main menu.

IP Configuration of End Point Devices and Spreadsheet Import 
Access the IP Routing endpoint configuration editing tool and a new, default GV Orbit C&M 
project (see Graphical Routing Workflow, on page 100 for more information).

1 In the Graphical Routing Workflow screen, click IP Configuration and Spreadsheet Import.

See Graphical Routing Workflow, on page 100 for more information.
2 Click the Comms Setup button:

3 Select Routing System controller type to be ‘GVOC’.

Comms Setup ButtonExport Import Device tab

Discovered devices are listed

IP Endpoint Editor tab
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4 Leave the GVOC domain number at its default (105).
5 Select the client PC network IP interfaces to use. 
6 Click OK. 

GV Orbit Client will discover IP End-points and list them.
7 Click on the Devices tab to see the listed devices.
8 Click Export to export the discovered IP end-point devices and their current settings. 

(A spreadsheet file, .xlsx file, is exported and this shows the spreadsheet file format. 
Settings include: device names, router port numbers, source/destination IP flows, and 
multi-cast IP addresses etc.) 

9 Edit the spreadsheet file to change settings and/or add more IP end-point devices.
10 Click Import to import IP End-point device settings via a spreadsheet. 
11 Select Project -> Save Project from the main menu. Close the IP Endpoint Editor tab.

Fig. 2-46: IP Endpoint Configuration Editor tab in GV Orbit Client (Device sub-tab shown)

This screen also allows:
• Manual configuration of end-points, if required.
• Review IP End-point settings, edit settings, validate settings, make engineering routes, 

if required.
• Monitor bandwidths at device interfaces, if required.

Note: SDI ‘end-point’ configuration etc. is set up via GV Orbit Control in the remaining 
controls on the routing workflow.
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Project Home Screen

Home Screen Windows
The appearance of the GV Orbit Client project Home Screen varies according to project type 
and according to which GV Orbit Client windows are enabled and being shown. Use tool bar 
icons to show/hide windows.

Lite Professional Enterprise
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Fig. 3-1: GV Orbit Client Project Home Screen Windows

Click the following tool bar icons to show/hide windows in the Home Screen:

Project Window

Network Window

Alarm History Window tab

Graphical Routing Workflow tab selected and a graphical routing 
workflow stage is shown.

C&M Screen tabWorkflow tab

 Table 3-1: Home Screen Windows
Window Description See

Project A tree view of projects opened by the GV Orbit Client. 
Allows users to access aspects of the current project, or 
to load another project.

Project Window, on page 80.

Network A view of devices/frames/services etc. in a GV Orbit 
system, presented in a tree-view or a list-view. A user 
can access device information and alarms.

Network Window, on page 84.

Alarm History A list of alarms that have occurred across the system 
over time.

Alarm History Window, on page 99.

Properties Shows the properties of the selected graphical widget 
when designing a graphical C&M project.

Properties Window, on page 81.

Workflow A graphical presentation of all the tasks and functions 
available in GV Orbit. 
Click on an icon to access a task or a function.

Graphical Routing Workflow, on 
page 100.
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Close All Windows
To close all windows and just see a default workflow: 

• Click Window -> Close All in the main menu.

Project Window
The Project window lists the project currently 
open and any projects previously opened by 
the GV Orbit Client on the client PC.

The currently-open project is expandable in a 
tree view to show the various project items. 
You can access and manage different 
aspects/functions of the project from this tree 
view item. 

Project Tree-Items
Project items seen when a project is expanded 
include:

• Components - Graphical custom 
components that appear on GV Orbit Client graphical control and monitoring screens.

• Networks - IP End-point configuration files, used in IP routing control set up.
• Panels - Soft XY Router control panels, created with a wizard and user-customizable.
• Resources - Imported resource items used in the project (for example, logo images 

etc.).
• Screens - C&M project user-defined graphical control/monitoring screens.
• Themes - The appearance of each graphical element on a GV Orbit custom graphical 

screen (multiviewer video wall screen, or C&M project control and monitoring screen) 
can have a style applied to it. A theme is a set of styles that can be applied to a project.

• Workflows - Workflow screen.
• configuration.prj - The GV Orbit project file. Select this file when opening an existing 

project in GV Orbit Client. Do not edit this file. 

Toolbar Icon Description

Alarm History window icon. See View Alarm History for System-
wide Alarms, on page 100.

Project window icon. See Project Window, on page 80.

Network window. See Network Window, on page 84.

Properties window (shown when a C&M screen tab is selected). 
See Properties Window, on page 81.

Workflow window. See Workflow Window, on page 83.

Project is 
expanded

Currently-open 
project

Fig. 3-2: Project Window
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• db.users - Project users, user roles and their associated permissions can be managed. 
New user names and logins etc. can be set up. 

• Grids - Imported tile-grid layouts for all multiviewer projects.
• Tiles - Video wall tile designs for all multiviewer projects.
• Rooms - Video wall designs for ‘Clustered Multiviewer’ projects.
• Walls - Video wall designs for ‘Multiviewer’ projects.

Project Window Actions
Right-click on a Project window tree-view item to open, import, or create a new item. 

For example, right click on: 
• Screens - Select New Screen to create a new user screen in a C&M project.
• Walls - Select New to create a new video wall in a single-multiviewer project.
• Resources - Select Import File(s) to import an image file into a project.
• db.users 

• Select Open to open the User Management window in a tab to set up users and 
roles.

• Select Import user database to import users from another project.
• <Project Name> - Select Rename project to rename the project.

Properties Window

The Properties window shows the properties of a selected graphical widget or on-screen 
item when designing/editing a C&M screen in GV Orbit Client in ‘Design’ mode. The 
window may be shown when a C&M screen tab, or a multiviewer video wall, or other 
graphical GV Orbit project item is selected.

Note:
Some project items are also accessible via icons in the routing workflow 
window (see Graphical Routing Workflow, on page 100).

Note:
Some project items may be specific to certain project types.

Lite Professional Enterprise
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Fig. 3-3: Properties Window Example: a) In Design Mode; b) In Run Mode.

a) Example C&M Screen Running in ‘Design’ mode in GV Orbit Client

Run/Design Mode icon indicates GV Orbit Client is in ‘Design’ mode 
for graphical editing and design.

Alarm List widget showing 
live alarms in a system

Selected (Alarm List) widget and its corresponding 
properties shown in Properties window

b) Example C&M Screen Running in GV Orbit Client

Properties Window
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Workflow Window

A workflow window shows a graphical representation of all the tasks and functions 
available in GV Orbit Professional and Enterprise systems. The Workflow window is the 
stage which presents all the tasks and functions the system has to offer to the GV Orbit user. 
Click on a workflow icon for direct access to a task or a function. 

View WorkFlow Stage
To view the Workflow stage:

1 Click the  icon in the tool bar. 

Workflow stage is then shown in a tab.
2 Select the workflow tab (if it is not already selected) to view it.

The workflow in Figure 3-4 is available to all new projects.

Fig. 3-4: Graphical Routing Workflow Stage

Lite Professional Enterprise

 

Note:
A Workflow window may be visible in GV Orbit Lite but it is not 
applicable to the GV Orbit Lite product version.

Workflow window icon workflow.wfl tab

Click on an icon to access GV Orbit project functions in 
GV Orbit Client, see Project Window, on page 80. 

Click on an icon to access a task item, 
see Graphical Routing Workflow, on 

page 100. 

Workflow stage

Click on a server icon to 
access a GV Orbit Server. 
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The graphical Workflow stage makes it easy to understand how tasks and functions are 
related and each icon provides direct access to the task/function it represents.

The workflow is optimized for carrying out the system configuration required:
• when re-purposing an existing routing infrastructure; or 
• for the steps to set up a fresh, new routing environment. 

Routing configuration and control is done through the GV Orbit Control application 
running on a GV Orbit Server, which supports Grass Valley NP0017 and SW-P-08 protocols. 
Both IP and SDI routing etc. may be controlled. The GV Orbit Control uses the GV Orbit 
Control service running on the GV Orbit Server.

Network Window

About the Network Window
The Network window shows a tree-view or a list-view of devices/frames/services etc. in a 
GV Orbit system. A user can access control screens, information and alarms about these 
items from the window.

Show/Hide Network Window
In the Network window’s main tool bar, click  to show / hide the Network window.

Tree-View and List-View
The Network window shows a tree-view or a list-view of devices/frames/services etc. in a 
GV Orbit system. A user can access control screens, information and alarms about these 
items from the window. For more information, see Network Window for more information.

The tree-view and list-view forms of the Network window are shown in Figure 3-5. 

The tree-view presents a hierarchical view of system devices/units/frames/services. See 
Figure 3-5a. The tree-view’s expand/collapse controls are presented in Figure 3-5a. 

Note:
To set up the Network window for a project, see Network Window Views, on 
page 43 onwards.
See Step 3.2.1: Network Window Setup For RollCall-protocol Devices, on 
page 44; Step 3.2.2: View a Device Control Screen - RollCall Devices, on 
page 46; Step 3.2.3: Network Window Setup For Densité Devices, on page 47; 
and Step 3.2.4: View a Device Control Screen - Densité Devices, on page 48.

Note: Automatically discovered devices:
For devices that are automatically discoverable by a GV Orbit system, these 
are shown in the Network window. For example, GV Fabric IP switch.

Note:
To set up the Network window for a project, see Network Window Views, on 
page 43 onwards.
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The list-view is a flattened view, listing all system devices/units/frames/services. See 
Figure 3-5b. The list may be filtered, see Network Window List-View Filter for a description 
of the list-view filter controls.

Fig. 3-5: Network Window: a) Tree-View; b) List-View.

Network Window Actions
Locate a device in the Network window and right-click on the item. The following actions 
are possible in GV Orbit:

• Lite, Professional and Enterprise:
• Device Information - View information about a device.
• Card Parameters - View Densité-protocol device parameters.
• Device Control - View and change device configuration settings. (Lite: RollCall 

devices only.)
• Upgrade Device - Upgrade (or downgrade) device software/firmware.

• And for Professional and Enterprise only:
• Alarm List - Live Alarms/Status - View a list of a device’s live status and alarms. 
• Alarm History for a Device - View the alarm history of a device. 

a) Tree-View b) List-View

Click to show List-View

Click to show Tree-View

Click to expand all of the tree-view.
Click to expand the selected part of the tree-view.

Click to collapse all of the tree-view.
Click to collapse the selected part of the tree-view.

List-view filter controls, see 
Network Window List-View Filter
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• Alarm Masking (Professional and Enterprise) - Mask device alarms. 

Network Window List-View Filter
In the Network window, the displaying of items in the list-view can be filtered. Filtering can 
be done:

• with a text string; and/or 
• by card type; and/or 
• by alarm state. 

The filter controls are shown in Figure 3-6.

Fig. 3-6: List-View Filter Controls

Filter Example 1: Filter List Item Name
To filter the Network window list-view for a particular device by its name:

1 Enter a fragment of text in the Filter text box. For example, “UCP or “XIO”.

The displayed names are those containing the entered text. See Figure 3-7b or c.

Filter text box

Filter icon
Filter drop-down menu

Filter on Device Type

Filter on Alarm State

Clear Filter text box filtering

Clear All Filtering



87

GV Orbit Version 2.3.0 Home Screen
User Guide Network Window List-View Filter

Fig. 3-7: List-View Filtered Names on Text

2 Click on the Filter icon and select ‘Clear Filter’. 

The text box is cleared and the text--box filtering is cleared.

Filter Example 2: Filter Device Type and then Alarm State
With all filters cleared, to filter on a device type and then their alarm states:

1 Click on the Filter icon and select ‘RollCall’. 

RollCall-protocol devices are shown. See Figure 3-8a.
2 Click on the Filter icon and select ‘Minor. 

‘Minor Warning’ RollCall-protocol devices are shown. See Figure 3-8c.

c) Filtered on “XIO”b) Filtered on “UCP”a) Unfiltered.
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Fig. 3-8: Filter on Device Type and then Alarm State

To clear the alarms:
3 Click on the Filter icon and select ‘Clear All Filters’. 

All filters are cleared and all devices are shown.

Network Window Actions
Locate a device in the Network window and right-click on the item. 

The following actions are possible in GV Orbit:
• Lite, Professional and Enterprise:

• Device Information - View information about a device.
• Card Parameters - View Densité-protocol device parameters.
• Device Control - View and change device configuration settings. (Lite: RollCall 

devices only.)
• Upgrade Device - Upgrade (or downgrade) device software/firmware.

• And for Professional and Enterprise only:
• Alarm List - Live Alarms/Status - View a list of a devices’ live status and alarms. 

b) Select to Show Minor Warning 
Alarm States

a) Filter RollCall-protocol devices c) Minor Warning RollCall-
protocol devices shown

Filter icon indicates some filtering is active
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• Alarm History for a Device - View the alarm history of a device. 
• Alarm Masking (Professional and Enterprise) - Mask device alarms. 

Device Information
To inspect device information from the Network window (tree-view or list-view):

1 Right-click on a device and select ‘Info’. 

Device information is shown in a Details pop-up window.

Fig. 3-9: Device Info - Details Pop-up Windows

Card Parameters
To view a Densité-protocol device’s parameter settings from the Network window:

1 Right-click on a Densité-protocol device and select ‘Card Parameters’.

A summary of the device’s parameter settings is shown in a tab. See Figure 3-10.

a) RollCall-protocol Device - Details window

b) Densité-protocol Device - Details window
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Fig. 3-10: Card Parameters Tab

2 Click on a column heading to sort the listed parameters on a column. 
3 Use the filter controls to restrict the shown listed items. See Figure 3-11.

Fig. 3-11: Example Filtered Card Parameters

4 Read/Write card parameters can be entered via the ‘Current Value’ column.

Device Control
To inspect a device’s configuration settings from the Network window:

1 Right-click on a device and select ‘Control’ to view the device’s control screen. (See Step 
3.2: Configuration of Densité and RollCall Devices, on page 43.)

Right-click and select ‘Card Parameters’, 
a summary of card parameters is shown in a tab

Example: Filtering on parameter name containing ‘Resp’
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Upgrade Device
To upgrade a device from the Network window:

1 Right-click on a device and select ‘Upgrade’ to open the device’s upgrade screen. (See 
Step 4: Device Upgrade, on page 50.)

Alarms
See Alarms section for more information.

Alarms

Alarm List - Live Alarms/Status 
Professional and Enterprise only.

Alarm List Window
To inspect live alarms and status of a device/frame/service from the Network window:

1 Right-click on a device item in the Network window and select ‘Alarm List’.

The live status and alarms reported by the device/frame/service are listed in an Alarm 
List window. See examples shown in Figure 3-12a and b, and Figure 3-13a and b.

Note: For GV Fabric IP Switch devices, the control screen that is opened in 
the GV Orbit Client window is the device’s web page.

Note: Alarms in GV Orbit v1.2 onwards:
In GV Orbit systems, alarms are handled ‘behind the scenes’ with internal 
addresses. These addresses have changed for GV Orbit v1.2.0 onwards:

• v1.2.0 onwards: Alarm-addresses for Densité-protocol devices are 
now aligned with the respective device/card address. 

• Earlier than v1.2.0: Densité-protocol device alarm-addresses are 
separate and are not aligned to device addresses.

CAUTION
As a result of this alarm addressing change, when upgrading to GV Orbit 
v1.2.0 onwards, addresses specified for alarms must be changed. This applies 
to custom operator panels of C&M projects and to Alarm Behaviours.
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Fig. 3-12: Example Alarm List Windows for:
a) System Device (XIP shown); b) GV Fabric IP Switch.

Click to select sorting of listed alarms from drop-down menu.

Filter on a column (Name or 
Value or State).

Clear filters on all columns.

a) Alarm List example for a system device, XIP device

b) Alarm List for an Auto-discovered GV Fabric IP Switch
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Fig. 3-13: Example Alarm List Windows for:
a) GV Orbit Server; 
b) GV Orbit Service.

b) Alarm List for a GV Orbit Service

a) Alarm List for a GV Orbit Server
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Alarm List Window Masking
In the Alarm List window, alarms can be masked:

• at a device-level; or 
• individual alarms for a device can be masked (alarm-level). 

Right-click on an item in the Alarm List window to see masking options. See Alarm 
Masking (Professional and Enterprise), on page 96 for further information on masking.

Fig. 3-14: Alarm List Window Right-Click Options

Alarm History for a Device
Professional and Enterprise only.

To inspect the history of device status and alarms from the Network window:
1 Right-click on a device in the Network window and select ‘Alarm History’.

The status messages and alarms etc. reported by the device are listed in 
a new History window tab. The address of the device is shown in the window tab. See 
Figure 3-15.

Right-click options

Device-level masking options

Right-click options Alarm-level masking options

Note:
The Alarm History window uses the following GV Orbit services:
IP Proxy, Log Server, Monitoring, Event Logging, and Densité Manager.
These services are all required for Alarm History.
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2 Click the search icon ( ) in the 
History window.

The Search Parameters dialog is 
shown.

3 Select a Log Data Source from the 
drop-down menu.

This selects an alarm data source to view in the window.

4 To close the Search Parameters dialog, 
(re-)click on the search icon (or click somewhere else in the History window).

The selected data source is shown in the History window. 
(See Alarm History Window, on page 99 for further information.)

Note:
The Log Data Source drop-
down menu lists the Event 
Logging filters that are set up 
on the GV Orbit Server’s Event 
Logging service.

Note:
See Alarm History Window, on page 99 for further information on data 
sources and the controls in this tab window.
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Fig. 3-15: Example History Window

Alarm Masking (Professional and Enterprise)
Alarm masking may be done on a device (device-level masking), or it may be done on a an 
individual alarm from a device (alarm-level masking):

• Device-level masking/unmasking can be done from the Network window, or from the 
Alarm List window for a device.

• Alarm-level masking/unmasking may be done from a device’s the Alarm List window.

Device-level masking is applied separately and additionally to any alarm-level masking. 
For example, if an alarm-level mask is applied to alarm A for a device and then a device-
level mask is applied to the device, when the device-level mask is removed, the alarm-level-
mask will still apply.

Apply a Device-Level Mask
To mask alarms associated with a device, from the Network window:

1 Right-click on a device, select ‘Alarm Masking’. See Figure 3-19.

Address of device shown in tab Click to filter on a column (Name or Value or State)

(See Alarm History Window, on page 99 for further information on the History window.)

Note: Masked alarms are shown “grayed-out” in the History window.
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Fig. 3-16: ‘Alarm Masking’ Menu Options

2 Select one masking option from:
• Mask Device - Mask all alarms from a device/unit/frame/service. 
• Mask Device Until Normal - Mask alarms from a device/unit until alarm state is OK 

(‘green’). For example, mask a device/unit until any fault/error is corrected. 
Note: This menu item is grayed-out for devices with an OK Alarm state.

• Mask Device with Tag - Mask a device with a Masking Tag. See Alarm Masking 
Tags. 

• Snooze Device - Mask alarms from a device/unit for a period of time. See Alarm 
Masking Snooze Times.

• Unmask - Unmask a device or a set of tagged devices.

Apply an Alarm-Level Mask
Mask an alarm from a device, from the device’s Alarm List window. See Figure 3-14 on page 
94.

Alarm Masking Tags
A set of device(s) can be masked with a Masking Tag.

Fig. 3-17: Mask a Device with a Masking Tag

Masking Tags are created in the ‘Tools > Options > Monitoring’ dialog from the main menu 
and provide a flexible, multiple and layered masking facility.

Note: Masking or unmasking menu options may be grayed-out in the 
menu.

‘Mask device until 
normal’ is grayed-out 
for devices with OK 
status.
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Fig. 3-18: Tools > Options > Monitoring Dialog

Masking Snooze Times defined

Masking Tags defined
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Alarm Masking Snooze Times
Alarms for a device/unit/frame/service may be masked for a period of time. 

Fig. 3-19: Masking Snooze Times

The selectable masking snooze times are configurable, see ‘Tools > Options > Monitoring’ 
in main menu in Figure 3-18 on page 98.

Alarm History Window

Introduction
The GV Orbit Client Alarm History window can show the history of system-wide alarms and 
status messages which are read from the Event Logging service on the GV Orbit Server. 

A GV Orbit Professional or Enterprise user can:
• Select an event log data-set to use from the event log store.
• Search for messages from a particular time period.

Masking ‘Snooze’ times

Lite Professional Enterprise

 

Note:
The History window is similar to the window shown for Alarm History for 
a Device, on page 94.

Note:
By default, the History window sources event log data from the event log 
store which is set up as default in the Event Logging service. For example, 
the event log for which the Default Index setting is selected.
A user can change the event log data source for an History window . For 
example, change Log Data Source in the Search Parameter dialog.



100

Home Screen GV Orbit Version 2.3.0
View Alarm History for System-wide Alarms User Guide

• Filter what is shown in the pages (for example, to just display minor alarms).

View Alarm History for System-wide Alarms
To view the Alarm History for GV Orbit system-wide alarms:

1 Click the Alarm History icon in the main 
tool bar.

The History window appears in a tab. 
Note: The tab shows no specific device 
address when showing system-wide alarms.

Select the History tab to view it. 

For further information about the Alarm History, refer to Event Log Viewer (Alarm 
History) in the GV Orbit Admin Guide. See Related Documentation, on page 19.

Graphical Routing Workflow 

Introduction
The factory-set Workflow stage shows a graphical workflow for routing system 
configuration and control with clickable icons to access tools through GV Orbit Control.

Note: Log Data Sources: 
A History window sources log data from the GV Orbit system event log store. 
All events are logged by an Event Logging service running on the GV Orbit 
Server (see Simple Custom Monitoring Screen Example, on page 117). 
Depending on a log data-set’s configuration, some and/or all events and 
alarms are logged. A store may be selected as the log data source for display 
in the History window.

Lite Professional Enterprise
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Fig. 3-20: Graphical Routing Workflow Stage - with Icons (1) to (13)

(1)

(2) (3) (4)

(5)

(6)

(8) (9)

(12) (13)

Click on icons (1) to (13) to access routing tools

(7)

(10)

(11)

Click on server icons to access 
landing pages for each GV Orbit Server.

Each icon (1) to (15) is described in 
the Steps for Graphical Routing Workflow Stage Icons 
table, on page 101.

(14) (15)

 Table 3-2: Steps for Graphical Routing Workflow Stage Icons 

Steps relating to icons in Figure 3-20 Graphical Routing Workflow Stage - with Icons (1) to 
(13), on page 101

(1) IP Configuration and Spreadsheet Import 
Access the IP Routing endpoint configuration editing tool or create a new default GV Orbit C&M 
project. See IP Configuration of End Point Devices and Spreadsheet Import, on page 75 for more 
information. See also IP Configuration, on page 793.
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(2) Logical Level Editor
Access logical route editor tool in GV Orbit Control. For the target router:

• Define, review, edit logical routing levels. For example, levels for audio channel(s), video 
channels, SDI video, ancillary data etc.

See Logical Level Editor Tasks, on page 190.

(3) Topology Configurator
Access router topology configurator tool in GV Orbit Control:

• Define router topology with the logical levels. For example, how physical and logical 
devices are arranged in the broadcast facility. 

• Select topology to use.
See Topology Configurator Tasks, on page 199.

 Table 3-2: Steps for Graphical Routing Workflow Stage Icons  (continued)

Steps relating to icons in Figure 3-20 Graphical Routing Workflow Stage - with Icons (1) to 
(13), on page 101
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(4) Logical Device Table
Access the logical devices editor tool in GV Orbit Control:

• Define logical devices in a table.
• Configure levels and IP streams.
• Configure audio shuffled streams and break-away streams.
• Create virtual crosspoints and logical destinations devices.

See Logical Device Table Tasks, on page 241.

(5) Category
Access the Category Configurator tool in GV Orbit Control:

• Manage sources and destinations with groups (or categories) based on type or usage. This 
is useful when there are multiple resources. Categories allow sources/destinations to be 
accessed quickly on a routing control panel.

See Category Configurator Tasks, on page 268.

 Table 3-2: Steps for Graphical Routing Workflow Stage Icons  (continued)

Steps relating to icons in Figure 3-20 Graphical Routing Workflow Stage - with Icons (1) to 
(13), on page 101
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(6) Panel Configurator
Access the Panel Configurator tool in GV Orbit Control:

• Create soft router control panel designs.
• Add buttons and behaviors to a routing control panel.
• Push the design to soft or hard panels.

See Panel Configurator Tasks, on page 275.

(7) GPIO Configurator
Access the GPIO Configurator tool for GPIs and GPOs on supported panels (for example, GPI-1501) 
with GV Orbit Control:

• Add rules for GPIs to trigger events such as a salvo or routing a source to a destination.
• Add rules for GPOs to activate on combinations of conditions.

See GPIO Configurator Tasks, on page 312.

 Table 3-2: Steps for Graphical Routing Workflow Stage Icons  (continued)

Steps relating to icons in Figure 3-20 Graphical Routing Workflow Stage - with Icons (1) to 
(13), on page 101
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(8) Bulk Routing
Access the Bulk Routing Control Panel tool in GV Orbit Control:

• Make routes between sources and destinations.
• Form break-away routes and shuffled routes.
• Execute salvos.

For an introduction to the Bulk Routing Control panel, see Bulk Routing Control Panel, on 
page 109.

(9) Snapshots
Access the Snapshots tab of the GV Orbit Routing Service that runs on the GV Orbit Server. 

• Recall routing snapshots.
• Create and save new snapshots.

Refer to Routing Service in the GV Orbit Admin Guide, specifically the Snapshots Screen. See 
Related Documentation, on page 19.

 Table 3-2: Steps for Graphical Routing Workflow Stage Icons  (continued)

Steps relating to icons in Figure 3-20 Graphical Routing Workflow Stage - with Icons (1) to 
(13), on page 101
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(10) Router Control
Access the Router Control Panel tool in GV Orbit Control:

• Make routes between sources and destinations.
• Create and execute salvos.

See Router Control Tasks, on page 470.

(11) Alias Editor
Access the Alias editor tool in GV Orbit Control:

• Assign aliases to sources and destinations 
(to support shorter length names, other languages, or different production staff needs).

See Alias Editor Tasks, on page 466.

 Table 3-2: Steps for Graphical Routing Workflow Stage Icons  (continued)

Steps relating to icons in Figure 3-20 Graphical Routing Workflow Stage - with Icons (1) to 
(13), on page 101
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(12) System Status
Access the System Status screen of the GV Orbit Control router controllers: 

• Monitor the health of GV Orbit Control router controller(s).
• View device health for a selected topology.
• Manual fail-over, if required.

See System Status Task, on page 457.

(13) Path Manager
Access the Path Manager screen of GV Orbit Control: 

• View source-destination paths of routed streams.
• View Tie-Line usage information, including % bandwidth used.

See Path Manager Tasks, on page 450.

 Table 3-2: Steps for Graphical Routing Workflow Stage Icons  (continued)

Steps relating to icons in Figure 3-20 Graphical Routing Workflow Stage - with Icons (1) to 
(13), on page 101
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(14) Device Manager
The GV Orbit Device Manager service lists and manages the connections to supported 
devices from a GV Orbit system to provide device operating status and information for the 
purpose of device health monitoring. 

See Device Manager in the GV Orbit Admin Guide. See Related Documentation, on page 19.

(15) Channel Manager
The Channel Manager service supports Densité cards such as the XIP-3901-UDC-IF that have 
two independent processing channels. It allows you to easily visualize, manage, and operate 
XIP processing channels as individual devices without you having to know what physical 
device the channel is on. 

See Channel Manager, on page 491. The Channel Manager is available by default in projects 
created in GV Orbit Control version 2.2.0 and above. To add it to projects created before this, 
see Adding Channel Manager to Projects Created before GV Orbit Control Version 2.2.0, on 
page 503.

 Table 3-2: Steps for Graphical Routing Workflow Stage Icons  (continued)

Steps relating to icons in Figure 3-20 Graphical Routing Workflow Stage - with Icons (1) to 
(13), on page 101
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Bulk Routing Control Panel 

Introduction 
The Bulk Routing Control Panel is a built-in router control panel accessible from GV Orbit 
Client. It requires the GV Orbit Routing service to be running on GV Orbit Server(s). IP 
routing or traditional (for example, SDI) routing may be controlled.

More Information on Bulk Routing Panel
For more information, see Chapter 13, Routing Control - XY Routing Panel, on page 591.

Open Bulk Routing Panel
1 Open an existing C&M project and set the GV Orbit Client window size to 1920x1080.
2 Click on the Bulk Routing icon in the 

Graphical Routing Workflow stage. 

A Bulk Routing Panel is shown in a 
window tab in the GV Orbit Client. 
See Figure 3-21.

Lite Professional Enterprise
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Fig. 3-21: Example Bulk Routing Panel

Troubleshooting
If problems are encountered when opening a Bulk Routing Panel, carry out the following 
checks:

1 Check that the project’s Client Domain is set for the GV Orbit system.

(Click Connections -> GVOP in the main menu. 
Set Client Domain to be the system’s ‘Client Domain’ number.)

2 The project’s Routing Address project variable (a RollCall address) should be set to the 
Routing service’s Logging Address. To verify this: 

• To see the project variables, click Project -> Edit Variables in the main menu.
• To see the Routing service’s Logging Address: 

Log into the GV Orbit Server and access the Routing service’s ‘System’ 
configuration screen. (See GV Orbit Server Login, on page 115, and Accessing 
Services Configuration Screens, on page 117.)

Source Grid

Router Control Pane

Destination Grid

Source Levels Grid Destination Levels Grid

Salvos Pane

Filtering boxes to limit items shown, 
see Filtering, on page 547
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To save any changes made to the project settings:
3 Click Project -> Save Project in the main menu to save the project locally.
4 Click Project -> Push to push and save the project to the GV Orbit Server.

Alternative Open Bulk Routing Panel (Network Window)
The Bulk Routing Panel may also be opened from 
the Network window in GV Orbit Client:

1 Display the Network window tree-view (click 
in the main tool bar to toggle displaying 

the window) and expand the tree-view.
2 In the Network window, 

locate the ‘Routing service’ item. 
(The item’s name is the Routing service’s 
“Logging Name”.)

3 Right-click on the Routing service item and 
select Open Panel. 

A Bulk Routing Panel is shown in a window tab 
in the GV Orbit Client. See Figure 3-21 on page 
110.

Bulk Routing Panel - List View
List View is a level-centric view of a Bulk Routing Panel, allowing a user to focus on routing 
to Destination Levels. List View presents all of the destinations in a ‘list’ format; each list 
item is a Destination with all of its Levels.

To access List View mode:
1 Open the Bulk Routing Panel and set the GV Orbit Client window size to 1920x1080.
2 In the Destination Grid’s tool bar, click on the List View icon.

This toggles between 
the normal Bulk 
Routing Panel view and 
the List View mode. 

The List View is shown. 
See Figure 3-22.

Note: A ‘Routing service’ item appears in the GV Orbit Network window 
when a Routing service is running on the connected GV Orbit Server 
and is configured to talk to a router controller.
Bulk Routing Panel ‘Source’ and ‘Destination’ buttons are annotated 
with router port names obtained through the Routing service.

List View icon

Destination Grid
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Fig. 3-22: Bulk Routing Panel - List View

Bulk Routing Panel Information
For further Bulk Routing Panel information, including about List View and about general 
operation, refer to Chapter 13, Routing Control - XY Routing Panel, on page 591.

Routing Snapshots
Snapshots of all routes and crosspoints in a GV Orbit system can be taken and restored from 
the GV Orbit Client with the Routing service configuration screen.

Access Routing Service Screen
1 Go to the GV Orbit Client workflow.wfl Workflow 

window. 
2 Click on the Snapshots icon.

The GV Orbit Server window is shown in a tab.

Click icon to toggle between List View and the normal view

Scrollable list of destinations

Destination Levels Grid

D
es

tin
at
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3 Scroll down the server window on 
the left 
and locate the ‘Services’ section 
and select ‘Routing’.

The Routing service configuration 
screen is shown.

4 Select the ‘Snapshots’ side-tab on 
the left.

The Routing service’s Snapshots 
screen is shown. See Figure 3-23.

Fig. 3-23: Routing Service Snapshots Configuration Screen

To Take a Routing Snapshot
In the Routing service Snapshots screen:

1 Enter a name for the new snapshot.
2 Click Create Snapshot.
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Fig. 3-24: Routing Service Snapshots Configuration Screen

A snapshot of all routes and crosspoints is taken. And the new snapshot appears in the 
list.

Fig. 3-25: New Snapshot Item in List

3 Click Save Changes.

To Recall a Snapshot
In the Routing service Snapshots screen:

1 Find a snapshot in the list and click Recall.

The signal routing and crosspoint settings present when the snapshot was taken are 
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restored.

Fig. 3-26: Recall Snapshot

GV Orbit Server Login

This section describes how to log into a GV Orbit Server from either the GV Orbit Client or 
with a web browser. When logged in, various configurations can be viewed, including 
settings for the GV Orbit services. 

Refer to the Launching and Logging in to GV Orbit Admin Interface in the GV Orbit Admin 
Guide. See Related Documentation, on page 19.

Login From GV Orbit Client
With a GV Orbit C&M project open in GV Orbit Client, to open a GV Orbit Server’s Home 
stage:

1 Either:
• click Project -> URLs in the main menu and select the GV Orbit Server item; or
• click on a server icon in the Workflow stage (for example, Server 1). 

Lite Professional Enterprise

  



116

Home Screen GV Orbit Version 2.3.0
Login from a Browser User Guide

Fig. 3-27: Click on Server Icon in Workflow Stage 

The GV Orbit Server Admin Login screen is then shown. See Figure 3-28 on page 116.

Login from a Browser
To log into a GV Orbit Server from a browser:

1 Enter the IP address of a GV Orbit Client into a web browser (Chrome recommended).

The GV Orbit Server Admin Login screen is shown. See Figure 3-28.

Server Admin Login Screen
For more details about the GV Orbit Server and logging in, refer to the GV Orbit Admin Guide 
in Related Documentation, on page 19.

Fig. 3-28: GV Orbit Server Admin Login Screen
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1 Click Log in.

A login screen is shown.
2 Enter the User ID and Password (the default user ID is ‘admin’ with password ‘admin’). 

Click Login.

The GV Orbit Server Home stage is shown. See Figure 3-1 on page 79.

Accessing Services Configuration Screens
Services should be set up by the GV Orbit system administrator. Services running on the 
GV Orbit Server are configured via their configuration screens accessible from the GV Orbit 
Server Home stage.

For information about the server and services, refer to the GV Orbit Admin Guide. See 
Related Documentation, on page 19.

Logs 

Introduction
Logs are kept for system device status/alarm messages (events) and also for 
applications/services running on the GV Orbit Server. 

• Simple Custom Monitoring Screen Example - In an operating GV Orbit system, GV Orbit 
device/service status, alarm messages and events are logged by a GV Orbit service 
running on a GV Orbit Server. Events etc. are logged to an event log data set. This is set 
up when configuring the Event Logging service on the server. 

• Server Application and Service Log Files - Each application/service running on the 
GV Orbit Server also has a set of log files. 

For further information about the log files, refer to Event Log Setup Screen in the GV Orbit 
Admin Guide. See Related Documentation, on page 19.

Simple Custom Monitoring Screen Example 

Note:
The GV Orbit Client and GV Orbit Control Client installers may also be 
downloaded from the GV Orbit Server Admin Login screen.

Lite Professional Enterprise

 

Lite Professional Enterprise
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Introduction
A simple custom graphical operator screen is presented here. The example describes a 
monitoring screen using a C&M project; device status is monitored by the screen. 

This requires:
• a configured C&M project; 
• a configured GV Orbit Server; and 
• the following minimum GV Orbit services to be running: 

• IP Proxy 
• Log Server 
• Monitoring
• Densité.

Steps:
• Step 1: Create a New Monitoring Screen Schematic, on page 118.
• Step 2: Add Monitoring, on page 120.
• Step 3: Save and Push Project, on page 125.
• Step 4: Run Custom Monitoring Screen, on page 125.

Step 1: Create a New Monitoring Screen Schematic
1 Open the C&M Project and show 

the Project window and the 
Workflow window with the 
Workflow stage.

2 On the workflow stage, 
click on the Screens icon.

The Screens dialog is shown.

Fig. 3-29: Screens Dialog
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3 Click New Screen.

The New Screen dialog is shown.
4 Enter a name for the new screen schematic and click OK.

A new, blank custom screen schematic is created. The new, blank schematic is shown in 
a window tab in GV Orbit Client. See Figure 3-30.

Fig. 3-30: New, Blank Custom Schematic

5 Click the Run Mode tool bar icon to select GV Orbit Client Design Mode. See Figure 3-
31.

Note:
A custom screen schematic is shown in GV Orbit Client; this is the ‘stage’ on 
which the schematic is:

• designed when GV Orbit Client is in Design Mode; and
• run and operated when GV Orbit Client is in Run Mode.

Run Mode icon (Showing project is in Design Mode) Note: Drag ‘handle’ to the right to 
reveal more tool bar icons

Schematic stage
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Fig. 3-31: Run Mode / Design Mode Tool Bar Icon

Step 2: Add Monitoring
A control and monitoring (C&M) screen will monitor items in a system with individual or 
aggregate alarms for a device (or collection of devices), or an individual alarm (or collection 
of alarms). This is quick and easy to achieve with GV Orbit Client. 

Items to be monitored can be dragged onto a C&M screen either from the Network 
window or from an Alarm List window. One or more devices or device alarms can be 
monitored.

Add Monitoring of Devices
For a C&M screen schematic open in GV Orbit Client in Design Mode:

1 Expand the Network window to find a RollCall- or Densité-protocol device to monitor.
2 Drag a device onto the C&M screen schematic, and release. 

At release, GV Orbit Client pops up a list of options. These control what will be created 
from the drag. See Figure 3-32a. 
(Figure 3-32b shows the resulting Run Mode screen appearance, see later steps.)

b) Icon appearance when in Design Mode 

a) Icon appearance when in Run Mode

Click to exit Run Mode

Click to enter Run Mode

Note:
In Design Mode, a project may be edited 
(for example, a video wall may be 
modified). 
In Run Mode, a project monitors log and 
alarm data and displays updated custom 
operator screens in real-time.

Note: A project’s ‘mode’ toggles between Run Mode and Design Mode.
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Fig. 3-32: Drag Device Monitoring onto the Schematic: 
a) Drag on Devices; b) Monitoring Shown when in Run Mode

3 Click ‘Create Single Tally’ in the pop-up options list.

GV Orbit Client then infers a default, graphical Tally widget on the schematic which is 
automatically set up to graphically indicate the overall status of the device when in Run 
Mode.

4 Drag on more devices, as required.

(Figure 3-32b shows what the graphical items may look like in Run Mode.)

This has quickly added simple device alarm state monitoring to the C&M project.

Project is in Design Mode

Selected device

Drag on-screen

a) Drag on Devices 

b) Monitoring Example when in Run Mode

Project is in Run Mode

Pop-up Options

Note: Add Device:
Dragging a device onto the schematic and releasing it on top of an existing 
monitoring Tally widget will add the device to the screen widget, thus 
creating an aggregate alarm.
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Add Monitoring of Alarms
Device alarm monitoring can also be added:

1 Expand the Network window to find a device to monitor.
Then right-click on the device item and select ‘Alarm List’.

The device’s alarms are all shown in a pop-up Alarm List window.
2 Select one or more alarms in the Alarm List window and drag them onto the C&M 

screen schematic, and release. 
(To select more than one alarm item, click on an item to select it, and select more with 
CTRL-click.)

At release, a list of options pops up which will control what will be created from the 
drag. See Figure 3-33.

Fig. 3-33: Drag Alarm Monitoring onto the C&M Screen Schematic

3 Select the pop-up option required.

GV Orbit Client then infers graphical monitoring widget(s) on the schematic which are 
automatically set up to indicate the alarm status.

This has quickly added simple device alarm monitoring to the C&M project.

Note: Pop-up Options:
These pop-up options are described in ‘Drag-On’ Options, on page 123.

C&M project is in Design Mode

Drag on screen

Alarm List window

Selected alarms

Pop-up options:
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When all monitoring widgets have been added, proceed to Step 3: Save and Push Project, 
on page 125.

‘Drag-On’ Options
The pop-up options for creating graphical, on-screen from the ‘drag-on’ item(s) are shown 
in Table 3-3. Figure 3-34b and Figure 3-34c show the result of each option Design Mode 
and in Run Mode respectively.

Note: Add an Alarm:
Dragging an alarm (from the same or from a different device) onto an 
existing monitoring widget will add the alarm to the screen widget.

Note: Right-click Drag:
Right-click dragging will use the last pop-up option selected and will avoid 
you having to select the same pop-up option each time.

Note: Label Style Change:
A text label is difficult to see against a black background. In this case, change 
the label’s appearance by selecting it and changing its ‘Style’ property value, 
see Text Label Style Change, on page 124.

 Table 3-3: ‘Drag-On Options
Option Description

A) Create multiple labels Creates a text label per item.

B) Create multiple tallies Creates a graphical Tally widget per item, to show the individual 
alarm state of each item.

C) Create multiple ‘stateful’ labels Creates a colorful text label per item, where the text color indicates 
each individual alarm state.

D) Create single aggregate tally Creates one graphical Tally widget to show a combined, aggregate 
alarm state of all the dragged-on items.
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Fig. 3-34: Dragged-on Monitoring Options A), B), C), and D) in: 
a) Design Mode; 
b) Run Mode.

Text Label Style Change
When creating a text label with this ‘drag-on’ method, the resulting default label may be 
difficult to see (for example, if against a black background). In this case, change the 
appearance of the text label by changing its ‘Style’ property value, see Figure 3-35a and 
Figure 3-35b.

• Select the label(s) on the schematic.

In the Properties box, click on the Style’-
property’s value (see Figure 3-35a).

A drop-down menu is shown.
• Select a Style value from the drop-down 

menu, for example ‘Solid Caption’.
• Click ‘Yes’ in the dialog that is shown.

The label appearance has been changed (see 
Figure 3-35b).

b) Result of options A), B), C), and D) in Run Mode

A)

B)

C)

D)

a) Result of options A), B), C), and D) in Design Mode

A)

B)

C)

D)

These graphical items show alarm state.
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Fig. 3-35: Changing Text Label Style Property

Step 3: Save and Push Project
When all the required device/alarm monitoring is added to the C&M project screen: 

1 Click Project -> Save Project in the main menu to save the project locally.
2 Click Project -> Push to push the project to the GV Orbit Server repository.

Step 4: Run Custom Monitoring Screen
1 Click the Design/Run Mode tool bar icon to take GV Orbit 

Client out of ‘Design Mode’ and into ‘Run Mode’: 

GV Orbit Client runs the C&M project and gets device status 
information to display on the custom monitoring screen’s 
Lamp widgets, which illuminate red/yellow/green to show 
device status. See Figure 3-36.

b) New Text Label Style 

a) Selected Labels

Icon when in Run Mode
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Fig. 3-36: Simple Custom Monitor Example Running in GV Orbit Client

Device status shown in Network window is reflected 
in the custom monitoring screen

Project in Run Mode

Note: Tally Widget graphics:
The graphics shown by these Tally widgets are:

Shape Alarm Status

Green circle OK

Yellow/amber triangle Minor Warning

Orange inverted triangle Major Warning

Red square Failure/Error

Blue diamond Unknown
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2 To go back to ‘Design Mode’, click the Design/Run Mode icon again.
3 To save the project locally, 

click Project -> Save Project from the main menu.
4 To push the project back to the GV Orbit Server:

• click Project -> Push from the main menu;
• select the project name in the list (it may already be selected/highlighted); and
• click OK.

5 To close the project, click Project -> Close Project .
6 To close the GV Orbit Client application, click Project -> Exit .

Main Menu and Tool Bar Items
This section describes the Home Screen’s main menu items and main tool bar items:

• Main Menu Items
• Main Tool Bar Items

And:
• Common Operations in Graphic Editors

Main Menu Items

• Project Menu, on page 127
• Connections Menu, on page 128
• Tools Menu, on page 129
• Window Menu, on page 130
• Multiviewer Menu Items, on page 130
• Help Menu, on page 131

Project Menu

Note: The main menu items shown depend on the type of GV Orbit project 
open in GV Orbit Client.

 Table 3-4: Project Menu Items 
Menu Item Description

New Project Click to create a new project.

Open Project Click to open an existing, locally-stored project.

Recent Projects Click to see a list of recently opened projects.

Save Project Click to locally save the current project with all recent changes.

Rename Project Click to rename the open project.
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Connections Menu

Close Project Click to close the open project.

Pull Click to pull a project from a repository (on a GV Orbit Server).

Push Click to push a project to a repository (on a GV Orbit Server).

Recent Files Click to see a list of recently opened files.

Save File Click to locally save the open file.

Save File As Click to locally save the open file as a new file.

Close Click to close the open file.

Set Home Click to set the currently open schematic to be the home schematic.

Edit Variables Click to see and edit project variables.

URLs Click to see and access URLs defined in the project. These are 
hyperlinks to webpages that have been configured in the Tools -> 
Options -> Links popup. See Tools Menu, on page 129.

Exit Click to close any project and exit GV Orbit Client.

Note: Setting up GV Orbit server IP address:
When the GV Orbit server IP address is set up (either at the start of a project, 
or in the ‘Connections > GV Server ‘menu), then the ‘RollCall-, ‘Densité-, and 
‘GVOP-Connections’ > menu item settings are automatically filled out and 
applied.

 Table 3-5: Connections Menu Items 
Menu Item Description

GV Server Click to set up project connection to GV Orbit Server.
Note: Setting this up will automatically cause the other settings in the 
‘Connections’ menu to be set up and applied.

Kaleido Click to set up a connection to a Kaleido multiviewer by entering its IP 
Address and the multiviewer is then added to the Network View. See 
Step 7.3.3: Configure Network Window for Kaleido Multiviewers, on 
page 73.

RollCall Click to set up RollCall connection settings and options. 
Network Map: See Step 3.2.1: Network Window Setup For RollCall-
protocol Devices, on page 44.
Connect To: See Step 3.1: Direct Configuration of RollCall-protocol 
Devices, on page 42.
RollCall Control Screen: See Step 3.2.2: View a Device Control Screen - 
RollCall Devices, on page 46.

 Table 3-4: Project Menu Items  (continued)
Menu Item Description
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Tools Menu

Densité Click to configure Densité connection settings. See Step 7.3.3: 
Configure Network Window for Densité-protocol Devices, on page 72.

GVOP Click to set up GV Orchestration Protocol settings. See Step 7.3.2: Client 
Domain Number (Connections -> GVOP), on page 72.

 Table 3-6: Tools Menu Items
Menu Item Description

Options Click to set up options in GV Orbit Client, including:

• Application - Graphical grid settings and font settings.
• Video - Real time video rendering options.
• Launch - Project launch options.
• Remotes - Remote access options.
• Links - Set one or more URLs to be used in the project. 

These are webpages such as the pre-configured GV Orbit 
Server Admin interface. You can add other services that you 
want to be available to be shown in the project.
These links then become available under the URLs button in 
the main toolbar or under the Project -> URLs menu. See Main 
Tool Bar Items, on page 132 and Project Menu, on page 127.

• Pop-ups - Name, size and position of any pop-up windows in 
project.

• Monitoring - Alarm Masking options.
• Map View - Options for C&M project MapView screens, 

including built-in links and alarm state colors.

Fig. 3-37: Tools > Options Dialog from Main Menu

 Table 3-5: Connections Menu Items  (continued)
Menu Item Description
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Window Menu
These menu items apply when more than one window (tab) is open in GV Orbit Client. 
Menu options may be grayed-out if they do not apply.

Multiviewer Menu Items

Multiviewer Menu (Single-Multiviewer Project)

This menu appear for non-clustered, single multiviewer cases.

 Table 3-7: Window Menu Items
Menu Item Description

Next Tab Click to go to the next open window tab. 
Alternatively, press CTRL-Tab.

Previous Tab Click to go to the previous open window tab. 
Alternatively, press CTRL-SHIFT-Tab.

Close All Click to close all window tabs.

List of open tabs Radio-button list:
Click on a list item to go to that windows tab.

 Table 3-8: Multiviewer Menu Items 
Menu Item Description

Properties Click to see multiviewer device information.

Input Alarms Click to enable and configure alarms on each multiviewer input. Alarms 
include video alarms and audio alarms.

Unit Alarms Click to enable and configure specific alarms for the multiviewer 
device. For example, ‘genlock state’.

Input Audio Set up input audio related settings, including: ‘audio metering type’, 
digital audio reference level, audio loudness and phase engines.

Note: The ‘audio metering type’ setting defines:
• the ballistics of all audio metering data generated by the 

device; and 
• the default audio meter scale for graphical Audio Bars 

widgets on the multiviewer’s video wall. 

CAUTION The audio metering data ballistics set up here applies 
globally for the multiviewer device. All audio metering 
data generated by the device will have the same 
ballistics.
A GV Orbit multiviewer project may change an audio 
meter type locally on a video wall tile/schematic which 
locally changes the meter scale only; the audio 
metering data used will still have the global ballistics 
type.



131

GV Orbit Version 2.3.0 Home Screen
User Guide Main Menu Items

Multiviewer Menu (Clustered Multiviewer Project)

This menu appears for clustered multiviewer cases.

Help Menu

Output Audio Set up the audio sources for each of the audio channels in each of the 
multiviewer outputs. Up to eight stereo channels are embedded in 
each output.

Units Select the units published by a Grass Valley Log Server that a 
multiviewer may view.

Download Logs Obtain logs from a multiviewer unit.

Note: The Alarm items are described in the user manual for the MV-8 Series 
multiviewer devices. 
See the MV-8 Series Core Multiviewer User Manual.

 Table 3-9: Multiviewer Menu Items
Menu Item Description

Multiviewer 
Cluster

Click to see multiviewer cluster information.
See Chapter 14 Multiviewer Cluster, on page 653.

 Table 3-10: Help Menu Items
Menu Item Description

About GV Orbit 
Client

Click to see information about GV Orbit Client software.

Grass Valley Home 
Page

Click to go to the Grass Valley web page.

GV Orbit Manual Click to go to the GV Orbit documentation web page.

 Table 3-8: Multiviewer Menu Items  (continued)
Menu Item Description
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Main Tool Bar Items
Tool bar icons implement some main menu functions. 

Fig. 3-38: Main Tool Bar Items

The tool icons shown depend on the type of project open in GV Orbit Client and on the 
editing function being carried out. For example, further Tool Bar items are shown when a 
multiviewer video wall is open. See Main Tool Bar with a Graphic Editor Open.

Main Tool Bar with a Graphic Editor Open
Additional tool bar icons are shown here. See Main Tool Bar Items for the other icons.

Fig. 3-39: Main Tool Bar with a Graphic Editor Screen Open

• New Project
• Open Project
• Save Project
• Save File
• Save File As

• Alarm History Window
• Project Window
• Network Window

(Toggle the display of windows 
in the GV Orbit Client)

• Tools > Options
• Lock/Unlock 

the client 
window

• Pull
• Push

• URL - Go to project 
URLs 

• Home - Go to Home 
schematic

Design Mode / Run Mode 
(shown in Design mode)

Properties window

Dock/Undock the active window

Set the active window to full-screen mode

Display drawing grid

Options 
(Tools > Options in main menu)

Zoom stage screen in/outGraphic Object Alignment Controls

Graphic object layer

Go back/forward a step

Select All
DeSelect All

Cut Copy Paste Delete
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Design Mode / Run Mode
Clicking on the Run Mode / Design Mode tool bar icon toggles between ‘Run’ and ‘Design’ 
modes of GV Orbit Client.

Fig. 3-40: Run Mode / Design Mode Tool Bar Icon

Full-Screen View
The graphical stage area can be viewed in full-screen mode. There are two ways to do this,

To Enter/Leave Full Screen Mode - Short Cut

To enter or to leave the full screen mode, when in a graphical screen:
• Press ALT-Enter.

This toggles full-screen mode on/off.

To View Full-screen
1 Click the Full Screen button ( ).

Fig. 3-41: Main Tool Bar with a Graphic Editor Screen Open

Note: Object selection/deselection operations used in graphic editors in GV 
Orbit Client are described Selection/De-Selection of Objects in 
Graphic Editors, on page 137.

b) Icon appearance when in Design Mode 

a) Icon appearance when in Run Mode

Click to exit Run Mode

Click to enter Run Mode

Note: 
• In Design Mode, a project may be 

edited (for example, a video wall may 
be modified). 

• In Run Mode, a project monitors log 
and alarm data and generates 
display screens in real-time.

Note: The Design Mode / Run Mode tool bar icon may not be shown if 
changing between these modes is not applicable in the screen mode 
of the GV Orbit project shown.

Set the active window to full-screen mode
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To Exit Full-Screen Mode
1 Right-click on the (full) screen and select ‘Full screen’ in the pop-up menu to exit full 

screen mode.

Fig. 3-42: Main Tool Bar with a Graphic Editor Screen Open

Graphic Object Alignment Controls
The graphic object controls are used in most graphical editing screens in GV Orbit Client. 
The controls are grayed out where they are not used.

Fig. 3-43: Graphic Object Alignment Tool Bar Controls

Align Controls

To use an align control in one of the GV Orbit Client’s graphical editor tools:
1 Select a graphical object. (See Figure 3-44a.)

This will be the object that will be aligned to.
2 SHIFT-select one or more further graphical objects. (See Figure 3-44b.)
3 Click on an align control in the main tool bar. 

The alignment is done to the first object selected. (See Figure 3-44c.)

Note: Object selection/deselection operations used in graphic editors in GV 
Orbit Client are described Selection/De-Selection of Objects in 
Graphic Editors, on page 137.

Align on a Grid

Align Controls

Layer controls: Send selected object(s):
• to the front; or 
• to the back.

Place selected object(s) in a central 
position of the stage area.
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Fig. 3-44: Alignment Example

Align on a Grid

Use this control to arrange selected objects (see Figure 3-45a) in a grid arrangement.

In one of the GV Orbit Client’s graphical editor tools:
1 Select all of the graphical objects to be arranged in a grid. (See Figure 3-45b.)
2 Click on the Align to Grid tool icon. (See Figure 3-45b.)

‘Align to Grid’ controls are shown in the Properties box. (See Figure 3-45c.)
3 Set the following ‘Align to Grid’ control values:

• Num Rows - number of rows required in the resulting grid of objects.
(For example, = 3.)

• Row Spacing - number of pixels between rows of the resulting grid. 
(For example, = 50.)

• Col Spacing - number of pixels between columns of objects in the resulting grid.
(For example, =20.)

4 Click Apply. (See Figure 3-45c.)

The object alignment is done to the specified grid. (See Figure 3-44d and Figure 3-44e.)

a) Select an object to align to. b) SHIFT-Select further objects. c) Objects aligned.
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Fig. 3-45: Align to Grid Example

a) Objects

e) Objects (deselected) aligned to a grid.

b) Select objects. Click Align to Grid icon.
c) Align to Grid settings in Properties box

d) Objects aligned to a grid.

Selected objects

Click Align to Grid
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Common Operations in Graphic Editors
• Selection/De-Selection of Objects in Graphic Editors
• Selection Etc. in Groups of Objects
• Selection/De-Selection of Objects in Graphic Editors

Selection/De-Selection of Objects in Graphic Editors
This section outlines actions to select and de-select objects in general in any of the graphic 
editors in GV Orbit Client. For example, in the Wall, Room, Tile, or Screen Editor tools.

 Table 3-11: Object Selection / De-selection in a Graphic Editor
Action Description

Click outside the schematic stage area. Deselect All 

ESC

Click ‘Deselect All’ in main tool bar.

CTRL-A Select All 

Click ‘Select All’ in the main tool bar

Click on an item. Select

ALT-Click on an item. Select an alternative item from a layer-stack 
of items.

Or: 

Select the group of objects that an item 
belongs to.
(For information on groups of objects, see 
Selection Etc. in Groups of Objects, on 
page 138.)

SHIFT-Click on an item. Add an item to the current selection. 

Note: When in a router control panel, 
SHIFT-click selects a contiguous range of 
sources are destination. For example, in the 
Routing Control - XY Routing Panel, in the 
Routing Control - XY Routing Panel, or in the 
XY Routing Sources screen of the MV Cluster - 
Room Editor.

CTRL-Click on an item. Add an item to the current selection when 
in a Room Editor XY Routing Sources 
screen. 

SHIFT-ALT-Click on an item. Add another item to the current selection 
from a layer-stack of items.
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Select All
Select All is accomplished via CTRL-A or by clicking a Select All button when in a graphic 
editor in GV Orbit Client. 

General Select All
The Select All operation generally selects all objects on a wall or tile etc.

Select All in Some Screens of the Room Editor
However, in the Room Editor there is some flexibility built into Select All when in either 
the:

• Design Layout mode; or 
• X/Y Routing mode.

In these Room Editor modes, then Select All is slightly modified:
• if nothing is selected, then 

Select All will select all multiviewer outputs of the video wall.
• if a video tile is selected in a multiviewer output, then 

Select All will select all tiles just belonging to that multiviewer output.

Selection Etc. in Groups of Objects

Grouping Objects Together
Graphical objects can be grouped together:

1 Select the objects. (‘Select’, and ‘SHIFT-select’ to add objects to selection.)
2 Right-click on the selected objects and select ‘Group’. (See Figure 3-46a.)

The objects are grouped together. (See Figure 3-46b.)

SHIFT-Click on an already-selected item. Remove an item from the current selection 

SHIFT-drag-cursor on screen to describe a 
rectangular area. 

Select objects within a rectangular area. 
All objects wholly or partly within the area 
are selected.

 Table 3-11: Object Selection / De-selection in a Graphic Editor
Action Description
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Fig. 3-46: Grouping Objects

Un-Grouping Objects
Graphical objects can be un-grouped:

1 Select the group of objects. 
2 Right-click and select ‘Un-Group’. 

Operations on Groups

a) Selected objects b) Grouped objects

Selected objects Right-click and select ‘Group’

 Table 3-12: Operations on Groups of Objects
Action Description

Select an object.
Hold down Left-click and start to drag, 
and then additionally 
hold down SHIFT to drag into a Group.

Add an object to a Group. 
(Drag into a group.)

ALT-click to select an object in a group, 
and then 
hold Left-click and drag out of group.

Remove an object from a group. 
(Drag out of a group.)
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4Manage Users

Introduction
GV Orbit Client provides user access control to GV Orbit projects. This controls who can 
open a GV Orbit project in GV Orbit Client and what editing or operational actions they may 
perform. Users of a project will require different access to aspects of a project depending on 
their role. 

The GV Orbit Client Manage Users screen enables project user roles and levels of user 
access to be set up and managed. 

When opening a project, a user is prompted for a user name and a password when 
accessing a GV Orbit project. 

Default Admin Username and Password
By default, only an ‘admin’ user is initially configured in a new project. The ‘admin’ user has 
full permissions. 

Default username = admin

Default password = admin
 

Accessing the Manage Users Tab
The Manage Users tab is accessible in several ways:

• From the Workflow Screen.
• From the Project Home Page.
• From the Project Window.

Note: The ‘admin’ user has administrator role permissions which enable all 
operations within GV Orbit Client to be carried out. 
The default ‘admin’ user password should be changed as soon as you 
log in for the first time, How to Change a User Password, on page 158. 

Note: Administrator user passwords should be recorded and kept secure.

Note: The ‘Users’ described here in this chapter are GV Orbit Client users. 
These are not users for the GV Orbit Control application in GV Orbit, 
which utilizes a separate users and user setup. See User Management 
Task, on page 477.
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From the Workflow Screen
To access the Manage Users screen from the GV Orbit Dynamic System Orchestrator 
workflow screen:

1 Click on the ‘User Management’ icon. See Figure 4-1.

The Manage Users tab is opened. See Figure 4-2 on page 143.

Fig. 4-1: Workflow User Management Icon

From the Project Home Page
The Manage Users tab is accessible from a GV Orbit Project Home screen (for example, in a 
multiviewer project): 

1 Start the GV Orbit Client application.
2 Open a (multiviewer) project and log in as an ‘admin’ user.

The GV Orbit Project Home screen is displayed.
3 Click on the large Manage Users icon. See Figure 4-2.

The Manage Users tab is shown. See Figure 4-4 on page 144.

Click User Management icon
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Fig. 4-2: Manage Users icon on Home Screen

From the Project Window
The Manage Users tab is accessible from the GV Orbit Client Project window: 

1 Start the GV Orbit Client application.
2 Open a (multiviewer) project and log in as an ‘admin’ user.
3 Clicking on the icon in the main tool bar ( ) toggles showing the Project window.

In the Project window:
4 Locate the name of the current project and expand the item.
5 Right-click on the ‘db.users’ item and select ‘Open’. See Figure 4-3.

The Manage Users tab is shown. See Figure 4-4 on page 144.

Fig. 4-3: Open Manage Users Tab from Project Window

Manage Users Tab

Manage Users Icon

Current project item, 
expanded in Project window.

Project window icon selected.

Click to 
expand/collapse 
current project item

Right-click on 
‘db.users’ item and 
select ‘Open’.

Note: Managing users:
Ensure that you are logged into the GV Orbit project with 
administrator permissions when managing users.

Note: The logged-in User name is shown in the main tool bar of each GV 
Orbit Client screen.
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Fig. 4-4: Manage Users Tab (‘Roles’ Tab shown)

The Manage Users tab is labeled ‘db.users’ and contains the following ‘sub-tabs’:
• Roles.
• Users.
• Permissions.

A file with the name “db.users” appears in the Project window, see Figure 4-4. 
This file contains encrypted project information, including user name and password details.

Changes to User Information
If a change has been made to settings in any of the Manage Users tabs, 
an asterisk (*) is appended to the “db.users” label. 

Save changes by:
1 Clicking the Save File icon in the GV Orbit Client main tool bar.

Manage Users tab
db.users tab name,
click x to close tab

Click to log out of project and change user

User name shown
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Change Logged-in User
When logged into a project as a user, it is possible to quickly log out and log back in as 
another user.

1 Start the GV Orbit Client application, open a project and log in.

The project opens in GV Orbit Client and the currently logged-in User name is shown in 
the main tool bar.

In the main tool bar:
2 Click the Change User icon ( ).

A Change User dialog is shown. See Figure 4-5.
3 Click Yes to log out and log in (as another user).

Fig. 4-5: User Name and Change Users Icon in Main Tool Bar

Roles Tab
To display the Roles tab in the Manage Users tab:

1 Click on the Roles tab. 

The Roles tab lists the defined user roles for the GV Orbit project with a brief description of 
each, see Figure 4-6. 

Select a listed Role for full role details.

Click Change User icon to log out and change user

Current logged-in User name 
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Fig. 4-6: Roles Tab

The Roles tab allows the roles to be viewed, created and edited; it is used to:
• Add and delete roles - New roles can be created and roles can also be deleted.

See Roles Tab, on page 145. 
• Edit permissions for each role - This defines which operations may be carried out in a 

role with the Permissions pane.
See Edit Role Permissions, on page 151. 

• Edit user roles - This assigns a role to each user name.
See Roles Tab, on page 145. 

Pre-defined User Roles
The following user Roles are configured by default in a new GV Orbit project:

• Administrator - role with all default permissions.
• Supervisor - role as administrator, but no user management role.
• Operator - role limited to read-only access to projects.

Permissions pane

List of defined User roles

Membership pane

Full details for selected Role
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The permissions for each of these roles are listed in Figure 4-7.

Fig. 4-7: Predefined User Role Permissions (Multiviewer project shown): 
a) Administrator; b) Supervisor; c) Operator.

Role Permissions (Permissions Pane)
A role’s permissions are set up in the Permissions pane. 

Permissions are operations that can be carried out on a GV Orbit project in the GV Orbit 
Client application. When applied to a user, they form the user’s privileges, that is, what each 
user is allowed to do.

a) Administrator b) Supervisor

c) Operator
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1 Select the Role in the list in the Roles tab.

Permissions information for the selected Role is shown in the Permissions pane. 
Permissions that are ‘allowed’ for the role and others that are ‘available’ are listed in the 
Permissions pane. See Figure 4-8. 

Fig. 4-8: Permissions (Supervisor Role in a Multiviewer Project Shown)

Note: A default new project’s ‘administrator’ role has permissions to 
add/edit users.

Note: The list of all permissions varies between GV Orbit project types.

 Table 4-1: Permissions - GV Orbit project types Multiviewer (MV)/ IP Routing (IP))

Permission The ability to... Project 
Type

MV IP

Purge ALL Purge all off-line devices. IP

Change multicast options Change automatic multicast assignment options. IP

Export ALL Export settings for all devices. IP

Change flow options Change the options used for automatic flow enabling. IP

Assign device ports Assign ports for a device. IP

Assign ALL ports Assign ports for all devices. IP
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Edit source multicast Edit individual multicast settings for a source flow. IP

Enable flows for source device Enable flows for a source device. IP

Edit port number Edit a port number for a spigot. IP

Edit screens Edit an X/Y Routing screen. Without this permission, 
when you open a MV Cluster Room File, you will be 
taken directly to the X/Y Routing Screen and GV Orbit 
Client will be put into full screen mode. You will only be 
able to switch Rooms, switch Room Layout and switch 
Monitor Layouts.

MV

Edit/create custom screens. IP

Edit device name Edit a device name. IP

Import ALL Import settings for all devices. IP

Disable flows for source device Disable flows for a source device. IP

Edit port name Edit a port name for a spigot. IP

Enable source flow Enable/disable individual source flows. IP

Export device Export settings for a device. IP

Enable flows for all source devices Enable flows for all source devices. IP

Import device Import settings for a device. IP

Device control Enable access to a device’s configuration panel. IP

Device upgrade Enable access to upgrade a device’s firmware. IP

Clear multicast for source device Clear multicast settings for a device. IP

Clear multicast for all source devices Clear multicast settings for all source devices. IP

Assign multicast for source device Assign multicast settings for a source device. IP

Assign multicast for all dest devices Set 1:1 or 1:All routes for all destination devices. IP

Clear multicast for all dest devices Clear multicast settings for all destination devices. IP

Transfer device Transfer settings from one device to another. IP

Edit schematics Modify video wall and tile designs. MV IP

 Table 4-1: Permissions - GV Orbit project types Multiviewer (MV)/ IP Routing (IP))

Permission The ability to... Project 
Type

MV IP
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Import user database Import a user database IP

Clear device ports Clear ports for a device. IP

Disable flows for all source device Disable flows for all source devices. IP

Clear multicast for dest device Clear multicast settings for a destination device. IP

Edit destination multicast Edit individual multicast settings for a destination 
flow.

IP

Assign multicast for dest device Set 1:1 or 1:All routes for a destination device. IP

Assign multicast for all source 
devices

Assign multicast settings for all source devices. IP

Change comms settings Change network domain and change IP interfaces. IP

Purge device Purge an off-line device. IP

Pull from repository Move a project from a product unit to GV Orbit Client.
For example, pulling a project from a multiviewer.

MV

Push to repository Move a project from GV Orbit Client to a product unit.
For example, pushing a project to a multiviewer.

MV

Add/rename/delete files or folders Manage project files and folders. MV

Edit multiviewer properties Edit properties for video wall themes, tiles and walls. MV

Edit multiviewer alarms Create and delete alarms. MV

Add/edit users Manage users and roles. MV

Import themes Import themes into a project from another GV Orbit 
Client project.

MV

Import walls Import walls into a project from another GV Orbit 
Client project.

MV

Import layouts Import wall layouts into a project from an GV Orbit 
Client project.

MV

Import settings Import project settings from another GV Orbit Client 
project.

MV

 Table 4-1: Permissions - GV Orbit project types Multiviewer (MV)/ IP Routing (IP))

Permission The ability to... Project 
Type

MV IP
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Edit Role Permissions
To edit the permissions for a Role:

1 Select a permission on the Permissions pane. See Figure 4-9.
2 Click > or < in the pane to move the selected Permission to/from the set of 

‘allowed’/’available’ permissions for the role.
3 Add/remove permissions as required.

When done:
4 Click Save File icon in the main menu to save changes.

Fig. 4-9: Edit Role Permissions

Assign Users to Roles (Membership Pane)
The Membership pane displays the following for the selected Role:

• User names assigned in the role - These are listed in the “Users in Role” list. 

Import tiles Import tiles into a project from another GV Orbit 
Client project.

MV

Import grids Import grids into a project from another GV Orbit 
Client project.

MV

 Table 4-1: Permissions - GV Orbit project types Multiviewer (MV)/ IP Routing (IP))

Permission The ability to... Project 
Type

MV IP



152

Manage Users GV Orbit Version 2.3.0
How to Delete Roles User Guide

• User names not assigned in the role - These are listed in the “Users not in Role” list. 

To assign a role to a user, in the Roles tab, 
1 Select a Role in the list.

This selects a role to be edited. (See Figure 4-10.)

Fig. 4-10: Selected Role and Membership Pane

To assign a user into a role: 
2 Click on the user name item in the “Users not in Role” list to select an user.

(More than one user may be selected. To deselect an item, click on the selected item.)
3 Click on the < button to add the selected user name(s) to the “Users in Role” list. 

The selected user(s) move from the “Users not in Role” list to the “Users in Role” list.

To remove a user from a role: 
4 Select the user name item in the “Users in Role” list.
5 Click on the > button to remove it from the “Users in Role” list. 

The selected user name moves to the “Users not in Role” list.

Lastly:
6 Save any changes by clicking on the Save File icon in the main menu.

How to Delete Roles 

To delete a Role, in the Roles tab: 
1 Select the Role to be deleted. 

Selected Role
and corresponding Membership pane

Note: A user will lose permissions if they are assigned to a role when the role 
is deleted. Ensure that no users are assigned in any role to be 
deleted. 
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Fig. 4-11: Select a Role for Deletion

2 Review the Role’s user details in the Membership Pane.

Before deleting a Role, there should be no users assigned to that Role.
3 Remove any users from the role using the Membership Pane.
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Fig. 4-12: Remove All Users from the Role

4 Click on the Delete Role button, see Figure 4-13.

A confirmation Delete Role dialog box will appear. 

Fig. 4-13: Delete Role

5 Read the message in the dialog. 
If you wish to proceed, click “Yes” to confirm that the role should be deleted, 
otherwise, click “No”.

The Role is deleted from the Roles tab.
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Fig. 4-14: Deleted Role

6 Save any changes by clicking Save File icon in the main tool bar.

How to Add a Role
New roles can be added. In the Roles tab:

1 Click Add New Role.

A new blank role item is added to the bottom of the roles list in the Roles tab.
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Fig. 4-15: Adding Role

On the right-hand side of the screen:
2 Enter a name for the new role in the Role name text box. Use a short, descriptive name.

(Use characters ‘a’ to ‘z’, ‘A’ to ‘Z’, ‘space’ and ‘0’ to ‘9’.)
3 Enter a brief description of the role in the Description text box. 

The new role’s name and description are shown in the list of roles. 
4 With the new role highlighted, add the permissions required 

- see Role Permissions (Permissions Pane), on page 147. 
5 With the new role still highlighted, assign any users

- see Assign Users to Roles (Membership Pane), on page 151. 
6 Save any changes by clicking Save File icon in the main tool bar. 

A finished new role screen is shown in Figure 4-16.

New blank role item



157

GV Orbit Version 2.3.0 Manage Users
User Guide Users Tab

Fig. 4-16: New Role Added

Users Tab
Click on the Users tab at the top of the Manager Users tab to display the Users Tab tab, 
see Figure 4-17. The users of a GV Orbit project can be viewed, edited and created. 
Users are listed in the main screen area in a graphical Users List - a list of icons.

The Users tab is used to:
• Change the password of an existing user, see How to Change a User Password.
• Add a new user, see How to Add a User.
• Delete an existing user, see How to Delete a User.
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Fig. 4-17: Users Tab 

Pre-defined Users
Initially, in a new GV Orbit project, a user named ‘admin’ is already defined with full 
administrator role permissions. This enables all operations within GV Orbit Client to be 
carried out.

Default username - admin

Default password - admin

The default password for user ‘admin’ should be changed as soon as you log into a new 
project, see section . 

Record the user names and passwords somewhere safe and secure.

How to Change a User Password
In the Users tab:

1 Click on a user icon in the Users List. 

This selects the user to be edited. 
2 Click on the Change button, located below the User name text box.

The change password dialog is displayed. See Figure 4-18.

User Roles list

User Name Change Password buttonUsers List (Icons)Users tab

Note: Keep a record of the administrator user name and password used.
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Fig. 4-18: Change Password Dialogs

3 Enter the original password in the Old password text box, if this is shown.
Enter the new password in both the New password text box 
and also in the Confirm password text box. 

4 Click OK to change the password or click Cancel to abandon the change. 

If a new password has been set, a “Password changed successfully” message is 
displayed; click OK. See Figure 4-19.

Fig. 4-19: Password Changed Successfully Message

5 Save any changes by clicking Save File icon in the main tool bar. 

How to Add a User 
In the Users tab: 

1 Click Add User. 
A new User Icon appears in the graphical Users List. See Figure 4-20.

a) Add Password for a new user
b) Change Password for a user



160

Manage Users GV Orbit Version 2.3.0
How to Add a User User Guide

Fig. 4-20: Adding a New User

2 Enter a name for the new user in the User name text box. 
(Use characters ‘a’ to ‘z’, ‘A’ to ‘Z’, ‘space’ and ‘0’ to ‘9’.)

3 Click on the Change button below the User name text box.

The Set New Password dialog is displayed. 
4 Enter a new password in the New password text box

and re-enter it in the Confirm password text box. 
5 Click OK to set the password, or click Cancel to abandon the change. 

If a new password has been set, 
a “Password changed successfully” message is displayed; click OK. 

6 Set the Control External Id: 
• If this user is to have a User ID when using the GV Orbit Routing service, set the 

Control External Id that they are to use in their NP0017 router control protocol 
communications with GV Orbit Control. 

• So that users with different Control External Ids cannot release a destination 
locked by another user or panel user; in GV Orbit Client, each user can be assigned 
a Control External Id. Users with a different Control External Id cannot release a 
destination locked by another with a different Control External Id. The admin user 
or a user with an Control External Id set to 0 can override locks set by any other 
user.

In all cases, you must ensure that the User IDs are coherent between GV Orbit Client 
and GV Orbit Control. To do this, see Setting a User ID for Lock, Protect, and Release 
with NDAC NP0016 / NP0017 Northbound Interfaces, on page 487.

New User Icon

User name text box

Set/change password button

Control External Id
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7 Save any changes by clicking Save File icon in the main tool bar. 

A new, empty user has been created. 

To assign the user to Role(s), see Assign Users to Roles (Membership Pane), on page 151.

How to Delete a User
In the Users tab:

1 Click on a User Icon in the Users List to select the user to be deleted. 
2 Click on the Delete user button.

A confirmation message dialog box appears. 
3 Click Yes to confirm user deletion, or click No to abandon deleting the user. 

If the user is deleted, the corresponding user icon disappears from the Users List.
4 Save any changes by clicking Save File icon in the main tool bar.

Permissions Tab
The Permissions tab lists the available Permissions with a brief description of each.

Permission types:
• Built-in - By default, a project has built-in Permissions, which are project-type-

dependent. 
• User - Additionally, a user can create custom Permissions for use.

To see the Permissions tab:
1 Click on the Permissions tab in the Manage Users tab to display the Permissions tab.
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Fig. 4-21: Permissions Tab

Custom User Permissions
Custom ‘user’ permissions can be created alongside the existing ‘built-in’ permissions and 
they can be assigned to roles. These allow user access/privileges to be tailored to 
operational needs.

A custom user Permission is automatically given to the ‘administrator’ Role.

Access-control to GV Orbit Client project screens or to on-screen graphical widgets can be 
designed into an GV Orbit Client project using custom ‘user’ permissions.

Add Custom User Permission
In the Permissions tab:

1 Click Add Permission.

A new item is added to the list.
2 Enter a name and enter a brief description for the new custom Permission. See 

Figure 4-22.
3 Save any changes by clicking Save File icon in the main tool bar.
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Fig. 4-22: New Custom User Permission

See Using a Custom User Permission.

Using a Custom User Permission

Permission Properties
In a GV Orbit Client project, a GV Orbit control and monitoring screen can be designed to 
implement access control for:

• GV Orbit Client project screens; or for
• on-screen graphical widgets (for example, buttons).

This is accomplished by utilizing a screen’s or a widget’s ‘Permission’ properties. See 
Figure 4-23.
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Fig. 4-23: Permission Properties (Widget shown)

A user’s ‘Role’, which will include or exclude various permissions, can determine whether a 
logged-in user:

• may use a widget or access screens in a running GV Orbit Client project; and 
• how a widget appears on-screen (disabled or hidden). 

This facility could, for example, control access to a MapView screen with certain 
operationally-sensitive controls and limit them to logged-in users whose role includes a 
certain (custom) permission. 

Access Control Example - MapView C&M Screen
This is a simple, contrived example on a C&M ‘MapView’ screen to demonstrate controlled 
access to a Button widget. 

Button Widget and its ‘Permissions’ properties

 Table 4-2: Widget Permissions Properties 
Property Description

General > Permission Specify the Permission required by the widget user. Select 
from:

• <none> - no Permission required. No access control.
• <inherit> - use the Permission of the parent MapView 

screen/component/widget.
• built-in permissions - list of all built-in Permissions.
• user permissions - list of all custom user Permissions.

General > Permission Type Set how the on-screen widget is affected if logged-in user 
does not have specified Permission:

• Disable - Widget on-screen control is disabled.
• Hidden - Widget is hidden from view.
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In our example:
1 A custom ‘user’ Permission has been defined (‘My Custom Permission’).
2 Four Button widgets have been configured to turn a Lamp widget on/off (see Figure 4-

24):
• Two (green-colored) Buttons control the Lamp widget on/off green. 

The Button widgets do not have any specific Permissions properties set.
• Two (red-colored) Buttons control the same Lamp widget on/off red.

These Button widgets require a logged-in user to have a specific, ‘user’ Permission 
set up.

3 There are two Users set up for this example (see Figure 4-25):
• User ‘admin’ has an administrator Role, which includes all Permissions, ‘built-in’ 

and ‘user’.
• User ‘supervisor 1’ has a supervisor Role which does not include a custom user 

Permission.

When this C&M project is run, the resulting on-screen behavior is shown in Figure 4-26. A 
user without the custom ‘user’ Permission only sees some grayed-out buttons and is unable 
to access them.
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Fig. 4-24: C&M Screen Widget Access Control Example - Buttons

Button widgets without any specific Permission set.

Button widgets with a specific, custom ‘user’ Permission set up.
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Fig. 4-25: C&M Screen Widget Access Control Example - Users:
a) Supervisor;
b) Administrator.

a) supervisor Role, without custom Permission

b) administrator Role, with custom ‘user’ Permission
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Fig. 4-26: C&M Screen Widget Access Control Example - Running:
a) Logged in as ‘administrator’ role;
b) logged in as ‘supervisor’ role.

a) Project run when logged in with ‘administrator’ role

b) Project run when logged in with ‘supervisor’ role

Buttons ‘grayed-out’, user ‘supervisor 1’ has no access to these Buttons.

All Buttons are accessible to the user.
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This chapter describes the following tasks:
• Launching GV Orbit Control, on page 169
• Logging in to GV Orbit Control, on page 169
• Navigating Back to Stage, on page 170
• Switching User Profiles, on page 171
• Viewing Notifications, on page 173

Launching GV Orbit Control
Once GV Orbit Control is installed on your computer, the shortcut icon appears on your 
desktop.

For details on installing GV Orbit Control for the first time, refer to the GV Orbit Admin Guide. 
See Related Documentation, on page 7. 

Logging in to GV Orbit Control
Tip: Before logging in to GV Orbit Control ensure that you have a valid user name and 
password, as well as the Management IP address of GV Orbit Admin.

To log in to GV Orbit Control
1 Click the GV Orbit Control icon on your PC.

The GV Orbit Control login screen appears.

2 Enter your user name and password in the User name and password text boxes.
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3 Enter the Management IP address of the GV Orbit Admin in the Server text box.
4 Click Log in.

Client Server Version Check Warning
A warning is displayed if the GV Orbit Control’s software version is different from the 
software version currently running on the connected server. In this case, it is strongly 
recommended that you download and reinstall the GV Orbit Control’s software from the 
server so that the client and server software versions will match: for details on installing 
GV Orbit Control, refer to the GV Orbit Admin Guide.

If both client and server software versions are the same, no warning will be displayed and 
the GV Orbit Control opens normally.

Click OK to continue to run the client application regardlessly: this can result in software 
crashes, database corruption, or other unexpected behavior. Running mismatched 
software versions is untested and unsupported. Click Cancel to go back to the login screen 
and then close and upgrade your GV Orbit Control.

Navigating Back to Stage
The Stage is the main entry point to configure GV Orbit Control. At any time, you can return 
to the Stage view.

To navigate back to Stage
1 Open GV Orbit Control to any task.
2 Do one of the following:

• Click the Stage tab at the bottom or the UI.
• Click the plus button at the bottom of the UI. 

Tip: The second option is useful, if you have a lot of tasks open.
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The home or Stage view appears.

Switching User Profiles
From the Stage or any open task, you can change to another user profile.

To switch to another user profile
1 Click on the user profile name at the top right of GV Orbit Control.

Note: Before switching to another user profile, ensure that you have the required 
user name, password, and Management IP address.
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A confirmation message appears.

2 Click Log out to continue.
The Log in screen appears.
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3 Enter your login credentials in the User name and Password text boxes.
4 Enter the Management IP address of the GV Orbit server you are connecting to in the 

Server field. 
5 Click Log in.

GV Orbit Control opens to the view applicable to the user.

Viewing Notifications
A notification is an indicator that an event has occurred.

To view your notifications
1 Log in to GV Orbit Control.

Note: Access permissions vary according to the permissions granted to the 
user’s role. For further information, see Administration Tasks, on page 477.
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2 Click on the up arrow in the top right corner of the UI.
The Notification window appears.

3 Expand the System list. The list of new events appears.
4 Click on a listed event on the right to view it in the UI.
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6Configuration Tasks

The Configuration tasks in GV Orbit Control are used for creating and maintaining areas, 
topologies, categories, and panels.

The Configuration Tasks are described under the following headings:
• Area Configurator Tasks, on page 177
• Logical Level Editor Tasks, on page 190
• Topology Configurator Tasks, on page 199
• Logical Device Table Tasks, on page 241
• Category Configurator Tasks, on page 268
• Panel Configurator Tasks, on page 275
• GPIO Configurator Tasks, on page 312
• Stream Configurator Tasks, on page 322
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Required Permissions
Only users who are assigned to the Administrators role have View, Edit, and Delete 
permissions in the Area task. All other configuration tasks are accessible to users with either 
Administrator or Engineer rights only. For more information, see Viewing Permissions by 
Role, on page 484.
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Area Configurator Tasks
The Area Configurator task is used for configuring the Areas and controllers in GV Orbit 
Control.

An Area is container that is used for grouping together a subset of resources within a 
system. Typically, these resources are closely related, by physical location, functionality, 
ownership, and/or logical organization. An area is managed by a single controller group, 
which is made up of:

• a single controller
• or optionally, two redundant controllers to provide 1:1 fail-over protection

This section describes the following:
• Accessing Areas in the GV Orbit Control, on page 177
• Adding an Area, on page 178
• Configuring a Controller Group, on page 179
• Selecting an Area, on page 183
• Deleting an Area, on page 184

Accessing Areas in the GV Orbit Control
All configuration in GV Orbit Control begins by creating one or more areas. Once you have 
the areas defined, you can add the logical levels, the topologies, and so on.

To configure the area in GV Orbit Control
1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select Configuration > Area Configurator.
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The Area Graph appears.

By default, there is one area, called Area. Use the Property Editor on the right to 
rename it and make it easy to identify within your system. 

3 Select the Area to access the Property Editor.
You are automatically in Edit mode. Edit is highlighted in the bar at the top.

4 Enter the required information in the Name, Short Name, Description, and External 
ID fields to identify the area. 

5 Repeat the procedure for each area in your system.

Adding an Area
You can create multiple areas for your system. This can facilitate configuration and control 
tasks. Smaller subsets are easier to bring into focus and manage. 

To add an area
1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select Configuration > Area Configurator. See Accessing Areas in the GV Orbit 

Control, on page 177.
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This opens the Area Graph.

3 Select the area tile on the left.
4 Drag it to the Area Graph.
5 Repeat the procedure as many times as required to add all the areas you require.

Configuring a Controller Group
By default, there is one area and one System Controller group on the Area Configurator 
Device Graph.

A controller group can have one or more areas. The controller is a physical or virtual server 
that runs the GV Orbit software. 

A Controller group can be made up of either one or two controllers. You need two 
controllers to implement redundancy or failover protection. In the redundant 
configuration, one controller is active and the other is on standby. If there is a problem, 
such as a network connection loss, the standby controller becomes the active controller, 
automatically. In addition, you can force the standby controller to become the active 
controller by performing a manual failover operation, at any time.

To configure a controller group
1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select Configuration > Area Configurator. See Accessing Areas in the GV Orbit 

Control, on page 177.

Note: Currently, GV Orbit Control supports one Area. Area inter-connectivity and 
multiple areas (Incoming Feeds, Master Control, Remote Site, Studio, and 
Transmission) are not supported.
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By default, there is one controller and one area on the graph.

3 Select the bubble for the System Controller you are configuring.
4 Select the System Controller Group Properties.

The following properties can be configured for the panel. See also Description of Common 
Device Properties, on page 332.

Parameter Description

Name The name or identifier for this system controller group.

# Controllers Enter 2 in the field if you are setting up redundancy. Otherwise, enter 
1. You can only have one or two system controllers in a group. 

Description An optional description for this system controller group.
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5 Select the Properties tab.
6 Select 1 under System Controller to configure the first controller.

Virtual IP Address This is the virtual IP address to communicate with the active server in a 
GV Orbit Server cluster (when a redundant configuration is used). If a 
GV Orbit Server cluster is not being used, use the GV Orbit Server 
administration IP address for devices instead of this IP Address.
For example, in a cluster configuration, a soft panel can be configured 
to point to this virtual IP address. When a failover happens, control is 
maintained through the panel using this virtual IP address.
See also System Status Task, on page 457 for more information about 
server clusters and failover.

Reference IP Set the IP of a machine that is always on. After a failover the server that 
can connect first to this IP will become the master.

NMOS Discovery DNS GV Orbit Control can automatically discover an NMOS registry through 
DNS-SD when the NMOS Discovery DNS and NMOS Discovery Search 
Domain parameters are set. 
For more information about how to configure and use GV Orbit 
Control’s NMOS registry, see To configure GV Orbit Control for use with 
NMOS, on page 377.

NMOS Discovery 
Search Domain

NMOS Registry This shows the current NMOS Registry Query API URL (hostname / IP 
address and port number).
For more information about how to configure and use GV Orbit 
Control’s NMOS registry, see To configure GV Orbit Control for use with 
NMOS, on page 377.

Domain IDs for IP 
Routing

Only applications / devices that use the same Domain IDs can 
communicate with each other on the network. For a list of such 
devices, see GVOP Devices, on page 206. 
This is a comma separated list of domain IDs on which you want to 
discover devices and communicate with them. The default value for 
Grass Valley equipment is 101.
Valid range: 0 to 232.

Domain IDs for Data 
Import

This is for future use.

Parameter Description
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The following properties can be configured for the individual system controller that form 
the system controller group. See also Description of Common Device Properties, on 
page 332.

7 Select tab 2 under System Controller to configure the second controller.

8 Update the identification fields for the second controller and set the network IP address 
for System Controller 2: see the table above. 
A confirmation message is displayed:

Parameter Description

Name The name or identifier for this system controller instance.

Description An optional description for this system controller instance.

Short Name A nickname used wherever the controller is specified. This name 
should be limited to 8 characters or less in length. This requirement is 
important if you are using NVISION panels as they use the Short Name 
to display device names and NVISION hardware can display a 
maximum of 8 characters for a device name. Otherwise, a longer 
nickname can be used.

IP Address The network IP address for this system controller instance.
This field for System Controller 1 is populated automatically with 
this system controller’s Management IP address. This cannot be 
changed.
When system controller redundancy is used (System Controller 2 is 
available), set the network IP address for System Controller 2.
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9 Click OK to continue.

You can view the health of both controllers on the System Status task. The System Status 
Task page will show the status of the controllers at all times, and the right hand section 
shows the health of devices specific to a topology. However, you must create your areas 
and topologies first. See System Status Task, on page 457.

Selecting an Area
You must select an area before you can create or maintain a topology within it. Only one 
area can be selected at a time. 

To switch from one selected area to another
1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.

The currently selected Area is displayed at the top of the interface.

2 Click on this area.
A secondary window appears.

3 Click on the area that you to select.

Notes

When redundancy has been configured, System Controller 2 joins the Controller 
group automatically as the standby controller. It becomes the active controller in the 
event of an automatic or manual failover. 
When you click OK, the database from Controller 1 is copied to Controller 2

Note: You can perform this procedure from Stage or from any open task. You can 
always select an area.
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In the screen shot above, this is Studio A.
4 Click Select Area at the top of the window.

Deleting an Area

To delete an area
1 Select another Area other than the one you are going to delete. See Selecting an Area, 

on page 183.
2 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
3 Select Configuration > Area Configurator. See Accessing Areas in the GV Orbit 

Control, on page 177.
4 Click on the Area you want to delete.
5 Click Delete  at the top of the logical level editor.
6 A confirmation message appears. It lists the topologies created in the Area.

7 Click OK to continue.

Selecting a Graph
In the Area Configurator, you define the various Areas in your system. Within each Area, you 
can create multiple Graphs, and each Graph contains a Topology. Each topology shows a 
part of how the various physical and logical devices are arranged and interconnected 
within the broadcast facility. 

To work on a topology, you first need to select the Graph in which the Topology is held. You 
can work on only one topology at a time. 

To select a Graph

Note: You cannot delete the currently selected Area. If necessary, make another 
Area active first. See Selecting an Area, on page 183.

Note: A Graph must be created in an area. Then, it is available only in the area where 
it was created.
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1 Select the required Area. See Selecting an Area, on page 183.
2 Click the Graph icon  that holds the currently active topology at the top left of 

GV Orbit Control.

This opens the graphs window. It shows the currently-available graphs for the selected 
Area. Each Graph contains a Topology.

3 Double-click the Graph you want to update or select the Graph you want to update and 
then click Load.

Now, any configuration work you carry out will be on this selected Graph. 

If the topology is new, the Graph is blank. The next step is to begin adding devices. See 
Adding Devices to a Topology, on page 204.
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Creating a new Graph for a Topology
To create a new topology

1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select the required Area. See Selecting an Area, on page 183.

3 Click the Graph icon  that holds the currently active topology at the top left of 
GV Orbit Control.
This opens a secondary window.

4 Click Add .
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The Create New Graph window appears.

5 Enter a name for the new topology and enter meaningful text in the Summary and 
Description fields for easy identification.

6 Click Add on the Create New Graph window.
The new topology appears in the list box with the existing topologies.

7 Select the new topology and click Load. Or double-click the topology.
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The selected topology is opened.

If the topology is new, the Topology is blank. The next step is to begin adding devices. 
See Adding Devices to a Topology, on page 204.

Deleting a Graph
Only inactive graphs / topologies can be deleted. See Making an Active Topology Inactive, 
on page 236. You cannot delete all graphs from GV Orbit Control; at least one graph must 
always be present.

To delete a Graph
1 Select the required Area. See Selecting an Area, on page 183.
2 If you are deleting the active topology, you must first make it inactive. See Making an 

Active Topology Inactive, on page 236.
3 Click the Graph icon  that holds the currently active topology at the top left of 

GV Orbit Control.

This opens the graphs window. It shows the currently-available graphs for the selected 
Area. 
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4 Select the Graph you want to delete and then click Delete.

Deleting the last Graph

You cannot delete all graphs from GV Orbit Control; at least one graph must always be 
present. To delete the last graph, proceed as follows.

1 Create a new graph (see Creating a new Graph for a Topology, on page 186)
2 Make the new graph active (Activating a Topology, on page 235). 
3 Delete the previous graph.
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Logical Level Editor Tasks
Logical levels allow for the definition of compatibility and shuffling rules. This gives you 
complete control of the path definition to prevent routing of incompatible levels. For 
example, Logical levels are used to identify a stream’s video resolution, the number of audio 
channels, ancillary data, and so on. 

Every unique type of stream format in your facility should have a unique Logical Level. 
These levels are then assigned to sources and destinations (in the Logical Device Table; see 
Logical Device Table Tasks, on page 241). This allows GV Orbit Control’ s routing system to 
make takes between sources and destinations with signal types that are compatible with 
each other, and with the underlying hardware, so that takes can be successfully made in the 
real world.

This section describes the following:
• Accessing the Logical Level Editor, on page 190
• Viewing the Default Logical Levels, on page 192
• Duplicating a Logical Level, on page 193
• Editing a Logical Level, on page 195
• Deleting a Logical Level, on page 196
• Configuring a New Logical Level, on page 196
• Configuring the Logical Levels for the Devices in a Topology, on page 197

Accessing the Logical Level Editor
Use the Logical Level Editor to define new logical levels and to view the compatibility of the 
default levels. 

To access the Logical Level Editor Task
1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select an area.
3 Select Configuration > Logical Level Editor.
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The Logical Level Editor appears.

The Logical Level Editor has two columns: 
• The first column contains tiles for all default logical levels along with the logical 

levels you have added.
• The second column has three tabs: compatible with, contains and shuffle with. The 

shuffle with allows a user to configure which audio levels can be shuffled with 
which. See Configuring Virtual Crosspoints (XPTs), on page 257.

Logical Level Editor Menu
The Logical Level Editor menu has the following menu options.

Note: Only users who are assigned to the Administrators or Engineers role in the 
selected area have View, Edit, and Delete permissions in the Logical Level Editor task. 
See Viewing Permissions by Role, on page 484.

Note: Before you can open the Logical Level Editor, you must open an Area and a 
Topology. Logical levels are defined specifically for each topology. 

Icon Description

 Edit Edit a logical level’s properties. See Editing a Logical Level, on 
page 195.

 Duplicate Make a copy of the currently-selected logical level. See Duplicating a 
Logical Level, on page 193.

 Delete Remove the currently-selected logical level. See Deleting a Logical 
Level, on page 196.
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Viewing the Default Logical Levels 
The default logical levels are represented by the first tiles displayed in the Logical Level 
Editor column, beginning with video, then audio, ancillary, and finally AES67. When you 
create new logical levels, they are added after these ones.

You can change the Short Label and Level ID of a default Logical Level, but not the Name. 
Click  Edit to do so. Also, you cannot delete a default level.

The Audio Live device uses AES67 audio levels. See AES Logical Levels that are used for IP 
Audio Streams, on page 436 for more information.

Verifying the Compatibility of the Default Logical Levels 
Compatibility defines which Logical Levels are compatible when making a take. This is 
shown in the Compatible with tab shown below. When a source and destination use the 
same Logical Level, or the two Logical Levels are compatible with each other, then a take is 
possible between the source and destination. 

Certain default Logical Levels are compatible with other Logical Levels. For example, 
AES67-16 is compatible with SDI audio. That is to say, a take between an AES67-16 source 
and an SDI audio destination is allowed by the router system. See also AES Logical Levels 
that are used for IP Audio Streams, on page 436.

When you create a Logical Level, you always modify the compatibility between these 
Logical Levels according to the required source / destination signal types.

To verify the compatibility of Logical Levels
1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select Configuration > Logical Level Editor. See Accessing the Logical Level Editor, on 

page 190.
The Logical Level Editor appears.

3 Select a logical level tile on the left.
The tiles for the logical levels it is compatible with are highlighted in the right column.

Note: A logical level is always compatible with itself.
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Verifying the Component Signal Types of the Default Logical Levels
Like the compatibility, the signal types of the default logical levels is predefined and cannot 
be changed. When you create a Logical Level, you always modify the signal type 
components.

To verify the signal types of the default logical levels
1 Follow the procedure under Verifying the Component Signal Types of the Default 

Logical Levels, on page 193.
2 When you select a tile for a logical level in Logical Level Editor, the compatibility is 

highlighted in the Contains tab.

Duplicating a Logical Level
A pre-existing logical level can be copied to reuse that logical level’s configuration 
properties and then you only need to modify the necessary logical level properties as 
required for the new application.

To duplicate a logical level
1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select Configuration > Logical Level Editor. See Accessing the Logical Level Editor, on 

page 190.
3 Select a pre-existing level on the left-hand panel that you want to duplicate.

4 Click Duplicate  at the top of the interface.

Notes

Logical levels are specific to topologies. In another topology, you won’t see the 
logical levels you create in the currently selected topology.

Only SDI and TICO levels can be duplicated.
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The Logical Level configuration window opens.

5 Enter meaningful names to identify the level in the Name Prefix, Name Suffix, Short 
Label Prefix, and Short Label Suffix text boxes.

6 Enter a unique identifier in the Starting Level ID text box.
7 Click OK.

A tile for your new logical level is displayed in the left hand column.

See Configuring the Logical Levels for the Devices in a Topology, on page 197.

Creating the Logical Levels for a UHD 4K Routing Setup
For an example of how to create the logical levels for UHD routing when a quad-link signal 
path is used, see:

• Configuring UHD 4K Two-Sample Interleave Division IP Streams for use with an IQMix, 
IQUCP, UCP-3901, or IPVU Device, on page 354.

• Configuring UHD 4K Quad-Link SDI Streams for use with an IQMix, IQUCP, UCP-3901, or 
IPVU Device, on page 359. 
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Editing a Logical Level
Use the following procedure to modify a logical level’s identification information. The 
Audio setting marks that the level is an audio level.

To edit a logical level
1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select Configuration > Logical Level Editor. See Accessing the Logical Level Editor, on 

page 190.
3 Select a level on the left-hand panel that you want to edit.

4 Click Edit at the top of the logical level editor.

5 Modify the properties as required.

6 Click OK.

Note: For the default logical levels, you can modify the Short Label and Level ID. You 
cannot modify the Name.

Parameter Description

Name The level’s name.

Short Label A shortened name for the level.

Level ID A unique identifier for this level.

Audio When set, this level will appear in the Shuffle with tab of the right 
pane for shuffling rules. See Configuring Virtual Crosspoints (XPTs), 
on page 257.

# Channels When available, this shows the number of audio channels supported 
by this level. The Audio Live device uses a range of levels, each one 
supporting a different number of audio channels. See AES Logical 
Levels that are used for IP Audio Streams, on page 436 for more 
information. See also Configuring a Device that Supports Audio 
Breakaway/Shuffling such as Audio Live, on page 433.
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Deleting a Logical Level
Use the following procedure to delete a logical level you have created that is no longer 
required in the selected topology.

To delete a logical level
1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select Configuration > Logical Level Editor. See Accessing the Logical Level Editor, on 

page 190.
3 Select the tile for the logical level you want to delete.

4 Click Delete at the top of the logical level editor.

Configuring a New Logical Level
Use the following procedure to configure a new logical level. This determines which signal 
types are compatible with this level.

To configure a new logical level
1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select Configuration > Logical Level Editor. See Accessing the Logical Level Editor, on 

page 190.

Note: You cannot delete the default logical levels. The Delete button is disabled 
when you click on these levels.

Note: There is no confirmation for the deletion.
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3 Select the tile for the logical level you want to configure.

The tile for your new logical level is automatically highlighted in the right hand column.
4 Select the tiles for the signal types in the right hand column that are compatible. Click a 

tile a second time to deselect it.

Configuring the Logical Levels for the Devices in a Topology
Use the following procedure to set the logical levels for the device’s sources and 
destinations in your topology. Logical levels can be used to define the type of signal carried 
on a physical connection between physical devices. If compatibility is not an issue, the 
default logical levels may be utilized. 

To configuring an area in GV Orbit Control
1 Select the required topology in the area. See Accessing the Topology Configurator, on 

page 199. 

2 Select the device for which you want to configure its logical level.
In the above example, the camera bubble is selected. SDI is the default logical level for 
cameras.
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3 Select Device Group Properties.
4 Select the Logical Level parameter in the Property Editor.

This opens the Logical Level list.

5 Select the required logical level for the device group.
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Topology Configurator Tasks
In the Area Configurator, you define the various Areas in your system. Within each Area, you 
can create multiple Graphs, and each Graph contains a Topology. The topologies show how 
the various physical and logical devices are arranged and interconnected within the 
broadcasting facility. See Area Configurator Tasks, on page 177 and Selecting a Graph, on 
page 184. 

These sections describes the following:
• Accessing the Topology Configurator, on page 199
• Selecting a Graph, on page 184
• Refreshing the Topology, on page 202
• Creating a new Graph for a Topology, on page 186
• Adding Devices to a Topology, on page 204
• Methods to Link Devices in a Topology, on page 222
• Defining Device Properties, on page 229
• Deleting a Device From a Topology, on page 234
• Activating a Topology, on page 235
• Making an Active Topology Inactive, on page 236
• Unlocking / Relocking a Topology, on page 238
• Locking an Unlocked Topology, on page 239

Certain devices require a detailed procedure to configure them; see Special Device 
Configuration Tasks, on page 331 for more information about these devices.

Accessing the Topology Configurator
You can access the Topology Configurator from Stage or from any open task. Access 
permissions are required. See also Selecting a Graph, on page 184.

To access the Topology Configurator from Stage
1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select Configuration > Topology Configurator.
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The Topology Configurator appears. The Topology Configurator comprises three 
sections. The left hand column has a list of bubbles, representing the device groups, 
such as cameras, routers, and monitors. You drag these onto to the Topology (middle 
column) and create connections between them. Then, you can configure the 
properties for the Device Groups in the Property Editor (right-hand column).

If an Area is open, the Topology Configurator opens in that area. You can switch areas 
from anywhere in GV Orbit Control. See Selecting an Area, on page 183.

Access Permissions
Access permissions to the Topology Configurator vary according to role. Only users who are 
assigned to the Administrators or Engineers role can View, Edit, and Delete topologies and 
device properties. Operators have the right to view topologies and device properties. 
Maintenance staff and Guests have no access. See Viewing Permissions by Role, on 
page 484.

Topology Configurator Menu

The Topology Configurator has the following menu options.

Icon Description

 Edit Use this editing mode to select a device on the topology to edit its 
properties. See Defining Device Properties, on page 229.

 Select Use this editing mode to select one or more devices on the topology 
(by drawing a square with your mouse cursor) to move the selected 
devices around on the topology as a group, or to delete them. Press 
the <Ctrl> key to temporarily enable this option.
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How to Identify if a Device Bubble is Selected or Not
A device bubble has the following selection states.

 Link Use this editing mode to connect a device’s sources to the destinations 
of another device. See Methods to Link Devices in a Topology, on 
page 222.
This editing mode is also used to break the connection between two 
devices. See Deleting the Connection Between Device Groups, on 
page 228.

 Refresh Reloads the Topology’s contents. See Refreshing the Topology, on 
page 202.

 Delete Remove the currently-selected device from the topology. See Deleting 
a Device From a Topology, on page 234.

 Quick Connect This automatically connects the unconnected ports of devices on the 
topology. See Methods to Link Devices in a Topology, on page 222 and 
Using Quick Connect to Link all Devices in a Topology, on page 222.

 Quick Config This sets the configuration of the selected devices on the topology. 
See Using Quick Config, on page 219.

 Deactivate / Active Activating a topology makes GV Orbit Control connect to and activate 
all drivers to devices in the topology. This is important for GV Orbit 
Control to learn a device’s current configuration.
See Activating a Topology, on page 235 and Making an Active 
Topology Inactive, on page 236.

 Lock / Unlock Lock a Topology to prevent you from inadvertently making edits on an 
active topology. See Unlocking / Relocking a Topology, on page 238 
and Locking an Unlocked Topology, on page 239.

Icon Description

Description Device Bubble State
Device properties are shown in the 

Property Editor

Gray, no white circle Not selected

Gray with white circle Selected

Blue with white circle Selected 
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Refreshing the Topology
If you have added a lot of devices to a topology or made many modifications to it, you may 
need to refresh the Topology. You can refresh topology regardless of whether it is active or 
inactive.

To refresh the Topology
1 Open a topology in the Topology Configurator.

2 Click the Refresh button at the top of the interface.
The topology is inaccessible during the brief time it takes to refresh the window.

Viewing the Topology in Full Screen Mode
By default, the selected topology is displayed in the center of the Topology Configurator 
task. The devices are displayed on the left and the Property Editor is displayed on the right.

To view the topology in fullscreen mode
1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select the required Area. See Selecting an Area, on page 183.
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3 Select the required topology. See Selecting a Graph, on page 184.

4 Click the Fullscreen toggle button at the top of the interface.
The Topology expands across all three columns in the Topology Configurator.

To return to default mode
1 When the Topology is in fullscreen mode, click Fullscreen to toggle the display back to 

the default mode.

TIP
To zoom and center the topology view:
• click the Refresh button.
• double-click an empty space.
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Adding Devices to a Topology
By adding devices to a topology, you are making a representation in GV Orbit Control of the 
real world equipment you are using, and the physical interconnections made between this 
equipment. 

There are two types of devices in GV Orbit Control.
• Virtual Devices: These are devices that GV Orbit Control does not need to know any of 

the device’s configuration parameters in order to use the device. Therefore, the device 
can be offline when configuring it in GV Orbit Control. See Adding a Virtual Device to a 
topology, on page 204. Certain devices may require advanced configuration 
procedures; see Special Device Configuration Tasks, on page 331. 

• Discovered: These are devices that GV Orbit Control needs to know the device’s 
configuration parameters in order to know which of the device’s spigots have been 
configured as sources or destinations, the levels, and so on. These devices must be 
online when configuring them in GV Orbit Control. For more information about 
discovered devices, see About Discovered Devices, on page 205.

Adding a Virtual Device to a topology
Certain Virtual Devices require advanced configuration procedures; see Special Device 
Configuration Tasks, on page 331 for more information about the specific device you are 
adding to the Graph, if necessary.

1 Select the required Area. See Selecting an Area, on page 183.
2 Select the required topology. See Selecting a Graph, on page 184.
3 The topology must be currently:

• Activated (see Activating a Topology, on page 235).
• Unlocked (see Unlocking / Relocking a Topology, on page 238).

4 From the Device Library, Virtual Device on the left, select Virtual Devices from the 
drop-down list.

5 From the Device Library, Virtual Device, find the device that represents a piece of 
equipment you want to control: select the device bubble and drag it into position on 
the Topology and release the mouse button. 
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Initially, the device bubble represents a single device, such as a single camera. However, 
a bubble is a device group that can represent one or more devices. See To name a 
device and set the number of devices in the group, on page 205.

6 Repeat step 5 to and the following procedure (To name a device and set the number of 
devices in the group, on page 205) until you have added all the required devices to the 
topology.

To name a device and set the number of devices in the group

A device group is a collection of devices of the same type that can be configured together. 
All bubbles in a Topology are automatically device groups with the exception of the 
following devices: IPVU, IPG-3901, IPG-4901, IQMIX, IQUCP, UCP-3901, MV-820-IP, Kahuna-IP, 
NMOS devices, Audio Live, IQAMD, Network Switch, Router, and GV Node.

1 Click on the name of the device underneath the bubble to create a device group.
The Device Group configuration window appears.

2 Enter meaningful names to identify the device group in the Name and Short Name 
fields.
In this case, the Camera device group is named CAM1 to identify the cameras 
controlled by Controller 1. These parameters can also be set in the Property Editor.

3 Use the plus and minus buttons to enter the number of device instances are in the 
device group.

4 Click OK.
Each device instance is shown and can be individually configured in the Property 
Editor, under Devices, by clicking an instance.
In the above example, five monitors, two IPGs, two network switches, and five cameras 
have been added to the Topology.

About Discovered Devices
There are two different types of discovered devices: 

• NMOS devices discovered with IS-04, that can be senders, receivers or both. For more 
information, see Adding NMOS Devices to a Topology, on page 377.

• Grass Valley devices discovered with GVOP; see below for a list of these devices. 



206

Configuration Tasks GV Orbit Version 2.3.0
Adding Devices to a Topology User Guide

GVOP Devices

In order to use discovered GVOP devices in GV Orbit Control, the discovered devices must 
first be configured through the GV Orbit Client. GV Orbit Control needs to know the device’s 
configuration parameters in order to know which of the device’s spigots have been 
configured as sources or destinations, the levels, and so on. These devices must be online 
when configuring them in GV Orbit Control. 

The following Devices Use GVOP to be discovered by GV Orbit Control.

When the IP Friendly Name service is running on the GV Orbit Server, and the device uses 
GVOP for Configuration:

• In GV Orbit Control, GVOP device properties are automatically filled in from when the 
devices were configured through GV Orbit Client. Changes to those devices’ properties 
in GV Orbit Client are updated in GV Orbit Control in real time. See Synchronization of 
Discovered GVOP Devices, Source, Destination, and Spigot Names made in GV Orbit 
Client, on page 211 for more information. 

• The device’s current source and destination configuration is read in real time and is 
updated in the Logical Device Table’s Multilevel Table when the Automatic Sources 
and Destinations parameter is set in the device’s properties. See Logical Device Table 
Tasks, on page 241, About Automatic Sources or Destinations, on page 246, Device 
Properties Definitions, on page 232, and Synchronization of Discovered GVOP Devices, 
Source, Destination, and Spigot Names made in GV Orbit Client, on page 211.

• There is no need to use Camera and Monitor devices to create the logical 
sources/destinations for these devices. Furthermore, Camera and Monitor devices are 
not created anymore when using the Quick Connect tool. See Using Quick Connect to 
Link all Devices in a Topology, on page 222.

• Logical sources/destinations are created using the device spigot streams (Video, Audio, 
ANC). There is a logical source for each sender spigot and a logical destination for each 
receiver spigot. 

Discovered Device 
Type For more information, see

IPG-3901 / IPG-4901 Configuring an IPG-3901 / IPG-4901 Device, on page 343

IPVU Configuring an IPVU Device, on page 349

IQMIX Configuring an IQMix, IQUCP, or UCP-3901 Device, on page 352

IQUCP

UCP-3901

MV-820-IP Configuring an MV-820-IP Multiviewer Device, on page 363

Kahuna-IP Configuring a Kahuna IP Production Switcher Device, on page 367

Audio Live Configuring a Device that Supports Audio Breakaway/Shuffling 
such as Audio Live, on page 433

IQAMD Configuring an IQAMD40 Device, on page 446

Other devices that use 
GVOP for 
Configuration

These are devices that can be configured through GV Orbit Client.
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Logical sources/destinations for GVOP devices are created using the audio channels 
from the spigot streams. The device’s spigot configuration must have the Num Audio 
Flows configuration parameter that allow the use of 1, 2 or 4 audio streams.
The device’s Num Audio Flows configuration parameter is configured on the device’s 
Spigot page by connecting to the card’s configuration with GV Orbit Client. See the 
device’s documentation to see if this parameter is supported and how to set it.

This spigot configuration allows the use of 1, 2 or 4 audio flows where the audio 
channels count in GV Orbit Control is accordingly adjusted. The 16 audio channels from 
the automatic logical sources / destinations are accordingly created using the multi 
audio streams / flows set in the card’s configuration. 

Num Audio Flows 
set in the GVOP 
card’s Spigot Effect in GV Orbit Control

1 There is 1 audio stream for the spigot with 16 audio channels which are 
represented in GV Orbit Control by the AES67-16 logical level. In the 
GV Orbit Control GVOP device Properties, the following streams are 
available:
1: SDI, SMPTE ST 2022. In the Logical Device Table, this is represented by 
the SDI column.
2: Video, SMPTE ST 2110-20. In the Logical Device Table, this is 
represented by the V column.
3: Audio AES67-16, SMPTE ST 2110-30. In the Logical Device Table, this is 
represented by the A1 to A16 columns.
7: Ancillary, SMPTE ST 2110-40. In the Logical Device Table, this is 
represented by the ANC column.

2 There are 2 audio streams for the spigot; each stream has 8 audio 
channels which are represented in GV Orbit Control by the AES67-8 
logical level. In the GV Orbit Control GVOP device Properties, the 
following streams are available:
1: SDI, SMPTE ST 2022. In the Logical Device Table, this is represented by 
the SDI column.
2: Video, SMPTE ST 2110-20. In the Logical Device Table, this is 
represented by the V column.
3: Audio AES67-8, SMPTE ST 2110-30. In the Logical Device Table, this is 
represented by the A1 to A8 columns.
4: Audio AES67-8, SMPTE ST 2110-30. In the Logical Device Table, this is 
represented by the A9 to A16 columns.
7: Ancillary, SMPTE ST 2110-40. In the Logical Device Table, this is 
represented by the ANC column.
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In the GV Orbit Control GVOP device Properties, the number, type of streams, and AES67 
Logical Level are updated in real time according to the card’s settings made in GV Orbit 
Client. For example, this screen shows the Properties for a card where the card’s Num 
Audion Flows parameter configured to 1 and as a consequence, the level for the audio 
stream is shown as AES67-16.

In the Logical Device Table, the GVOP device reflects the configuration settings, where 
there is only one audio stream. 

4 There are 4 audio streams for the spigot; each stream has 4 audio 
channels which are represented in GV Orbit Control by the AES67-4 
logical level. In the GV Orbit Control GVOP device Properties, the 
following streams are available:
1: SDI, SMPTE ST 2022. In the Logical Device Table, this is represented by 
the SDI column.
2: Video, SMPTE ST 2110-20. In the Logical Device Table, this is 
represented by the V column.
3: Audio AES67-4, SMPTE ST 2110-30. In the Logical Device Table, this is 
represented by the A1 to A4 columns.
4: Audio AES67-4, SMPTE ST 2110-30. In the Logical Device Table, this is 
represented by the A5 to A8 columns.
5: Audio AES67-4, SMPTE ST 2110-30. In the Logical Device Table, this is 
represented by the A9 to A12 columns.
6: Audio AES67-4, SMPTE ST 2110-30. In the Logical Device Table, this is 
represented by the A13 to A16 columns.
7: Ancillary, SMPTE ST 2110-40. In the Logical Device Table, this is 
represented by the ANC column.

Num Audio Flows 
set in the GVOP 
card’s Spigot Effect in GV Orbit Control
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To add a Discovered device to a Topology, see below. See also AES Logical Levels that are 
used for IP Audio Streams, on page 436.

To add a Discovered Device to a Topology
Discovered devices typically require advanced configuration procedures; see Special 
Device Configuration Tasks, on page 331 for more configuration information about the 
specific device you are adding to the Graph. 

Adding a discovered device to a topology
1 Select the required Area. See Selecting an Area, on page 183.
2 Select the required topology. See Selecting a Graph, on page 184.
3 The topology must be currently:

• Activated (see Activating a Topology, on page 235).
• Unlocked (see Unlocking / Relocking a Topology, on page 238).

4 From the Device Library, on the left, select Discovered from the drop-down list. In the 
example below, an IQMix was discovered on the network.

5 From the Device Library, Discovered find the device that you want to control: select 
the device bubble and drag it into position on the Topology and release the mouse 
button. 
The device pulled from the Device Library, Discovered becomes grayed out and 
another instance of the same device instance cannot be added again to the Topology. 
However, multiple device instances found in the Device Library can be used to create a 
device group. 
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6 To create a device group:
a From the Device Library, Discovered, find the device that you want to control: 

select the device bubble and drag it into position on the Topology and release the 
mouse button. 

b From the Device Library, Discovered, find another identical device that you want 
to control: select the device bubble and drag it on top of the first device instance 
already on the Topology and release the mouse button. 

The two device instances are shown and can be individually configured in the Property 
Editor, under Devices, by clicking an instance.

7 Click on the name of the device underneath the bubble to name the device or device 
group.

These parameters can also be set in the Property Editor when the device bubble is 
selected.
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Using GVOP Devices
As of GV Orbit Control version 2.8.0 or higher, the way devices that use GVOP are 
configured has changed. To identify a device that uses GVOP, see GVOP Devices, on 
page 206. This brings new features such as:

• Tighter integration with GV Orbit Client to:
• Automatically synchronize certain configuration parameters in GV Orbit Control. 
• Allow a spreadsheet import to set many GVOP device parameters in bulk in both 

GV Orbit Client and GV Orbit Control. 
See Synchronization of Discovered GVOP Devices, Source, Destination, and Spigot 
Names made in GV Orbit Client, on page 211.

• Devices that Use GVOP for Configuration no longer use the SDI camera/monitor 
bubble. 

• Logical sources/destinations related to those GVOP devices will be automatically 
created using the spigot name (Port Name), once the configured device is added to the 
topology, even before making the appropriate connections. Those logical 
sources/destinations are created using the appropriate streams. For gateway devices, 
the SDI streams will be used and for IP devices, the IP streams will be used.

• The operating method of any GVOP device configured in GV Orbit Control version 2.7.X 
or earlier will remain unchanged after project migration to version 2.8.0 or higher. 
However, GVOP devices can be migrated to use this new function model of operation. 
See To migrate GVOP Devices for IP routing, on page 218.

Synchronization of Discovered GVOP Devices, Source, Destination, and Spigot 
Names made in GV Orbit Client

When the IP Friendly Name service is running on the GV Orbit Server, this service pushes 
certain configuration parameters made in GV Orbit Client to the same discovered GVOP 
device in GV Orbit Control. Changes to configuration parameters can result from having 
used the spreadsheet import feature in GV Orbit Client. See also GVOP Devices, on 
page 206.

This service uses a common device identifier, the device’s GUID. A device’s GUID is like a 
serial number that uniquely identifies individual GVOP devices. Through a device’s GUID, 
the IP Friendly Name service:

• Provides persistence to the GV Orbit system for the naming of discovered GVOP 
devices. If the IP Friendly Name service is not running, Device and Spigot values from 
the configuration will not be available to GV Orbit Control and in such a case, GV Orbit 
Control will use the default values for device, spigot and logical source/destination 
labels. See Troubleshooting, on page 218. 

• Updates made to GVOP devices in GV Orbit Client are dynamically reflected to those 
same devices in GV Orbit Control topology. 

For example, by setting the device name in GV Orbit Client, the device name of the same 
GVOP device in GV Orbit Control will be updated in real time. 

The intended workflow is to first configure the device in GV Orbit Client and then integrate 
the device for routing in GV Orbit Control.
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When a discovered GVOP device is added to a Topology in GV Orbit Control, and the 
device’s name is subsequently updated in GV Orbit Client, the device name and the Device 
Group name will also be automatically updated. However, once a second or more 
discovered devices have been added to this Device Group, then the name of the Device 
Group will no longer be updated due to changes made in GV Orbit Client to the name of any 
device found in the Device Group. The names of the individual devices, regardless of how 
many of them are in a device group, will always be updated.

Likewise, the device’s current source and destination configuration is read in real time and 
is automatically updated in the Logical Device Table’s Multilevel Table when the Automatic 
Sources and Destinations parameter is set in the device’s properties. For more information, 
see About Automatic Sources or Destinations, on page 246 and Device Properties Definitions, 
on page 232. 

Logical sources and destinations are created using the appropriate streams. For gateway 
devices, the SDI streams will be used and for IP devices, the IP streams will be used.

You can still manually create custom logical sources / destinations using the streams of your 
choice; see Configuring Streams for New Sources / Destinations, on page 249. 
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For gateway devices, the Stream Configurator allows you to expose any stream of your 
choice, including the device’s IP streams. In such a case, the logical sources / destinations 
created using the SDI streams from the same spigot as the exposed IP streams will not be 
reachable anymore by GV Orbit Control’s pathfinding, since the newly exposed IP streams 
become the device’s edge. See Stream Configurator Tasks, on page 322. The following 
diagram shows that when IP streams are exposed, the SDI streams are no longer reachable.

To Configure Device Information in GV Orbit Client

The following device parameter values are pushed from GV Orbit Client to GV Orbit Control. 
As a result, in GV Orbit Control, these parameters are read only. The IP Friendly Name service 
persists this data in the GV Orbit Server. For more information, see About Automatic Sources 
or Destinations, on page 246 and Device Properties Definitions, on page 232.

Note: When replacing a failed GVOP device, you will have to replace the 
device with the new one in the Topology of GV Orbit Control. The swapping 
of a GVOP device for a replacement one is not supported.

GatewayCamera

SDI IP

2022-6
2110-20
2110-30
2110-40

SDI

Gateway Monitor

SDIIP

2022-6
2110-20
2110-30
2110-40

SDI

GV Orbit Control 
Device Property 
(read only)

GV Orbit Client 
Parameter Comment See 

Name Device Name This is the device’s Friendly Name. If no 
friendly name has been set, the device type 
(product's model number) is shown.

To Configure Device 
Information in 
GV Orbit Client, on 
page 213

Network Host Name Host Name

Description Description This is also the Friendly Name value. If the 
Description value is set in GV Orbit Client, 
then this value is used as the description in 
GV Orbit Control. Otherwise, if no friendly 
description has been set in GV Orbit Client, 
the device's product model number is 
shown. 
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Proceed as follows.
1 In GV Orbit Client, open the Devices tab. See also IP Configuration of End Point Devices 

and Spreadsheet Import, on page 75.

2 Identify the device you want to configure.
3 Set the Device Name, Short Name, Host name, and Description parameters for the 

device.

Short Name Short Name If a friendly short name is set in the GV Orbit 
Client, then this is the value set as the short 
name in GV Orbit Control. If no friendly 
short name is set, then the value for this 
GV Orbit Control will be derived from the 
Name parameter.

—

Source and 
Destination
For example, found 
in the Sources / 
Destinations tab of 
the Multilevel Table 
in the Logical 
Device Table. See 
Logical Device Table 
Tasks, on page 241.

The Logical Source / 
Destination gets its 
name as follows:
• The spigot port 

name (if this value 
has been set in 
GV Orbit Client), OR

• The device’s short 
name plus “ . “ plus 
spigot number.

When the Automatic Sources and 
Destinations property is set for a GVOP 
device (this is the default setting, see GVOP 
Devices, on page 206), the name of the 
spigot’s source or destination set in GV Orbit 
Client is applied, when the topology is 
activated (see Activating a Topology, on 
page 235). 

To Configure Source 
and Destination 
Information in 
GV Orbit Client, on 
page 215

GV Orbit Control 
Device Property 
(read only)

GV Orbit Client 
Parameter Comment See 
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This information is immediately updated for the same device in GV Orbit Control.

To Configure Source and Destination Information in GV Orbit Client

The following source and destination spigot parameter values are pushed from GV Orbit 
Client to GV Orbit Control. As a result, in GV Orbit Control, these parameters are read only. 
The IP Friendly Name service persists this data in the GV Orbit Server. For more information, 
see About Automatic Sources or Destinations, on page 246 and Device Properties Definitions, 
on page 232.

These values can be assigned automatically; see To Automatically Assign Port Numbers, 
Short Names, and Port names in GV Orbit Client, on page 216. Proceed as follows.

1 In GV Orbit Client, open the Devices tab. See also IP Configuration of End Point Devices 
and Spreadsheet Import, on page 75.

2 Select the device you want to configure.
3 Select the Spigots tab.

4 Identify the device’s source (Src) and destination (Dst) spigots in Mode. This reflects the 
device’s current configuration.

5 Set the Port Number, Short Name, and Port Name parameter for the spigot.

GV Orbit Control 
Spigot Property 
(read only)

GV Orbit 
Client 
Parameter Comment See 

Name Port Name The name or identifier for this input or output port.
The Port Name in GV Orbit Client is used as the 
label to generate sources and destinations. If no 
value is specified in GV Orbit Client, GV Orbit 
Control will use a combination of device name 
plus spigot number for the sources and 
destinations.

 Short name Short Name This is the spigot name commonly used in the 
GV Orbit Control interface.

Port Number Port Number Uniquely identifies any source or destination 
across all devices. A source and a destination can 
have the same port number. However, two sources 
/ destinations cannot have the same port number. 
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Enter the Port Number FIRST before entering other values. If you try to set a Short 
Name or Port Name parameter for a spigot that doesn't have a Port Number, then the 
value you enter is not saved.
This information is immediately updated for the same device in GV Orbit Control.

To Automatically Assign Port Numbers, Short Names, and Port names in GV Orbit Client
1 Select the Spigots tab.

2 Right-click the device’s name and select Assign Ports. Or click Assign Ports above the 
table to assign ports to all devices.
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3 Set the following parameters in the Assign Port Mappings screen.

Parameter Description

Spigot Selection Select the scope of this screen.
Sources and Destinations: Apply automatic assignment changes to 
both sources and destinations.
Sources: Apply automatic assignment changes to sources only.
Destinations: Apply automatic assignment changes to destinations 
only.

Source Ports / Base 
port number

This tool uses a counter to assign a number to a port. This setting 
allows you to individually set the starting number for the first source 
and destination port from which the count will start.Destination Ports / 

Base port number
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4 Click OK.
This information is immediately updated for the same device in GV Orbit Control.

To migrate GVOP Devices for IP routing

As of GV Orbit Control version 2.8.0 or higher:
• GVOP devices newly added to a Topology will no longer need to be connected to 

Camera and Monitor devices and the logical sources/destinations will be automatically 
created when: the device is added to the topology, the topology is activated, and the 
status of the device’s control port is Online.

• The spigots of these devices can be re-named in GV Orbit Client. See Synchronization 
of Discovered GVOP Devices, Source, Destination, and Spigot Names made in GV Orbit 
Client, on page 211.

GVOP devices configured in GV Orbit Control version 2.7.X or earlier are not automatically 
updated to use this new routing method when a project is migrated to GV Orbit Control 
version 2.8.0 or higher. If you want to use the new behavior available to GV Orbit Control 
version 2.8.0 or higher, then you must manually migrate the devices. 

To migrate GVOP for IP routing, choose one of the following methods.
• Delete The Camera and Monitor linked to the GVOP device and then set the Automatic 

Sources and Destinations parameter in the device’s properties. See Device Properties 
Definitions, on page 232.

• Delete the GVOP device, the associated Camera and Monitor devices and then add only 
the GVOP device back to the Topology.

Troubleshooting

Verify that the IP Friendly Name service is running; if:
• A device’s friendly name disappears from the GV Orbit Client.
• The device Name, Short Name and Network Host Name show the device’s primary IP 

address. 

Assignment Mode Select the way port numbers are assigned:
Synchronize source and dest assignments in discrete blocks: Assign 
port numbers such that the next highest available number is used to 
start numbering the first source and destination ports together in 
unison.
Ad hoc - use next free source or destination port: Separately assign 
port numbers, individually to sources and destinations, in sequence 
such that the next available port number is always used. 

Options Automatically generate the parameter values for port and short 
names.
Create default port names: Set to automatically generate the value in 
the Port Name column as follows: [device name] + [S = source, D = 
destination] + [Port Number]
Create default short names: Set to automatically generate the value 
in the Short Name column as follows: [Port Number] + [S = source, D = 
destination] + [Port Number]

Parameter Description
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Ensure the IP Friendly Name service is installed and running on the GV Orbit Server. Refer to 
Application Maintenance in the GV Orbit Admin Guide. See Related Documentation, on 
page 7. 

Using Quick Config
Quick Config is used to make bulk configuration changes to the selected devices. See How 
to Identify if a Device Bubble is Selected or Not, on page 201. It can:

• Change a device’s logical level.
• Expose or un-expose the device’s streams.

Switches allow the changes to apply only to IP streams, SDI streams, inputs, or outputs. For 
example, Quick Config can be used multiple times: the first time to set the logical level for 
the device’s inputs, and then a second time to set another logical level for the device’s 
outputs.

To set the Quick Config options for the selected devices
1 Select the devices on the Topology you want to configure. 
2 Click  in the Topology Configurator’s toolbar.

3 Set the following options.

Parameter Description

Logical level family Select the logical level to assign to the device’s source and destination 
streams. See also Duplicating a Logical Level, on page 193.
Keep current level: leaves the device’s currently-assigned source and 
destination logical levels untouched.

Expose streams Only certain devices support this property. When Expose Stream is set, 
it displays the streams for this device in the Logical Device Table. See 
Logical Device Table Tasks, on page 241. 

un-expose streams

Set port redundancy Certain third-party devices that support port redundancy are not 
automatically recognized by GV Orbit Control to support redundancy.
When devices have been configured with two or more ports, set this 
option to make the ports redundant in GV Orbit Control. See Setting 
Port Redundancy for Many Devices at Once, on page 220.

Apply to IP streams Set to apply the above settings to IP network connections between 
devices.

Apply to SDI Set to apply the above settings to SDI connections between devices.
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4 Click OK.

Setting Port Redundancy for Many Devices at Once
Redundancy associates a port with another port to create a redundant network traffic flow 
path for failover protection. The associated port will not be available to carry other traffic. 
For example, this is a requirement of a SMPTE ST 2022-7 network topology. See also 
Configuring Network Switch Redundancy to Support SMPTE ST 2022-7, on page 399.

Certain third-party devices that support port redundancy are not automatically recognized 
by GV Orbit Control to support redundancy. For such devices, once they have been 
configured with two or more input / output connectors, use the Set port redundancy 
option in Quick Config (see Using Quick Config, on page 219) to make the ports redundant 
in GV Orbit Control. When completed, the Redundancy Port parameter in the Device 
Properties for in / out 1 is in / out 2 and the Redundancy Port parameter for in / out 2 is in / 
out 1. If there are 4 ports, then the Redundancy Port parameter for in / out 3 is in / out 4 and 
the Redundancy Port parameter for in / out 4 is in / out 3 and so on. 

For more information about Device Properties, see Defining Device Properties, on 
page 229.

Use other Quick Config options to focus the redundancy on the required ports and port 
direction. For example, to make the selected device’s output IP streams redundant, set the 
Quick Config as shown below.

Apply to Inputs/Rx Set to apply the above settings to device destinations.

Apply to Outputs/Tx Set to apply the above settings to device sources.

Parameter Description

Note: This feature is to only be used with third-party devices.
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Once these devices have been configured, use the Stream Configurator to set the IP 
address for a large number of devices in an efficient way. See Stream Configurator Tasks, on 
page 322.

Example of how to set port redundancy for many devices at once

This procedure is an example for the following scenario:
• 100 IP analog-to-digital audio devices have been connected to the network switches 

with redundant connections.
• Each audio device supplies IP outputs for 16 channels of AES67 audio.

This example makes the IP output connections 1 and 2 redundant for each audio device in a 
device group of 100 generic IP Devices.

1 Open the Topology Configurator. See Accessing the Topology Configurator, on 
page 199. 

2 From the Device Library, drag an IP Device onto the Topology Configurator. See Adding 
a Virtual Device to a topology, on page 204.

3 Select the IP Device. See How to Identify if a Device Bubble is Selected or Not, on 
page 201.

4 Set the device group’s properties as follows (see Defining Device Properties, on 
page 229 and Device Properties Definitions, on page 232):

• Set the number of output connections in # Output Connections to 2.
• Set the logical levels for the device in Logical Level to AES67-16. 
• For a SMPTE ST 2110 device with three output streams, set the number of streams 

in # Streams Per Output to 3. 
• Set the logical levels for each of these streams to video, audio, and ancillary 

found under the individual stream properties.
• Set the IP address for each stream (video, audio, and ancillary) found under the 

individual stream properties.
5 Set the number of IP Device instances to 100 and set a name for the devices. See To 

name a device and set the number of devices in the group, on page 205.
6 Click  in the Topology Configurator’s toolbar while the device group is selected. See 

To set the Quick Config options for the selected devices, on page 219.
7 Set the following Quick Config options:

• Set port redundancy
• Apply to IP streams
• Apply to outputs / Tx

8 Click OK.

When complete, the Redundancy Port parameter in the Device Properties for out 1 is out 2 
and the Redundancy Port parameter for out 2 is out 1 for all device instances. The IP 
address for these devices can be efficiently set with the Stream Configurator. See Stream 
Configurator Tasks, on page 322.
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Methods to Link Devices in a Topology
Once two or more devices have been added to the Topology Configurator (see Adding 
Devices to a Topology, on page 204), devices can be linked together using the following 
methods. Using one method does not prevent you from using another method in the 
future. 

Using Quick Connect to Link all Devices in a Topology
Quick Connect automatically connects all unconnected ports of:

• All devices currently in the Topology Configurator when no devices are selected. 
• The currently selected devices in the Topology Configurator.

See How to Identify if a Device Bubble is Selected or Not, on page 201.

When necessary, it reads the device’s configuration to learn:
• Which ports / spigots have been configured as sources or destinations.
• The available IP ports, including control and management ports.

If a NMOS node has been added to the topology and has been configured and is working 
(see Adding NMOS Devices to a Topology, on page 377), Quick Connect will connect the 
NMOS node’s management ports.

Quick connect also automatically connects the link’s physical connection parameters 
(sources and destinations) for each link.

Once more devices have been added to the topology, or if a link has been cut, Quick 
Connect can be run again to automatically connect those devices. Quick Connect will 
ignore pre-existing connections between devices.

Quick Connect has an option to automatically create sources and destinations for SDI 
inputs and outputs. SDI inputs are connected to Camera device groups, and outputs are 
connected to Monitor device groups. As a result, these SDI Camera and Monitor devices 
become available in the Logical Device Table as the device’s inputs and outputs. See Logical 
Device Table Tasks, on page 241.

Linking Method Description See Procedure

Quick Connect Automatically connects all unconnected 
ports of devices currently in the Topology 
Configurator. Quick Connect options can 
limit automatic connections by stream, 
source, or destination type.

Using Quick Connect to Link all 
Devices in a Topology, on 
page 222.

Manual Linking Create the links between devices 
manually. Manual linking allows precise 
control over link parameters.
You must also set the link’s physical 
connection parameters (sources and 
destinations) for each link.

1 Manually Linking the Devices 
in a Topology, on page 224.

2 Manually Setting the Link’s 
Physical Connection 
Parameters (Sources and 
Destinations), on page 225.
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However, as of GV Orbit Control version 2.8.0 or higher, for devices that use GVOP (see 
GVOP Devices, on page 206), the sources and destinations of such a device newly added to 
a Topology will no longer be connected to Camera and Monitor devices by Quick Connect. 
The sources and destinations of the GVOP device become immediately available in the 
Logical Device Table when it is added to the Topology and the topology is activated. See 
Synchronization of Discovered GVOP Devices, Source, Destination, and Spigot Names made in 
GV Orbit Client, on page 211 for more information.

Quick Connect is found in the Topology Configurator’s toolbar.

PREREQUISITES: The following must have been configured: 
• If the system requires physical IP connections to be made, make sure you have at least 

one network switch device in your topology. If your network uses a second network 
switch to support redundancy (for example, to support SMPTE ST 2022-7), then you 
must have at least two network switch devices in your topology. See also Configuring 
Network Switch Redundancy to Support SMPTE ST 2022-7, on page 399.

• Ensure that core devices such as those listed in Special Device Configuration Tasks, on 
page 331 have been added to the topology using drag-and-drop from the Virtual or 
Discovered devices libraries and have been configured before using this tool. For 
example, GV Nodes, IPG-X901, IQMix, IQUCP, UCP-3901 cards, Audio Live, and Routers. 
See Special Device Configuration Tasks, on page 331 for specific configuration 
information about these devices. 

• Add the remaining devices to the topology. See Adding Devices to a Topology, on 
page 204.

• The topology must be currently:
• Activated (see Activating a Topology, on page 235).
• Unlocked (see Unlocking / Relocking a Topology, on page 238).

• All devices must be currently online. That is, no device should be shown in red in the 
System Status. See System Status Task, on page 457.

• The required logical levels have been created. See Accessing the Logical Level Editor, on 
page 190.

Using Quick Connect 

Set the Quick Connect options before using Quick Connect. See Using Quick Config, on 
page 219.

1 Click  in the Topology Configurator’s toolbar.
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2 Set the following options.

3 Click OK.

Manually Linking the Devices in a Topology
Once the device groups are added to the Topology, the next step is to create links between 
them using the Link mode which allows you to link bubbles with a touch-based device. 
Otherwise, if you are using a mouse and keyboard interface, you can link devices together 
using the following procedure while in the Edit mode as well. 

To link devices or device groups in a topology

Open the required topology.
1 Select the required Area. See Selecting an Area, on page 183.
2 Select the required topology. See Selecting a Graph, on page 184.

Parameter Description

Do IP connections Set to automatically create IP network connections between devices.

Main network Select the name of the primary switch in your network.

Backup network If your network uses two network switches to support redundancy (for 
example, to support SMPTE ST 2022-7), then select the name of the 
secondary switch in your network. See also Configuring Network 
Switch Redundancy to Support SMPTE ST 2022-7, on page 399.

Do SDI connections Set to automatically create SDI connections between devices.
As of GV Orbit Control version 2.8.0 or higher, this option no longer 
applies to devices that use GVOP (see GVOP Devices, on page 206). 
See Synchronization of Discovered GVOP Devices, Source, Destination, 
and Spigot Names made in GV Orbit Client, on page 211 for more 
information. Topologies created in a previous GV Orbit Control version 
will not be changed to reflect this new behavior, unless the device is 
added again to the Topology.
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3 Click the Link button at the top of the interface.
4 Select the first bubble in the pair you want to connect.

When the bubble is selected, the device is highlighted in blue and both the bubble’s 
input and outputs ports become available. Input ports are on the left side of the 
bubble. Output ports are on the right side of the bubble. 

5 Select an input or output port on the bubble.
If the input port was selected, the output ports of all the available devices appear. If the 
output port was selected, the input ports of all the available devices appear.

6 Draw a line, with your mouse, between the ports of the two devices to make the 
connection between them. Or if you are using a touch-based device, the Link mode 
allows you to link bubbles together by dragging a bubble over others so that the 
connectors touch each other and then pull them apart to their final position.

Manually Setting the Link’s Physical Connection Parameters (Sources and 
Destinations)
When a link is selected, the Physical Connection Table appears. It is in this table where you 
create the connections between device ports. When you add devices to a Topology and 
you then link two devices, you are indicating that the two devices in two groups are 
virtually connected.   Therefore, you need a place to specify how these devices are actually 
(physically) connected. This is achieved through the Physical Connections Table. It is in this 
table where you will actually specify that port1 of device1 that is part of group1 is 
connected physically with port1 of device1 of group2, for example.

To make a connection, you must start in the Builder tab, and then complete the action in 
the Candidate tab. 

The Physical Connection Table uses connection icons as follows.

Icon State (status) Action

The stream is ready to be connected as it 
has been selected in the Builder tab.

—
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The Physical Connection Table uses port type icons as follows. A source’s output port type 
must be linked to the same input port type at the destination. 

In the Physical Connection Table, more than one table row can be selected at a time; to 
add to a selection, use Shift or Ctrl to select a range of table rows or to add another row to 
the selection.

Builder Tab

The Builder tab shows all the outputs and the inputs available for connections. The output 
streams are shown on the left and the inputs are shown on the right for the selected link. By 
selecting streams in the Builder tab makes them available in the Candidate tab where they 
are then linked. For extra information about an input or output, set Router external labels. 
The Router external labels are only available for router ports and not all device ports.

To associate a device’s output stream to another device’s input
1 Select one or more source output stream table rows that you want to link to 

destination’s input.
2 Drag the source output stream table rows onto the destination input(s).

The selected items become available in the Candidate tab.

The stream is connected. Connect: make the connection between 
the source and destination devices.

— Disconnect: break the connection 
between the source and destination 
devices.

Port Type 
Icon Description

The connection type is SDI.

The connection type is IP.

The connection type is MADI.

Icon State (status) Action
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You can bypass the Candidate tab as follows: you select all your destination, and all your 
sources and then with your right mouse button held down you drag the destinations over 
the sources. With this method, the only way to review your connections is by going into the 
Connected tab and disconnecting the wrong/unwanted ones.

Candidate Tab

Once a device’s output stream has been associated to another device’s input in the Builder 
tab, you can review these associations to then select the ones you want to link together. 

To link a device’s output stream to another device’s input
1 Select one or more table rows that you want to link the source’s output stream to the 

destination’s input.
2 When satisfied with your selection, click Connect at the top of the table.

Connected Tab

This tab shows the currently linked streams between the source’s output and the 
destination's input. Links can be disconnected in this tab.

To disconnect a device’s output stream from another device’s input
1 Select one or more table rows that you want to disconnect the source’s output stream 

to the destination’s input.
2 When satisfied with your selection, click Disconnect at the top of the table.
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Other Tab

This tab will show you all the other connections that a device's ports has on another links. 
For example, you have device1 with 20 ports, 10 are connected to device2 and 10 to 
device3. You select the first link and you connect the 10 ports. You select the second link on 
the Other tab you will see the first 10 ports that you connected. 

Deleting the Connection Between Device Groups
To delete the connection between devices

Open the required topology.
1 Select the required Area. See Selecting an Area, on page 183.
2 Select the required topology. See Adding Devices to a Topology, on page 204.

3 Select the Link button at the top of the interface.
4 Draw a line across the connection.

The scissor icon appears on the line and the link turns red.
5 Release the mouse.

The connection link is removed.
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Defining Device Properties
You set the parameters for the selected device in the Property Editor. 

• The configuration parameters for most devices is intuitive and no further explanation is 
required. See Device Properties Definitions, on page 232 for a primer.

• The configuration of certain devices requires advanced knowledge; see Special Device 
Configuration Tasks, on page 331 for more information about these devices.

Inheritance of Property Values from the Device Group Properties Tab

Certain parameter values in the Device Properties tab inherit their values from the 
corresponding parameter values in the Device Group Properties tab. This allows you to 
configure common parameters for a large number of devices at once with a default value.

When you change the value of a parameter in the Device Properties tab such that it is now 
different from the corresponding value set in the Device Group Properties tab, the 
parameter will be displayed with an orange background. This is shown below.

To define properties for a device
1 Open the required topology. See Selecting a Graph, on page 184.
2 Select the device you want to configure.

Device Properties Tab
Parameter Values

Device Properties Tab
Parameter Values

Device Group Properties Tab
Parameter Values (Default)

Parameter Value 
Inheritance

The parameter’s value is a non-default value 
(indicated by the orange highlight)

Click to reset the parameter’s value back to the 
default value set in the Device Group 
Properties
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The Property Editor is displayed on the right.

In this case, the IPG2 bubble is selected and the Device Group Properties tab is selected 
in the Property Editor.

3 Select the Device Properties tab to view the properties for the individual device. See 
also Description of Common Device Properties, on page 332.
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For example, for the Cameras, there is a Device Group Properties tab for the camera 
group and a Device Properties tab for each of the five cameras.

Camera Device Group Properties

The Device Group Properties tab sets the default parameter values to be passed down to 
each individual device in the Device Properties tab to save time. These default values can 
be overridden in the at the device level in the Device Properties tab. 

Camera Device Properties

Note: All devices, device groups, and connections have properties.
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Device Properties Definitions
This is a non-exhaustive overview of the device properties parameters.

Parameter Description

Namea The name or identifier for this device instance.
The name or identifier for this input or output port.
For devices that use GVOP to configure them, see Synchronization of 
Discovered GVOP Devices, Source, Destination, and Spigot Names 
made in GV Orbit Client, on page 211.

Descriptiona An optional description for the related input, output, or device. For 
devices that use GVOP to configure them, see Synchronization of 
Discovered GVOP Devices, Source, Destination, and Spigot Names 
made in GV Orbit Client, on page 211.

Short Namea The nickname by which the input, output, or device is referred to 
everywhere in the system. For devices that use GVOP to configure 
them, see Synchronization of Discovered GVOP Devices, Source, 
Destination, and Spigot Names made in GV Orbit Client, on page 211.

# Devices The number of device instances in this device group.

Network Host Namea The hostname is the unique name by which the device is known on 
the network. For devices that use GVOP to configure them, see 
Synchronization of Discovered GVOP Devices, Source, Destination, and 
Spigot Names made in GV Orbit Client, on page 211.

Logical Level The logical level for this input or output. Click to change the logical 
level through the Logical Level Selector.

Select a logical level and click OK to change the level.
For more information about logical levels, to create, or modify logical 
levels, see Logical Level Editor Tasks, on page 190.

# Input Connectors The number of physical input port connections made to the device. 

# Output Connectors The number of physical output port connections made to the device. 

# Streams Per Input The typical number of streams available on each physical input 
connection. 

# Streams Per Output The typical number of streams available on each physical output 
connection. 

# Streams The actual number of streams available on the selected physical input 
/ output connection. 
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Port Identifier This is the generic identifier of the port within GV Orbit Control.

IP Address The port’s IP Address.

Automatic Sources 
and Destinations

This parameter is for GVOP devices (see GVOP Devices, on page 206) 
only: set to automatically use the names and the flow type configured 
for sources and destinations for this same device in GV Orbit Client in 
real time when the Topology is activated (see Activating a Topology, 
on page 235). 
This can be set for the device as a whole, or for individual spigots. 
When a GVOP device is newly added to the topology, this parameter is 
now set by default. 
For more information, see Synchronization of Discovered GVOP 
Devices, Source, Destination, and Spigot Names made in GV Orbit 
Client, on page 211 and About Automatic Sources or Destinations, on 
page 246.
For topologies created prior to GV Orbit Control version 2.8.0 or 
higher, this parameter is deselected for all pre-existing GVOP devices. 
If you set this parameter, then connected camera / monitor groups will 
no longer work. See also To migrate GVOP Devices for IP routing, on 
page 218.
When deselected, the streams will be unexposed for the device. You 
can create custom logical sources/destinations by exposing the 
required streams first, using the Stream Configurator. See Stream 
Configurator Tasks, on page 322.

Automatic 
Destination
Automatic 
Destinations on 
Inputs
Automatic 
Destinations on 
Outputs

Set to automatically create a destination by the system for the 
specified streams. See also About Automatic Sources or Destinations, 
on page 246.

Automatic Source
Automatic Sources on 
Outputs
Automatic Sources on 
Inputs

Set to automatically create a source by the system for the specified 
streams. See also About Automatic Sources or Destinations, on 
page 246.

Expose Streams When set, it displays the streams for this device in the Logical Device 
Table. See Logical Device Table Tasks, on page 241. 
The following methosa are available to set or clear this parameter at 
once: 
• Quick Config; see Using Quick Config, on page 219. 
• The Stream Configurator; see Stream Configurator Tasks, on page 322

SSM Address Enabled Shows if the source specific multicast address is enabled. 

Parameter Description
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Deleting a Device From a Topology
You must open a topology in the Topology Configurator before you can delete it.

To delete a topology
1 Select the Area. See Selecting an Area, on page 183.
2 Select the topology. See Selecting a Graph, on page 184.
3 Select the device you want to remove.

The device is highlighted on the Topology.
4 Click Delete.

SDP See Using SDP Parameters to Take a Stream from a non-NMOS Device 
to an NMOS Device, on page 385.

Redundancy Port Associates a port with another port to create a redundant network 
traffic flow path for failover protection. The associated port will not be 
available to carry other traffic. This is usually a requirement of a SMPTE 
ST 2022-7 network topology. 
See also Configuring Network Switch Redundancy to Support SMPTE 
ST 2022-7, on page 399. 
See also Setting Port Redundancy for Many Devices at Once, on 
page 220.

a. When an asterisk (*) is shown, parameter cannot be edited in GV Orbit Control. To edit this value, it 
must be done in GV Orbit Client. For more information about this, see Synchronization of 
Discovered GVOP Devices, Source, Destination, and Spigot Names made in GV Orbit Client, on 
page 211.

Parameter Description
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Activating a Topology
By activating a topology makes GV Orbit Control connect to and activate all drivers to 
devices in the topology. For example, for a GV Node it means initiating the Densité and 
NP0016 connections and being able to control them. By activating a topology, panels will 
become active and light up.

You must select a topology and open it in the Topology Configurator before you can make 
it active.

To make a topology active
1 Select the required Area. See Selecting an Area, on page 183.
2 Select the required topology. See Selecting a Graph, on page 184.

3 Click Active at the top of the Topology Configurator.
A confirmation message appears.

4 Click OK to continue.

Note: Only one topology can be active at a time for each area.
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The following changes occur.

• The topology name is displayed in red at the top of the Topology Configurator.
• A red lightbulb is displayed beside the topology name.
• A red box appears around the topology.
• Active is written on the bar.
• The topology is locked. 
• The red Active bar is displayed on the thumbnail for the active topology.

Making an Active Topology Inactive
Only one topology can be active at a time for each area. You must open the active topology 
in the Topology Configurator before you can make it inactive.

To make an active topology inactive
1 Select the required Area. See Selecting an Area, on page 183.
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2 Select the required topology. See Adding Devices to a Topology, on page 204.

3 Click the Active button at the top of the Topology Configurator.
A confirmation message appears.

4 Click OK to continue.
The following changes occur.

• The topology name no longer appears in red at the top of the Topology 
Configurator.

• The red bar no longer appears at the base of the Topology.
• The topology is unlocked. 
• The red Active bar is no longer displayed on the thumbnail for the active topology 

in the secondary window.
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Unlocking / Relocking a Topology
A topology is locked automatically when you make it active. The lock only affects the 
current GV Orbit Control application. If multiple users have the same topology open, then 
each user can lock/unlock their client to do edits; this setting is not global to all open 
clients.

To unlock an active topology
1 Select the required Area. See Selecting an Area, on page 183.
2 Select the required topology. See Selecting a Graph, on page 184.

This opens the topology in the Topology Configurator.

3 Click the Lock button.
A confirmation message appears.
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4 Click OK to continue.

When a topology is unlocked
• The lock icon is unlocked.
• If you have Edit permissions to the Topology Configurator for the selected area, you 

can modify the active topology.

Locking an Unlocked Topology
It is recommended to relock an unlocked topology, when you have finished your edits. This 
prevents you from inadvertently making edits on an active topology, such as selecting an 
object and pressing delete by accident.

To lock a unlocked active topology
1 Select the required Area. See Selecting an Area, on page 183.
2 Select the required topology. See Selecting a Graph, on page 184.

Note: You can only lock an unlocked active topology. Inactive topologies cannot be 
locked or unlocked.
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This opens the topology in the Topology Configurator.

3 Click the unlocked Lock button at the top of the Topology Configurator.
No confirmation message appears.

The Lock icon switches to the locked state.
No one can edit the topology.
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Logical Device Table Tasks
Use the Logical Device Table task to view and configure the streams for the logical levels. 
Audio shuffling and breakaway can also be configured to create multiple streams with 
different audio channels (for example, for multi-language support). 

The Logical Device Table task is also where you create virtual crosspoints (XPTs) and to 
configure logical destination devices that are related to these virtual XPTs. See Configuring 
Virtual Crosspoints (XPTs), on page 257.

Megasource is a logical source device that is defined with multiple streams, under multiple 
logical levels, that can be routed to a logical destination with at least one matching logical 
level. This allows the definition of a source device with multiple locations in the topology, 
where the destination devices’ logical levels will determine which streams to route. For 
example, you may connect Bars to two different routers, the destination logical level will 
determine which of these two source streams are to be used. This is usually the source 
stream that is local to the destination. Megasource also allows for UHD quad-link sources to 
share a single stream of 16 channel audio and ancillary data with the 4 video streams. See 
Using Megasource, on page 254 for more information.

Accessing the Logical Device Table task
To access the Logical Device Table Task

1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select an area. See Selecting an Area, on page 183.
3 Select a topology. See Selecting a Graph, on page 184.
4 Select Configuration > Logical Device Table.
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The Logical Device Table task appears.

The default streams for your topology, are displayed in the left hand column under 
Stream Browser. 
The following tabs are found in the right hand column under Multilevel Table.

Items in the Multilevel Table may be shown as grayed out and they cannot be edited. 
These devices’ configuration properties come from GV Orbit Client. See 
Synchronization of Discovered GVOP Devices, Source, Destination, and Spigot Names 
made in GV Orbit Client, on page 211.

5 Select the Sources tab to view the streams from the sources.
The Logical Level associated with the source are displayed. For information on the 
logical levels, see Logical Level Editor Tasks, on page 190.

6 Scroll down in the Sources view to see all the levels for the selected source.

Stream Browser / Channel Browser 
The Stream Browser shows all currently available steams. When a stream has two or more 
channels, the Channel Browser gives you access to the individual audio channels in a 
stream thereby allowing you to implement audio breakaway and audio shuffle for 
independent audio routing. See Configuring Streams for New Sources / Destinations, on 
page 249. 

Tab Description

Sources Show the currently configured sources. Sources are the available 
outputs for all the devices on your topology. See Adding a Source or 
Destination to the Logical Level Table, on page 248.

Destinations Show the currently configured destinations. Destinations are the 
available inputs for all the devices on your topology. See Adding and 
Configuring a Destination, on page 254.

Virtual XPTS Show the currently configured virtual crosspoints. See Configuring 
Virtual Crosspoints (XPTs), on page 257.
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To make use of this feature, streams will need to pass through a device that supports audio 
breakaway/shuffling, such as a hybrid router, GV Node, or Audio Live. See Configuring a GV 
Node Device, on page 333 and Configuring a Device that Supports Audio 
Breakaway/Shuffling such as Audio Live, on page 433.

The Stream Browser and Channel Browser menu have the following menu options.

Icon Description

 Select All Selects all items in the Stream Browser. 

 Clear All Deselects all items in the Stream Browser. 

 Channel Browser Shows the Channel Browser (found in the Stream Browser only).

 Show Long 
Names

Toggles between the display of the long name or short name of the 
stream and device names in the Stream Browser, Channel Browser 
and the Multilevel Table.

 Automated 
Sources 

 Automated 
Destinations

Creates all the audio levels in the Multilevel Table for the selected 
streams. See also Configuring an IQAMD40 Device, on page 446 for an 
example of how to use this feature.

Channels per Device

Set how many channels are assigned per logical device when you have 
enabled the Automated Sources or Automated Destinations options.
For example, if you select 64 streams in the channel browser, and you 
set Channels per Device to 16, and then you click the Automatic 
Sources option, it will automatically create 4 logical sources for you. 
The first 16 streams are assigned to A1-16 of the first source, the next 
16 are assigned to A1-A16 of the second source, and so on.
Likewise, if you select 64 streams in the channel browser, and you set 
Channels per Device to 8, and then you click the Automated Sources 
option, it will automatically create 8 logical sources for you. The first 8 
streams assigned to A1-A8 of the first source, the next 8 assigned to 
A1-A8 of the second source, and so on.
Similarly, if you select 64 streams, and set Channels per Device to 2, it 
will create 32 sources.

The Channel Browser shows the 
available audio channels for the 
selected stream

The selected stream

Each audio channel can be 
dragged onto a different level in 
the Multilevel table to shuffle 
the source’s audio

Note: if more than one 
stream is selected in the 
Stream Browser, then the 
Channel Browser shows all 
channels derived from the 
selected streams

Shows detailed information 
about this stream
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Multilevel Table Menu
The Multilevel Table menu has the following menu options.

Filter

Filters the list. Note that the filter operates on the currently shown list 
items according to the Show Long Names setting. 
See Filtering Lists, Table Columns, Sources, and Destinations, on 
page 266.

 Information Shows detailed information about the stream / channel.

Icon Description

 New Creates a new Source / Destination / Virtual XPTS in the Logical Device 
Table. See Adding a Source or Destination to the Logical Level Table, 
on page 248, Adding and Configuring a Destination, on page 254, and 
Configuring Virtual Crosspoints (XPTs), on page 257.

 Delete Removes the currently-selected Source / Destination / Virtual XPTS in 
the Logical Device Table. See Deleting a Source, Destination, or Virtual 
XPTS, on page 256.

 Select All Selects all rows in the Multilevel table.

 Clear All Deselects all rows in the Multilevel table.

 Levels Shows the Logical Level Selector. This allows you to set the logical 
levels that are to be shown in the Multilevel Table.
See Setting the Logical Levels to be Displayed in the Multilevel Table, 
on page 247. 

 Hide automatic 
sources

 Hide automatic 
destinations

Shows or hides automatic sources / destinations in the Logical Device 
Table.

 Virtual 
Destinations

Shows the available destinations available from previously-configured 
virtual XPTS.

 Reset all filters The columns of the Logical Device Table have filters. These buttons 
clear all filters and restores the previous filters.
See Filtering Lists, Table Columns, Sources, and Destinations, on 
page 266.

 Reload all filters 

 Export Exports the Logical Device Table to a CSV file. See Exporting a Logical 
Device Table, on page 257 or Selecting all Devices in the Logical 
Device Table for Export, on page 257.

 Restore default 
label

When a source or destination has been renamed, this resets the name 
to its original label.

Icon Description
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About the Multilevel Table and GVOP Devices
When the following conditions are met, the device's configuration is read from the GVOP 
device in real time and GV Orbit Client automatically creates / updates sources and 
destinations for these GVOP devices in the Logical Device Table's Multilevel Table:

• The device uses GVOP (see GVOP Devices, on page 206), and the Automatic Sources 
and Destinations parameter is enabled in the device’s properties (this is the default 
setting; see Device Properties Definitions, on page 232).

• The device is online.

For example, if the Flow Type for a video flow is assigned to SMPTE2022 in a GVOP device, 
then in the Multilevel Table, this flow appears as an SDI flow for this device and the SMPTE 
ST 2110-20, 2110-30, and 2110-40 flows are not used. Likewise, if an SMPTE ST 2110-30 
audio flow is set to None, then in the Multilevel Table, this flow is no longer applied to the 
audio level for the given source or destination.

In addition, if the IP Friendly Name service is running on the GV Orbit Client Server, the 
custom naming configuration for the device and its spigots1 is read in real time and it 
updates the names and descriptions of the sources and destinations in the Logical Device 
Table's Multilevel Table. 

See also About Automatic Sources or Destinations, on page 246 and Synchronization of 
Discovered GVOP Devices, Source, Destination, and Spigot Names made in GV Orbit Client, 
on page 211.

 Show Redundant 
Streams

For each stream in the Multilevel Table:
• When a source or destination has redundant IP streams (as may be 

the case with an SMPTE ST 2022-7 network for example), for each 
stream in the Multilevel Table, this toggles between the display of the 
IP address for the primary stream and the display of the IP address for 
the secondary stream. 

• When this option is selected, and the stream has a secondary IP 
address to be shown, the stream’s secondary IP address is shown 
with a blue background to identify that the secondary stream’s IP 
address is currently being shown.

Streams that have no redundancy (no secondary IP address) are 
unaffected by this option.

 Refresh Reloads the Logical Device Table’s contents.

Icon Description

1.Custom naming for the device and its spigots is carried out in GV Orbit Client.
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About Automatic Sources or Destinations
Certain sources and destinations are created automatically by GV Orbit Control, such as 
edge devices: cameras, monitors, and so on. Automatic sources or destinations are created 
when the following properties (as applicable) have been set in the device’s property editor:

• Automatic Sources and Destinations
• Automatic Destination
• Automatic Destinations on Inputs
• Automatic Destinations on Outputs
• Automatic Source
• Automatic Sources on Outputs
• Automatic Sources on Inputs

See also Device Properties Definitions, on page 232.

The A icon is shown next to the name for the row in the Multilevel Table to indicate that the 
source or destination was automatically created by GV Orbit Control.

Automatically created sources’ and destinations’ name can be re-named by double-clicking 
the name field. A yellow bar indicates that the name of the source or destination is no 
longer the automatically-generated name. Click  Restore default label to revert back to 
the automatically-generated name.
Such automatically generated sources and destinations have icons to represent the source or 
destination type when shown, for example, in the Panel Configurator, Category Configurator, or 
elsewhere. A key to a few source and destination icons is shown below. These icons are derived 
from the icon used to represent the device in the Device Library and on the Topology 
Configurator. See Adding Devices to a Topology, on page 204.

This yellow bar indicates that the 
name is no longer the automatically-
generated name

Source or destination was 
automatically created by GV Orbit 
Control

Note: You cannot delete a default source from the Logical Level Table. However, you 
can modify the levels associated with the source. Also, you can modify or delete the 
sources that you create.

Icon Description

Camera source

Logical device source

Encoder source

Monitor destination

Default destination for a panel. See Creating a Single-Destination Work Flow 
Panel, on page 297.
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If you try to delete an automatic source or destination from the Logical Device Table, the 
following message is displayed at the bottom of the task.

To remove an automatic source or destination, you must deselect the following properties 
(as applicable) in the device’s Property Editor:

• Automatic Sources and Destinations
• Automatic Destination
• Automatic Destinations on Inputs
• Automatic Destinations on Outputs
• Automatic Source
• Automatic Sources on Outputs
• Automatic Sources on Inputs

Setting the Logical Levels to be Displayed in the Multilevel Table
You can show or hide the Logical Level shown in the Multilevel Table. For example, once 
you have created custom levels in the Logical Table Editor, you might want to show those 
levels while hiding others that are not of interest for the moment. Showing or hiding 
Logical Levels in the Multilevel Table is used to facilitate bulk assignment of sources and 
destinations in the Multilevel Table. See Bulk Assigning Logical Levels in the Multilevel 
Table, on page 253.

To modify the logical levels associated with a source / destination
1 Select a Source / destination in the Logical Device Table. See Accessing the Logical 

Device Table task, on page 241.
2 Click the Logical Levels icon  at the top of the table.

A secondary window opens displaying the levels for the selected source / destination.
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3 Select one or more levels you want to use for the selected source / destination.
4 Click OK.

The columns in the Multilevel Table adjust to show the ones you have selected.

Adding a Source or Destination to the Logical Level Table
By default, the logical device table displays the sources and destinations in the selected 
topology in the Sources and Destinations tabs. You can add a logical device to the table 
that is not on the topology. You would then have the option of switching to the new logical 
device in place of the existing device. 

To add a source or destination to the logical level table
1 Open the logical level table for the required topology.

2 Select the Sources or Destinations tab.
3 Click New  at the top of the Multilevel Table.

A secondary window appears.

4 Enter the required information in the Base Name, Start Index, and Count fields.
5 Click OK.
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New sources / destinations are created. The Base Name is displayed under the Name 
and Description fields. The number of new sources / destinations created corresponds 
to the number you enter in the Count field.

In the example, five new sources are created. The name for each device begins with the 
base name CAM100. A number is appended to the base name. This begins with the 
starting index and increases by one for every number in the count. 

Configuring Streams for New Sources / Destinations
After creating new sources / destinations, the next step is to configure the streams for 
them. Different streams can be assigned to different levels, so that a source / destinations is 
composed of streams from different devices (to do an implicit breakaway). 
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For example, the column you drop a stream on in the Multilevel table selects the part of the 
stream to use to create the logical device. This is shown below for a stream from the Stream 
Browser.

For instance, you could create a source with Video from a GV Node and the audio from an 
IPG-3901, or IPG-4901. You do this by assigning the GV Node stream under the SDI column, 
and the IPG-3901, or IPG-4901 stream under the Audio (A) column. If audio 
breakaway/shuffling is required to complete the path, GV Orbit Control will automatically 
choose a route through Audio Live for example.

Note that some levels are a composite of other levels, for example, dropping an SDI stream 
onto the SDI column will fill all levels as an SDI stream is composed of all levels. This logical 
levels hierarchy is shown below as it applies to each Multilevel Table column.

Stream Drop onto 
Multilevel Table 
Column Description

SDI This fills all levels (video, 16 audio channels (A1 to A16), ANC, and 
V-ANC) with the equivalent levels from the SDI video stream.

V This takes the video level only from the SDI stream. 

A This takes the audio levels only from the SDI or audio stream for all 16 
audio channels (A1 to A16). 

A1 to A16 This takes the first audio channel from the SDI or audio stream.

ANC This takes the ANC level only from the SDI stream. 

V-ANC This takes the V-ANC level only from the SDI stream. 

Video 
Component

Audio 
ComponentsSDI Video 

Audio 
Channel 1

Audio 
Channel 2

Select the row before dropping a source / destination onto it

SDI

V-ANC

V
ANC

A

A1 to A16

SDI or SMPTE ST 2022-6

SMPTE ST 2110-20
SMPTE ST 2110-40

SMPTE ST 2110-30
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LIMITATIONS
• Any shuffling done internally in a card through iControl or RollCall is not taken into 

account by GV Orbit Control and is not controlled by GV Orbit Control. Such shuffling is 
local to the card and this can result in unexpected shuffling should the card’s 
processing path be dynamically assigned by GV Orbit Control to another use or 
destination, where such internal shuffling would be detrimental.

• You cannot shuffle audio to the same destination more than once. For example, the 
same Destination channel is added to a destination from the Channel Browser three 
times. This will not work and must be avoided, as multiple sources cannot be routed to 
the same destination. A destination can only resolve to a single source.

To configure streams for the new sources
1 Open the Logical Device Table for the required topology.

In the left hand column under Stream Browser, the default streams for your topology 
are displayed.

2 Add sources to the Logical Level Table. See Adding a Source or Destination to the 
Logical Level Table, on page 248.

3 Select a source’s row to which you want to add a stream.

Select the row before dropping a source / destination onto it
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4 Drag a stream onto the source. 

In the above image, a stream is added to a source for its video component. Optionally 
drag the same stream or another stream from the Stream Browser to a source to add 
its audio components.

5 To create an audio or video breakaway with this new source or destination, once the 
stream has been assigned to the SDI column, drag another stream from the Stream 
Browser onto the Video (V), Audio (A, A1 to A16), or ANC column to use that specific 
flow component from that second stream.
To indicate that the source / destination is composed of streams from more than one device 
(this includes a video or audio breakaway), the following  symbol is shown with the 
name of the new source / destination. 

Video 
Component

Audio 
Components
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Configuring Streams for Audio Live Audio Channels

When using Audio Live in your topology or a similar device (see Configuring a Device that 
Supports Audio Breakaway/Shuffling such as Audio Live, on page 433), you can:

• From the Stream Browser, drop the main audio stream (never the redundant audio 
stream) onto the audio (A) column. 

• From the Channel Browser, drop one or more audio channels from the stream onto the 
A1 to A16 column(s). To open the Channel Browser, click . See also Stream Browser / 
Channel Browser, on page 242.

Bulk Assigning Logical Levels in the Multilevel Table
The Stream Browser and Channel Browser have filters that allow you to refine the stream 
selection shown. See Filtering Lists, Table Columns, Sources, and Destinations, on page 266. It 
is often possible that by using filtering, streams can be grouped together so that they can 
be dropped in bulk onto the Multilevel Table, on a row or a column. 

• To bulk drop streams on to a row, select one row first and then select two or more 
streams to drop onto the row.

• To bulk drop streams on to a column, select two or more rows first and then select two 
or more streams to drop onto the column.

Video 
Component

Audio 
ComponentsSDI Video 

Audio 
Channel 1

Audio 
Channel 2

Select the row before dropping a destination onto it
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Adding and Configuring a Destination
The procedures for adding and configuring destinations are the same as for adding and 
configuring sources. For details, see Setting the Logical Levels to be Displayed in the 
Multilevel Table, on page 247, Adding a Source or Destination to the Logical Level Table, on 
page 248, Configuring Streams for New Sources / Destinations, on page 249, and Bulk 
Assigning Logical Levels in the Multilevel Table, on page 253.

Destinations have the IP Clean Switch option which enables the routing of an IP source to a 
local GV Node destination for a vertically accurate switch.

Using Megasource 
Megasource changes GV Orbit Control’s pathfinding rules to match exact logical levels 
before applying best match logic. This allows you to create logical sources where the same 
or different streams can be added to the logical level columns that share the different 
custom logical levels. Megasource only applies to sources with multiple stream/level 
pairings and the filtering happens when a normal destination is used in a route. 

When doing a take, the GV Orbit Control’s pathfinding algorithm will attempt to find an 
exact level match between the logical source and the logical destination. Failing to find an 
exact match, it attempts to find a compatible level match as it currently does. If there is 
more than one possible compatible match (ambiguous take), it will fail the take because we 
don't know which stream should be used on the logical destination.

Note that a UHD 4K take is a subset of this feature where there are four SDI levels per logical 
source and logical destination (one SDI level for each quad-link or two-sample interleave 
division substream component). See Creating the Logical Levels for a UHD 4K Routing 
Setup, on page 194 for more information.

For example, you have three SDI signals from the same source. One signal is full resolution 
1080p video, the second signal is 720p video, and the third is 480p video. One destination is 
for the full resolution 1080p video, the second destination is for the 720p video, the second 
destination is for the 480p video, where the destination devices’ logical levels will 
determine which streams to route.
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The following is an example of how to do this. 

Using Megasource
1 Create the following Topology to use for this example. See Adding Devices to a 

Topology, on page 204.

2 Create three copies of the SDI Logical Level called SDI-A, SDI-B, and SDI-C in the 
Logical Level Editor. See Duplicating a Logical Level, on page 193.

3 Click  in the Multilevel Table, Sources tab, of the Logical Device Table to hide the 
automatically-generated sources. See Multilevel Table Menu, on page 244. 

4 Click  in the Multilevel Table, Sources tab, of the Logical Device Table to create a 
new source (shown in this example as Megasource). See Adding a Source or Destination 
to the Logical Level Table, on page 248. 

5 In the Logical Device Table, select a source’s row to which you want to add the streams. 
See To configure streams for the new sources, on page 251.

6 From the Stream Browser of the Logical Device Table, drag the three source streams 
onto the Multilevel Table. The first stream represents 1080p video, the second stream 
represents is 720p video, and the third stream represents 480p video.

7 Click  in the Multilevel Table, Destinations tab, of the Logical Device Table to hide 
the automatically-generated destinations. See Multilevel Table Menu, on page 244. 

Select a row before dropping 
the streams onto it
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8 Click  in the Multilevel Table, Destinations tab, of the Logical Device Table to 
create new destinations, one for each level (1080p, 720p, and 480p video). See Adding a 
Source or Destination to the Logical Level Table, on page 248. 

9 In the Logical Device Table, select the first source’s row to which you want to add the 
streams. 

10 From the Stream Browser of the Logical Device Table, drag the first destination stream 
onto the Multilevel Table. 

11 In the Logical Device Table, select the second source’s row to which you want to add 
the streams. 

12 From the Stream Browser of the Logical Device Table, drag the second destination 
stream onto the Multilevel Table. 

13 In the Logical Device Table, select the third source’s row to which you want to add the 
streams. 

14 From the Stream Browser of the Logical Device Table, drag the third destination stream 
onto the Multilevel Table. 

15 Test the configuration by making takes between a logical source and destination that 
use the Megasource source. See Performing a Take in Router Control, on page 471. See 
in Pathfinder that the correct source resolution is received by each destination. See 
Viewing Information about the Destinations, on page 454.

Deleting a Source, Destination, or Virtual XPTS
You can delete any source, destination, or virtual XPTS that you have created.

To delete a source, destination, or virtual XPTS
1 Open the Logical Device Table task for the required topology.
2 Select the Sources tab, the Destination tab, or virtual XPTS tab according to what you 

are deleting.
3 Select the sources, destinations, or virtual XPTS in the table.

4 Click the Delete icon .

Select the row before dropping a destination onto it

Note: You can delete one or more sources or destinations at the same time.
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Exporting a Logical Device Table
You can export the data in your logical device table in a csv file.

To export a logical device table
1 Open the Logical Device Table task for the required topology.
2 Select the rows you want to export.
3 Click the Export icon .
4 Navigate to the folder where you want to save the file.
5 Click Save.

Selecting all Devices in the Logical Device Table for Export
You can select all devices in the logical device table, for example, to export the Device 
Table’s configuration data to a csv file.

To select all the devices and save their configuration data
1 Open the Logical Device Table task for the required topology.
2 Click the Select All icon .
3 Click the Export icon .
4 Navigate to the folder where you want to save the file.
5 Click Save.

Configuring Virtual Crosspoints (XPTs)
Without virtual XPTs, only one route can be made for each task. Virtual XPTs are used when 
multiple outputs are required to be switched to the same source in a single take. 

Virtual XPTs can be used to:
• Show user-friendly device names on the operators’ control panels. For example, the 

name of the virtual XPT is shown on control panels when used.
• Hide implementation details from the operator(s). For example, in a transparent 

fashion, an output signal is also sent to a monitor.

Destination 1 Destination 2

Source

Destination 1 Destination n

Source

Virtual XPT
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Virtual XPTs are used for the following two primary applications:
• Monitoring: to follow the source routed to a given destination and to route that same 

source to other destinations as needed.
• Utility DA (distribution and amplifier): to allow for a configurable virtual 

destination/source that can be routed to other real destinations.

The following virtual XPT functional behaviors are by design:
• A take with a virtual XPT will fail if the path to the source does not exist and as a 

consequence the virtual source will fail. The status (Tally) will not reflect this.
• A take with a virtual XPT’s destination will be ignored if the take fails.
• A logical destination can only be added to one virtual XPT destination at a time. Once a 

real destination has been added to a virtual XPT, it is no longer available to be used 
with other virtual destinations. A pop-up message is shown if you try to add a logical 
destination that has already been added to another virtual XPT. Click OK to remove the 
logical destination from the previous virtual XPT and add to it the new virtual XPT.

• You can only route virtual sources to unrelated virtual destinations that are not 
associated with the same virtual XPT. This allows you to increase the number of logical 
destinations devices that can be switched with a single route. Routing a logical source 
device to the virtual destination of another virtual XPT will route said source to all 
logical destination devices that the virtual source is routed to. Routing that virtual 
source to another virtual destination, will mean routing the original logical source 
device to all destination devices that the corresponding virtual source was routed to, as 
well. 

Routing a logical source device to the virtual destination of another virtual XPT

• A virtual XPT can have up to 100 real logical destinations.
• The status of a virtual XPT is shown in the Path Manager. See Accessing the Path 

Manager, on page 451.
• Adding a logical destination device to a virtual XPT changes the status of the 

destination to the virtual source - with the logical source device content being routed 
to the logical destination device(s). Removing the logical destination device from a 
virtual XPT, will change the status of that destination to the logical source device.

Destination 1-1 Destination 1-n

Source

Virtual XPT 1

Destination 2-1 Destination 2-n

Virtual XPT 2
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Virtual XPT Use Scenario 1
In this scenario, the physical level is set up so that any source routed to destination Z will be 
taken to the following destinations: R, S, and T.

If the operator takes A to Z, the software “discovers” that source Z is virtually routed to R, S, 
and T. Therefore, it routes A to R, S, and T as real routes.

Here, a source was taken to multiple destinations with a single take, and that fact was 
concealed from the operator. The operator’s control panel reports that A was taken to Z. 
The Path Manager can be used to know the actual path that was internally used by the 
router; see the Path Manager Tasks, on page 450.

Other inputs can be taken to Z with a similar result: that source will be taken to destinations 
R, S, and T.

Virtual XPT Use Scenario 2
In this scenario, the virtual XPT setup is the same as for scenario 2.

If the operator takes B to Z, the software “discovers” that source Z is virtually routed to R, S, 
and T. Therefore, it routes B to R, S, and T as real routes.

The operator’s control panel reports that A was taken to Z. The operator executed a single 
take.

A P
B Q
C R
D S
E T
F U

Z Z
Y Y
X X

Virtual XPT Setup

A P
B Q
C R
D S
E T
F U

Z Z
Y Y
X X

Operator “takes” A to Z

A P
B Q
C R
D S
E T
F U

Z Z
Y Y
X X

Result: Operator still 
sees A as taken to Z

A P
B Q
C R
D S
E T
F U

Z Z
Y Y
X X

Virtual XPT Setup

A P
B Q
C R
D S
E T
F U

Z Z
Y Y
X X

Operator “takes” A to Z

A P
B Q
C R
D S
E T
F U

Z Z
Y Y
X X

Result: Operator still 
sees A as taken to Z
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This scenario illustrates that any time an operator takes a source to virtual XPT destination 
n, the router actually takes the source to the real destinations “connected” to virtual XPT 
source n.

To create Virtual XPTs

Virtual XPTs are created in the Logical Device Table task. 
1 In the Topology Configurator, activate the topology. See Activating a Topology, on 

page 235.
2 Open the Logical Device Table task. See Accessing the Logical Device Table task, on 

page 241.
3 Select the Virtual XPTs tab.

4 Click New 

5 Enter a name for the new virtual XPT and click OK. 
Optionally, a range of virtual XPTs can be created: The Name parameter is the prefix for 
the generated virtual XPTs. The Start Index is the index starting value, and the End 
Index is the last index value for the virtual XPT range.
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The new virtual XPT is added to the Multilevel Table under the Virtual XPTS tab. 

A new logical source and a new logical destination are created automatically in the 
system with the name of the virtual XPT. 

Virtual source and destination filters are available for you to filter on virtual XPTs when 
configuring the panel, categories, and router control user interfaces. See Filtering Lists, 
Table Columns, Sources, and Destinations, on page 266

6 Add the default destinations for the virtual XPT. Select the virtual XPT and then click 
Destinations .

A list of all currently available destinations appears.
7 Select the default destinations the virtual XPT will use and click OK.

In this scenario, the physical level is set up so that any source routed to destination 
VXPT will be taken to the following destinations: Mon5, Mon6, and Mon7.

A Mon3
B Mon4
C Mon5
D Mon6
E Mon7
F Mon8

VXPT VXPT
Y Y
X X
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Once you have created one or more Virtual XPTs, you can start using them in Router 
Control. 

To perform a take with a Virtual XPT

You must first create and activate the topology in the Topology Configurator. You perform 
takes with a Virtual XPT in Router Control. See also Performing a Take in Router Control, on 
page 471.

1 In the Topology Configurator, activate the topology. See Activating a Topology, on 
page 235.

2 Create a virtual XPT in the Logical Device Table task. See To create Virtual XPTs, on 
page 260. As an example, in this procedure, the name of the virtual XPT is VXPT.

3 Open Router Control. See Accessing the Router Control Task, on page 470. 

The default virtual XPT destinations that were configured in the Logical Device Table 
are shown by selecting the virtual XPT destination. See To create Virtual XPTs, on 
page 260.

4 To route Cam1 to Mon5, Mon6, and Mon7 using the virtual XPT VXPT, perform a take 
Cam1 to destination VXPT. 

Virtual XPT DestinationVirtual XPT Source

The Current Virtual XPT Destinations

Cam1 Mon3
Cam2 Mon4
Cam3 Mon5
Cam4 Mon6
Cam5 Mon7
Cam6 Mon8

VXPT VXPT
Y Y
X X
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First click the destination virtual XPT VXPT and then click Cam1 and finally click Take.

The destination virtual XPT VXPT button shows the current source.

The Path Manager can be used to know the actual path that was internally used by the 
router; see the Path Manager Tasks, on page 450.

To dynamically add a Virtual XPT destination

Destinations can dynamically be added to a virtual XPT. In this example, Mon8, and Mon9 
are added to the virtual XPT VXPT’s destination.

1 In the Topology Configurator, activate the topology. See Activating a Topology, on 
page 235.

2 First click the source virtual XPT and then click Mon8 and finally click Take.
3 First click the source virtual XPT and then click Mon9 and finally click Take.

The current destinations for the selected virtual XPT are updated.

S: Current source
P: Pending source
D: Destination

Virtual XPT Source 

Click to revert to the 
default virtual XPT 
destinations configured in 
the Logical Device Table
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See also Performing a Take in Router Control, on page 471 for more information about 
how to use the controls available in this window. The Path Manager can be used to 
know the actual path that was internally used by the router; see the Path Manager 
Tasks, on page 450.

To dynamically remove a Virtual XPT destination

Destinations can dynamically be removed from a virtual XPT. In this example, Mon9 is 
removed from the virtual XPT VXPT’s destinations. This is done by assigning the destination 
to be removed to another source. 

1 In the Topology Configurator, activate the topology. See Activating a Topology, on 
page 235.

2 First click the destination Mon9 then click Cam9 and finally click Take.

Minimize and Expand Virtual XPT Destinations
In the Router Control Task, when a virtual XPT is routed to another virtual XPT, the second 
virtual source is nested in the first virtual XPT. See Routing a logical source device to the 
virtual destination of another virtual XPT, on page 258.

As shown below, when Minimize Virtual XPT  is selected, the VXPT2 virtual XPT is shown 
minimized. 
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As shown below, when Expand Virtual XPT  is selected, all destinations are shown, 
including the nested destinations of all other virtual XPTs.

See also Performing a Take in Router Control, on page 471 for more information about how 
to use the other controls available in this window.

These are the now-visible
destinations of VXPT2
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Filtering Lists, Table Columns, Sources, and Destinations
Virtual source and destination filters are available for you to filter on virtual XPTs when 
configuring the panel and category configurator user interfaces. To show virtual XPT 
sources or destinations only, enable the Show virtual setting in the filters dialog only.

The functions available in a filter adapt to the screen in which the filter is found. For 
example, the Stream Browser has filters to allow you to filter streams that come from either 
input or output ports.

Filter Parameter Description

Reload filter [] Reloads the previously-used filter.

Reset filter Clears the text in the filter function.

Filter by Stream Filter by the stream’s name.

Filter by Device Group Filter by the device group’s name.

Filter by Device Filter by the device’s name.

Filter by Port Filter by the port’s name.

Deselect these filters

Select this filter

Click to open filter tool

Select this filter only

Click to open filter tool

Filter text
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Filter by Logical Level Filter by the Logical Level’s name.

Show SDI Show results where the connection type is SDI.

Show IP Show results where the connection type is IP.

Show MADI Show results where the connection type is MADI.

Show Inputs Show results where the connection direction is an input.

Show Outputs Show results where the connection direction is an output.

Show automatic Show automatically-created sources and destinations.

Show custom Show user-created sources and destinations.

Show virtual Show virtual XPTS.

Filter Parameter Description
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Category Configurator Tasks
Use the Category Configurator to make it easier to manage the sources in your topologies. 
Creating groups of categories, based on type or use, is useful when you have multiple 
resources.

Categories are used to group sources and destinations together thereby allowing them to 
be accessed quickly on a panel, either by adding a category button or by using keyboard 
shortcuts. See also Panel Configuration Example Using Categories with Custom Navigation, 
on page 302.

Accessing the Category Configurator
To access the Category Configurator Task

1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select an area. See Selecting an Area, on page 183.
3 Select a topology. See Selecting a Graph, on page 184.
4 Select Configuration > Category Configurator.
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The Category Configurator task opens:

See the following Category Configurator procedures: 
• Creating Categories for the Sources and Destinations in Your Topology, on page 270
• Assigning a Keystroke Label to a Source or Destination, on page 273
• Creating a Keystroke Label, on page 274

Sources & Destinations Menu
The Sources & Destinations menu has the following menu options.

Icon Description

 Select All Select / deselect all source or destination items. 

 Select Alias Select the Alias you want to use to identify Source and Destination 
streams in GV Orbit Control’s interface. 

Aliases are created in the Alias Editor. See Adding Aliases, on page 467.
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Creating Categories for the Sources and Destinations in Your Topology
When you first open the Category Configurator, the Home tab appears in the Sources and 
Destinations tab.

To create a category for your sources
1 Open the Category Configurator task for the required topology. See Accessing the 

Category Configurator, on page 268.
2 Click Add .

3 The Enter a name for the new category window appears:

4 Enter a name for the new category and click OK.
The new category is added to the top of the Category Configurator column.

5 Click Sources or Destinations to view the available sources / destinations.
All the sources / destinations in the selected topology are displayed. This includes the 
logical sources you created in the Logical Device Table task. See Logical Device Table 
Tasks, on page 241. 
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6 Select the newly created category.

The category is added to the lower part of the center column under Category Content.
7 Drag the sources / destinations from the Sources & Destinations column to the 

Category Content area. 

Alternatively, you can drag a source/destination to the created Category button. 
When a Category contains only Sources or it contains only Destinations, the Category’s 
symbol will change accordingly to show the type of content. For example, this allows 

OR
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you to have two Categories with the same name where one only has Sources and the 
other Category only has Destinations and you can still distinguish them.

8 Click Home to toggle between Sources (Green) or Destinations (Orange) as necessary. 

Re-ordering Category Content
The sequence of category content (Sources and Destinations) can be re-ordered so that 
when a category is used on a panel, the Sources and Destinations will be shown in the 
order that you want it to be.

1 Add Sources and Destinations to a Category. See Creating Categories for the Sources 
and Destinations in Your Topology, on page 270.

2 Re-order the Sources and Destinations in a Category: in the Category Content, drag the 
Source and Destination tiles into the oder you want them to be.

3 In the Panel Configurator, add a panel and configure it. See Panel Configurator Tasks, on 
page 275.

4 Add the Category to a panel button. See Adding Resources to the Panel, on page 287.
5 For each panel button you have added a Category to, select the panel button 

individually and set the Sort Mode property to Manual it in the button’s Property 
Editor. See Setting the Properties for Panel Resources, on page 292.

 Table 1: Meaning of Category Icons

Icon Description

 The category:
• Is empty (contains no Sources or Destinations).
• Contains a mix of Sources and Destinations.

 The category only contains Sources.

 The category only contains Destinations.
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Assigning a Keystroke Label to a Source or Destination
A keystroke label can be added to sources and destinations once they have been added to 
a category. Assigning a keystroke label to a source or destination allows a user to bring up 
categories by using a keypad on a panel. For example, if you have 100 categories in your 
system, a panel can bring up category 37 by pressing 3 then 7 instead of browsing through 
dozens of panel pages. This also applies to selecting sources or destinations. For instance, 
Cam17 can be directly accessed by pressing 1 then 7 on the panel instead of searching for 
the Cam17 button.

To add a keystroke label to a source or destination
1 Open the Category Configurator task for the required topology. See Accessing the 

Category Configurator, on page 268.
2 Click a Category to show sources and destinations that have been configured for that 

category, shown in Category Content.
3 From the Keystroke Label Editor drag one or more labels onto a source or destination to 

create a unique sequence for that source or destination. 

The Keystroke Editor shows the current keystroke label for the selected source or 
destination. 

Edit a Source or Destination Keystroke Sequence
The Keystroke Editor allows you to change the selected source or destination’s keystroke 
label. Setting for automatically assigning keystroke labels to a source or destination can 
also be set.
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Set Auto Add to automatically assign a keystroke to a source or destination as it is added to 
a category. Click Options to configure this feature.

Proceed as follows to delete a keystroke. 
1 Select a source or destination shown in Category Content.
2 Select a keystroke in the Keystroke Editor and click Delete.

Proceed as follows to delete all keystrokes. 
1 Select a source or destination shown in Category Content.
2 Click Clear All in the Keystroke Editor.

Creating a Keystroke Label
You can assign custom keystrokes to a source or destination. Create a keystroke label to do 
so.

To creating a keystroke label
1 Open the Category Configurator task for the required topology. See Accessing the 

Category Configurator, on page 268.
2 In the Keystroke Label Editor, click New .

The Create a new keystroke label window opens.

3 Set the keystroke label as required and click OK.
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Panel Configurator Tasks
This allows you to add buttons and behaviors to a panel. Those buttons represent sources, 
destinations, levels, groups and various operations that can be saved under specific 
configurations and then pushed to a software or hardware panel.

For an example of how to setup and use a panel, see Panel Configuration Example Using 
Categories with Custom Navigation, on page 302.

Accessing the Panel Configurator
To access the Panel Configurator Task

1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select an area. See Selecting an Area, on page 183.
3 Select a topology. See Selecting a Graph, on page 184.
4 Select Configuration > Panel Configurator.

The Panel Configurator task appears:
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Page Editor Menu
The Page Editor menu has the following menu options.

Icon Description

 Manage Creates multiple templates for hardware or software panels for various 
panel models. Then, you can add the template to a panel that you 
have added to the topology. A pre-existing panel can be duplicated; 
see Creating a New Panel, on page 277 or Viewing another Panel, on 
page 280. Using Layouts, panel layouts can be nested when used with 
the same panel model type. See Layouts in Adding Resources to the 
Panel, on page 287.

 Add Page Adds a page to the panel’s layout. See Adding Panel Pages, on 
page 283.

 Previous Page Returns to the panel’s previous page, when the panel configuration 
has two or more pages.

 Next Page Goes forward to the panel’s next page, when the panel configuration 
has two or more pages.

 Home Page Make the currently shown page the panel’s Home page. This is 
available when the panel’s configuration has two or more pages and 
you currently are not on the Home page. To add panel pages, see 
Adding Panel Pages, on page 283. To set a page to be a panel’s home 
page, see step 4 on page 283.

 Delete Page Removes the currently-selected page from the panel’s configuration. 
This is unavailable for the panel page currently designated as the 
Home page.

 Cut Cuts the contents from the panel’s currently selected button(s).

 Copy Copies the contents from the panel’s currently selected button(s).

 Paste Pastes the clipboard contents to the panel’s currently selected button. 
See About the Copy / Cut / Paste Buttons, on page 277.

 Copy Category 
Properties

Copies the properties of another category to the panel’s currently 
selected category. First configure a category’s properties according to 
your needs, and then copy the properties to other categories using 
thislo feature as needed. See Copying the Properties from one 
Category to Another, on page 295. 

 Refresh Reloads the Panel’s contents. 

 Select All Selects all the panel’s contents. 

 Clear All Deselects all the panel’s contents. 

 Clear Removes all the selected panel’s contents. 
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About the Copy / Cut / Paste Buttons
Copy / cut / paste buttons can be used from one panel page to another and from one 
panel to another. Copy / cut / paste can be done using either the icons in the toolbar or 
through keyboard shortcuts: <ctrl>+X, <ctrl>+C, and <ctrl>+V.
You can multi-select using the <Shift> / <Ctrl> key: 

• By holding the <Shift> key and selecting the first and the last button/cell on the 
panel, all buttons/cells in between are selected. If the first and the last selected 
buttons/cells are in different lines, the entirety of the lines will be selected between 
the two buttons/cells.

• By holding the <Ctrl> key, you can toggle the selection by clicking individual 
buttons/cells on the panel.

Creating a New Panel
You can create multiple templates for hardware or software panels of various models. Then, 
you can add the template to a panel that you have added to the topology. A pre-existing 
panel can be duplicated; see Viewing another Panel, on page 280.

To create a new panel
1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select an area. See Selecting an Area, on page 183.
3 Select a topology. See Selecting a Graph, on page 184.
4 Select Configuration > Panel Configurator. See Accessing the Panel Configurator, on 

page 275.

5 Click Manage.
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A secondary window opens.

6 Click New .
The New window appears.

7 Enter meaningful text in the Name, Summary, and Description fields to identify the 
panel.

8 Select the required model from the list.
9 Click Create.

The new panel is added to GV Orbit Control.
Panels can have more than one page. When the panel is shown with a red outline, this 
indicates that the Home Page is being shown.

A Red outline indicates
that the Home Page is

currently being shown
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10 Configure the panel’s properties; see Configuring a Panel’s Properties, on page 281.

Duplicating a Pre-Existing Panel
A pre-existing panel can be copied to reuse that panel’s configuration properties and then 
you only need to modify the necessary panel properties as required for the new 
application. The new panel configuration will have a new name and any changes to that 
configuration will not affect the original panel configuration that you chose to base its 
configuration on. 

To duplicate a Pre-Existing Panel
1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select an area. See Selecting an Area, on page 183.
3 Select a topology. See Selecting a Graph, on page 184.
4 Select Configuration > Panel Configurator. See Accessing the Panel Configurator, on 

page 275.

5 Click Manage.
A secondary window opens.

6 Click on a pre-existing panel that you want to duplicate and then click Duplicate . 
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The New Name window appears.

7 Enter a name to identify the panel.
8 Click Ok.
9 Configure the panel’s properties; see Configuring a Panel’s Properties, on page 281.

Viewing another Panel
When you have configured two or more panels, you can change between configuring them 
as follows.

To view a Pre-Existing Panel
1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select an area. See Selecting an Area, on page 183.
3 Select a topology. See Selecting a Graph, on page 184.
4 Select Configuration > Panel Configurator. See Accessing the Panel Configurator, on 

page 275.

5 Click Manage.
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A secondary window opens.

6 Click on a pre-existing panel that you want to view. 
The configuration for the selected panel appears.

Configuring a Panel’s Properties
Set the basic parameters to configure the panel. 

To Configure a Panel’s Properties

1 Click 1 next to Zones [1].
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The following properties can be configured for the panel. See also Description of 
Common Device Properties, on page 332.

See also Setting the Properties for Panel Resources, on page 292.

Parameter Description

Name The name or identifier for this panel

# Zones Sets the number of zones available for the selected panel. The default 
is 1, however you can add more as needed.
Buttons can be assigned to any zone. Each zone can then act as an 
separate panel. For example, you can have two zones on a panel, and 
each zone has its own sources, destinations, and take button. 
Selection and take in one zone will not affect the other zone. Zones 
can be assigned to the button in the Property Editor when the button is 
selected in the Resources for Topology.

Alias group 
(Destinations)

Shows the currently selected destination / source alias to use on the 
panel button’s / interface to use in place of the short labels. See Using 
Source and Destination Aliases with a Panel, on page 291.Alias group (Sources)

Comment An optional comment about this panel.

Default Destination Shows the currently selected default destination for this panel. See 
Creating a Single-Destination Work Flow Panel, on page 297.

Description An optional description for this panel.

Display 24 characters When deselected, panel button labels are limited to a maximum 
length of 8 characters.
When selected, panel button labels are limited to a maximum length 
of 24 characters. This option is useful when using source / destination 
aliases that usually are longer than 8 characters. This will disable the 
destination status on the destination buttons. The display will only 
show the system names. The level buttons will only show the system 
names. To create source / destination aliases, see Alias Editor Tasks, on 
page 466. See also Using Source and Destination Aliases with a Panel, 
on page 291.

Multi-select When deselected, the panel will allow multiple selection of 
destination buttons. This enables an operator to take a single source 
to multiple destinations at once.
When selected, only one destination can be selected at a time.

Panel Model The current panel’s model number that was added in step 6 on 
page 278.

Select Persist When deselected, the source and destination selections are cleared 
when a take is complete.
When selected, the source and destination selections are maintained 
when a take is complete.
This is parameter is selected by default. This parameter is not zone-
specific.
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Adding Panel Pages
A panel can have one or more pages. Each page can be tailored to a function or purpose. 
Navigation buttons can be added to the page so the panel user can go page to page. There 
is more than one way for a panel user to navigate to another page; for example, see Panel 
Configuration Example Using Categories with Custom Navigation, on page 302.

To add a panel page
1 View a panel. See Viewing another Panel, on page 280.
2 Configure the panel. See Configuring a Panel’s Properties, on page 281.
3 In Tool, navigate to Home > Pages and click Add Page .

A new page is added to the Pages list in the Tool pane.
4 To make a panel page the Home page, select the page in Tools and click Home .

OR

A Red outline indicates 
that the Home Page is 
currently being shown
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In the Tool list of panel pages, the Home icon is shown for current Home page. A red 
outline around the panel image indicates when the Home page is currently being 
shown.

Adding Actions to a Panel
A panel can support a number of actions that must be added to it before the action 
becomes available to the panel user. For example, add a Take button to a panel as follows.

1 Open the Panel Configurator task for the required topology. See Creating a New Panel, 
on page 277.

2 Select the required Panel.
3 Drag the Take tool from the Tools column onto a panel button.

4 If the panel has a display, drag the Page Up and Page Down tools from the Tools 
column onto panel buttons (some panels have two dedicated buttons set apart for this 
purpose next to the display).

Tool Page Icon Description

 The panel page is currently not a home page.

 The panel page is currently a home page.
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See the panel’s documentation for more specific details about the behavior of panel 
buttons. The following table provides summary information.

Built-in Panel 
Actions Description

Back Allows the panel user to go back to a previously visited page.
The Back button stacks all visited pages or layout pages and will be 
highlighted until the panel user reaches the first page visited where the 
button becomes low tally. The stack of visited pages:

• Is persisted against restart, reboot and failover actions.
• Is cleared when a panel user clicks a Load home Page button on the 

panel.

Blank Some buttons can span multiple pages. This is used to force a button to 
appear on a higher-level page only.

Cancel Cancels a Keystroke. Removes all keystrokes in the selection.

Category This either (1) displays a category’s device list or (2) displays a “suffix 
page.” A category button is associated with either a source category or 
destination category. The button text is normally the category name and 
is short as space is limited.

Clear Clears the Keystroke. Removes the last key stroke.

Default Destination Provide the tally for the default destination when the Show Tally 
parameter is set in the button’s property. 
Set a destination to which all takes made on a panel will be made. See 
Creating a Single-Destination Work Flow Panel, on page 297.

Destination Select a destination. 

Destination Item This is used to do an indexed take. Use Multiple destination items to 
preset a multiple take. Each destination item will have a different index. 

Destination Status Provide the tally for the selected destination. See also Creating a Single-
Destination Work Flow Panel, on page 297.

Indexed Take Make a take on the Destination item. 

Keystroke Create a Keypad to select Source or Destination by their numbers.

Level • Used to display the level of the destinations. 
• Used to display the preset of a selected level. 
• Used for audio Break away and audio shuffling.

Level Map This cross-connects levels. The function is typically used to shuffle audio 
channels, for example, to connect AES1/2 to AES3/4. 

List Item Used in conjunction with the Category list button to create an area where 
the source or destination will be displayed in a list.

Load Home Page Takes the panel user to the Home page. To set a page to be a panel’s 
home page, see step 4 on page 283.

Load Layout This is shown when a layout is dropped on a panel button. See Layouts in 
Adding Resources to the Panel, on page 287.
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Load Page Loads any panel page. To add a panel page, see Adding Panel Pages, on 
page 283

Lock This prevents changes to the panel settings, especially router crosspoints. 
When the panel is locked, the button array becomes blank except for the 
Panel Lock button which becomes high-tally red. The button is a toggle: 
press the ‘Lock’ button to lock the panel. Press it again to unlock the 
panel.The button text is either “Lock” or “Unlock.”
See also About Lock, Protect, and Release, on page 472 for more 
information about the use and limitations of this feature.

Multi-Select Allows the selection of multiple destinations.

Next Continue forward to browse down a category list (this does not change 
the page). Normally you would not use this button directly but let the 
category list place it automatically, unless you need to map to a special 
button on a panel.

Next Page When there are two or more pages that have been configured in the 
panel’s layout, this cycles forward to the next panel page when available. 
When the panel user is at the last page, the button becomes low tally and 
the panel user can go no further.

Page Down This scrolls the alphanumeric display down.

Page Up This scrolls the alphanumeric display up.

Panel Lock This locks the panel. When set, the panel button turns red and all other 
panel buttons are unavailable. Press the button again to release the lock.

Previous Browse backwards to move up a category list (this does not change the 
page). Normally you would not use this button directly but let the 
category list place it automatically, unless you need to map to a special 
button on a panel.

Previous Page When there are two or more pages that have been configured in the 
panel’s layout, this cycles backwards to the previous panel page. When 
the panel user is at the first page, the button becomes low tally and the 
panel user can go no further.

Protect This is a toggle that sets or clears a protect on the current destination 
device. The protect can be removed at the panel that originally set the 
protect, at any panel that has the same user ID, or by a forced release at 
any panel. 
• Note: a protect prevents others from routing to a destination; a lock 

prevents anyone—even the panel user who issued the lock—from 
routing to the destination.

• You may lock a protected destination, but you cannot change a locked 
destination to a protected destination directly. 

You must first unlock it. The ‘Destination Protect’ button text is normally 
Dest Protect and when a selected MD destination is protected, the 
button legend becomes Dest Unprotect.
See also About Lock, Protect, and Release, on page 472 for more 
information about the use and limitations of this feature.

Built-in Panel 
Actions Description
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Adding Resources to the Panel
The Resources for Topology menu has the following menu options.

Reset Panel Reset the panel to its initial state and go to the home page. 

Salvo This executes a system salvo. A salvo is a pre-defined set of commands. 
The button text is the salvo’s mnemonic. Pressing the salvo button puts 
the panel in “salvo” mode. To confirm that you want to execute the salvo, 
press a ‘Take’ button. When you press the take button, the salvo begins 
executing immediately. Salvos are typically short in duration. If you want 
to cancel the salvo before it executes, press the salvo button again. If you 
press an ‘Information’ button while the panel is in salvo mode, the panel 
presents the salvo commands on the display. You may scroll the display 
to view the entire salvo. 
See Creating Salvos, on page 474.

Select After selecting Source or Destination from a Keypad, the panel user 
presses Select. This confirms the choice.

Select Persist The destination stays selected after a Take. 

Source
Quick Source

This selects a source. Note that the quick source button selects a source 
and also performs an immediate take. Quick Source and Source buttons 
are similar, except that the Quick Source performs a take. Be aware of 
which buttons are quick sources so you do not perform an accidental 
take. 

Take In X-Y mode, a take button routes the preset source device(s) on selected 
levels to the selected destination device. In MD mode, a take button 
routes the preset source device(s) to the selected destination device(s) on 
all levels.

Built-in Panel 
Actions Description

Icon Description

 Quick Source This is shown only when Sources is selected. When enabled, the 
sources that are dragged onto the panel are quick sources, meaning 
the operator does not need to press the take button to do the take. 
The take is done as soon as the source is selected on the panel.

 Default 
Destination

This is shown only when Destinations is selected. This makes the 
selected destination the default destination for the panel. When set:
• The panel’s properties shows the currently selected destination, 

found under Default Destination. 
• The icon on the destination changes to  thus indicating its default 

destination status.
To remove the Default Destination, select the destination set as the 
Default Destination and click .
See Configuring a Panel’s Properties, on page 281.
See Creating a Single-Destination Work Flow Panel, on page 297.

 Select All Selects all the available resources. 
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In the Tool list of panel pages, the Home icon is shown for current Home page. A red 
outline around the panel image indicates when the Home page is currently being 

 Clear All Deselects all the available resources. 

 Select Alias Select the Alias you want to use to identify Source and Destination 
streams in GV Orbit Control’s interface. 

Aliases are created in the Alias Editor. See Adding Aliases, on page 467.

Icon Description
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shown. From the Resources for Topology, the following resources can be dropped onto 
panel buttons.

Tool Page Icon Description

The currently configured sources. Sources are the available outputs for 
all the devices on your topology. See Adding a Source or Destination 
to the Logical Level Table, on page 248.
Sources may be identified by an icon that represents the source type 
when it was automatically created as a virtual device. See About 
Automatic Sources or Destinations, on page 246 for more information.

The currently configured destinations. Destinations are the available 
inputs for all the devices on your topology. See Adding and 
Configuring a Destination, on page 254.
Destinations may be identified by an icon that represents the 
destination type when it was automatically created as a virtual device. 
See About Automatic Sources or Destinations, on page 246 for more 
information.
When a destination has been set to be the default destination for a 
panel, it is designated by the Default Destination icon . See 
Creating a Single-Destination Work Flow Panel, on page 297.

Logical levels allow for the creation of shuffling and breakaways. 
For more information about logical levels, see Logical Level Editor 
Tasks, on page 190.

Shows the available categories. See:
• Table  Category Configurator Tasks on page 268. 
• Table 1 Meaning of Category Icons on page 272.
• Panel Configuration Example Using Categories with Custom 

Navigation, on page 302

A keystroke label can be added to sources and destinations once 
they have been added to a category. See Assigning a Keystroke 
Label to a Source or Destination, on page 273.

Click a zone to see which panel buttons are assigned to that specific 
zone. The number of zones is set in the # Zones parameter in the panel 
properties. See Configuring a Panel’s Properties, on page 281.

Some panel buttons support the display of more than one color. For 
buttons that support colors, the button’s color is used to show the 
current operating state. The color used for a button to represent any 
one of the given states can be changed. See Changing a Button’s Color 
used to Represent a State, on page 295 and Changing a Button’s 
Default Color used to Represent a State, on page 297.

When a salvo is triggered, it executes a list of pre-configured 
actions. See Creating Salvos, on page 474. 
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To add panel resources
1 Open the Panel Configurator task for the required topology. See Creating a New Panel, 

on page 277.
2 Select the required Panel. See Viewing another Panel, on page 280.

The resources that can be added to the panel are displayed in the lower section of the 
center column under Resources for Topology.

3 Click on resource type to begin adding individual resources to the panel such as 
Sources, Destinations, or Levels. 

Allows a panel to be used as a template to then be used in another 
panel. Making changes to the template panel will be seen 
everywhere the template is used. When:

1 You have created two or more panels with the same model 
type (for example, you have added three NV6954 panels in the 
Panel Configurator), 

2 And you are viewing a panel with the same model type (for 
example, one of the three NV6954 panels in the Panel 
Configurator).

Then:
• These model types become available in this list (excluding the 

current panel). To create a panel, see Creating a New Panel, on 
page 277. 

• A panel from Layouts can be dragged and dropped onto a 
button of the current panel layout to be reused. This creates a 
Load Layout button on the panel. 

Select the Load Layout button to configure its properties in the 
Property Editor. See Setting the Properties for Panel Resources, on 
page 292.

Tool Page Icon Description
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For example, click Sources to add cameras and other types of sources.

All the sources available in the topology are listed. This includes the logical sources you 
created in the Logical Device Table task. See Logical Device Table Tasks, on page 241.

4 Select a resource and drag it to one of the panel buttons at the top of the column. More 
than one resource can be added at a time; to add to a selection, use Shift or Ctrl to 
select a range of resources or to add another resource to the selection. 

5 For each panel button you have added a resource to, select it individually and set the 
properties for it in the Property Editor. For a Category, see Setting the Properties for 
Panel Resources, on page 292.

6 Add resources from Destinations, Levels, and Keystrokes to the panel as required.

Using Source and Destination Aliases with a Panel
Aliases can be used for a panel to change the name of sources and destinations from short 
labels to the labels of the corresponding alias. First you must create one or more source and 
destination aliases; to create an alias, see Alias Editor Tasks, on page 466.

Note:

Only use the video+ancillary (V-ANC) logical level button unless you are routing in 
SMPTE ST 2110 mode. For SMPTE ST 2110 mode, you can individually use the Video 
or the Ancillary logical level buttons. 
To directly control a GV Node’s internal matrix, you must use the video + ancillary 
logical level button for video breakaway.
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1 Under Resources for Topology, click Sources or Destinations. 
2 Select from the Select Alias drop-down list the alias to use for this panel instance.

3 If the aliases are longer than 8 characters, consider setting the Display 24 characters 
option for the panel in the Panel’s Property Editor. See Creating a New Panel, on 
page 277.

Setting the Properties for Panel Resources
When a resource has been added to a panel’s button, you can select the button to then 
configure the properties for it.

Parameter Description

Category Selects the category instance for the selected button.
Typically this should be the category that was dragged onto the panel 
in Resources for Topology. It can be changed here for another 
category.

Category filter A category can contain sources and/or destinations. Select the ones 
you want to be displayed.
Both: display sources and destinations.
Destinations: display destinations only.
Sources: display sources only.

Display Mode Keystroke: if the category item has keystrokes assigned to it, you can 
select this option.
List: if not select List; this will list all sources/destinations in the 
category.
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Exit Mode (for Load 
Layout, when a panel 
is used as a template)

Select how the panel user will be returned from a panel layout once 
they have made a category item selection or Take. The category item 
selection is displayed once the panel user has pressed the category 
selection button. 
Never: The panel user will remain in the same page where the 
category item selection is made. Other navigation buttons must be 
added to the page so that the panel user can navigate from the page 
(such as the Back button and / or the Previous Page and Next Page 
buttons). 
Preset: Once the panel user has made a selection in the category 
items, the panel user is immediately returned to the previous page 
(where the category selection button is located). 
Take: When the category items page has a Take button, the panel user 
is returned to the previous page (where the category selection button 
is located) once they select a category and then click Take. 
See Panel Configuration Example Using Categories with Custom 
Navigation, on page 302 for an example of how to use this parameter.

Exit Mode (for 
category item 
selection)

Select how the panel user will be returned once they have made a 
category item selection or Take. The category item selection is 
displayed once the panel user has pressed the category selection 
button. 
Never: The panel user will remain in the same page where the 
category item selection is made. Other navigation buttons must be 
added to the page so that the panel user can navigate from the page 
(such as the Back button). With this option, the Exit Page parameter 
below is not applicable.
Preset: Once the panel user has made a selection in the category 
items, the panel user is immediately returned to the previous page 
(where the category selection button is located). This is the default. 
With this option, the Exit Page parameter can send the panel user to 
any other page (see below).
Take: When the category items page has a Take button, the panel user 
is returned to the previous page (where the category selection button 
is located) once they select a category and then click Take. With this 
option, the Exit Page parameter can send the panel user to any other 
page (see below).
See Panel Configuration Example Using Categories with Custom 
Navigation, on page 302 for an example of how to use this parameter.

Parameter Description
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Exit Page (for category 
item selection)

In conjunction with the Exit Mode parameter, this parameter changes 
the Preset and Take return navigation to any other panel page. This 
can be used to save the panel user from making extra panel presses to 
navigate back to the Home page, for example.
In order to use this feature the Exit Mode must be set to Preset or 
Take. See above.
When the value for this parameter is blank (empty), the Exit Page 
parameter has no effect. This is the default. 
When the value for this parameter is a panel’s page, the panel behavior 
is to take the panel user to the selected panel page once they have 
pressed the category item selection or Take button. See Panel 
Configuration Example Using Categories with Custom Navigation, on 
page 302 for an example of how to use this parameter.

Layout Set the panel to be associated to the Load Layout button.

Name Set the name that will appear in the category button instead of the 
category name.

Page Sets the page to display when the category button is pressed. It 
should typically contain either List Item buttons or Keystroke buttons.

Sort Mode If the list display mode is selected, this will:
A-Z: show the sources/destinations in alphabetical order.
Manual: show the sources/destinations in the order you have set for 
the Category. see Re-ordering Category Content, on page 272.
Z-A: show the sources/destinations in reverse alphabetical order.

Next These options are present for the List Item buttons. If the list of 
sources/destinations in the category is greater than the number of list 
item buttons added to the page, some buttons will be used as next or 
previous buttons. This is determined automatically by GV Orbit 
Control, but you can override the default by specifying that a button 
can be used as a next or previous button if need be.

Previous

Keystroke This parameter is available with the Keystroke button. It specifies the 
keystroke associated with the button.

Zone Select the zone for the category button.
Buttons can be assigned to any zone. Each zone can then act as an 
separate panel. For example, you can have two zones on a panel, and 
each zone has its own sources, destinations, and take button. 
Selection and take in one zone will not affect the other zone. Zones 
can be assigned to the button in the Property Editor when the button is 
selected in the Resources for Topology.

Parameter Description
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Copying the Properties from one Category to Another
Copies the properties of the panel’s currently selected category to one or more other 
categories used on the panel. The scope (the type of parameters) of the copy can be 
controlled.

To copy the Properties from one Category to Another
1 Add two or more categories to the panel. See Adding Resources to the Panel, on 

page 287.
2 Configure the properties of one of the categories according to your needs. See Setting 

the Properties for Panel Resources, on page 292.
3 Select the category from which you want to copy the properties from. 
4 Click  Copy Category Properties to copy the properties of the selected category to 

other categories.

5 Select one or more categories to which you want to copy the properties to. Click OK.

Changing a Button’s Color used to Represent a State
Some panel buttons support the display of more than one color. For buttons that support 
colors, the button’s color is used to show the current operating state. The color used for a 
button to represent any one of the given states can be changed as follows. 

Icon Description

 Select All Selects all the available categories. 

 Clear All Deselects all the available categories. 

 Property to copy Select from the dropdown list the property parameter field you want 
to copy.
• All Properties: Copy all the following properties to the selected 

categories: Display Mode, Exit Mode, Page, Category Filter, Zone, 
and Sort Mode.

• Display Mode, Exit Mode, Page, Category Filter, Zone, and Sort 
Mode: This allows you to copy only a specific property parameter 
while leaving the remaining property parameters for the categories 
untouched. 

For more information about these category property parameters, see 
Setting the Properties for Panel Resources, on page 292.
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1 Click a button that has a behavior previously associated to it (a blank button will not 
work). See Adding Actions to a Panel, on page 284 and Adding Resources to the Panel, 
on page 287.

2 Click on the Colors resource type.

All available state colors for the selected button are shown on the lower half. 
3 Drag a color from the color pallet (shown on the upper half ) onto any one the state 

colors on the lower half.

A Def bar appears on the state color which indicates the default color. Double-click the 
state color to revert to this default color.
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Changing a Button’s Default Color used to Represent a State
The default color used by all buttons for a behavior state can be changed when an across 
the system change is necessary.

1 Click the Custom Color Settings icon .
2 Click a behavior that you want to configure, for example, Destination.

3 Drag a color from the color pallet (shown on the upper half ) onto any one the state 
colors on the lower half.
Certain panel buttons support fewer colors. The 7, 3, and 2 Color Buttons columns will 
show how your color choice will be implemented for these reduced color-range 
buttons.

Creating a Single-Destination Work Flow Panel
A panel can be configured as an input selector: the panel shows a range of sources, from 
which the panel operator can choose from, and the selected source will always be routed to 
a single specific, pre-defined static destination for monitoring. Note that in this example, 
there are no destination buttons defined on the panel. 

To create a single-destination work flow panel

This example shows how to create a single-destination work flow panel.
1 Create a new panel. See Creating a New Panel, on page 277.
2 Add the sources and a Lock and Take buttons to the panel. See Adding Resources to the 

Panel, on page 287 and Adding Actions to a Panel, on page 284.
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3 Select the destination to which all sources will be routed for this panel: In Resources for 
Topology, Destinations, select a destination to which any selected source will be sent. 

4 Set this destination as the default destination: click Default Destination . The icon on 
the destination changes to .

In the panel properties, the Default Destination parameter shows the selected 
destination as its value.

5 On the Home page, add a Destination Status from the Built-In Tool to a panel button. 
This panel button provides the tally of the default destination to the panel operator. 
See Adding Actions to a Panel, on page 284.

The panel operator can now select a source that will be routed to the Router-Out 1 In 1 
destination. The Destination Status button updates with the current tally for the 
destination.
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Adding the New Panel to the Topology
After you have configured one or more templates for your software or hardware panels, you 
can add a panel to your topology.

To add a panel to the topology
1 Add the Panel to the Topology: from the Device Library, Virtual Device, find the Panel 

bubble. See Adding a Virtual Device to a topology, on page 204. 

2 Select the bubble for the panel device to configure the panel’s Device Group Properties 
in the Property Editor. See also Description of Common Device Properties, on 
page 332.

3 Select Device Properties and click New  next to Control Port at the top of the 
Property Editor and select NV96XX Panel Control from the list.

Parameter Description

Name The name or identifier for this panel instance.

# Devices The number of panel instances in this device group.

Network Host Name When one or more panels are managed by DCNM through the media 
network, set a unique network identifier for these panels so as to be 
able to push policies to them.

Advanced > 
Description

An optional description for this panel’s control port.

Advanced > Logical 
Level

The logical level for this panel. See Logical Level Editor Tasks, on 
page 190.

Advanced > Default 
Connector Type

The panel’s connector type.



300

Configuration Tasks GV Orbit Version 2.3.0
Adding the New Panel to the Topology User Guide

The Panel Control Port tab appears. See also Description of Common Device 
Properties, on page 332.

4 Select Panel Control Port tab to make the following properties visible. See also 
Description of Common Device Properties, on page 332.

Parameter Requireda

a. This parameter must be configured in order for the panel to become functional.

Description

Name The name or identifier for this panel instance.

Description An optional description for this panel instance.

Logical Level The logical level for this panel. See Logical Level Editor 
Tasks, on page 190.

Panel Layout  Select the name of the panel you used when you created 
the panel (see Creating a New Panel, on page 277) from 
the drop-down list.

Panel Model When you have selected the Panel Layout parameter, this 
is the panel’s model number that was selected when you 
created the panel. It is read-only.

Panel User  Select the panel’s user name from the drop-down list. For 
further information, see Administration Tasks, on 
page 477. 
A panel Admin or Operator user has the ability to release 
locks made by another user. Whereas non-Admin or non-
Operator users can only release locks they made 
themselves.
Destinations Lock/Protect is performed through the panel 
and if a destination is currently locked by another user, 
any take to this same destination will fail.
If a specific router port is locked/protected but not linked 
to any destination within the Control System, the 
Lock/Protect status won't be exposed in the Control 
System and in fact is not releasable.
See also About Lock, Protect, and Release, on page 472 for 
more information.

Reset Device When the topology is inactive (see Making an Active 
Topology Inactive, on page 236), click to reset the device.

Parameter Requireda Description

Panel Control Port > 
Name

The panel’s control port name.

Panel Control Port > 
Description

An optional description for this panel’s control port.
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5 In the hardware or software panel, ensure you have configured the Panel ID number 
and the Controller 1 IP address. For a software panel, set Connect.
When the panel is online, you can control GV Orbit Control from the panel.

You can view the health of the panel in the System Status task. See System Status Task, 
on page 457.

The green bar indicates the health of the panel is good.

Panel Control Port > 
Connection State 1 / 2

Connection State 1 shows the connection status of the 
panel with the primary server of a server group. 
Connection State 2 shows the connection status of the 
panel with the secondary server of a server group. See 
Configuring a Controller Group, on page 179.
unknown: the topology is inactive (see Activating a 
Topology, on page 235) or the panel does not have 
network connectivity to the GV Orbit Server(s).
offline: the panel does not have network connectivity to 
the GV Orbit Server(s).
online: the panel is connected to the GV Orbit Server(s).

Panel Control Port > 
PanelID

 Each control panel must have been configured with a 
unique Panel ID number. 
Enter the Panel ID that corresponds with the physical 
panel that is to be used with this panel instance.

a. This parameter must be configured in order for the panel to become functional.

Parameter Requireda Description
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6 Click the Panel ID at the top of Panel Communication Status column to view data on the 
panel. This appears at the bottom of the interface.

Panel Configuration Example Using Categories with Custom Navigation
This panel configuration example shows how to:

• Set panel navigation when using categories.
• Generally configure a panel.

For this example, the following panel page structure is used. The goal of this example is to 
teach you how to configure the panel so that the panel user has a work flow with the least 
number of panel navigation button presses (that is, the need to use exit, return, or home 
button presses has been minimized).

Panel Page Structure and Panel User Navigation Steps for this Example 

Home

Category
(test signal selection)

Dest Items







Source Items (test 
signals)

Take
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The following steps outline panel navigation button presses used for this example. See the 
circled numbers in the above diagram.

About panel user navigation in this example

Note that no up, home, or return navigation buttons are used in this example. In practice, a 
panel’s configuration should include navigation buttons as an answer to when a panel user 
changes their mind and no longer wants to commit to an action. In this example, a panel 
user must complete the action once started; there is no escape function to exit the above 
procedure part way through. This is solved by adding a Load Page action to a panel button 
and configuring the action to take the panel user to the Home Page for example. See 
Adding Actions to a Panel, on page 284.

To configure this example

Proceed as follows.
1 Create the following topology that is used for this example. 

Step
Panel User Button 
Press Description

1 Category On the panel’s Home page is:
• Is a range of sources and destinations, plus a Take button for 

normal routing activities.
• A Category button (test signal selection) that allows the panel 

user to route a test signal to a destination using categories.

2 Dest Items On the panel’s Category page (test signal selection) are Dest 
Items and Source Signals buttons (test signals).
The panel user presses Dest Items.

3 Select a destination A selection of five destination category items are shown in the 
Dest Items page. The panel user presses a button to select a 
destination to which a test signal will be sent.
The panel user is returned to the panel’s Category page.

4 Source Items On the panel’s Category page (test signal selection) are Dest 
Items and Source Signals buttons (test signals).
The panel user presses Source Items.

5 Select a source and 
then Take

A selection of five source category items (test signals) are shown 
in the Source Items page. The panel user presses a button to 
select a source (test signal)and then presses TAKE. 

6 – Once the Take is made in the Source Items page, the panel’s 
configuration navigates the panel user to the Home page where 
the panel user is ready to continue with other operations.
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Add to the Topology Configurator the following device groups: 5 Test Signal 
Generators, 5 cameras, 5 monitors. Then add a router with 10 inputs and 5 outputs to 
the Topology Configurator. See Adding Devices to a Topology, on page 204 and To 
name a device and set the number of devices in the group, on page 205.

2 Click Quick Connect to link the devices together. See Using Quick Connect to Link all 
Devices in a Topology, on page 222.

3 In the Category Configurator, Create the categories you will use with the panel. See 
Creating Categories for the Sources and Destinations in Your Topology, on page 270.
For this example, five test signal sources have been added to the Source Category 
(shown) and five destinations have been added to the Destination Category (not 
shown).

4 Create a panel if you have not already done so. See Creating a New Panel, on page 277.
5 Configure the panel’s properties. See Configuring a Panel’s Properties, on page 281.
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6 Add the following pages to the panel: Category, Source Items, and Dest Items. See 
Adding Panel Pages, on page 283.

These are the pages between which the panel user will navigate according to the 
configuration parameters you set in the Panel’s configuration, shown in later steps in 
this procedure.



306

Configuration Tasks GV Orbit Version 2.3.0
Panel Configuration Example Using Categories with Custom Navigation User Guide

7 On the Home page, add a Load Page from the Built-In Tool to a panel button. See 
Adding Actions to a Panel, on page 284.

8 On the Home page, select the Load Page panel button and set the Page property 
parameter to Category. With this setting, when the panel user presses this button, they 
will be shown the Category page. 
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9 On the Category page, add the Destination Category to a panel button. See Adding 
Resources to the Panel, on page 287.

10 On the Category page, add the Source Category to a panel button. See Adding 
Resources to the Panel, on page 287.
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11 On the Category page, select the Destination Category panel button and set the Exit 
Mode, Exit Page, and Page property parameters. 

The following configuration parameter explanation should be interpreted within the 
context of this example procedure.

See also Adding Resources to the Panel, on page 287 and Setting the Properties for 
Panel Resources, on page 292 for more information about the remaining properties. 

Parameter Description

Category This should show Destination for this step.

Exit Mode Select how the panel user will be returned once they have made a category 
item selection or Take. 
In this example, set this to Preset. With this option, the panel behavior is to take 
the panel user to the Category page immediately once they have pressed a 
destination category in the Dest Items page. 

Exit Page In this example, this is set to [blank]. The Exit Page feature is unused.

Page For the Destination category, set to Dest Items. 
With this setting, when the panel user presses this panel button on the 
Category page, they will be shown the Dest Items page where the panel user is 
able to select a destination item. 
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12 On the Category page, select the Source Category panel button and set the Exit Mode, 
Exit Page, and Page property parameters. 

The following configuration parameter explanation should be interpreted within the 
context of this example procedure.

Parameter Description

Category This should show Source for this step.

Exit Mode Select how the panel user will be returned once they have made a category 
item selection or Take. 
In this example, set this to Take. With this option, the panel user has to select a 
source category and then press the Take button.

Exit Page In conjunction with the Exit Mode parameter, this parameter changes the Take 
return navigation to any other panel page. 
In this example, set this to Home; the panel behavior is to take the panel user to 
the Home page immediately once they have pressed the category item 
selection and then the Take button in the Source Items page. 

Page For the Source category, set to Source Items. 
With this setting, when the panel user presses this panel button on the 
Category page, they will be shown the Source Items page where the panel 
user is then able to select a source item and then clicks Take. 
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13 On the Dest Items page, add five List Item from Built-In to five panel buttons. This 
corresponds to one List Item for each of the five sources. 

Note: You can use copy and paste a block of List Item on the panel to quickly create a 
large number of sources or destinations.

14 On the Source Items page, add five List Item from Built-In to five panel buttons. This 
corresponds to one List Item for each of the five sources. See Adding Resources to the 
Panel, on page 287.
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15 On the Source Items page, add a Take button. 

16 Add a panel device to the topology and configure the panel and its control port 
properties. See Adding the New Panel to the Topology, on page 299. 
Note: The panel device bubble on the Topology Configurator does not need to be 
linked to any other bubble.

17 In the Topology Configurator, activate the topology. See Activating a Topology, on 
page 235.

18 Test the panel’s behavior. Change the Exit Page and Exit Mode property parameters for 
the Source and Destination buttons on the Category page to see how the navigation 
behavior changes.

19 Add load page buttons that will allow the panel user to return to the Home page, to 
each of the following pages: Category, Source Items, and Dest Items. See also Adding 
Resources to the Panel, on page 287 and Setting the Properties for Panel Resources, on 
page 292 for more information. 
This step is necessary because when the changing the Exit Page and Exit Mode 
property parameters for the Source and Destination buttons on the Category page, 
the panel user might wind up in a page without a way to exit out of it. Once testing is 
complete, and navigation is perfected, these buttons can be removed.
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GPIO Configurator Tasks
Tally devices you connect to the panel’s inputs can trigger events in the router control 
system such as a salvo or it can route a source to a destination. 

In reaction to pressing a panel button, to a GPI input, or to a XPT status, the router control 
system can trigger events through the panel’s relay outputs to switch your tally devices.

SUPPORTED PANELS: the following panels that support GPIO; NV9605, NV9606, NV9607, 
NV9609, NV9646, NV9649 (configured as a NV9609 panel model), NV9640, and NV9642.

Soft panels are available with GPIO controls that allow you to test and debug your GPIO 
configuration before putting a panel into production.

PREREQUISITES: The following must have been configured: 
• a Topology (Topology Configurator Tasks, on page 199) including:

• Panel Configuration: see Panel Configurator Tasks, on page 275
• Sources and destinations: see Methods to Link Devices in a Topology, on page 222.

• a router: see Configuring Router Devices, on page 422

Accessing the GPIO Configurator
To access the GPIO Configurator Task

1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select an area. See Selecting an Area, on page 183.
3 Select a topology. See Selecting a Graph, on page 184.
4 Create and configure a Panel. See Creating a New Panel, on page 277, Configuring a 

Panel’s Properties, on page 281, Adding Actions to a Panel, on page 284, and Adding 
Resources to the Panel, on page 287.

5 If a salvo is to be triggered by a GPI, create one or more salvos. See Creating Salvos, on 
page 474. 

6 If aliases are to be used, create them. See Adding Aliases, on page 467.
7 Add a panel to the topology. See Adding the New Panel to the Topology, on page 299.
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8 Select Configuration > GPIO Configurator.

The GPIO Configurator task appears:

The GPIO Configurator has the following main sections shown above:
• GPIO Rules
• GPI Rules and GPO Rule Editor
• Errors log and Script Help

GPIO Rules Menu
The GPIO rules menu has the following menu options.

Icon Description

 New Create a new rule in the rules list. See Adding a GPIO Rule, on 
page 314.

 Duplicate Make a copy of the currently-selected rule. See Duplicating a Rule, on 
page 320.

GPIO Rules

Errors log and Script Help

GPI Rules and GPO Rule Editor
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GPI / GPO Rule Editor Menu
The GPIO rule editor has the following menu options.

Adding a GPIO Rule
Create one or more rules to control your tallies. Rules can be enabled and disabled as 
needed.

To add a rule
1 Click New . 

2 Enter meaningful text in the Name and Description fields to identify the rule.

3 For the new row, click the cell for the Panel ID column.

 Delete Remove the currently-selected rule. See Deleting a Rule, on page 321.

 Alias Select the Alias to use for all rules. See Choosing an Alias for all Rules, 
on page 321.

Icon Description

 Delete Remove the configuration for this rule. 

 Select GPI Select the GPI input to be configured. See Configuring a GPI to Trigger 
an Event, on page 315.

Select GPO Select the GPO output to be configured. See Configuring a Script to 
Trigger a GPO, on page 317.

 Validate Verifies if the rule is valid

Icon Description

Note:

It is possible to create two or more rules can that act upon the same GPO, thereby 
creating a conflict. No error or warning will be flagged in this case. When two or 
more rules conflict, you must deactivate rule(s) such that only one rule controls a 
GPO at a time. See Activating / Deactivating a Rule, on page 320.
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The Panel Selector window appears showing the panels that have been previously 
configured. See Panel Configurator Tasks, on page 275.

4 Select the panel which has GPIO connections made to it that you want to configure.

5 Click OK.
The Panel Id is shown for the GPIO rule and the Status is green.

Configuring a GPI to Trigger an Event
Tally inputs (called GPIs) can be configured to trigger an event when the input transitions 
from OFF to ON and to trigger another event on a transition from ON to OFF. Events include:

• Execute a salvo. The salvo must have been previously created. See Creating Salvos, on 
page 474. 

• Route a source to a destination. The source and destination must have been previously 
created. See Logical Device Table Tasks, on page 241.

Input Transition from 
ON to OFF

GPI Contact 
Closed (ON)

GPI Contact 
Closed (ON)

GPI Contact 
Open (OFF)

Time

G
PI
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Input Transition from 
OFF to ON
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Separate actions are triggered depending on whether the transition is from ON to OFF or 
the transition is OFF to ON as shown above.

To configure a GPI state transition to route a source to a destination or trigger a salvo
1 Add a Rule if necessary. See To add a rule, on page 314. Select the rule you want to 

configure. Ensure the rule is de-activated.

2 Click the GPI tab.
3 Select the panel’s GPI input to be used as a trigger.
4 Select the action to execute when this input transitions from ON to OFF:

• Execute a salvo: select the salvo to be executed from the list. 
• Route a source to a destination: select a source and a destination from the lists.

5 Select the action to execute when this input transitions from OFF to ON:
• Execute a salvo: select the salvo to be executed from the list. 
• Route a source to a destination: select a source and a destination from the lists.

6 Repeat for the remaining GPI inputs to be used as a trigger for an action.
7 Click Validate  to check the syntax and semantics with respect to the current 

configuration and it then saves the script.
8 Activate the rule. See To activate a rule, on page 320.
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Configuring a Script to Trigger a GPO
Relay outputs can be configured to activate on a number of Boolean true or false 
conditions that form a script:

• One or more routes occurring on specific levels. 
• Conditions involving output ports (destination, level).
• A transition on one or more of the panel’s tally inputs. 

In this dialog, you create a Boolean script involving sources, destinations, port status, and 
GPI (input) status. When the conditions of the entire Boolean script evaluates as true, the 
relay output closes. When the conditions are not met, the relay output opens. Names of 
sources, destinations, levels and so on are case sensitive.

Boolean expressions comprise terms and operators. The operators include those shown 
under the Script Help tab. Expressions can be parenthesized to control the order of 
evaluation. Operator precedence is normally NOT > AND > OR. All parenthesized 
expressions are evaluated first; expressions in nested parentheses are evaluated before 
those in outer parentheses. 

Function Description

AND,OR, NOT,() Logical AND, OR, NOT, and precedence. Note that && (AND), || (OR), ! 
(NOT) are also supported.

Tally(SRC,DST) Returns true when the specified source is tallied on the specified 
destination for the SDI level.

Tally(SRC,DST,Level) Returns true when the specified source is tallied on the specified 
destination for the specified level.

Tally(SRC,DST,Levels...) Returns true when the specified source is tallied on the specified 
destination for the specified level shuffles. Level shuffle arguments are 
in pairs.

Locked(DST) Returns true when the specified destination is locked.

LockReleased(DST) Returns true when the specified destination is unlocked. 

Protected(DST) Returns true when the specified destination is protected.

ProtectReleased(DST) Returns true when the specified destination is unprotected.

GPI(GPI#, STATUS) Returns true when the GPI status is equal to the specified STATUS. 
STATUS value could be ON or OFF.

Term
Operator

Term
Operator

Term
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For example, the following script is true when Cam1 is tallied on Mon1 for the SDSDI level 
and GPI1 input is on or GPI8 input is on: 

Tally(Cam1, Mon1, SDSDI) AND (GPI(1, ON) OR GPI(8, ON))

Click a function to see an example script of how to use the function under Example.

To configure a script to control GPOs 
1 Add a Rule if necessary. See To add a rule, on page 314. Select the rule you want to 

configure. Ensure the rule is de-activated.

2 Click the GPO tab.
3 Select the panel’s GPO output to be used as a trigger.
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4 Create a script that when true will close the output relay’s contact.

5 Click Validate  to check the script’s syntax. 
Any errors are shown in the Errors tab. Correct the script as necessary. Click the Script 
Help tab for how to use script arguments. 

6 Activate the rule. See To activate a rule, on page 320.

Deleting a GPI or GPO Action Configuration
To delete a GPI or GPO action configuration

1 Click the GPI or GPO tab.

2 Select an Input or Output to be deleted.
3 Click Delete .
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Activating / Deactivating a Rule
To activate a rule

1 Set Active in the rule’s row.

The rule’s configuration becomes read only and cannot be modified. The rule’s status 
becomes a green circle to indicate that the rule is valid.

To deactivate a rule
1 Deselect Active in the rule’s row.

Duplicating a Rule
To duplicate a rule

1 Select the rule to be duplicated.
2 Click Duplicate .

3 Set the name and description of the new rule.
4 Click OK.
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Deleting a Rule
To delete a rule

1 Select the GPIO rule to be deleted.

2 Click Delete .

Choosing an Alias for all Rules
The source and destination aliases must have been previously created. See Adding Aliases, 
on page 467. The alias selection applies to all current rules.

To set an alias
1 Click Alias .

2 Set the Source and Destination aliases to use for all rules.
3 Click OK.
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Stream Configurator Tasks
The Stream Configurator task displays all streams in the current topology and allows you to 
configure on a large scale the following stream parameters:

• Set the stream’s Unicast and multicast IP addresses 
• Change the stream’s SDP template
• Change the stream’s logical levels 
• Expose or hide streams

This can be done in bulk by selecting multiple rows and using the paste functionality, to set 
the IP addresses of hundreds of streams in one action. Filters allow you to narrow down the 
list in order to only show the devices you want to change their IP addresses / port numbers. 
The list has multiple sort, so you can put the devices in the right order (from top to bottom), 
thereby allowing you to paste an incremental range of IP addresses. Content can be pasted 
from a vertical column of Microsoft Excel worksheet cells, or from a text editor where there 
is one IP address per line.

The Stream Configurator is also useful for troubleshooting: for example, you discover an 
unexpected IP address is being routed and you want to find the device associated with that 
IP address. Use the IP address in the filtering at the top of the Unicast IP or Multicast IP 
columns in the Stream Configurator to find the device.

PREREQUISITES: The following must have been configured: 
• a Topology (Topology Configurator Tasks, on page 199).
• a number of devices on the topology such as a GV Node which has a variety of streams 

(see Adding Devices to a Topology, on page 204). 

Setting the IP address in GV Orbit Control for third-party IP devices are an ideal application 
for the stream configurator; see Using Quick Config, on page 219 and the example in 
Setting Port Redundancy for Many Devices at Once, on page 220 to create such devices.

Accessing the Stream Configurator
To access the Stream Configurator Task

1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select an area. See Selecting an Area, on page 183.
3 Select a topology. See Selecting a Graph, on page 184.
4 The topology must be currently:

• Activated (see Activating a Topology, on page 235).
• Unlocked (see Unlocking / Relocking a Topology, on page 238).
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5 Select Configuration > Stream Configurator.

The Stream Configurator task appears:

Stream Configurator Menu
The Stream Configurator menu has the following menu options.

Icon Description

 Refresh Reloads the Stream Configurator’s contents. The Stream Configurator’s 
content is static. If you make a configuration change in another task, it 
will not automatically be reflected in the Stream Configurator.

 Select All Selects all rows in the Stream Configurator. 

 Clear All Deselects all rows in the Stream Configurator. 

 Filters Filters the list by signal type and direction. See Stream Configurator 
Filters Tool, on page 325.
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 Paste IP addresses Pastes the clipboard contents to the selected Stream Configurator’s 
column from a Microsoft Excel spreadsheet column or a text editor, 
where there is one IP address per line.
See Pasting Unicast and Multicast IP Addresses from a Microsoft Excel 
Spreadsheet / Text Editor, on page 326.
Certain IP addresses are reserved by GV Orbit Control and cannot be 
used. Refer to the Release Notes for more information. See Related 
Documentation, on page 7.

 Set stream SDP file Set the SDP pattern for streams. See Setting SDP Templates for one or 
more Streams, on page 327.

 Set stream level Sets the logical level of one or more selected streams. This shows the 
Logical Level Selector. 

Select a logical level and click OK to change the level of all selected 
streams to the new logical level.
For more information about logical levels, see Logical Level Editor 
Tasks, on page 190.

 Expose or hide 
streams

Sets to expose or hide streams of one or more selected streams. Only 
certain devices support this property. When Expose Stream is set, it 
displays the streams for this device in the Logical Device Table. See 
Logical Device Table Tasks, on page 241. 

Filter

Row filters can be applied to each column by typing text in the filter 
boxes to filter the list according to a column’s content. The 
combination of all applied filters means that a row must match all filter 
values in order to be displayed. See Filtering the Stream Configurator 
List, on page 325. See also Filtering Lists, Table Columns, Sources, and 
Destinations, on page 266.

Icon Description



325

GV Orbit Version 2.3.0 Configuration Tasks
User Guide Stream Configurator Filters Tool

Stream Configurator Filters Tool
A filter button is available in the toolbar for you to show or hide signal types (SDI, IP, MADI) 
or signal direction (Input/Rx and Output/Tx streams).

Pasting IP addresses from a Microsoft Excel worksheet into the 
Stream Configurator

In order to paste a vertical column of worksheet cells of an ordered list of IP addresses you 
have created in Microsoft Excel, you must first prepare the Stream Configurator by:

1 Filtering the table to only show the devices, inputs / outputs, signal type, logical levels, 
for which you are going to update their IP addresses. Filters allow you to narrow down 
the Stream Configurator list in order to only show the devices of interest.

2 Sorting the filtered list such that the devices are in the same order as the vertical 
column of worksheet cells you have created in Microsoft Excel.

3 Paste a vertical column of worksheet cells you have created in Microsoft Excel into 
either the Unicast IP or Multicast IP columns of the Stream Configurator.

Certain IP addresses are reserved by GV Orbit Control and cannot be used. Refer to the 
Release Notes for more information. See Related Documentation, on page 7.

Filtering the Stream Configurator List
First, filter the Stream Configurator’s contents to create a list of only the devices that are of 
interest; those devices you want to update their IP addresses.

Icon Description

Show SDI Show results where the connection type is SDI.

Show IP Show results where the connection type is IP.

Show MADI Show results where the connection type is MADI.

Show inputs / rx Show results where the connection direction is an input.

Show outputs / tx Show results where the connection direction is an output.

Set the required filters

Click to open filter tool
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Filtering can be done by combining the following methods:
• Use the Filters tool to show or hide signal types (SDI, IP, MADI) or signal direction 

(Input/Rx and Output/Tx streams). See Stream Configurator Filters Tool, on page 325.
• Enter text into the row filters found at the top of each column by typing text in the filter 

boxes to filter the list according to a column’s content. The combination of all applied 
filters means that a row must match all filter values in order to be displayed. See 
Filtering Lists, Table Columns, Sources, and Destinations, on page 266.

Sorting the Stream Configurator List
Once the Stream Configurator’s contents have been filtered, then sort the filtered list.

The list has multiple sort, so you can put the devices in the right order (from top to bottom), 
thereby allowing you to paste an incremental range of IP addresses. Content can be pasted 
from a vertical column of Microsoft Excel worksheet cells, or from a text editor where there 
is one IP address per line.

Each column can be sorted by clicking the header text. Multiple sort can be applied by 
<Shift> + clicking the headers. Bullets and numbers will appear next to the sort arrow 
indicating the column’s sort priority. An up arrow is ascending sort, and a down arrow is a 
descending sort.

Pasting Unicast and Multicast IP Addresses from a Microsoft Excel 
Spreadsheet / Text Editor
Unicast and Multicast IP address values can be bulk pasted into the Stream Configurator 
from a Microsoft Excel spreadsheet column by using copy/paste. 

• Multicast IPs are formed with the following semi-colon separated concatenated format: 
[IPv4 Address]:[Port Number]. For example, the text to be pasted for a multicast 
address should look like 231.102.30.13:5004
If you paste an IPv4 address without a port number into the Multicast IP column, only 
the IP address will be updated and the current port number will be left intact.

• Unicast IPs are a basic IP address without a port number.

To paste Unicast or Multicast IP Addresses
1 Select a column with IP addresses from a Microsoft Excel spreadsheet and copy them. 
2 Select the rows in the Stream Configurator that contain the streams to be changed. See 

Selecting Stream Configurator Rows, on page 329.

First sort 
priority (one 

bullet)

Second sort 
priority (two 

bullets)

Third sort 
priority 
(three 

bullets)

Fourth sort 
priority 

Fifth sort 
priority 

Eighth sort 
priority 
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3 Click the paste  button in the Stream Configurator toolbar. Choose whether to apply 
the paste to Unicast or Multicast IP addresses. The paste is made starting from top-to-
bottom of the selected rows.

Editing Unicast and Multicast IP Addresses
Cells in the Unicast IP column can be double-clicked in oder to edit their contents. These 
cells will only accept valid IPv4 addresses.

Cells in the Multicast IP column can also be double-clicked in oder to edit their contents. 
These cells only accept valid IPv4 addresses and a port number separated by a colon (:). For 
example 231.102.30.13:1080. 

Setting SDP Templates for one or more Streams
Not all devices are NMOS compliant, however with the use of SDP parameters, GV Orbit 
Control may be able to make a take of a stream from a non-NMOS Device to an NMOS 
Device. GV Orbit Control can intuit some SDP parameters while other parameters will have 
to be provided by you. For more information about how to form an SDP template, see Using 
SDP Parameters to Take a Stream from a non-NMOS Device to an NMOS Device, on 
page 385.

You can set the SDP templates for one or more streams as follows.
1 If necessary, filter and sort the Stream Configurator list to only show the devices, inputs 

/ outputs, signal type, logical levels, for which you are going to update their SDP 
templates. Filters allow you to narrow down the Stream Configurator list in order to 
only show the devices of interest. See Filtering the Stream Configurator List, on 
page 325 and Sorting the Stream Configurator List, on page 326.

2 Select the rows in the Stream Configurator that contain the streams to be changed. See 
Selecting Stream Configurator Rows, on page 329.

3 Click the cogwheel  icon. The SDP template text for the last selected stream in the 
table is shown in a pop-up.
If the last selected stream type is SDI or a receiver, the SDP template text area will be 
blank. 

4 Type in or paste the SDP template text into the pop-up text area and click OK. See 
Using SDP Parameters to Take a Stream from a non-NMOS Device to an NMOS Device, 
on page 385.

Note: All pasted IP addresses are validated and if any one address is invalid, the 
entire paste is canceled and nothing happens.
Certain IP addresses are reserved by GV Orbit Control and cannot be used. Refer to 
the Release Notes for more information. See Related Documentation, on page 19.

Note: The SDP text you enter is not validated by GV Orbit Control. The SDP is directly 
applied to IP streams only. All other stream types are ignored.
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All selected streams will be updated with the new SDP template.

GV Orbit Control SDP Variables that can be used with Third-Party Devices

The following table lists whether the GV Orbit Control SDP variables are supported when 
used with third-party devices. Any unsupported SDP variable must be replaced by a hard 
coded value that represents the third-party device’s static property value.

GV Orbit Control SDP 
Variable

Supported with third-
party-devices Description

${audioBits} The audio stream’s bit depth.

${channelCount} The number of (audio) channels.

${clockSetting} The PTP master clock setting.

${sequence} This SDP file’s ID.

${packetTime} The length of time in milliseconds 
represented by the (audio) media in a 
packet.

${portIpAddress}  The sending port’s IP address.
The source for this variable comes from 
the Port’s IP Address parameter for this 
stream.

${streamIpAddress}  The transmit (sending) stream’s 
multicast IP address.
The source for this variable comes from 
the stream’s IP Address parameter.

${streamPortNumber}  The transmit (sending) stream’s IP port 
number.
The source for this variable comes from 
the stream’s IP Port parameter.

${redundantIpAddress}  The transmit (sending) stream’s 
redundant multicast IP address.
The source for this variable comes from 
the stream’s IP Address parameter 
used for the redundancy port. See the 
Redundancy Port parameter to 
identify the current redundancy port. 

${redundantPortNumber}  The transmit (sending) stream’s 
redundant IP port number.
The source for this variable comes from 
the stream’s IP Port parameter used for 
the redundancy port. See the 
Redundancy Port parameter to 
identify the current redundancy port. 
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Selecting Stream Configurator Rows
Stream Configurator rows can be selected as follows:

• All current rows can be selected by clicking Select All from the Stream Configurator’s 
menu. See Stream Configurator Menu, on page 323.

• Select one or more streams in the Stream Browser using <Ctrl> + click.
• Select a range of streams in the Stream Browser by selecting the first stream and then 

<Shift> + click the last stream in the range.

${redundantPortIpAddre
ss}

 The transmit (sending) stream’s 
redundant IP port number.
The source for this variable comes from 
the stream’s IP Address parameter 
used for the redundancy port. See the 
Redundancy Port parameter to 
identify the current redundancy port. 

${rtpPayloadType} The RTP payload type as defined by 
the SDP specification.

${samplingRate} The audio stream’s sampling rate.

GV Orbit Control SDP 
Variable

Supported with third-
party-devices Description
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The configuration of certain features for a specific device require an in depth explanation 
which is provided here.

Special Devices

These special device are described under the following headings:
• Configuring a GV Node Device, on page 333
• Configuring an IPG-3901 / IPG-4901 Device, on page 343
• Configuring an IPVU Device, on page 349
• Configuring an IQMix, IQUCP, or UCP-3901 Device, on page 352
• Configuring UHD 4K Two-Sample Interleave Division IP Streams for use with an IQMix, 

IQUCP, UCP-3901, or IPVU Device, on page 354
• Configuring UHD 4K Quad-Link SDI Streams for use with an IQMix, IQUCP, UCP-3901, or 

IPVU Device, on page 359
• Configuring an MV-820-IP Multiviewer Device, on page 363
• Configuring a Kahuna IP Production Switcher Device, on page 367
• Configuring a K-Frame Production Switcher, on page 370
• Adding NMOS Devices to a Topology, on page 377
• Using SDP Parameters to Take a Stream from a non-NMOS Device to an NMOS Device, 

on page 385
• Configuring Cisco DCNM Network Switch Devices, on page 389
• Direct Flow Orchestration: How To Create a Static Flow with a Cisco Network Switch, on 

page 395
• Configuring a GV Fabric Network Switch Device, on page 396
• Configuring Network Switch Redundancy to Support SMPTE ST 2022-7, on page 399
• Configuring an NVISION Hybrid Series Router, on page 404
• Configuring a Sirius Series Router, on page 411 
• Configuring Router Devices, on page 422
• Configuring a Device that Supports Audio Breakaway/Shuffling such as Audio Live, on 

page 433
• Configuring an IQAMD40 Device, on page 446
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Description of Common Device Properties
The description for certain device properties are universal.

Parameter Description

# Input Connectors The number of physical input port connections made to the device. 
This shows the current status for information purposes.

# Output Connectors The number of physical output port connections made to the device. 
This shows the current status for information purposes.

# Streams Per Input The typical number of streams available on each physical input 
connection. This shows the current status for information purposes. 

# Streams Per Output The typical number of streams available on each physical output 
connection. This shows the current status for information purposes.

# Streams The actual number of streams available on the selected physical input 
/ output connection. This shows the current status for information 
purposes.

Automatic 
Destination
Automatic 
Destinations on 
Inputs
Automatic 
Destinations on 
Outputs

Set to automatically create a destination by the system for the 
specified streams. See also About Automatic Sources or Destinations, 
on page 246.

Automatic Source
Automatic Sources on 
Outputs
Automatic Sources on 
Inputs

Set to automatically create a source by the system for the specified 
streams. See also About Automatic Sources or Destinations, on 
page 246.

Description An optional description for the related input, output, or device.

Enabled This shows the current status for information purposes.

Expose Streams When set, it displays the streams for this device in the Logical Device 
Table. See Logical Device Table Tasks, on page 241. 
Quick Config can be used to set or clear this parameter; see Using 
Quick Config, on page 219. 

Logical Level The logical level for this input or output. See Logical Level Editor Tasks, 
on page 190.

Name The name or identifier for this device instance.
The name or identifier for this input or output port.

Short Name The nickname by which the input, output, or device is referred to 
everywhere in the system. 

SSM Address Enabled Shows if the source specific multicast address is enabled. 

SDP See Using SDP Parameters to Take a Stream from a non-NMOS Device 
to an NMOS Device, on page 385.
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Configuring a GV Node Device
To configure a GV node Device

1 Add the GV Node device to the Topology: from the Device Library, Virtual Device, find 
the GV Node device bubble. See Adding a Virtual Device to a topology, on page 204. 

2 Select the GV Node bubble and configure the Device Properties in the Property Editor. 
See Defining Device Properties, on page 229 for more information.

See also Description of Common Device Properties, on page 332.

Parameter Description

Frame IP Address The network IP address for the associated GV Node frame.

Network Host Name The hostname is the unique name by which the associated GV Node 
CPU-ETH3 is known on the network. 

Advanced > 
Description

An optional description for this GV Node’s control port.



334

Special Device Configuration Tasks GV Orbit Version 2.3.0
Configuring a GV Node Device User Guide

Advanced > 2022-7 
Mode

When the IFM-2T-OPT-40G-6 option is active, you can choose to 
enable SMPTE ST 2022-7 Low Latency redundant, high-bit-rate 
streams on the aggregation ports, using the GV Node manager.
If this option has been enabled in the GV Node Manager, then enable 
it here. 

Advanced > 6 HD 
Mode

This no redundancy, low bitrate option reduces each channel from 
3Gbps to 1.5Gbps, allowing all 144 channels to be sent on aggregation 
ports 1-6, and leaving aggregation ports 7-12 unused.
If this option has been enabled in the GV Node Manager, then enable 
it here. 

Advanced > Card 
Enabled Option

This option controls audio embedding / de-embedding. 
For example, the XIO-4901 3G/HD/SD SDI input/output card supports 
audio embedding/de-embedding, as a software option (MDX):
MDX: The GV Node Manager allows you to enable or disable audio 
embedding/de-embedding on a card’s SDI inputs and outputs.
None: If your system is monitoring MADI signals (supported at the 
XIO-4901 card’s inputs/outputs 8 and 9), then disabling the MDX 
option lets you select MADI at the inputs and outputs matching your 
physical configuration. See Configuring MADI support with a GV Node 
Device, on page 339 for more information.

Advanced > Card 
Mode

Set the signal type.

Advanced > Gateway 
Connection State 1

Gateway Connection State 1 shows the connection status of the GV 
Node frame with the primary server of a server group. 
Gateway Connection State 2 shows the connection status of the GV 
Node frame with the secondary server of a server group. See 
Configuring a Controller Group, on page 179.
unknown: The topology is inactive (see Activating a Topology, on 
page 235) or the GV Node frame does not have network connectivity 
to the GV Orbit Server(s).
offline: The GV Node frame does not have network connectivity to the 
GV Orbit Server(s).
online: The GV Node frame is connected to the GV Orbit Server(s).

Advanced > Gateway 
Connection State 2

Advanced > Gateway 
NP16 Connection 
State

This shows the NP16 connection status of the GV Node frame with a 
server of a server group. 
unknown: The topology is inactive (see Activating a Topology, on 
page 235) or the GV Node frame does not have network connectivity 
to the GV Orbit Server(s).
offline: The GV Node frame does not have network connectivity to the 
GV Orbit Server(s).
online: The GV Node frame is connected to the GV Orbit Server(s).

Advanced > IFM-2T 
Version

 The IFM-2T Fabric Module User Interface version number.

Advanced > Internal 
Wiring Done

Shows if the internal modeling of the GV Node is complete.

Parameter Description
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3 Configure the card in each slot and configure the inputs and outputs for each card by 
making a selection at the top to make the related parameters become available below. 

Advanced > Join 
Timeout (ms)

When GV Orbit Control is used with a GV Node version 1.3.0, to allow a 
clean switch that will not be reported as a fail, we recommend this 
parameter to be set to 2 ms. 

Advanced > Router 
Connection State 1

Router Connection State 1 shows the connection status of the router 
with the primary server of a server group. 
Router Connection State 2 shows the connection status of the router 
with the secondary server of a server group. See Configuring a 
Controller Group, on page 179.
unknown: The topology is inactive (see Activating a Topology, on 
page 235) or the router does not have network connectivity to the 
GV Orbit Server(s).
offline: The router does not have network connectivity to the GV Orbit 
Server(s).
online: The router is connected to the GV Orbit Server(s).

Advanced > Router 
Connection State 2

Select the
To configure the properties exposed below 
under

Card by its slot number in Slots Slot #

Card’s SDI output number in SDI Outputs.
Then select the Card’s SDI Output Stream 
Configuration number in Streams

Out #
GV Node-[instance] Out #

Card’s Stream SDP Configuration number 
in Stream SDP Config

IP Stream Prototype #

Card’s Input Lanes number in Input Lanes.
Then select the card’s stream number in 
Streams.

Eth In #.#
GV Node-[instance] Eth In#.# Stream #

Parameter Description
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Configure the GV Node Card Properties in the Property Editor. See also Description of 
Common Device Properties, on page 332.

Card’s SDI Input number in SDI Inputs.
Then select the card’s stream number in 
Streams.

In#
GV Node-[instance] In#

Card’s Output Lanes number in Output 
Lanes.
Then select the card’s stream number in 
Streams.

Eth Out #.#
GV Node-[instance] Out#.# Stream #

Parameter Description

Slot #

Card Enabled Option This option controls audio embedding / de-embedding. 
For example, the XIO-4901 3G/HD/SD SDI input/output card supports 
audio embedding/de-embedding, as a software option (MDX):
MDX: The GV Node Manager allows you to enable or disable audio 
embedding/de-embedding on a card’s SDI inputs and outputs.
None: If your system is monitoring MADI signals (supported at the 
card’s inputs/outputs 8 and 9), then disabling the MDX option lets you 
select MADI at the inputs and outputs matching your physical 
configuration. See Configuring MADI support with a GV Node Device, 
on page 339 for more information.

Out #

Name The name or identifier for this SDI output.

# Sreams The number of streams for this SDI output.

Port Identifier An input lane is specified as QSPFport.lane which in turn corresponds 
to a physical port on the router. The number property specifies which 
physical port it is. The port identifier is how you name it so that you 
can refer to it.

Number Set the port number on the router.

Direction This shows the current status for information purposes.

Connector Type

Capacity (bps) The stream’s data rate.

IP Address The stream’s network IP address.

Mods-Out to IFM This option sets the expected output signal type: 
SDI: The output signal is a standard SDI video signal with embedded 
audio. 
MADI: The output signal is a MADI signal (supports 64 audio 
channels). See Configuring MADI support with a GV Node Device, on 
page 339 for more information.

Select the
To configure the properties exposed below 
under
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Redundancy Port Associate this port with another port to create a redundant network 
traffic flow path for failover protection. The associated port will not be 
available to carry other traffic.

GV Node-[instance] Out #

Name The name or identifier for this SDI output.

Automatic Source Set to automatically create a source by the system using the specified 
stream.

Bandwidth (bps) The stream’s data rate.

IGMPv3 SSM Address Source Specific Multicast address as per IGMPv3 (Internet Group 
Management Protocol) protocol.

IP Stream Prototype #

Name The name or identifier for this SDI output.

Flow Type Set the content type for this stream: Audio, Data, or Video.

SDP The Session Description Protocol is a format for describing streaming 
media communications parameters.

Eth In #.#

Name The name or identifier for this IP input.

# Sreams The number of streams for this IP input.

Port Identifier An input lane is specified as QSPFport.lane which in turn corresponds 
to a physical port on the router. The number property specifies which 
physical port it is. The port identifier is how you name it so that you 
can refer to it.

Number Set the port number on the router.

Direction This shows the current status for information purposes.

Connector Type

Capacity (bps) The stream’s data rate.

GV Node-[instance] Eth In#.# Stream #

Name The name or identifier for this IP input.

Flow Type Set the content type for this stream: Audio, Data, or Video.

Automatic Source Set to automatically create a source by the system using the specified 
stream.

SDP The Session Description Protocol is a format for describing streaming 
media communications parameters.

IGMPv3 SSM Address Source Specific Multicast address as per IGMPv3 (Internet Group 
Management Protocol) protocol.

IP Address The stream’s network IP address.

IP Port Port number for the stream.

In#

Parameter Description
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Name The name or identifier for this IP input.

# Sreams The number of streams for this IP input.

Port Identifier An input lane is specified as QSPFport.lane which in turn corresponds 
to a physical port on the router. The number property specifies which 
physical port it is. The port identifier is how you name it so that you 
can refer to it.

Number Set the port number on the router.

Direction This shows the current status for information purposes.

Connector Type

Capacity (bps) The stream’s data rate.

Bandwidth Usage 
(bps)

The stream’s data rate.

IP Address The stream’s network IP address.

Mods-In to IFM This option sets the expected input signal type: 
SDI: The input signal is a standard SDI video signal with embedded 
audio. 
MADI: The input signal is a MADI signal (supports 64 audio channels). 
See Configuring MADI support with a GV Node Device, on page 339 
for more information.

Redundancy Port Associate this port with another port to create a redundant network 
traffic flow path for failover protection. The associated port will not be 
available to carry other traffic.

GV Node-[instance] In#

Name The name or identifier for this IP input.

Automatic Source Set to automatically create a source by the system using the specified 
stream.

IGMPv3 SSM Address Source Specific Multicast address as per IGMPv3 (Internet Group 
Management Protocol) protocol.

Eth Out #.#

Name The name or identifier for this IP input.

# Sreams The number of streams for this IP input.

Port Identifier An input lane is specified as QSPFport.lane which in turn corresponds 
to a physical port on the router. The number property specifies which 
physical port it is. The port identifier is how you name it so that you 
can refer to it.

Number Set the port number on the router.

Direction This shows the current status for information purposes.

Connector Type

Capacity (bps) The stream’s data rate.

Parameter Description
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Configuring MADI support with a GV Node Device
To support a MADI input on a GV Node frame, this option must be configured both in 
GV Orbit Control and the MADI input must have been previously configured in iControl 
Navigator; locate the GV Node Manager associated with your GV Node and double-click its 
icon. For example, the following figure shows the 9th input XIO-4901 card in slot 16 is set to 
accept a MADI input. Within GV Orbit Control, the same setting must be made wherever a 
MADI input has been configured in iControl Navigator for a GV Node frame.

Fig. 7-1: A GV Node in iControl Navigator

Bandwidth Usage 
(bps)

The stream’s data rate.

IP Address The stream’s network IP address.

Redundancy Port Associate this port with another port to create a redundant network 
traffic flow path for failover protection. The associated port will not be 
available to carry other traffic.

GV Node-[instance] Out#.# Stream #

Name The name or identifier for this IP input.

IP Address The stream’s network IP address.

IP Port Port number for the stream.

Flow Type Set the content type for this stream: Audio, Data, or Video.

Automatic Source Set to automatically create a source by the system using the specified 
stream.

SDP The Session Description Protocol is a format for describing streaming 
media communications parameters.

Bandwidth (bps) The stream’s data rate.

IGMPv3 SSM Address Source Specific Multicast address as per IGMPv3 (Internet Group 
Management Protocol) protocol.

Parameter Description
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The above iControl Navigator configuration is used as an example configuration for the 
following procedure.

To configure a GV node MADI input in GV Orbit Control
1 Select the required Area. See Selecting an Area, on page 183.
2 Select the required topology. See Selecting a Graph, on page 184.
3 Add and configure a GV Node device. See Configuring a GV Node Device, on page 333.
4 In the Property Editor for the GV Node device, make the same setting as in GV Node 

Manager for Enabled Options for the card: in the GV Node’s properties, in Slots, select 
16, then set None in Card Enabled Option.

5 Use the following table to identify the SDI input number used by GV Orbit Control from 
the card’s slot and input number for the next step. Only the eighth and ninth inputs of 
each slot support MADI input signals. For example, the ninth input of the card in slot 16 
is 144.

Matrix Input from Fabric Number for each GV Node Frame Slot

Card’s Input 
from GV Node 
Fabric 

GV Node Frame Slot Number

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

First Input 1 10 19 28 37 46 55 64 73 82 91 100 109 118 127 136

Second Input 2 11 20 29 38 47 56 65 74 83 92 101 110 119 128 137

Third Input 3 12 21 30 39 48 57 66 75 84 93 102 111 120 129 138

Fourth Input 4 13 22 31 40 49 58 67 76 85 94 103 112 121 130 139

Fifth Input 5 14 23 32 41 50 59 68 77 86 95 104 113 122 131 140

Sixth Input 6 15 24 33 42 51 60 69 78 87 96 105 114 123 132 141
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6 In the Property Editor for the GV Node device, make the same setting as in GV Node 
Manager for the card’s input: in the GV Node’s properties, in SDI Inputs, select 144, then 
set MADI in Mods-In to IFM.

For each MADI input, 64 audio streams are shown in Streams and the logical level is 
MADI for each stream. These 64 streams are made available within the Logical Device 
Table for use on manually created logical devices. If you choose the Automatic 
source/destination option for the MADI, then 4 devices of 16 channels of audio are 

Seventh Input 7 16 25 34 43 52 61 70 79 88 97 106 115 124 133 142

Eighth Input 8 17 26 35 44 53 62 71 80 89 98 107 116 125 134 143

Ninth Input 9 18 27 36 45 54 63 72 81 90 99 108 117 126 135 144

Matrix Input from Fabric Number for each GV Node Frame Slot (continued)

Card’s Input 
from GV Node 
Fabric 

GV Node Frame Slot Number

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
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created in the Logical Device Table on the appropriate tab. See Logical Device Table 
Tasks, on page 241.
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Configuring an IPG-3901 / IPG-4901 Device
The Densité IP Gateway (IPG-3901) plug-and-play module is a 3 RU module for the Densité 
3 frame, which provides bidirectional IP/SDI conversion. The Gateway operates with 10 
GigE audio/video video-over-IP, supporting UHD/3G/HD/SD-SDI formats.

The GV Node IP Gateway (IPG-4901) plug-and-play module is a 3 RU single slot module for 
the GV Node frame, which provides bidirectional fiber IP connectivity to provide conversion 
to and from other equipment that cannot be handled directly by the GV Node aggregation 
ports (GV Node’s receivers and transmitters). This card allows you to expand the receivers 
available on the GV Node, as well as it brings more flexibility to the allowed audio profiles 
that can be accepted through the IPG-4901

PREREQUISITES: All IPG-3901 and IPG-4901 devices must have been previously configured 
in iControl Navigator. GV Orbit Control reads this configuration information from iControl 
through the GV Node / Densité Manager. 

To configure an IPG-3901 / IPG-4901 Device
1 Add the IPG-3901 or IPG-4901 device to the Topology: from the Device Library, Virtual 

Device, find the IPG-3901 or IPG-4901 device bubble. See Adding a Virtual Device to a 
topology, on page 204. 
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2 Select Device Group Properties. Configure the GV Node IP Address / Frame IP 
Address and Slot Number properties. 

See also Description of Common Device Properties, on page 332.

3 Activate the topology. See Activating a Topology, on page 235.
The card configuration is read from Densité Manager and applied to the device.

Parameter Description

# Devices The number of panel instances in this device group.

Network Host Name The hostname is the unique name by which the associated 
IPG-3901 or IPG-4901 is known on the network. 

# Input Connections The current status for information purposes, once the GV Node 
IP Address and Slot Number parameters are configured and 
the topology is activated. See Activating a Topology, on 
page 235.

# Output Connections

Advanced > Default 
Connector Type

Advanced > # Streams Per 
Input

Advanced > # Streams Per 
Output

Advanced > Receive Stream 
IP Pattern

Advanced > Send Stream IP 
Pattern
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4 Select the Device Properties tab and then select IPG next to Devices. See also 
Description of Common Device Properties, on page 332.

Parameter

Applies to

DescriptionIPG-3901 IPG-4901

Network Host Name   The hostname is the unique name by which the 
associated IPG-3901 or IPG-4901 is known on 
the network. 

GV Node IP Address  IP Address of the CPU-ETH3 for the GV Node 
frame into which the IPG-4901 card is installed.

Frame IP Address  IP Address of the CPU-ETH3 for the Densité 
frame into which the IPG-3901 card is installed.

Slot Number   The slot in which the IPG-3901 or IPG-4901 
device is located in the GV Node frame.

Connection to 
Controller 1

  Connection to Controller 1 shows the 
connection status of the IPG device with the 
primary server of a server group. 
Connection to Controller 2 shows the 
connection status of the IPG device with the 
secondary server of a server group. See 
Configuring a Controller Group, on page 179.
unknown: The topology is inactive (see 
Activating a Topology, on page 235) or the IPG 
device does not have network connectivity to 
the GV Orbit Server(s).
offline: The IPG device does not have network 
connectivity to the GV Orbit Server(s).
online: The IPG device is connected to the 
GV Orbit Server(s).

Connection to 
controller 2

 

Firmware Version   Shows the firmware version installed on the 
IPG-3901 or IPG-4901 card. This shows the 
current status for information purposes.

Internal Wiring Done   Shows if the internal modeling of the IPG-3901 
or IPG-4901 is complete.

Operation Mode   Shows the operation mode of the ETH2 port of 
the IPG-3901 or IPG-4901 card for information 
purposes:
Redundancy: ETH 2 is redundant to ETH 1. 
Aggregation: Both ETH 1 and ETH 2 are 
available simultaneously.
OFF: ETH 2 is disabled.



346

Special Device Configuration Tasks GV Orbit Version 2.3.0
Configuring an IPG-3901 / IPG-4901 Device User Guide

5 Select ETH# next to Ethernet Ports. These are the network configuration parameters 
for the IPG-3901 or IPG-4901 card’s Ethernet ports. See also Description of Common 
Device Properties, on page 332.

6 Select one of the streams next to Gateways (by default labelled as OUT# or IN#). See 
also Description of Common Device Properties, on page 332.

7 Select 1 or 2 next to Streams. See also Description of Common Device Properties, on 
page 332.

Parameter Description

IP Address The network IP address for this Ethernet port. 

Gateway The network gateway IP address.

Subnet Mask The IP network’s subnet mask.

Parameter Description

Direction This shows the current status for information purposes.

Logical Level on SDI Stream To force a stream to use the IPG-3901 or IPG-4901 device, 
create a new level (see Duplicating a Logical Level, on 
page 193) that you will use to select these specific streams at 
the source and destination ports. Set the logical level that will 
be used for this here.
For example, create a logical level called IPG-SDI from the SDI 
logical level. Now use this level to send and receive streams to 
and from this device.

Parameter Description

Ethernet Port The Ethernet port this gateway is assigned to (ETH 1 or ETH 2). 
This shows the current status for information purposes.

Format The gateway format: SD, HD, or 3G for video streams, or AES67 
profile for audio streams. This shows the current status for 
information purposes.

IGMPv3 Source For a receiver gateway, this is the address of the joined stream’s 
port when SSM Address is enabled on the device.

IP Address The stream’s network IP address.

Logical Level on ETH stream The Logical level to apply on the ETH side of the gateway. By 
default for the video stream, this value is SDI and for the audio 
stream, this value is SDI audio.

Port The stream's network port.

Redundant IGMPv3 Source When the IPG-3901 or IPG-4901 card is in Redundancy mode: 
For a receiver gateway, this is the address of the joined stream’s 
port when SSM Address is enabled on the device.
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Connecting an IPG-4901 device
The IPG 4901 has 9 SDI input ports, 9 SDI output ports, and 2 bidirectional ETH ports. The 
SDI ports must be connected to the SDI ports of the GV Node in which the IPG-4901 is 
slotted in. This rule is not enforced in GV Orbit Control. GV Orbit Control allows you to use 
an IPG-4901 like an IPG-3901, however this is not a valid use case and will not work.

The 9 SDI input ports short labels are called OUT for OUT from fabric, and the 9 SDI output 
ports short labels are called IN for In to fabric to follow iControl’s behavior.

Device properties
• It is possible to assign a logical level to SDI ports by changing the Logical Level of SDI 

stream at the Gateway level.
• It is possible to assign a logical level to IP streams by changing the Logical Level on ETH 

stream on Stream level, under the Gateway.
• It is possible to change the multicast address for SDI to IP gateways (called OUT) by 

changing the IP Address, Port, Redundant IP Address and Redundant Port properties 
on Stream level, under Gateway. These changes are propagated to iControl.

• In OFF or Redundancy mode, gateways OUT 6 to 9 and IN 6 to 9 are disabled and not 
visible in Property Editor. They become visible only if card is in Aggregation mode.

Redundant IP Address When the IPG-3901 or IPG-4901 card is in Redundancy mode: 
The stream’s network IP address.

Redundant Port When the IPG-3901 or IPG-4901 card is in Redundancy mode: 
The stream's network port.

Parameter Description
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Example Topology Using an IPG-4901 
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Configuring an IPVU Device
The IPVU is a compact dual-channel IP-to-HDMI converter that is perfect for displaying IP 
sources and a multiviewer’s IP outputs on HD and UHD HDMI displays. 

The inputs of an IPVU are called spigots. See also How to Know if a Spigot is an Input or an 
Output, on page 353.

There is no offline configuration of the IPVU device. It must first be discovered on the 
network by GV Orbit Control. 

The IPVU device must have been previously configured with GV Orbit Client before being 
integrated into GV Orbit Control as most configuration parameters shown in GV Orbit 
Control are for information purposes only (GV Orbit Control reads it from the IPVU devices). 
See the IPVU Installation Guide for more information.

PREREQUISITES: The Domain ID of the IPVU device(s) must be set in the System Controller 
Group Properties under Domain Ids. See Configuring a Controller Group, on page 179. 
These devices must be on the same subnet that the GV Orbit Server is connected to. 

Related Topics
• How to Know if a Spigot is an Input or an Output, on page 353.
• Configuring UHD 4K Two-Sample Interleave Division IP Streams for use with an IQMix, 

IQUCP, UCP-3901, or IPVU Device, on page 354.
• Configuring UHD 4K Quad-Link SDI Streams for use with an IQMix, IQUCP, UCP-3901, or 

IPVU Device, on page 359.

Spigot Usage

An IPVU device has 8 input spigots. They are used according to the IPVU’s output resolution.

WARNING
The IPVU’s configuration is set through GV Orbit Client and then GV Orbit Control 
reads the configuration from the IPVU device. All spigots on an IPVU are inputs.

Input Spigot Number HD Output Description  UHD Output Description

Spigot1 Stream input for Monitor 
Output 1 connection

SMPTE ST 424-5 Link 1 input stream for 
Monitor Output 1 output connection

Spigot2 Not used SMPTE ST 424-5 Link 2 input stream for 
Monitor Output 1 output connection

Spigot3 Not used SMPTE ST 424-5 Link 3 input stream for 
Monitor Output 1 output connection

Spigot4 Not used SMPTE ST 424-5 Link 4 input stream for 
Monitor Output 1 output connection

Spigot5 Stream input for Monitor 
Output 2 connection

SMPTE ST 424-5 Link 1 input stream for 
Monitor Output 2 output connection

Spigot6 Not used SMPTE ST 424-5 Link 2 input stream for 
Monitor Output 2 output connection
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To configure an IPVU Device
1 Add the IPVU device to the Topology: from the Device Library, Discovered, find an 

IPVU device bubble that you want to control. See To add a Discovered Device to a 
Topology, on page 209. 

2 Configure the IPVU properties. See also Description of Common Device Properties, on 
page 332. The IPVU device should be first configured with GV Orbit Client before being 
integrated into GV Orbit Control as most configuration parameters shown in GV Orbit 
Control are shown for information purposes only. 

Spigot7 Not used SMPTE ST 424-5 Link 3 input stream for 
Monitor Output 2 output connection

Spigot8 Not used SMPTE ST 424-5 Link 4 input stream for 
Monitor Output 2 output connection

Parameter Description

Network Host Name The hostname is the unique name by which the associated IPVU is 
known on the network. 

Domain ID Set the same Domain IDs on all IPVU devices that are to communicate 
with each other on the network. 
The default value for Grass Valley equipment is 101.
Valid range: 0 to 232.
See also Configuring a Controller Group, on page 179.

Internal wiring Shows if the internal modeling of the IPVU is complete.

Input Spigot Number HD Output Description  UHD Output Description
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3 Create and connect the core IP devices to the IPVU. See Methods to Link Devices in a 
Topology, on page 222.
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Configuring an IQMix, IQUCP, or UCP-3901 Device
The IQMIX / IQUCP / UCP-3901 series is a range of multi-channel video over IP transceiver 
modules developed for use within low latency, high bandwidth Ethernet IP networks, 
capable of encoding / decoding multiple SDI signals. They provide both compressed and 
uncompressed modes of operation.

The inputs and outputs of an IQMIX / IQUCP / UCP-3901 are called spigots. There are a 
variety of spigot configurations that are available; for example, 6 inputs / 6 outputs, 12 
inputs / 0 outputs, 0 inputs / 12 outputs, 8 inputs / 0 outputs. See also How to Know if a 
Spigot is an Input or an Output, on page 353.

There is no offline configuration of the IQMIX / IQUCP / UCP-3901 device. It must first be 
discovered on the network by GV Orbit Control. 

The IQMIX / IQUCP / UCP-3901 device must have been previously configured with GV Orbit 
Client before being integrated into GV Orbit Control as most configuration parameters 
shown in GV Orbit Control are for information purposes only (GV Orbit Control reads it from 
the IQMIX / IQUCP / UCP-3901 devices). See the IQMIX / IQUCP / UCP-3901 User Manual for 
more information.

PREREQUISITES: The Domain ID of the IQMIX / IQUCP / UCP-3901 device(s) must be set in 
the System Controller Group Properties under Domain Ids. See Configuring a Controller 
Group, on page 179. These devices must be on the same subnet that the GV Orbit Server is 
connected to. 

Related Topics
• How to Know if a Spigot is an Input or an Output, on page 353
• Configuring UHD 4K Two-Sample Interleave Division IP Streams for use with an IQMix, 

IQUCP, UCP-3901, or IPVU Device, on page 354.
• Configuring UHD 4K Quad-Link SDI Streams for use with an IQMix, IQUCP, UCP-3901, or 

IPVU Device, on page 359

WARNING
The spigot configuration is set through GV Orbit Client and then GV Orbit Control 
reads it from the IQMIX / IQUCP / UCP-3901 card. For any given spigot, you must know 
which mode (input or output) has been configured to connect the spigots correctly 
in GV Orbit Control.

Note: An IQMix using VC2 video compression format is not currently supported by 
GV Orbit Control.
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To configure an IQMIX / IQUCP / UCP3901 Device
1 Add the IQMIX / IQUCP / UCP-3901 device to the Topology: from the Device Library, 

Discovered, find an IQMIX / IQUCP / UCP-3901 device bubble that you want to control. 
See To add a Discovered Device to a Topology, on page 209. 

2 Configure the IQMIX / IQUCP / UCP-3901 properties. See also Description of Common 
Device Properties, on page 332. The IQMIX / IQUCP / UCP-3901 device should be first 
configured with GV Orbit Client before being integrated into GV Orbit Control as most 
configuration parameters shown in GV Orbit Control are shown for information 
purposes only. 

3 Create and connect the edge devices (SDI and IP devices) that are connected to the 
IQMIX / IQUCP / UCP-3901. See Methods to Link Devices in a Topology, on page 222.

How to Know if a Spigot is an Input or an Output
To know if a spigot In GV Orbit Control is an input or output, proceed as follows:

1 Select the device bubble on the Topology Configurator. See Selecting a Graph, on 
page 184.

2 Expand Ip Spigots in Device Properties and select a spigot from the list. 
3 For each spigot, interpret the Mode property as follows: 

• SRC = Output
• DST = Input

Parameter Description

Network Host Name The hostname is the unique name by which the associated IQMIX / 
IQUCP / UCP-3901 is known on the network. 

Domain ID Set the same Domain IDs on all IQMIX / IQUCP / UCP-3901 devices 
that are to communicate with each other on the network. 
The default value for Grass Valley equipment is 101.
Valid range: 0 to 232.
See also Configuring a Controller Group, on page 179.

Internal wiring Shows if the internal modeling of the IQMIX / IQUCP / UCP-3901 is 
complete.
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Configuring UHD 4K Two-Sample Interleave Division IP Streams for 
use with an IQMix, IQUCP, UCP-3901, or IPVU Device

To support UHD 4K streams, the image is mapped onto four SDI HD sub-images using a 
two-sample interleave division. This means each of the four sub-stream carries a quarter-
resolution picture. These four sub-streams must:

• each be individually represented by four logical levels; one level for each sub-stream. 
For example, SDI2SIuhd1, video2SIuhd2, video2SIuhd3 and video2SIuhd4.

• The first logical level, SDI2SIuhd1, carries the full SDI stream for video, audio, and 
ancillary data.

• The remaining logical levels will only use the video stream from the SDI levels, 
video2SIuhd2, video2SIuhd3, and video2SIuhd4. 

• be logically linked together so that they are switched together at once ensuring that 
there is no switching delay between the four streams that would create visible glitches 
between the four quadrants. 

The following shows the typical video stream composition of a two-sample interleave 
division display with the associated logical levels used in this procedure.

1: SMPTE ST 424-5 Link 1 pixels carried by HD Logical 
Level SDI2SIuhd1
2: SMPTE ST 424-5 Link 2 pixels carried by HD Logical 
Level Video2SIuhd2
3: SMPTE ST 424-5 Link 3 pixels carried by HD Logical 
Level Video2SIuhd3
4: SMPTE ST 424-5 Link 4 pixels carried by HD Logical 
Level Video2SIuhd4

UHD Composite Image

1 1 2 2
3 3 4 4

1 1 2 2
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PREREQUISITES: 
• For IQMix / IQUCP / UCP-3901 devices:

• The IQMix / IQUCP / UCP-3901 device(s) must already be configured in GV Orbit 
Client. See Configuring an IQMix, IQUCP, or UCP-3901 Device, on page 352.

• Configure the IQMix / IQUCP / UCP-3901 device spigots to be used for UHD in 
GV Orbit Client by enabling the UHD Links parameter in the Link Control Page for 
all quad-link signal spigots.

• Set the corresponding spigots to use 2SI signals: Under TPG, clear (disable) the 
SDQS check boxes as required.

• The IPVU device(s) must already be configured in GV Orbit Client. See Configuring an 
IPVU Device, on page 349.

• Configure the IPVU device spigots to be used for UHD in GV Orbit Client by:
• Enabling the Enable UHD parameter in the IPVU configuration page for 

Monitor Output 1 and 2 as necessary.
• Set the UHD Mode to 2SI.

To configure UHD 2SI Streams with an IPVU Device
1 Add IPVU device(s) to the topology and configure them in GV Orbit Control. See 

Configuring an IPVU Device, on page 349.



356

Special Device Configuration Tasks GV Orbit Version 2.3.0
Configuring UHD 4K Two-Sample Interleave Division IP Streams for use with an IQMix, IQUCP, UCP-3901, or IPVU Device User 

2 Link the IPVU device(s) to the logical sources and destinations in GV Orbit Control. See 
Methods to Link Devices in a Topology, on page 222. 
The following topology will be used as an example, where the IPVU receives UHD 
stream sources from the GV Node.

3 Create the logical levels necessary to support 2SI sources and destinations: Create the 
following UHD logical levels from the Logical Level Editor from the pre-existing SDI 
logical level: SDI2SIuhd1, SDI2SIuhd2, SDI2SIuhd3, and SDI2SIuhd4. See Duplicating 
a Logical Level, on page 193.

For this example, only the following “2SIuhd” levels will be used: SDI2SIuhd1, 
Video2SIuhd2, Video2SIuhd3, and Video2SIuhd4. It is optional to delete all other 

Duplicate the SDI Logical Level four times to create SDI2SIuhd1, 
SDI2SIuhd2, SDI2SIuhd3, and SDI2SIuhd4
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“2SIuhd” logical levels for a cleaner presentation, if they are not used elsewhere. See 
Deleting a Logical Level, on page 196.

4 From the Multilevel Table of the Logical Device Table, under the Sources tab, click the 
Levels icon . See Accessing the Logical Device Table task, on page 241.

5 Select the levels you want to display in the Logical Device Table. As shown below, the 
2SIuhd filter was applied and then you can select the 4 SIuhd levels (SDI2SIuhd1, 
Video2SIuhd2, Video2SIuhd3, and Video2SIuhd4), each representing one sub-stream 
of a of a 2SI signal. Click OK. 

The columns of the Multilevel Table updates to only show the SDI2SIuhd1, 
Video2SIuhd2, Video2SIuhd3, and Video2SIuhd4 columns. 

6 In the Logical Device Table, select a source’s row to which you want to add the streams. 
See To configure streams for the new sources, on page 251.
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7 In the Logical Device Table, map streams with levels: Configure the UHD sources and 
destinations by assigning quad-link IP streams to each level. 

8 Select the levels you want to display in the Logical Device Table. Again, select the 4 
SIuhd levels (SDI2SIuhd1, Video2SIuhd2, Video2SIuhd3, and Video2SIuhd4), each 
representing one sub-stream of a of a 2SI signal. Click OK.
The columns of the Multilevel Table updates to only show the SDI2SIuhd1, 
Video2SIuhd2, Video2SIuhd3, and Video2SIuhd4 columns. 

9 From the Multilevel Table of the Logical Device Table, under the Destinations tab, 
click the Levels icon . See Accessing the Logical Device Table task, on page 241.

10 Repeat step 6 for destinations.
11 Test the configuration by making takes between a logical source and destination that 

use the two-sample interleave division streams. See Performing a Take in Router 
Control, on page 471. See in Pathfinder that the correct source sub-streams are 
received by each destination. See Viewing Information about the Destinations, on 
page 454.

Select the row before dropping a destination onto it
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Configuring UHD 4K Quad-Link SDI Streams for use with an IQMix,
IQUCP, UCP-3901, or IPVU Device

To support UHD 4K streams, a quad-link (square division) configuration is used. That is, the 
UHD image is divided into four SDI HD quadrants, and each quadrant is sent as four 
separate streams. These four streams must:

• each be individually represented by four logical levels; one level for each quadrant. For 
example, SDI, SDIuhd2, SDIuhd3 and SDIuhd4.

• The first logical level is the base SDI logical level. This logical level carries the video, 
audio, and ancillary data.

• The SDIuhd2, SDIuhd3 and SDIuhd4 logical levels are video only.
• be logically linked together so that they are switched together at once ensuring that 

there is no switching delay between the four streams that would create visible glitches 
between the four quadrants. 

The following shows the typical video stream composition of a UHD quad-link display with 
the associated logical levels used in this procedure.

Quadrant 1, Link 1
HD Logical Level SDI

Quadrant 2, Link 2
HD Logical Level 

SDIuhd2

Quadrant 3, Link 3
HD Logical Level 

SDIuhd3

Quadrant 4, Link 4
HD Logical Level 

SDIuhd4

UHD Composite Image
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PREREQUISITES: 
• For IQMix / IQUCP / UCP-3901 device(s):

• The IQMix / IQUCP / UCP-3901 device(s) must already be configured in GV Orbit 
Client. See Configuring an IQMix, IQUCP, or UCP-3901 Device, on page 352.

• Configure the IQMix / IQUCP / UCP-3901 device spigots to be used for UHD in 
GV Orbit Client by enabling the UHD Links parameter in the Link Control Page for 
all quad-link signal spigots.

• Set the corresponding spigots to use Square Division signals: Under TPG, set 
(enable) the SDQS check boxes as required.

• For IPVU device(s):
• The IPVU device(s) must already be configured in GV Orbit Client. See Configuring 

an IPVU Device, on page 349.
• Configure the IPVU device spigots to be used for UHD in GV Orbit Client by:

• Enabling the Enable UHD parameter in the IPVU configuration page for 
Monitor Output 1 and 2 as necessary.

• Set the UHD Mode to SQD.

To configure UHD Quad-Link Streams

Create the logical levels necessary to support quad-link sources and destinations. 
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1 Create the following UHD logical levels from the Logical Level Editor from the pre-
existing SDI logical level: SDIuhd1, SDIuhd2, SDIuhd3 and SDIuhd4. See Duplicating a 
Logical Level, on page 193.

2 From the Multilevel Table of the Logical Device Table, click the Levels icon . See 
Accessing the Logical Device Table task, on page 241.

3 Select the levels you want to display in the table. As shown below, a filter SDIuhd was 
applied and then you can select the 4 SDI UHD levels and click OK.

The logical device table will show 4 items (SDIuhd1, SDIuhd2, SDIuhd3, and SDIuhd4), 
each with a UHD level representing one quadrant of a of a quad-link signal. 

4 Add IQMix / IQUCP / UCP-3901 device(s) to the topology and configure them in 
GV Orbit Control. See Configuring an IQMix, IQUCP, or UCP-3901 Device, on page 352.

5 Link the IQMix / IQUCP / UCP-3901 device(s) to the logical sources and destinations in 
GV Orbit Control. See Methods to Link Devices in a Topology, on page 222. 

Duplicate the SDI Logical Level four times to create SDIuhd1, SDIuhd2, 
SDIuhd3, and SDIuhd4
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The following topology will be used as an example, where the IQMix is used as the UHD 
stream sources (called uhd1 and uhd2) and the IQUCP is used as the UHD stream 
destination (called DEST-uhd).

6 In the Logical Device Table, map streams with levels: Configure the UHD sources and 
destinations by assigning quad-link IP streams to each level. 

7 Repeat step 6 for destinations.
8 Test the configuration by making takes between a logical source and destination that 

use the quad-level link streams. See Performing a Take in Router Control, on page 471. 
See in Pathfinder that the correct quad-level link streams are received by each 
destination. See Viewing Information about the Destinations, on page 454.

Select the row before dropping a destination onto it
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Configuring an MV-820-IP Multiviewer Device
The MV-820-IP multiviewer has 48 IP inputs and 12 IP outputs in a 2 RU chassis, making it 
ideal for high-density IP monitoring applications. Internally, the MV-820-IP multiviewer is 
an MV-820 SDI multiviewer wrapped inside four IQMix cards to provide IP connectivity 
through a rear panel that supports the QSFP network interface adapters (refer to the MV-
820 Multiviewer User Manual, where this is referred to as the Video IP Circuitry). These four 
IQMix cards are used to convert the IP network input streams to feed the 48 SDI inputs of 
the MV-820 cards, and uses three of the four same IQMix cards to also convert the 12 SDI 
mosaic outputs of the MV-820 cards into IP stream outputs. These IQMix cards are labeled 
as MV-820-IP-REAR in GV Orbit Client and GV Orbit Control. See Configuring an IQMix, 
IQUCP, or UCP-3901 Device, on page 352 for more information about how to configure an 
IQMix.

The inputs and outputs of an MV-820-IP are called spigots that, within GV Orbit Control, are 
provided by four MV-820-IP-REAR devices with the following spigot configuration: 48 input 
spigots across four MV-820-IP-REAR devices and 12 mosaic output spigots across three 
MV-820-IP-REAR devices. The third MV-820-IP-REAR device has no output spigots. 

For each MV-820-IP-REAR device, the spigots are used as follows. The third MV-820-IP-REAR 
device has no output spigots. See also How to Know if a Spigot is an Input or an Output, on 
page 353.

There is no offline configuration of the MV-820-IP device. It must first be discovered on the 
network by GV Orbit Control. 

The MV-820-IP multiviewer must have been previously configured with GV Orbit Client 
before being integrated into GV Orbit Control as most configuration parameters shown in 
GV Orbit Control are for information purposes only (GV Orbit Control reads it from the 
MV-820-IP cards). See the MV-820-IP User Guide for more information.

For example, in GV Orbit Client 2.5 the MV-820-IP is shown as 4 MV-820-IP-REAR.

PREREQUISITES: The Domain ID of the MV-820-IP devices must be set in the System 
Controller Group Properties under Domain Ids. See Configuring a Controller Group, on 

MV-820-IP-REAR ‘A’: 12 Input Spigots
MV-820-IP-REAR ‘B’: 12 Input Spigots
MV-820-IP-REAR ‘C’: 12 Input Spigots
MV-820-IP-REAR ‘D’: 12 Input Spigots

MV-820-IP-REAR ‘A’: 4 Output Spigots
MV-820-IP-REAR ‘B’: 4 Output Spigots
MV-820-IP-REAR ‘C’: 0 Output Spigots
MV-820-IP-REAR ‘D’: 4 Output Spigots

MV-820 SDI 
Multiviewer

Input: Spigot 5

Input: Spigot 16

Mosaic Output: Spigot 1
Mosaic Output: Spigot 2
Mosaic Output: Spigot 3
Mosaic Output: Spigot 4

IQMix
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page 179. These devices must be on the same subnet that the GV Orbit Server is connected 
to. 

To configure an MV-820-IP Multiviewer
1 Select the required Area. See Selecting an Area, on page 183.
2 Select the required topology. See Selecting a Graph, on page 184.
3 The topology must be currently:

• Activated (see Activating a Topology, on page 235).
• Unlocked (see Unlocking / Relocking a Topology, on page 238).

4 From the Device Library, on the left, select Discovered, from the drop-down list.

5 From the Device Library, Discovered, find the four MV-820-IP-REAR devices with the IP 
addresses that correspond with those for the MV-820-IP multiviewer on your network: 
select one of the MV-820-IP-REAR device bubbles and drag it into position on the 
Topology and release the mouse button. 
The device pulled from the Device Library, Discovered becomes greyed out and 
another instance of the same device instance cannot be added again to the Topology. 

6 Now create a device group by adding the remaining three MV-820-IP-REAR device 
bubbles on top of the MV-820-IP-REAR already on the Topology: 

a Select another MV-820-IP-REAR device bubble from the Device Library and drag it 
on top of the first MV-820-IP-REAR device instance already on the Topology and 
release the mouse button. 

b Repeat this action for the third and fourth MV-820-IP-REAR device bubble in the 
Device Library.

The four MV-820-IP-REAR device instances are shown as a single device on the 
Topology and can be individually configured in the Property Editor, under Devices, by 
clicking an instance. See Defining Device Properties, on page 229 for more information.

7 Click on the name of the device underneath the bubble to name the device or device 
group. See To name a device and set the number of devices in the group, on page 205.

Note: An MV-820-IP using VC2 video compression format is not currently supported 
by GV Orbit Control.
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8 Configure the MV-820-IP multiviewer’s properties. See also Description of Common 
Device Properties, on page 332. The MV-820-IP device should be first configured with 
GV Orbit Client before being integrated into GV Orbit Control as most configuration 
parameters shown in GV Orbit Control are shown for information purposes only. 

9 Create the logical sources and destinations in GV Orbit Control for the MV-820-IP by 
adding SDI devices to the topology and then linking them. See Methods to Link 
Devices in a Topology, on page 222. An example is shown below.

These logical sources and destinations represent the SDI inputs and outputs of the 
MV-820 multiviewer that will be used when making a take. 

a From the Device Library, Virtual Devices, find the SDI Device bubble and drag it 
into position on the Topology and release the mouse button.

Parameter Description

Network Host Name The hostname is the unique name by which the associated MV-820-IP 
is known on the network. 

Domain ID Set the same Domain IDs on all MV-820-IP devices that are to 
communicate with each other on the network. 
The default value for Grass Valley equipment is 101.
Valid range: 0 to 232.
See also Configuring a Controller Group, on page 179.

Internal wiring Shows if the internal modeling of the MV-820-IP is complete.

Logical Sources 
Represent the 

Multiviewer’s SDI 
Mosaic Outputs

Logical 
Destinations 

Represent the 
Multiviewer’s SDI 

Inputs
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b Click on the name of the device underneath the bubble to name the device or 
device group. See To name a device and set the number of devices in the group, on 
page 205. For example, Enter MV-Out in both the Name and Short Name fields, 
then enter 12 for the number of device instances. These parameters can also be set 
in the Property Editor.

c From the Device Library, Virtual Devices, find the SDI Device bubble and drag it 
into position on the Topology and release the mouse button.

d Click on the name of the device underneath the bubble to name the device or 
device group. For example, Enter MV-In in both the Name and Short Name fields, 
then enter 48 for the number of device instances. 

e Interconnect the SDI source and destination devices to the proper IQMix spigot SDI 
inputs and outputs as shown above.

If needed, contact support for more information as how to configure this device. See 
Grass Valley Technical Support, on page 862.
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Configuring a Kahuna IP Production Switcher Device
The Kahuna IP is a production switcher. Internally, the Kahuna IP production switcher is an 
Kahuna SDI production switcher wrapped inside two IQMix cards to provide IP 
connectivity. These two IQMix cards are used to convert the IP network input streams to 
feed the 12 SDI inputs of the Kahuna, and the other IQMix card to convert the 12 SDI 
outputs of the Kahuna into IP stream outputs. These IQMix cards are labelled as 
KahunaIPI10 and KahunaIPO10 in GV Orbit Control. See Configuring an IQMix, IQUCP, or 
UCP-3901 Device, on page 352 for more information about how to configure an IQMix.

The inputs and outputs of a Kahuna IP are called spigots. There are 12 input and 12 output 
spigots. In the GV Orbit Control Device Library, the Kahuna IP switcher is discovered as two 
separate IP devices: the first represents the IP inputs (device type: KahunaIPI10) and the 
second represents the IP outputs (device type: KahunaIPO10). 

See also How to Know if a Spigot is an Input or an Output, on page 353.

There is no offline configuration of the Kahuna IP device. It must first be discovered on the 
network by GV Orbit Control. 

The Kahuna IP device must have been previously configured with GV Orbit Client before 
being integrated into GV Orbit Control as most configuration parameters shown in 
GV Orbit Control are for information purposes only (GV Orbit Control reads it from the 
Kahuna IP device). See the Kahuna IP User Guide for more information.

PREREQUISITES: The Domain ID of the Kahuna IP device(s) must be set in the System 
Controller Group Properties under Domain Ids. See Configuring a Controller Group, on 
page 179. These devices must be on the same subnet that the GV Orbit Server is connected 
to. 

To configure a Kahuna IP Device
1 Select the required Area. See Selecting an Area, on page 183.
2 Select the required topology. See Selecting a Graph, on page 184.
3 The topology must be currently:

• Activated (see Activating a Topology, on page 235).
• Unlocked (see Unlocking / Relocking a Topology, on page 238).

KahunaIPI10: 12 Input Spigots KahunaIPO10: 12 Output SpigotsKahuna SDI 
Switcher
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4 From the Device Library, on the left, select Discovered from the drop-down list.

The Kahuna IP is discovered as two separate IP devices: the first represents the IP inputs 
(device type: KahunaIPI10) and the second represents the IP outputs (device type: 
KahunaIPO10).

5 From the Device Library, Discovered, find the Kahuna IP input device that you want to 
control: select the KahunaIPI10 device bubble and drag it into position on the 
Topology and release the mouse button. 
The device pulled from the Device Library, Discovered becomes greyed out and 
another instance of the same device instance cannot be added again to the Topology. 

6 From the Device Library, Discovered, find the matching KahunaIPO10 device bubble 
and drag it into position on the Topology and release the mouse button. 

7 For each Kahuna IP device (IP inputs device type: KahunaIPI10 and IP outputs device 
type: KahunaIPO10) Click on the name of the device underneath the bubble to name 
the device. See To name a device and set the number of devices in the group, on 
page 205. 

8 Configure the Kahuna IP properties. See also Description of Common Device 
Properties, on page 332. The Kahuna IP device should be first configured with GV Orbit 
Client before being integrated into GV Orbit Control as most configuration parameters 
shown in GV Orbit Control are shown for information purposes only. 

Parameter Description

Network Host Name The hostname is the unique name by which the associated Kahuna IP 
is known on the network. 

Domain ID Set the same Domain IDs on all Kahuna IP devices that are to 
communicate with each other on the network. 
The default value for Grass Valley equipment is 101.
Valid range: 0 to 232.
See also Configuring a Controller Group, on page 179.

Internal wiring Shows if the internal modeling of the Kahuna IP is complete.
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9 Create and connect the edge devices (SDI and IP devices) that are connected to the 
Kahuna IP. See Methods to Link Devices in a Topology, on page 222. An example is 
shown below.

These logical sources and destinations represent the SDI inputs and outputs of the 
Kahuna switcher that will be used when making a take. 

a From the Device Library, Virtual Devices, find the SDI Device bubble and drag it 
into position on the Topology and release the mouse button.

b Click on the name of the device underneath the bubble to name the device or 
device group. See To name a device and set the number of devices in the group, on 
page 205. For example, Enter Switcher-Out in both the Name and Short Name 
fields, then enter 3 for the number of device instances. These parameters can also 
be set in the Property Editor.

c From the Device Library, Virtual Devices, find the Monitor Device bubble and 
drag it into position on the Topology and release the mouse button.

d Click on the name of the device underneath the bubble to name the device or 
device group. For example, Enter Switcher-In in both the Name and Short Name 
fields, then enter 12 for the number of device instances. 

e Interconnect the SDI source and destination devices to the proper IQMix spigot SDI 
inputs and outputs as shown above.

If needed, contact support for more information as how to configure this device. See 
Grass Valley Technical Support, on page 862.

Logical Sources 
Represent the 
Switcher’s SDI 

Mosaic Outputs

Logical Destinations 
Represent the 

Switcher’s SDI Inputs
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Configuring a K-Frame Production Switcher
The K-Frame is a series of production switchers, and certain models support IP connectivity. 
The following frames are supported:

• K-Frame-V Production Switcher has 4 slots each providing 8 inputs and 4 outputs to the 
switcher, for a total of 32 inputs x 16 outputs. 

• K-Frame-X Production Switcher has 14 slots. 10 slots each providing 16 inputs and 8 
outputs to the switcher, followed by 4 slots each providing 8 inputs and 4 outputs of 
the switcher, for a total of 192 inputs x 96 outputs. 

The following diagram shows a K-Frame-V / K-Frame-X Production Switchers populated 
with a typical assortment of I/O cards.

There are two types of modules which can be used in the K-Frame Production Switcher 
slots:

• SDI only card, equipped with BNC connectors.

K‐Frame‐X Series

16 × 8 I/O SDI Card
16 Inputs, 8 Outputs

16 × 8 I/O IP Card
16 Inputs, 8 Outputs, 8 SFPs

8 × 4 I/O SDI Card
8 Inputs, 4 Outputs

8 × 4 I/O IP Card
8 Inputs, 4 Outputs, 4 SFPs

16 × 8 I/O IP Card
16 Inputs, 8 Outputs, 8 SFPs

16 × 8 I/O IP Card
16 Inputs, 8 Outputs, 8 SFPs

16 × 8 I/O IP Card
16 Inputs, 8 Outputs, 8 SFPs

Inputs 1 to 16
Outputs 1 to 8
SFPs 1 to 8

Inputs 17 to 32
Outputs 9 to 16
SFPs 9 to 16

Inputs 33 to 48
Outputs 17 to 24
SFPs 17 to 24

Inputs 49 to 64
Outputs 25 to 32
SFPs 25 to 32

Inputs 65 to 80
Outputs 33 to 40
SFPs 33 to 40

Inputs 81 to 96
Outputs 41 to 48
SFPs 41 to 48

Inputs 97 to 112
Outputs 49 to 56
SFPs 49 to 56

Inputs 113 to 128
Outputs 57 to 64
SFPs 57 to 64

Inputs 129 to 144
Outputs 65 to 72
SFPs 65 to 72

Inputs 145 to 160
Outputs 73 to 80
SFPs 73 to 80

Inputs 161 to 168
Outputs 81 to 84
SFPs 81 to 84

Inputs 169 to 176
Outputs 85 to 88
SFPs 85 to 88

Inputs 177 to 184
Outputs 89 to 92
SFPs 89 to 92

Inputs 185 to 192
Outputs 93 to 96
SFPs 93 to 96

8 × 4 I/O IP Card
8 Inputs, 4 Outputs, 4 SFPs

16 × 8 I/O IP Card
16 Inputs, 8 Outputs, 8 SFPs

K‐Frame‐V Series

Inputs 1 to 8
Outputs 1 to 4
SFPs 1 to 4

Inputs 9 to 16
Outputs 5 to 8
SFPs 5 to 8

Inputs 17 to 24
Outputs 9 to 12
SFPs 9 to 12

Inputs 25 to 32
Outputs 13 to 16
SFPs 13 to 16

8 × 4 I/O SDI Card
8 Inputs, 4 Outputs

8 × 4 I/O IP Card
8 Inputs, 4 Outputs, 4 SFPs

8 × 4 I/O IP Card
8 Inputs, 4 Outputs, 4 SFPs

8 × 4 I/O IP Card
8 Inputs, 4 Outputs, 4 SFPs

16 × 8 I/O IP Card
16 Inputs, 8 Outputs, 8 SFPs

16 × 8 I/O SDI Card
16 Inputs, 8 Outputs

8 × 4 I/O SDI Card
8 Inputs, 4 Outputs
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• IP only card, equipped with SFP connectors.

Here are some details about IP cards you will need to know to model your K-Frame 
Production Switcher in GV Orbit Control:

• An SFP can receive two streams and transmit one. A stream is a group of the essence 
flows (a 2022-6 stream has a single flow, a TR-04 stream has two flows and a SMPTE 
2110 stream has three flows)

• Each SFP stream maps directly to a switcher input or output of the slot. For example: 
the IP card in the second slot of the K-Frame-V Production Switcher has 4 SFP pairs (for 
redundancy) providing signals to inputs 9-16 of the switcher. The first SFP provides 
streams for inputs 9-10, the second SFP provides streams for inputs 11-12 and so on.

• IP cards support SMPTE 2022-6, SMPTE 2110, and TICO.
• Redundancy in SMPTE 2022 and SMPTE 2110 is supported.
• For SMPTE 2110-30, the following profiles are supported: L16/48K/125us, L16/48K/1ms, 

L24/48K/125us, L24/48K/1ms.

Note that GV Orbit Control only controls the K-Frame Production Switcher’s IP receivers and 
transmitters. In consequence, The K-Frame Production Switcher must have been previously 
setup and configured before being integrated into GV Orbit Control. See the K-Frame 
Installation & Service Manual for more information. 

PREREQUISITES: GV Orbit Control must have IP connectivity to the K-Frame Production 
Switcher:

• to automatically detect the K-Frame Production Switcher’s model (K-Frame-V / K-
Frame-X) and its current configuration parameters that are needed by GV Orbit Control.

• before making connections to the Production Switcher bubble in GV Orbit Control. See 
To configure a K-Frame Production Switcher, on page 373.
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K-Frame Production Switcher Nomenclature used in GV Orbit Control

The following diagram shows the nomenclature used in GV Orbit Control for the K-Frame-V 
Production Switcher signal flow. A K-Frame-X Production Switcher’s signal flow uses a 
similar architecture, with more inputs and outputs.

* Note that GV Orbit Control’ s Short Name property for a port is composed of a 
combination of the System SFP number and the Physical SFP letter in the following format: 
SFP-[System SFP number][Physical SFP letter]

Slots

Boards

K‐Frame‐V
Video/Audio Routing & Processing

32 Inputs & 16 Outputs

B A B A B A B

1 2 3 4

A B A B A B A B

5 6 7 8

A B A B A B A B

9 10 11 12

A B A B A B A B

13 14 15 16System SFPs

Physical SFPs* A

Inputs 1 to 8
Outputs 1 to 4

Inputs 9 to 16
Outputs 5 to 8

Inputs 17 to 24
Outputs 9 to 12

Inputs 25 to 32
Outputs 13 to 16

IP I/O Board
SFPs 1 to 4

IP I/O Board
SFPs 5 to 8

IP I/O Board
SFPs 9 to 12

IP I/O Board
SFPs 13 to 16

8 4 8 4 8 4 8 4

Port Number Equivalent 
Used in GV Orbit 

Control / GV Convergent
17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 322 3 4 5 6 7 8 9 10 11 12 13 14 15 161

SMPTE 2022‐7 Support: Ports shown in red are for the Red LAN. Ports shown in blue are for the Blue LAN

*  This is shown in the Short Name property for a port. For example, SFP‐1A is the first input port.

Flows

Streams

Video

Audio

Ancillary
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For example, SFP-1A is the first input port. This port is shown below in the K-Frame Menu 
for reference.

When Redundancy Mode is Enabled in the K-Frame Menu, you must use a SMPTE ST 2022-7 
network setup; see Configuring Network Switch Redundancy to Support SMPTE ST 2022-7, 
on page 399.

To configure a K-Frame Production Switcher
1 Add the Production Switcher device to the Topology: from the Device Library, Virtual 

Device, find the Production Switcher device bubble. See Adding a Virtual Device to a 
topology, on page 204. 

2 Click on the name of the device underneath the bubble to enter a meaningful name to 
identify this device in the Name field. See To name a device and set the number of 
devices in the group, on page 205. 
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These parameters can also be set in the Property Editor.
3 Click New  next to Control Port at the top of the Property Editor and select K-

Frame CPL TCP/IP from the list. See also Defining Device Properties, on page 229 for 
more information.

The K-Frame CPL TCP/IP tab appears. To remove the control port, click Delete.
4 Configure the K-Frame Production Switcher properties. See also Description of 

Common Device Properties, on page 332. 

Parameter Description

Network Host Name The hostname is the unique name by which the associated K-Frame 
Production Switcher is known on the network. 

IP Address The IP address of the K-Frame Production Switcher to be controlled.
Once connected, GV Orbit Control automatically detects the K-Frame 
Production Switcher’s model (K-Frame-V / K-Frame-X) and K-Frame 
Production Switcher’s configuration parameters that are needed by 
GV Orbit Control. 
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5 Activate the topology. See Activating a Topology, on page 235.
The current K-Frame Production Switcher input and output ports are read into GV Orbit 
Control and become available to be connected within GV Orbit Control. According to 
the type of streams configured in K-Frame Production Switcher, the corresponding 
logical levels are created in the Logical Device Table. See Logical Device Table Tasks, on 
page 241 for more information.

Connection State 1
Connection State 2

K-Frame Production Switcher Connection State 1 shows the 
connection status of the K-Frame Production Switcher with the 
primary server of a server group. 
K-Frame Production Switcher Connection State 2 shows the 
connection status of the K-Frame Production Switcher with the 
secondary server of a server group. See Configuring a Controller 
Group, on page 179.
unknown: The topology is inactive (see Activating a Topology, on 
page 235) or the K-Frame Production Switcher does not have network 
connectivity to the GV Orbit Server(s).
Reconnecting: The topology has been activated and GV Orbit Control 
is learning the K-Frame Production Switcher’s current configuration.
offline: The K-Frame Production Switcher does not have network 
connectivity to the GV Orbit Server(s).
online: The K-Frame Production Switcher is connected to the GV Orbit 
Server(s).

Frame Model Once the topology has been activated, this shows the frame model. 
This is shown for information purposes only.

Parameter Description
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When a port is selected, see the Short Name property to see the K-Frame Production 
Switcher’s internal port reference. For more information, see K-Frame Production 
Switcher Nomenclature used in GV Orbit Control, on page 372.

Each input port supports two sources. When a stream is selected, see the Short Name 
property to see the stream type currently configured in the K-Frame Production 
Switcher. 

The K-Frame Production Switcher can now be used to make takes. See Router Control Tasks, 
on page 470 for more information.

Streams Description Short Name

1 This is the video stream for the first source. Swr-In-1A-Vid 

2 This is the audio stream for the first sourcea.

a. This stream is not shown if the selected port is configured as SMPTE 2022-6.

Swr-In-1A-Aud

3 This is the Ancillary stream for the first sourcea. Swr-In-1A-Anc 

4 This is the video stream for the second source. Swr-In-2A-Vid 

5 This is the audio stream for the second sourcea. Swr-In-1A-Aud

6 This is the Ancillary stream for the second sourcea. Swr-In-1A-Anc 
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Adding NMOS Devices to a Topology
GV Orbit Control supports Networked Media Open Specifications (NMOS) AMWA IS-04 for 
device discovery and registration and IS-05 for connection management1. Furthermore, it 
supports AMWA BCP-002-01 for the natural grouping of NMOS resources. 

GV Orbit Control has a built-in NMOS registry (see below) that can be used to register 
NMOS devices. To be able to discover NMOS devices, you have one of the following options:

• Allow GV Orbit Control to automatically discover one or more NMOS registries through 
DNS-SD. DNS-SD can discover an NMOS registry that is available on the network and 
registered in your DNS server. 

• Point GV Orbit Control to use its internal NMOS registry (when enabled), or to an 
external NMOS registry. 

GV Orbit relies on the NMOS senders / receivers Group Hint Tag property to determine the 
available audio streams / flows to be used in order to extract the appropriate audio 
channels used for the creation of the automatic logical sources / destinations. You can still 
create custom logical sources / destinations using specific streams and specific audio 
channels. 

PREREQUISITES: 
• Entries for your NMOS registries have been added to the network DNS server. This 

enables automatic DNS-SD discovery. Contact your IT department to do so. Otherwise 
you can manually specify the registry to connect to.

• Routing between IP sources and IP destinations that have different flow configurations 
requires an Audio Live in order to convert audio flows into compatible ones. See 
Configuring a Device that Supports Audio Breakaway/Shuffling such as Audio Live, on 
page 433.

To configure GV Orbit Control for use with NMOS 

To use GV Orbit Control with NMOS devices, you first must configure it to use its internal 
NMOS registry, to use an external NMOS registry, or to automatically search for external 
NMOS registries. 

1.GV Orbit Control supports IS-05 v1.1 API when available. This version is used before v1.0 when both 
versions are available.

Notes

• GV Orbit Control listens for changes to any of the nodes in the registry. As it 
receives updates, it automatically updates any device that is dropped onto any 
topology that is associated with that node.

• If the registry is shut down, or the node is stopped and is removed from the 
registry, the devices will disappear from the list of discovered devices. The devices 
you already have dropped will remain on the topology, but will no longer receive 
updates.

• If the registry is restarted or the node is restarted, GV Orbit Control will continue 
to update the devices on the topology (assuming the devices have the same UUID).
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1 Open the System Controller Group Properties. See Configuring a Controller Group, 
on page 179.

2 Set the following parameters.

Parameter Description

NMOS Discovery DNS GV Orbit Control can automatically discover an NMOS registry 
through DNS-SD when the NMOS Discovery DNS and NMOS 
Discovery Search Domain parameters are set. 
NMOS Discovery DNS: The IP address of the network DNS server that 
is also used to support networked NMOS devices.
NMOS Discovery Search Domain: The network’s domain name on 
which GV Orbit Control will search for NMOS devices and the NMOS 
registry. 
The NMOS Discovery DNS and NMOS Discovery Search Domain 
parameters are automatically retrieved from the GV Orbit’s Server 
operating system when available (refer to IP Configuration, DNS tab 
in the GV Orbit Admin Guide; see Related Documentation, on page 7). 
The operating system values can be overridden by setting the 
appropriate values here.
NOTE: If the DNS information is changed in the admin interface, 
GV Orbit Control must be restarted to retrieve the new values from 
the OS. 

NMOS Discovery 
Search Domain
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3 To be able to discover NMOS devices in GV Orbit Control, you have one of the following 
options:

• Allow GV Orbit Control to automatically discover one or more NMOS registries 
through DNS-SD (set the NMOS Discovery DNS and NMOS Discovery Search 
Domain parameters). This is possible when the NMOS registries have been added 
to the network DNS server. 

• Manually point GV Orbit Control to use the NMOS Registry service (when enabled), 
or to an external NMOS registry by setting a fixed URL for the registry (set the 
NMOS Registry parameter). 

Update the server’s Host file

In order for GV Orbit Control to communicate with the NMOS registry to retrieve a list of all 
its resources, retrieve update notifications, download SDP files and perform connection 
management, GV Orbit Control must be able to reach the host where the registry is running 
by its hostname. In order to do this, an entry for the NMOS host MUST be added to the 
server’s hosts file.

The Host file is found here: /etc/hosts

Sample entry:
10.37.80.177    <registryHostName>

Once the server for the NMOS registry has been added to the hosts file, the GV Orbit 
Control service needs to be restarted. See Reboot found under Upgrade Task in the GV Orbit 
Admin Guide. See Related Documentation, on page 7.

Note that this applies even if you use the registry's IP address when specifying the URL of 
the NMOS Discovery Registry. Once the entry in the hosts file is added, the NMOS Registry 

NMOS Registry This shows the current NMOS Registry Query API URL (hostname / IP 
address and port number).
Set a static NMOS registry URL when NMOS registry discovery is non-
functional or when you want to override it to use a specific NMOS 
registry. 
If the NMOS Registry service is installed and running on the GV Orbit 
Server and you want to use GV Orbit Control’s built-in NMOS registry, 
set this URL to the local host IP address for this service: 
http://127.0.0.1:4041. The NMOS registry is available to NMOS devices 
at the current system controller’s IP addressa, on port 4041. The 
priority of GV Orbit Control’s NMOS registry is 0.
If redundancy has been configured for GV Orbit Control, use the 
Virtual IP Address, on port 4041 to access the NMOS registry. 
Refer to Application Upgrade in the GV Orbit Admin Guide to install 
the NMOS Registry service and ensure that it is running. See Related 
Documentation, on page 7.
To revert to automatic NMOS registry discovery, clear this field, press 
<Enter>, and wait 10 seconds for the above NMOS Discovery DNS and 
NMOS Discovery Search Domain parameters to take effect.

a. This is the same IP address as for GV Orbit Control’s administration interface. This is shown as IP 
Address in step 6 on page 181.

Parameter Description
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parameter can be either http://10.37.80.177:4041 or 
http://<registryHostName>:4041 

To update the server’s Host file, contact Grass Valley Technical Support. See Grass Valley 
Technical Support, on page 862.

NMOS Node control port status in GV Orbit Control

GV Orbit Control pings the NMOS node to keep the connection active using the URL 
http://XXX.XXX.XXX.XXX:4041/x-nmos/node/v1.2/self. GV Orbit Control uses the 
success of the ping to determine the node’s control port status (Online/Offline).

How to test the NMOS registry

Test the registry as follows: in a web browser, enter the following address into the browser’s 
address bar: http://XXX.XXX.XXX.XXX:4041/x-nmos/query/v1.2/ 

Where XXX.XXX.XXX.XXX is the IP address of GV Orbit’s NMOS registry. This can be either 
GV Orbit’s Server IP address (for its internal NMOS registry), or the query API IP address of an 
external NMOS registry, if available. For external NMOS registries, see the NMOS registry’s 
documentation as it may use a number of different IP addresses; one for the query API and 
another for the registration API for example.

The following NMOS registry switches show the current NMOS registry’s content:
subscriptions

nodes

devices

senders

receivers

flows

sources

Note: If the NMOS node’s status is offline, check if the node’s URL contains only a 
hostname (as opposed to a numeric IP address). If GV Orbit Control cannot resolve 
the hostname, then you need to add an entry into the server’s hosts file and then 
restart GV Orbit Control. GV Orbit Control must be able to resolve the node’s 
hostname in order to report the control port status as being online, download SDP 
files, and perform connection management. See Update the server’s Host file, on 
page 379 and Reboot found under Upgrade Task in the GV Orbit Admin Guide. See 
Related Documentation, on page 7.
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This is accessible by, for example, entering the following address into the browser’s address 
bar: http://XXX.XXX.XXX.XXX:4041/x-nmos/query/v1.2/nodes 

As the NMOS registry has just been started, it is normal that it is empty of content. Wait for 
devices to discover the NMOS registry and to publish their resources to the registry.

About the grouphint tag

AMWA BCP-002-01 makes use of the grouphint tags to identify senders and receivers. When 
a discovered device publishes grouphint tag information in senders / receivers to the NMOS 
registry, GV Orbit Control will automatically create the related logical sources and 
destinations for the device, once the NMOS device has been added to the topology. If a 
discovered device does not publish grouphint tags to the NMOS registry, then you will have 
to create the logical sources and destinations for the device manually in GV Orbit Control. 

Logical sources / destinations are created using the audio channels from the grouphint tag 
information, when available. GV Orbit assesses if the audio flows use 1, 2 or 4 audio streams 
and then the 16 audio channels from the automatic logical sources / destinations are 
accordingly created using the multi audio streams / flows as required. 

Note: If nodes are not published to the registry and are not listed under 
http://XXX.XXX.XXX.XXX:4041/x-nmos/query/v1.2/nodes, they will not be 
discovered by GV Orbit Control. Further device troubleshooting will be required to 
identify why a device is not publishing to the NMOS registry.

Number of Audio 
Flows as 
determined by 
the flow’s 
grouphint tag Effect in GV Orbit Control

1 There is 1 audio stream with 16 audio channels which are represented in 
GV Orbit Control by the AES67-16 logical level. In the NMOS device’s 
Properties, the following streams are available:
1: SDI, SMPTE ST 2022. In the Logical Device Table, this is represented by 
the SDI column.
2: Video, SMPTE ST 2110-20. In the Logical Device Table, this is 
represented by the V column.
3: Audio AES67-16, SMPTE ST 2110-30. In the Logical Device Table, this is 
represented by the A1 to A16 columns.
7: Ancillary, SMPTE ST 2110-40. In the Logical Device Table, this is 
represented by the ANC column.
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In the NMOS device Properties, the number, type of streams, and AES67 Logical Level are 
updated in real time according to the grouphint tag information. For example, this screen 
shows the Properties for an NMOS device where there is 1 audio stream, and as a 
consequence, the level for the audio stream is shown as AES67-16.

2 There are 2 audio streams; each stream has 8 audio channels which are 
represented in GV Orbit Control by the AES67-8 logical level. In the NMOS 
device’s Properties, the following streams are available:
1: SDI, SMPTE ST 2022. In the Logical Device Table, this is represented by 
the SDI column.
2: Video, SMPTE ST 2110-20. In the Logical Device Table, this is 
represented by the V column.
3: Audio AES67-8, SMPTE ST 2110-30. In the Logical Device Table, this is 
represented by the A1 to A8 columns.
4: Audio AES67-8, SMPTE ST 2110-30. In the Logical Device Table, this is 
represented by the A9 to A16 columns.
7: Ancillary, SMPTE ST 2110-40. In the Logical Device Table, this is 
represented by the ANC column.

4 There are 4 audio streams; each stream has 4 audio channels which are 
represented in GV Orbit Control by the AES67-4 logical level. In the NMOS 
device’s Properties, the following streams are available:
1: SDI, SMPTE ST 2022. In the Logical Device Table, this is represented by 
the SDI column.
2: Video, SMPTE ST 2110-20. In the Logical Device Table, this is 
represented by the V column.
3: Audio AES67-4, SMPTE ST 2110-30. In the Logical Device Table, this is 
represented by the A1 to A4 columns.
4: Audio AES67-4, SMPTE ST 2110-30. In the Logical Device Table, this is 
represented by the A5 to A8 columns.
5: Audio AES67-4, SMPTE ST 2110-30. In the Logical Device Table, this is 
represented by the A9 to A12 columns.
6: Audio AES67-4, SMPTE ST 2110-30. In the Logical Device Table, this is 
represented by the A13 to A16 columns.
7: Ancillary, SMPTE ST 2110-40. In the Logical Device Table, this is 
represented by the ANC column.

Number of Audio 
Flows as 
determined by 
the flow’s 
grouphint tag Effect in GV Orbit Control
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In the Logical Device Table, the NMOS device reflects the automatic.

To Add an NMOS Device to a Topology
PREREQUISITES: 

• There is an operational NMOS registry on the network.
• GV Orbit Control has been configured to connect to the NMOS registry. See To 

configure GV Orbit Control for use with NMOS, on page 377.
• NMOS devices must be configured to publish their available resources to the NMOS 

registry.

Proceed as follows.
1 Add the NMOS device to the Topology: from the Device Library, Discovered, find an 

NMOS device bubble that you want to control. See To add a Discovered Device to a 
Topology, on page 209. 

2 Click on the name of the device underneath the bubble to name the device or device 
group. See To name a device and set the number of devices in the group, on page 205.
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3 The NMOS Control Port parameters are configured in the device’s Property Editor, 
under the Device Properties tab. See Defining Device Properties, on page 229 for more 
information about this tab.

4 Select NMOS tab (next to Control Port at the top of the Property Editor) to configure 
the Device Properties in the Property Editor. See also Description of Common Device 
Properties, on page 332.
The NMOS control port properties appear. 

Ports and streams are automatically created using the values found in the registry, and they 
will automatically be updated whenever GV Orbit Control receives notifications of changes 
from the NMOS registry. 

You can change the following NMOS device properties which will not be overwritten with 
values from the NMOS registry (the value you set for these properties will persist in GV Orbit 
Control): Labels, Short labels, Descriptions, Network label, and Logical levels. See Defining 
Device Properties, on page 229.

Parameter Description

Connection State 1 / 2 This shows the current connection state to the NMOS nodes. When a 
redundant configuration is used (two GV Orbit Servers form a cluster) 
Connection State 1 and Connection State 2 shows the connectivity of 
each server to the NMOS nodes.
unknown: The topology is inactive (see Activating a Topology, on 
page 235) or the NMOS device does not have network connectivity to 
the GV Orbit Server(s).
reconnecting: The GV Orbit Server is in the process of establishing 
communications with the NMOS device.
offline: The NMOS device does not have network connectivity to the 
GV Orbit Server(s).
online: The NMOS device is connected to the GV Orbit Server(s).

Force Resync Device Set to make GV Orbit Control reload the NMOS device’s parameters 
from the NMOS registry.

IS-05 Controllable This status shows whether the corresponding node in the NMOS 
registry has devices that support being controlled through IS-05 
(connection management).
Yes: Routes to these devices should succeed. 
No: If you try to route to a device that is not IS-05 controllable, the 
route will fail.
Partial: Some devices are controllable in this node, while others are 
not.

NMOS Device URL This is the NMOS device’s current URL and port number. 
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Using SDP Parameters to Take a Stream from a non-NMOS Device
to an NMOS Device

In order to use IS-05 connection management, Session Description Protocol (SDP) 
information is required to be sent as part of the command. GV Orbit Control can create SDP 
type parameters that a receiving NMOS device requires in order to successfully complete a 
take made from devices that do not generate and publish their own information.

The SDP information is now generated by GV Orbit Control and is included in the 
connection management commands to allow discovered AMWA NMOS receivers to join 
non-discovered senders, or source devices created within the GV Orbit Control client. This 
SDP information is not currently published to the AMWA NMOS registry.

Within GV Orbit Control, a number of default SDP parameter templates are built-in and are 
selected according to the stream’s Logical Level parameter. The SDP parameters can be 
tweaked if necessary as these SDP parameters must represent the current details and 
specifications of the source’s stream.

The following device bubbles support SDP parameters:
• IP Device 
• GV Node
• IQ-family type IP devices, for example, IQMix, IQUCP, UCP-3901, IQAMD, MV-820-IP, 

Kahuna IP, and so on
• Audio Live

Related Topics
• The Stream Configurator allows you to configure the SDP template for streams on a 

large scale. See Stream Configurator Tasks, on page 322.

PREREQUISITES: To customize the SDP parameter, you must know how to form a valid SDP. 
This is beyond the scope of this document. For more information about SDP specific 
parameters, see RFC 4566. See also SDP.

https://tools.ietf.org/html/rfc4566
https://en.wikipedia.org/wiki/Session_Description_Protocol
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The SDP parameters are configured in the device’s Property Editor, under the Device Group 
Properties tab and in the Device Properties tab. See Defining Device Properties, on 
page 229 for more information about these tabs.

Certain SDP parameters have been enhanced with new GV Orbit Control variables which 
allows for better device control integration within GV Orbit Control. These variables are 
available for SDP parameters configured under the Device Group Properties and the 
Device Properties tab, output stream property. Variables always start with a dollar sign ($) 
and are enclosed in curly brackets {} as shown in the example below. 

Once the topology is activated, the variables set in the SDP are replaced with the actual 
values GV Orbit Control has resolved for the device’s stream. This can be helpful for 
troubleshooting.

See Defining Device Properties, on page 229 to know more about how parameter values in 
the Device Properties tab inherit their values from the corresponding parameter values in 
the Device Group Properties tab. 

Example of SDP parameters used in GV Orbit Control

The following is a typical example of the SDP parameters used in GV Orbit Control. 
v=0

o=- ${sequence} 0 IN IP4 ${portIpAddress}

s=grassvalley 1

t=0 0

a=recvonly

a=ts-refclk:ptp=IEEE1588-2008:08-00-11-FF-FE-22-04-00:127

a=mediaclk:direct

m=video ${streamPortNumber} RTP/AVP 98
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c=IN IP4 ${streamIpAddress}/1

a=rtpmap:98 SMPTE2022-6/27000000

Special GV Orbit Control SDP Variables

The following table lists the supported special GV Orbit Control variables for use anywhere 
within the SDP parameter. These variables reference parameters that are configured 
elsewhere in GV Orbit Control, thereby automatically keeping stream information up-to-
date. 

Editing SDP Parameters

Any of the above variables can be substituted with a fixed equivalent value so that it is hard 
coded. For example, the variable ${portIpAddress} represents a multicast IP address and 
it can be replaced with an IP address such as 230.1.1.1.

GV Orbit Control SDP 
Variable Description

${audioBits} The audio stream’s bit depth.

${channelCount} The number of (audio) channels.

${clockSetting} The PTP master clock setting.

${sequence} This SDP file’s ID

${packetTime} The length of time in milliseconds represented by the (audio) 
media in a packet.

${portIpAddress} The sending port’s IP address.
The source for this variable comes from the Port’s IP Address 
parameter for this stream.

${streamIpAddress} The transmit (sending) stream’s multicast IP address.
The source for this variable comes from the stream’s IP Address 
parameter.

${streamPortNumber} The transmit (sending) stream’s IP port number.
The source for this variable comes from the stream’s IP Port 
parameter.

${redundantIpAddress} The transmit (sending) stream’s redundant multicast IP address.
The source for this variable comes from the stream’s IP Address 
parameter used for the redundancy port. See the Redundancy 
Port parameter to identify the current redundancy port. 

${redundantPortNumber} The transmit (sending) stream’s redundant IP port number.
The source for this variable comes from the stream’s IP Port 
parameter used for the redundancy port. See the Redundancy 
Port parameter to identify the current redundancy port. 

${redundantPortIpAddre
ss}

The transmit (sending) stream’s redundant IP port number.
The source for this variable comes from the stream’s IP Address 
parameter used for the redundancy port. See the Redundancy 
Port parameter to identify the current redundancy port. 

${rtpPayloadType} The RTP payload type as defined by the SDP specification.

${samplingRate} The audio stream’s sampling rate.
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When you edit any SDP parameter:
• The SDP becomes fixed and will no longer automatically update when you make a 

change elsewhere in the Property Editor. For example, changing the logical level 
parameter will not update the SDP parameters with the logical level change. You will 
have to further edit the SDP to adapt it to any such change.

• The SDP becomes orange to indicate that its default value has been overridden. See 
Defining Device Properties, on page 229 to know more about how to reset a parameter 
to its default value.
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Configuring Cisco DCNM Network Switch Devices
Networks that use Cisco Data Center Network Manager (DCNM) to manage LAN fabric can 
be controlled by GV Orbit Control.

PREREQUISITES: 
• DCNM build 11.0(1) or higher
• Switch’s firmware: NXOS 9.2(1) or higher for 9200, 9300-EX, and 9500-R switches.
• Switch’s BIOS: version 07.64, compile time: 05/17/2018
• Configure the required DCNM network switch’s flow policies. See below.

Configuring the Network Switch’s Flow Policies
If you are using a network switch with DCNM control port, flow policies must be manually 
set in the DCNM web interface, before you configure GV Orbit Control to use the network 
switch. 

Each flow policy sets the maximum bandwidth that can be allocated to a type of traffic flow. 
See the table below. Only the flow policies for bandwidths you will use in your network 
need to be created.

Each flow policy must have a multicast IP address range associated to it, according to your 
network addressing pattern, as GV Orbit Control uses a different multicast IP range for each 
type of traffic flow and bandwidth (audio, video 3G, Video HD, ANC / metadata, and so on). 
Class D IP addresses are multicast addresses. By default, IP address 239.255.0.1 may be 
reserved for use by certain Grass Valley equipment for DDS discovery and should not be 
allocated for any other purpose. 

Review documentation for all equipment you are going to use on your network for any 
specific IP addressing and bandwidth requirements.

Establish the Customer Multicast IP Addressing Pattern
All network IP devices must be assigned an IP address, and each network traffic type is 
assigned to a IP address range according to its bandwidth requirement. 

Note: As of DCNM v11.5(1), the DCNM application is now separate from the 
RabbitMQ application, with each application having its own independent user 
credential management. Thus, changing DCNM user credentials will not change 
existing RabbitMQ user credentials. Note that GV Orbit Control uses the user 
credentials from RabbitMQ and not from DCNM.
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For example, the following table shows a typical multicast IP addressing pattern and the 
bandwidth allocation required by traffic flow type.

Delete Pre-existing Flow Policies
If your switch has been previously configured, you may need to remove any pre-existing 
flow policies. These flow policies have the status Create under Deployment Action.

To delete pre-existing current flow policies
1 In the Deployment drop menu, select Undeploy All Custom Policies. 

Traffic Flow 
Type Flow Policy

Typical IP address range Recommended 
Bandwidth AllocationFrom To

Video SMPTE2022-6(3G) 230.1.1.1 230.255.255.255 3.2Gbps

SMPTE2022-6(HD) 229.1.1.1 229.255.255.255 1.601Gbps

SMPTE2022-6(SD) 228.1.1.1 228.255.255.255 0.27Gbps

SMPTE2110-20(3G) 238.1.1.1 238.255.255.255 2.703Gbps

SMPTE2110-20(HD) 237.1.1.1 237.255.255.255 1.401Gbps

SMPTE2110-20(SD) 236.1.1.1 236.255.255.255 0.23Gbps

Audio SMPTE2110-30(AES) 234.1.1.1 234.255.255.255 61Mbps

ANC 
(metadata)

SMPTE2110-40(ANC) 235.1.1.1 235.255.255.255 2Mbps

Defaulta

a. This allows any general network management data to pass through the network while 
guaranteeing that it will not take up any significant amount of total network bandwidth. When 
needed, this bandwidth allocation is also used for DDS discovery when such equipment uses a 
multicast address that is outside of any other pre-existing flow policy you have created (this must be 
the case).

* 150Kbps
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2 The Deployment Action column will show Delete instead of Create.
3 Select all flow policies from the list, but exclude the Default flow policy: do not remove 

the Default flow policy as it will be needed.
4 Use the delete (X) button to delete the selected flow policies.

Add New Flow Policies Using Your IP Addressing Pattern
According to the IP addressing pattern shown in the above table, create the new flow 
policies for each traffic flow type you are going to use.

To add new flow policies
1 Click New (+).

2 Set the parameters for the flow policy. The setting for QoS/DSCP is CS1.
3 Click Deploy.
4 Repeat to create all necessary flow policies.
5 In the Deployment drop menu, select Deploy All Custom Policies. 

The status under Deployment Action becomes Create and the Deployment Status 
becomes Success.
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Configuring a DCNM Network Switch Device
To configure a DCNM Network Switch Device

1 Add the Network Switch device to the Topology: from the Device Library, Discovered, 
find the Network Switch device bubble. See Adding a Virtual Device to a topology, on 
page 204. 

2 Click on the name of the device underneath the bubble to enter a meaningful name to 
identify this device in the Name field. See To name a device and set the number of 
devices in the group, on page 205. 
These parameters can also be set in the Property Editor.

3 Set the number of physical input and output connectors being used on the network 
switch in # Input Connectors and # Output Connectors. See Defining Device 
Properties, on page 229 for more information.

The configuration for these ports become available as Ports under IN and OUT.
4 Click New  next to Control Ports at the top of the Property Editor and select Cisco 

DCNM from the list. Dummy Network Switch should be used when the DCNM network 
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manager is not being used for the network switch. See Defining Device Properties, on 
page 229 for more information.

The Cisco DCNM tab appears. To remove the control port, click Delete.
5 Select Cisco DCNM tab (next to Control Port at the top of the Property Editor) to 

configure the Device Properties in the Property Editor. Only the properties shown 
below should be used. See also Description of Common Device Properties, on 
page 332.

Parameter Description

Network Host Name This is the unique name by which the Network Switch is identified 
within GV Orbit Control. This value is used to construct the 
input/output port labels.

Cisco DCNM Control Port parameters

Virtual IP Address This is the virtual IP address to communicate with DCNM cluster. This 
IP is used to address any active member of the two nodes that are 
operating in High Availability (HA) mode. If DCNM is not operating in 
HA mode, use the DCNM node IP address.

Exclusive Policy 
Control 

When set, GV Orbit Control operates in exclusive mode: any change 
to the host aliases, host policies or flow policies (through DCNM web 
interface for example) will be overwritten and restored by GV Orbit 
Control. This is the supported mode to be used.
Only deselect this parameter under the guidance of Grass Valley 
Technical Support.

Enabled When set, GV Orbit Control controls the switch. 
When deselected, GV Orbit Control no longer controls the switch, 
thus allowing you to perform maintenance operations on the switch. 
When re-establishing control (set Enabled), GV Orbit Control will 
push the current policies to the switch.

Username Set the administrator’s username to access the DCNM network.

Password Set the administrator’s password to access the DCNM network.
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6 Do not configure any parameters found under Ports or Streams. These are shown for 
information purposes only. 

7 Add IP devices to the topology and then connect them to the switch: Click Quick 
Connect to link the devices. See Using Quick Connect to Link all Devices in a Topology, 
on page 222. See also Methods to Link Devices in a Topology, on page 222.

To support network redundancy for use with SMPTE ST 2022-7 compatible equipment, see 
Configuring Network Switch Redundancy to Support SMPTE ST 2022-7, on page 399.

Use the Path Manager to view and troubleshoot the flow of streams through the switch 
fabric. See Path Manager Tasks, on page 450.

Connection State 1 / 2 This shows the current connection state to the switch. When a 
redundant configuration is used (two GV Orbit Servers form a cluster) 
Connection State 1 and Connection State 2 shows the connectivity of 
each server to the switches.
Unknown: The Virtual IP is not configured yet or the topology is 
inactive.
Online: GV Orbit Control is connected to DCNM.
Offline: The topology is active and GV Orbit Control is unable to 
communicate with DCNM.
Reconnecting: GV Orbit Control is trying to reach DCNM.

Active Host Name In a redundant High Availability network architecture, one node (in 
standby mode) provides failover protection to another node (currently 
active). 
Host Name: The hostname is the unique name by which the active / 
standby node is known on the network. 
IP Address: The network IP address for the active / standby node.

Active IP Address

Standby Host Name

Standby IP Address

Parameter Description
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Direct Flow Orchestration: How To Create a Static Flow with a Cisco
Network Switch 

This topic describes the use case where a destination IP device does not have an API 
exposed that allows GV Orbit Control to direct the device’s receivers to join send streams. 
Or you want to control what is to be sent to an IP destination. For this, GV Orbit Control can 
control the egress ports of a network switch to statically stitch flows feeding the IP device. It 
is also necessary to remove the network interface ports from the available resources for 
dynamically stitching flows via IGMP joins. Another way of stating this, it is necessary to 
remove these paths from the available tielines.

To create a static flow with GV Orbit Control you need to set some information on an output 
port of a network switch with a DCNM control port.

1 For this procedure the following topology will be used. See Adding Devices to a 
Topology, on page 204.

2 In the Network Switch’s Property Editor, under Control Ports, select an output port on 
your network switch (for example, Cisco DCNM). This port should not be connected to 
anything. See Configuring Cisco DCNM Network Switch Devices, on page 389.

3 Set the number of streams you need in #Output Connectors. 
4 With the Cisco DCNM control port selected, set Expose Streams.
5 Set the name and IP address of the network switch’s control port (Cisco DCNM). You 

find this information through the Inventory page on the DCNM web UI. (Inventory, 
Switches, Select a leaf, Interfaces tab). You have to add 1 to the last number of the IP. For 
example: 192.102.45.0/31 becomes 192.102.45.1. 

6 On the port's streams, set the Logical Level. See Configuring the Logical Levels for the 
Devices in a Topology, on page 197.

7 On the port's streams, set Automatic Destination if you do not want to create a logical 
destination yourself.

8 To create the static flow, you need to do a normal take from the streams (or logical 
destination if you created one) to the source you want.

9 To confirm if the flow is passing, you can check the flow status page on the DCNM UI 
(Media Controller, Flow status). Note: If the static flow was created but the source does 
not have a signal, there will be no feedback.

To delete a static flow, you need to do a take from the destination to a source with an IP of 
0.0.0.0 on the streams.
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Configuring a GV Fabric Network Switch Device
GV Fabric is an IP switch enabling format agnostic signal routing for small to enterprise-
wide installations. GV Orbit Control automatically discovers and configures any GV Fabric 
switch found by the GV Orbit Automatic Network Configurator service. When this service 
finds a GV Fabric network switch on the network, or when you factory-reset an existing 
GV Fabric network switch, the service uses Zero Touch Provisioning (ZTP) to automatically 
configure the GV Fabric network switch to optimize its configuration to forward media 
traffic. Once the initial configuration of the GV Fabric switch is done, the GV Fabric switch 
becomes available as a discovered device in the Device Library. 

GV Orbit Control also monitors the switch and updates the configuration as required. For 
example, the switch’s media Ethernet interfaces are automatically assigned as members of 
the MEDIA_VLAN and configured for use.

PREREQUISTIES: 
• The Automatic Network Configurator service must be licensed, installed, and running on 

the GV Orbit Server. See Automatic Network Configurator Service in the GV Orbit Admin 
Guide; see Related Documentation, on page 7.

• The GV Orbit Server must be configured to use DHCP. See DHCP Task and Connecting 
the GV Fabric Network Switch in the GV Orbit Admin Guide; see Related 
Documentation, on page 7.

LIMITATION: You must manually configure an interface breakout by using the GV Fabric 
Command Line Interface (CLI).

To configure a GV Fabric Network Switch Device
1 Add the GV Fabric Network Switch device to the Topology: from the Device Library, 

Discovered, find the GV Fabric Network Switch device bubble that you want to use. See 
To add a Discovered Device to a Topology, on page 209. 
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2 Select Device Properties and select GV Fabric. See Defining Device Properties, on 
page 229 for more information.

3 Select GV Fabric tab (next to Control Port at the top of the Property Editor) to 
configure the Device Properties in the Property Editor. Only the properties shown 
below should be used. See also Description of Common Device Properties, on 
page 332.

Parameter Description

Network Host Name This is the unique name by which the Network Switch is identified 
within GV Orbit Control. This value is used to construct the 
input/output port labels.

GV Fabric Control Port parameters

Name Once GV Orbit Control connects to the switch, the switch’s name is 
read from the switch’s configuration.

MGT0 / MGT1 IP 
Address

Once GV Orbit Control connects to the switch, the switch’s 
management IP addresses are read from the switch’s configuration.

Username The Zero-Touch Provisioning (ZTP) process creates a gvapi user 
account in the switch. By default, GV Orbit Control uses the gvapi user 
account to access the switch.
The username field can be customized to use another switch user 
account. Such a user account’s capability must be Monitor or higher. 
See GV Fabric documentation to create a new user on the switch.
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4 Do not configure any parameters found under Ports or Streams. These are shown for 
information purposes only. 

5 Add IP devices to the topology and then connect them to the GV Fabric switch: Click 
Quick Connect to link the devices. See Using Quick Connect to Link all Devices in a 
Topology, on page 222. See also Methods to Link Devices in a Topology, on page 222.

To support network redundancy for use with SMPTE ST 2022-7 compatible equipment, see 
Configuring Network Switch Redundancy to Support SMPTE ST 2022-7, on page 399.

Use the Path Manager to view and troubleshoot the flow of streams through the switch 
fabric. See Path Manager Tasks, on page 450.

Password Set the administrator’s password for GV Orbit Control to access the 
GV Fabric switch’s user account.
When the GV Fabric device is added to the topology, the password for 
the gvapi user account is preset.

Connection State 1 / 2 This shows the current connection state to the switch. When a 
redundant configuration is used (two GV Orbit Servers form a cluster) 
Connection State 1 and Connection State 2 shows the connectivity of 
each server to the switches.
Unknown: The Virtual IP is not configured yet or the topology is 
inactive.
Online: GV Orbit Control is connected to DCNM.
Offline: The topology is active and GV Orbit Control is unable to 
communicate with DCNM.
Reconnecting: GV Orbit Control is trying to reach DCNM.

Parameter Description
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Configuring Network Switch Redundancy to Support SMPTE 
ST 2022-7

This topic describes the theory of how to implement network redundancy, and as such, 
information is provided as an example that can be used for any SMPTE ST 2022-7 
compatible equipment. 

To make streaming more reliable over an IP network, the implementation of SMPTE 
ST 2022-7 seamless protection switching depends on stream redundancy. This protection 
scheme transmits two identical packet streams over physically separate network routes 
(shown as Red LAN and Blue LAN in the figure below), so that if packets from one network 
are lost or delayed, the data can be reconstructed using packets from the second network 
stream. This process is seamless because switching between the streams is instantaneous 
and does not impact content. 

PREREQUISITES: 
• At least two DCNM-compliant switches must be used for this application. Contact Grass 

Valley for more information about switch compatibility. See Grass Valley Technical 
Support, on page 862.

Blue LAN

Red LAN

IPG-3901 B

IPG-3901 A

GV Node B

GV Node A

IPG-4901 B

Network
Switch ‘Red’

Network
Switch ‘Blue’

IPG-4901 A
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• For any GV Node frame:
a In iControl’s GV Node Manager, make sure to set redundancy to ON. See the GV 

Node User Manual for more information. 
b In GV Orbit Control, set 2022-7 Mode and configure the Redundancy Port 

parameter. See Configuring a GV Node Device, on page 333.
• For any IPG-4901 / IPG-3901 card

a In iControl’s Network panel, Settings tab, for the ETH 2 Port, make sure to set the 
Operation Mode to Redundancy. See the IPG-4901 Guide to Installation and 
Operation for more information.

b In GV Orbit Control, set the Operation Mode to Redundancy. See Configuring an 
IPG-3901 / IPG-4901 Device, on page 343.

• For certain third-party devices you may have to configure port redundancy manually. 
See Setting Port Redundancy for Many Devices at Once, on page 220.

To configure SMPTE ST 2022-7 example
1 Add the following devices to the Topology: from the Device Library, Virtual Device, 

add the following device bubbles to the Topology. See Adding a Virtual Device to a 
topology, on page 204. 

Quantity Device

2 Network Switch

2 IPG-3901

2 3 instances in a group Camera

2 3 instances in a group Monitor
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Arrange the devices on the Topology as shown below.

2 Activate the topology. See Activating a Topology, on page 235.
3 Configure the devices on the Topology. See Special Devices, on page 331. For any other 

device, see Adding Devices to a Topology, on page 204. 
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4 Click Quick Connect to link the devices as shown below. See Using Quick Connect to 
Link all Devices in a Topology, on page 222. See also Methods to Link Devices in a 
Topology, on page 222.

Much more elaborate systems can be configured. The objective is to connect all SMPTE 
ST 2022-7 IP devices (#2 to #9) to both network switches (RED and BLUE).

5 If you are manually making the connections between the devices, select the links 
between devices, one at a time, to make the connections between devices as shown 
below. See Manually Setting the Link’s Physical Connection Parameters (Sources and 
Destinations), on page 225. If you use Quick Connect, this is not necessary.

Link Make the following connections

# From To From To

1 Camera IPG-3901 Cam1
Cam2
Cam3

SDI to 1 (Input Port Id: 3)
SDI to 2 (Input Port Id: 4)
SDI to 3 (Input Port Id: 5)

2 IPG-3901 Network Switch 
RED

ETH1 SwitchIn1

3 IPG-3901 Network Switch 
BLUE

ETH2 SwitchIn1

4 Network Switch 
RED

IPG-3901 SwitchOut1 ETH1

5 Network Switch 
BLUE

IPG-3901 SwitchOut1 ETH2

6 IPG-3901-A Network Switch 
RED

ETH1 SwitchIn2

1

4

5

3

2

9

8

6

7

10
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7 IPG-3901-A Network Switch 
BLUE

ETH2 SwitchIn2

8 Network Switch 
RED

IPG-3901-A SwitchOut2 ETH1

9 Network Switch 
BLUE

IPG-3901-A SwitchOut2 ETH2

10 IPG-3901 Camera SDI to 1 (Output Port Id: 3)
SDI to 2 (Output Port Id: 4)
SDI to 3 (Output Port Id: 5)

Mon1
Mon2
Mon3

Link Make the following connections

# From To From To
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Configuring an NVISION Hybrid Series Router
To control an NVISION Hybrid Series Router, GV Orbit Control uses the NP0016 router 
control protocol. The following NVISION Hybrid Routers are supported: NV8140, NV8144, 
NV8280, NV8576, or NV8576 Plus. Once the IP address(es) have been added to the Control 
Port(s) that connects to the NVISION Hybrid Series Router, the router’s configuration is read 
into GV Orbit Control, and the router’s card types and ports are automatically configured 
within GV Orbit Control.

PREREQUISITE: You must have a list of the card type for each slot in the router’s frame. This 
information may be available in the router’s MRC configuration software.

LIMITATIONS: 
• The disembedder / embedder output card is currently not supported.
• The following topology use case is unsupported.

The tieline between two NVISION Hybrid Routers should not be MADI (for example, to 
link between a MADI source and a MADI destination). Taking a MADI source to a MADI 
destination will only work if both of them are directly connected to the same NVISION 
Hybrid Series Router.

• The following topology use case does not support lock and protect from a third-party 
control system on the NVISION Hybrid Router for a Logical Destination. 

Any output of a NVISION Hybrid Router that is connected to another router cannot be 
locked in GV Orbit Control. GV Orbit Control will only update the lock/protect status of 
a destination which is directly connected to the NVISION Hybrid Router (that is, without 
any other devices in-between).
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To configure an NVISION Hybrid Series Router Device
1 Add the NV Hybrid Router device to the Topology: from the Device Library, Virtual 

Device, find the NV Hybrid Router device bubble. See Adding a Virtual Device to a 
topology, on page 204. 

2 The control port(s) must be configured to allow communication with the router 
thereby permitting GV Orbit Control to control the router. NVISION Hybrid Series 
Routers are controlled through the NP0016 router control protocol.
Select the NV Hybrid Router bubble and click New  next to Control Port at the top 
of the Property Editor and select the router’s control protocol from the list. Dummy 
can be used for testing purposes (or pre-deployment) when the actual router model is 
unknown. See also Defining Device Properties, on page 229 for more information.

A tab for the selected router model appears. Select this tab to configure the control 
port. 
If the router has a second redundant network connection for controlling it, add a 
second control port and configure it the same way as the first one except for the IP 
address which must reflect that of the router’s second network connection.
Specifically, you must set the router’s control port IP Address and IP Port number 
parameters.

To delete a control port, see To delete a router’s control port, on page 426.
3 Activate the topology. See Activating a Topology, on page 235.

Router Control Protocol See

NP0016 Compact Router NP0016 Compact Router Control Port Configuration Parameters, 
on page 427

NP0016 Enterprise Router NP0016 Enterprise Router Control Port Configuration Parameters, 
on page 427
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The Connection State 1 / 2 status for the control port(s) becomes Online when is has 
successfully connected to the NVISION Hybrid router. 
Once GV Orbit Control has connected to the NVISION Hybrid Router through the 
Control Port, it reads the router’s configuration to then automatically configure the 
NVISION Hybrid Router device properties in GV Orbit Control accordingly. Should the 
NVISION Hybrid router’s configuration change (for example, changes have been made 
to the type and slot location of the router’s cards), the router’s configuration can be re-
loaded into GV Orbit Control; see To automatically refresh the NVISION Hybrid router’s 
card information in GV Orbit Control, on page 409.

4 Deactivate the topology. See Making an Active Topology Inactive, on page 236.
5 Configure the NVISION Hybrid Series Router properties. See also Description of 

Common Device Properties, on page 332. 

6 This step is optional; setting the Card Type for each slot in the router’s frame can 
automatically be done by GV Orbit Control: To automatically update GV Orbit Control’s 
configuration when the type and slot location of the cards have been changed in the 
router, see To automatically refresh the NVISION Hybrid router’s card information in 
GV Orbit Control, on page 409.
Manually set the router’s card type for any of the router’s input and output slots that 
need to be updated: select an Input Slot or Output Slot in the router’s frame in the 

Parameter Description

Network Host Name The hostname is the unique name by which the associated NVISION 
Hybrid Series Router is known on the network. 

Audio Physical Level 
ID

From the NVISION Hybrid Series Router’s configuration, specify the 
level ID number that has been assigned to the router’s audio matrix. 
Usually this is 2.

Video Physical Level 
ID

From the NVISION Hybrid Series Router’s configuration, specify the 
level ID number that has been assigned to the router’s video matrix. 
Usually this is 1.

NVision Hybrid Router 
Type

Shows the router’s model type. This is automatically read from the 
router.

Advanced > Internal 
Wiring Done

Shows if the internal modeling of the NVISION Hybrid Router is 
complete.
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Property Editor and then set the card type in the Card Type parameter. If the slot has 
no card installed in it, set the Card Type parameter to NONE.
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7 Select each input or output port to configure them individually. These are the 
configuration parameters for each of the router’s input/output ports. See also 
Description of Common Device Properties, on page 332.

Parameter Description

Port Identifier This is the generic identifier of the port within GV Orbit Control.

Number This shows the current status for information purposes.

Direction

Connector Type

Capacity (bps) The stream’s data rate.

Bandwidth Usage 
(bps)

This shows the current status for information purposes.

Embedder bypassed Shows the current embedder status for the selected output port 
according to the current path being routed. See also Path Manager 
Tasks, on page 450.
When set, the output embedder is not being used. 
When deselected, the output embedder is being used. 
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8 Select each steam found under each input and output port to configure them 
individually. These are the configuration parameters for the individual streams carried 
on a network port. See also Description of Common Device Properties, on page 332.

9 Link the NVISION Hybrid Router to other devices on the topology that the NVISION 
Hybrid Router is connected to in the real world. See Methods to Link Devices in a 
Topology, on page 222.

10 Test the configuration by making takes that use this router. See Performing a Take in 
Router Control, on page 471.

To automatically refresh the NVISION Hybrid router’s card information in GV Orbit 
Control 

When the router has been reconfigured with new or different cards, GV Orbit Control can 
read the router’s configuration again to automatically configure the NVISION Hybrid Router 
device properties in GV Orbit Control accordingly.

1 De-activate the topology if activated. See Making an Active Topology Inactive, on 
page 236.

2 Select one of the router’s control ports.
3 Scroll-down the router’s Device Properties list to the control port.

4 Click Update Slotted Cards and then click OK. 
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GV Orbit Control reads the router’s configuration to then automatically configure the 
NVISION Hybrid Router device properties in GV Orbit Control accordingly. 

5 Activate the topology. See Activating a Topology, on page 235.



411

GV Orbit Version 2.3.0 Special Device Configuration Tasks
User Guide Configuring a Sirius Series Router

Configuring a Sirius Series Router
A Sirius 800 series router device type can be added to the topology for more detailed 
control, including support for multiple controllers and different types of I/O cards. Note that 
the router must have been previously configured before adding it to the topology. See the 
router’s documentation for this.

To control a Sirius Series Router, GV Orbit Control uses the SAM SW-P-08 TCP/IP router 
control protocol. The following Sirius Routers are supported: Sirius Dual S850, Sirius S830, 
Sirius S840, or Sirius S850. Once the IP address(es) have been added to the Control Port(s) 
that connects to the Sirius Series Router, the router’s current cross-points are read into 
GV Orbit Control.

PREREQUISITE: You must have a list of the card type for each slot in the router’s frame. This 
information may be available in the router’s MCM configuration software.

LIMITATIONS: 
• The following topology use case is unsupported.

The tieline between two Sirius Routers must not be MADI or AES (for example, to link 
between a MADI source and a MADI destination) unless both routers are equipped with 
AHP cards for this. 

• The following topology use case does not support lock and protect from a third-party 
control system on the Sirius Router for a Logical Destination. 

Any output of a Sirius Router that is connected to another router cannot be locked in 
GV Orbit Control. GV Orbit Control will only update the lock/protect status of a 
destination which is directly connected to the Sirius Router (that is, without any other 
devices in-between).
GV Orbit Control only handles lock/protect on destinations. If a router locks an output 
and GV Orbit Control doesn't have a corresponding Logical Destination, no lock will be 
seen in GV Orbit Control. Also note that SWP08 does not support the concept of a 
Protect; only LOCK is supported.

• GV Orbit Control only supports MV83X cards when they have been configured with 
Redundancy set to true with the Workbench router configuration software. The setting 
for Main output follow is ignored.
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To configure a Sirius Series Router Device
1 Add the NV Hybrid Router device to the Topology: from the Device Library, Virtual 

Device, find the Sirius Router device bubble. See Adding a Virtual Device to a topology, 
on page 204. 

2 The control port(s) must be configured to allow communication with the router 
thereby permitting GV Orbit Control to control the router. Sirius Series Routers are 
controlled through the SAM SW-P-08 TCP/IP router control protocol.
Select the NV Hybrid Router bubble and click New  next to Control Port at the top 
of the Property Editor and select the router’s control protocol from the list. Dummy 
can be used for testing purposes (or pre-deployment) when the actual router model is 
unknown. See also Defining Device Properties, on page 229 for more information.

A tab for the selected router model appears. Select this tab to configure the control 
port. 
If the router has a second redundant network connection for controlling it, add a 
second control port and configure it the same way as the first one except for the IP 
address which must reflect that of the router’s second network connection.
Specifically, you must set the router’s control port IP Address and IP Port number 
parameters. See SAM SW-P-08 TCP/IP Control Port Configuration Parameters, on page 431 
to configure the control port(s) for the router.

To delete a control port, see To delete a router’s control port, on page 426.
3 Activate the topology. See Activating a Topology, on page 235.

The Connection State 1 / 2 status for the control port(s) becomes Online when is has 
successfully connected to the Sirius router. 

4 Deactivate the topology. See Making an Active Topology Inactive, on page 236.
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5 Configure the Sirius Series Router properties. See also Description of Common Device 
Properties, on page 332. 

6 For each of the router’s input, output, and multiviewer slots, set the Card Type for each 
slot in the router’s frame in the Property Editor under Input slots, Output slots, and 
MV slots: Select an Input slot, Output slot, MV slot and then set the card type in the 
Card Type parameter. Do so for each and every input, output, and multiviewer card 
slot. If the slot has no card installed in it, set the Card Type parameter to NONE.Link the 
Sirius Router to other devices on the topology that the Sirius Router is connected to in 
the real world. See Methods to Link Devices in a Topology, on page 222.

Parameter Description

Network Host Name The hostname is the unique name by which the associated Sirius 
Series Router is known on the network. 

Audio Matrix ID Specific to SWP08, it is similar to a level, but each Matrix could have 
multiple levels, but we only support one. Default is 2.

Audio Physical Level 
ID

From the Sirius Series Router’s configuration, specify the level ID 
number that has been assigned to the router’s audio matrix. Usually 
this is 1. For example, this is level 1 of matrix 2. 

Video Matrix ID From the Sirius Series Router’s configuration, specify the level ID 
number that has been assigned to the router’s video matrix. Usually 
this is 1.

Video Physical Level 
ID

From the Sirius Series Router’s configuration, specify the level ID 
number that has been assigned to the router’s video matrix. Usually 
this is 1.

Advanced > Sirius 
Router Type

Set the router’s model type. 

Advanced > Internal 
Wiring Done

Shows if the internal modeling of the Sirius Router is complete.
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For example, certain cards such as the MV830 use an input and output slot: If such a 
card is located in slot 1, then set the Card type for Input slots 1 to MV830 and set the 
Card type for Output slots 1 to MV830 also.
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7 Select each input or output port to configure them individually. These are the 
configuration parameters for each of the router’s input/output ports. See also 
Description of Common Device Properties, on page 332.

Parameter Description

Port Identifier This is the generic identifier of the port within GV Orbit Control.

Direction This shows the current status for information purposes.

Connector Type

Capacity (bps) The stream’s data rate.

Bandwidth Usage 
(bps)

This shows the current status for information purposes.
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8 Select each steam found under each input and output port to configure them 
individually. These are the configuration parameters for the individual streams carried 
on a network port. See also Description of Common Device Properties, on page 332.

9 Link the Sirius Router to other devices on the topology that the Sirius Router is 
connected to in the real world. See Methods to Link Devices in a Topology, on 
page 222.

10 Test the configuration by making takes that use this router. See Performing a Take in 
Router Control, on page 471.

Logical Destinations for Multiviewer Cards
When the Sirius router is equipped with multiviewer cards, and the matching card 
configuration is made in GV Orbit Control, Logical Destinations are automatically created 
for these multiviewer destinations. See Router Control Tasks, on page 470.

This allows you to control the multiviewer inputs. 
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In Router Control, use Sirius Router as a filter to focus on these multiviewer destinations. See 
Filtering Lists, Table Columns, Sources, and Destinations, on page 266.

Sirius Router Card Type and making Physical Connections
The Sirius Router has a number of cards that support different physical connection types.

Configuring a MADI Source / Destination for use
For a MADI source, proceed as follows.

1 Add a MADI source device to the topology and name it accordingly. Typically this is an 
SDI device. See Adding Devices to a Topology, on page 204.

2 Select the device bubble for the MADI source device and if necessary, set the Default 
connector type property in the MADI Device Properties to MADI. See Defining Device 
Properties, on page 229. 

Typical Logical 
Destination naming Description

Sirius Router MV-
PTs.pp

PT: Pass through where s is the slot number and pp is the port number.

Sirius Router MV-
OBs.pp

OB: On board where s is the slot number and pp is the port number.

Card Type For more information, see

AES + MADI Configuring an AES Source / Destination for use, on page 419
Configuring a MADI Source / Destination for use, on page 417MADI

MV800 Methods to Link Devices in a Topology, on page 222

MV830

MV831

MV840

MV850

SDI

SDI AHP



418

Special Device Configuration Tasks GV Orbit Version 2.3.0
Sirius Router Card Type and making Physical Connections User Guide

Under the MADI Device Properties, OUT, Ports, 64 MADI audio Streams become 
available and these streams also become available in the Stream Browser of the 
Logical Device Table.

3 Link the MADI source device to the Sirius Router. For example, in the Physical 
Connections Table, MADI connectors are identified by the  symbol. See Manually 
Linking the Devices in a Topology, on page 224 and Manually Setting the Link’s Physical 
Connection Parameters (Sources and Destinations), on page 225.

Normally, GV Orbit only routes 16 audio channels at a time. A MADI source has 64 audio 
channels, so a MADI source requires 4 sources to route all the audio channels. You must 
create these sources in the Logical Device Table. 

4 Create 4 new sources in the Logical Device Table. See Adding a Source or Destination 
to the Logical Level Table, on page 248. For example, create the following sources: 
Madi1, Madi2, Madi3, and Madi4.
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5 From the Stream Browser, assign the MADI streams to the audio channels in the 
sources. For example:

• Assign MADI.1 to MADI.16 in the Stream Browser to Madi1 A1 to A16 in the 
Multilevel Table (drop the streams on the A1 column).

• Assign MADI.17 to MADI.32 in the Stream Browser to Madi2 A1 to A16 in the 
Multilevel Table.

• Assign MADI.33 to MADI.48 in the Stream Browser to Madi3 A1 to A16 in the 
Multilevel Table.

• Assign MADI.49 to MADI.64 in the Stream Browser to Madi4 A1 to A16 in the 
Multilevel Table.

See also Bulk Assigning Logical Levels in the Multilevel Table, on page 253.
6 Create 4 new destinations in the Logical Device Table. See Adding a Source or 

Destination to the Logical Level Table, on page 248. For example, create the following 
destinations: Madi1, Madi2, Madi3, and Madi4.

7 From the Stream Browser, assign the MADI streams to the audio channels in the 
destinations. For example:

• Assign MADI.1 to MADI.16 in the Stream Browser to Madi1 A1 to A16 in the 
Multilevel Table (drop the streams on the A1 column).

• Assign MADI.17 to MADI.32 in the Stream Browser to Madi2 A1 to A16 in the 
Multilevel Table.

• Assign MADI.33 to MADI.48 in the Stream Browser to Madi3 A1 to A16 in the 
Multilevel Table.

• Assign MADI.49 to MADI.64 in the Stream Browser to Madi4 A1 to A16 in the 
Multilevel Table.

Configuring an AES Source / Destination for use
For a AES source, proceed as follows.

1 Add an AES source device to the topology and name it accordingly. Typically this is an 
SDI device. See Adding Devices to a Topology, on page 204.

Select the row before dropping the streams onto it
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2 Link the AES source device to the Sirius Router. See Manually Linking the Devices in a 
Topology, on page 224 and Manually Setting the Link’s Physical Connection Parameters 
(Sources and Destinations), on page 225.

3 Select the device bubble for the AES source device and set the Logical Level property 
in the AES Device Properties to AES. See Defining Device Properties, on page 229. 
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4 In the Logical Level Selector, select AES as the level and click OK. 

In the Logical Device Table, two AES channels become available in the Channel 
Browser of AES stream in the Stream Browser. See Logical Device Table Tasks, on 
page 241.

5 Select the AES channels in the channel browser.

6 Click Automated Sources  in the channel browser to create the sources / destinations 
for the AES channels. 

7 ???DONE TO HERE???
8
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Configuring Router Devices
The following procedure configures a router device. Different models of routers use a range 
of control protocols that GV Orbit Control uses to control the router. Each router control 
protocol is individually covered in follow up procedures: see also Configuring a Router’s 
Control Port, on page 425.

For more information about how GV Orbit Control manages a router’s Lock, Protect, and 
Release, see also About Lock, Protect, and Release, on page 472.

To configure a Router Device
1 Add the Router device to the Topology: from the Device Library, Virtual Devices, find 

the Router Device bubble. See Adding a Virtual Device to a topology, on page 204. 
2 Add and configure router control port(s) according to the router model you want to 

control. Control port(s) must be configured to allow communication with the router 
thereby permitting GV Orbit Control to control the router; see Configuring a Router’s 
Control Port, on page 425.

3 Select the router’s tab (next to Control Port at the top of the Property Editor) to 
configure the Device Properties in the Property Editor. See also Description of 
Common Device Properties, on page 332.

Parameter Description

Network Host Name The hostname is the unique name by which the associated router is 
known on the network. 

Physical Level ID Set the Physical Level ID value that has been configured for the 
corresponding router to be controlled by this device instance. To 
obtain this value, use the router’s native configuration interface.

Advanced > Default 
Connector Type

The router’s physical interface port connector: HD/SDI, IP/RJ-45, 
MADI.

Controller Starting 
Input

The starting input port number from which you want to control the 
router’s physical level. 

Controller Starting 
Output

The starting output port number from which you want to control the 
router’s physical level. 
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4 Set the number of physical input and output connectors being used on the router in # 
Input Connectors and # Output Connectors. 

The configuration for these ports become available as Ports under IN and OUT.
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5 Select each input or output port to configure them individually. These are the 
configuration parameters for each of the router’s input/output ports. See also 
Description of Common Device Properties, on page 332.

Parameter Description

Port Identifier This is the generic identifier of the port within GV Orbit Control.

Number This shows the current status for information purposes.

Direction

Connector Type

Capacity (bps) The stream’s data rate.

Bandwidth Usage 
(bps)

This shows the current status for information purposes.

IP Address This is the interface IP address of the selected port. This is currently not 
used in the router virtual device.

Redundancy Port Associate this port with another port to create a redundant network 
traffic flow path for failover protection. The associated port will not be 
available to carry other traffic.
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6 Select each steam found under each input and output port to configure them 
individually. These are the configuration parameters for the individual streams carried 
on a network port. See also Description of Common Device Properties, on page 332.

7 Link the router to other devices on the topology that the router is connected to in the 
real world. See Methods to Link Devices in a Topology, on page 222.

8 Test the configuration by making takes that use this router. See Performing a Take in 
Router Control, on page 471.

Configuring a Router’s Control Port
Control port(s) must be configured to allow communication with the router thereby 
permitting GV Orbit Control to control the router. There are many types of control ports 
suited to the router’s individual model or control protocol. First, you must add a control port 
to the router’s configuration in GV Orbit Control and then configure it. 

PREREQUISITE: Add a router device to the Topology Configurator. See To configure a Router 
Device, on page 422.

To add a router control port
1 Select the Router bubble on the Topology Configurator and then select Device 

Properties and click New  next to Control Port at the top of the Property Editor and 
select the router’s model / control protocol from the list. Dummy can be used for 
testing purposes (or pre-deployment) when the actual router model is unknown. See 
also Defining Device Properties, on page 229 for more information.

A tab for the selected router model appears. Select this tab to configure the control 
port. The control port(s) must be configured to allow communication with the router 
thereby permitting GV Orbit Control to control the router.
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If the router has a second redundant network connection for controlling it, add a 
second control port and configure it the same way as the first one except for the IP 
address which must reflect that of the router’s second network connection.

2 Configure the control port. See below.

To delete a router’s control port

Delete a router’s control port as follows.
1 De-activate the topology if activated. See Making an Active Topology Inactive, on 

page 236.
2 Select one of the router’s control ports.
3 Scroll-down the router’s Device Properties list to the control port

4 Click Delete.

Supported router control protocols
The following router control protocols are supported.

Router Control Protocol See

NP0016 Compact Router NP0016 Compact Router Control Port Configuration Parameters, 
on page 427

NP0016 Enterprise Router NP0016 Enterprise Router Control Port Configuration Parameters, 
on page 427

NS-BUS NS-BUS Control Port Configuration Parameters, on page 430

NV9000 TCP/IP (NP0017 
device-based)

NV9000 TCP/IP Control Port Configuration Parameters, on 
page 430

SAM SW-P-08 TCP/IP SAM SW-P-08 TCP/IP Control Port Configuration Parameters, on 
page 431
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NP0016 Compact Router Control Port Configuration Parameters
See also Description of Common Device Properties, on page 332.

NP0016 Enterprise Router Control Port Configuration Parameters
The enterprise router control port supports the protocol's 'Coherent take' command when 
performing multiple crosspoint changes at the same time. See also Description of Common 
Device Properties, on page 332.

Parameter Description

IP Address The network IP address for the associated router’s management or 
control port Ethernet address.

Connection State 1 Connection State 1 shows the connection status of the router with the 
primary server of a server group. 
Connection State 2 shows the connection status of the router with the 
secondary server of a server group. See Configuring a Controller 
Group, on page 179.
unknown: The topology is inactive (see Activating a Topology, on 
page 235) or the router does not have network connectivity to the 
GV Orbit Server(s).
offline: The router does not have network connectivity to the GV Orbit 
Server(s).
online: The router is connected to the GV Orbit Server(s).

Connection State 2

Connections From 
Multiple Servers

Set this if the router supports multiple concurrent connections to it. 
When set, this allows GV Orbit Control main and backup servers to 
connect at the same time to the router, thereby increasing system 
availability.

IP Port Port number for the control port stream used by the router. The 
default is 5194.

In router Lock/Protect 
enabled

Set to transfer the management of Locks/Protects from the GV Orbit 
Control control system to the Router for destinations that are directly 
connected to this router. 
Deselect to manage all Lock/Protect in GV Orbit Control exclusively.
See About In router Lock/Protect enabled for a Router using NP0016 
router control protocol, on page 429.

Parameter Description

IP Address The network IP address for the associated router’s management or 
control port Ethernet address.
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Connection State 1 Connection State 1 shows the connection status of the router with the 
primary server of a server group. 
Connection State 2 shows the connection status of the router with the 
secondary server of a server group. See Configuring a Controller 
Group, on page 179.
unknown: The topology is inactive (see Activating a Topology, on 
page 235) or the router does not have network connectivity to the 
GV Orbit Server(s).
offline: The router does not have network connectivity to the GV Orbit 
Server(s).
online: The router is connected to the GV Orbit Server(s).

Connection State 2

Connections From 
Multiple Servers

Set this if the router supports multiple concurrent connections to it. 
When set, this allows GV Orbit Control main and backup servers to 
connect at the same time to the router, thereby increasing system 
availability.

IP Port Port number for the control port stream used by the router. The 
default is 5194.

In router Lock/Protect 
enabled

Set to transfer the management of Locks/Protects from the GV Orbit 
Control control system to the Router for destinations that are directly 
connected to this router. 
Deselect to manage all Lock/Protect in GV Orbit Control exclusively.
See About In router Lock/Protect enabled for a Router using NP0016 
router control protocol, on page 429.

Use Coherent Take 
Message

Set for GV Orbit Control to use the protocol's 'Coherent take' 
command when performing multiple crosspoint changes at the same 
time for this router.

Parameter Description
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About In router Lock/Protect enabled for a Router using NP0016 router control protocol

For a router using the NP0016 router control protocol, Lock, Protect, and Release have 
different behaviors depending on whether the In router Lock/Protect enabled parameter 
is set in the Router Control Port configuration. 

See also About Lock, Protect, and Release, on page 472.

In router 
Lock/Protect 
enabled parameter Description

Set For destinations that are directly attached to the router, this setting 
transfers the management of Locks/Protects from the GV Orbit Control 
control system to this router, thereby allowing better third-party 
router control integration with GV Orbit Control. This is called in router 
lock and protect. 
This setting keeps the router’s Lock/Protect and GV Orbit Control’s 
Lock/Protect in synchronization as follows: 
• If a Lock/Protect is updated in the router, it's also updated in GV Orbit 

Control.
• If a Lock/Protect is updated in GV Orbit Control, it's also updated in 

the router.
This option has the following effects and consequences: When locks / 
protections are created in the router through another control system, 
the user name used to create the locks / protections will be unknown 
to GV Orbit Control’s user management mechanism. These unknown 
users are treated as admin users within GV Orbit Control. Note that 
admin users within GV Orbit Control can override the locks and 
protections of any other GV Orbit Control user. This means that any 
third-party control system will override locks / protections made in 
GV Orbit Control.

Deselected GV Orbit Control stores the locks in its database and they are 
preserved after a restart/reboot. As such, destinations will remain 
locked/protected. GV Orbit Control system does not read a lock from 
a router and does not control a lock in the router. This is called in 
control system lock and protect. This is how all other types of routers 
are managed.
Locks and protections are made in GV Orbit Control without 
consideration of any locks and protections that have been made 
through another control system (locks and protections are not 
synchronized between GV Orbit Control and the router). This can 
result in unexpected routing behavior such as a failed path that looks 
as though it should have been successful.
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NS-BUS Control Port Configuration Parameters
See also Description of Common Device Properties, on page 332.

NV9000 TCP/IP Control Port Configuration Parameters
This option uses the NP0017 device-based router control protocol to control an NV9000 
router through Ethernet network link(s). If the router has two control ports, add a second 
control port, one for each control port on the router. See also Description of Common 
Device Properties, on page 332.

Parameter Description

Connection State 1 Connection State 1 shows the connection status of the router with the 
primary server of a server group. 
Connection State 2 shows the connection status of the router with the 
secondary server of a server group. See Configuring a Controller 
Group, on page 179.
unknown: The topology is inactive (see Activating a Topology, on 
page 235) or the router does not have network connectivity to the 
GV Orbit Server(s).
offline: The router does not have network connectivity to the GV Orbit 
Server(s).
online: The router is connected to the GV Orbit Server(s).

Connection State 2

IP Address The network IP address for the associated router’s management or 
control port Ethernet address.

IP Port Port number for the control port stream used by the router. The 
default is 37800.

Multiple Connections 
Capable

Set this if the router supports multiple concurrent connections to it. 
When set, this allows GV Orbit Control main and backup servers to 
connect at the same time to the router, thereby increasing system 
availability.

Parameter Description

IP Address The network IP address for the associated router’s management or 
control port Ethernet address.

Connection State 1 Connection State 1 shows the connection status of the router with the 
primary server of a server group. 
Connection State 2 shows the connection status of the router with the 
secondary server of a server group. See Configuring a Controller 
Group, on page 179.
unknown: The topology is inactive (see Activating a Topology, on 
page 235) or the router does not have network connectivity to the 
GV Orbit Server(s).
offline: The router does not have network connectivity to the GV Orbit 
Server(s).
online: The router is connected to the GV Orbit Server(s).

Connection State 2
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Lock, Protect, and Release with the NV9000 Control Port

GV Orbit Control stores the locks in its database and they are preserved after a 
restart/reboot. As such, destinations will remain locked/protected. The GV Orbit Control 
system does not read a lock from a router and does not control a lock in the router.

See also About Lock, Protect, and Release, on page 472.

SAM SW-P-08 TCP/IP Control Port Configuration Parameters
Grass Valley/Pro Bel devices including the Sirius router that use the Pro Bel SW-P-08 
switcher protocol can be controlled by GV Orbit Control through an IP network. These 
routers use two control ports to control them. 

LIMITATION: GV Orbit Control control of a Sirius router is limited to a maximum of 11522 
crosspoints using single-level X-Y control. 

To connect the GV Orbit Server to the router
1 Add two control ports in GV Orbit Control. See To add a router control port, on 

page 425.
2 Configure both control port configuration parameters. See also Description of 

Common Device Properties, on page 332.

Connections From 
Multiple Servers

Set this if the router supports multiple concurrent connections to it. 
When set, this allows GV Orbit Control main and backup servers to 
connect at the same time to the router, thereby increasing system 
availability.

IP Port Port number for the control port stream used by the router. 

Protocol The IP connection protocol.
TCP: A point-to-point connection protocol.
UDP: A stateless connection protocol that can also broadcast data to 
more than one device.

Parameter Description

IP Address The network IP address for the associated router’s management or 
control port Ethernet address.

Connection State 1 Connection State 1 shows the connection status of the router with the 
primary server of a server group. 
Connection State 2 shows the connection status of the router with the 
secondary server of a server group. See Configuring a Controller 
Group, on page 179.
unknown: The topology is inactive (see Activating a Topology, on 
page 235) or the router does not have network connectivity to the 
GV Orbit Server(s).
offline: The router does not have network connectivity to the GV Orbit 
Server(s).
online: The router is connected to the GV Orbit Server(s).

Connection State 2

Parameter Description
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Connections From 
Multiple Servers

Set this if the router supports multiple concurrent connections to it. 
When set, this allows GV Orbit Control main and backup servers to 
connect at the same time to the router, thereby increasing system 
availability.

IP Port Port number for the control port stream used by the router. The 
default is 14000.

Matrix ID A SW-P-08 device can have multiple matrices, each with multiple 
physical levels. Set the Matrix ID value that has been configured for the 
corresponding router to be controlled by this device instance. To 
obtain this value, use the router’s native configuration interface.
Refer to your router’s documentation for more information about this 
parameter. 

Polling Set this to poll the crosspoint status at regular intervals.

Protocol The IP connection protocol.
TCP: A point-to-point connection protocol.
UDP: A stateless connection protocol that can also broadcast data to 
more than one device.

Use Extended Mode Set this for GV Orbit Control to try to use the extended command set 
of the SW-P-08 protocol with the router first. Extended commands 
allow routers larger than 1023 1023 to be controlled. If the router 
does not support extended commands, the GV Orbit Control will 
fallback to the standard command set and with it, the associated 
control limitations.

Parameter Description
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Configuring a Device that Supports Audio Breakaway/Shuffling 
such as Audio Live

Audio breakaway and shuffling can be done by Audio Live and by GV Node. Audio Live is 
designed specifically for audio processing.

About Audio Live
Audio Live is an IP-only device that manages audio feeds only. It accepts a number of AES67 
streams as inputs. Internally, it demultiplexes these inputs to obtain a series of mono PCM 
audio channels which then go through an audio router. Outputs from the router get 
multiplexed in accordance with the required output configuration. This allows Audio Live 
to perform breakaway and/or shuffling of mono channel audio feeds, in addition to audio 
format conversion.

Example Audio Live configuration with 128  16 matrix for the input and 64 32 matrix for the output

The inputs and outputs of an Audio Live are called spigots. There are a variety of spigot 
configurations that are available. See also How to Know if a Spigot is an Input or an Output, 
on page 353.

GV Orbit Control is able to detect the number of channels in the input spigots and will 
assign one of the AES67 levels to the input stream for each spigot (for example, AES67-4, 
AES67-8, AES67-16, AES67-32 or AES67-64). This is conditional on having configured the 
input spigots in GV Orbit Client to not use the Auto setting for the number channels. This is 
shown in the procedure below (Required Audio Live Configuration in the GV Orbit Client 
Control Panel, on page 434).

AES 
Stream

1

AES 
Stream

1

Internal Audio Matrix
2048 × 2048

Input Streams Output StreamsMultiplexersDemultiplexers

...

1Channel 1

2Channel 2

16Channel 16

...

17Channel 1

18Channel 2

32Channel 16

...

2031Channel 1

2032Channel 2

2048Channel 16

...

AES 
Stream

2

AES 
Stream

2

...

1 Channel 1

2 Channel 2

32 Channel 32

...

2017 Channel 1

2018 Channel 2

2048 Channel 32

AES 
Stream

64

...
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GV Orbit Control will detect the number of channels in the output spigots and one of the 
AES67 logical levels will be automatically assigned to the output stream of each output 
spigot (for example, AES67-4, AES67-8, AES67-16, AES67-32 or AES67-64).

Audio Live can accept audio packets with any packet time on the input. Audio Live can 
convert audio packet times as well as the number of channels in the streams. For example, 
an input spigot accepts an AES67 stream with 8 channels and packet time of 1 millisecond, 
and route the signals to an output spigot with 16 channels and packet time of 250 
microseconds. When using audio streams with different packet times however, extra 
configuration steps are required: see Required Configuration for Audio Streams with 
Different Packet Times, on page 437.

About the Routing Path of Audio Channels
If there are multiple devices on the topology that can perform audio shuffling, Audio Live 
will not necessarily always do the shuffle. For example, if the first device reached along the 
path (from destination to source) is a GV Node, then the GV Node may do the shuffle. It is 
GV Orbit Control that determines whether and when Audio Live is required for a given 
route. To know if an Audio Live or GV Node device is currently in use for a given route, use 
the Path Manager to see if there are tie-line connections to the Audio Live / GV Node 
device. See Path Manager Tasks, on page 450.

Prerequisites
Audio Live v1.5 or higher must be connected to the network, licensed, and has been 
previously configured with GV Orbit Client. 

Required Audio Live Configuration in the GV Orbit Client Control Panel

In the Audio Live User Guide, see the following topics that must be configured according to 
your needs.

1 In GV Orbit Client, set the size of Audio Live’s audio matrix (Maximum Supported 
Channel Count) and the number of channels per AES input and output streams. This 
setting is found under Audio Live > Setup> System Configuration > Input 
Configuration and Output Configuration.

2 Stop the Audio Live server in Agent Configuration; under Available Agents, select 
Audio Live and click Stop.
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3 Once the Status under Selected Agent becomes Stopped, click Start.
4 In GV Orbit Client, set the Channels parameter to the maximum number of channels 

available for each stream. This setting is found under Audio Live > Input> Source Flows 
> Channels. 

Set the number of channels to 
the maximum available in this 
dropdown. Note: the default 
Auto setting will not work.

For each available stream, you 
must...
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Setting the maximum number of channels is necessary as GV Orbit Control expects 
that all channels be available for it to use at any time.

5 Click Take.
6 In GV Orbit Client under Audio Live > Output> Dest Flows:

• Set the Channels parameter to the maximum number of channels available for 
each stream. This setting is found under Audio Live > Output> Dest Flows.

• Set the Packet Time parameter according to the number of channels configured 
for each stream. See table below. This setting is found under Audio Live > Output> 
Dest Flows.

7 Click Take.

AES Logical Levels that are used for IP Audio Streams

To support a GVOP device’s ability to support a range of audio channels per AES stream (for 
devices such as Audio Live; see GVOP Devices, on page 206), and on GVOP devices that 
support this feature, the following logical levels are used according to the number of 

Packet Time Maximum number of channels that the stream can carry 

125us up to 64 channels 

250us up to 32 channels 

500us up to 16 channels 

1ms up to 8 channels 

4 ms up to 2 channels 
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channels in the AES stream. See also Logical Level Editor Tasks, on page 190 and Setting the 
Logical Levels to be Displayed in the Multilevel Table, on page 247.

To see the number of audio channels a given logical level supports, see Editing a Logical 
Level, on page 195.

Required Configuration for Audio Streams with Different Packet Times

If for a given topology, all audio streams have the same packet time, then the automatically 
assigned levels to the output spigots will work. If the topology has audio streams with 
different packet times, you will have to configure the packet times on Audio Live’s output 
spigots. Currently GV Orbit Control is unaware of these settings in GV Orbit Client, so you 
must proceed as follows: duplicate the SDI audio level as many times as there are different 
packet times. To duplicate an SDI audio level, see Duplicating a Logical Level, on page 193.

For example, to accommodate a 1 microsecond audio packet time, you duplicate the SDI 
audio level with the -1 suffix. To accommodate a 250 microseconds audio packet time, you 
again duplicate the SDI audio level with the -250 suffix.

Logical Level Description

AES67-4 4 mono audio channels

AES67-8 8 mono audio channels

AES67-16 16 mono audio channels
This logical level is interchangeable with the SDI audio logical level.

AES67-32 32 mono audio channels

AES67-64 64 mono audio channels
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You also need to set the proper AES67 levels on the Audio Live output streams in GV Orbit 
Control. For example:

• If output spigot 1 has been configured with 16 channels at 250 microseconds, then the 
streams for output spigot 1 should be assigned the AES67-16-250 level.

• If the output spigot has been configured with 8 channels at 1 ms, then the streams for 
that spigot should be assigned the AES67-8-1 level. 

Configuring an Audio Live device in GV Orbit Control
To add an Audio Live device to a topology

1 Add the Audio Live device to the Topology: from the Device Library, Discovered, find 
an Audio Live device bubble that you want to control. See To add a Discovered Device 
to a Topology, on page 209. 

2 Click on the name of the device underneath the bubble to name the device or device 
group. See To name a device and set the number of devices in the group, on page 205.

Note: You will need to set the level on all output streams of the Audio Live 
configuration in GV Orbit Control if your topology uses more than one packet time 
value.
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3 On the topology, connect the Audio Live device to the network switches. See Methods 
to Link Devices in a Topology, on page 222.

By default, the Audio Live device is created according to the configuration defined in 
GV Orbit Client. The streams are assigned the appropriate AES67 levels, based on the 
number of channels. The Audio Live can be used as is, without a need to modify the 
device properties in the Property Editor, unless you need to modify the streams to use 
custom levels.

4 Select the Audio Live bubble and configure the Device Properties in the Property 
Editor. See Defining Device Properties, on page 229 for more information.
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See also Description of Common Device Properties, on page 332.

5 Create the sources and destinations. See Automatically Creating AES67 Audio Channels 
for Sources and Destinations, on page 447.

Parameter Description

Name (of device 
bubble)

The name of the Audio Live device set in GV Orbit Client. When two 
Audio Live devices have been configured to be redundant, the name 
comes from the pricloudmary device.

Name (found under 
Node)

The name of the individual Audio Live device set in GV Orbit Client. 

Nodes When two Audio Live devices have been configured to be redundant:
Node 1: The Audio Live that has been configured as Redundant - 
Primary in RollCall.
Node 2: The Audio Live that has been configured as Redundant - 
Secondary in RollCall.
See Audio Live Redundancy Support, on page 441.

Software The firmware version running on the Audio Live device.

Primary IP Address
Secondary IP Address

When two Audio Live devices have been configured to be redundant:
Primary IP Address: The IP Address of the Audio Live that has been 
configured as Redundant - Primary.
Secondary IP Address: The IP Address of the Audio Live that has 
been configured as Redundant - Secondary.
See Audio Live Redundancy Support, on page 441.

Connection to 
Controller 1

Connection to Controller 1 shows the connection status of the Audio 
Live device with the primary server of a server group. 
Connection to Controller 2 shows the connection status of the Audio 
Live device with the secondary server of a server group. See 
Configuring a Controller Group, on page 179.
unknown: The topology is inactive (see Activating a Topology, on 
page 235) or the Audio Live device does not have network 
connectivity to the GV Orbit Server(s).
offline: The Audio Live device does not have network connectivity to 
the GV Orbit Server(s).
online: The Audio Live device is connected to the GV Orbit Server(s).

Connection to 
controller 2

Primary spigot 
routing count

These paramters come from the Audio Live’s configuration made in 
RollCall.

Primary matrix 
routing count

Redundancy Mode Shows the Audio Live’s current configuration.
Independent: This Audio Live bubble represents a single Audio Live 
device.
Redundant: This Audio Live bubble represents a pair of Audio Live 
devices operating in a cluster for improved availability. See Audio Live 
Redundancy Support, on page 441.
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6 Test the configuration by making takes between a logical source and destination that 
use the AES67 audio levels. See Performing a Take in Router Control, on page 471.

Known Audio Live limitations
• When choosing an Audio Live spigot to use for the take, GV Orbit Control will only use 

an output spigot that has the same number of channels as the destination, and only 
use an input spigot that has the same number of channels as the source. If no such 
spigot is available, the take will fail. It will not try to use multiple spigots (for example, if 
the source/destination is 16 channels, it will not try to use 2 spigots, each with 8 
channels), and it will not try to use part of a spigot (for example, if the 
source/destination is 8 channels, it would not try to use the first 8 channels of a 16 
channel spigot).

• In the Audio Live configuration, the channel count of an Input Configuration and 
Output Configuration cannot be set to Auto as GV Orbit Control does not support this 
setting. See Required Audio Live Configuration in the GV Orbit Client Control Panel, on 
page 434.

• The number of channels on the input stream must match the number of channels on 
the source stream, and the number of channels on the output stream must match the 
number of channels on the destination stream. 

• For streams that have an AES67-X level, the logical source/destination that is 
automatically created is not usable. Instead, you must create custom logical sources 
and destinations, and place the streams in the SDI Audio or audio1 to audio16 level 
columns instead. See Required Configuration for Audio Streams with Different Packet 
Times, on page 437.

Audio Live Redundancy Support
Audio Live redundancy is supported in GV Orbit Control systems with Audio Live v1.5.3 
firmware version or higher. With this Audio Live firmware, each Audio Live unit can be 
configured as Independent, Redundant - Primary, or Redundant - Secondary. These 
configuration parameters are available through the RollCall Unit Redundancy page, for 
each unit. When two Audio Live units are configured as follows, the units form a cluster for 
increased availability: Audio Live 1 is configured as Redundant - Primary and Audio Live 2 is 
configured as Redundant - Secondary.
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Audio Live Network Connections
The Audio Live Primary and Secondary input and output ports from both units must be 
connected to RED and BLUE network switches and the corresponding spigots/streams 
must be properly configured.

For more information about network connections, refer to GV Orbit Server Cabling chapter 
of the GV Orbit Admin Guide. See Related Documentation, on page 19.

Redundancy on Audio Live was designed to prevent signal loss or signal glitching in case of 
a hardware failure of one of the two units. In order to achieve this, the Audio Live cluster is 
using, on the sender side, the primary port from the Primary unit as the cluster primary 
output, whereas the secondary port of the secondary unit is used as the cluster secondary 
output.

The secondary output from the primary unit and the primary output from the secondary 
unit are not used by the GV Orbit Control systems.

On the receiver side, input ports from both Primary and Secondary units are used and join 
the same flows; primary input from the primary unit and the primary input from the 
secondary unit, as well as the secondary input from the primary unit and the secondary 
input from the secondary unit. The input and output ports currently being used are 
displayed through the Path Manager. See Path Manager Tasks, on page 450.

Required Audio Live Configuration in RollCall
Access the Audio Lives units, one at a time through RollCall and configure them as follows 
in their Unit Redundancy page. For redundancy support, both Audio Live units must be 

Synchronization
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configured in redundancy mode, one unit as Redundant - Primary and the other one as 
Redundant - Secondary. 

Both units must be identically configured with respect to any parameter that can affect the 
output audio. This is done in each Audio Live’s RollCall configuration. This includes:

• Spigot routing (destinations and sources).

Parameter Description

Unit State Shows this unit’s state. 
-: Unknown status.
Initializing: Unit is in the process of connecting and synchronizing 
with the partnered unit.
Running: Unit has successfully paired with the partnered unit.

Partner State Shows the partnered unit’s state, when available.
-: Unknown status.
Running: Unit has successfully paired with this unit.

Redundancy Status Shows the status of the paired Audio Live units.
Matched: The two Audio Live units are operating with redundancy.
Error: Configuration or communication issue.

Unit assignment Set this unit’s role.
Independent: This unit is not associated with another Audio Live unit; 
there is no Audio Live redundancy currently enabled.
Redundant - Primary: This unit is the primary unit to be associated to 
another Audio Live unit (the secondary unit) for redundancy through 
the Partner IP Address parameter.
Redundant - Secondary: This unit is the secondary unit to be 
associated to another Audio Live unit (the primary unit) for 
redundancy through the Partner IP Address parameter.

Network interface Set the Ethernet interface on which this Audio Live is to communicate 
with the other Audio Live. With redundancy, this must be set on both 
units such that both Audio Live units have network connectivity with 
each other.

Partner IP Address With redundancy, set the IP Address of the other Audio Live device. If 
this is the primary unit, set the secondary unit’s IP address. If this is the 
secondary unit, set the primary unit’s IP address. 
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• Internal channel matrix routing.
• Input and output configurations. In GV Orbit Client, set the size of Audio Live’s audio 

matrix (Maximum Supported Channel Count) and the number of channels per AES 
input and output streams. This setting is found under Audio Live > Setup> System 
Configuration > Input Configuration and Output Configuration.

• Input and output delays.
• Timestamp alignment settings.
• Input 2110-31/AES3 selections.
• Input synchronizer selections.
• Output channel counts and packet times.

Once the Audio Live configuration is complete, both units are synchronized in order to 
exchange flow data in order to handle redundancy.

Redundant Audio Live Configuration in GV Orbit Control
It is important to have both units up-and-running while configuring the Audio Live cluster 
in GV Orbit Control. Once the Audio Live cluster configuration is completed, the cluster will 
be discovered in GV Orbit Control systems, as a GVOP discovered device. If there is any 
configuration issue between the two Audio Live units, causing the cluster to be in a bad 
state (not synchronizing properly), then the discovered entity will not be discovered under 
the GV Orbit Control system and if the device is already on the topology, its status will 
change to offline.

A new icon is used to distinguish between Audio Live units using v1.5.3 firmware and units 
using an older firmware, regardless of the redundancy mode (Independent or Redundant).

The name of the discovered cluster and its related spigots will be using the ones from the 
primary Audio Live unit.

Once the cluster is added to the topology, the cluster group device will be listing two nodes 
corresponding to the two Audio Live units. Each node will provide the Audio Live unit 
properties (Unit name, hostname, Control IP address, GUID. and so on) and also the specific 
unit ports and spigots. See Configuring an Audio Live device in GV Orbit Control, on 
page 438.

The cluster device group lists the ports and the spigots from those units; the primary port is 
the one from the primary unit where the secondary port is the one from the secondary unit.

Audio Live Icon Audio Live Firmware Version Description

v1.5.2 or lower Audio Live redundancy is unsupported.

v1.5.3 or higher Audio Live redundancy is supported.



445

GV Orbit Version 2.3.0 Special Device Configuration Tasks
User Guide Audio Live Redundancy Support

The cluster Redundancy mode property will reflect the current cluster status (Independent 
or Redundant).

The control port status (Online / Offline / Reconnecting) for the cluster is available on the 
cluster device group and also through the System Status page where the status for both 
units is also available. See System Status Task, on page 457.

Further notes:
• When replacing a failed unit, it's important to apply the same IP configuration to the 

new unit as was applied to the previous faulty unit, otherwise tally issues may occur.
• Independent Audio Live units from existing topologies, using an older Audio Live 

firmware, cannot be used for redundancy. Those units must be deleted from the 
topology, upgraded to v1.5.3 firmware (or higher), configured in a cluster mode and 
then they will be discovered by GV Orbit Control systems.

• No changes will be noticed if an independent Audio Live unit, using v1.5.3 Audio Live 
firmware (or higher) is added to the topology, except the new icon and the new unit 
Redundancy Mode, shown as Independent.

• Cisco DCNM host policies are only created for the streams corresponding to the ports 
that are actually used by GV Orbit Control systems.
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Configuring an IQAMD40 Device

About IQAMD40
The IQAMD40 provides multichannel MADI-to-IP interfacing, and has been developed to 
allow high-density audio integration into Ethernet IP networks. Using industry standard 
AES67 encapsulation and an IP interface enables the IQAMD40 to interface directly with 
many common audio desks and systems.

PREREQUISITES: IQAMD40 must be connected to the network, licensed, and has been 
previously configured with GV Orbit Client. 

IQAMD40 Integration in GV Orbit Control
GV Orbit Control supports the routing of audio signals through an IQAMD40 card.

To add an IQAMD device to a topology
1 Add the IQAMD device to the Topology: from the Device Library, Discovered, find an 

IQAMD device bubble that you want to control. See To add a Discovered Device to a 
Topology, on page 209. 
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2 On the topology, connect the IQAMD device to the network switches. See Methods to 
Link Devices in a Topology, on page 222.

Automatically Creating AES67 Audio Channels for Sources and Destinations
GV Orbit Control routes multiples of 16 audio channels by default. As a result, if you want to 
send 64 audio channels to a destination, you create four destinations with 16 audio 
channels each.

An automation shown in the procedure below allows you to add the all the Stream’s AES67 
audio channels to the Multilevel Table in the Logical Device Table at once for AES67 sources 
and destinations. 

To automatically create the AES67 audio channels for sources and destinations
1 In the Logical Device Table, Multilevel Table, select the Sources tab.
2 Select one or more streams in the Stream Browser (using <Ctrl> + click) for which you 

want to create all the source / destination audio channels.

3 Click  to show the Channel Browser in the Stream Browser of the Logical Device 
Table. See Stream Browser / Channel Browser, on page 242.

4 Click  to select all in the Channel Browser.
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5 Click  automated sources / destinations in the Channel Browser to create the 
selected streams in the multilevel Table.

The 64 audio streams are created as four sources / destinations with 16 audio channels 
each.

6 Select the Destinations tab and repeat from step 2.
7 Test the configuration by making takes between a logical source and destination that 

use AES67 levels. See Performing a Take in Router Control, on page 471.
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Overview
The Monitoring tasks in GV Orbit Control are used to view information about tie line use 
and the source to destination path of the streams and to monitor the health of the GV Orbit 
Servers and the devices in the selected topology.

The GV Orbit Control Monitoring Tasks include:
• Path Manager Tasks, on page 450
• System Status Task, on page 457
• Audio Live Usage, on page 463
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Path Manager Tasks
Use the Path Manager task to view information about the tie-line use and the source to 
destination path of the streams. Tie-lines also show the current percentage of bandwidth 
used.

When a topology includes a DCNM Network Switch, the Path Manager shows:
• Technical information that can be used to help diagnose network connectivity and 

path issues (no signal or wrong signal at the destination).
• The overall health status of each Network Switch device. 

Network Switch devices have a blue bubble that when clicked provides more information 
about the internal status of the DCNM Network Switch that is shown in the Status tab.

DCNM
Network
Switches

Click to view more DCNM 
Network Switch device 
detail

The DCNM Network 
Switch is currently offline

Percent of currently-used 
bandwidth
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Interpreting DCNM Network Switch Symbols
The following DCNM network switch symbols are used to represent the Network Switch 
device’s health.

For a system-level health status, see System Status Task, on page 457.

Accessing the Path Manager
To access the Path Manager Task

1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select the required Area. See Selecting an Area, on page 183.
3 Select the required topology. See Selecting a Graph, on page 184.
4 Make the topology active. See Activating a Topology, on page 235.

Symbol Description

The DCNM network switch device is healthy.

Connection to the DCNM network switch device is offline. 
To diagnose: Select this device and select the Status tab to view more technical 
information that can be used to troubleshoot the issue in the DCNM Web interface 
(by looking at the host policy / flow policy / flow status).



452

Monitoring Tasks GV Orbit Version 2.3.0
Accessing the Path Manager User Guide

5 Select Monitoring > Path Manager.

The Path Manager task opens:

Under Path Management, click any of the following tabs for more information:
• Tie-lines
• Streams
• Destinations
• Status

Path Manager Topology Menu
The Path Manager Topology menu has the following menu options.

Icon Description

 Refresh Reloads the Topology’s contents. See Refreshing the Topology, on 
page 202.

Overview Shows the top level of the topology.

 Refresh Tielines Allows you to recompute the tielines usage based on the current 
crosspoints in each device, in case the tieline status in the control 
system has become out-of-sync with what is actually routed.
During tieline refresh, all tielines are locked and you can not perform 
any takes. Only use this feature during off hours as this can take up to 
30 seconds to complete.
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Viewing Information about the Tie-lines
To view information about the tie-lines

1 Open the Path Manager for the selected topology. See Accessing the Path Manager, on 
page 451.

2 Click Overview  if available.
The tie-lines show their currently-used capacity in percent.

3 Select a tie line in the Topology.

In the Tie-lines tab, the source and destination information is displayed under the 
following headings:

• Tie line Name
• Tie line Source: Device, Port, Capacity (bps), BW (bps)
• Tie line Destination: Device, Port, Capacity (bps), BW (bps)
• Source
• Destination

Viewing Information about the Streams
To view information about the streams

1 Open the Path Manager for the selected topology. See Accessing the Path Manager, on 
page 451.

2 Click Overview  if available.
3 Select a tie line in the Topology.
4 Select the Streams tab.
5 In Tie-lines, select a tie-line that you want more information on its streams.
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The stream information is displayed under the following headings:
• Stream
• IP address
• BW (bps)
• Source
• Destination

Viewing Information about the Destinations
This tab shows the path for a signal to a destination. If a destination is showing the wrong 
signal, use this tab to trace the destination signal back to the source or to start fault-finding.

When a topology includes a GV Fabric / DCNM Network Switch, this tab shows operational 
status information about the path used by a signal to a destination through the GV Fabric / 
DCNM Network Switches, GV Node senders and receivers for example. When you select a 
Network Switch device that is in alarm, more information about the internal status of the 
GV Fabric / DCNM Network Switch is shown in the Status tab.

To view information about the destinations
1 Open the Path Manager for the selected topology. See Accessing the Path Manager, on 

page 451.
2 Select the Destinations tab.

All the destinations are listed on the right.
3 Select a destination. The path details to that destination are shown. 

If the topology includes a DCNM Network Switch, the path details will include the spine 
and leaf connections within the DCNM network. This can be used to diagnose issues 
with the DCNM network switch or any other signal path issue. For example, the figure 
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below shows that the RED network is in alarm and as such no signal is passing through 
this part of the switch’s fabric. 

To know more about the DCNM Network switch symbols that are used for health 
monitoring, see Interpreting DCNM Network Switch Symbols, on page 451

4 If a DCNM network switch is in alarm, select it and more specific diagnostic information 
for the related flow shown under the Path Management, Status tab. 

Use this information to diagnose path issues, for example, through the switch’s or 
GV Node’s native configuration interface.

5 Click Overview  to view a highlighted path between the source, shown in green, 
and the destination, shown in brown.

Viewing Information about the Status
When a topology includes a DCNM Network Switch, this tab shows more technical 
information about the DCNM Network Switches such as the Network Switch device’s 
operational status that can be used to diagnose the issue in the path issue, for example, 
through the switch’s or GV Node’s native configuration interface.

To view information about the status
1 Open the Path Manager for the selected topology. See Accessing the Path Manager, on 

page 451.
2 Select the Status tab.
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The flow status of the DCNM Network Switches are displayed, if applicable.

Network Switch devices have a link  that when clicked shows the exploded network 
switch showing more information about spine and leaves, and the bandwidth capacity 
for each specific link.

Click each switch to see its health of the switch (as report by the switch itself ). 
Disabled Ports shows a list of all the switch’s disconnected or unused ports that are 
currently disabled by the switch.

DCNM
Network
Switches

Click to view more DCNM 
Network Switch device 
detail

The DCNM Network 
Switch is currently offline

Percent of currently-used 
bandwidth
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System Status Task
Use the System Status Task to monitor the health of the GV Orbit Servers and the devices in 
the selected topology. You can also perform a manual failover from this task.

Accessing the System Status Task
To access the System Status Task

1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select the required Area. See Selecting an Area, on page 183.
3 Select the required topology. See Selecting a Graph, on page 184.
4 Select Monitoring > System Status.

The System Status task opens:

In this configuration, Controller 1 is the active controller and Controller 2 is not present. 
The System Status task displays the following information for both GV Orbit Control 
controllers: Controller 1 and Controller 2. Depending on the server hardware model 
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and the software applications that are currently installed, certain status parameters 
shown in the table below will not be displayed.

Parameter Description

IP The current controller’s IP address.

Status The current status of GV Orbit Control Controller 1 and Controller 2 (if 
equipped): 
Active: All GV Orbit Control task are being processed by this controller.
Inactive: This controller is in hot standby. It is ready to take over from the 
active controller.
Force Active: Make this controller the active controller. See Forcing the 
Inactive Controller to be the Active Controller, on page 459.

Health The current controller’s health metric: 
Green bar: Indicates that the controller’s overall health is good.
Red Bar: Indicates an issue requires attention / maintenance actions.

ID Identifies the members of a cluster:
1: The server that the administrator logged in to when creating the cluster. 
This is the first server of the cluster.
2: The second server that was added by an administrator who was logged 
in to the first server when creating the cluster. 

CPU and Memory The current GV Orbit Server’s CPU and memory usage show the current 
level of activity.

Orbit Control 
Memory

The current GV Orbit Server’s memory usage for the local GV Orbit 
applications.

Densité Memory The current GV Orbit Server’s memory usage for the local Densité 
application. The percentage reflects the memory used out of its allocated 
heap size of 8 GB.

Fans The current controller’s cooling fan health: 
A green box indicates that the controller’s fans are operating correctly.

PSU Green: the PSU is plugged and detects power.
Red: the PSU doesn't detect power. Possibly the power cable is unplugged.
Gray or no status: the server doesn't detect correctly the PSU unit because 
the unit is physically removed or the initialization isn’t done. In this second 
case, shutdown the server, disconnect both power cables, physically 
remove both power supply units, re-insert them both and apply power to 
both. Then start the server.

Network Interface The current controller’s Ethernet interface names and health: 
A green box indicates that the controller’s Ethernet interfaces are 
operating correctly.

Panels 
Communications 
Status

Shows the network connection status between the GV Orbit Server and 
the panel that have been configured in GV Orbit Control.
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For more information about the health status of a DCNM Network Switch device, see Path 
Manager Tasks, on page 450.

Forcing the Inactive Controller to be the Active Controller
If two controllers are configured in a redundant configuration, then during the normal 
course of operations, one controller is active and the other is inactive at all times. 

If a problem occurs, such as network loss or connectivity issues, the inactive controller 
(Controller 2) becomes the active controller. The controller that was formerly active 
(Controller 1) reboots. This is an automatic failover. You can perform a manual failover if you 
have administrator rights in the selected Area. See Viewing Permissions by Role, on 
page 484.

To perform a manual failover
1 Open the System Status task for the required topology. See Accessing the System 

Status Task, on page 457.

2 Click the Force Active button for the Inactive Controller.

Devices The current status of the devices: 
Active: This device is in active operation.
Standby: This device is in hot standby. It is ready to take over from the 
active device.
Primary / Secondary: When a cluster of Audio Live devices are configured 
for redundancy, this shows the IP addresses and the health of those 
devices. See also Audio Live Redundancy Support, on page 441.

Faults A list of any current faults.

Parameter Description
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A confirmation message appears.

3 Click OK to continue.
The controllers switch states. The formerly inactive controller (Controller 2) becomes 
active. The formerly active controller (Controller 1) reboots. As it shuts down, the 
following changes occur and are reflected on the System Status task.

• The Status of the Controller 1 is now Inactive.
• A red bar is displayed for the Health of Controller 1, indicating it is not good.
• The CPU and Memory are at 0%.
• The Fans and Network Interface are blank.
• The Status of the Controller 2 is now Active.
• A green bar is displayed for the Health of Controller 2, indicating it is good.
• The CPU and Memory fields show their level of activity.
• The Fans are green, indicating health.
• The Network Interface displays the Management Interface port name (em1).
• The status of all devices controlled by Controller 1 is unknown.
• The status of all devices controlled by Controller 2 is active.
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When Controller 1 comes back, the following changes occur and are reflected in the 
interface.

• The status of Controller 1 is now Inactive.
• The health field for Controller 1 displays a green bar indicating it is good.
• The CPU and Memory fields for both controllers show the current level of activity.
• The fans for both controllers show green boxes indicating health.
• The Network Interface port of both controllers is displayed, em1.
• The status of the devices on Controller 1 is unknown.
• The status of the devices on Controller 2 is active.

Finally, when Controller 1 is fully rebooted, the following changes occur:
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• The status of the devices on Controller 1 is standby.

Permissions
Only users who are assigned to Administrators role in the selected area have View, Edit, and 
Delete permissions in the System Status task. Users who are assigned to Engineers, 
Operators, and Maintenance roles have view rights only. See Viewing Permissions by Role, 
on page 484.
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Audio Live Usage
Use the Audio Live Usage Task to have more information about the loading and use of an 
Audio Live’s capacity. This is a debugging tool to help you to better understand what the 
Audio Live’s routing capacity. 

PREREQUISITES: One of more Audio Live devices must have been configured on the 
current topology. See Configuring an IQAMD40 Device, on page 446.

Accessing the Audio Live Usage Task
To access the Audio Live Usage Task

1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select the required Area. See Selecting an Area, on page 183.
3 Select the required topology. See Selecting a Graph, on page 184.
4 In the Topology Configurator, activate the topology. See Activating a Topology, on 

page 235.
5 Select Monitoring > System Status.

The Audio Live Usage task opens:

All table columns can be filtered. See Filtering Lists, Table Columns, Sources, and Destinations, 
on page 266.

Icon Description

 Refresh Reloads the Audio Live Usage task contents. If you make a Take for 
audio streams through an Audio Live device, then you must click 
Refresh to see the results.

Audio Live Name The device name configured for the Audio Live device, in the device’s 
properties.

64ch Input Usage The number of AES67-64 input levels currently being used out of 
the available number of AES67-64 input levels, expressed as a 
fraction.

16ch Input Usage The number of AES67-16 input levels currently being used out of 
the available number of AES67-16 input levels, expressed as a 
fraction.

8ch Input Usage The number of AES67-8 input levels currently being used out of the 
available number of AES67-8 input levels, expressed as a fraction.

4ch Input Usage The number of AES67-4 input levels currently being used out of the 
available number of AES67-4 input levels, expressed as a fraction.
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6 Select an Audio Live device from the list. Detailed spigot information is shown under 
Spigot Information. 

Columns in the Spigot Information table can be multi-sorted, the same way the Stream 
Configurator List can be sorted. See Sorting the Stream Configurator List, on page 326.

64ch Output Usage The number of AES67-64 output levels currently being used out of 
the available number of AES67-64 output levels, expressed as a 
fraction.

16ch Output Usage The number of AES67-16 output levels currently being used out of 
the available number of AES67-16 output levels, expressed as a 
fraction.

8ch Output Usage The number of AES67-8 output levels currently being used out of 
the available number of AES67-8 output levels, expressed as a 
fraction.

4ch Output Usage The number of AES67-4 output levels currently being used out of 
the available number of AES67-4 output levels, expressed as a 
fraction.

Icon Description

Spigot Name The name configured for this spigot, in the device’s properties.

Channel Capacity The number of AES-67 channels supported by the spigot.

Direction Shows the signal direction for this spigot.
Input: The spigot is a destination from another device.
Output: The spigot is a source to another device.

Tieline Status Shows this spigot’s current connection status.
Free: There is no device connection for this spigot.
Busy: The tieline is connected to another device.
Exposed: Indicates that the spigot’s stream is exposed.

Multicast IP Shows the current multicast IP address that is joined to this spigot.
For an Input, this is the source multicast IP address that the Audio 
Live is connected to. 
For an Output, this is the Audio Live source multicast IP address 
that a destination device connects to.

Sources Shows the current name of the source(s) connected to the input.

Destinations Shows the current name of the destination(s) connected to the 
output.

Icon Description
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Overview

The GV Orbit Control Tasks include:
• Alias Editor Tasks, on page 466GV Orbit Client
• Router Control Tasks, on page 470
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Alias Editor Tasks
Use the Alias Editor to assign aliases to sources and destinations. More than one set of 
aliases can be created to allow the source / destination naming conventions to be changed 
on the fly, for example, to change the interface for different programs or production staff, or 
to support another language(s). 

Accessing Alias Editor Tasks
To access the Alias Editor

1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select the required Area. See Selecting an Area, on page 183.
3 Select the required topology. See Selecting a Graph, on page 184.
4 Select Control > Alias Editor.

The Alias Editor task opens.

The Alias Editor has tabs for Source and Destination IDs. 

Alias Editor Menu
The Alias Editor menu has the following menu options.

Icon Description

 Refresh Reloads the Alias Editor’s contents. 

 Cut Cuts the selected contents from an alias column.

 Copy Copies the selected contents from an alias column.

 Paste Pastes the clipboard contents to the alias column.
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About External IDs and Northbound Control Interfaces
External IDs are shown by setting Show External ID Columns. External IDs are used for 
Northbound control interfaces that use ID-based protocols. 

Certain control protocols require that the numbering of external IDs must be contiguous. In 
this case, if they are not sequential, click Re-Index Ext. IDs. In order to protect against an 
erroneous click, a captcha-style dialog requires that you confirm this action which can have 
a large impact on router tables.

GV Orbit Client can use the GV Orbit Control External ID's when Show External IDs is set to 
True; see Step 7.3.1: Project Variables (Project -> Edit Variables), on page 70. If Show External 
IDs is set to False, and you click Re-Index Ext. IDs, then you will need to make sure that any 
external system that relies on this updated index will still have the correct associations for 
their external IDs, including GV Orbit Client. 

External IDs that are larger than the total number of sources or destinations will not status 
northbound.

GV Orbit Control must have status for all destinations within GV Orbit Control or they will 
not report northbound for that external ID. For example, if a take has never been made to a 
destination, that destination will not have its status set. This behavior is different from a 
physical router where all destinations have a status set by default.

Adding Aliases
These aliases can be used in router control to change the name of sources and destinations 
from short labels to the labels of the corresponding alias. The alias can be composed of up 
to 24 characters to create a more descriptive name than its equivalent short label. Aliases 
can also be used with panels; see Creating a New Panel, on page 277. See also Using Source 
and Destination Aliases with a Panel, on page 291.

Once an alias column has been added, you can also copy/paste a list of values from an 
Microsoft Excel spreadsheet column into the alias column to bulk name the sources and 
destinations.

Aliases created here can be selected in GV Orbit Control’s user interface where sources and 
destinations are used with the Select Alias option. For example, in the Category 
Configurator; see Category Configurator Tasks, on page 268.

To Add Aliases
1 Open the Alias Editor. See Accessing Alias Editor Tasks, on page 466.

The Alias Editor task opens.

 Restore default 
label

When a selected alias has been renamed, this resets the name to its 
original label.

 New Adds an alias column. See Adding Aliases, on page 467.

 Delete Removes the selected alias column. 

Icon Description
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The Alias Editor has tabs for Source and Destination IDs. 
2 Select Show External ID Columns columns if necessary. 

The aliases are now available to be used with router control and panels. If aliases are used 
with a panel and they are longer than 8 characters, consider setting the Display 24 
characters option for the panel in the Panel’s Property Editor. See Creating a New Panel, on 
page 277. The alias to be used in the Category Configurator can be selected; see Sources & 
Destinations Menu, on page 269.

Renaming Source and Destination Labels
Source and destination labels can be renamed. You can also copy/paste a list of values from 
an Microsoft Excel spreadsheet column into the Name or Alias columns to bulk rename the 
sources and destinations. Or you can copy the content of one column and paste it into 
another column.

To rename Source and Destination Labels
1 Open the Alias Editor. See Accessing Alias Editor Tasks, on page 466.

The Alias Editor task opens.
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The Alias Editor has tabs for Source and Destination IDs. 
2 Rename the source or destination by slow clicking it twice. Or paste a list of names from 

an Microsoft Excel spreadsheet column into the Name or Alias column to bulk rename 
them. 
Source and Destination labels in the Alias Editor may be shown as grayed out and they 
cannot be edited. These devices’ configuration properties come from GV Orbit Client. 
See Synchronization of Discovered GVOP Devices, Source, Destination, and Spigot 
Names made in GV Orbit Client, on page 211.
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Router Control Tasks
Use the Router Control task to control the sources and destination in an active topology. 

Accessing the Router Control Task
To access the Router Control task

1 Open GV Orbit Control Stage. See Navigating Back to Stage, on page 170.
2 Select the required Area. See Selecting an Area, on page 183.
3 Select the required topology. See Selecting a Graph, on page 184.
4 Select Control > Router Control.

The Router Control task opens

The sources are listed on the left under Logical Router. The destinations are listed in the 
center. The right hand column displays the actions you can perform.

Router Control Menu
The Router Control menu has the following menu options.

Icon Description

 Select All Selects all source or destination items. 

 Clear All Deselects all source or destination items. 

 Sort Ascending Sort the source or destination items in alphabetical order from A to Z.
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Performing a Take in Router Control
You can perform a take in Router Control as follows.

1 Under Logical Router, select a source, shown in green.
2 Select a destination, shown in brown.
3 Under Router Control, Control tab, click Take.

 Sort Descending Sort the source or destination items in alphabetical order from Z to A.

 Use Wide Widgets Doubles the source or destination display width to accommodate 
longer labels.
This option setting is remembered for the currently logged in user on 
the current client PC.

 Select Alias Select the Alias you want to use to identify Source and Destination 
streams in GV Orbit Control’s interface. 

Aliases are created in the Alias Editor. See Adding Aliases, on page 467.

Icon Description
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About Lock, Protect, and Release
The following topics provide a detailed look at how GV Orbit Control manages Lock, 
Protect, and Release.

LIMITATIONS:
• iControl matrices do not support protect.

Parameter Description

Take / Auto-Take / 
Salvos radio buttons

Sets the router control mode:
• Take: Once the source and destination has been selected, you then 

click Take to make the take.
• Auto-Take: Once the source and destination has been selected, the 

take is automatically made.
• Salvos: Trigger previously-configured salvos. See also Creating 

Salvos, on page 474.

Take button Makes the connection between the currently selected source and 
destination. In salvo mode, it triggers the selected salvo. 

Cancel button Cancels the current selection.

Lock button Will lock the current destination to not allow the source to be changed 
by any user. High Tally when enabled on selected destination. See also 
About Lock, Protect, and Release, on page 472.

Protect button Will protect the current destination to not allow the source to be 
changed by a user other than the current user. High Tally when 
enabled on selected destination. 

Release button Releases lock or protect on the selected destination.

Virtual XPT > 
Minimize Virtual XPTa

a. This becomes available when virtual XPTs have been previously configured (see Configuring Virtual 
Crosspoints (XPTs), on page 257). You must select a destination that is part of a virtual destination in 
the router control grid or select a virtual destination in the router control grid.

To minimize the destinations within the selected virtual XPTb. 

b.See Minimize and Expand Virtual XPT Destinations, on page 264 for more information.

Virtual XPT > Expand 
Virtual XPTa

To show all the destinations within the selected virtual XPT, including 
the nested destinations of all other virtual XPTsb.

Virtual XPT > Reset 
XPTa

Initialize the selected virtual XPT. This will route the appropriate virtual 
source to the logical destinations that were configured for the virtual 
XPT in the logical device table. 
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• Lock and protect currently affects all levels of the destination and does not consider 
individual levels. Locking one level locks all destination levels and the control system 
does not currently support specific lock levels.

Ability to Override a Lock or Protect according to User Rights

When logged in to GV Orbit Control, the permissions assigned to your user profile 
determine whether you can override a Lock or Protect made by other users. For example, 
when a user has admin or Operator rights, the user can override any lock or protection made 
by:

• Any other user. See Viewing Permissions by Role, on page 484.
• A third-party control system that uses NP0017 to control GV Orbit Control.
• A third-party control system that placed a lock on a device which is also controlled by 

GV Orbit Control and for which in router lock and protect is enabled. See About In router 
Lock/Protect enabled for a Router using NP0016 router control protocol, on page 429.

• A panel used to set a lock.

Otherwise, without admin or Operator rights, you will not be able to override a Lock or 
Protect set by other users.

See Administration Tasks, on page 477 for more information about how to create users and 
how to set a user’s permissions to allow or deny them from overriding a Lock or Protect set 
by another user. The following user permissions control the ability to override a Lock or 
Protect.

• Force Unlock
• Force Unprotect

For example, the admin user has the user permissions for both Force Unlock and Force 
Unprotect. Therefore, an admin user can override any other user who has set a Lock or 
Protect on a destination. 

Using a Panel to Override a Lock or Protect

If a configured panel in GV Orbit Control is used, a user must be assigned to it. Assign a user 
to a panel through the Panel User parameter (see Adding the New Panel to the Topology, 
on page 299). It is the user rights that are associated to the user selected in the Panel User 
parameter that determines the panel’s priority to override a lock or protect made by 
another panel user. This can be used to prevent other users from being able to remove a 
lock. When the Panel User parameter is set to a user that has admin or Operator rights, the 
panel can be used to override any lock or protection made by:

• Any other user. See Viewing Permissions by Role, on page 484.
• A third-party control system that uses NP0017 to control GV Orbit Control.
• A third-party control system that placed a lock on a device which is also controlled by 

GV Orbit Control and for which in router lock and protect is enabled. See About In router 
Lock/Protect enabled for a Router using NP0016 router control protocol, on page 429.

• Another panel used to set a lock.
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Identifying the User who has Locked a Destination

To see who has locked a destination, try to make a take to the destination in the Router 
Control task. See Router Control Tasks, on page 470. The user locking / protecting the 
destination is then shown in the lower left corner. If the user is admin, then this could be the 
result of a third-party control system having locked or protected a destination in the router. 

How is Lock, Protect, and Release Implemented?

The router protocol and the GV Orbit Control’s router control port configuration can affect 
how the Lock, Protect, and Release are implemented. For a further explanation, refer to the 
router protocol you are using. 

Lock, Protect, and Release with the NP0016 / NS-Bus / SAM SW-P-08 Control Ports

GV Orbit Control stores the locks in its database and they are preserved after a 
restart/reboot. As such, destinations will remain locked/protected. GV Orbit Control system 
does not read a lock from a router and does not control a lock in the router. 

Creating Salvos
When a salvo is triggered, it executes a list of pre-configured actions. You can create a salvo 
as follows.

1 Under Router Control, Salvo Editor tab, click New .
2 Enter a name and description for the salvo in the Salvos list.

Router Control Protocol See

NP0016 Compact Router About In router Lock/Protect enabled for a Router using NP0016 
router control protocol, on page 429NP0016 Enterprise Router

NV9000 TCP/IP (NP0017 
southbound)

Lock, Protect, and Release with the NV9000 Control Port, on 
page 431

NP0016 Enterprise Router Lock, Protect, and Release with the NP0016 / NS-Bus / SAM SW-P-
08 Control Ports, on page 474NS-BUS

SAM SW-P-08 TCP/IP
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Icon Description

 New Create a new salvo and associated salvo action list.

 Duplicate Make a copy of the currently-selected salvo.

 Delete Remove the currently-selected salvo / take.

 Take Add the currently-selected source and destination as a take action to 
the salvo list. The following functional behaviors are by design:

• If multiple destinations are selected, then there will be 
multiple take actions added to the salvo list. 

• If there is only one source and multiple destinations selected, 
then that source is routed to all destinations. 

• If multiple sources are selected (for example, Source1, Source2, 
Source3) and multiple destinations are selected (for example, 
Destination1, Destination2, Destination3, and Destination4), 
then the takes added to the salvo list are Source1 to 
Destination1, Source2 to Destination2, Source3 to 
Destination3.

 Lock Lock the currently selected destination. See also About Lock, Protect, 
and Release, on page 472.

 Protect Protect the currently selected destination.

 Release Release the currently selected destination.

 Pause The wait time in milliseconds that can be added to the list of 
operations.

 Append In this mode, any new salvo operation will be added to the end of the 
salvo action list.

 Insert In this mode, any new salvo operation will be inserted at the currently 
selected spot in the salvo action list.

Salvo Action
List

Salvos
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3 Under Logical Router, select a source, shown in green.
4 Select a destination, shown in brown.
5 Under the salvo action list, click Take.

Selecting the Name of Sources and Destinations
When a source or destination has been assigned an alias, you can select the alias to be 
shown through the Alias drop-down menu. To create aliases, see Alias Editor Tasks, on 
page 466. 

1 Select a source or destination under Logical Router.
2 Click the alias drop-down menu and select an alias option.

The label for the selected source or destination changes to the selected option.

 Replace In this mode, any new salvo operation will replace the currently-
selected salvo action from the salvo action list.

 Move Up Move the selected salvo action up in the salvo action list.

 Move Down Move the selected salvo action down in the salvo action list.

Icon Description
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User Management is the only Administration task. Only administrators have access to it.

User Management Task
As an administrator, you have access to the User Management Task. This is used for:

• Creating, editing, and deleting user profiles. See Creating User Profiles, on page 479.
• Managing access rights to the areas in your system. See Granting Access Permissions to 

an Area, on page 481.
• Viewing and assigning permissions according to predefined user roles. See Viewing 

Permissions by Role, on page 484.
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The User Management Task Overview

When you first log in to the User Management Task, the admin tile appears in the Users 
section.

The User Management Task UI has four columns:
• Users: The column displays a tile for each user who has access to your system. See 

Creating User Profiles, on page 479.
• Areas: The column displays a tile for each area defined in your system. See Granting 

Access Permissions to an Area, on page 481.
• Roles: The column displays a tile for each of the predefined roles: Administrator, 

Engineer, Operator, Maintenance, and Guest. 
Permissions to view, edit, and delete within each client task vary by role. These 
permissions can be seen when you select the role in the Roles column; for example, 
Administrator is selected in the screen shot above. The permissions granted to the 
administrator role are shown in the Permissions column. (Members of the administrator 
role have full access permissions to all areas in the system). See Viewing Permissions by 
Role, on page 484 for a list of the permissions available to each role.

• Permissions: The column displays a tile for the tasks that users can perform within the 
areas in your system according to the selected User, Area, and Role. View, edit and 
delete icons show the current user’s rights for the task.

Note: Before you assign access permissions, you must create areas in your system. 
For details, see Area Configurator Tasks, on page 177.
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Creating User Profiles
The first step is to create your user profiles.

To create a new user account:
1 Launch GV Orbit Control.
2 Log in as an administrator.
3 Select Administration > User Management.

The User Management window appears.

4 Click the Add button  in the top left corner.
The user configuration window appears.

5 Enter the required information in the User ID, First Name, Last Name, Password, and 
Confirm Password fields.

6 If this user is to represent an external northbound routing device for Lock, Protect, and 
Release with the NP0016 / NP0017 router control protocol, set the External ID that this 

Note: To access the user profiles, you must belong to the administrator role. 
Otherwise, Administration tasks are not visible in GV Orbit Control Stage.
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device uses in its NP0017 router protocol communications with GV Orbit Control. This 
value is an unsigned integer. See Setting a User ID for Lock, Protect, and Release with 
NDAC NP0016 / NP0017 Northbound Interfaces, on page 487 for more information.

In all cases, you must ensure that user IDs are coherent between GV Orbit Client and 
GV Orbit Control. 

See How to Add a User, on page 159 for how to set these parameters in GV Orbit Client.
7 Click OK.

A new tile representing the new user account appears in the Users section.

In addition, you can perform the following procedures in the Users section:
• Edit: Select the icon for the user and click Edit to modify the user’s credentials.
• Delete: Select the icon for the user and click Delete to remove the user account. There is 

no confirmation when you click Delete. The user profile is immediately removed.

See also
• Switching User Profiles, on page 171

Note: User databases are not synchronized between the GV Orbit Client 
and GV Orbit Control. You must assign the same ID to the same user 
in both the GV Orbit Client and GV Orbit Control. 

Equivalent Parameter in GV Orbit Client Equivalent Parameter in GV Orbit Control

User name User ID

Control External Id External Id
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Granting Access Permissions to an Area
Users are granted access to each area via a predefined role. The procedure is as follows:

To grant access to an area
1 Launch GV Orbit Control.
2 Log in as an administrator.
3 Select Administration > User Management.

The User Management task appears.

The Users column displays tiles for all the users who have access to the system.
4 Select the applicable user tile in the Users section.

The Areas column displays tiles for all the areas defined in your system.
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5 Select an area tile in the Areas section while keeping the user tile selected.
The Roles column displays tiles for all the roles when both the user tile and the area tile 
are selected, at the same time.

6 Select a role tile and drag it on top of the area tile.

This action gives the user all the permissions defined for the role in the selected area.
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When you select the user tile in the Users section, the user’s role in the area is displayed 
at the bottom right of the Area tile.

The permissions granted to the selected role; for example, view, edit, delete, are 
displayed on the Permissions tile in the Permissions column. 

These are listed in the next section.
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Viewing Permissions by Role
Users are granted access to the areas in the system via their assigned roles. The following 
rules apply:

• Users can be assigned to different roles in different areas. 
• Users cannot be granted permissions as individuals, only according to role.
• The roles are predefined, as follows: Administrator, Engineer, Operator, Maintenance, 

and Guest. The roles cannot be modified.
• Administrators have full access to all tasks in all areas. Guests have the least 

permissions. The Engineer, Operator, and Maintenance roles have various permissions, 
as listed in the following table:

The permissions granted to each role can be viewed on the tiles in the Permissions list book 
of the User Management task. These can be viewed when the user, the area, and the role 
are all selected at the same time.

Task Role Permissions

Area configurator Administrator View, Edit, Delete

Engineer No access

Operator No access

Maintenance No access

Guest No access

Logical Level Editor Administrator View, Edit, Delete

Engineer View, Edit, Delete

Operator No access

Maintenance No access

Guest No access

Topology Configurator Administrator View, Edit, Delete

Engineer View, Edit, Delete

Operator View

Maintenance No access

Guest No access

Category Configurator Administrator View, Edit, Delete

Engineer View, Edit, Delete

Operator No access

Maintenance No access

Guest No access
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Logical Device Table Administrator View, Edit, Delete

Engineer View, Edit, Delete

Operator No access

Maintenance No access

Guest No access

Panel Configurator Administrator View, Edit, Delete

Engineer View, Edit, Delete

Operator No access

Maintenance No access

Guest No access

User Management Administrator View, Edit, Delete

Engineer No access

Operator No access

Maintenance No access

Guest No access

Path Manager Administrator View

Engineer View

Operator View

Maintenance No access

Guest No access

System Status Administrator View, Edit, Delete

Engineer View

Operator View

Maintenance View

Guest No access

Alias Editor Administrator View, Edit, Delete

Engineer View, Edit, Delete

Operator View, Edit, Delete

Maintenance No access

Guest No access

Router Control Administrator View, Edit, Delete

Engineer View, Edit, Delete

Operator View

Maintenance No access

Guest No access

Task Role Permissions
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Maintenance & Deployment Administrator View, Edit, Delete

Engineer No access

Operator No access

Maintenance View

Guest No access

Router Force Unlock

See also About Lock, Protect, 
and Release, on page 472 and 
Setting a User ID for Lock, 
Protect, and Release with 
NDAC NP0016 / NP0017 
Northbound Interfaces, on 
page 487. 

Administrator View, Edit, Delete

Engineer No access

Operator View, Edit, Delete

Maintenance No access

Guest No access

Router Force Unprotect

See also About Lock, Protect, 
and Release, on page 472 and 
Setting a User ID for Lock, 
Protect, and Release with 
NDAC NP0016 / NP0017 
Northbound Interfaces, on 
page 487.

Administrator View, Edit, Delete

Engineer No access

Operator View, Edit, Delete

Maintenance No access

Guest No access

External ID Administrator View, Edit, Delete

Engineer View, Edit, Delete

Operator No access

Maintenance No access

Guest No access

Task Role Permissions
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Setting a User ID for Lock, Protect, and Release with NDAC NP0016 
/ NP0017 Northbound Interfaces

With the NP0016 and NP0017 router control protocols, Lock/Protect commands require a 
User ID. So that users with different User IDs cannot release a destination locked by another 
user or panel user; in GV Orbit Control and GV Orbit Client, each user can be assigned a 
different External ID / Control External Id parameter value. Users with a different External 
ID / Control External Id cannot release a destination locked by another user with a different 
External ID / Control External Id, unless they have admin or Operator rights. 

The NP0016 and NP0017 router control protocol User ID should be set in:
• GV Orbit Control: as of GV Orbit version 1.7.0 and above, the User ID provided in 

northbound commands is taken into account as follows: 
• You map this User ID to the External Id parameter of a GV Orbit Control user set in 

User Management. 
• If this GV Orbit Control user has its External Id parameter value configured to the 

same value as the User ID in a command, the operation will be performed internally 
using the alias of the matching user with the user’s associated privileges with 
respect to Lock, Protect, and Release.

• If this GV Orbit Control user does not have admin or Operator rights, the third-party 
control system that uses NP0016 / NP0017 to control GV Orbit Control cannot 
override the lock or Protect set by other GV Orbit Control users. See Viewing 
Permissions by Role, on page 484.. 

• If no GV Orbit Control user has an External Id parameter value matching the 
command's user ID, the operation is performed internally as the GV Orbit Control 
admin user. 

• GV Orbit Client: as of GV Orbit version 2.0.0 and above, the User ID provided in 
northbound commands from the GV Orbit Control Routing service is taken into account 
as follows: 

• You map this User ID to the Control External Id parameter of a GV Orbit Client user 
set in the User tab. 

• This user then issues NP0017 router control protocol communications with the 
User ID from the user’s Control External Id value. 

• The admin user or a user with an Control External Id set to 0 can override locks set 
by any other user.

The User ID / External ID / Control External Id parameter is an unsigned integer. 

To create a User to represent external northbound routing device in GV Orbit Control

Proceed as follows.
1 In GV Orbit Control, create a new user to represent the third-party control system. See 

Creating User Profiles, on page 479. 

Note: User databases are not synchronized between the GV Orbit Client 
and GV Orbit Control. You must assign the same ID to the same user 
in both the GV Orbit Client and GV Orbit Control separately. 



488

Administration Tasks GV Orbit Version 2.3.0
Setting a User ID for Lock, Protect, and Release with NDAC NP0016 / NP0017 Northbound Interfaces User Guide

2 In GV Orbit Control, set the External Id parameter to that of the user ID used by the 
third-party control system in its NP0016 / NP0017 router control protocol. 

3 In GV Orbit Control, assign the privileges to this new user. See Granting Access 
Permissions to an Area, on page 481:

• Assign Engineer or Maintenance rights to this new user to prevent the third-party 
control system from overriding the lock or Protect set by other GV Orbit Control 
users.

• Assign admin or Operator rights to this new user to allow the third-party control 
system to override the lock or Protect set by other GV Orbit Control users.

If the third-party control system’s NP0016 / NP0017 router control protocol, 
Lock/Protect commands use a user ID that GV Orbit Control cannot match to the 
External Id value of any GV Orbit Control user, the Lock/Protect commands will be 
carried out as an Admin user (which has the Router Force Unlock and Router Force 
Unprotect privileges), thereby allowing the external control system to overrride the 
locks of other GV Orbit Control users.
See also About Lock, Protect, and Release, on page 472 to better understand how Lock, 
Protect, and Release works with other users and other GV Orbit Control components 
such as panels.
GV Orbit Control stores the locks in its database and they are preserved after a 
restart/reboot. As such, destinations will remain locked/protected. GV Orbit Control 
system does not read a lock from a router and does not control a lock in the router. 

4 In GV Orbit Client, create a new user to represent the same user name you created in 
GV Orbit Control above. See How to Add a User, on page 159. 

5 In GV Orbit Client, set the Control External Id parameter to the same User ID value you 
set above in the External Id parameter above. 
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The Channel Manager abstracts physical cards to make their processing channels available 
without having to know where the card is physically located in the system. 

You can logically associate one or more processing channels by assigning them to a group. 
A group can represent the Channels used for ingest for example.

You can set and save card processing channel configuration parameters, and apply saved 
settings to other channels that may be on other cards of the same type. 

PREREQUISITES:
• The Channel Manager is available by default in projects created in GV Orbit Control 

version 2.2.0 and above. To add it to projects created before this, see Adding Channel 
Manager to Projects Created before GV Orbit Control Version 2.2.0, on page 503.

• The Channel Manager is supported by the Channel Manager Service. The Channel 
Manager Service must be installed and running on the GV Orbit Server. Refer to Channel 
Manager Service in the GV Orbit Admin Guide. See Related Documentation, on page 7. 

• One or more supported devices. Supported devices are listed in the GV Orbit Release 
Notes under Channel Manager Card Support. See Related Documentation, on page 19.

• Channels are auto populated from suitable devices found / discovered in the Network 
Tree. See Network Tree in Network Window, on page 84.

The channel Manager has the following panels.
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Icon / Parameter Description

 Channels Shows all the processing channels, channel groups, and the 
configuration of channel parameters. See Channel Screen, on 
page 493.

 Snapshots 
Configuration

Shows all the currently available snapshots and some of the 
configuration parameters used to create the snapshot. See Snapshots 
Configuration, on page 499.

 Snapshots Logs Shows a history of snapshot activity. See Snapshots Logs, on page 501.
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Channel Screen
In the Channel screen, you can:

• Logically associate one or more processing channels by assigning them to a group. A 
group can represent the Channels used for ingest for example.

• Set and save card processing channel configuration parameters, and apply saved 
settings to other channels that may be on other cards of the same type. 

Icon / Parameter Description

 Select All Selects all items in the Channels Browser. 

 Clear All Deselects all items in the Channels Browser. 

Channel Name 
Group Name

Filters the Channels / Groups list according to the text you type in the 
filter field and according to the filter option set by clicking ; see 
below. Clear the filter text and press <Enter> to remove the filter.

 Click to set the scope for the filtering to the text contained in the 
Channel Name, Group Name, or Description of the channel’s 
properties.

 

 Add Creates a new Channel Group. See Creating a New Channel Group, on 
page 494.

 Delete Removes the currently-selected Channel Group. This does not delete 
any of the channels in the group.
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Creating a New Channel Group
A Channel Group organizes a number of associated channels together. 

1 In the Channel Manager, click Add  .

2 Configure the creation parameters.

3 Click OK.
The Channel Group(s) are added to the Groups section of the Channel Manager.

Adding Channels to a Channel Group
A Channel Group collects associated streams, for example a 4K UHD stream and an HD 
stream of the same content. A Channel can be added to more than one Channel Group.

PREREQUISITE: You must have created one or more Channel Groups. See Creating a New 
Channel Group, on page 494.

 Save Settings Saves the configuration parameters to a configuration snapshot. A 
configuration snapshot can be later recalled to quickly recreate the 
configuration settings needed for a given system deployment. See 
Configuring the Channel and Saving the Channel Settings to a 
Snapshot, on page 495.

 Recall Settings Applies the saved configuration setting from a previously-created 
Channel snapshot, to the current channel. Configuration snapshots 
created from the settings of one channel can be applied to another 
compatible channel, that is, the channel’s origin is of the same card 
bundle / SDC combination. See Recalling a Channel Snapshot, on 
page 496.

Name Add / edit a unique Channel Group name.

Description Add / edit an optional description for the Channel / Channel Group to 
make its role easier for you and others to distinguish.

Icon / Parameter Description

Parameter Description

Number of groups The number of Channel Groups to add. When this is set to 2 or more, 
the Channel Groups are suffixed with a number.

Name A unique Channel Group name.

Description An optional description for the Channel Group / Channel to make its 
role easier for you and others to distinguish.
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1 Select one or more Channels that you want to add to a Channel Group.
You can multi-select using the <Shift> / <Ctrl> key: 

• By holding the <Shift> key and selecting the first and the last Channel, all Channels 
in between are selected. 

• By holding the <Ctrl> key, you can toggle the selection by clicking individual 
Channels.

2 Drag and drop the Channels into the Channel Group. The mouse cursor shows the 
channels that are to be added. Or if a Channel Group is currently selected, you can drop 
the Channels into the Channel Group.

Configuring the Channel and Saving the Channel Settings to a Snapshot
When a Channel is selected in a Channel Group, you can set and save card processing 
channel configuration parameters, to create a snapshot. All current operational parameters 
for that channel are saved in the snapshot. A configuration snapshot can be later recalled to 
quickly recreate the configuration settings needed for a given system deployment. 

1 Select a Channel in the Channel Group.
2 Set the Channel’s processing parameters. Refer to the card’s documentation for 

configuration information.

OR

Parameter Description

Name Add / edit a unique Channel Group name.

Description Add / edit an optional description for the Channel / Channel Group to 
make its role easier for you and others to distinguish.
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3 Click Save Settings  to save the configuration parameters to a configuration snapshot.

All current operational parameters for that channel are saved in the snapshot. During 
snapshot generation, all users looking at this same channel will be blocked with a 
spinning icon to indicate that card configuration is temporarily suspended.

4 Click OK.

Once you have saved the Channel setting to a snapshot, you can apply the settings to other 
channels that may be on other cards of the same type. See Recalling a Channel Snapshot, 
on page 496.

Recalling a Channel Snapshot
Recalling a Channel Snapshot overwrites and applies the saved configuration settings and 
operational parameters from a previously-created Channel Snapshot, to the currently-

Parameter Description

Description An optional description for the Channel to make its role easier for you 
and others to distinguish.

Card parameter 
configuration screens

Configure the device/module/card parameters for this channel. These 
parameters are device-specific. For more information, see the 
documentation for the individual device/card/module type. 

Parameter Description

Name A unique Channel name.

Comments An optional comment for the Channel to make its role easier for you 
and others to distinguish.
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selected channel. Configuration Snapshots created from the settings of one channel can be 
applied to another compatible Channel, that is, the channel’s origin is of the same card 
bundle / SDC combination. 

PREREQUISITE: You must have created one or more Channel Snapshot(s). See Configuring 
the Channel and Saving the Channel Settings to a Snapshot, on page 495.

1 Select a Channel in the Channel Group.
2 Click Recall Settings .

3 Select a Channel Snapshot to apply to the Channel.
4 Click OK.

All operational channel parameters and settings for the selected channel are 
overwritten by the parameters contained in the snapshot. During snapshot recall, all 
users looking at this same channel will be blocked with a spinning icon to indicate that 
card configuration is temporarily suspended.

Deleting a Channel Snapshot
A Channel Snapshot that is no longer needed can be removed. 

1 Select a Channel in the Channel Group.
2 Click Recall Settings .

3 Select a Channel Snapshot to delete.

4 Click Delete.
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5 Click OK to confirm the deletion.
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Snapshots Configuration
This screen shows all the currently available snapshots and some of the configuration 
parameters used to create the snapshot such as the channel’s application type, the card’s 
name, and so on. The contents of this screen can be copied or exported to Microsoft Office 
applications.

This screen allows you to:
• Find the right snapshot for your application as every column has a filter that allows you 

to narrow the list of snapshots down. See Filtering Table Columns, on page 504.

Parameter / Table 
Header Description

 Removes the currently-selected snapshot(s). 

 Click to filter the content to allow you to focus on the snapshot of 
interest. See Filtering Table Columns, on page 504.

Snapshot Name The name given to the snapshot. See Add or Modify a Snapshot’s 
Comments or Name, on page 500.

Channel Name The name given to a channel.

Channel Type The channel application type.

Flow Type The channel’s video resolution.

Application Type The card model.

Card Name The NMOS name given to the card.

Frame The name given to the frame in which the card is located.

Version The card’s application version.

Date The date the snapshot was created.

Comments The comment given to the snapshot. This optional comment makes its 
role easier for you and others to distinguish. See Add or Modify a 
Snapshot’s Comments or Name, on page 500.
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• Delete a snapshot when it is no longer needed. See Deleting a Channel Snapshot, on 
page 500.

• Copy or export the contents to Microsoft Office applications. See Copying or Exporting 
Details from the Snapshots Configuration or Snapshot Logs Screens, on page 502.

Add or Modify a Snapshot’s Comments or Name
You can add or modify a snapshot’s comments or name to make it easier to identify, use, 
and maintain the snapshots. Click on the field and type the new name or comment.

Deleting a Channel Snapshot
A Channel Snapshot that is no longer needed can be removed. 

1 Select one or more Channels in the Snapshots Configuration list. More than one row 
can be selected at a time; to add to a selection, use Shift or Ctrl to select a range of rows 
or to add another row to the selection. 

2 Click .

3 Click OK to confirm the deletion.
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Snapshots Logs
Shows a history of the events that have occurred with each of the snapshots. 

The contents of this screen can be copied or exported to Microsoft Office applications. See 
Copying or Exporting Details from the Snapshots Configuration or Snapshot Logs Screens, 
on page 502.

Icon / Parameter Description

 Click to filter the content to allow you to focus on the snapshot logs 
of interest. See Filtering Table Columns, on page 504.

Date The date the snapshot event was logged.

Operation Type Shows the operation that was logged.
Delete: The snapshot was deleted.
Recall: The snapshot was applied to a channel.
Save: The snapshot was created.

Snapshot Name The snapshot’s name associated to this event. 

Channel Name The snapshot channel’s name:
For snapshot save: shows the name of the channel that snapshot was 
saved from.
For snapshot recall: shows the name of the channel that snapshot 
was recalled to.

Card Name The snapshot card’s name:
For snapshot save: shows the name of the card that snapshot was 
saved from.
For snapshot recall: shows the name of the card that snapshot was 
recalled to.

Frame The name of the frame associated to this event. 

Version The application version associated to this event. 

Status Shows the status of the logged operation.
Complete: The operation completed without failure.
Incomplete: The operation did not complete (it failed).

Comments The comment given to the snapshot associated to this event. 
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Copying or Exporting Details from the Snapshots Configuration or 
Snapshot Logs Screens

The details of one or more rows from the Snapshots Configuration or Snapshot Logs screen 
can be copied or exported to Microsoft Office applications. 

1 Select one or more Channels / Logs in the Snapshots Configuration / Snapshots Logs 
list. More than one row can be selected at a time; to add to a selection, use Shift or Ctrl 
to select a range of rows or to add another row to the selection. 

2 Right-click on one of the selected rows.

Right-click Option Description

Copy Copies the contents of the selected rows for pasting into a Microsoft 
Office application.

Copy with Headers Copies the contents of the selected rows including the headers for 
pasting into a Microsoft Office application. Headers are the labels at 
the top of each column.

CSV Export Saves the contents of the selected rows as a comma-separated values 
(CSV) file.

Excel Export (.xlsx) Saves the contents of the selected rows as an XLSX Microsoft Excel file.

Excel Export (.xml) Saves the contents of the selected rows as an XML Microsoft Excel file.
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Adding Channel Manager to Projects Created before GV Orbit 
Control Version 2.2.0

To add Channel Manager to an existing project that was created before GV Orbit Control 
version 2.2.0, proceed as follows.

1 Upgrade the GV Orbit Client to version 5.2.x or higher. Refer the GV Orbit Release Notes 
and GV Orbit Admin Guide for more information. See Related Documentation, on 
page 19.

2 Ensure the project is not open in GV Orbit Client.
3 Copy the file C:\Program Files\Grass 

Valley\GV Orbit\workflows\workflow.wfl into the workflows folder of your 
project. For example: C:\My-Project-Folder\My-Project-Name\workflows

4 Open the project in GV Orbit Client.
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Filtering Table Columns 
Filters are available at the top of each column for you to filter on the criteria of that column 
to narrow the results show in the snapshot list below.

Filter Parameter Description

And When a second filter criteria is used, both filter criteria must be met for 
the item to be shown in the snapshot list below.

Or When a second filter criteria is used, either filter criteria must be met 
for the item to be shown in the snapshot list below.

Contains The items in the snapshot list below must have the same text as the 
search criterion.

Does Not Contain The items in the snapshot list below must not have any of the same 
text as the search criterion.

Equal The items in the snapshot list below must be an exact match to the 
search criterion.

Not Equal The items in the snapshot list below must not match at all to the 
search criterion.

Starts With The items in the snapshot list below must start with the search 
criterion.

Ends With The items in the snapshot list below must end with the search 
criterion.

Click to select a filter logical operator

Set the filter criteria

Click to open filter tool

Optional: Set a logical operator for use with a 
second filter criteria

Click to clear the filter

Optional: Set the second filter criteria

Click to select a filter logical operator

Select a logical operator

Click to open filter tool
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Introduction
GV Orbit Client has user router control functionality and offers the following routing control 
panels:

• Routing Control - Bulk Routing Panel (see this chapter) - a simple, non-editable soft 
panel for fast control of all router cross-points. 

• Routing Control - XY Routing Panel - an editable and customizable soft panel, typically 
used for small custom panels for specific routing needs.

This chapter describes the Bulk Routing Panel.

GV Orbit System
Routing control panels (soft or hard) connect to a GV Orbit Routing service running on a 
GV Orbit Server.

Fig. 12-1: GV Orbit Routing Panel, Routing Service and Router Controller

A GV Orbit system has one or more GV Orbit Servers which run GV Orbit services. Routing 
panels in a GV Orbit Client connect to a router controller device via the GV Orbit Routing 
service. Router controllers include GV Orbit itself, a Grass Valley Router Controller device, or 

GV Orbit Client

GVOP protocol

Controller-specific connection protocol: 
• SW-P-08; or
• NP-0017

GV Orbit Server

GV Orbit Routing Panel
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GV Convergent. The Routing service provides source/destination information to the client 
and acts on routing commands from the client. See Figure 12-2.

Fig. 12-2: GV Orbit System Diagram 

Prerequisites
A GV Orbit Server is required, running:

• A GV Orbit Control application.
• A GV Orbit Routing service configured for connection to a Router Controller using 

either NP0017 or SW-P-08 protocol.

What is a Bulk Routing Panel?
The GV Orbit Bulk Routing panel is accessible from the GV Orbit Client application. This is a 
simple, quick, non-editable panel which has been designed to allow fast control of router 
cross-points and facilitate both keyboard and mouse navigation. 
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Fig. 12-3: Bulk Routing Panel Example

Key Features

• Keyboard navigation. • Shuffles and Breakaways.

• Single source to single destination.
• Single source to multiple destinations.
• Multiple sources to multiple destinations.
• Copy Paste

• Filter Sources, Destinations, Levels 
and Salvos.

• Custom filtering.
• Filter destinations by routed source.

• Take and Auto Take. • Sort (ascending and descending). 

• Lock and Protect. • Source and Source-Level Dial-up.

• Salvos.

• List View mode for level-focused routing.
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Open a Bulk Routing Panel
The GV Orbit Bulk Routing Panel is accessible from the GV Orbit Client application:

• From the Workflow Window 
• From the Network Window

From the Workflow Window
To open the Bulk Routing Panel from the Workflow window: 

1 Open a GV Orbit C&M project in GV Orbit Client and adjust the window size to be full-
screen.

Full-size is the recommended window size for operation; all controls are visible.
2 Ensure the GVOP client domain is set to be the same as that being used by the GV Orbit 

Routing service on the GV Orbit Server. (Main menu: ‘Connections > GVOP’.)
3 In the Workflow window, click on the Bulk Routing icon. (See Figure 12-4.)

Fig. 12-4: Open a Bulk Routing Panel

The Bulk Routing Panel is opened. See Figure 12-6 for a sample Bulk Routing Panel.

From the Network Window
To open the Bulk Routing Panel from the Network window: 

1 Open a GV Orbit C&M project in GV Orbit Client and set the window size to be full-
screen.

2 Ensure the GVOP client domain is set to be the same as that being used by the GV Orbit 
Routing service on the GV Orbit Server. (Main menu: ‘Connections > GVOP’.)

3 Locate the Routing service item in the Network window of GV Orbit Client. And right-
click on the item and select ‘Open Panel’. See Figure 12-5.

Note: The Bulk Routing Panel is best viewed in full-screen on a 1080P 16:9 
monitor screen with GV Orbit Client.

Click on Bulk Routing icon.
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Fig. 12-5: Open a Bulk Routing Panel

An example Bulk Routing Panel is shown in Figure 12-6.

Note: A ‘Routing service’ item in the Network window is formed when a 
Routing service is running on the GV Orbit Server and is configured 
to talk to a router controller.

Right-click on the
Routing service item 
and select ‘Open Panel’.
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Fig. 12-6: Example Bulk Routing Panel
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Bulk Routing Panel Layout and Controls

Fig. 12-7: Bulk Routing Panel Layout

The panel is laid out as six grids/panes (see Figure 12-7): 
• (1) Source Grid – Scrollable list of all available sources. 
• (2) Source Levels Grid – Scrollable list of available levels for selected source(s).
• (3) Destination Grid – Scrollable list of all available destinations.
• (4) Destination Levels Grid – Scrollable list of available levels for selected 

destination(s).
• (5) Router Control Pane – Take, Lock, and Protect functionality.
• (6) Salvos Pane – List of available Salvos when connected over the NP0017 protocol.

Vertical sizing of the Source and Destination grids can be altered by dragging a splitter 
handle up/down the screen. Horizontal sizing and sizing of the Router Control and Salvos 
panes can be altered by dragging a splitter handle left/right. Other sizing is handled 
automatically. See Figure 12-7.

(1) Source Grid

(5) Router Control

(3) Destination Grid

(2) Source Levels Grid

(4) Destination Levels Grid

(6) Salvos

Splitter handles

Keyboard Shortcuts icon
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What are the Operational Keyboard Shortcuts?
Keyboard shortcuts are available when navigating and operating the Bulk Routing Panel, in 
addition to using a mouse. You can freely mix ‘mouse’ and ‘keyboard’ methods. 

A list of keyboard shortcuts may be displayed in a movable window which can remain on 
display while using the Bulk Routing Panel. 

To see a list of keyboard shortcuts:
1 Click on the ‘Keyboard Shortcuts’ icon 

in the tool bar of the Router Control pane.

The Bulk Routing Keyboard Shortcuts 
window is shown, see Figure 12-8. This window lists the keyboard shortcuts. It remains 
on display and may be moved.

Fig. 12-8: Bulk Routing Keyboard Shortcuts Movable Window

Equivalent mouse clicks for some keyboard shortcuts are listed in Table 12-1.
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 Table 12-1: Bulk Routing Panel Operational Keys / Mouse operations
Operation Keyboard Mouse

Toggle Selection Space bar Mouse click

Take Enter Click Take

Panel Button Focus Cursor Arrow Keys Mouse movement/click

Panel/Grid Focus CTRL + Arrow Keys Mouse movement/click

Add a series of items to/remove 
from a multiple selection

SHIFT + Cursor keys SHIFT + Mouse click

Add distinct items to/remove from 
a multiple selection

CTRL + Space bar CTRL + Mouse click

Select Range

(Select a contiguous range)

Space bar on first item then 
SHIFT + space bar on last item.

Mouse click on first item then
SHIFT click on last item.

Paste Series Alt-CTRL + V when a range of 
destinations are selected.

Click ‘Paste Series’ icon in panel.

See What is Copy-and-Paste Series Routing?, on page 534.

Take Return / Enter Double-click

Dial Source Begin to type the name of a 
Source when a destination is 
selected.

See Dial Source Dialog, on 
page 526.

N/A

Dial Source-Level Press any single alpha-numeric 
key when a destination and (one 
or more) levels are selected.

See Dial Source-Level Dialog, on 
page 527.

N/A

Cancel Escape Click ‘Cancel’ button in the Router 
Control pane.

Select All in the focused panel CTRL + A Click ‘Select All’ icon in panel.

Select None in focused panel CTRL + D Click ‘Select None’ icon in panel.

Copy a Destination CTRL + C when a destination is 
selected

Click ‘Copy’ icon in panel

Paste a Destination CTRL + V when target destination, 
or destinations, are selected

Click on ‘Paste’ icon in panel
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Select/Focus in a Bulk Routing Panel

Current Button-Focus
When the mouse cursor is moved over a button, or control item, the button/item is 
highlighted indicating the current item is in focus.

Fig. 12-9: Current Button-Focus Item

Select a Button
To select a button:

• click on a button; or
• press the space-bar key when a button is the current focus item.

De-select Buttons
To deselect all buttons:

• click Cancel in the Router Control pane; or
• press the ESC key.

Move Focus Between Grids/Panels of the Bulk Routing Panel
To move the focus between a grid/panel of the Bulk Routing panel:

• Use the CTRL key and one of the cursor arrow keys. 

Focus is indicated by a border around the focused grid.

Selected Destination
Current Button- Focus

Navigate with:
Cursor Keys, 

or use the mouse
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Fig. 12-10: Current Panel/Grid Focus Item

Selecting Multiple Items

Select Multiple Items (CTRL select)
Select multiple items (such as destinations, or sources, etc.) by selecting the first item and 
CTRL-selecting the others. For example, to select multiple destinations:

1 Select the first destination by clicking on the destination selection button.
2 CTRL-click on the next destination to add that to the selection.
3 Add other destinations.

Select Multiple - Alternative Method

Multiple items can be selected using the Control key, the Cursor Arrow keys and the Enter 
key.

1 With the cursor over the first item to be selected, press enter to select it.
2 Use the cursor arrow keys to move to the next item. 
3 Select it with CTRL-Enter. This adds to the selection.
4 Add other items similarly.

Select a Range of Items (SHIFT select)
When selecting multiple items (such as destinations, or sources etc.), a range may be 
selected by selecting:

1 The first destination in the range by clicking on the destination selection button.
2 Selecting the last destination by SHIFT + clicking on its destination button.

Source ranges can be selected similarly.

Currently-routed 
Source

Current 
Button-Focus

Current Panel/Grid Focus

Pre-selected Source

Navigate with:
Control-Cursor Keys, 

or use the mouse
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Select a Range - Alternative Method

A range of consecutive sources or destinations can be selected using the Shift key, Cursor 
Arrow keys, and Enter key.

1 With the cursor over the first item to be selected, press Enter to select it.
2 Move to the last item in the range with the cursor keys.
3 Hold down the SHIFT key and press Enter to select it.

The last item and all the items from the first to the last are added to the selection.

Source/Destination Grid Buttons
The source/destination selection grid buttons and level-selection buttons are annotated to 
reflect the source/destination name or the level name. Additionally, the destination buttons 
may show the currently-routed source and currently-selected source for the selected 
destination. Buttons also change shape and are highlighted to show if they are selected or 
if sources are currently-routed or currently-selected. See Figure 12-11.

Note:
See Breakaway and Levels and Shuffle and Levels for examples of 
selecting levels.
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Fig. 12-11: Selection Buttons

Level Selection
When a source or a destination is selected, the associated levels are shown in the 
corresponding ‘Levels’ grid. If multiple sources or destinations are selected, then only their 
common levels are shown. 

All levels are selected by default. If you select one or more levels, then all other levels are 
deselected. 

Source Name Destination Name

Pre-Selected Source Name

Currently-Routed Source Name

Pre-Selected Source

Currently-Routed Source

Pre-Selected Source Level NameSource Level Name

Selected Destination

Destination Level Name

Pre-Selected Source Name

Note: Select a Destination or a Source to see the corresponding Level 
selection buttons.
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Keep Last Level Selection After Take
When a different source or destination is selected after a ‘Take’, the level selection is 
normally cleared. To keep the selected levels, select the Keep Last Selection button in the 
‘Levels Grid’ pane tool bar (see Figure 12-12). 

Fig. 12-12: Keep Last Selection Buttons

Keep Last Selection toggle buttons

Source Levels Grid Destination Levels Grid



519

GV Orbit Version 2.3.0 Routing Control - Bulk Routing Panel
User Guide Router Control Pane

Router Control Pane
The Router Control pane in the Bulk Routing Panel contains the Take, Lock and Protect 
functions.

Fig. 12-13: Router Control Pane: 
a) No Selections Made; 
b) Destination Selected; 
c) Destination and Source Selected.

Click Cancel to cancel all selections.

Select Auto-Take to make a route as 
soon as source(s) and destination(s) are 
selected.

a) No Selections Made

b) Destination Selected

With a destination selected, Lock and Protect buttons are active.

c) After Destination and Source Selection

After destination(s) and source(s) are selected, the Take button goes active (red). 

Click icon to see a list of keyboard shortcuts.
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Tool Bars in a Bulk Routing Panel
There is a small tool bar at the top of each grid/pane containing controls for selection/de-
selection, sorting and filtering.

Source Selection Grid Tool Bar

Fig. 12-14: Source Selection Grid - Tool Bar

Source Levels Grid Tool Bar

Fig. 12-15: Source Level Selection Grid - Tool Bar

Click to see drop-down menu of tool bar items.
Click to Select all sources.

Click to Deselect all sources.

Click to Sort sources A-Z.

Click to Sort sources Z-A.

Filter control, see What is 
Bulk Routing Panel 
Filtering?, on page 547.

Click to toggle the optional display of Wide Source and 
Destination Selection Buttons.

Click to see drop-down menu of tool bar items.

Click to Select all levels.
Click to Deselect all levels. 

Click to Sort levels A-Z.
Click to Sort levels Z-A.

Click to keep the Levels selection after a Take.

Filter control, see What is Bulk Routing 
Panel Filtering?, on page 547.
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Destination Grid Tool Bar

Fig. 12-16: Destination Selection Grid - Tool Bar

Filter control, see What is Bulk 
Routing Panel Filtering?, on 
page 547.

Click to:
• See a drop-down menu of all tool bar items.

• Copy routing information of a Destination selection.
• Paste routing information to a Destination.
• Paste a series of sources to a Destination range. 

(See What is Copy-and-Paste Routing?, on page 533.)
• Select all destinations.
• Deselect all destinations.
• Sort destinations A-Z.
• Sort destinations Z-A.

• Toggle display of wide selection buttons.
• Toggle Hide Sources. See Hide Sources, on page 562.
• Toggle List View mode. See List View, on page 564.
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Destination Levels Grid Tool Bar

Fig. 12-17: Destination Level Selection Grid - Tool Bar

Router Control Pane Tool Bar

Fig. 12-18: Router Control Pane - Tool Bar

Click to see drop-down menu of tool bar items.

Click to Select all level.
Click to Deselect all levels. 

Click to Sort levels A-Z.
Click to Sort levels Z-A.

Click to keep the Levels selection after a Take.

Filter control, see What is Bulk Routing 
Panel Filtering?, on page 547.

Keyboard Shortcuts icon
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Salvos Pane Tool Bar

Fig. 12-19: Salvos Pane - Tool Bar

Wide Source and Destination Selection Buttons
To facilitate the display of longer source or destination names on selection buttons, there is a 
‘wide button’ display option. This is selectable in the Source Grid and, independently, in the 
Destination Grid. The option is selected with a toggle button in the tool bar of each grid. See 
Figure 12-20. 

The display option persists between sessions with the Bulk Routing Panel.

Fig. 12-20: Wide Buttons (Source Grid Shown)

Panel Pop-Up Items

Right-Click in a Bulk Routing Panel
Right-click on the Bulk Routing Panel to display a pop-up context menu. See Figure 12-21.

Click to see drop-down menu of tool bar items

Click to sort sources A-Z
Click to sort sources Z-A

Filter control, 
see What is Bulk Routing Panel Filtering?, on page 547

Click to toggle display of normal and wide buttons.
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Fig. 12-21: Right-Click Context Menu

Pop-up Notification Messages
During Bulk Routing Panel operation, notification messages may pop up at the foot of the 
GV Orbit Client application window to provide information and advice, for example, on the 
setting up of a route, or of a broken/re-made Routing service connection. See Figure 12-22 
for some example messages. 

Click OK to clear a message. 

 Table 12-2: Right-Click Context Menu Items 
Item Keyboard

Dock/Undock 
Window

Undock or dock the Bulk Routing Panel window from/to the 
GV Orbit Client window.

Full Screen The Bulk Routing Panel window is shown full-screen. 
The control toggles full screen mode on/off.

Copy Same as:
• clicking on Copy icon in grid/pane tool bar; or 
• pressing Ctrl-C.

Deselect All Deselects all items. 

Lock/Unlock Click to lock panel. When panel is locked, controls are grayed-out 
and user operation is disabled. The control toggles lock on/off

Set Timeout Click to set a timeout (in seconds) for confirmation from the router 
controller of routing actions (that is setting the router’s 
crosspoints). 

If the timeout is exceeded, a timeout notification is shown on 
screen. See Pop-up Notification Messages.

Copy As Widgets Click to copy a selection of one or more buttons to the GV Orbit 
Client’s copy-buffer. 
(This is used when designing an XY Routing Panel. See Chapter 13, 
Routing Control - XY Routing Panel, Quick Port-per-Button 
Assignment, on page 625.)
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Fig. 12-22: Notification Message Examples

Dial Source and Dial Source-Level Dialogs
To help with source and source level selection when making a route, a ‘dial-up’ dialog 
allows you to begin to type in a source name and see a filtered list of sources and source 
levels. 

There are two ‘dial-up’ dialogs
• Dial Source Dialog for Source selection.
• Dial Source-Level Dialog for Source and Level selection.

These dialogs enable a user to select a source and/or level and route it to a destination.

Click OK to clear the message. 
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Dial Source Dialog
Dial Source is a quick way of selecting a Source for a destination and routing it.

With a Destination selected, a Source may then be found by typing a part of a source name 
with the keyboard’s alpha-numeric keys. A Dial Source dialog is displayed and, as 
characters are entered:

• Sources matching the entered characters are displayed in a drop down list; and the 
• Source Grid is correspondingly filtered. 

After a valid Source has been selected, a route can be made by pressing the Enter key.

Example

To see and use the Dial Source dialog:
1 Select a Destination.
2 Begin to type in a Source name.

A Dial Source dialog pops up. (See Figure 12-23.)
3 Continue typing in a valid source name and press Enter; and/or

select a source from the (scrollable) filtered list in the dialog.

A route is made from the selected Source to the selected Destination. No ‘Take’ is 
required.

Fig. 12-23: Dial Source Dialog

Note: To clear a ‘dial-up’ dialog before making a route, click the ESC key.

Note: Enter will execute the route if a valid source has been selected. A 
mouse click on a source will also execute the route.

Selected 
Destination

Pop-up Dial Source dialog

Type in Source name, or 
select Source name.
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Further routing examples can be found at:
• Route with Dial Source, on page 530.

Dial Source-Level Dialog
Dial Source-Level is a quick way of selecting a Source and a Level for a destination and 
routing it. By default, the Dial Source-Level dialog shows the currently-routed Source and 
Source-Level.

With a Destination and a Destination Level selected, type a single alpha-numeric character 
to display the default Dial Source-Level dialog. 

A Source may then be found by starting to type a source name. As the Source name is 
typed, the Sources listed in the dialog are filtered. 

After a valid Source has been highlighted, press Tab to select a valid Source Level and a 
route can be made by pressing the Enter key.

Routing a level from a different source to a destination forms a breakaway (see Breakaway 
and Levels). Routing a different level from the same source forms a shuffle (see Shuffle and 
Levels). 

Example

To see and use the Dial Source-Level dialog:
1 Select a Destination.
2 Select one or more Destination Levels.
3 Type a single alpha-numeric character.

A default Dial Source-Level dialog pops up and shows the currently-routed Source 
name and Level. (See Figure 12-24.) 
(Note: It is assumed that level-based routing is required.)
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Fig. 12-24: Dial Source-Level Dialog

4 If a different Source Name is required, begin to enter the required Source name.

The list of Source names is filtered on the typed text.
5 Either:

• continue typing in a valid Source name (but do not press the Enter key); or
• highlight a Source name in the list (do not select it).

6 When the required (and valid) Source name is in the upper text box of the dialog,
press the Tab key. (See Figure 12-24.)

This toggles focus from ‘Sources’ to ‘Levels’; the filtered list changes to listing Levels.

7 Type in the Level name required and press Enter; and/or 
select the Level from the filtered list in the dialog.

A route is made from the (one) selected Source Level to the selected Destination 
Level(s). No ‘Take’ is required. 

Selected 
Destination Pop-up Dial Source-Level 

dialog

Type in a valid Source name; 
and press Tab key to 
toggle focus to Levels.

Selected 
Destination 
Levels

Type in Level name; and/or 
select Level name.

Note: To clear a ‘dial-up’ dialog before making a route, click the ESC key.

Note: Enter will execute the route if a valid source and level has been 
selected. A mouse click on a source or source level will also execute 
the route.



529

GV Orbit Version 2.3.0 Routing Control - Bulk Routing Panel
User Guide Bulk Routing Panel Operation

Further routing examples can be found at:
• Quick Breakaway with Dial Source-Level, on page 540.
• Quick One-Level Shuffle with Dial Source-Level, on page 546.

Bulk Routing Panel Operation

Make a Simple Route
To make a simple route:

1 Select a Destination.

The source currently routed to the selected destination is automatically highlighted in 
the Source Grid.

2 Select a Source to be routed to the selected destination.

See Figure 12-25.

Fig. 12-25: Make a Route Example - Before TAKE. 

3 Click Take. (Click Cancel, to deselect the source/destination.)

Before a Take, the Levels Grids show level information for the selected source and destination.

Click Take to make route

1

2
3
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The selected source (all of its levels) is routed to the selected destination. See Figure 12-
26.

Fig. 12-26: Make a Route Example - After TAKE. 

Simple Route - Alternative Method

Also, to make a route, the source may be selected first:
1 Select a Source.
2 Select a Destination.
3 Click Take.

Route with Dial Source
See Dial Source Dialog, on page 526, for more information. To make a simple route:

1 Select a Destination.
2 Begin to type in a Source name.

A Dial Source dialog pops up. 
3 Continue typing in a source name and press Enter; and/or

select a source from the (scrollable) filtered list in the dialog.

After the TAKE, the new source of 
the destination and its levels is 
shown in the Destination Grid and 
Destination Levels Grid.
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A route is made from the selected Source to the selected Destination. No ‘Take’ is 
required.

Route One Source to Multiple Destinations
One to many.

To route a single source to multiple destinations:
1 Select a Destination by clicking on the destination selection button. 

(Equivalent keyboard shortcuts = cursor arrow keys and space-bar.)
2 Select a second Destination by CTRL + clicking on a destination button. 

(Equivalent keyboard shortcuts = cursor arrow keys and CTRL-Space-Bar.)
3 Select further destinations with CTRL + click.

A selection of destinations has been made.

When all destinations have been selected:
4 Select a Source.

(Equivalent keyboard shortcuts:
Change to Source grid = CTRL-Cursor arrow keys.
Select Source = cursor arrow keys and space bar.)

5 Click Take.
(Equivalent keyboard shortcuts = Enter.)

The selected source is routed to all selected destinations.

One Source to Multiple Destinations - Alternative Method
Alternatively, the source may be selected first:

1 Select a Source.
2 Make a selection of Destinations (by CTRL-clicking, or SHIFT-clicking, or a combination). 
3 Click Take.

Route Multiple Sources to Multiple Destinations
Many to many.

To route multiple sources to multiple destinations:
1 Select a Destination by clicking on the destination selection button.
2 Select a second Destination by CTRL + clicking on a destination button.

Note: The Bulk Routing Panel may be operated with a mouse, or using 
keyboard shortcuts, or by using a mixture of both.

Note: Alternatively, a range selection may be made by:

• Selecting the first destination; and then 
• SHIFT-selecting the last one. 

This selects a sequential range of destinations, from first to last.
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3 Select further destinations with CTRL + click.

When all destinations have been selected:
4 Select a Source by clicking on the source selection button.
5 Select a second Source by CTRL + clicking on a source button.
6 Select further sources with CTRL + click.

7 Click Take.

The source is routed to all selected destinations.

Multiple Sources to Multiple Destinations - Alternative Method
Alternatively, the source may be selected first:

1 Select multiple sources.
2 Select multiple destinations.
3 Click Take.

Multiple Selection Type and Routing Order
Routing multiple Sources and/or multiple Destinations requires a selection of Sources and 
of Destinations to be made. This can be done as:

• a selection of multiple items (see Select Multiple Items (CTRL select), on page 515); or 
as

• a range selection of multiple items (see Select a Range of Items (SHIFT select), on 
page 515).

The selection order is different in each case and affects routing order.

CTRL-Selection Type Order
When routing multiple sources to multiple destinations and selecting multiple items with 
CTRL-clicks (that is, not by using a range selection), then the order of selection is significant 
and affects the order in which routing is done. 

For example, to route sources 1 to 8 to destinations 8 to 1:

Note: Alternatively, a range selection may be made by:

• Selecting the first Destination; and then 
• SHIFT-selecting the last one. 

This selects a range, from first to last.

Note: Alternatively, a range selection may be made by selecting the first 
Source and then SHIFT-selecting the last one. This selects a range, 
from first to last.

Note: Select the same number of sources as there are selected destinations. 
A reminding, pop-up notification message will appear.
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• Select sources 1 to 8 by CTRL-clicking on each source button in the order 1 to 8.
• Select destinations 8 to 1 in that order by CTRL+clicking on each destination button in 

the order 8 to 1.
• Click Take.

SHIFT-Selection (Range) Type Order
When routing multiple sources to multiple destinations and using a selection range (a 
selection made with ‘SHIFT’), then selection order is from the first to the last item of the 
range, in the order that the items (Source or Destination buttons) are shown. This is the 
routing order used.

What is Copy-and-Paste Routing?

Copy and paste allow routing information from one destination to be copied onto another 
destination. The Copy and Paste controls are in the Destination Grid tool bar.

Fig. 12-27: Destination Grid Copy and Paste Controls

To Perform Copy-and-Paste Routing
1 Select a Destination.
2 Click the Copy icon in the tool bar of the Destination Grid, or press ‘CTRL +C’.

The copy-selected Destination is shown highlighted with a ‘crawling’, dashed outline. 
See Figure 12-28.

Fig. 12-28: Copy-Selected Destination

Then:
3 Select a different Destination (the one to copy to).
4 Click the Paste icon, or press ‘CTRL + V’.

The routing of the first destination is applied to the second destination and a route is 
made automatically. The routing done is ‘all-levels’.

Copy
Paste

‘Copy-Selected’ Destination
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The copy-selection is still selected (the dashed outline indicates this), so further pastes can 
be made. To paste the same to further Destination(s):

5 Select a Destination (or select multiple destinations) and click on the Paste icon (or 
press ‘CTRL-V’.)

6 Repeat for any further Destinations.

Finally:
7 To clear the copy selection, press ESC. (This can be done at any time.)

What is Copy-and-Paste Series Routing?
Paste Series fills a range of Destinations with a consecutive series of Sources.

To Perform Copy-and-Paste Series Routing
1 Select a Destination.
2 Click the Copy icon, or press ‘CTRL +C’.

The routing information of the selected destination is copied.
3 Select a range of Destinations.
4 Click the Paste Series icon, or press ‘SHIFT + V’.

Fig. 12-29: Paste Series Icon

The routing of the first, ‘copy-selected’ destination is applied to the first destination in 
the selected range. 
The next sequential source is routed to the next destination in the range 
and so on. 
Routing is done automatically (no Take required).

Paste Series Example
1 Select destination 1 and click Copy.
2 Select destination range 11 up to 19. (Select first and Shift-select last.)
3 Click Paste Series .

The following routing is done:
Source 1 to destination 11, source 2 to 12, 3 to 13, 4 to 14, ... , 9 to 19.

Paste Series icon
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What is Quick 1-to-1 Routing?
Quick 1-to-1 routing can be used to make 1-to-1 routes quickly. This can be useful at system 
set up. For example, for the first 100 sources routed to the first 100 destinations.

To Perform Quick 1-to-1 Routing
To make a set of quick 1-to-1 routes:

1 Select destination 1, select Source 1, and click Take.

This routes the first destination.
2 Click Copy.

Destination 1’s routing information is copied.
3 Select destination range 1 to 100. (Select first and Shift-select last.)
4 Click Paste Series .

The following routing is done:
Source 1 to 1, source 2 to 2, 3 to 3, ... , 99 to 99, and 100 to 100.

This has quickly copied Sources to all selected Destinations.

Destination Protect

What is Destination Protect?
When a destination is protected by a user, users of other types of routing control panel 
cannot route to it. 

This means that users of Bulk Routing Panels in GV Orbit Clients would be able to route to a 
destination protected by another such Bulk Routing Panel. But hardware panel users would 
not be able to route to a destination protected by a Bulk Routing Panel. (And vice versa.)

To Protect a Destination
1 Select a Destination.
2 Click the Protect button in the Router Control pane.

The destination is protected.

Note: The rules of selection type and order apply. See Multiple Selection 
Type and Routing Order, on page 532.
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Fig. 12-30: Protected Destination

To Un-Protect a Destination
1 Select the protected destination.
2 Click the Release button in the Router Control pane.

The destination protection is removed from the selected destination.

Protected 
Destination, 
selected

Protect button

Selected 
Destination’s levels 
are also shown as 
protected

A Protected 
Destination, 
not selected
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Destination Lock

What is Destination Lock?
When a destination is locked, it cannot be routed to by any user. When a destination is 
locked by another user, click on a destination to see which user locked it.

To Lock a Destination
1 Select a destination.
2 Click Lock in the Router Control pane.

The destination is locked.

Fig. 12-31: Locked Destination 

To Unlock a Destination
1 Select the locked destination.
2 Click the Release button in the Router Control pane.

The destination lock is removed from the selected destination.

Selected 
Destination, Locked

Lock button

Locked 
Destination’s levels 
are also shown as 
locked
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Breakaway and Levels

What is a Breakaway?
A ‘breakaway’ occurs when all levels of a destinations do not come from the same source. 
This is also referred to as the destination being ‘unmarried’. 

Fig. 12-32: Breakaway

Destinations which are ‘unmarried’ are indicated with a breakaway icon (Figure 12-33c) on 
the destination button.

Breakaway example shown:
Two audio channels of Destination B (A1 and A2) are obtained 
from a different source (Source C).
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Perform a Breakaway
To perform a breakaway:

1 Select a Destination.
2 Select the Destination Levels to make a route to (for example, audio channels A1 and 

A2). (See Figure 12-33a.)
3 Select a new Source. 
4 Click Take.

The corresponding levels of the selected source are routed to the selected destination 
levels and a breakaway is formed. Figure 12-33b shows the breakaway result.

Fig. 12-33: Breakaway Example: a) Before TAKE; b) After TAKE; c) Breakaway Icon on 
Button.

a) Before TAKE: 
• Destination MV10-9 is currently all routed from source 

S10-9
(as shown in the Destination Levels Grid).

• Destinations levels A1 and A2 are selected.
• S10-18 is the currently-selected source.

b) After TAKE: 
• Destination MV10-9 is routed partly from source S10-9 

and partly from S10-18 (levels A1 and A2). 
• This breakaway situation is indicated with a Breakaway 

icon on the destination button.
• The source of each destination level is shown in the 

Destination Levels Grid.

c) Breakaway icon on button

1

2

3
4
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Breakaway - Alternative Method
Also, to perform a breakaway, the source may be selected first:

1 Select a Source.
2 Select a Destination.
3 Select the Destination Levels to route.
4 Click Take.

Quick Breakaway with Dial Source-Level
A quick single-level breakaway method uses the Dial Source-Level Dialog.

To perform a quick video-level breakaway:
1 Select a Destination.
2 Select a Destination Level. (See Figure 12-34.)

Fig. 12-34: Selected A Destination and a Level

3 Type a single alpha-numeric character.

A default Dial Source-Level dialog box appears showing the currently-routed Source 
and Level. 

Note:
A ‘breakaway’ occurs when not all of a destination’s levels are selected for 
routing.
This can also happen if a source with fewer levels than the selected 
destination is routed, this will result in a ‘breakaway’ (without selecting 
destination levels). 

Selected Destination

Selected Video Level
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4 Begin to type a (new) Source name at the keyboard. 
(For example, type “s” or “S” if source names begin with “S” - “S10-10”, “S10-11”, etc.)

A Dial Source-Level dialog box appears. See Figure 12-35.

Fig. 12-35: Dial Source-Level Dialog

5 Type the new Source name into the dialog box. But do not press the Enter key yet.
6 When the Source name is typed, press the Tab key.

This toggles focus from ‘Sources’ to ‘Levels’ and to the lower dialog text entry box. 

Fig. 12-36: Source and Level are Dialed-up

7 Type in the Level name, for example “V” and press the Enter key when done. 
Or select a level from the filtered list.

Type Source name

Level text entry box

Source name text entry box

Press Tab key to toggle focus to 
the Level text entry box

Typed in source name
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The route is made, connecting the dialed-up Source Level to the selected Destination 
Level and forming a breakaway. See Figure 12-37.

Fig. 12-37: Resulting Video Level Breakaway

Use this method to set up any breakaways (or shuffles, see Quick One-Level Shuffle with 
Dial Source-Level, on page 546) required.

Shuffle and Levels

What is a Shuffle?
A destination is said to be ‘shuffled’ when one of its levels is routed from another level of the 
same source. For example, destination audio channel 5 from source audio channel 4. When 
this occurs, the Bulk Routing Panel indicates a ‘shuffled’ destination with a Shuffle icon on 
the destination button.

Video Level sourced from a 
different source. (Breakaway)

(Level sources:

‘Video’ - now from S10-111, 

‘other’ - unchanged, S10-10.)
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Fig. 12-38: Shuffles

To Perform a Shuffle
1 Select a Destination.
2 Select the Destination Levels. 

For example, in Figure 12-40a, levels A1, A2, A3 and A4 are selected in that order.
3 Select a Source. 
4 Now select the Source Levels in the order in which they shall apply to the destination 

Levels. 
For example, in Figure 12-40a, levels A4, A3, A2 and A1 are selected in that order.

A source is routed to a destination 
and audio channels are ‘shuffled’ 
around; they are not routed ‘1-to-1’.

Shuffle example shown:
Audio channels of Destination B (A1 and 
A2) are obtained from a source (Source 
A) but not all levels are mapped “1 to 1”.

Note: Selecting just one source level will route this to all selected 
destination levels.
Otherwise select the same number of source levels as destination 
levels. A notification prompt appears at the bottom of the GV 
Orbit Client window, reminding you to select source levels (see 
Figure 12-39).
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Fig. 12-39: Select Levels Notification

5 Click Take.

The selected source levels are routed to the selected destination levels and a shuffle is 
formed. Figure 12-40 shows a shuffle example reversing the order of the four audio 
channels (A1 to A4).

Notification prompt.
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Fig. 12-40: Shuffle Example: a) Before TAKE; b) After TAKE; c) Shuffle Icon on Dest. Button.

c) Shuffle icon on button

1

5

2

3

4

a) Before TAKE: 
• Destination MV10-9 is currently all routed from source 

S10-9
(as shown in the Destination Levels Grid).

• Destinations levels A1, A2, A3 and A4 are selected.
• Source S10-9 is selected.
• Source Levels A4, A3, A2 and A1 have been selected 

(in that reversed order).

b) After TAKE: 
• Destination MV10-9 is still all routed from source S10-9. 
• This ‘shuffled’ situation is indicated with a Shuffle icon on the 

destination button.
• The source of each destination level is shown in the 

Destination Levels Grid.
In particular, the destination’s A1, A2, A3 and A4 are now routed 
from A4, A3, A2, and A1 respectively.
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Quick One-Level Shuffle with Dial Source-Level
To shuffle (route) one level using the Dial Source-Level Dialog: 

1 Select a Destination.
2 Select a Destination Level.

A Destination and one Level are now selected.
3 Type a single alpha-numeric character.

A default Dial Source-Level dialog appears and showing a filtered list of source names. 
The currently-routed Source and Level are shown.

Do not click; do not press Enter at this time.

Note: The currently-routed Source name is shown in the default dialog.
4 Press the ‘Tab’ key.

Focus then moves (toggles) from Source to Levels in the dialog.

Fig. 12-41: Dial Source-Level Dialog

5 Type in a new Level name and press Enter, or 
select a new Level item in the filtered list, click to select.

A route is performed, connecting the selected Source Level to the selected Destination 
Level. A shuffle is made, see Figure 12-42.

Selected Destination

Selected Destination Level

Dial Source-Level dialog

Source name

Selected Source Level

Current Source routed to 
selected Destination
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Fig. 12-42: Shuffle Routed

Use this method to set up any shuffles (or breakaways, see Quick Breakaway with Dial 
Source-Level, on page 540) required.

Filtering

What is Bulk Routing Panel Filtering?
Most grids/panes of the Bulk Routing Panel have a filter control on their tool bar. The filters 
control what items are shown in the grid/pane. Filters can be applied to the 
Source/Destination grids, the Level Selection grids and the Salvos pane. Custom filters can 
be created and applied. For destinations, filtering can also be by (routed) source. 
By default, level filtering is set up to show the usual video and audio levels.

Note: Using this method, one Source Level can be routed to one or more 
Destination Levels.

Shuffle now made, audio 
level A11 at destination 
comes from audio level A7.
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What are the Filter Controls in a Bulk Routing Panel?
Each grid/pane contains a similar filter text box and icon. These access a filter items list (also 
accessed by typing Ctrl-F when in a grid/pane), and filter options menu respectively.

Fig. 12-43: Filter Controls: 
a) Filter Text Entry Box; b) Filter Drop-Down Options Menu;
c) Drop-Down Menu for Destination Grid; d) Level Grid Filter Items List (Default).

Filtering Actions

Simple Filtering by Name
To simply filter items in a grid or pane by name: 

1 Select the Filter text entry box.
2 Enter a filter search term into the Filter text box. 

For example, type ‘S11’ to only show source names starting with ‘S11’.

Note: Filtered Lists:
When a filter is applied, a filtered (reduced) set of items is shown in a 
grid/pane. 
Subsequent actions, such as ‘select all items’ or ‘selecting a range’, then 
all operate on the filtered items shown and not on the full list of items. 

Filter search text box

a) Filter Controls - Text Entry Box b) Filter Drop-Down Menu

c) Filter Drop-Down Menu - for the Destination Selection Grid

d) Levels Grid Filter Default

Click the Filter icon to show the Filter options menu.

Filter items listDestination Grid’s Filter options menu

Note: The default ‘Levels’ filter list shows 
one video level and 16 audio channels.
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As the filter search term is typed, the number of displayed items in the Grid/Pane is 
reduced (filtered). The reduced number of items gives a preview of the filter’s action.

3 To abort the filter set up, press the ESC key.
4 When the required filtering is reached, press the Return/Enter key to apply the filter.

The filter has been applied to the grid. Then only filtered items are shown in the 
grid/pane, with names which contain the search term. 

Fig. 12-44: Example of Simple Filtering Applied to a Grid/Pane (Search Term = “S11”)

Clear Applied Filtering in a Grid/Pane
To clear filtering that has been applied in a grid or pane: 

1 Either:
• click on the Filter icon ( ) in the grid/pane’s tool bar; or
• in the Filter text entry box, press the Tab key. 

And then select ‘Clear Filter’.

The filtering is removed and all grid/pane items are shown. 
The filter search term is also cleared and the Filter items drop-down list is shown.

2 At this point, a new search term may be entered. 
Or the filter clearing action can be aborted by pressing the ESC key.

If no further filter set up is required:
3 Press the Enter/Return key to remove the Filtering and the Filter items drop-down list.

Set Level Filtering in a Grid/Pane
To set any applied Level filtering back to its ‘default’: 

1 Either:
• click on the Filter icon ( ) in the Level grid/pane’s tool bar; or
• in the Filter text entry box, press the Tab key, 

Filter search term
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And select ‘Video, Audio 1 to 16’.

Fig. 12-45: Set Level Filtering to Default

Any filtering is replaced by the default ‘Video, Audio 1 to 16’ filtering and the filter 
search term reflects this. 

Fig. 12-46: Level Filtering Default

2 Press Enter to apply this change (or press ESC to cancel this filter change).

Fig. 12-47: Level Filtering Default Applied

Select ‘Video, Audio 1 to 16’
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Dynamic Filtering By Name

Fig. 12-48: Dynamic Filtering (Source Names Example): 
a) Enter Search Term and Select. 
b) Selected Item Displayed

To dynamically filter items by their name: 
1 Enter the filter search term into the Filter text box. 

GV Orbit looks for names which contain the filter search term.
A drop-down, scrollable filtered list of names is presented. 
The list dynamically changes with the search term.

2 Find a name in the list by scrolling through the items. 
(Use a mouse wheel, the scroll-bars, or up/down arrow keys to scroll through the list.)

3 Select an item. 
(Click on it, or press the Return/Enter key when item is highlighted.)

The result of the selected filter item is shown in the grid.

Filtering Destinations by Source
Filtering of items by their names has been described so far. The filtering is extended for 
Destinations to enable Destination names to be filtered by the names of the sources that are 
routed to them. The filter drop-down menu of the Destination Grid contains an extra item, 
for this, ‘Filter by Source’. 

1 In the Destination Grid, click on the Filter icon ( ) and select Filter by Source. 

b) Selected Item(s) Displayeda) Enter Search Term and Select

Filter search term List of names containing the search term (scrollable).
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Fig. 12-49: Filtering of Destinations by Source is Enabled

2 Enter a search term in the Filter text box.

Fig. 12-50: Filter Destinations by Source

3 Press the Enter/Return key to apply the filtering.

With the Filter by Source option selected, the Destination Grid will show only 
destinations which have a filter-matching source routed to them. 

Fig. 12-51: Example Destination ‘Filter by Source’

‘Filter by Source’ is selected

Filter search term.

Destinations shown have 
Source names matching the 
filter search criteria. 

Search term

‘Filter by Source’ is selected
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Preset Level Filters
The Source Level and Destination Level grids offer some preset filters to filter audio/video 
levels. For example, ‘Video, Audio 1 to 16’ which is for video and 16 audio channels. This 
preset filter is listed in the drop-down Filter items list, along with the names of the items 
(levels).

Custom Filters

What is a Custom Filter in a Bulk Routing Panel?
GV Orbit allows more complex and custom filters to be created. This can be done for any of 
the filterable grids/panes.

A custom filter can be:
• Created, given a name and saved. 
• Edited or deleted. 
• Re-named.

A custom filter is applied by entering the start of the custom filter name into the filter text 
box. The custom filter name will appear in the Filter items drop-down list for selection. 
Select the custom filter name to apply it.

Custom filters are stored in the GV Orbit Routing service for the currently-logged-in 
GV Orbit user. In this way, the filter will be available to the same user on other machines. 

What is a Custom Filter Rule?
Filter expressions can be defined and combined together to form complex filter conditions, 
filter rules. The filter rule of a custom filter is designed in a Filter dialog. 

Expressions can be combined to make rules by ANDing and ORing them together:
• AND - filter condition is met if both filter expressions are satisfied.
• OR - filter condition is met if either filter expression is satisfied.

Custom Filtering

Creating a Custom Filter
In a grid/pane:

1 Click on the Filter tool bar icon and select ‘Create Filter’.

An empty Filter dialog is shown. See Figure 12-52.

Note: Custom filters will not be seen by other users on other machines.
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Fig. 12-52: Filter Dialog

2 Enter a Filter name for the filter.

Fig. 12-53: Saving New Custom Filter

3 Click Save.

A new Custom Filter has been created.

Selecting a Custom Filter
A Custom Filter is listed in the drop-down Filter items list:

1 In the Filter text box, start to type the name of a Custom Filter.

The Filter items drop-down list contains the Custom Filter name.

Custom filter rule to 
be defined here.

Filter name entered
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Fig. 12-54: Custom Filter in Filter Items List

Constructing the Rules for a Custom Filter
See Filter Dialog and Custom Filter Rules, on page 556, for adding filter rules with the dialog 
to construct the filter.

To Edit an Existing Custom Filter
1 Click on the Filter tool bar icon and select Edit Filter.

Fig. 12-55: Select Custom Filter to Edit

2 Select the filter to edit from the list shown. (See Figure 12-55b.)

The Filter dialog is shown for the selected custom filter.

To Delete a Custom Filter
1 Click on the Filter tool bar icon and select Delete Filter.
2 Select the filter to delete from the list shown. 

Select a Custom Filter name

A Custom Filter name

a) Select Edit Filter name

b) Select which Custom Filter to Edit
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The filter is deleted when the selection is made.

Filter Dialog and Custom Filter Rules
The filter rule of a custom filter is designed in the Filter dialog (see Figure 12-56). A rule is 
formed from the logical combination of filter expressions. Expressions can be ANDed or 
ORed together and complex AND/OR configurations can be defined for a custom filter:

• AND - filter condition is met if both filter expressions are satisfied.
• OR - filter condition is met if either filter expression is satisfied.

A worked example is given (Example Custom Filter, on page 557) which shows how to 
construct Filter rules with the Filter dialog.

Fig. 12-56: Filter Dialog - Custom Filter Example

Logical AND / OR Combining

The Custom Filter being designed must be expressible in the form of a logical expression 
so that it can be captured in the Filter dialog.

A rule might be designed to filter:
• destination names that both start with a ‘C’ and contain a ‘6’.
• destination names that either end with a ‘4’ or end with a ‘5’.
• destinations whose source names start with ‘Cam’.

Custom Filter name (editable)

Logical AND/OR 
combination item

Click to save the custom filter and close the dialog.

Click to apply custom filter.

Select the target of
the expression,

(Destination) ‘Name’
or ‘Source’

Operator, see Table 12-3

Enter operand

Click to Add Expression item 
under an AND/OR item.

Click to Add AND/OR item 
under an AND/OR item.

Defines the logical 
AND/OR structure 

Delete AND/Or item and 
items beneath it.

Expression item

AND/OR item

Delete Expression item
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• destinations whose names end with a ‘X’ and whose source names are ‘Cam12’.

Filter Expressions

An expression tests a Destination Name or Source Name with an operator and an operand.

Filter Expression Operators
The operators include:

Example Custom Filter
This section explains What the Filter Should Do and Defining the Custom Filter Example via 
the Filter dialog.

What the Filter Should Do
“Display two destinations only if they have certain sources currently routed to them.“

(Destinations Mon1 and Mon2 and sources Cam1 and Cam2 are used in this example.)

The filter for this example may be written:

“Show a destination if the destination name is Mon1 or Mon2, and its routed source name 
is Cam1 or Cam2.”

This may be written out to show its logical expression structure.
Show a destination if the following is true:

 Table 12-3: Operators - Name/Source and Operand
Operation True when...

Equals Name matches.

Not Equals No match.

StartsWith Starts with the operand.

EndsWith Ends with the operand.

Contains Contains the operand.

NotContains Does not contain the operand.

Greater Than Numerical part of name is greater than the operand.

Less Than Numerical part of name is less than the operand.

GreaterThanEqual Numerical part of name is greater than or equal to the operand.

LessThanEqual Numerical part of name is less than or equal to the operand.
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Defining the Custom Filter Example
This example Custom Filter filter may be entered into the Filter dialog as follows:

1 Click on the Destination Grid’s Filter tool bar icon and select Create Filter.

An empty Filter dialog is shown. See Figure 12-52 on page 554.
2 Enter a Filter Name for the filter.
3 Select AND as the first (top-level) logical combination item with the drop-down menu 

button. See Figure 12-57.

Fig. 12-57: Select AND

4 Click the Add AND/OR icon. 

An indented AND/OR item appears. 
An expression item also appears below the OR. See 
Figure 12-58.

5 Select OR as the new, indented logical combination item. 

Fig. 12-58: Select OR

6 Click the new Add Expression icon. 

A second expression item appears 
under the OR. See Figure 12-59.

Destination name is Mon1 

OR 

Destination name is Mon2

AND

its routed Source name is Cam1

OR

its routed Source name is Cam2

Filter Name entered

Expression item
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Fig. 12-59: Added a Second Expression Item

7 Click the first Add AND/OR icon again. 

This add a second OR logical combination item 
indented under the AND. See Figure 12-60.

Fig. 12-60: Second OR Logical Combination Item Added

8 Add a second expression item under the new OR item. See Figure 12-61.

Fig. 12-61: Second Expression Item Added

The basic ‘AND-OR-OR’ logical combination structure for the example has now been 
entered for the Filter rule.

The next step completes the expression item and saves the filter:
9 Set up the expressions as shown in Figure 12-62. 

Second expression item

Operator
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Fig. 12-62: Completed Custom Filter

10 Click Save in the Filter dialog to save the custom filter and close the dialog.

Custom filter rules have been entered; the Custom Filter has been created, ready to use. 
See Using a Custom Filter.

Using a Custom Filter
To use the custom filter ‘My Custom Filter 1’:

1 Start entering the custom filter name into the Filter text box. 
(‘My’ in this example.) A list of possible matching custom filters is presented. 

Fig. 12-63: Select Custom Filter

2 Select the ‘My Custom Filter 1’ item.

The filter is applied. 
In this example, only destinations ‘Mon1’ or ‘Mon2’ are shown if they have sources 
‘Cam1’ or ‘Cam2’ routed to them. See Figure 12-64.

Filter Name

Expressions
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Fig. 12-64: Applied Custom Filter

To clear the filtering: 
3 Click on the Filter tool bar icon and select Clear Filter.

Salvos 

What is a Salvo? 
Salvos are created and defined in Grass Valley’s GV Orbit product and are available to the 
Bulk Routing Panel through the GV Orbit Routing service that the Bulk Routing Panel is 
connected to.

Salvos are shown in the Salvos pane of the Bulk Routing Panel. The list of Salvo names can 
be filtered using the tool bar controls. Filters can be set up in a similar way to the other 
grids/panes of the Bulk Routing Panel.

Fig. 12-65: Salvos Pane with Salvo Buttons

Executing Salvos

To Execute a Salvo
Either:

• double-click on the Salvo button; 

or, 
• select the Salvo button (single-click) and click Take. 

(The Custom Filter displays only destinations
‘Mon1’ and ‘Mon2’ - which happen to be locked.) 
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To Execute multiple Salvos
1 Select the first Salvo.
2 Select other Salvos with CTRL-click. 
3 Press Take.

Hide Sources

What is the Hide Sources Mode?
In Hide Sources mode, the Source Selection and Source Level Selection grids may be 
hidden from view. Thus more destinations are displayed. 

The Hide Sources icon in the Destination Grid’s tool bar enables this mode.

Fig. 12-66: Hide Sources Icon in Destination Grid Tool Bar

Enter Hide Sources Mode
Toggle Hide Sources on/off by:

• Click the Hide Sources icon in the Destination Selection grid tool bar.

The Bulk Routing Panel hides the Sources and more Destinations are shown. See 
Figure 12-67b on page 563.

Routing in Hide Sources Mode
Use the Dial Source or Dial Source-Level facility to route source signals and/or levels to 
destinations. See Dial Source Dialog, on page 526 and Dial Source-Level Dialog, on 
page 527.



563

GV Orbit Version 2.3.0 Routing Control - Bulk Routing Panel
User Guide Routing in Hide Sources Mode

Fig. 12-67: Bulk Routing Panel: 
a) Sources and Destinations Shown; 
b) Hide Sources.

b) Hide Sources

a) Sources Shown
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List View

What is List View Mode?
List View is a level-centric view of a Bulk Routing Panel, allowing a user to focus on routing 
to Destination Levels. List View hides Sources and Source Levels and presents all of the 
destinations in a ‘list’ format; each list item is a Destination with all of its Levels.

Figure 12-68a shows a normal Bulk Routing Panel view and Figure 12-68b shows a List 
View.

Fig. 12-68: Bulk Routing Panel: a) Normal View; b) List View

a) Normal Bulk Routing Panel View

b) List View
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Focus between the Destination and Destination Levels sections can be moved with the 
CTRL-Cursor-arrow-keys, as usual. Focus is shown with a thin blue bounding box.

List View Tool Bar
The List View tool bar is an amalgamation of the tool bars of the normal Destination pane 
and Destination Level grid of a Bulk Routing Panel. Icons may be grayed-out according to 
panel focus. See Figure 12-69.

Fig. 12-69: List View Tool Bar

Destination Filtering
There are two filter boxes and these are for: Destination filter and Destination Level filter. 
See Figure 12-69. List View presents all of the destinations in a scrollable list. To aid 
selection of destinations and levels, and navigation of the list, the filter facility can be used 
to limit what is listed:

• Destination filtering may be done by name or by their routed Source. 
• Destination Level filtering may be done by Level name. 

See Filtering, on page 547, for more information about using the filter facility. 

A filter may be invoked by pressing CTRL-F according to where your panel focus is. In List 
View, with panel focus on:

• the Destination column, then CTRL-F invokes Destination filter; or on
• the Level grid, then CTRL-F invokes Destination Level filter.

Selection in List View

Select a Destination
1 Click on a Destination. 

(Or move focus to the level with the cursor keys and press Space-Bar.)

All of the destination’s levels are automatically selected.

Icons, some may be grayed-out depending on panel focus.

Two filter boxes, 
for Destination filtering and Destination Level filtering
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Fig. 12-70: Select a Destination

Select Multiple Destinations
1 Click on a Destination to select it. 

(Or move focus onto the Destination with the cursor arrow keys and press the Space-
Bar key.)

2 CTRL-click to add other Destinations.
(Or focus on another Destination and press CTRL-Space-Bar.)

Alternatively or additionally, SHIFT-select can be used when selecting a range.

Select a Destination Level
1 Click on a Destination Level.

The Level is selected and the Destination is selected automatically. No other Levels are 
selected.
e

Fig. 12-71: Select a Destination Level

Select Multiple Destination Levels

CTRL-Selecting
1 Select a Destination Level.
2 CTRL-Select other Levels to add further Levels to the selection.

Select a Destination, then all Levels are selected

Select a Level, then the Destination is selected.



567

GV Orbit Version 2.3.0 Routing Control - Bulk Routing Panel
User Guide Selection in List View

Fig. 12-72: Select Multiple Destination Levels

SHIFT-Selecting a Range of Destination Levels

To select a range of Levels:
1 Select the first Level in the range. 

(Move button focus onto a Level and click on it, or press Space-Bar.)
2 SHIFT-Select the last Level in the range.

(To move focus from the first Level to the last, use the mouse or use SHIFT-cursor-
left/right arrow keys. To select, click or press Space-Bar.)

Levels from the first to the last are selected.

Fig. 12-73: Select a Range of Destination Levels

SHIFT-Selecting a Block of Destination Levels

A block of Levels may be selected. This is similar to selecting a range, but it goes across 
more than one destination. To select a block of Levels:

1 Select the first, ‘top-left’ Level in the block.
2 SHIFT-Select the last, ‘bottom-right’ Level in the block.

Levels from the first selection to the last in a block are selected.

Select a Level, then CTRL-Select others.

Select the first Level, then SHIFT-Select the last.
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Fig. 12-74: Select a Block of Destination Levels

Selecting Source and/or Source Level
Source and Source Level selection is done via the Dial Source and Dial Source-Level dial-
up dialog facility. After the required Destination(s) or Destination Level(s) are selected type 
in an alpha-numeric character to open one of the dial-up dialogs. (See Dial Source and Dial 
Source-Level Dialogs, on page 525.)

For normal routing operation in List View mode, only a single Source or a Single Source 
Level can be selected.

Routing in List View
Routing in List View is done by selecting a Destination (and Levels) and then selecting a 
Source and Source Levels via the Dial Source and Dial Source-Level facility. (See Dial 
Source and Dial Source-Level Dialogs, on page 525.) 

Some Routing examples are provided, see:
• Routing Examples - ‘All Levels’, on page 568.
• List View Routing Examples - One-Level, on page 570.
• List View Routing Examples - Destination Copy-Paste, on page 575.
• List View Routing Examples - Copy-Paste Levels, on page 577.

A brief summary of these examples is found at List View Routing Summary, on page 581.

Routing Examples - ‘All Levels’
Several routing examples are presented:

• Simple Route, One Source to One Destination (‘All-Levels’).
• One Source to Multiple Destinations (‘All-Levels’).

Routing utilizes the Dial Source and Dial Source-Level Dialogs.

Simple Route, One Source to One Destination (‘All-Levels’)
To make a simple ‘all-levels’ route in List View:

1 Select a Destination.

Select the first, ‘top-left’ Level, then SHIFT-Select the last, ‘bottom-right’.
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Fig. 12-75: Destination Selected

2 Begin to type a Source name, for example, ‘S10-’.

A Dial Source dialog appears. Source names are listed in the dialog and are filtered on 
the typed text. See Figure 12-76.

Fig. 12-76: Dial Source Dialog

3 Continue to type in (‘dial-up’) a Source Name and press Return; and/or select the 
required Source name from the filtered Source list in the Dial Source dialog. For 
example, ‘S10-22’.

An ‘all-levels’ route is made to the selected Destination.

Filtered Source ListTyped in text

New source is routed to the destination, all levels.
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Fig. 12-77: Routed All-Levels

An ‘all-levels’ route has been made.

One Source to Multiple Destinations (‘All-Levels’)
To make a simple ‘all-levels’ route from one Source to multiple Destinations:

1 Select the first Destination.
2 CTRL-Select and/or SHIFT-Select other Destinations.

When all Destinations have been selected:
3 Begin to type a Source name, for example, ‘S10’.

A Dial Source dialog appears. Source names are listed in the dialog and are filtered on 
the typed text. 

4 Proceed to ‘dial up’ a Source name, as described in Simple Route, One Source to One 
Destination (‘All-Levels’).

5 Select a Source to make the route.

An ‘all-levels’ route is made to multiple Destinations.

List View Routing Examples - One-Level
Several routing level-based examples are presented:

• Simple One-Level Route (Breakaway).
• One-Level Shuffle.
• One Level to Multiple Levels.

Simple One-Level Route (Breakaway)
To make a ‘one-level’ route in List View:

1 Select a Destination Level.

Fig. 12-78: Destination Level Selected

The corresponding Destination is also selected.
2 Type a single alpha-numeric character. 

A default Dial Source-Level dialog appears. User focus is in the (upper, Source-name) 
text entry box. The dialog shows the currently-routed Source name and Level.

3 Begin to enter a new Source name into the upper text entry box, for example, ‘S11-’.

Source names are listed, filtered on the typed text. See Figure 12-79.
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Fig. 12-79: Select a Source Name

4 Either:
• select the required Source name in the filtered list; or
• finish entering the Source name into the dialog and press Enter.

A ‘one-level’ route is made to the selected Destination Level from the selected Source, 
on the same Level. This forms a Breakaway.

Fig. 12-80: One Level Routed from a Different Source, Breakaway

A one-level, breakaway, route has been made.

One-Level Shuffle
A shuffle is similar to a breakaway and, in List View mode, is routed is a similar way to 
Simple One-Level Route (Breakaway). 

Select a Source, or type in the name fully and press Enter.

Note: When a Dial Source-Level dialog first appears, it shows the 
currently-routed Source and Level. For a Shuffle, the Source name 
simply needs to remain the currently-routed Source.
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(Refer to What is a Breakaway?, on page 538, and What is a Shuffle?, on page 542, for 
general information.)

To do a one-level route:
1 Select a Destination Level.

The corresponding Destination is also selected.
2 Type a single alpha-numeric character. 

A default Dial Source-Level dialog appears. User focus is in the (upper, Source-name) 
text entry box. The dialog shows the currently-routed Source and Level.

Note: The default dialog already shows the currently-routed Source name and Level 
name, regardless of the single alpha-numeric character typed.

3 Press the Tab key.

In the dialog, user focus changes from the (upper Source name) text entry box to the 
(lower, Source-Level-name) text entry box. 

4 Either:
• begin to type in a (new) Source Level name and then select the required Source 

Level in the list (by clicking on it, or by highlighting the Level and pressing the 
Enter key); or 

• fully type in the Source Level name (for example, ‘A2’) and press the Enter key.

A ‘one-level’ route is made from the selected |Source Level to the selected Destination 
Level, which forms a one-level Shuffle in this case.

A one-level shuffle route has been made.

Channel-Swap Shuffle
To do a channel-swap in List View, carry out two One-Level Shuffle routes. See Figure 12-81.
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Fig. 12-81: Forming a Channel-Swap Shuffle: 
a) Before any one-Level routing;
b) After first one-Level route;
c) After second one-Level route.

One Level to Multiple Levels
To route one Source Level to multiple Destination Levels:

1 Select a Destination Level.
2 CTRL-Select and/or SHIFT-Select other Destination Levels. 

(Note: These Levels do not have to belong to the same Destination.)

Figure 12-82a gives an example of multiple selected Destination Levels.

This has selected the Destination Levels required. 
Then:

3 Type a single alpha-numeric character. 

A default Dial Source-Level dialog appears. User focus is in the (upper, Source-name) 
text entry box. The dialog shows the currently-routed Source and Level.

Note: The default dialog already shows the currently-routed Source name and Level 
name, regardless of the single alpha-numeric character typed.

a) Before one-Level routing

b) After first one-Level route

c) After second one-Level route

Routed-Source’s channel A3 is routed to Destination’s Channel A2

Routed-Source’s channel A2 is routed to Destination’s Channel A3, and vice versa
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4 Dial-up a Source Level with the Dial Source-Level dialog, see Simple One-Level Route 
(Breakaway) and make a one-Level route to all selected Destination Levels.

Figure 12-82b shows an example with Figure 12-82c showing the resulting route made.

Fig. 12-82: One Level to Multiple Levels: 
a) Multiple Selected Destination Levels; b) Dialing Up the Source Level;
c) Routed Levels.

a) Multiple Selected Destination Levels

b) Dialing Up the Source Level

c) Routed Levels
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List View Routing Examples - Destination Copy-Paste
With Copy-Paste routing, the Source assignments of a Destination (that is, the current 
routing to all the Levels of a Destination) can be copied to other Destinations. Alternatively, 
the routing to just one or more Destination Levels can be copy-pasted to other Destination 
Levels.

Several routing Copy-Paste examples are presented:
• Destination Copy-Paste.
• Destination Paste-Series.

Destination Copy-Paste
The routing to a Destination can be copied to one or more other Destinations. This operates 
on all levels and allows a routing to be quickly copied to other Destinations:

1 Select a Destination. (See Figure 12-83a.)
2 Copy the Destination by, either:

• CTRL-C; or
• right-click and select ‘Copy’; or 
• click on the ‘Copy’ icon in the List View tool bar.

The selected Destination (with its Levels) is outlined with a ‘crawling’ dashed line. (See 
Figure 12-83b.)

Fig. 12-83: Destination Copy-Paste: a) Selected Destination; b) Destination Copied.

3 Select a Destination to ‘copy to’. (See Figure 12-84.)

a) Selected Destination 

b) Destination Copied
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Fig. 12-84: ‘Copy’To’ Destination Selected

4 If required, 
further ‘copy-to’ Destinations can be added to the selection with CTRL-Select and/or 
SHIFT-Select.

When all ‘copy to’ Destinations are selected, to paste the ‘copied’ Destination’s routing to 
the selection:

5 Paste the ‘copied’ Destination’s routing to the selection by either:
• pressing CTRL-V; or
• right-click and select ‘Paste’; or
• click the ‘Paste’ icon in the List View tool bar.

The routes are made (all levels) and the original copied Destination’s routing is applied 
(pasted) onto all the selected Destination(s). (See Figure 12-85.)

Fig. 12-85: Routing Pasted onto a Destination

Destination Paste-Series
Destination Copy-Paste applies the copied Destination into all of the selected ‘Copy to’ 
Destinations. Alternatively, a series of sources can be applied to several selected ‘Copy to’ 
Destinations. The series starts from the ‘Copied’ Destination’s currently-routed Source and 
the Source increments.

The operation is similar to Destination Copy-Paste. To paste a series onto a selection of 
‘Copy to’ Destinations:

1 Select a Destination and copy it.
2 Select a first ‘Copy to’ Destination and select a range of these by SHIFT-Selecting the 

last ‘Copy to’ Destination.

This has selected the ‘Copy to’ range.
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At this point (with a Destination copied and several ‘Copy to’ destinations selected) a 
normal ‘paste’ would result in the copied routing being applied to all ‘Copy to’ Destinations. 
But, instead, to Paste Series:

3 Press Alt-CTRL-V, or click the Paste Series icon in the List View tool bar.

The currently-routed Source of the copied Destination is applied to the first ‘Copy to’ 
Destination in our ‘Copy to’ range. The next Source is applied to the next ‘Copy to’ 
Destination in the range, etc. See Figure 12-86 for an example.

Fig. 12-86: Result of Destination Paste-Series

List View Routing Examples - Copy-Paste Levels
The routing to one or more selected Destination Levels can be copied and pasted onto 
other Destination Levels. This allows a user to set up levels quickly on one or more 
Destinations.

The copy-paste is a two-step process:
1 Copy - Destination Levels are selected and copied.
2 Paste - A paste ‘starting Level’ is selected and pasting is done from this ‘starting Level’. 

With more than one Destination Level copied, the pasting of routing onto ‘Copy to’ 
Destination Levels can be done in two ways:

• Paste Levels with CTRL-V - pastes with no gaps.
• Paste Levels with Alt-CTRL-R - pastes preserving gaps.

Both paste types are done in the Levels grid from the ‘starting Level’. 
When pasting to more than one ‘starting Level’, a warning is given if there are any pasting 
conflicts. See Levels Copy-Paste Footprint and Levels Paste Warning.

Paste Levels with CTRL-V
1 Select Destination Levels and copy them. For example, A3, A4, A6 and A8, see 

Figure 12-87.

This has copied the routing of these selected Destination Levels.

Currently-routed 
Source of the 
copied Destination

Currently-routed 
Source applied to 
first ‘Copy to’ 
Destination.

Next Source 
applied to next 
Destination.

And so on.
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2 Select one ‘Copy to’ Destination Level. This is the ‘starting Level’.
And click the Paste icon, or press CTRL-V, or select right-click ‘Paste’.

Routes are made to consecutive Destination Levels and the copied routing is applied to 
the ‘Copy to’ Destination Level and to subsequent, consecutive Destination Levels. 
See Figure 12-87 for the result of CTRL-V paste from the copied Destination Levels.

Fig. 12-87: Result of CTRL-V Paste

Paste Levels with Alt-CTRL-R
The CTRL-V pasting pastes into consecutive Destination Levels and ignores any gaps there 
might be in the original copied Levels. Whereas, pasting with Alt-CTRL-R retains the 
original copied Levels pattern, preserving any gaps in the original pattern. Pasting is still 
done from a ‘starting Level’.

To paste and preserve gaps:
1 Select Destination Levels and copy them. For example, A3, A4, A6 and A8, see 

Figure 12-88.
2 Select one ‘Copy to’ Destination Level. This is the ‘starting Level’.

And press Alt-CTRL-R.

Routes are made and the routing of the copied Levels is applied to the ‘Copy to’ Destination 
Level (‘starting Level’) and to subsequent Levels with any gaps preserved. See Figure 12-88 
for the result of an ALT-CTRL-R paste from the two copied Destination Levels.

One selected ‘Copy to’ Level,
‘starting Level’

Selected Destination Levels

Routes made to consecutive Levels
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Fig. 12-88: Result of Alt-CTRL-V Paste

Levels Copy-Paste Footprint
The copied Levels pattern and the pasting type determine a pasting ‘footprint’ in the List 
View Levels grid. The pasting footprint pattern

• retains or ignores any gaps in the copied Levels pattern, depending on pasting type 
(CTRL-V or Alt-CTRL-R);

• is applied in the List View Levels grid and is based at each ‘starting Level’ in turn, 
starting with the first ‘starting Level’. 
(Note: It is possible to select more than one ‘starting Level’.) 

Figure 12-89 shows 2x1 copied Levels pasted with various ‘Copy to’ starting Levels. In 
Figure 12-89d, the pasting footprints overlap.

• Figure 12-89a - Single starting Level and a resulting 2x1 pasting.
• Figure 12-89b - One column of four starting Levels which result in four 2x1 pasting 

footprints.
• Figure 12-89c - Two columns of four starting Levels which result in two columns of four 

2x1 pasting footprints, which do not overlap.
• Figure 12-89d - Two adjacent columns of four starting Levels which results in two 

columns of four 2x1 pasting footprints which do overlap. The overlap is warned with a 
pop-up Levels Paste message, see Levels Paste Warning.

One selected ‘Copy to’ Level, 
‘starting Level’

Selected Destination Levels

Routes made to Levels and the original copied pattern is retained, gaps are preserved.
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Fig. 12-89: Example Level Pasting

Levels Paste Warning

For a Levels Copy-Paste operation which has more than one ‘starting Level’, if the 
operation will result in overlapping paste footprints (see Figure 12-89d), a Levels Paste 
warning pops up. See Figure 12-90. 

Fig. 12-90: Level Paste Warning

You can choose to not paste, or to paste anyway, in which case the paste footprints are 
applied sequentially, starting with the first ‘starting Level’ in the selection. If there is 
overlap, then some of the Levels Copy-Paste routing may be overwritten. The later routing 
wins.

Copied Levels, a ‘2x1’ shape.

b) c) a) Single starting Level and 
resulting ‘2x1’ pasting.

d) 
Paste footprint overlaps
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List View Routing Summary

List View Routing Summary - All-Levels 
One Source to One Destinations One Source to Multiple Destinations 

To make: An ‘all-levels’ route to a destination: An ‘all-levels’ route to multiple destinations:

1 Select a single Destination. Select a Destination. 

2 - Select further with CTRL-Select and/or 
SHIFT-Select.)

3 Begin to type a Source name.

A Dial Source dialog appears. 

4 Proceed to ‘dial up’ a Source name.

5 Then either:
• select the typed-in Source by pressing Enter/Return;

and/or:
• select a Source from the Dial Source filtered source list. 

Result: An ‘all-levels’ route is made to the 
destination.

An ‘all-levels’ route is made to the 
destinations.

List View Routing Summary - One-Level 
Simple One-Level (Breakaway) Simple One-level (Shuffle)

To route: One level from another source: One level from same destination.

1 Select a single Destination Level.

2 Type a single alpha-numeric character. 

A default Dial Source-Level dialog appears showing currently-
routed Source and Level.

3 Begin to enter a new Source name into the 
dialog’s upper text entry box.

Press the Tab key. 

User focus changes to the lower text entry 
box in the dialog, for Source Level entry.
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4 Then in the dialog, either:
• select the required Source name; 

or
• finish entering the Source name 

and press Enter/Return.

Then in the dialog, either:
• begin to type in a (new) Source 

Level name and then select the 
required Source Level in the list; 

or 
• fully type in the (new) Source Level 

name (for example, ‘A2’) and press 
the Enter/Return key.

Result: A one-level, breakaway route has been 
made. (For a channel-swap, do 2x Simple 
One-level (Shuffle) ).

A one-level, shuffle route has been made.

List View Routing Summary - One-Level  (continued)
Simple One-Level (Breakaway) Simple One-level (Shuffle)

One Level to Multiple Levels 
To route: One level to multiple destination levels:

1 Select a Destination Level.

2 And select further with CTRL-Select and/or SHIFT-Select. 

3 Type any single alpha-numeric character. 

A Dial Source-Level dialog appears showing currently-routed Source and Level.

4 Press the Tab key. 

User focus changes to the lower text entry box in the dialog. 

5 Then, either:
• begin to type in a (new) Source Level name and then select the required 

Source Level in the list; or 
• fully type in the (new) Source Level name (for example, ‘A2’) and press the 

Enter/Return key.

Result: A one-level route is made to all selected Destination Levels.

List View Routing Summary - Destination Copy 
Destination Copy-Paste Destination Paste-Series

To: Copy a Destination’s Source-assignments to 
another Destination:

‘Copy-Paste’ a series of Destinations:

1 Select a single Destination. 
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2 Either:
• type CTRL-C; or 
• right-click ‘Copy’; or 
• click on the ‘Copy’ icon in the List View tool bar.

The Destination’s routing (all levels) is 
‘copied’ and is outlined with a ‘crawling’ 
dashed line. 

The Destination is copied. 

3 Select a Destination to ‘copy to’. Select the first Destination in the range to 
‘copy to’.

4 (Optionally, select further ‘copy-to’ 
Destinations with CTRL-Select and/or 
SHIFT-Select.)

SHIFT-Select the last Destination in the 
range to ‘copy to’. 
This has selected the ‘Copy to’ range.

This has selected the ‘Copy to’ range.

5 Either:
• press CTRL-V; or 
• right-click ‘Paste’; or 
• click the ‘Paste’ icon in the List View 

tool bar. 

Then either:
• press Alt-CTRL-V; or
• click the Paste Series icon in the 

List View tool bar.

Result: The ‘copied’ routing (all levels) is pasted to 
the selected Destination(s).

The currently-routed Source of the copied 
Destination is applied to the first 
Destination in our ‘Copy to’ range. The next 
Source is applied to the next Destination in 
the ‘Copy to’ range, etc. 

List View Routing Summary - Destination Copy  (continued)
Destination Copy-Paste Destination Paste-Series

List View Routing Summary - Paste Levels
Paste Levels with CTRL-V Paste Levels with Alt-CTRL-R

To: Copy multiple Destination Levels’ routing 
and to consecutive Destination Levels with 
no gaps

Copy multiple Destination Levels’ routing 
and to Destination Levels.with gaps.

1 Select a Destination Level. 

2 Select further with CTRL-Select and/or SHIFT-Select.

3 Then either:
• press CTRL-C; or 
• right-click ‘Copy’; or 
• click on the ‘Copy’ icon in the List View tool bar. 

The routing of the Destination Levels is copied along with the 
pattern of levels. 
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GV Orbit Custom User Panels

Can a Bulk Routing Panel be Opened from a Custom User Panel?
The Bulk Routing Panel may be opened from a GV Orbit custom user panel (created as part 
of a GV Orbit control and monitoring, C&M, project). 

When the custom user panel is designed, a ‘Load Panel’ GV Orbit Routing Behaviour is used 
to invoke the Bulk Routing Panel when the custom user panel is run.

Typically, this GV Orbit ‘Behaviour’ would be invoked upon the press of a button on an 
GV Orbit C&M project custom user panel.

See:
• Amend an Existing GV Orbit C&M Project
• Exercise the C&M Custom Screen

Amend an Existing GV Orbit C&M Project
To prepare a GV Orbit C&M project to be able to open a Bulk Routing Panel:

1 Open/create a GV Orbit C&M project.
2 In the main menu, click on Control and Monitoring > Connections > GVOP and set the 

Client Domain to a domain with an GV Orbit Routing Service running.
3 Create a New Screen. For example, in the Project window: expand the project item, 

right-click on ‘screens’, and select ‘New Screen’, enter a name, and click OK.

A new blank C&M project screen opens as a tabbed screen.
4 In the new C&M project screen, add a Button widget. For example, drag on a Button 

widget from the widget icons along the bottom edge of the GV Orbit Client application 
window.

5 Edit the Button widget’s Caption property. See Figure 12-91.

4 Select one ‘Copy to’ Destination Level (the ‘starting level’). 

5 And then either:
• click the Paste icon; or
• press CTRL-V; or 
• select right-click ‘Paste’.

And press Alt-CTRL-R

Result: The copied routing is applied to the ‘Copy 
to’ Destination Level (‘starting level’) and to 
subsequent, consecutive Destination 
Levels. Any gaps in the copied pattern are 
not preserved.

The copied routing is applied to the ‘Copy 
to’ Destination Level (‘starting Level’) and 
to subsequent Levels with any pattern gaps 
preserved. 

List View Routing Summary - Paste Levels (continued)
Paste Levels with CTRL-V Paste Levels with Alt-CTRL-R



585

GV Orbit Version 2.3.0 Routing Control - Bulk Routing Panel
User Guide Amend an Existing GV Orbit C&M Project

Fig. 12-91: C&M Project Screen with Button Widget

6 Select the Button widget on screen.
7 Click on the Edit Behaviours button. 

The ‘Behaviour and Bindings’ graphical editor is shown. See Figure 12-92.

In the ‘Behaviour and Binding’ graphical editor:
8 Select to show ‘Routing’ Behaviours and click on the ‘Load Panel’ item. 

A Load Panel Behaviour and a configured Click Handler Binding is automatically 
placed into the graphical editor. 
See Figure 12-92.

Project item expanded in Project window Edit Behaviours button

Button widget icon Set Button widget’s Caption property

Button widget on screen
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Fig. 12-92: Behaviour and Bindings Graphical Editor

9 Double-click on the added Load Panel Behaviour.

The Behaviour’s configuration screen is shown in the graphical editor.

In the Network window:
10 Expand and locate the Routing service of the GV Orbit Server being used. 
11 Right-click on the Routing service item and select ‘Copy > Address’.

This copies the RollCall address of the Routing service.

In the graphical editor:
12 Paste the copied address into the ‘Address’ property of the Load Panel configuration.

See Figure 12-93.

Select ‘Routing’

Select ‘Open Panel’ item (single-click) to add a Load Panel Behaviour.

‘Behaviour and Binding graphical editor’
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Fig. 12-93: Setting Load Panel Behaviour’s RollCall Address

13 Click Close in the configuration screen.

To save this project change:
14 Click Project > Save File in the main menu
15 Click Project > Save Project.

This has designed (a simple) C&M custom screen which contains a button which will open 
the Bulk Routing Panel.

Exercise the C&M Custom Screen
With the designed C&M custom screen open in GV Orbit Client:

Right-click on a ‘Routing Service’ item in the Network window.

Select ‘Copy > Address’.

Paste the address into the ‘Address’ property of the Load Panel configuration screen.

Click Close in the Load Panel configuration screen.
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1 Click the Design/Run Mode button in the main tool bar of the GV Orbit Client 
application window. See Figure 12-96a.

Fig. 12-94: Design/Run Mode Icon (in Main Tool Bar)

The GV Orbit Client enters Run mode and the custom screen is run. See Figure 12-96b.

Fig. 12-95: Running the Custom Screen

2 Click on the Button widget to open a new tab containing an Bulk Routing Panel. See 
Figure 12-96.

Click to enter Run mode.

Click to enter Design mode.

Design/Run Mode icon indicates GV Orbit is in Design mode.

a) Click to Enter Run Mode

b) Screen is running.

Click on the Button widget to open the Bulk Routing Panel.

Design/Run Mode icon indicates GV Orbit is in Run mode.
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Fig. 12-96: Bulk Routing Panel Opened in a Tab

Tab running C&M Custom Panel Tab running the opened Bulk Routing Panel
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13Routing Control - XY Routing Panel

Introduction
GV Orbit Client has user router control functionality and offers the following routing control 
panels:

• Routing Control - Bulk Routing Panel - a simple, non-editable soft panel for fast control 
of all router cross-points. 

• Routing Control - XY Routing Panel (this chapter) - an editable and customizable soft 
panel, typically used for small custom panels for specific routing needs.

This chapter describes the XY Routing Panel.

GV Orbit System
Routing control panels connect to a GV Orbit Routing service running on a GV Orbit Server.

Fig. 13-1: GV Orbit Routing Panel, Routing Service and Router Controller

A GV Orbit system has one or more GV Orbit Servers which run GV Orbit services. Routing 
panels in a GV Orbit Client connect to a router controller device via the GV Orbit Routing 
service. Router controllers include GV Orbit itself, a Grass Valley Router Controller device, or 
GV Convergent. The Routing service provides source/destination information to the client 
and acts on routing commands from the client. See Figure 13-2.

GV Orbit Client 

GVOP protocol

Controller-specific connection protocol: 
• SW-P-08; or
• NP-0017

GV Orbit Server

GV Orbit Routing Panel
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Fig. 13-2: GV Orbit System Diagram 

Prerequisites
A GV Orbit Server is required, running:

• A GV Orbit Control application.
• A GV Orbit Routing service configured for connection to a Router Controller using 

either NP0017 or SW-P-08 protocol.

What is an XY Routing Panel?
An XY Routing Panel runs in the GV Orbit Client application. It is editable and customizable 
and is typically used for small, purpose-built routing panels for specific routing needs. It can 
be part of a custom soft user/operator panel in GV Orbit Client. 

It can be created with a wizard and tailored to most needs. It is a flexible soft routing control 
panel which may be:

• Created with a wizard and used.
• Created and then edited for customized use.
• Created from scratch with the GV Orbit Client, in a similar way to a GV Orbit Client C&M 

project user/operator soft control panel.

XY panels can also be embedded in GV Orbit soft custom operator/user panels. 
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Fig. 13-3: XY Routing Panel Examples

Key Features

a) Example XY Routing Panel from the Wizard

b) Example Customized XY Routing Panel c) Example with Customized Layout

• X/Y panel wizard.
• Source and Destination filtering.
• Take, Auto-take, Cancel.
• Shuffles and Breakaways.
• Panel Lock.

• Customizable, editable.
• Source and Destination selection:

• paged access to all ports; or
• definable port-per-button.
• Levels
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This Chapter
This chapter describes:

• How to Create a New XY Panel, on page 594.
• Customizing with the XY Wizard, on page 597.
• XY Panel Layout, on page 602.
• Getting XY Routing Panel Running, on page 610.
• XY Panel Operation, on page 614.
• Assigning Ports to a Port-per-Button XY Panel, on page 621, including:

• Assigning Port-per-Button, on page 621.
• Assign Ports to Individual Buttons, on page 621.
• Quick Port-per-Button Assignment, on page 625.

• Customizing an XY Panel, on page 628, including:
• Further Editing an XY Panel, on page 628.
• Creating a Custom XY Panel from Scratch, on page 629.
• Creating a Custom BPX Panel, on page 637.
• Enhancing the Appearance of a Panel, on page 643.

• How to Embed an XY Panel into a Custom User Panel, on page 650.

How to Create a New XY Panel
One or more XY Routing Panels can be created in a GV Orbit C&M project.

XY Routing Panels are created in GV Orbit Client and stored in a ‘panels’ folder in the 
Project window. (If your project does not contain a ‘panels’ folder, see Creating a ‘panels’ 
Folder for Early GV Orbit Client Projects, on page 594 for instructions on creating one.)

For instructions on creating a new XY Panel, see Create a New XY Routing Panel, on 
page 595.

Creating a ‘panels’ Folder for Early GV Orbit Client Projects
Some early GV Orbit C&M projects do not contain a ‘panels’ folder in the Project window. If 
this is the case, then one may be created. See below.

If your project does have a ‘panels’ folder in the Project window, go on to Create a New XY 
Routing Panel, on page 595.

To create a missing ‘panels’ folder:
1 Open a C&M project in the GV Orbit Client application.
2 Right-click on the project name item in the Project window and select ‘New Folder’.

Fig. 13-4: Creating a New ‘panels’ Folder’
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3 Enter ‘panels’ as the folder name, and click OK.

A new folder called ‘panels’ is added into the Project window.

Fig. 13-5: New ‘panels’ Folder’

4 Click Save File. Click Save Project.

This has created a default new ‘panels’ folder in the project. 
Now go on to Create a New XY Routing Panel, on page 595.

Create a New XY Routing Panel
To create an XY panel in a C&M project in the GV Orbit Client application:

1 Expand the project name in the Project window and look for the ‘panels’ sub-folder. 
2 Right-click on the ‘panels’ folder and select ‘New Panel’.

Note: A project folder named ‘panels’:
• allows only files of type ‘panel’;
• displays a ‘New Panel’ right-click menu item.

The folder name is case-sensitive.
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Fig. 13-6: Create a New XY Routing Panel

The New X/Y Panel dialog is shown.
3 Enter a name for the new XY Panel in the New X/Y Panel dialog. 
4 And click OK.

A new panel item is then added into the ‘panels’ folder and a new generic XY Panel is 
shown in a tab.
Figure 13-7 shows an example with GV Orbit shown in ‘Design Mode’ (not ‘Run Mode’).

5 Click Save File. Click Save Project.

This has created a default new, generic XY Panel (see example in Figure 13-7) which is 
editable and customizable, see Customizing with the XY Wizard, on page 597. Various 
button types can be shown/hidden on the panel with the wizard.
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Fig. 13-7: Example New Generic XY Routing Panel

Customizing with the XY Wizard
A default new, generic XY Panel can be created which is editable and customizable. See 
How to Create a New XY Panel, on page 594. When an XY Panel is open in GV Orbit Client, 
the panel is editable with the client in ‘Design Mode’ (rather than in ‘Run’ mode). 

Customizing may be done with the XY Wizard and editable items include the:
• panel size
• number of and arrangement of Sources/Destinations 
• number of and arrangement of Levels
• enabling/disabling of other controls

Use the XY Wizard on new, generic XY Panels.

To Open the XY Wizard
To open the XY Wizard for an XY Panel:

1 Open the XY Panel and go to ‘Design’ mode in GV Orbit Client.
2 Click XY Wizard button. See Figure 13-8. 

GV Orbit Client shown in ‘Design Mode’
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Fig. 13-8: XY Wizard Button

The XY Wizard dialog is displayed for editing the XY panel. For a new XY Panel, it is 
generic XY panel settings that are shown selected. See Figure 13-9.

Click XY Wizard to open the XY Wizard dialog.

XY Panel open in GV Orbit Client 

‘Design’ mode indicated

a) Settings of a new, generic XY Panel

b) Corresponding XY Panel
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Fig. 13-9: XY Wizard Dialog (a) and Panel (b, New, Generic Panel Settings Shown)

Fig. 13-10: XY Wizard Dialog and Panel (Deselected Settings Shown for a GV Orbit Client System)

3 Deselect the wizard options that are not applicable to GV Orbit Client. See Figure 13-
10a.

The panel appearance changes in response to the settings changes as they are made. 
See Figure 13-10b.

For the remaining settings, these may be selected/deselected and configured as required:
4 Change the XY panel setting as required. 

(See XY Wizard Settings and Table 13-1 for descriptions of each XY Wizard setting.)

The panel appearance changes in response to the settings changes as they are made.
5 Close the XY Wizard dialog when finished changing settings. 

(This dialog can always be re-opened if required.)
6 Click Save File. Click Save Project.

The modified XY Panel has been saved. 

Note:
Some settings are not currently applicable to a GV Orbit Client system, these 
include:

Undo, Re-do, Protect  and Dial.

Recommendation: 
Deselect these settings for GV Orbit Client systems. See Figure 13-10.

a) Deselected Settings for GV Orbit Client b) Corresponding XY Panel

= Deselected for GV Orbit Client system cases
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XY Wizard Settings

 Table 13-1: XY Wizard Dialog Settings 
Item For 

GV Orbit 
Client

Description

Panel Size: Sets the overall size of the XY Panel (in pixels).

Normally, set this to be the size of the monitor used to display the 
panel.

Width  Text box.
Enter the panel screen width (pixels). Default = 1920.

Height  Text box.
Enter the panel screen height (lines). Default = 1080.

Layout  Select the left-right/top-bottom layout arrangement of the 
Source/Source-level and Destination/Destination-level grids:

Sources

Destinations

Source Levels

Destination Levels

For selection buttons on the XY panel:

 Text box.
Select the number of items to control. (Sources, Destinations, etc.)

Columns  Text box.
Select the number of columns used to display items.

Auto  Check box.
• Select to automatically arrange the items in columns.

Control: Enable various ‘Routing Control’ controls.

Note: Some items do not apply to GV Orbit Client systems and 
should be deselected.

Enable Take  Check box.
• Select to enable a Take button.

Enable Undo  This does not apply to GV Orbit Client systems.

Check box. 
• Select to enable an Undo button.
• Deselect for GV Orbit Client systems.
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Enable Protect  This does not apply to GV Orbit Client systems.

Check box. 
• Select to enable a Protect button.
• Deselect for GV Orbit Client systems.

Enable Redo  This does not apply to GV Orbit Client systems.

Check box. 
• Select to enable a Redo button.
• Deselect for GV Orbit Client systems.

Enable Panel Lock  Check box.
• Select to enable a Panel Lock button.

Enable Cancel  Check box.
• Select to enable a Cancel button.

Display:

Port Numbers  Check box.
• Select to show router port numbers on Source/Destination 

selection buttons.

Paging: The Source selection and Destination selection button-grids can 
be independently configured for either:

• paging through all of the respective router sources/destination 
ports; or for 

• accessing a specific router source/destination port per button.

Page Sources  Check box.

Control Source button-grid configuration:
• Select for ‘Paged’:

Paged Source port selection. Button-grid gives paged access to 
all router Sources, indexed. 
See Paged Ports, on page 605.

• Deselect for ‘Port-per-Button’:

A ‘fixed’ specific Source port is assignable per button. Each 
button accesses a specific Source port, non-indexed. 
See Port-per-Button, on page 605.

 Table 13-1: XY Wizard Dialog Settings  (continued)
Item For 

GV Orbit 
Client

Description
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XY Panel Layout
The layout and controls of a newly-created XY Panel are shown in Figure 13-11. 

Page Destinations  Check box.

Control Destination button-grid configuration:
• Select for ‘Paged’:

Paged Destination port selection. Button-grid gives paged 
access to all router Destinations, indexed. 
See Paged Ports, on page 605.

• Deselect for ‘Port-per-Button’:

A ‘fixed, specific Destination port is assignable per button. 
Each button accesses a specific Destination port, non-indexed. 
See Port-per-Button, on page 605.

Filtering:

Filter Sources  Check box.
• Select to show Sources filter control.

Filter Destinations  Check box.
• Select to show Destinations filter control.

Dialing: For dial-up selection of a Source or a Destination via its router port 
number. 
Note: Dialing does not apply to GV Orbit Client systems and these 
controls should be deselected.

Dial Sources   This does not apply to GV Orbit Client systems.

Check box.
• Select to show Sources dial-up controls.
• Deselect for GV Orbit Client systems.

Dial Destinations   This does not apply to GV Orbit Client systems.

Check box.
• Select to show Destinations dial-up controls.
• Deselect for GV Orbit Client systems.

Invert Keypads   This does not apply to GV Orbit Client systems.

Check box.
• Select to show Dial-up numeric keypads with 7,8,9 on top 

row.
• Deselect to show 1,2,3 on top row.

 Table 13-1: XY Wizard Dialog Settings  (continued)
Item For 

GV Orbit 
Client

Description
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Fig. 13-11: Example New XY Panel Layout

An XY Routing Panel is designed in and run from the Client application. Figure 13-11 shows 
a view of the XY Panel in ‘Design Mode’ and Figure 13-12 shows an annotated view in ‘Run’ 
mode.

The panel is laid out with the following main grids/areas (see Figure 13-12): 
• Source Grid – Sources are presented here, configurable in the XY Wizard to be a:

• Paged list of all available sources.
• Sub-set of defined sources.

• Source Levels Grid – List of available levels for selected source(s).
• Destination Grid – Destinations are presented here, configurable in the XY Wizard to 

be a:
• Paged list of all available destinations.
• Sub-set of defined destinations.

• Destination Levels Grid – List of available levels for selected destination(s).
• Routing Controls – Buttons are configured as shown/hidden in the XY Wizard, and 

include: ‘Undo’, ‘Redo’, ‘Protect’, ‘Take’, ‘Panel Lock’ and ‘Cancel’.
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Fig. 13-12: New XY Panel Layout and Controls (Annotated, ‘Run’ Mode)

Button face legend:

(1) Destination selected.

(2) Currently-routed Source shown.

(3) New Source pre-selected.

(4) Click Take to make route.

Buttons show names and router port numbers.,see Figure 13-15.

Source Grid

Routing 
Controls

Destination Grid

Source Levels Grid Destination Levels Grid

Source grid paging control Destination grid paging controlSources filter box Destinations filter box

Click to toggle 
Source Port Dial Grid 
on/off.

Shown when a Destination is selected

(3) 

(1) 

(4) 

Click to toggle 
Destination Port 
Dial Grid on/off.

Shown when a Source is selected

(2) 

Note: Dial Grids are not applicable to GV Orbit 
Client systems.

Note: The following controls on a newly-created XY Panel are not applicable 
to GV Orbit Client systems:

• Undo, Re-do, and Protect buttons; and
• Source and Destination Dial Grids.
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Source and Destination Selection Button-Grids
The Source and Destination button-grids can be independently configured with the XY 
Wizard Settings for either:

• Paged Ports operation; or for 
• Port-per-Button operation.

When an XY Panel is running, buttons are annotated to reflect the source/destination 
names, see Source/Destination Button Annotations. 

Paged Ports
A Source or Destination button-grid can be configured for paging through all of the 
respective router sources/destination ports. (Configuration is done in the XY Wizard 
Settings.)

Figure 13-13 shows a running example XY Panel with 12-button button-grids configured 
for ‘paged ports’ operation. Each paged button grid has paging controls to access all router 
ports (source or destinations accordingly). Page 1 starts at port 1 and shows consecutive 
ports on the button grid buttons. 

Fig. 13-13: Example Paged Ports Button Grid

Port-per-Button
A Source or Destination button-grid can be configured for accessing a ‘fixed’, specific router 
source/destination port per button. (Configuration is done in the XY Wizard Settings, on 
page 600.)

Figure 13-14 shows an example XY Panel with 12-button button-grids configured for ‘port 
per button’ operation. There is no paging here.

The example XY Panel is shown both in ‘Design’ mode and in ‘Run’ mode. This example has 
an initial, default assignment (from the XY Wizard) of ports-to-buttons, where buttons in 
each grid access ports starting from 1 onwards. 

Each button can be further configured to access a specific port, as required. See Assigning 
Port-per-Button, on page 621.

Paging controls
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Fig. 13-14: Example Port-per-Button

a) Wizard settings used in the example here

b) Example XY Panel, Port-per-Button, ‘Design’ mode

c) Example XY Panel, Port-per-Button, ‘Run’ mode

Buttons show router port names etc. when panel is running.

By default, buttons are assigned ports starting from 1 onwards.
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Source/Destination Button Annotations
The source/destination selection and source/destination level selection buttons in ‘Run’ 
mode are annotated to reflect the source/destination name or level name etc. when the 
panel is running. 

Additionally, when making a route, the selected destination button shows the currently-
routed source and the current (pre-)selected source for that destination. 

Buttons can be configured to show router port numbers and port names, see XY Wizard 
Settings, on page 600. 

Figure 13-15 shows button-face annotations.

Fig. 13-15: XY Panel Buttons on a Running XY Panel

Routing Control Buttons

Depending on the settings in the XY Wizard, the Routing Control section of the panel 
contains:

• Take button.

Click to make a route to the selected Destination from a pre-selected Source.
• Cancel button.

Click to deselect all Destinations and Sources.
• Lock button.

Click to lock the XY panel controls. Click again to unlock.

Destination Name name

Pre-selected Source name

Currently-Routed Source name

Destination Button:

Destination Level Button:

Destination Level name

Pre-selected Source Level name

Currently-Routed Source Level name

Source Button:

Source Level Button:

Port number

Source name

Level name

Port number

Note: Undo, Redo, Protect functions are not currently available in an XY 
Panel for GV Orbit systems. (Use the Bulk Routing Panel for these functions.)
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XY Routing Panel- Operational Keys

XY Panel Level Selection
When a source or a destination is selected, the associated levels are shown in the 
corresponding ‘Levels Grid’ panel. If multiple sources or destinations are selected, then only 
their common levels are shown. 

All levels are selected by default. If you select one or more levels, then all other levels are 
deselected. 

XY Panel Right-Click Menus
Right-click on background of a XY Routing Panel to show a drop-down context menu. See 
Figure 13-16.

 Table 13-2: XY Panel Operational Keys
Operation Mouse

Select Mouse click on a Source or Destination.

Select a Range Mouse click on first item then
SHIFT click on last item.

Add to/remove from a multiple selection CTRL + Mouse click

Paste Series Click ‘Paste Series’ icon in panel.

Take Double-click on pre-selected Source; 

or click Take button.

Cancel Click ‘Cancel’ button.
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Fig. 13-16: XY Panel Background Right-Click Menu: a) in ‘Run’ Mode; b) in ‘Design’ Mode.

a) In ‘Run’ mode’ b) In ‘Design’ mode

 Table 13-3: XY Panel Right-Click Menu Items 
Item Shown in Description

‘Run’ 
Mode

‘Design’ 
Mode

Dock/Undock 
Window

  Undock or dock the XY Routing Panel window from the GV Orbit 
Client window.

Full Screen   Show the XY Routing Panel window full-screen.

When full-screen, right-click > Exit Full Screen.

Exit Run Mode  Click to exit ‘Run’ mode and enter GV Orbit ‘Design’ mode.

Enter Run Mode  Click to enter GV Orbit ‘Run’ mode.

Scale to Fit   Click to fit the panel to the window.

Select All  Selects all items. 

Deselect All  Deselects all items. 
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Getting XY Routing Panel Running
When an XY Panel runs on the GV Orbit Client in a C&M project, it controls signal routing via 
the Routing service running on a GV Orbit Server.

Lock/unlock   Click to toggle locking/unlocking the panel. 
When the panel is locked, user operation is disabled.

Note: Clicking the ‘Lock’ icon in the GV Orbit Client main tool 
bar also toggles panel lock.

Resize to Widgets  Click to resize the XY panel background to fit to its constituent 
widgets. 

Reset Panel Styles 
to Default

 Click to set widget styles all to ‘default’.

Variables...   Click to show the Variables dialog.

Note: The Variables dialog is not editable in ‘Run Mode’.

Connection Mode  Note: This item is a generic widget feature, not routing-specific.

Widget feature: 

When designing C&M project screens or XY Panels, the graphical 
widgets used may be shown to be visually connected together 
by a curved line. 
Click Connection Mode to show connection points on the 
widgets.

Edit Behaviours  Click to toggle showing the Behaviours and Bindings graphical 
editor.

 Table 13-3: XY Panel Right-Click Menu Items  (continued)
Item Shown in Description

‘Run’ 
Mode

‘Design’ 
Mode
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What is a Routing Service?
As part of setting up a GV Orbit Client system, a Routing service must be configured with a 
RollCall address and a GVOP domain, and started up to run on a GV Orbit Server. The 
Routing service uses its RollCall address and is visible in the Network window of a GV Orbit 
Client and see Figure 13-17. 

Fig. 13-17: Routing Service in Network Window

How to Connect an XY Panel to a Routing Service

Automatic Setup
To run in GV Orbit Client, an XY Panel must point at a Routing service on a GV Orbit Server. 
This is usually automatically set up for you, including:

• GV Orbit Client C&M project GVOP domain the same as the Routing service. This should 
be set automatically.

(To see the project’s GVOP domain number, go to the main menu item 
‘Connections > GV Orbit Server’, and look at the ‘Client domain’ setting. 
Edit the domain number here if required.)

Right-click and select ‘Info’ to see details of the Routing service item

Routing service RollCall address’.
To copy this address, right-click in Network window and select ‘Copy > Address’.

Note: The GVOP domain of the GV Orbit C&M project and 
the GVOP domain of the Routing service must be the same.

http://127.0.0.1: 8080/routingnode/
http://127.0.0.1: 8080/routingnode/
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• XY Panel set with a RollCall address of the Routing service. This should be set 
automatically.
To do this, the XY Panel’s ‘Address’ variable must be set to be the RollCall address of the 
target Routing service.

Manual Setup
To manually set up the XY Panel to point at a Routing service:

1 In the Network window, right-click on the Routing service item, and
select ‘Copy > Address’. 

This copies the RollCall address of the service into your copy buffer.
2 Go to the XY Panel and right-click on the XY Panel background and select ‘Variables...’. 

The Variables dialog is shown. See Figure 13-18.

Fig. 13-18: Setting Routing Service RollCall Address for XY Panel

3 In the Variables dialog, 
paste in the copied RollCall address into the value of the ‘Address’ variable. 
See Figure 13-18. (Alternatively, simply enter the address manually.)

4 Click OK.
5 Click Save File. Click Save Project.

This has manually pointed an XY Panel at a Routing service.

To Run an XY Panel
When an XY Panel runs, it connects to the Routing service and collects routing information 
and data (Source names/port numbers, Destination names/port numbers, routed source 
names etc.) and populates the panel buttons with names and router port numbers etc.

Paste copied address into ‘Address’ value field
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To run an XY panel:
1 Open the panel in GV Orbit Client and click on the ‘Run’ mode/’Design’ mode main tool 

bar icon to enter ‘Run’ mode. See Figure 13-20.

Fig. 13-19: Enter Run Mode

The XY Panel run and connects to the Routing service and gets source and Destination 
names etc. See Figure 13-20.

Click to enter ‘Run’ mode (from ‘Design’ mode)’ Buttons show actual source and 
destinations name s etc.

a) XY Panel in ‘Design’ mode b) XY Panel in ‘Run’ mode

(1) Destination selected.

(2) Current Source shown.

(3) New Source pre-selected.

(4) Click Take to make route.

(1) 

(2) 

(3) 

Note: Routing Control buttons can be shown/hidden with the XY Wizard tool.
(See Customizing with the XY Wizard, on page 597.)

(4) 
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Fig. 13-20: Running XY Panel Example

XY Panel Operation 

Make a Simple Route with an XY Routing Panel

Simple Route
To make a simple route:

1 Select a Destination.

The currently-routed Source is shown.
2 Select a Source.

The pre-selected Source is shown.
3 Click Take. (Click Cancel, to deselect the source/destination.)

The selected source is routed to the selected destination. The route is made.

Alternatively, select the Source first.

1) Select Destination

Currently-routed Source is shown.

2) Select Source

3) Take

1) 1)

2)

3)
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Fig. 13-21: Making a Simple Route

Route One Source to Multiple Destinations
1 Select a Destination by clicking on the destination selection button.
2 Select a second Destination by CTRL + clicking on a destination button.
3 Select further destinations with CTRL + click.
4 Select one Source.
5 Click Take.

The source is routed to all selected destinations.

Fig. 13-22: One Source Routed to Multiple Destinations

Alternatively, the source may be selected first.

Note: A contiguous range of Destinations (or Sources) can be selected 
by clicking the first Destination (or Source) in the range and then SHIFT-
click on the last Destination (or Source) in the range.

Selected Destinations

Currently-routed Sources shown

Pre-selected Source

Routed result
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Route Multiple Sources to Multiple Destinations
1 Select a Destination by clicking on the destination selection button.
2 Select a second Destination by CTRL + clicking on a destination button.

And select any further destinations with CTRL + click.
3 Select a Source by clicking on the source selection button.
4 Select a second Source by CTRL + clicking on a source button.

And select any further sources with CTRL + click.

5 Click Take.

The source is routed to all selected destinations.

Fig. 13-23: Making Multiple Routes

Alternatively, the Sources may be selected first.

Note: Select the same number of sources as there are selected destinations.

Selected Destinations

Currently-routed Sources are shown

Pre-selected Sources

Routed result
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Breakaway

What is a Breakaway?
See What is a Breakaway?, on page 538, for an explanation of a breakaway.

Perform a Breakaway 
To perform a breakaway (see Figure 13-24):

1 Select a Destination.
2 Select one or more Destination Levels to route (for example, audio channels A1 and 

A2).
3 Select a new Source. (Pre-selected source)
4 Click Take.

A routing is made: The selected Destination Levels have corresponding levels from 
the preselected Source routed to them. See Figure 13-24b. 
The Destination button shows a ‘Breakaway’ symbol.

Note: Source or Destination CTRL-selection Order: 

When routing many sources to many destinations and making 
selections with CTRL-clicks, then the order of selection is 
significant and affects the order in which the routing is done. 
For example, to route sources 1 to 8 to destinations 8 to 1:

• Select Destinations 1 to 8 by ‘CTRL-clicking’ on each button 
in the order 1 to 8.

• Select Sources 8 to 1by ‘CTRL-clicking’ on each button in 
the order 8 to 1.

• Click Take.

Note: With the contiguous SHIFT-selection, the order used is that 
of the buttons on the panel, not the order of selection of buttons. 

Note: Implied Breakaway:
A ‘breakaway’ occurs when not all of a destination’s levels are selected for 
routing. This can happen if a source with fewer levels than the selected 
destination is routed, this will result in a ‘breakaway’ (without explicitly 
selecting destination levels when routing). 

Note:
Performing a ‘normal’ route to a Destination which already has a ‘Breakaway’ 
will over-ride the breakaway on the Destination, resulting in no ‘Breakaway’.
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Fig. 13-24: Breakaway Example: a) Before TAKE; b) After TAKE.

As an alternative, to perform a breakaway, the source may be selected first.

a) Before TAKE

b) After TAKE 

Selected Destination

Selected Destination Level(s)
Currently-routed Source shown

Audio channels shown routed from another Source

Breakaway symbol shown on button

Take

Pre-selected Source
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Shuffle

What is a Shuffle?
See What is a Shuffle?, on page 542, for an explanation of a shuffle.

Example Shuffle 
This example swaps two audio channels pairs.

Fig. 13-25: Swap Two Audio Channel Pairs

1 Select a Destination.
2 Select one or more Destination Levels. (For example, click on audio channels A5, A6, 

A7 and A8. See Figure 13-26.)
3 Select the currently-routed Source. 
4 Select the Source Levels in the order in which they shall apply to the destination 

Levels.
(For example, audio channels A7, A8, A5 and A6 in that order.)

5 Click Take.

The selected source levels are routed to the selected destination levels and a shuffle is 
formed. Figure 13-26 shows a shuffle example, swapping the order of two audio 
channel pairs, as per Figure 13-25.

Note: A shuffle is applied to a destination and stays with that destination 
when other routes are made to it until the shuffle is explicitly undone.

Note: Selecting just one level will route this to all selected destination 
levels.
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Fig. 13-26: Shuffle Example: a) Before TAKE. b) After TAKE.

a) Before TAKE

b) After TAKE

Selected DestinationSelect the currently-routed Source
Select Source Levels A7, A8, A5 and A6 in that order.

‘Shuffle’ symbol shown on button

Selected Destination Level(s) A5 to A8

Take

Audio channels shown shuffled
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Routing to a Shuffled Destination
When routing to a shuffled Destination, the ‘Shuffle’ persists. 

For example, when a routing Source ‘Cam S10’ to the already-shuffled destination ‘Mon1’, 
created in Example Shuffle, the Source is routed and the audio stereo pair swapping of 
Figure 13-25 still exists (but with the new source).

A ‘Shuffle’ persists on a Destination until it is explicitly undone with a new routing 
operation.

Undo Shuffle
This example describes a new routing operation to undo the shuffle of the Example Shuffle, 
on page 619.

1 Click Cancel to cancel any selections already made.
2 Select the ‘already-shuffled’ Destination.
3 Select the shuffled Destination Levels.
4 Select the currently-routed Source. 
5 Select the Source Levels in the order in which they shall apply to the Destination 

Levels.
So, to undo our Example Shuffle, on page 619, 
select audio channels A5, A6, A7 and A8 in that order.

6 Click Take.

The selected Source Levels are routed to the selected Destination Levels, undoing 
the shuffle. The ‘shuffle’ symbol no longer appears on the Destination button. 

Assigning Ports to a Port-per-Button XY Panel
When creating an XY Panel, a Source button-grid or Destination button-grid can be defined 
for accessing a ‘fixed’, specific router source/destination port per button. (This ‘fixed’ 
definition is done in the XY Wizard Settings.) 

Following definition with the XY Wizard, each button of a ‘port-per-button’ button-grid 
then can be configured to access a specific port. This port assignment is described here.

Assigning Port-per-Button
Following creation from the XY Wizard, buttons in a ‘Port-per-Button’ button-grid can be 
assigned specific ports on a per button basis, as required. 

There are two ways to perform the port assignments to the buttons:
1 Assign Ports to Individual Buttons, on page 621. This describes individual assignment 

of ports to buttons.
2 Quick Port-per-Button Assignment, on page 625. This describes selecting all ports with 

the Bulk Routing panel and copy-pasting this into the XY Panel.

Assign Ports to Individual Buttons
Assigning individual buttons done in the XY Panel in ‘Design’ mode.
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The example of Figure 13-14 shall be used to show how to assign a port to a button:
1 In ‘Design‘ mode, select the Source button-grid and ‘Alt-select’ its first button. 

The first button is selected. See Figure 13-27a.
2 Click on the Edit Behaviours button in the Properties box. See Figure 13-27a.

The graphical Behaviours and Bindings editor is opened. See Figure 13-27b.
The editor shows the Behaviours and Bindings linked to the selected button widget.

Fig. 13-27: Open Behaviour and Bindings Editor

3 Double-click on the Behaviour linked to the selected widget.

The properties of the Behaviour are shown. See Figure 13-28a.
4 Select the value of the ‘Source’ property (see Figure 13-28a) 

and enter a router port to use:

a) First Source button selected, click Edit Behaviours

b) Graphical Behaviours and Bindings Editor

Edit Behaviours buttonSource button selected

Behaviour

Binding

Selected Widget
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• enter a port name and/or port number; or
• click on the  icon and select a Source name from the filterable list; or
• enter a GV Orbit Client variable. (For example, {My_Source_Port} )

A new ‘Source’ property value has been entered.

Note: The entered router port may be:

• a port number;
• a port name; or
• a ‘Number:Name’, for example, 12:Cam1; or
• a GV Orbit Client variable.

In the case of a port name, the name is looked up automatically to find 
the port number to assign.

In the case of ‘Number :Name’, then the port number is used to assign 
with.

In the case of a user variable, this should be defined as a port number.

Note: To select a router port from a filterable list:

• Click on the  icon at the far end of the Source/Destination 
property value field (see Figure 13-28 a).

The Source/Destination Picker dialog is shown and displays a 
list of Sources/Destinations. See Figure 13-28b.

• The list is filterable.
• Select a Source/Destination name from the filterable list.
• Click OK when done.
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Fig. 13-28: Setting ‘Source’ or ‘Destination’ Property Value

a) Setting ‘Source’ property of the Behaviour

b) Source Picker Dialog (Destination Picker is similar)

Enter a Port Number, or Name, or Number: Name. 

Alternatively, click on the  icon.
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Fig. 13-29: New ‘Source’ Property Value

5 Click Close.
6 Click Save File. Click Save Project.
7 Enter ‘Run’ mode.
8 The XY Panel runs and the newly-assigned Source is assigned to the Source button, see 

Figure 13-30.

Fig. 13-30: Running XY Panel

Thus, a Source button can have a port assigned to it.

Destinations buttons are assigned similarly.

Assign all buttons as required.

There is a quicker way to make these assignments, which uses the help of the Bulk Routing 
Panel. See Quick Port-per-Button Assignment.

Quick Port-per-Button Assignment
This describes a quicker method of assigning buttons to ‘Port-per-Button’ XY Panel button-
grids. All ports are selected via the Bulk Routing panel and then simply ‘copy-pasted’ into 
the XY Panel.

Prerequisites:
• A new XY Panel with one or more button grids set to be ‘Port-per-Button’ (not ‘Paged 

Ports’, see ‘Paging’ setting in XY Wizard Settings, on page 600).

The following example assumes that the buttons of both the Source button-grid and of the 
Destination button-grid require setting up in for ‘Port-per-Button’ operation. If an XY Panel 
just has one such button-grid, then that grid may be quickly set up in a similar way.

To quickly make port-to-button assignments:
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1 Open a Bulk Routing Panel. 
(Click the ‘Bulk Routing’ icon on the Routing Workflow, see Figure 13-31.)

Fig. 13-31: Open Bulk Routing Panel

2 Select all the Destination and Source ports required.

Fig. 13-32: Copy As Widgets in Bulk Routing Panel

3 When all ports are selected, 
right-click in the background of the Bulk Routing panel and select ‘Copy as Widgets’.

The selected buttons (Source and Destination ones in this example) are copied to your 
GV Orbit Client copy-buffer.

4 Open the target XY Panel.
5 Enter ‘Design’ mode in GV Orbit Client.
6 Right-click in the background of the XY Panel and select ‘Paste’.

Note: When selecting the ports in the Bulk Routing panel, the filtering may 
be used and ranges of ports and individual ports can be selected.

Selected Sources and selected Destinations

Right-click and select ‘Copy as Widgets’.
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The copied buttons are pasted into the XY Panel. See Figure 13-33.

Fig. 13-33: Paste Buttons in from Bulk Routing Panel ‘Copy as Widgets’

7 The buttons now in the XY Panel can be arranged as required and any previously-
existing Source/Destination buttons may be deleted if required.

8 Click Save File. Click Save Project.
9 Go to ‘Run’ mode to exercise the XY Panel.

Fig. 13-34: XY Panel with Quick-Assigned Ports

Port-per-Button Pasting into C&M Custom Soft Panel
The example in Quick Port-per-Button Assignment pastes selected button widgets from a 
Bulk Routing Panel into an XY Panel. This selection of buttons may also be pasted into a 
GV Orbit Client C&M user/operator custom panel.

Pasted buttons

Right-click and select ‘Copy as Widgets’.

‘Design’ mode is shown
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:

In this case, the pasted buttons are still functional and will select Destinations and Sources when 
the soft panel is run. There is no ‘Take’ button and ‘auto-take’ applies. See Figure 13-35

Fig. 13-35: Auto-Take with Pasted-in Routing Buttons (Running)

Customizing an XY Panel
An XY Panel may be modified and customized by simply using the XY Wizard. Additionally, 
an XY Panel may be further modified and customized by:

• Using the XY Wizard and then further editing the XY panel, 
see Further Editing an XY Panel, on page 628. 

An XY Panel may also be created from scratch without using the XY Wizard. 
This is done with GV Orbit graphical widgets and GV Orbit Client Behaviours and Bindings 
in a similar way to designing a custom user/operator panel in a C&M project. 
See: 

• Creating a Custom XY Panel from Scratch, on page 629; and see 
• Creating a Custom BPX Panel, on page 637.

To enhance the appearance of a control panel, lines, labels etc may be added. 
See Enhancing the Appearance of a Panel, on page 643.

Further Editing an XY Panel
Editing an XY panel is done in a similar way to editing a GV Orbit Client C&M Project custom 
user/operator screen and an XY Panel can be customized as required. For example:

• buttons may be re-positioned, re-sized; 

Note:
In the GV Orbit Client Project window:

• XY Panels are listed in the ‘panels’ folder; and
• Custom user/operator soft panels are listed in the ’screens’ folder.

Selected Destination

Routed Source

Pre-selected Source

Route automatically made to destination



629

GV Orbit Version 2.3.0 Routing Control - XY Routing Panel
User Guide Creating a Custom XY Panel from Scratch

• other widgets can be added (Labels, Tally Lamps, etc.); 
• colors can be changed (background colors); and
• widget style themes can be selected. 

Figure 13-36 shows an example XY Panel that has been edited after being started with the 
XY Wizard. See Enhancing the Appearance of a Panel, on page 643, for further examples of 
enhancing the appearance of an XY Panel.

Fig. 13-36: Edited XY Panel Example

Creating a Custom XY Panel from Scratch
A custom XY Panel can be created from scratch in a GV Orbit Client C&M project.
A custom panel can be made to be smaller and more suited to be embedded into a C&M 
project screen. An example small panel with two destinations and a handful of possible 
sources is given in Figure 13-37 and the steps to generate it are below. 
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Fig. 13-37: Custom XY Panel Example

Step1: New Empty Basic XY Panel
Firstly, create a new empty XY Panel:

1 Open an GV Orbit C&M project in the GV Orbit Client application.
2 Right-click on the ‘panels’ folder item in the Project window and select ‘New Panel’.
3 Enter a name into the New XY Panel dialog and click OK. See Figure 13-38.
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Fig. 13-38: Create New XY Panel

A new XY Panel is created in the ‘panels’ folder and is shown in the Project window and 
is open in a tab.

4 In the new XY Panel tab, delete all widgets. 
(Type CTRL-A in the tab to select all widgets and then press the Delete key.)

An empty XY Panel results.
5 Click Save File.

This has created an empty XY Panel in the C&M project. See Figure 13-39.

Fig. 13-39: Empty XY Panel

When editing the XY Panel, it is useful to adjust the position of the routing control widgets 
tool bar in the GV Orbit Client, to make it more accessible. To do this:
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6 Drag the routing control widgets tool bar by its handle to a convenient position. See 
Figure 13-40.

Fig. 13-40: Re-positioning the Routing Control Widgets Tool Bar

Step 2: Add Routing Control Widgets to (empty) XY Panel
With the empty XY Panel open in GV Orbit Client:

1 Add 8 Source Button widgets from the Routing widget tool bar (see Figure 13-41).
(Click on ‘Source Button’ button on the tool bar and drag on button widgets.)

The button annotation names increment automatically for each added button.
2 Similarly add 2 Destination Button widgets.

Drag handle and release to re-position Routing Control widget tool bar
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Fig. 13-41: Adding Source and Destination Buttons

Finally, add a Take button:
3 Select ‘Control Buttons’ in the tool bar.

A small dialog appears.

Fig. 13-42: Adding a Take Button

4 Select ‘Take’ and click OK.

A Take button widget appears at your cursor, drop this onto the XY Panel.
5 Arrange the buttons as required.
6 Click Save File and Save Project.

Source Button widgets
Routing control 
widgets tool bar

Destination Button widgets
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Fig. 13-43: Added Buttons

Step 3: Exercise Panel
This XY Panel, when run, will allow you to select a source from sources 1 to 8 and route it 
independently to destinations 1 or 2.

Fig. 13-44: Running the New XY Panel

Source selection 
buttons

Destination selection 
buttons
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Step 4: Assigning a Port-per-Button
With the XY Panel in ‘Design’ mode in GV Orbit Client, the Source buttons and Destination 
buttons can be configured for other source or destination ports in the same way as in a 
‘Port-per-Button’ panel (See Assigning Ports to a Port-per-Button XY Panel, on page 621, for 
more information.) 

To assign ports:
1 Right-click in the XY Panel’s background and select ‘Edit Behaviours’.

The ‘Behaviours and Bindings’ graphical editor is shown.

Fig. 13-45: Double-click on ‘Source Button’ Behaviour

2 Select a Source button in the XY Panel and double-click on the ‘Source Button’ 
Behaviour in the editor. See Figure 13-45.

The Behaviour’s properties are shown.
3 Set the ‘Mode’ property to ‘Fixed’.
4 Set the ‘Source’ property to a chosen Source name. 
5 Click Close.

A Source button now has a port assigned.
6 Repeat for the other Source buttons.

And then: 
7 Perform similar steps for each Destination button.

The buttons now all have assigned ports.
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Step 5: Styling
1 Arrange the buttons and resize as required.
2 Add any further labels/shapes/colors to enhance the panel’s appearance, as required.

Finally: 
3 Right-click on the XY Panel background and

select ‘Resize to Widgets’.

Fig. 13-46: Custom XY Panel

4 Click Save File. 
Click Save Project.
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Step 6: Exercise Panel
1 Click the ‘Run Mode’ icon in the main tool bar and exercise the panel.

Fig. 13-47: Exercising the XY Panel

The small custom panel operates like a fixed, reduced-size XY Panel and may be dragged 
onto a C&M project custom user panel screen and embedded into it, if required. See How to 
Embed an XY Panel into a Custom User Panel, on page 650.

Creating a Custom BPX Panel

What is a BPX Panel Type?
A BPX (BPX, button per crosspoint) panel enables a button-click to specify and make a 
route between a source and destination. A simple custom panel can be designed as part of 
a C&M project, for example, to route one of several sources to a single destination.

A BPX Behaviour is available in GV Orbit which can be associated with a button widget. This 
enables a button-click to make a route between a specific source and destination. BPX 
Panel Example

An example BPX panel is a simple panel where each button is configured to set a route to 
the same destination, but from a different source. This simple BPX panel is shown in 
Figure 13-48 and the steps to generate it in GV Orbit are given below. 

• Select Destination.
• Select source to route
• Click Take.
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Fig. 13-48: Custom BPX Example

Basic BPX Panel
To create this panel:

1 Create a new empty XY Panel. 
(This is described in Step1: New Empty Basic XY Panel, on page 630 for the Creating a 
Custom XY Panel from Scratch, on page 629.)

2 Add a graphical Button widget to the panel. (See Figure 13-49.)

Each button configured to make a different route 
(usually) to the same destination.
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Fig. 13-49: Add a Button Widget

3 Right-click in the XY Panel’s background and select ‘Edit Behaviours’.

The ‘Behaviours and Bindings’ graphical editor is shown.
4 Select the Button widget.

The ‘Behaviours and Bindings’ graphical editor for the selected button is shown. 

Drag on a Button widget
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Fig. 13-50: Behaviours and Bindings of Selected Button Widget 

In the editor:
5 Filter the Behaviours on ‘Routing’. See Figure 13-51a.
6 Select a BPX Behaviour. See Figure 13-51b.

A BPX Behaviour is added to the ‘Behaviour and Bindings’ editor and a Binding too. See 
Figure 13-51b.
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Fig. 13-51: Adding a BPX Behaviour

A BPX button’s function is to specify a Source and a Destination and a route between the 
two:

7 Double-click on the BPX Behaviour.

The Behaviour’s properties are shown. See Figure 13-52.
8 Set the ‘Source’ property to a required Source.
9 Set the ‘Destination’ property to the required Destination.

b) Select a BPX Behaviour

a) Filter Behaviours on ‘Routing’

BPX Behaviour is added and a Binding

Filtered list of 
Routing 
Behaviours
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Fig. 13-52: Setting ‘Source’ and ‘Destination’ Property Values

10 Click Close.

This has defined one BPX button. For example, a route between the Source and 
Destination.

Now we will copy this button (with its Behaviour/Binding settings) twice:
11 In the BPX panel, select the one Button widget, right-click on it and select ‘Copy’.
12 Select the panel’s background, right-click and select ‘Paste’.
13 And again, select the panel’s background, right-click and select ‘Paste’.

This copies the button twice more on the panel.
14 Select the panel’s background, right-click and select ‘Edit Behaviours’.

For each button that was copied:
15 Select the button, and edit the button’s BPX Behaviour.
16 Change the ‘Source’ property to select a different Source each time.

Then:
17 Click Close. 
18 Click Save File. 
19 Click Save Project.

Fig. 13-53: BPX Panel, Designed
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This has created a basic BPX panel with three buttons. Each button is configured to set a 
route to the same destination, but from a different source.

Exercise the BPX Panel 
1 Enter ‘Run’ mode in GV Orbit Client.
2 Operate the panel. See Figure 13-54.

Fig. 13-54: BPX Panel Running

Enhancing the Appearance of a Panel
• Panel Enhancement - Add Labels, on page 643.
• Enhancement - Add Lines, on page 647.

Panel Enhancement - Add Labels
Label widgets can be added for the display of information. In this example, some text is 
added to the BPX panel to display the destination name and the source routed to it.

1 Add four Label widgets to the BPX panel. See Figure 13-55.
2 Set two labels to have fixed ‘Caption’ properties. See Figure 13-55.

Click the second button to 
make a route from its source, S10-2. 
See the result

Click the third button to 
make a route from its source, S10-3. 
See the result

Currently routed Source to the Destination

Destination

Source which the button will route to the Destination, if selected.

Note: Carry out edits to the panel design in GV Orbit Client in ‘Design’ 
mode.
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Fig. 13-55: Adding Labels

For each of the other two Labels:
3 Open the ‘Behaviour and Bindings’ graphical editor. 

(Right-click and select ‘Edit Behaviours’ in the panel background.)
4 Select one of the Labels. See Figure 13-55.
5 Add a Destination Behaviour. See Figure 13-55.

A Destination Behaviour and a Binding are added to the ‘Behaviour and Bindings’ 
editor.

6 Double-click on the Destination Behaviour and set its ‘Destination’ property to the 
same destination that each of the Buttons control. See Figure 13-56.

7 Click Close.

Label widgets with fixed ‘Caption’ property Label widgets using a Destination Behaviour

Selected Label

Add a Destination Behaviour
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Fig. 13-56: Setting Destination for a Label’s Destination Behaviour

This has set up both of the Label captions to show the Source name of the pointed-to 
Destination. To modify one of the Label captions to show the Destination name instead:

8 Select the Label to see its Behaviours and Bindings. See Figure 13-57.

Fig. 13-57: Select a Label

9 Double-click on the Binding to see the Binding’s properties.

See Figure 13-58.

Destination Behaviour pointed at the same destination monitored as the BPX 
buttons.
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Fig. 13-58: Edit Binding Properties

10 Change the following properties of the Binding:
• ‘Behaviour Value’ property from ‘Source Name’ to ‘Dest Name’.
• ‘Name’ property from ‘Routed source onto caption’ to ‘Dest name onto caption’.

11 Click Close.
12 Click Save File. Click Save Project.

This has modified our BPX Panel design. See Figure 13-59a.
13 Exercise the BPX panel with the Labels. 

When a button is clicked, the resulting route is shown by the labels. See Figure 13-59b.

Fig. 13-59: BPX Panel with Labels: a) Designed; b) Running

a) Designed BPX Panel with Labels b) Running BPX Panel with Labels
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Enhancement - Add Lines
Lines (Line widgets) or any shapes may be added to a panel.

Fig. 13-60: Added Lines

Additionally, Line widgets can have their visibility controlled from the state of the routing. 
This is shown by using the example panel from Panel Enhancement - Add Labels, on 
page 643. To do this:

1 Open the panel and show the ‘Behaviour and Bindings’ graphical editor.
2 Add the required lines, in this example, three lines are added.

For each button:
3 Select the button and then view the properties of the associated BPX Behaviour; 

change the ‘Name’ property to a unique name. (for example, to ‘BPX-1’, ‘BPX-2’, and 
‘BPX-3’. )

This gives each BPX Behaviour a unique name.

For each line:
4 Select the line and add a Property Binding. See Figure 13-61.
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Fig. 13-61: Add Property Binding

5 Double-click on the added Property Binding to edit its properties.
6 Change the following Property Binding property values: (See Figure 13-62.)

• ‘Source Behaviour’, select a unique BPX Behaviour. For example, ‘BPX-1’,or ‘BPX-2’, 
or ‘BPX-3’.

• ‘Behaviour value’ to ‘Is Routed’.
• ‘Property to Bind’ to ‘Visibility’.

Fig. 13-62: Added Property Binding

7 Click Close.

This has set the visibility of a line to be controlled by the routing status of the BPX 
Behaviour associated to a Button. 
Do this for each line and select a unique BPX Behaviour name each time.
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Fig. 13-63: BPX Panel Example

When the visibilities of all three lines are changed:
8 Click Save File. Click Save Project.
9 Exercise the panel. See Figure 13-64.

The lines simply indicate the route that is made when clicking buttons.
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Fig. 13-64: Exercising BPX Panel with Lines

How to Embed an XY Panel into a Custom User Panel
An XY Panel may be embedded into an XY Routing Panel C&M project screen as an GV Orbit 
‘Component’.

To embed:

Click button:

Route is made and 
a line indicates the routing 
made.

Click Button:

Route is made and 
a line indicates the routing 
made.

Click Button:

Route is made and 
a line indicates the routing 
made.
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1 Open the GV Orbit project containing the XY Panel and a C&M project screen.

Firstly, check that the overall XY Panel size is just bigger than the widgets it contains. To do 
this:

2 Open the XY Panel and check the size values in the Properties box.
(Properties box: Screen > Dimensions > Page Size > ‘Width’ and ‘Height’.)

3 If the panel size needs adjusting:
• right-click in the panel background and select ‘Resize to Widgets’, and/or 
• adjust the background’s screen ‘Width’ and ‘Height’ properties directly.

4 Close the XY Panel.

Now embed the XY Panel into a C&M project screen:
5 Open a C&M screen.
6 Drag an XY panel from the Project window onto the C&M project screen. 

and release. See Figure 13-65.

Fig. 13-65: Drag on an XY Panel

The panel object is like a GV Orbit component object on a C&M project screen. 
7 Resize the panel object as required.
8 Click Save File. Click Save Project.
9 Run the C&M screen and exercise the XY Panel on the screen.

One or more instances of an XY panel on a screen can be used.

Drag panel onto screen
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14Multiviewer Cluster

Introduction

A multiviewer cluster (MV Cluster) is a group of multiple MV-8 Series multiviewer devices in 
a GV Orbit system which are all acting together to serve one or more video walls. The 
cluster is treated as one multiviewer resource, rather than as a set of single, individual 
multiviewer devices. 

All of the video walls served by the multiviewer cluster are designed in a single ‘Clustered 
Multiviewer’ project in GV Orbit Client. This is done using the ‘Room Editor’ tool and an MV 
Cluster Manager service is required to be running on a GV Orbit Server. The resulting video 
wall(s) are managed at a higher level (at a ‘cluster-level’) and router destinations are referred 
to in operation rather than video wall tiles or multiviewer inputs.

MV Cluster Information

What is an MV Cluster?
An MV Cluster is a cluster of multiviewer devices configured together and all acting 
together to serve one or more video walls. An MV cluster contains one or more multiviewer 
devices.

Lite Professional Enterprise

 

 Table 14-1: MV Cluster Numbers for MV-8 Series Multiviewers
Number of 

Multiviewer 
Devices 

Number of head display outputs: Number of video wall tiles: 

per device maximum 
available

per 
device

per 
video wall

1 up to 12 12 48 up to 48

2 up to 12 24 48 up to 48 * 2 (=96)

3 up to 12 36 48 up to 48 * 3 (=144)

... ... ... ... ...

NCluster
a up to 12 12 * NCluster 48 up to 48 * NCluster

a.The number of devices in an MV Cluster has no fixed limit. See MV Cluster Size for more information. 
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MV Cluster Size
The number of devices in an MV Cluster (NCluster) has no fixed limit: The number of multiviewers that GV 
Orbit Client and the MV Cluster Manager service can handle has no real limit.

However, in practice, limiting factors are anticipated. The maximum number of MV-8 Series multiviewers in 
an MV Cluster (NClusterMax) is determined by performance and various system factors, including:

• GV Orbit system size; and 

• network speed. 

Contact Grass Valley Technical Support for further information on NClusterMax for specific use cases.

Defining Video Walls for an MV Cluster
A user can define a set of video walls for a broadcast production studio or OB truck using 
the GV Orbit Client with a ‘Clustered MV’ project. The video walls are all served by a cluster 
of MV-8 Series multiviewers.

GV Orbit Client is used along with GV Orbit system services. Video walls are defined and 
managed independently from the individual multiviewer devices used. Video wall tiles are 
referred to by their router destination name.

Additionally, for a ‘Clustered MV’ GV Orbit project, TSL tally settings and audio bars 
configuration can be done for each whole video wall.

Fig. 14-1: Video Walls Served by Multiviewer Cluster (Example shown has an MV Cluster of 6 Devices)

MV-8XX Multiviewer Cluster Example
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What is a Clustered Multiviewer Project?
A GV Orbit Clustered MV project (Clustered MV project) enables a user to define a set of 
video walls for a broadcast production studio or OB truck served by an MV Cluster. 

The video walls can each comprise one or more display monitors. One or more video walls 
may be defined, all served by a cluster of multiviewer devices.

All of the video walls are designed in one ‘Clustered MV’ project, which then holds the 
designs of one or more video walls for a studio or an OB truck. 

Overall TSL tally set up and Audio Bars audio channel configuration of audio bars is also 
integrated and handled within such a project. 

The project is stored centrally on the GV Orbit Server and the entire video wall design is 
then automatically parsed and administered across the individual multiviewers in the 
cluster.

Multiviewer Discovery

Video Wall Design
Video walls are formed from a physical arrangement of one or more display monitors and 
each display monitor is driven from any one of the multiviewer head display outputs 
available from the multiviewer cluster. Video wall tile layouts can be applied and layouts for 
the whole video wall and also for individual monitors can be saved and switched between. 
Assignment of router destinations to video tile layouts completes the video wall design. 
Finally, the assignment of video sources to video tiles (PiPs) is integrated into the GV Orbit 
routing control system and the routing of video to wall tile positions can be interactively 
achieved. 

Deployment
Deployment is a one-step process, requiring the finished project to be simply pushed to the 
GV Orbit Server. Behind the scenes, the video wall designs are then automatically translated 

Is the Multiviewer device on the network?

Yes No

Is Multicast data enabled on network?

Yes No

Multiviewer is 
automatically discovered 
by GV Orbit Client for the 

Clustered MV project.

Require manual entry of 
multiviewer devices into 
the Clustered MV project.

Add the device to the 
network.
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into constituent, individual ‘multiviewer projects’ which are targeted at each individual 
multiviewer of the cluster. The constituent projects are automatically pushed out to the 
individual multiviewer devices.

Clustered MV project vs. Multiviewer Project
A Clustered MV project is opened, saved, pushed etc. in a similar way to other GV Orbit 
multiviewer projects; the main exceptions/differences are listed in Table 14-2.

Use a Clustered MV project when defining and managing video walls from a cluster of MV-
8xx multiviewers.

IMPORTANT
Multiviewers should be operated either in a clustered mode or as 
individual, non-clustered single-multiviewers. 
Changing readily between these operational modes is not 
supported. 

Recommendation:
All multiviewer set-up and configuration is carried out fully for the 
intended mode of operation.

 Table 14-2: Clustered MV Project Differences 

Item
GV Orbit Project Type

Clustered Multiviewer Multiviewer, or
Connected Multiviewer

Video wall design tool Room Editor 
in GV Orbit Client

Wall Editor a
in GV Orbit Client

Multiviewer resource(s) One or more multiviewer devices. 
(NCluster devices in an MV Cluster)

A single multiviewer device.

GV Orbit System Required, running a MV Cluster 
Manager Service

Can operate with or without a GV 
Orbit system

Deployment Push project to a 
GV Orbit Server repository.

Push project to a 
single multiviewer device.

Max number Video Walls up to 12x NCluster 12

Max number Video Tiles up to 48x NCluster 48

Video Wall Arrangement Flexible Constrained

Video Wall Layouts Yes, Room Layout No.

Monitor-level Layouts Yes, Monitor Layout Yes, Wall Layout

a.For information on the Wall Editor, refer to Orbit documentation.
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Room Editor vs Wall Editor
Wall Editor - Both the original Orbit Client tool and the current GV Orbit Client allow 
configuration of video walls from single multiviewers using the original GV Orbit 
‘Multiviewer’ type projects and the Wall Editor tool (refer to Orbit documentation).

Room Editor - GV Orbit additionally allows configuration of video walls from a multiviewer 
cluster with a ‘Clustered MV’ project. This is done via the new Room Editor tool in GV Orbit 
Client with the MV Cluster Manager service running on a GV Orbit Server.

Single Multiviewer as an MV Cluster
A single multiviewer may be considered as an ‘MV Cluster of one’ and a video wall design can 
be generated for a single multiviewer with the Room Editor in a ‘Clustered MV’ project. 

What is an MV Cluster Manager?
The MV Cluster Manager is a service running on the GV Orbit Server which automatically 
translates a GV Orbit ‘Clustered MV’ project into its constituent, single-multiviewer projects. 
The service automatically manages each individual multiviewer device of an MV Cluster. A 
GV Orbit system may have zero or one such service.

Once it is configured, the service will:
• check for the availability of multiviewers in the room; and 
• put a watch on the relevant GV Orbit Server repositories for any project changes. 

The service processes any detected repository project changes and rebuilds any 
constituent single-multiviewer projects where necessary, automatically pushing the 
projects to the appropriate multiviewer device(s).

Note: Room Editor vs Wall Editor:

MV-8 Series multiviewer(s)

Cluster of 
one or more 

Single, individual

Client tool? Room Editor Wall Editora

a. For information about the Wall Editor, refer to Orbit documentation.

GV Orbit project type? Clustered 
Multiviewer

Multiviewer

Minimum system 
configuration 

GV Orbit system 
with server 

None

Uses MV Cluster 
Manager service?

Yes, 
an MV Cluster 

Manager service is 
required.

No

Note: For an MV Cluster of any size, an MV Cluster Manager service is 
required to be running on a GV Orbit Server.
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The service will alert the GV Orbit system to any off-line multiviewers and missing 
repositories.

The service is automatically discovered by a GV Orbit Client in a GV Orbit system and a user 
can then create a ‘Clustered MV’ project.

Configuring an MV Cluster Manager Service
The MV Cluster Manager service configuration is carried out on the GV Orbit Server.

The following settings can be configured from the MV Cluster Manager service’s 
configuration page on the GV Orbit Server:

• Service Settings:
• GVOP Client Domain ID number for the service to use.
• Network interface(s) on the GV Orbit Server for the service to use.
• RollCall address of the service in the GV Orbit system.
• A friendly name for the service, to be used in a GV Orbit Client’s Network window.

• Project Settings:
• GV Orbit Server repository name of the Clustered MV project for the service to use. 

Video Wall Configuration Workflow (Clustered Multiviewers)
This user guide describes the configuration and operation of clustered MV-8XX 
multiviewers in a GV Orbit control and monitoring system for multiple video walls, for 
example in an OB truck environment.

This chapter has provided some MV Cluster definitions. It proceeds to provide some MV 
Cluster information:

1 Configuring an MV Cluster Manager Service, on page 658.
2 Creating a New Clustered Multiviewer Project for an MV Cluster, on page 659.
3 Clustered MV Project Screens, on page 668.
4 Managing Multiviewer Cluster Information in a Project, on page 671.

Additionally, the workflow description is continued in further user guide chapters:
5 Chapter 15, MV Cluster - Room Editor:

a Room Editor Introduction, on page 675.
b Room Editor Workflow, on page 686.
c Step 1: Create a Room, on page 689.
d Step 2: Arrange Monitors and Assign Multiviewer Outputs, on page 691.
e Step 3a: Design Layout - Assign Tile Grid Layouts to a Video Wall, on page 704.

Refer to: Refer to the GV Orbit Admin Guide for information about GV Orbit 
services, including configuring the MV Cluster Manager service. 
See Related Documentation, on page 7. 

Note: The ‘Project Settings’ may be set up separately later, when a 
‘Clustered MV’ project has been created along with its repository.
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f Step 3b: Create Optional Alternative Layouts for a Video Wall, on page 713.
g Step 4a: Assign Destinations to Tile Positions, on page 722
h Step 5a: X/Y Routing Video Sources to Tiles, on page 741.

Also see Chapter 16 MV Cluster - TSL Tally Configuration, on page 757, and Chapter 17 
Audio Bars Configuration, on page 783.

Creating a New Clustered Multiviewer Project for an MV Cluster
The video walls served by an MV Cluster are defined with a ‘Clustered Multiviewer’ Project 
in GV Orbit Client. 

Procedure
To create a new ‘Clustered Multiviewer’ project (Clustered MV project) in GV Orbit Client:

Step 1: Create and Connect a Project to a GV Orbit Server
1 Open GV Orbit Client.

The initial screen is shown.

Fig. 14-2: Initial Screen of GV Orbit Client

2 Select New Project on the initial screen.

The New Project dialog is shown.
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Fig. 14-3: New Project Dialog

3 Select the Clustered Multiviewer project type. (See Figure 14-3.)
4 Enter a Name for the new project in the ‘Details’ section.

This is a name for the local storage of project information.
5 Browse to a folder location (local or network) for the project to be stored in while the 

multiviewer video walls are being designed. 

6 Click Choose to select the folder.

Fig. 14-4: Filled Out New Project Dialog

7 Click OK in the dialog.

Note: Folder Location:
The folder location must be accessible from the client computer 
running the GV Orbit Client tool. This location is used while the 
project is being edited. 
When the editing is complete and the project is ready to be deployed, 
it is pushed from the GV Orbit Client to a central repository location 
on the GV Orbit Server of the GV Orbit system.

Select Clustered Multiviewer 
project type.

Enter a Name for the new 
project.

Browse to a folder location.
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A Setup dialog for the project is then shown. See Figure 14-7.

Project Setup Dialog:

Fig. 14-5: Setup Dialog 

In the clustered multiviewer project’s Setup dialog:
8 Set Server 1 IP to the IP address of the GV Orbit Server and press Enter.

(For a GV Orbit Server Cluster system, still just enter the IP address of one server. The 
second server will be discovered automatically in the steps below.)

After the IP address is entered, some basic system tests are carried out using the 
current, original settings of the Setup dialog. 
(This basic system testing includes testing system connectivity and gathering some 
basic system information from the GV Orbit Server.) 

The results of these basic system tests are then shown in the Setup dialog’s console 
window.

9 After these basic system tests are done, any differences in the settings are adopted by 
the Setup dialog.

Step 2: Repository for Clustered MV Project
When creating a new ‘Clustered Multiviewer’ project, a new repository needs to be created.

(Compare to when opening an existing ‘Clustered Multiviewer ‘project; in this case, an 
existing repository must be specified, see Open an Existing Clustered Multiviewer Project, 
on page 664.)

Note: The current, original dialog settings will most likely differ from those 
of the GV Orbit system being connected to. Discrepancies are shown 
in red-highlighted text in the dialog’s console window. This is normal.

Server 1 IP

Basic system test results
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To Create a New Repository for the Project:

In the Setup dialog, to create a new Repository to be used: 
1 At the Repository setting, click New.

Fig. 14-6: Click New in Setup Dialog 

The Create Repository dialog is shown.

2 Enter a Name for the new repository on the 
GV Orbit Server for the ‘Clustered MV’ project to use and press Enter, or click OK.

The new repository name is shown in the Setup dialog.

Note: Characters to use in a Repository Name:
Use only:

• alpha-numeric characters (0 1 2 A B C x y z etc.); and/or
• underscore characters (_); and/or 
• tilde characters (~).

Note: Repository Name:
Use a unique and identifiable repository name for the ‘Clustered MV’ 
project to use. In this way, it is easily identified and found in a list of all 
repositories on a server.

Click New
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Step 3: System Re-Test (optional) During Project Setup
With a new or an existing Repository name shown in the Setup dialog, a system re-test can 
be carried out.

1 Click System Test.

This re-does the basic system tests. The results are shown in the console. Any ‘red’ items 
from before should now be cleared. See Figure 14-7.

Fig. 14-7: System Re-Test

Step 4: Finally, Create Project
1 Click Apply in the Setup dialog.

The settings are applied 
to the project and a 
progress bar appears in 
the dialog.

IMPORTANT
If a new Repository has been created during the ‘Clustered MV’ 
project creation, then the MV Cluster Manager service repository 
needs to be configured with the new Repository.
(See the ‘Project Settings‘part of Configuring an MV Cluster Manager 
Service, on page 658.)

Note: At this point, a system re-test is optional and will now remove any 
red items in the console pane. Optionally, in the Setup dialog:
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2 While settings are applied, a pop-up dialog 
may appear, asking if the local project 
should be updated from the chosen 
repository:

For a new project where no changes have 
been made locally, answer Yes.

• Click Yes to update the local project 
from the repository on the server (this will lose any local changes made); or

• Click No to keep any local project changes made (and not pull the project from the 
repository on the server).

3 While the applying of the settings continues, progress is shown in the progress bar. 
4 When the settings changes are all applied, an All Done message pops up. 

:

Fig. 14-9: Applying of Project Settings is All Done

5 Click OK.
6 Close the Setup dialog.

The new Clustered Multiviewer project is created and its Home screen is then shown. 
See Clustered MV Project Home Screen.

7 Click OK.

The Clustered Multiviewer project information is contained in the local folder, ready for 
editing. For a newly-created project it is an empty project.

Open an Existing Clustered Multiviewer Project
To open an existing ‘Clustered Multiviewer’ project from a repository on the GV Orbit Server, 
the procedure is similar to the procedure for creating a new ‘Clustered Multiviewer’ project 
(refer to Creating a New Clustered Multiviewer Project for an MV Cluster, on page 659).

The steps below open an existing project from an existing repository.

Procedure

Step 1: Create and Connect
1 Carry out the steps in Step 1: Create and Connect a Project to a GV Orbit Server, on 

page 659.

This creates an empty, locally-stored project.

Note: The Setup dialog can also be viewed when a GV Orbit project is open 
by clicking Connections > GV Server in the main menu.

Fig. 14-8: Update Local Project?
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Step 2: Repository for Clustered MV Project
When opening a Clustered MV project from a repository, an existing repository must be 
specified:

To specify an existing Repository for the project, in the Setup dialog: 
1 At the Repository drop-down box, select a Repository from the drop-down list. (See 

Figure 14-10.) 
The repository must be a ‘Clustered Multiviewer’ repository.

Fig. 14-10: Select Existing Repository

The selected Repository name is shown in the Setup dialog.

Step 3: System Re-Test (optional)
With a Repository name shown in the Setup dialog, a system re-test can be carried out.

1 Carry out the steps in Step 3: System Re-Test (optional) During Project Setup, on 
page 663.

Step 4: Finally, Open the Project from the Repository
1 Click Apply in the Setup dialog.

The settings are applied 
to the project and a 
progress bar appears in 
the dialog.

2 While settings are applied, a pop-up dialog 
may appear, asking if the local project 
should be updated from the chosen 
repository:

For a new project where no changes have 
been made locally, answer Yes.

Select an existing RepositoryClick on drop-down arrow

Fig. 14-11: Update Local Project?
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• Click Yes to update the local project from the repository on the server (this will lose 
any local changes made); or

• Click No to keep any local project changes made (and not pull the project from the 
repository on the server).

3 While the applying of the settings continues, progress is shown in the progress bar. 
4 When the settings changes are all applied, an All Done message pops up. 

Fig. 14-12: Applying of Project Settings is All Done

5 Click OK.
6 Close the Setup dialog.

The exiting Clustered Multiviewer project is opened and its Home screen is then 
shown. See Clustered MV Project Home Screen.

7 Click OK.

The Clustered Multiviewer project information is contained in the local folder, ready for 
editing. For a newly-created project it is an empty project.

Deploying a Clustered Multiviewer Project (Push/Pull)
For deployment, a Clustered MV project is pushed to a central store on the GV Orbit Server, 
for example, to the Repository. There is one project per Repository. 
Compare this to a single-multiviewer project: that is for a non-clustered multiviewer device, 
in which case the project is pushed to the multiviewer itself.

Push Project to Repository
To send a locally-saved and edited project to the Repository for automatic deployment on 
the multiviewer cluster by the MV Cluster Manager Service on the GV Orbit Server:

Note: To edit an existing repository project information on a new PC, then 
click Yes to pull the existing project information from the repository 
into the newly created ‘Clustered MV’ project.
If you click No here, then subsequent pushing back to the repository 
will overwrite the existing project information in the repository.

Note: The Setup dialog can also be viewed when a GV Orbit project is open 
by clicking Connections > GV Server in the main menu.

Note: The Home Page is not automatically refreshed, and new Room files 
will not be shown. 
Close and re-open the project to refresh and then see files pulled 
from the repository.
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1 Click Push in the main tool bar.

Fig. 14-13: Push in Tool Bar

A Choose Projects dialog is shown.

Fig. 14-14: Choose Push

2 Ensure that the project Repository to be pushed is selected (highlighted in blue) in the 
dialog. See Figure 14-14.

3 Click OK.

The project information is pushed to the Repository.
4 When the Push is done, a Push dialog is shown.

Fig. 14-15: Push Done

5 Click OK to close the Push dialog.

Pull Project from Repository
To get a project from a Repository into an opened project for editing and/or locally saving: 

1 Click Pull in the main tool bar.

Fig. 14-16: Pull in Tool Bar

A Choose Projects dialog is shown.
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Fig. 14-17: Choose Pull

2 Ensure that the project Repository to be pulled is selected (highlighted in blue) in the 
dialog. See Figure 14-17.

3 Click OK.

The project information is pulled from the Repository.
4 When the Pull is done, a Pull dialog is shown.

Fig. 14-18: Pull Done

5 Click OK to close the Pull dialog.

Clustered MV Project Screens

Clustered MV Project Home Screen
The Home screen of a Clustered Multiviewer project is shown in Figure 14-19.

Note: For best practice, Pull a project before starting to edit it. 
This ensure that the most up to date project information is used.
If there are any conflicts between locally-stored project information 
and the repository, then you are prompted. You may then either 
discard their changes, or keep their changes and discard any server-
side changes.



669

GV Orbit Version 2.3.0 Multiviewer Cluster
User Guide Clustered MV Project Home Screen

Fig. 14-19: Clustered Multiviewer Project Home Screen

The Home screen of the Clustered MV project is similar to that for a GV Orbit Multiviewer 
project; differences include:

• Multiviewer Cluster dialog which lists the multiviewers of the cluster. 
(Main menu item ‘Multiviewer -> Multiviewer Cluster’.)

• Rooms icon on the Home screen which allows you to create .room files and edit them 
in the Room Editor. (See Chapter 15, MV Cluster - Room Editor, on page 675.)

• Project window has a ‘rooms’ sub-folder for .room files.

The large icons are similar to (non-clustered) multiviewer projects:
• Manage Users - Set up project users and their roles. (See Chapter 4, Manage Users, on 

page 141.)
• Themes - Edit or create new on-screen appearance styles for graphical widgets for use 

on the video wall.
• Rooms - Edit or create .room file(s) with the Room Editor tool for the ‘Clustered 

Multiviewer’ project. (See Chapter 15, MV Cluster - Room Editor, on page 675.)
• Tiles - Edit or create new Custom Tiles for use on the video wall.

Main menu bar
Project name

Click Edit to edit Project name
Main tool bar

Local path to project folder

Click ‘Multiviewer > Multiviewer Cluster’ in 
the main menu for information on the 
multiviewers in the MV Cluster.

Click Rooms icon to create a .room file in the project 
and open it in the Room Editor.
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Main Menu Items
See Main Menu Items, on page 127.

Main Tool Bar Items
See Main Tool Bar Items, on page 132.

Further Tool Bar items are shown when a multiviewer video wall is open. See Main Tool Bar 
with Room Editor Open.

Clustered MV Room Editor Screen
The Home screen of the Room Editor is shown in Figure 14-20.

Fig. 14-20: Clustered Multiviewer Room Editor Screen

For further description of the Room Editor, see Chapter 15, MV Cluster - Room Editor, on 
page 675.

Main menu bar
Properties BoxMain tool bar

.room file open in Room Editor tab window

Room Editor tool bar

Network window

Project window
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Main Tool Bar with Room Editor Open
Additional tool bat icons are shown here. See Main Tool Bar Items for the other icons.

Fig. 14-21: Clustered Multiviewer Main Tools Bar with Room Editor Screen Open

Managing Multiviewer Cluster Information in a Project
The multiviewers in a multiviewer cluster are automatically discovered by GV Orbit where a 
network allows multicast discovery data packets.

In addition, a user can manually add one or more networked multiviewers to the cluster. 

View/Edit Multiviewer Information about Multiviewers in the Cluster

Procedure
To view information about each multiviewer in the multiviewer cluster:

1 Click ‘Multiviewer > Multiviewer Cluster’ in the GV Orbit Client main menu.

The Multiviewer Cluster dialog is shown. See Figure 14-22. 
The dialog shows the auto-discovered multiviewers of the cluster.

Run/Design Mode
shown in Design mode)

Properties window

Dock/Undock the active window

Set the active window to full-screen mode

Display drawing grid

Options 
(Tools > Options in main menu)

Zoom stage screen in/out

Graphic object alignment controls,
see Graphic Object Alignment Controls, on page 134

Graphic object layer

Note: Manual entry of multiviewer devices is required where a network 
does not have multicast data enabled.
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Fig. 14-22: Multiviewer Cluster Dialog

In the Multiviewer Cluster dialog, the following should be manually set up:
2 Select the number of ‘Heads’ that are licensed for each multiviewer in the list.
3 Select the output ‘Resolution’ for the multiviewers.
4 Click OK.

If required, multiviewers can be explicitly added, see Adding Multiviewers Explicitly.

Adding Multiviewers Explicitly
It is possible to add multiviewers to the list in the Multiviewer Cluster dialog. This may be 
required if, for example, multicast discovery data packets are not allowed on a network. 

Procedure
To add multiviewers manually:

1 Click New to add the information about each multiviewer of the cluster. See Figure 14-
23. 

2 Click OK to close the dialog.
3 Click Project -> Save Project in the main menu to save the project locally.

Note: The head display outputs of an MV-8 Series multiviewer all share the 
same resolution. Select either 1920x1080 or 720x1280.
UHD (4K) is achieved with four outputs and 1080p quad-link.

RollCall address
IP address

Number of supported, licensed 
multiviewer head display outputs

Multiviewer output resolution
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Fig. 14-23: Multiviewer Cluster Dialog- Adding New Multiviewer Device

Video Walls Etc. Design Workflow for an MV Cluster
For instructions on designing video walls in a ‘Clustered MV’ project see the workflow 
described in:

• Chapter 15, MV Cluster - Room Editor, on page 675.

Also see these additional design steps:
• Chapter 16 MV Cluster - TSL Tally Configuration, on page 757.
• Chapter 17 Audio Bars Configuration, on page 783.

MV-8 Series multiviewer head display outputs all 
share the same resolution. 
Select either 1920x1080 or 720x1280.
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15MV Cluster - Room Editor

Room Editor Introduction

Room Editor is a facility offered in a ‘Clustered MV’ project in GV Orbit Client. It enables a 
user to design one or more video walls that are served by a cluster of multiviewers. This 
allows a user to design and manage all the video walls in a production-facility (for example, 
studio, or OB truck). The multiviewer devices are automatically discovered by GV Orbit 
Client.

Fig. 15-1: Example Facility Schematic - Cluster of Multiviewer Devices Serving a Production Facility

In the This section defines and describes some terms etc. used when using the Room Editor 
in GV Orbit Client., a user can define and position all of the physical monitor displays for all 
their video walls. Assignment of multiviewer devices and outputs to video wall monitors is 
performed once. Video walls can be fed by any multiviewer output available in the 
multiviewer cluster and are assigned to router destinations. Assignment of video signals to 
the video wall for monitoring is integrated into the GV Orbit routing system and carried out 
with a graphical interface in GV Orbit Client.

Lite Professional Enterprise

 

Cluster of multiviewers

Video walls, Rooms
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Subsequent design and management of all the various video walls is then independent of 
the individual multiviewers in the cluster and video tile positions on the video wall are 
referred to with router destination names.

The Room Editor also enables a user to set up TSL tally settings and audio bars 
configuration for a video wall.

This section defines and describes some terms etc. used when using the Room Editor in 
GV Orbit Client.

What is a Room?
A Room (also known as a Room file, or, simply, a Room) is part of a Clustered MV project. A 
file holds information for a video wall (Room Design). There can be more than one Room 
in a Clustered MV project. 

The files are stored in the ‘Clustered MV’ project’s folder structure, in the ‘rooms’ sub-folder, 
and are accessible from the Project window in GV Orbit Client or from the opening project 
Home Page.

Fig. 15-2: Room Files in a Clustered Multiviewer Project Describe Video Walls

Cluster of 
multiviewers
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What is a Room Design?
A video wall is formed in a ‘Clustered MV’ project from ‘physical’ video monitor displays. 
Each video wall design is a Room Design. A user can form a large video wall from multiple 
‘physical’ displays arranged and configured. They can be driven from one or more 
multiviewer devices from an MV cluster. Video wall tile layouts can be applied and video 
tiles can be assigned router destinations. 

A Room Design is stored in a Room file. 

See Step 1: Create a Room, on page 689, for the workflow steps.

What is Monitor Arrangement and Multiviewer Output Assignment?
As part of a Room Design, a user can configure a large video wall from multiple ‘physical’ 
displays and driven from one or more multiviewer devices from an MV cluster. 

Fig. 15-3: Room Designs: a) Arranging Monitors; b) Assigning and Configuring Multiviewer 
Outputs.

b) Assign a Multiviewer Output to Each Monitor

Cluster of multiviewers

Monitors

a Room Design

a) Arrange Monitors for each video wall
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Monitor Arrangement includes:
1 Creating a representation of a large video monitor wall by positioning ‘physical’ 

displays on a ‘stage’. 
2 Defining each display, including:

• Display size, geometry.
• Type: single HD, or quad-split for UHD. 
• Orientation: Vertical or Horizontal. 

Assign Outputs includes:
3 Assigning a multiviewer output to each physical monitor display. 

A monitor arrangement and assigned outputs in a Room file can be saved locally and, 
when complete, the Room Design can be saved centrally on a GV Orbit Server in a 
‘Clustered Multiviewer’ project.

See Step 2: Arrange Monitors and Assign Multiviewer Outputs, on page 691, for the 
workflow steps.

What is Room Design Layout?
This defines the arrangement of tiles used in a project for each video wall monitor. 

The arrangement of tiles plus their connection to multiviewer inputs on a monitor is termed 
its Layout. 

Note: A UHD monitor is fed from four MV-8 Series multiviewer “HD” 
multiviewer outputs. These must be multiviewer outputs from the 
same multiviewer device.

Note: Monitor aspect ratio is assumed to be 16:9.
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Fig. 15-4: Video Wall Design Layout

Layout Workflow
For a created Room Design, for each monitor:

• A tile-grid is applied from a selection of templates (for example, 2x2, 3x3 etc.) to 
position tiles and fine-positioning can be done. 

• Each tile type is then defined (for example, video tile, audio tile, or custom tile).

This has prepared a basic Design Layout in a Room Design.

(See What is a Monitor Layout?, and What is a Room Layout?)

See Step 3a: Design Layout - Assign Tile Grid Layouts to a Video Wall, on page 704, for the 
workflow steps.

What is a Tile-Grid?
A tile-grid determines the position and size of tiles on a monitor, irrespective of tile type. 
For example, a tile-grid may comprise:

• 3x3 tiles; or of
• one larger, central tile surrounded by twelve smaller tiles .

A tile-grid includes the assignment of multiviewer inputs and router destinations to each 
tile position in the grid.

Tile-Grid Excludes Tile Types
A tile-grid excludes the tile types that populate the tile-grid. 

Tile layouts added to video wall monitors

Tiles
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What is a Monitor Layout?
In a project, monitors on the video wall are each configured to show a tile-grid layout, 
either from pre-configured grids (2x2 or 3x3 etc.), or from user-defined grids. These 
‘monitor layouts‘ then make up the layout of the entire video wall.

Further, an individual monitor may be set up with a set of two or more alternative tile-grid 
layouts which can be available to the monitor at run time. (For example, there may be a 2x2, 
3x3, a 4x4 tile grid and a user-defined tile grid layout in the set of alternative layouts to 
select from at run time on the monitor.) 

These alternative layouts are saved for an individual monitor for selecting at run time on the 
video wall. These are called Monitor Layouts and they apply to individual monitors on the 
video wall.

These ‘monitor-level’ layouts form part of the overall Layout Configuration. 

Monitor Layouts can be created (see Create a New Monitor Layout, on page 713).

Monitor Layouts can be selected live for a video wall in X/Y Routing mode (see Step 5b: 
Change Layouts in X/Y Routing Mode, on page 751).

What is a Room Layout?
A Room Layout is a snapshot of Monitor Layouts across the monitors on a video wall. A 
Room Design can have one or more Room Layouts to select from. This ‘room-level’ layout 
applies across a whole video wall in a Room.

(See Step 3b: Create Optional Alternative Layouts for a Video Wall, on page 713, for the 
workflow steps.)

Room Layouts enable a video wall to have various optional, alternative, similar layouts to 
use for different scenarios. Table 15-1 shows some possible example combinations.

Note: Tile-grid + Tile types = Monitor Layout. 
(See What is a Monitor Layout?.)

Note: Live-Selecting of Monitor Layouts:
Monitor Layouts are live-selectable.

(Monitor Layout in the Room Editor tool is equivalent to 
Wall Layout in the Wall Editor tool in GV Orbit Client.)
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Room Layouts can be created (see Create a Room Layout for a Video Wall, on page 717).

Room Layouts can be selected live for a video wall in X/Y Routing mode (see Step 5b: 
Change Layouts in X/Y Routing Mode, on page 751) and, in this mode, they may also be 
created live and saved.

What is Destination Assignment for a Room?
Assignment of router destinations to tile positions on the video wall tile-grid allows you to 
manage video walls, and their specifically tile positions, in terms of router destinations.

Assignment of destinations is done for all video walls in a Clustered MV project (for 
example, for all Rooms in the project). There are two destination assignment mechanisms 
that can be used:

• Static Destination Assignment - see What is Static Destination Assignment?, on 
page 682.

• Dynamic Destination Assignment - see What is Dynamic Destination Assignment?, 
on page 683.

 Table 15-1: Example Room Layouts with different Monitor Layouts Combinations

Room Layouts

Monitor Layouts

Monitor 1
Monitor Layouts

Monitor 2
Monitor Layouts
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Fig. 15-5: Video Wall - Assigned Destinations

TSL Configuration and Audio Bars Configuration
Additionally, this Room Editor mode allows:

• TSL settings to be configured globally for the Room. 
(See Chapter 16, MV Cluster - TSL Tally Configuration, on page 757.)

• Audio bar configuration for Audio Bars in on-screen graphical widgets to be configured 
globally for the Room. 
(See Chapter 17, Audio Bars Configuration, on page 783.)

What is Static Destination Assignment?
Static Destination Assignment is where one, or more, or all video tiles on video walls are 
manually assigned specific router destinations. It may be implemented partly or fully in a 
system. Full static assignment is suitable in routing systems where each video tile on each 
video wall from each multiviewer is assigned a fixed, specific router destination, which 
needs to remain static throughout routing operation. (For example, this may be suitable for 
systems with third-party router controllers.)

For a created Room Design, for each monitor in a video wall, the workflow for static 
destination assignment is:

1 Router destinations are manually mapped to multiviewer inputs for all devices in the 
MV cluster.

2 Destinations are then manually assigned to tile positions on the video walls.

This has prepared the Destination Assignments for monitors in a Room. The multiviewers 
are ready have signals routed to them.

Router destinations assigned to each tile position.
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What is Dynamic Destination Assignment?
Dynamic Destination Assignment implements routing based on video wall tiles rather 
than on router destinations. This is made possible with the integrated nature of 
multiviewing and routing in a GV Orbit system.

The assignment of router destinations to video tiles is done at run time by a GV Orbit 
service. This keeps track of the current video wall active layouts for each multiviewer. The 
service then knows which multiviewer inputs are actively feeding video tiles and which are 
free. This information is shared with the GV Orbit system.

Upon a video wall layout change, the service re-assigns destinations on the fly to meet the 
needs of the newly switched-to layout. 

In this way:
• A user does not have to keep track of multiviewer input usage across different video 

wall layouts.
• Multiviewer inputs (up to 48 per multiviewer) can flexibly accommodate the needs of 

different video wall layouts.
• It is easier for a user to design video walls, because dynamic destination assignment is 

the default on video tiles from the outset. 
(Note: A video tile can still be set to a static destination, preventing the destination to 
be assigned dynamically if required.)

Note: The GV Orbit Multiviewer Cluster Manager Service (MVCMS) is 
required for the dynamic destinations assignment to function.

Note: TSL assignments made will automatically follow any destination re-
assignments done in dynamic destination assignment mode.
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What is X/Y Routing Source Assignment for a Room?
The final step in designing the video wall (Room) involves routing sources to all of the tile 
positions in each monitor tile-grid. This is done with an integrated, easy-to-use, graphical 
routing panel enabling you to route by selecting sources and destination tiles.

Fig. 15-6: Video Wall - Routed Sources

The ‘X/Y Routing’ tool mixes a graphical representation of the monitor wall with a (router) 
source selection panel. The monitor wall representation is the (router) destination selection 
panel. 

A source can easily be assigned (routed) to a tile position on a monitor of a video wall. 

See Step 5a: X/Y Routing Video Sources to Tiles, on page 741, for the workflow steps.

Routing Sources Workflow
The workflow for each video tile position on a monitor is:

1 select the tile position in the monitor’s tile-grid (this is the destination to route to); and
2 select the source.

When a route is made, all levels are routed. and tile positions on the tile-grid show their 
logical names.

Router sources assigned to each tile position.
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Room Editor Home Screen

Fig. 15-7: Room Editor Screen Example

The Room Editor stores video wall design information for one or more video walls in a 
single ‘Clustered MV’ GV Orbit project (see What is a Clustered Multiviewer Project?). Each 
video wall design is stored in a Room file (see What is a Room?) in the project.

Room Editor Workflow Overview
Room Editor allows a user to easily create video walls. This is an overview of the workflow:

1 Create monitor wall arrangements from one or more monitors and assign multiviewer 
outputs. 

2 Create the layout - Assign tile-grids to each monitor in the video wall and populate with 
tile types, and create all room layouts and monitor layouts.

3 Assign router video destinations to video wall tile positions in the grid. 
4 Assign video sources to video wall tile positions in the tile-grid.

The Room Editor workflow steps are outlined in Room Editor Workflow, on page 686. The 
steps are then fully described in the subsequent sections of this chapter, that is in sections: 
Step 1: Create a Room through to Step 5a: X/Y Routing Video Sources to Tiles.

Video wall design open in Room Editor tab window

Room Editor Tool Bar 
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Room Editor Tool Bar
The first few icons in the Room Editor tool bar follow the MV Cluster video wall design’s 
Room Editor workflow and take you through the various modes of operation of the Room 
Editor workflow.

Room Editor Workflow
The workflow for creating Room designs in the Room Editor is listed here and described in 
the following sections of this chapter. A prerequisite is a GV Orbit ‘Clustered MV’ project 
open in GV Orbit Client. (See Creating a New Clustered Multiviewer Project for an MV 
Cluster, on page 659.)

Workflow steps overview:
• Create a Room (Room File)

Icon Description

 Switch to assign 

multiviewer outputs 
mode

Select for Arrange Monitors and Assign MV Outputs Mode. See 
Arrange Monitors and Assign Multiviewer Outputs, on page 687.

 Switch to design 

layout mode

Select for Design Layout Mode. See Design Room Layout - Assign Tile 
Grid Layouts, on page 687.

 Switch to assign 

destinations mode

Select for Assign Router Destinations Mode. See Assign Router 
Destinations to Tile Positions, on page 688.

 Switch to X/Y 

routing mode

Select for X/Y Routing Mode. See Routing Video Sources to Tile 
Positions, on page 688.

 Delete Click to delete the selected item (monitor).

 Room layouts Room Layout actions.

 Monitor layouts Monitor Layout actions.

 Configure the 

mapping from 
multiviewer input to 
router destinations

Map multiviewer inputs to router destinations.

 Enable freehand 

positioning of tiles

Fine, free-hand positioning of tiles on tile-grid.

 Select all tiles Select all tiles on selected monitor.

 Save and load 

source assignments 
by default

When set, this automatically saves the sources associated with tiles for 
each layout. On a layout change the source is automatically recalled 
and routed.
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• Arrange Monitors and Assign Multiviewer Outputs
• Design Room Layout - Assign Tile Grid Layouts
• Create Optional Alternative Layouts for a Video Wall
• Assign Router Destinations to Tile Positions
• Tally Configuration
• Routing Video Sources to Tile Positions

These steps are outlined in subsequent sections of this chapter, listed as Workflow 
Procedure Steps, on page 689.

Create a Room (Room File)
Firstly, for each video wall, create a Room for each video wall.
See Step 1: Create a Room, on page 689.

Then, for each Room, create a Room Design to form the video wall design, as described in 
subsequent sections:

Arrange Monitors and Assign Multiviewer Outputs
See Step 2: Arrange Monitors and Assign Multiviewer Outputs, on page 691.

Position monitors on a ‘stage’; define monitor types (includes size, orientation, single HD or 
quad-split for UHD); and assign one or more MV outputs to each monitor.

Design Room Layout - Assign Tile Grid Layouts
See Step 3a: Design Layout - Assign Tile Grid Layouts to a Video Wall, on page 704.

Assign tile-grid templates to the monitors of the video wall; populate with tiles; and 
customize if required to form the video wall layout. Additionally, manage destinations 
assigned to the video wall tiles.

Note: The Assign Multiviewer Outputs mode of the Room Editor does 
not use ‘Run mode’ ; the ‘Design/Run Mode’ tool bar icon is hidden
(See Design Mode / Run Mode, on page 133.)
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Create Optional Alternative Layouts for a Video Wall
See Step 3b: Create Optional Alternative Layouts for a Video Wall, on page 713.
 This mode enables creates different layouts for the video monitor wall.

Assign Router Destinations to Tile Positions
See Step 4a: Assign Destinations to Tile Positions, on page 722.

This mode: maps destinations to multiviewer inputs; assigns destinations to video wall tile 
positions on each tile-grid; and can also be used to assign TSL settings for the Room.

The mapping made between router destinations and multiviewer inputs needs to be made 
whether operating in the Dynamic Destination Assignment mode or in the Static 
Destination Assignment mode, or in a mixture of both. All the destinations that are 
mapped to tiles configured for dynamic assignment will be assigned dynamically.

Tally Configuration
See Step 4b: Configure TSL Tally Settings for a Room, on page 741.
Optional at this stage and may be done separately later.

Routing Video Sources to Tile Positions
See Step 5a: X/Y Routing Video Sources to Tiles, on page 741.

This mode routes required sources to video tiles for the required video monitoring. 
Different video monitor wall layouts can be selected from this Room Editor mode and seen 
live on the video monitor wall. Additionally, new layouts can be tried and saved.

Note: Design Room Layout mode of the Room Editor may operate in 
GV Orbit Client’s Design or Run Mode.
(See Design Mode / Run Mode, on page 133.)

Note: The Assign Router Destinations mode of the Room Editor does not 
use ‘Run mode’ ; the ‘Design/Run Mode’ tool bar icon is hidden. 
(See Design Mode / Run Mode, on page 133.)

Note: Routing Video Sources mode of the Room Editor operates in ‘Run 
Mode’, allowing live changes on a video wall to be made.
(See Design Mode / Run Mode, on page 133.)
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Workflow Procedure Steps
Workflow steps described in subsequent sections of this chapter:

• Step 1: Create a Room, on page 689
• Step 2: Arrange Monitors and Assign Multiviewer Outputs, on page 691
• Step 3a: Design Layout - Assign Tile Grid Layouts to a Video Wall, on page 704
• Step 3b: Create Optional Alternative Layouts for a Video Wall, on page 713
• Step 4a: Assign Destinations to Tile Positions, on page 722
• Step 4b: Configure TSL Tally Settings for a Room, on page 741
• Step 5a: X/Y Routing Video Sources to Tiles, on page 741
• Step 5b: Change Layouts in X/Y Routing Mode, on page 751

Step 1: Create a Room
Create a Room (Room file) with the Rooms icon from the Home Page or from the Project 
window. All video wall design information for one video wall will be stored in the Room 
file. A project may contain one or more Room files, which are shown in the Project window.

Create a Room for each video wall.

Procedure
To create a Room in the project from the Home Page:

1 Click the Rooms icon on the Home Screen and click New Room.

The New Room File dialog is shown. (See Figure 15-8)
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Fig. 15-8: New Room File Dialog

2 Enter a name for the Room and click OK.

A new, empty Room is created and is shown in the Project window in the ‘rooms’ sub-
folder.

Fig. 15-9: Create New Room File

Alternative Procedure, from Project Window
Alternatively, to create a Room from the Project window (see Figure 15-10):

Click OK.

Enter a name for the Room file.

Click New Room.

Room file is created and shown 
in the Project window.

Project window ‘rooms’ sub-folder.
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1 Right-click on the ‘rooms’ folder in the Project window and select New Room.

Fig. 15-10: Create New Room File

The New Room File dialog is shown.
2 Enter a name for the Room and click OK.

A new, empty Room file is created and is shown in the Project window in the ‘rooms’ 
sub-folder.

Step 2: Arrange Monitors and Assign Multiviewer Outputs

Rt-click on ‘rooms’ folder in 
Project window. 
Select New Room.



692

MV Cluster - Room Editor GV Orbit Version 2.3.0
Procedure User Guide

Prerequisites:
• There is a new Room in GV Orbit Client as part of a Clustered MV project.
• Multiviewers in the multiviewer cluster are discoverable or have been manually 

entered into the GV Orbit Client via the ‘Multiviewer > Multiviewer Cluster’ dialog of 
the Clustered MV project.

Procedure
Overview of procedure:

• Drag Monitors onto Video Wall Stage Area, on page 693.
• Configure Monitor on Video Wall Stage Area, on page 696.
• Arrange Monitors on Video Wall Stage, on page 700.

a) Arrange Monitors

b) Assign Multiviewer and Multiviewer Outputs

Cluster of multiviewers

Monitors

Video Wall Room Design
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Drag Monitors onto Video Wall Stage Area
To position monitors for one video wall, in the Project window:

1 Open the Room by double-clicking on the Room file name, or by right-clicking on it 
and selecting Open.

The Room opens in the Room Editor in GV Orbit Client. When first opened, the Room 
is shown in its ‘Assign Multiviewer Outputs’ mode. And All multiviewer outputs are 
listed in a banner at the top of the central stage area.

Fig. 15-11: New Room in Room Editor (‘Assign Multiviewer Outputs’ Mode shown)

Room name 
shown in tab.

Stage area

Room Editor tool bar Multiviewer outputs listed 
in banner,

’Assign Multiviewer Outputs’ mode button is selected.
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Note: If there are no multiviewer devices in the cluster, then the banner area 
is empty and a message appears at the bottom of the stage area, 
instructing you on how to add multiviewer devices to the cluster. 

“No multiviewers have been automatically discovered. 
To manually add a multiviewer, 
click ‘Multiviewer > Multiviewer Cluster’ from the tool bar menu.”

Fig. 15-12: Message at the Bottom of the Stage Area

(See Managing Multiviewer Cluster Information in a Project, on 
page 671 for a description of adding multiviewers to cluster.)

Note: Banner Controls:
The multiviewer outputs banner area has controls to help locate 
multiviewer outputs (especially useful with several multiviewers and 
outputs). Controls are (see Figure 15-13):

• Scroll control - A vertical scroll to see multiviewer outputs.
• Resize control - A splitter bar to re-size the banner and see 

more multiviewer outputs at one time.
• Filter control - A filter control to locate multiviewer outputs in 

the banner.

– Enter text in the filter text box. 
For example, Enter ‘Output 1’ to see:
multiviewer outputs ‘Output 1 MV1’, ‘Output 10 MV1’ ... and 
‘Output 1 MV2’, ‘Output 10 MV2’ etc. 
Note that this is case sensitive. For example, seraching for 
output returns nothing, where Output does find results.

– Click on the filter symbol and select a multiviewer name in 
the drop-down list to see all outputs from that multiviewer.

To clear the filter, clear the filter text box.
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2 Drag a multiviewer output from the banner onto the stage area and release.

Fig. 15-13: Drag on a Multiviewer Output

A representation of the monitor appears on the stage. See Figure 15-14. 

Fig. 15-14: Dragged-on Monitor

All multiviewer outputs

Drag a multiviewer 
output onto the stage

Use scroll control to see 
multiviewer outputs.

Drag splitter bar to see more/fewer 
multiviewer outputs.

Use the filter control to find 
multiviewer outputs.

Drag on

Monitor label: 
Output and multiviewer device is 
indicated in label for display 
purposes in the Room Editor.
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Configure Monitor on Video Wall Stage Area
1 Configure the monitor on the stage area by double-clicking on it.

The Configure Monitor dialog is shown (see Figure 15-15), where monitor properties 
can be changed.

2 Also, when a monitor is selected, 
its properties may be viewed and edited in the Properties window. 
To view the Properties window:

• Select the ‘Properties Window’ button in the main tool bar. See Figure 15-15.)
• Right-click on the monitoring and select Configure Output.

Note: For display purposes in the Room Editor, 
each monitor on the stage area has a label indicating which 
multiviewer output and device is being used for the monitor.

Note: Monitor Aspect Ratio:
Monitors aspect ratio should be 16:9.
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Fig. 15-15: Configure Monitor Dialog

To edit monitor properties, set up the monitor parameters in the Configure Monitor 
dialog, including:

3 TV Size - Enter the nominal monitor screen diagonal size (inches). 

When a value is entered:

• indicates a supported size; and

• indicates an unsupported size.

4 Rotation - Select the monitor screen orientation used: 

• Landscape ( ), 

Double-click on monitor to show its Configure Monitor dialog

Select Properties Window button to show Properties Window.
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• Portrait ( ); or 

• Inverted Portrait ( ).
5 Resolution - Define whether monitor is an HD monitor, or a UHD monitor (requiring 

quad-link multiviewer outputs) by selecting the corresponding icon:

• HD monitor ( ).

• UHD monitor, requires 4x multiviewer (HD) outputs ( ).

The following multiviewer assignment settings of the monitor are automatically set up 
when the monitor is dragged onto the screen. However, these may be changed in the 
Configure Monitor dialog, if required:

6 Multiviewer - Select a different multiviewer device to be assigned to the monitor, if 
required.

7 Multiviewer Output - Select different multiviewer output(s) (head output) to be 
assigned to drive the monitor. (Already-used outputs are grayed-out.)

For:
• HD monitors, select one output (see Figure 15-16a). 
• UHD monitors, select four outputs for driving the four monitor picture quadrants 

(see Figure 15-16b).
8 Re-ordering UHD monitor quadrants, if required, enables you to quickly and easily 

compensate for any quadrant wiring mis-matches. For UHD monitors:
• Re-order four the quadrant inputs by dragging monitor quadrants in the dialog, 

see Figure 15-16c.
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Fig. 15-16: Select Multiviewer Outputs for Monitor:
a) HD Monitor - one output selected.
b) UHD Monitor - four outputs selected.
c) UHD Monitor - selected outputs rearranged.

9 Monitor Name - Enter an optional operational name for the monitor, which will appear 
on the monitor label. For example “Cameras”, see Figure 15-17.

b) UHD Monitor - four outputs selected. c) UHD Monitor - outputs rearranged

a) HD Monitor - one output selected.
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Fig. 15-17: Monitor Name

Additionally, the following TSL item may be set up:
10 TSL 5.0 screen index to use by default for video tiles shown by the multiviewer output.

Finally, 
when all settings changes are complete in the dialog:
11 Click OK in the Configure Monitor dialog.

This has configured the monitor.

Arrange Monitors on Video Wall Stage
1 Position the monitor on the video wall stage area.

Enter an operational name for the monitor, 
which appears on the monitor label.

Note: If using the TSL 5.0 tally protocol, then set the TSL 5.0 screen index 
for each monitor screen.

Note: Undo / Redo:
Edits in the Room Editor are all un-doable and re-doable with the 
usual GV Orbit Client key strokes:

• CTRL-Z (undo action); and 
• CTRL-Y (redo action).
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Then:
2 Drag on further monitors, configure and position these to form your video wall monitor 

arrangement by abutting monitors on the stage.

Note: Fine Positioning:
Monitors can be finely-positioned using the arrow keys. 

Note: When dragging monitors on the stage, overlap of monitors is not 
permitted in a video wall. Any overlapping areas are shown in red.

Note: Monitor Alignment:
Monitors can be aligned and arranged on the stage using the GV 
Orbit Client’s alignment tools in the tool bar.

Note: Snap-to-Monitor and Snap-to-Grid:
Monitors will snap to other monitors on the stage when brought 
close. 
If ‘snap to grid’ is turned on for the Room Editor, then snap-to-grid 
takes precedence over snap-to-monitor when positioning monitors. 
(‘Tools > Option > App’ in main menu for Room Editor grid controls.)
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3 Click Project > Save File in the main menu to save changes to the Room file.

This has created a Room Design in a Room file in the Clustered MV project. 

A video wall is defined with its constituent monitors and connected to multiviewer outputs 
from the MV cluster.

Finally:
4 Repeat this for each video wall required for each Room.

Notes Etc. for Monitor Arrangement

Note: Copy-Paste Monitors with CTRL-C and CTRL-V:
Monitors can be copy-pasted for quick editing on the stage. The 
configuration of a copied monitor must be set up accordingly in the 
Configure Monitor dialog.
To copy-paste a monitor:

• Select a monitor on the stage and press CTRL-C. 
• Click elsewhere on the stage and press CTRL-V to paste a 

copy of the monitor. 
(Further CTRL-V will paste more monitors.)

CAUTION 
Multiviewer Outputs for UHD monitors:
When assigning four multiviewer outputs for a UHD 
monitor use any four licensed outputs from the same 
multiviewer device.
Note: All four outputs must be from the same multiviewer 
device. (This enables the required quad-split to be formed 
from four (HD) multiviewer outputs.)

Note: Landscape and Portrait:
Room Editor:
When using the Room Editor, a monitor arrangement can mix 
‘Landscape’ and ‘Portrait’ monitors.
Wall Editor:
However, when using the older Wall Editor, there is a restriction that 
‘Landscape’ and ‘Portrait’ must not be mixed on a video wall. 
(This restriction does not apply when using the Room Editor and a 
cluster of multiviewers.)
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Example Monitor Arrangement
Figure 15-19 shows an example video wall monitor arrangement with assigned multiviewer 
outputs.

Fig. 15-19: Example Video Wall Monitor Arrangement

Next step: Step 3a: Design Layout - Assign Tile Grid Layouts to a Video Wall

Note: Monitor Properties:
When the Properties window is open, selecting a monitor in the 
video wall stage area will show the monitor’s properties in the 
Properties window.

Fig. 15-18: Monitor Properties in Properties Window
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Step 3a: Design Layout - Assign Tile Grid Layouts to a Video Wall

Prerequisites:
• There is a Room file open in the Room Editor which has a Room Design.

Procedure to Assign Tile Grids
To assign tile-grids to a video wall, in the Project window:

1 Open the Room file in the Room Editor. 
2 To select the grid design mode, select the Design Layout icon.

Note: Tile Grid relates to a grid arrangement of tiles on a video wall 
monitor. This ‘grid’ is different to the ‘drawing grid’ that can be 
enabled in graphical drawing tools, such as in the Room Editor in 
GV Orbit Client. 
(‘Drawing grid’ controls are accessed via ‘Tools > Options > App’ in 
the main menu.)

Tile layouts

Video Wall Tile Layout Configuration
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Fig. 15-20: Room Editor Tool Bar - Design Layout Icon

The Room Design is now shown in Design Layout mode which shows the available 
Tile Grid templates. See Figure 15-49.

Fig. 15-21: Design Layout Mode in Room Editor

To apply a grid layout to a monitor:
3 Select a monitor by clicking on its monitor header.
4 Then select a tile-grid from the available Tile Grid templates.

The grid is applied to the monitor.

Design Layout icon selected

Available Tile Grid templates

Monitor header, showing: Multiviewer Output and Device
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Two things have actually happened to the monitor:

i) a grid layout has been applied; and 

ii) the grid has been automatically populated with video tiles.

Fig. 15-22: Apply Tile Grid Template to Monitor

5 Apply grid layouts to all monitors.

When all monitors have been assigned grid layouts:
6 Click Project > Save File in the main menu to save the grid layout changes to 

the Room.

This has quickly defined the layout of the video wall using tile grids from the available 
templates. Figure 15-23 shows an example.

Note: Tile-grids are automatically populated with video tiles by default 
when added to a monitor. The tiles populated on a tile-grid can be 
configured as required or replaced with customs Tiles. See Monitor 
Layouts and Tiles, on page 715.

Select Tile Grid template

Select monitor

Unassigned monitorsAssigned monitors



707

GV Orbit Version 2.3.0 MV Cluster - Room Editor
User Guide Modifying a Tile-Grid on a Video Wall

Fig. 15-23: Example Quick Grid Layout on Video Wall

A Room Layout has been generated. 

Modifying a Tile-Grid on a Video Wall
Quick edits to a tile-grid of a video wall can be done in Design Layout mode. The following 
example modifies the video wall shown in Figure 15-23 on page 707:

1 Select a monitor to modify. 

Fig. 15-24: Selected Monitor to Modify

’Dynamic’ indicates tile has 
Dynamic Destination Assignment enabled.

Note: Each video tile in each tile-grid by default has ‘Dynamic 
Destination Assignment’ enabled, by default.

Selected Monitor to 
modify
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2 Select a new Tile Grid template.

The new Tile Grid is assigned and shown on the monitor.

Fig. 15-25: Modified Grid Layout

3 Click Project > Save File to save the grid layout in the Room file.

Customizing a Tile-Grid on a Video Wall
Further, a custom change can be made to a grid layout in Design Layout mode.

In Design Layout mode:
1 Select a monitor to modify. 

Fig. 15-26: Select a Monitor

2 Select a tile position in the monitor’s tile-grid.

Fig. 15-27: Select a Tile Position in a Tile-Grid

New grid layout on 
monitor

Select new Tile Grid 
template to use.

Select a tile position.
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3 Drag a corner of the tile position and release it to resize it.

Fig. 15-28: Resize a Tile Position in a Tile-Grid

A video wall’s tile-grid layout on one monitor has been customized.

This customized tile-grid may be saved, see Saving a Customized Tile-Grid.

a) Drag a Corner of a Tile Position

Drag tile position corner

b) Release a Corner of Tile Position
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Saving a Customized Tile-Grid
For a customized tile-grid that is on a video wall, to add it to the available templates in 
Design Layout mode:

1 Select the monitor containing the with the customized tile-grid.

Fig. 15-29: Select a Monitor Grid Layout

2 Click Add Grid.

The Tile Grid of the selected monitor is added to the available templates and is then 
available for use in the project.

Fig. 15-30: Custom Grid Layout Added to Available Grid Templates

3 Click Project > Save File to save the video wall’s grid layout in the Room file.

Select customized monitor
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A customized grid layout has been saved in the Room and can be re-used. The information 
is stored in the Room file in the project.

Example Customized Tile-Grids 

Fig. 15-31: Example Grid Layout with Two Customized Monitor Grid Layouts

Customized Tile-Grids saved as Tile-Grid Templates
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Fine Positioning of Tile Positions on a Tile-Grid
So far in this chapter, the tile grids have been populated with tiles placed at tile-positions of 
the (template) tile-grid. A tile-position may be repositioned ‘off-grid’ when in Design 
Layout mode:

1 Click on the Freehand Positioning icon (see Figure 15-32). 

Fig. 15-32: Freehand Positioning Icon

The stage now enables the freehand positioning of tile-positions.

Fig. 15-33: Freehand Positioning Icon

2 Select a tile at a tile position on a tile-grid.
3 Move it, or drag one of its corners, to finely reposition it.
4 Click Save File in the main tool bar to save the change.

Lastly:
5 Click on the Freehand Positioning icon to toggle freehand mode off. 

Drag corner
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Step 3b: Create Optional Alternative Layouts for a Video Wall
Design Layout mode can be used to create different layouts for a video wall.

In a Room, each video wall monitor can have more than one possible tile-grid layout. (This 
is called a Monitor Layout. See What is a Monitor Layout?, on page 680 for further 
information.)

A Room Layout is a snapshot of Monitor Layouts on a video wall and a Room can have 
more than one Room Layout for its video wall. 
(See What is a Room Layout?, on page 680 for more information.)

Use the Room Editor’s Design Layout mode to optionally create alternative layouts for a 
video wall, either for its monitors:

• Create a New Monitor Layout.
• Monitor Layouts and Tiles.

Or for the whole video wall:
• Create a Room Layout for a Video Wall.

Create a New Monitor Layout
To create a new Monitor Layout for a monitor on a video wall, in Design Layout mode:

1 Select a monitor. 

Fig. 15-34: Select a Monitor

2 Click on the Monitor Layout icon ( ) in the Room Editor tool bar and 
select ‘New Monitor Layout’.

Fig. 15-35: Select ‘New Monitor Layout’
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3 Enter a name for the new Monitor Layout and click OK.

Fig. 15-36: Enter a Name for the New Monitor Layout’

4 Select a new Tile Grid template from those available.

The selected template appears on the selected monitor.

Fig. 15-37: Select New Tile Grid Template

5 Click Save File in the main tool bar.

This has created a new tile-grid layout for use by the selected monitor. Further Monitor 
Layouts for the monitor may be created.

New selected Tile Grid appears on monitor.
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List Monitor Layouts
To see what Monitor Layouts there are for a monitor:

1 Select the monitor.
2 Click the Monitor Layout icon.

The pop-up menu lists the available Monitor Layouts for the selected monitor. See 
Figure 15-38. A radio button allows a Monitor Layout to be selected.

Fig. 15-38: List Monitor Layouts for a Selected Monitor

Monitor Layouts and Tiles
A tile grid is populated with tiles. Monitor Layouts also record the type of tile at each 
populated tile position. In this way, two Monitor Layouts may have the same tile-grid but 
contain different tiles. Tile change-overs on a video wall can then be recalled with a 
Monitor Layout. 

Tile types to populate a tile-grid with include:
• an Auto-tile configured as a video tile. (See Configured Video Tile, on page 716.)
• an Auto-tile configured as a clock tile. (See Clock Tile, on page 716.)
• a Custom Tile.

A new Monitor Layout can be created for each change of tile type and saved. Then a 
Monitor Layout can be recalled and saved as a Room Layout (see Create a Room Layout 
for a Video Wall, on page 717).
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Configured Video Tile

Fig. 15-39: Configured Video Tile Example

Clock Tile

Fig. 15-40: Dragged-On Clock Tile Example

Video tile properties changed in Properties box

Properties of selected tile

Drag tile on
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Custom Tile

Fig. 15-41: Drag on Custom Tile

Create a Room Layout for a Video Wall
Prerequisite:

• One or more Monitor Layouts have been generated for each monitor in the video wall 
of the Room.

With various Monitor Layouts created for monitors, different Monitor Layouts can be 
selected and saved as new Room Layouts for a video wall. 

To create a new Room Layout based on the current Room Layout:
1 View a video wall in Design Layout mode.

a) Edit a video tile in the Tile Editor to create a Custom Tile

b) Drag Custom Tile onto Tile Grid in Room Editor

Image widget added Digital Clock widget added

UMD widget added

Audio Bars widget configured 
for more bars etc.

Drag tile onto the stage
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Fig. 15-42: Video Wall in Grid Layout Mode.

2 On each monitor in the video wall, select the required Monitor Layouts on each 
monitor.

3 Click on the Room Layout icon ( ) and select ‘New Layout’. 

Fig. 15-43: Select New (Room) Layout

4 Enter a name for the new Room Layout and click OK.

Fig. 15-44: Enter a Name for the New Room Layout

This creates a new Room Layout from the current one. 
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To make a change to this new Room Layout:
5 Select a monitor that has more than one Monitor Layout and 

then right-click on it.

A drop-down menu appears.
6 Select ‘Switch Monitor Layout’ and 

select a Monitor Layout from the list. (See Figure 15-45.)

Fig. 15-45: Select a Monitor Layout

The selected monitor shows the new Monitor Layout.

Select a tile
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Fig. 15-46: New, Selected Monitor Layout

7 Click Save File in the main tool bar.

The new Room Layout now uses the selected Monitor Layout for the selected 
monitor.

Edit an Existing Room Layout
To edit an existing Room Layout:

1 View the Design Layout mode and select the Room Layout to be edited.
2 Select a monitor and, for that monitor, select a new Monitor Layout.
3 Click Save File in the main tool bar to save the modified Room Layout.
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Example Room Layouts

Fig. 15-47: Example Room Layouts 1 to 5

Next step: Step 4a: Assign Destinations to Tile Positions

Example Room Layout1

Example Room Layout2

Example Room Layout3

Example Room Layout4

Uses Monitor Layout = “Layout_5x5”

Uses Monitor Layout = “Layout_4x4”

Uses Monitor Layout = “Layout_2x2”

Uses Monitor Layout = “Layout1”

Uses Monitor Layout = “Layout_3x3”

Example Room Layout5
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Step 4a: Assign Destinations to Tile Positions
This step associates router destinations to video wall tiles. 

For video tiles which are configured for Static Destination Assignment, the assignments 
made are used unchanged.

For video tiles configured for Dynamic Destination Assignment, then the assignments 
made define which destinations may be dynamically routed.
(Note: This needs the Multiviewer Cluster Manager Service running on the GV Orbit Server), 

Prerequisites:
• There is a Room open in the Room Editor which has a Room Design which defines a 

video wall which has a Design Layout. 
• Router destinations have been set up in the router controller (GV Orbit Control).
• The Routing service is connected to GV Orbit Control.

Router destinations assigned to each tile position.

Assign Router Destinations to Video Wall Tile Positions



723

GV Orbit Version 2.3.0 MV Cluster - Room Editor
User Guide Procedure Overview

Procedure Overview
The Assign Router Destinations workflow is presented below in the following steps:

• Step 4a-1: Open Room Editor in Assign Destinations Mode
• Step 4a-3: To Edit a Tile to be Static
• Step 4a-2: Map Router Destinations to Multiviewer Inputs
• Step 4a-4: Assign Mapped Destinations to Tile Positions

And then some TSL configuration settings may be optionally set up (or set up later, as 
required):

• Step 4b: Configure TSL Tally Settings for a Room 

Step 4a-1: Open Room Editor in Assign Destinations Mode
By default, destinations are set to dynamic mode. To assign multiviewer router destinations 
to a video wall, in the Project window:

1 Open the Room in the Room Editor. 
2 To select the destination assignment mode, select the Assign Destinations icon.

Fig. 15-48: Room Editor Tool Bar - Assign Destinations Icon

The Room Design is now shown in Assign Destinations mode. See Figure 15-49.

Fig. 15-49: Assign Destinations Mode in Room Editor - First Screen

Assign Destinations icon selected

Icon indicates that 
a video wall tile 
uses Dynamic 
Destination 
Assignment
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Step 4a-2: Map Router Destinations to Multiviewer Inputs
Router destinations should have already been reserved for all multiviewer inputs of the MV 
cluster in the routing system. These each need mapping to the multiviewer inputs for our 
Clustered MV project for either the Static Destination Assignment case or Dynamic 
Destination Assignment case.

First, map the destinations before the assignments can be done.

In the Room Editor tool bar in Assign Destinations mode, to map destinations to 
multiviewer inputs:

1 Click on the Configure Mapping icon.

Fig. 15-50: Room Editor Tool Bar - Assign Destinations Mode, Configure Mapping Icon

A Destination Configuration tab is opened which lists all multiviewer devices in the 
cluster. For each multiviewer, all multiviewer inputs are listed. Initially this list is 
empty.See Figure 15-51.

Fig. 15-51: Destination Configuration Tab

Note: Video tiles that are using the Dynamic Destination Assignment

mode are indicated with a  icon.

Click on Configure Mapping icon
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To map router destinations to multiviewer inputs:
2 Select the multiviewer.
3 Click on the ‘Destinations’ column heading to select all multiviewer inputs.

Fig. 15-52: Select Multiviewer, Select All Inputs

All inputs of the selected multiviewer are selected. 
4 Alternatively, select a range of inputs by:

• clicking on the first empty destination box in the range;
• scrolling down the list; and 
• SHIFT-clicking on the last item. 

See Figure 15-53.

All inputs in the range are selected. 

Click on column heading to 
select all multiviewer inputs.
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Fig. 15-53: Select Multiviewer and Select Multiviewer Input Range

With inputs selected:
5 Click on the Destination Picker icon in the Destination Configuration tab tool bar.

Fig. 15-54: Multiviewer Selected and Inputs Selected

The Add Destinations dialog is shown, which shows a filterable and scrollable list all of 
the destinations of the GV Orbit routing system. See Figure 15-55. 

Select

SHIFT-Select to select a range

Click on the Destination Picker icon
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Fig. 15-55: Add Destinations Dialog

6 Typically, destination names have consistent and logical naming. 
(For example, ‘MV-1 Dest**’, or ‘MV-2 Input**’ . )

Note: List items can be selected in a similar way to using the Bulk Routing 
Panel: Select and item, then SHIFT-select to select a range of items 
and CTRL-select to add individual items to the selection. 

Scrollable

Tool bar icons:
• Select all - Select all destinations displayed in the dialog.
• De-select All - De-select all destinations.
• Wide Buttons - Click to toggle Destination button width.
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If required, use the filtering to locate the destinations for your selected multiviewer 
inputs.

7 Select the range of destinations for the selected multiviewer inputs. (Select, then SHIFT-
Select.)

Fig. 15-56: Selected Range of Destinations

8 Click OK in the Add Destinations dialog.

The selected destinations are mapped and listed against the multiviewer inputs.

Note: Useful Filter feature:
When assigning router destinations to multiviewer inputs, typically, 
the destinations intended for multiviewer inputs are consistently and 
logically named. The filter feature of the Add Destinations dialog can 
then be used to easily list the destinations required.

Select

SHIFT-Select

Select

Filtering on MV*
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Fig. 15-57: Selected Destinations Mapped to Multiviewer Inputs

Some multiviewer inputs have been mapped to destinations. 

Now:
9 Repeat these steps to map all of the multiviewers and their inputs to router 

destinations.
10 Click Save File.

When all multiviewer inputs have been mapped to destinations and saved:
11 Close the Destination Configuration tab.

Fig. 15-58: Close Destination Configuration Tab

All multiviewer inputs have been mapped to router destinations.

Note: Changes made in the Destination Configuration tab need to be 
saved before the changes can be seen in the Room Editor.

Destinations mapped 
to multiviewer inputs
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Step 4a-3: To Edit a Tile to be Static
Dynamic Destination Assignment is the default tile configuration. It may be applied to 
one, or more, or all video tiles. It is possible to mix dynamic- and static-assigned tiles.

To configure a tile for Static Destination Assignment:
1 Select a tile.

Fig. 15-59: Preparing to Set a Static Destination

2 Deselect the Automatic Destination Assignment button.

Router destinations are listed in the lower pane. See Figure 15-72.

Select a tile.

Deselect the 
Automatic 
Destination 
Assignment 
button.
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Fig. 15-60: Set a Static Destination

If no destinations are listed on the lower pane, then see Step 4a-2: Map Router 
Destinations to Multiviewer Inputs, on page 724, for instructions for manually mapping 
router destinations.

Once destinations are listed:
3 Select a multiviewer input in the lower pane.

The selected tile now indicates its static router destination setting.
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Fig. 15-61: Static Destination for a Tile

4 Click Save File in the main menu.

Step 4a-4: Assign Mapped Destinations to Tile Positions
The video wall tab shows our video wall and we have mapped destinations to multiviewer 
inputs.

Selected tile has a 
static router 
destination 
setting.

Note: This step is only required to be done for tiles which are configured for 
Static Destination Assignment.
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Fig. 15-62: Video Wall Tab Ready for Assigning Mapped Destinations to Tile Positions

The workflow is presented with these sub-sections:
• Assign Single, Static Destination to Single Tile Position.
• To Assign Static Destination(s) to All Tile Positions on a Monitor’s Tile-Grid.
• Assign (Static) Series of Destinations to Multiple Tile Positions.

And:
• Delete a Destination Assignment.
• Edit a Static Destination Assignment.
• Edit a Tile - Static to Dynamic Destination Assignment.

Assign Single, Static Destination to Single Tile Position
To assign static destinations to tile position:

1 Select a tile position on a monitor.

For the selected position, the destinations mapped to the corresponding multiviewer 
are listed below. These are all possible destinations for the selected position. See 
Figure 15-63.

Monitor header areas annotated 
with multiviewer output 
information.

Video wall tiles populated 
in the tile positions
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Fig. 15-63: Possible Mapped Destinations for Selected Tile Position

2 Select a destination.

The destination is assigned as a static destination to the tile position, which is 
annotated with the destination name.

Fig. 15-64: Static Destination Assigned to Tile Position

This has assigned a static destination to a tile position on the tile-grid. Other tile positions 
can be assigned static destinations similarly.

To Assign Static Destination(s) to All Tile Positions on a Monitor’s Tile-Grid
To quickly assign static destinations, all tile positions on a monitor can be selected and 
assigned:

1 Double-click on a monitor header area.

All tile positions on the monitor are selected.

Destinations mapped 
to multiviewer

Click to toggle wide 
buttons

Selected tile 
position

Tile position annotated with assigned (static) destination name.

Tile position is unassigned.
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Fig. 15-65: Select All Tile Positions on Monitor

2 Select a destination.

An Assign Destination to Multiple Tiles dialog pops up. See Figure 15-66.

Fig. 15-66: Assign Destination to Multiple Tiles Dialog

Double-click on monitor header area to select all tile positions on the monitor.

Select a destination.

Select several tiles.
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3 In the Assign Destination to Multiple Tiles dialog:
• Click Fill Series to fill the selected tile positions with a series of destination, starting 

from the selected one.
• Click Duplicate Destination to fill all the selected tile positions with the selected 

destination.

Figure 15-67 shows the result of doing Fill Series.

Fig. 15-67: Result of Fill Series

Assign (Static) Series of Destinations to Multiple Tile Positions
Assignment by Fill Series can be done to a selection of tile positions: 

1 Select tile positions from the same multiviewer with ‘select’ and ‘SHIFT-select’. 
2 Use ‘Fill Series’ to assign static destinations.

Series-filled tiles
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Delete a Destination Assignment
1 Select one or more tile positions.
2 Click the Unassign icon or press the Delete key to delete the destination assignment.

Fig. 15-68: Deleted Destination Assignment

Edit a Static Destination Assignment
1 Select a tile position.

Fig. 15-69: Selected Tile Position

2 Select a new static destination.

Fig. 15-70: Select New Destination

The new static destination assignment is made.

Destination assignment deleted.

Unassign icon

Tile position selected

Selected destination
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Fig. 15-71: New Static Destination Assignment

New static destination assignment
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Edit a Tile - Static to Dynamic Destination Assignment
To set dynamic assignment for a static assignment tile:

1 Select a tile.
2 Select the Automatic Destination Assignment button in the lower pane.

The selected tile now indicates its dynamic router destination setting. See Figure 15-72.

Fig. 15-72: Make a Static Destination Assigned Tile Dynamic

3 Click Save File in the main menu.

Select a static tile.

Click on the 
Automatic 
Destination 
Assignment 
button.

Automatic Destination Assignment 
button is shown selected.

Selected tile now has 
Dynamic Destination Assignment.

a) Select a static tile b) Tile now has dynamic destination assignment
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Destination Assignment Notes

Example Static Destination-Assigned Video Wall
The video wall is now managed in terms of destinations.

Fig. 15-73: Example Video Wall Tab

The destination assignment needs only to be done once in a project.

Note: When assigning static destinations:
• assigning the same destination to more than one tile position is 

permitted. 
Note: For MV-8XX multiviewers, the architecture of the MV-8 Series 
core multiviewer has one image scaling function per multiviewer 
input. If one destination is assigned to more than one tile position, 
then the video image is viewed at the smallest resizing scale.

• not all destinations need to be assigned.

Note: Prerequisites of assigning router destinations is that:

1 The router controller (‘GV Orbit Control’ in the GV Orbit system) 
is configured with destinations reserved for use by multiviewer 
inputs in its topology. See Logical Device Table Tasks, on 
page 241.

2 The GV Orbit Routing service must have a valid connection to 
‘GV Orbit Control’. See the GV Orbit Admin Guide. See Related 
Documentation, on page 7. 
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Next
When all destination assignment is done (dynamic, static, or a mixture) to multiviewer 
inputs and tile positions, then TSL Tally configurations (including for TSL address mappings 
to multiviewer inputs and video wall tile) can optionally be done. See Step 4b: Configure 
TSL Tally Settings for a Room.

After this, the next step in video wall design is: Step 5a: X/Y Routing Video Sources to Tiles

Step 4b: Configure TSL Tally Settings for a Room
Following the assignment of destinations to multiviewer inputs and mapping to video wall 
tile positions in the Room Editor ‘Assign Destinations’ mode, TSL Tally configuration for the 
Room can also be done. 

Configuring the TSL settings is described in Chapter 16, MV Cluster - TSL Tally 
Configuration, on page 757.

After this optional TSL Tally configuration step during video wall design, the next step in 
video wall design is: Step 5a: X/Y Routing Video Sources to Tiles

Step 5a: X/Y Routing Video Sources to Tiles

Note: The TSL Tally configuration can also be done separately later. It is 
optional at this stage in video wall design.

Note: The Destination Assignments should be all completed in the Room 
Editor before for the Tally settings can fully function and map to 
video wall tiles etc.

Note: TSL configuration is optional at this stage of the video wall design 
(Room design) and it can be set up later, if required.
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Prerequisites:
• There is a Room file open in the Room Editor which has a Room Design defining a 

video wall which has a assigned router destinations. 
• Clustered Multiviewer project has been pushed to the repository on the GV Orbit 

Server.
• The Multiviewer Cluster Manager Service (MVCMS) is running on the GV Orbit Server 

and is set to use the pushed project from the repository.

Introduction
X/Y Routing mode has a live connection to the multiviewer cluster via the MVCMS service.

When using dynamic destinations, a live connection (through the MVCMS service) to an MV 
unit is required, otherwise the tiles will show up without any destinations assigned to them. 

The X/Y Routing workflow is presented in the following sub-sections:
• Open ‘X/Y Routing’ in the Room Editor
• Procedure for ‘X/Y Routing’ to a Video Wall Tile Position
• Route a Source to Multiple Tile Positions
• Route Multiple Sources to Multiple Tile Positions

Additionally, in this X/Y Routing mode of the Room Editor, the selection or creation of a 
different Room or Monitor Layout is shown live on the multiviewer video wall, see Step 5b: 
Change Layouts in X/Y Routing Mode, on page 751.

Router sources assigned to each tile position.

X/Y Routing of Video Sources to Video Wall Tile Positions
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Open ‘X/Y Routing’ in the Room Editor
The routing of sources to video tiles (actually to the tile positions) is done in the Room 
Editor, in its ‘X/Y Routing’ tool. 

To open this Room Editor facility:
1 Open the Room file in the Room Editor.
2 Click on the X/Y Routing icon to select the mode.

Fig. 15-74: Room Editor Tool Bar - XY Routing Icon

The Room Design is now shown in X/Y Routing mode. See Figure 15-75. 

Note: If you do not have the Edit screens permission then when you open a 
MV Cluster Room File, you will be taken directly to the X/Y Routing 
Screen and GV Orbit Client will be put into full screen mode. You will 
only be able to switch Rooms, switch Room Layout and switch 
Monitor Layouts. See Manage Users, on page 141.

X/Y Routing icon selected



744

MV Cluster - Room Editor GV Orbit Version 2.3.0
Open ‘X/Y Routing’ in the Room Editor User Guide

X/Y Routing Mode in Room Editor

Fig. 15-75: X/Y Routing Mode in Room Editor

Router sources are listed in a grid below the representation of the video wall showing the 
tiles, which are the routing destinations. Routing ‘Take’ controls appear in the banner area. 
The X/Y Routing mode provides you an XY routing panel. 

Routings that are made will be reflected on the Room video wall itself.

Router sources grid

Routing ‘Take’ controls

Filter box Sources Filter box

Room Video Wall Tile Destinations

Note: For full information on routing with an XY routing panel, refer to 
Chapter 13, XY Panel Operation, on page 614.
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X/Y Routing Mode Controls

Fig. 15-76: Routing Controls

Fig. 15-77: Router Sources Grid Banner Tool Bar Controls

• Click to Take destination-source selection.
• Click to Cancel destination-source selection.

• Select ‘Take’ action. Make route:
• When Take button is clicked, or when double-clicking on source.
• Immediately when source is selected.

• Click to Release selected destination 
from Lock/Protect.

• Click to Protect selected destination.
• Click to Lock selected destination

• Select All
• Deselect all.
• Sort A to Z
• Sort Z to A
• Toggle wide button size

Sources Filter box, to limit which 
sources are shown.

Note: When routing sources to the video wall, typically, such sources are 
consistently and logically named. (For example, ‘CAM 1’, ‘CAM 2’ etc.) 
The filter feature of the X/Y Routing mode can then be used to easily 
list the source(s) required.
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Procedure for ‘X/Y Routing’ to a Video Wall Tile Position
The procedure broadly operates like an XY routing panel:

• select the destination (where the route is to be made to); and 
• then select the source of the route to be made; and 
• then there is an optional ‘Take’ step.

To route a source:
1 Select a tile position. (This is the destination of the route to be made.)

Note: Any other tile position that is fed by the same source as the selected tile position 
is also selected.

2 Select a router (video) source in the sources grid. (This is the source of the route to be 
made.)

With a destination selected and a source selected, a route is ready to be made. See 
Figure 15-78.

Fig. 15-78: Ready to Make a Router

Selected tile-grid destination

Selected router source
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3 Click the Take button. 

The route is made from the selected source to:

a) the selected tile position (see Figure 15-79); and also to 

b) any other tile Position on the video wall that is fed with the same source.

Fig. 15-79: Routed Result

Routed Source shown on tile

Currently-routed source
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Route a Source to Multiple Tile Positions
To route router sources to a video wall, in the Project window:

1 Select a tile position. 
2 Select further positions with:

• SHIFT-select a range of tile positions; and/or 
• CTRL-select to add positions to the selection.

3 Select a router (video) source in the sources grid. 
4 Click Take.

The routes are made.

Route Multiple Sources to Multiple Tile Positions
To route router sources to a video wall, in the Project window:

1 Select a tile position. 
2 Select further tile positions with:

• SHIFT-select a range of positions; and/or 
• CTRL-select to add positions to the selection.

3 Select a router (video) source in the sources grid. 
4 Select further sources with:

• SHIFT-select a range of sources; and/or 
• CTRL-select to add sources to the selection.

5 Click Take.

The routes are made.

Routing with Dynamic Destination Assignment
If dynamic destination assignment is operating, routing is performed in the same way as 
before. See Procedure for ‘X/Y Routing’ to a Video Wall Tile Position, on page 746, etc.

When using dynamic destinations, a live connection (through the MVCMS service) to an MV 
unit is required, otherwise the tiles will show up without any destinations assigned to them. 

Quick Dial Source Routing on the X/Y Routing Screen
Dial Source routing speeds up the selection of a source for routing to a tile.

In X/Y Routing mode:
1 Select a tile on a monitor using the mouse. 

Note: Navigation:
• To navigate between tiles on the selected monitor, 

use the left- and right-arrow cursor keys.
• To select a different monitor, use the mouse.
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2 With a tile selected, 
start typing a source name.

A filtered list of sources pops up. 

Fig. 15-80: Pop-Up Filtered Sources List

Continue to type in the source name. While characters are entered, source names 
matching the entered characters are displayed in the pop-up list. 

3 To pre-select a source to be routed and make the route (see Figure 15-81), either:
• Use the down- and up-arrow keys to highlight the required source in the filtered 

list (thus pre-selecting the source).
And then press the Enter key to route the pre-selected source to the selected tile.

or:
• Click on the required source in the filtered list to select it and make the route.
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Fig. 15-81: Select Source

The route is made. See Figure 15-82.

Fig. 15-82: Pre-Selected Source is Routed to the Selected Tile

Currently-routed source to tile

Pre-selected source
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Step 5b: Change Layouts in X/Y Routing Mode
X/Y Routing mode has a live connection to the multiviewer cluster (via the MVCMS service) 
and the stage area shows the video wall layout of the multiviewer devices. 
The mode offers the facility to change Room Layouts (see What is a Monitor Layout?, on 
page 680) and Monitor Layouts (see What is a Monitor Layout?, on page 680).

In this section:
• Select a Room Layout in X/Y Routing Mode
• Select a Monitor Layout in X/Y Routing Mode
• New Layouts:

• Select a New Current Video Wall Layout
• X/Y Routing Mode Video Wall Layout vs Room Layout
• Saving a New Video Wall Layout as a Room Layout

Select a Room Layout in X/Y Routing Mode
If there is more than one Room Layout, then a different Room Layout may be selected in 
the X/Y Routing mode of the Room Editor. This will also change the layout on the physical 
video wall. Sources may then be routed to this layout, as required.

In X/Y Routing mode in the Room Editor, to select a Room Layout:
1 With no monitor selected, 

click on the Room Layout icon and select a different layout to show.

The Room Editor screen shows the selected layout and commands are sent to the live 
video monitor wall to change layouts. The selected Room Layout is then shown on the 
monitor wall.

Fig. 15-83: Select an Alternate Room Layout in X/Y Routing mode in Room Editor

Note: The live selection of Room or Monitor Layouts is only possible in the 
X/Y Routing screen of the Room Editor. This is not available in other 
Room Editor modes.

Room Layout icon



752

MV Cluster - Room Editor GV Orbit Version 2.3.0
Select a Monitor Layout in X/Y Routing Mode User Guide

Fig. 15-84: Newly-Selected Room Layout

Select a Monitor Layout in X/Y Routing Mode
If there is more than one Monitor Layout for a monitor, then a different Monitor Layout 
may be selected in the X/Y Routing mode of the Room Editor. This will change the layout 
on the physical video wall also.

In X/Y Routing mode in the Room Editor, to select a new Monitor Layout:
1 Select a monitor in the X/Y Routing screen stage area. (See Figure 15-85.)

Fig. 15-85: Select Alternate Monitor Layout

2 Click on the Monitor Layout icon in the Room Editor tool bar
and select the required Monitor Layout to show. (See Figure 15-85.)

Note: Tile positions in this newly-selected monitor’s layout 
require more routed sources

Select a monitor in the stage area.

Select a Monitor Layout.

Monitor Layout icon
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The Room Editor screen shows the selected layout and commands are sent to the live 
video monitor wall to change layouts. The selected Monitor Layout is then shown on 
the monitor wall. (See Figure 15-86.)

Fig. 15-86: Selected Alternate Monitor Layout Shown

Layout Change in Dynamic Destination Assignment Mode
Layout changes are made in the same way when Dynamic Destination Assignment is 
active. 

If a layout change results in not enough multiviewer destinations being available to meet 
the layout’s needs, then this is indicated in the X/Y Routing mode screen in GV Orbit Client 
and on the video wall with one or more 50%-transparent blue tiles in GV Orbit Client. See 
Figure 15-87. The actual video wall will show a black tile area.
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Fig. 15-87: New Layout and Not Enough Free Multiviewer Destinations

a) Selecting another Monitor Layout

b) New Monitor Layout Shows there are not enough free multiviewer destinations

• Blue coloration to tile indicates that the 
current overall on-screen layout requires more 
multiviewer destination than are currently 
available from the multiviewer.

• A pop-up message reinforces this, explaining 
that the number of destinations has been 
exceeded.

A Monitor layout change
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New Layouts
Room Layouts and Monitor Layouts can be selected when in X/Y Routing mode and the 
video wall changes accordingly. (See Select a Room Layout in X/Y Routing Mode, on 
page 751, and Select a Monitor Layout in X/Y Routing Mode, on page 752.)

A video wall layout can be adjusted ‘on the fly’ in the X/Y Routing mode of the Room 
Editor.

Select a New Current Video Wall Layout
With a Room Layout selected and displayed:

1 Select an alternate Monitor Layout for a monitor, in order to change the on-screen 
video wall layout.

The resulting new overall video wall layout is shown. 

X/Y Routing Mode Video Wall Layout vs Room Layout
The displayed video wall layout is a combination of Monitor Layouts which may, or may 
not, correspond to an already-saved Room Layout in the ‘Clustered Multiviewer’ project.
If the Monitor Layout combination:

• Does Correspond to a Room Layout:

GV Orbit recognizes this and automatically selects the corresponding Room Layout.
• Does NOT correspond to a Room Layout: 

GV Orbit detects this and automatically creates a new, ‘Untitled*’ item in the Room 
Layout drop-down menu (see Figure 15-88), which may be saved and renamed as 
required, see Saving a New Video Wall Layout as a Room Layout.

Fig. 15-88: ‘Untitled*’ Room Layout

Saving a New Video Wall Layout as a Room Layout
To save a ‘Untitled*’ video wall layout as a Room Layout, with the layout displayed in the 
stage area:

1 Click the Design Layout icon in the Room Editor to leave the X/Y Routing mode.

A Room Layout Changes dialog asks you if you want to save the layout as a new Room 

Room Layout icon Monitor Layout icon

New item in Room Layout drop-down menu, ‘Untitled*’
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Layout.

Fig. 15-89: Room Layout Changes Dialog

2 Click Yes.

You are asked and which Room Layout name to use.

Fig. 15-90: New Room Layout Name Dialog

3 Enter a new name and click OK.

Note: If the X/Y routing mode screen is returned to in GV Orbit Client, then 
the X/Y Routing stage will reflect the current video wall layout of the 
multiviewer devices. 



 757

16MV Cluster - TSL Tally Configuration

Introduction

TSL tally configuration is integrated and centralized for a ‘Clustered MV’ project. 
Configuration is done on a per Room basis and the whole video wall inherits the Tally 
configuration. This provides the basic Tally settings for the video wall’s graphical, on-screen 
widgets to use to display Tally status. (For example, a Tally Lamp, Label, or Shape.)

TSL tally protocols supported:
• TSL 3.1 - Basic industry tally standard protocol over UDP.
• TSL 5.0 - Advance industry tally protocol over UDP or TCP. 

In GV Orbit Client, TSL tally configuration is carried out from the Room Editor’s Destination 
Assignment mode. Tally configuration includes:

• Selecting TSL protocol to use.
• Optionally customizing Tally names, Tally address level names, and on-screen Tally 

colors.
• Mapping of TSL addresses and video wall video tiles (multiviewer device logical inputs 

and their assigned router destinations). 

When TSL tally configuration is done, ‘tally-indicating’ graphical widgets in video wall tiles 
can be configured. This then determines which TSL data packets are indicated by which 
widgets.

Tally Protocols
Up to four Tally addresses supported per multiviewer input (that is up to four address 
levels). 

The TSL protocols are compared in the table below:

Lite Professional Enterprise

 

Note: When designing a video wall and using widgets to display Tally 
status, the Tally configuration provides the basic settings. It is still 
possible to change local settings on a video wall tile to modify widget 
behavior and/or appearance on a tile-by-tile basis in GV Orbit Client.
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Tally Configuration in Room Editor
TSL Tally settings for a Room are configured in a Destination Configuration tab which is 
found in the Destination Assignment mode of the Room Editor.

Open Destination Configuration Tab
1 Open the Room file in the Room Editor and select the Assign Destinations icon in the 

Room Editor tool bar. 
(Refer to Chapter 15, Step 4a: Assign Destinations to Tile Positions, on page 722 for full 
instructions.)

The Room Design is shown in its Assign Destinations mode. See Figure 16-1.

 Table 16-1: Comparing TSL Protocols 
TSL Protocol

TSL 3.1 TSL 5.0

Tallies ‘Tally 1’ to ‘Tally 4’ ‘Left’, ‘Right’, and ‘Text’

Tally States Two states: On, Off Four states

Number of Tallies 
per MV-8 Multiviewer 

Video Wall Tile
16 12

Address Range 0 to 126 0 to 65534

IP data packet protocol 
used UDP UDP or TCP

Note: The Destination Assignments should be all completed in the Room 
Editor before for the Tally settings can fully function and map to 
video wall tiles etc. 
(For Destination Assignment steps, see Chapter 15 Step 4a: Assign 
Destinations to Tile Positions, on page 722.)
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Fig. 16-1: Assign Destinations Mode in Room Editor

2 Click on the Configure Mapping icon in the Room Editor tool bar.

A Destination Configuration tab is opened. See Figure 16-2.

Destination Configuration Tab

Fig. 16-2: Destination Configuration Tab - TSL Tally Levels Config Columns

Click on Configure Mapping icon

Selected Assign Destinations icon

Room Editor tool bar

TSL Tally Levels Config columnsTSL button
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Following a Destination Assignment step in video wall design, the ‘Destinations’ column 
is filled out and multiviewer inputs are mapped to video wall tiles. See Chapter 15, Step 4a: 
Assign Destinations to Tile Positions, on page 722.

‘Tally’ features of the Destination Configuration tab are:
• TSL Tally Levels Config columns ‘L1’ to ‘L4’:

• Initially the columns are empty. 
• Assign TSL Tally Addresses to Multiviewer Inputs.
• Customize TSL Tally Address Level Names by renaming columns, if required.

• TSL button in the tool bar. Use the TSL button to:
• Select TSL 3.1 or 5.0 Tally Protocol; and
• Customize Tally Names and On-Screen Colors.

Assign TSL Tally Addresses to Multiviewer Inputs

Assign Addresses
TSL Tally addresses can be assigned for each multiviewer input. Up to four addresses may 
be assigned (that is up to four address ‘levels’ for a video wall tile).

The TSL Tally Level address mapping defaults to being ‘empty’. Assign TSL addresses to 
each multiviewer input. Up to four are allowed per input.

Ranges of TSL addresses can be automatically assigned and manually edited/entered as 
required.

Auto-Assignment
To automatically assign a range of addresses to TSL Tally Levels in the Destination 
Configuration tab screen:

1 Select a multiviewer. (See Figure 16-3.)

To select a contiguous range of TSL addresses to fill out:
2 Click in the first TSL Level table cell of the range.

And SHIFT-click in the last cell of the range.

(Further cells may be added to the selection with CTRL-click/SHIFT-click.)

This selects the TSL addresses to be filled out. See Figure 16-3.
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Fig. 16-3: Destination Configuration Tab - TSL Tally Level Config Columns

3 Click on the Auto-Assign TSL Addresses button
and enter a start TSL address in the pop-up dialog. (See Figure 16-4.)

4 Click OK.

Select a multiviewer

Select

CTRL-Select

Auto-Assign TSL Addresses button

Selected range
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Fig. 16-4: TSL Address Range Filled Out

The selected TSL addresses cells are filled out from the entered start address.

This has quickly assigned some TSL addresses.
5 Repeat this to assign up to four addresses (columns ‘L1’ to ‘L4’) per multiviewer input, 

using the four columns.

Then:
6 Repeat for each multiviewer.

And finally:
7 Click Save File.

This has quickly assigned TSL addresses for each multiviewer input.

It is possible to manually enter addresses or to edit addresses, see Manual Assignment.

Manual Assignment
To assign addresses to TSL Tally Levels:

1 Select a multiviewer.
2 Click in a TSL Level column row item and enter a TSL address.

Select

CTRL-Select

Selected range

a) Enter start address to fill from. b) Filled out TSL addresses.

Note: Checking and Auto-Assigned TSL Tally Addresses:
The addresses added during auto-assignment are checked and an 
error message pops up to alert you that the address is already in use.
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3 Press the Down-arrow key to go on to the next row in the column. 
Enter another address. Etc.

4 Repeat for all multiviewer inputs.

Fig. 16-5: Destination Configuration Tab - TSL Tally Level Config Columns

5 Press Return when done to exit the address level column.

6

When four addresses (columns ‘L1’ to ‘L4’) have been assigned for each multiviewer, finally:
7 Click Save File.

This has assigned TSL addresses for each multiviewer input.

Customize TSL Tally Address Level Names

Fig. 16-6: Customized Tally Address Level Names

Select multiviewer

CAUTION Unlike auto-addressing, there is no check on entered 
addresses when manually editing the addresses. 

Note: TSL addresses can be duplicated, if required, by using manual entry of 
TSL addresses.
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TSL Tally address level names can be customized, which is useful when assigning Tallies to 
on-screen Tally indicators such as Tally Lamps or UMDs.

Procedure
To rename a Tally address Level across the whole Room:

1 Click on the ‘Tally Level’ column heading in the Destination Configuration tab.

A Header dialog is shown.

Fig. 16-7: Customize Tally Address Level Name 

2 Enter a new name for the address level and click OK.

The new address level name is used for the Room Design and appears in the column 
header and persists for all multiviewers used by the Room. See Figure 16-8.

Fig. 16-8: New Address Level Name Persists for Other Multiviewers in the Room

3 Click Save File.

Click on ‘Tally Level’ column heading
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TSL Tally Configuration for a Room
The TSL tally settings assigned here will be assigned to the video wall tiles for the Room 
and will be available to on-screen, graphical, tally-indicating widgets (such as Lamps, 
Labels, Shapes, UMDs).

Configuration is done the Destination Configuration tab in the Room Editor.

Configuration items:
• Select TSL 3.1 or 5.0 Tally Protocol
• Customize Tally Names and On-Screen Colors

• TSL 3.1 Customizing
• TSL 5.0 Customizing

Select TSL 3.1 or 5.0 Tally Protocol
To select the TSL Tally protocol to be used in the Room Design:

1 Click on TSL icon in the Room Editor tool bar.

Fig. 16-9: TSL Icon

A TSL Configuration dialog is shown.

Fig. 16-10: TSL Configuration Dialogs: a) TSL 3.1 Selected; b) TSL 5.0 Selected.

2 Select TSL 3.1 or TSL 5.0.
3 Click Apply.

This has selected the TSL Tally protocol to be used in the Room.

a) TSL 3.1 Dialog b) TSL 5.0 Dialog
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TSL Protocols
• TSL 3.1

There are four Tallies (Tally 1 to Tally 4) and each has an associated Tally color. 
There are colors for graphical on-screen Tally Lamp widgets and for Shape widgets.

• TSL 5.0

There are four Tally states (State 1 to State 4) and each has an associated ‘Left-Tally’, 
‘Right-Tally’, and ‘Tally Text’. And, in turn, each has associated on-screen colors.

The protocols are compared in Table 16-1, on page 758.

Customize Tally Names and On-Screen Colors
The names of each tally and the on-screen colors used can be customized in the TSL 
Configuration dialog. A customized Tally name can help to identify it when assigning 
tallies to on-screen graphical widgets (Tally Lamps etc.) in the video wall design steps.

Customizations:
• TSL 3.1 Tally Name
• TSL 3.1 Tally Lamp Color
• TSL 3.1 Shape Fill Color
• TSL 5.0 Tally Name
• TSL 5.0 Tally Lamp State Color
• TSL 5.0 Shape Fill State Color
• TSL 5.0 Text Tally Font Color

Show TSL Configuration Dialog
To show the TSL Configuration dialog:

• Click on the TSL icon in the Room Editor tool bar.

The TSL Configuration dialog is shown. (See Figure 16-10 on page 765.)

Note: Dynamic selection of Tally protocol on MV-8 multiviewer devices:
The Tally protocol is usually selected once in a project and then does 
not change.
The dynamic selection of the Tally protocol in a project will be 
supported in MV-8 multiviewer software version v4 onwards. 

CAUTION Typically the TSL Tally protocol is set once. 
If, however, the setting is changed between protocols, it is 
recommended that all the Tally assignments that have 
been made are re-checked.
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TSL 3.1 Customizing

TSL 3.1 Tally Name
In the TSL 3.1 TSL Configuration dialog:

Fig. 16-11: Customize TSL 3.1 Tally Name

1 Click on a Tally name.
2 Enter a new name and Click OK.

The new tally name is shown.
3 Click Apply.
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TSL 3.1 Tally Lamp Color
Three standard colors are available ( ). 

In the TSL 3.1 TSL Configuration dialog:

Fig. 16-12: Customize TSL 3.1 Tally Lamp Color

1 Click on a Lamp color.
2 Select a new color.

The new color is shown.
3 Click Apply.
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TSL 3.1 Shape Fill Color
For an on-screen shape, four standard colors are available ( ) to be used as the 
shape fill color. Alternatively, a custom color may be picked to allow custom colors to be 
used.

In the TSL 3.1 TSL Configuration dialog:

Fig. 16-13: Customize TSL 3.1 Tally Shape Fill Color

1 Click on a Shape color.

A small color selector menu pops up.
2 Select a new color: 

Select a preset color, or 
select the Color Picker icon to show 
the Select Color dialog, then select 
a color and click OK.

The new color is shown.
3 Click Apply.

Preset colors

Select Color dialog



770

MV Cluster - TSL Tally Configuration GV Orbit Version 2.3.0
TSL 5.0 Customizing User Guide

TSL 5.0 Customizing

TSL 5.0 Tally Name
(The procedure for TSL 5.0 is similar to TSL 3.1 Tally Name, on page 767.)

In the TSL 5.0 TSL Configuration dialog:
1 Click on a Tally name (‘Left Tally’, or ‘Text Tally’, or ‘Right Tally’).
2 Enter a new name and Click OK.

The new name is shown.
3 Click Apply.

Fig. 16-14: Customized TSL 5.0 Tally Names

TSL 5.0 Tally Lamp State Color
(The procedure for TSL 5.0 is similar to TSL 3.1 Tally Lamp Color, on page 768.)

In the TSL 5.0 TSL Configuration dialog:
1 Click on a Lamp state color.
2 Select a new color.

The new color is shown.
3 Click Apply.

Fig. 16-15: Customizes TSL 5.0 Tally Lamp State Colors
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TSL 5.0 Shape Fill State Color
(The procedure for TSL 5.0 is similar to TSL 3.1 Shape Fill Color, on page 769.)

In the TSL 5.0 TSL Configuration dialog:
1 Click on a Shape state color.
2 Select a new color to be used for the shape’s fill color.

Or, if the color picker icon is selected, the Select Color dialog is shown. 
Select a color and click OK.

The new color is shown.
3 Click Apply.

Fig. 16-16: Customized TSL 5.0 Tally Shape State Colors

TSL 5.0 Text Tally Font Color
(The procedure for TSL 5.0 is similar to TSL 3.1 Shape Fill Color, on page 769.)

In the TSL 5.0 TSL Configuration dialog:
1 Click on a Text Tally state color.
2 Select a new color.

Or, if the color picker icon is selected, the Select Color dialog is shown. 
Select a color and click OK.

The new color is shown.
3 Click Apply.

Fig. 16-17: Customized TSL 5.0 Text Tally Font Colors
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Configuring On-Screen Widgets
With each multiviewer input configured for TSL Tallies, graphical widgets on video tiles can 
be configured. The widget editing is done when editing a Custom Tile in the Tile Editor.

Open a Custom Tile in the Tile Editor

Open an Existing Custom Tile:
To open a Custom Tile in the Tile Editor:

Either:
• Expand the project in the Project window and in the ‘Tiles’ folder, double-click on the 

Custom Tile name. The tile is opened in the editor.

Or:
• Open the video wall double-click on the Custom Tile. The tile is opened in the editor.

Create a New Custom Tile

New Empty Custom Tile

A Custom Tile may be created from scratch, if required: 
• Expand the project in the Project window and right-click on the ‘Tiles’ folder and select 

‘New’. Then select the tile type. A new tile is opened in the editor.

Quick Custom Tile

Alternatively, a new Custom Tile can be created quickly from an existing video auto-tile by 
double-clicking on a video tile to copy it and open it in the Tile Editor.

To quickly create a new Custom Tile:
1 Double-click on a video tile in the video wall.

The Create Custom Tile dialog is shown.

Note: Typically for a video wall, a few particular ‘template’ video tile designs 
are used throughout. In GV Orbit Client, you can design custom video 
tiles for use on video walls (Custom Tiles).
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Fig. 16-18: Create Custom Tile

2 Enter a name for the Custom Tile and click OK.

The selected tile is copied and opened in the Tile Editor. See Figure 16-19.

Fig. 16-19: Custom Tile in Tile Editor

Widget palette

Custom Tile tab



774

MV Cluster - TSL Tally Configuration GV Orbit Version 2.3.0
TSL Tally Configuring Widgets User Guide

TSL Tally Configuring Widgets
Certain graphical widgets can be used on video wall tiles to display Tally information. The 
TSL Tally configuration of a widget comprises specifying what Tally data is to drive the 
widget. Widgets include:

• Tally Lamp Widget
• Label Widget (Font Color)
• Shape Widget (Fill Color)

Tally Lamp Widget
Open a Custom Tile in the Tile Editor.

If a Tally Lamp widget needs to be added, then: 
1 Click on the Tally Lamp icon in the Widget Palette and drop on a Tally Lamp widget. 

repeat for a second one if required. See Figure 16-20.

Fig. 16-20: Added Tally Lamp Widget(s)

Configure the widget tallies:
2 Right-click on a Tally Lamp widget and select ‘Tally Configuration’.

A Tally Configuration dialog is shown, either for TSL 3.1 (see Figure 16-21a) or for TSL 
5.0 (see Figure 16-21b).

Click on Tally Lamp widget 
icon in the Widget palette, 
then drop a widget onto the 
Tile stage area.

Drop widget onto tile stage area.
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Fig. 16-21: Tally Lamp Widget Tally Configuration Dialogs: a) TSL 3.1; b) TSL 5.0

3 In the dialog, 
select the Tally Status and Address level, or Tally Position and Address level for the 
widget 
for TSL 3.1 or 5.0 respectively. 

4 Click Apply.

This configures the TSL settings for the widget. 
• Configure each Tally Lamp widget on the tile.

With the tallies up for the widget in the Room, the following will determine which TSL data 
packet controls the Tally Lamp’s color:

• the widget’s Tally Configuration setting (above); 
• the video tile position on the video wall; and 
• the TSL address mapping set up in the Destination Configuration tab.

Label Widget (Font Color)
A Label widget can have its font color controlled by TSL messages. The widget tally 
configuration is done in a similar way to the Tally Lamp Widget.

a) TSL 3.1 Widget Tally Configuration

b) TSL 3.1 Widget Tally Configuration
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Fig. 16-22: Label Widget

Shape Widget (Fill Color)
A Shape widget (for example, a Rectangle) can have its fill color controlled by TSL 
messages. The widget tally configuration is also done in a similar way to the Tally Lamp 
Widget.

Fig. 16-23: Shape Widget

Tally Border Video Tile Example
This example forms a video tile with a customizable colored border which is bound to a TSL 
tally message. 

Assumptions
• A Room has been created.
• Monitors have been arranged to form a video wall.
• Monitors have been assigned to multiviewer outputs.
• A layout has been designed for the video wall.
• Destinations have been assigned to multiviewer inputs and to video wall tiles

TSL address mapping has been done in the Destination Configuration tab in the 
Destination Assignment mode of the Room Editor.

Tally Lamp widget

Label widget

Rectangle shape 
widget.



777

GV Orbit Version 2.3.0 MV Cluster - TSL Tally Configuration
User Guide Create a Starter Custom Tile

Create a Starter Custom Tile
A custom video tile can be created quickly to start with in GV Orbit Client:

1 Double-click on a video tile in the video wall.

The Create Custom Tile dialog is shown.
2 Enter a name for the Custom Tile and click OK.

The selected video tile is copied and opened in the Tile Editor. 

Fig. 16-24: Starter Custom Tile

Tile Size:
3 Click off the Tile but in the Tile Editor stage area. See Figure 16-25.

The Tile’s Width and Height are shown in the Properties box. 
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Fig. 16-25: Tile Size in Properties

In the example in Figure 16-25, the Custom Tile’s dimensions are:
• width = 910 pixels 
• height = 503 pixels.

Add a Border Tally
A border Tally may be added to the Custom Tile by:

• slightly resizing the Video widget and centering it on the Tile;
• adding a Rectangle shape widget;
• setting the shape to be the same size as the Tile itself; 
• placing the shape behind the Video widget; and 
• configuring the TSL settings for the Rectangle shape 

(that is, which TSL data packets will drive the shape fill color).

Procedure Example
For this example, to add a 15 pixel wide TSL Tally border:

Resize and re-position Video widget:
1 Select the Video widget.
2 Change the Properties:

• ‘Dimensions > Position > X’ = 15.
• ‘Dimensions > Position > Y’ = 15.
• ‘Dimensions > Size > Width’ = 880. (880 = 910 - 2x15)
• ‘Dimensions > Size > Height’ = 473. (473= 503 - 2x15)

This reduces the widget size and centers the widget on the Tile, adding a 15 pixel 

Click off the Tile, but on the Tile Editor stage area.
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margin around the sides.

Fig. 16-26: Video Widget Size/Position Properties

Add border shape:
3 Click on the Rectangle shape icon in the Widget Palette.

Fig. 16-27: Rectangle Shape Widget Icon in Widget Palette

4 Add a Rectangle shape widget to the tile.
5 Select the shape and change its position/size properties:

• ‘Dimensions > Position > X’ = 0.
• ‘Dimensions > Position > Y’ = 0.
• ‘Dimensions > Size > Width’ = 910. (910 is the Tile width.)
• ‘Dimensions > Size > Height’ = 503. (503 is the Tile height.)
• ‘Extended Style > Border > Border Thickness’ = 0.

6 Right-click on the Rectangle shape widget and select ‘Tally Configuration’.
7 Set up the widget’s Tally settings (so as to control the shape’s Fill color).
8 With the shape still selected, click the Move to Back icon in the main tool bar.

Video widget resized and centered.

Click Rectangle shape widget icon
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Fig. 16-28: Move Selected Object to Back

The Rectangle shape moves to be behind the Video widget.

Fig. 16-29: Video Widget Size/Position Properties

9 Click Save File.

Add more Tally widgets:

If required, further tally-indicating widgets may be added:
10 Add two Tally Lamps.
11 Right-click on each widget and set up the widget Tally settings.
12 Add a Label widget.
13 Right-click on the widget and set up the widget settings (to control the Label text’s font 

color).
14 Click Save File.

The Custom Tile has been prepared.

Deploy Tile
The tile may already be present on the video wall in the Room Design. In this case, the new 
Custom Tile will be seen in the Room Editor. Otherwise, the tile may be added to the 
Room’s video wall in the Room Editor in its Design Layout mode. (See Chapter 15, Step 3a: 
Design Layout - Assign Tile Grid Layouts to a Video Wall, on page 704.)

Click Move to Back icon

Rectangle shape widget is behind the Video widget
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Fig. 16-30: Deployed Custom Tile Example
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Introduction
Audio meters are implemented on video wall tiles with graphical Audio Bars widgets, 
which require configuring for the audio channels they will monitor.

Widgets are configured from the Tile Editor by selecting them and editing their properties 
in the Properties box. For an Audio Bars widget on a Custom Tile, its audio channel 
configuration may be set up quickly via a pop-up menu. 

Audio Bars Widget Configuration
The Audio Bars widget may be set up by selecting the widget in the Tile Editor and 
modifying properties in the Properties box. See Figure 17-2.

Note: Typically for a video wall, a few particular ‘template’ video tile designs 
are used throughout. In GV Orbit Client, you can design custom video 
tiles for use on video walls (Custom Tiles).
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Fig. 17-1: Audio Bars Widget Properties

The setting up of which audio channels are being monitored by the widget is done in a 
pop-up menu, see Audio Bars Widget Audio Channels.

Audio Bars Widget Audio Channels
An Audio Bars widget shows one or more bars of audio data from specified audio 
channels. This ‘bars’ configuration is set up in a dialog which is accessible from a right-click 
in the Tile Editor.

Properties boxSelected Audio Bars widget
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Open Audio Configuration Dialog

For an Audio Bars widget on a Custom Tile its audio bars configuration can be quickly set 
up:

1 Select the Audio Bars widget in the Tile Editor.
2 Right-click on the widget and select ‘Audio Configuration’ in the pop-up menu. (See 

Figure 17-2.)

Fig. 17-2: Right-Click on Audio Bars Widget

The Audio Configuration dialog is shown. 

Note: Audio Configuration and MV-8 Multiviewer Software Version:
The Audio Configuration dialog feature will be supported in MV-8 
multiviewer software version v4 onwards.

Properties boxRight-click on selected Audio Bars 
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The dialog is described in Audio Configuration Dialog - PCM Audio Bars Configuration, 
on page 787. 

3 To set up the audio bars configuration, see instructions in:
• Audio Configuration Dialog - PCM Audio Bars Configuration, on page 787; or in 
• Audio Configuration Dialog - DolbyE Audio Bars Configuration, on page 789.

4 When the audio bar configuration is done, click Apply.

The Audio Bars widget on the Custom Tile now shows the number of audio bars set up.

Fig. 17-3: Example 6-Bar Audio Bars Widget
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Fig. 17-4: Example Audio Monitoring with Audio Bars Widget

Audio Configuration Dialog - PCM Audio Bars Configuration
The dialog has a ‘PCM’ or a ‘DolbyE’ mode (see Figure 17-5 and Figure 17-6 respectively) 
and permits the configuration of up to 8 audio bars in the Audio Bars widget. 

CAUTION Ballistics and MV-8 Series Multiviewer Devices:
For MV-8 Series multiviewers, each multiviewer device has a 
global audio data ballistics setting. 
All audio metering data generated by the device uses this one 
global ballistics setting.
A device’s global ballistics setting is found:

• For a non-clustered multiviewer -

See the GV Orbit Client main menu
‘Multiviewer > Input Audio > Meter’  item
‘Meter Type’ setting.

• For a clustered multiviewer -

See the device’s control screen (RollCall template).
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Fig. 17-5: Audio Bars Configuration Dialog PCM Selected)

Bar Configuration
To configure audio bars for monitoring PCM audio channels:

1 Select PCM in the Audio Configuration dialog.
2 Enable the number of audio bars required. 

Note: These must be contiguous in the dialog, starting with ‘Bar 1’.

Tip: For example, to enable six bars:

PCM / DolbyE selection

(Mono) Audio channel selection 
for display on the audio bar

Audio Bar enable
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• Simply enable ‘Bar 6’. 

Bars 1 to 5 are enabled automatically.

For each enabled bar:
3 Select a mono audio channel (if the automatically selected channel is not what is 

required). There are 32 mono audio channels to choose from.
4 Repeat the above for each enabled bar.
5 Click Apply.

The Audio Bars widget shows the new number of audio bars in the Tile Editor.

Audio Configuration Dialog - DolbyE Audio Bars Configuration
The dialog has a ‘PCM’ or a ‘DolbyE’ mode (see Figure 17-5 and Figure 17-6 respectively) 
and permits the configuration of up to 8 audio bars in the Audio Bars widget.

Note: As bars are enabled, the (mono) audio channel selection increments 
automatically.
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Fig. 17-6: Audio Bars Configuration Dialog (DolbyE Selected)

Bar Configuration
To configure audio bars for monitoring DolbyE audio channels:

1 Select DolbyE in the Audio Configuration dialog.
2 Enable the number of audio bars required. 

Note: These must be contiguous in the dialog, starting with ‘Bar 1’.

Tip: For example, to enable six bars:

PCM / DolbyE selection

Channel-pair selection
(Mono) Audio channel selection

for display on the audio bar

Audio Bar enable
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• Simply enable ‘Bar 6’. 

Bars 1 to 5 are enabled automatically.

For each enabled bar:
3 Select a channel-pair to use (if the automatically selected channel-pair is not what is 

required). There are 16 channel-pairs to choose from.
4 Select a mono audio channel (if the automatically selected channel is not what is 

required). There are 8 audio channels to choose from (decoded from the DolbyE data in 
the selected channel-pair).

5 Repeat the above for each enabled bar.
6 Click Apply.

The Audio Bars widget shows the new number of audio bars in the Tile Editor.

Note: As bars are enabled, the (mono) audio channel selection increments 
automatically.



792

Audio Bars Configuration GV Orbit Version 2.3.0
Audio Configuration Dialog - DolbyE Audio Bars Configuration User Guide



 793

18IP Configuration

Introduction
GV Orbit is a dynamic system orchestrator tool. One of its many features is that it can 
configure, control and monitor signal routing in a GV Orbit IP routing system: It is the 
GV Orbit Control application that handles routing. GV Orbit Client is used to enter and 
manage the configuration settings of IP endpoints of devices for the IP routing system. This 
‘IP configuration’ uses the IP Configuration tool within GV Orbit Client. 

The IP Configuration tool automatically discovers all GVOP-supporting devices in a 
GV Orbit system which are on a GVOP domain, connected to the network and up-and-
running. The resulting list of discovered devices is presented to you. The tool allows you to 
configure IP settings for the devices ready for IP routing. Settings include:

• device name, device short name, and network host name;
• multicast group IP address settings; 
• spigot names and port numbers; and 
• IP flow enabling from spigots on a device etc. 

GV Orbit Client provides the IP Configuration information to the GV Orbit system, and in 
particular it is automatically passed to the router controller application, GV Orbit Control. 
The information is automatically used as the basis for IP device and spigot naming etc. for 
the routing topology that GV Orbit Control controls.

More than one IP routing system can be ‘IP-configured’ with GV Orbit Client in the same 
GV Orbit project. 

Spreadsheet Import
IP routing configuration information can be added manually into the IP Configuration tool 
or, more practically, it can be imported from a spreadsheet. The spreadsheet import/export 
facility provides a quick and convenient way of defining and saving IP endpoint settings, 
automating data entry and saving system settings.

Some validation of the data in the spreadsheet is performed automatically, checking for 
duplicate entries. 

Certain IP addresses are reserved by GV Orbit Control and cannot be used. Refer to the 
Release Notes for more information. See Related Documentation, on page 19.

IP routing devices in the system are either sources of or destinations for IP streams, or both. 
Data validation is carried out at import and status reporting on the devices and their IP 
streams is provided in the IP Configuration tool.

Note: The IP Configuration tool currently supports all endpoint devices 
that support GVOP, the GV Orchestration Protocol.
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Manual Edits
IP routing configuration information can be edited manually in the IP Configuration tool. 
Some validation of each new manual entry is performed automatically, checking for 
duplicate entries. 

IP Configuration Tool
The IP Configuration tool in GV Orbit Client enables fast, easy and reliable configuration of 
IP routing device parameters for use in a GV Orbit system. In this way, configurations are 
entered by you and then used by GV Orbit applications – for example by GV Orbit Control 
for the system routing. 

Such parameters are editable in GV Orbit Client only.

What the IP Configuration Tool Does Do...
IP Configuration tool is used to:

• Assign device and spigot names.
• Configure all IP flows sourced by the devices.
• Assign (traditional) router port numbers to the spigots used by the flows. (Source 

spigots and destination spigots.)
• Set (traditional) router port numbers and names.

Once a source flow within a Grass Valley device has been configured with multicast 
parameters, it starts to send IP flow data to the IP network switch.

GV Orbit Client IP Configuration tool does do the following:
• Discovers devices of an IP network system which use the same GVOP domain.
• Enables the setting up of IP routing device parameters, including for A and B redundant 

network fabrics.
• Sets up ‘traditional’ router port assignments.
• Provides the IP configuration information to the GV Orbit system, and in particular to its 

router controller application, GV Orbit Control.

What the IP Configuration Tool Does Not Do...
GV Orbit Client IP Configuration tool does NOT do the following:

• Does not configure network settings etc. on the devices themselves (such as: device IP 
addresses or VLAN information). This must be done when setting up each device.

• Does not know about any IP network topology nor about physical networks.

IP Configuration Tool and IP Router Operation
Once the IP Configuration is made, the information is passed to the GV Orbit system and 
then routing can be done in the usual way. 

Note:  GV Orbit Client talks to devices while carrying out its configuring and 
monitoring.
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While the IP router is operating and continues to operate:
• GV Orbit Client may be run with the IP Configuration screen open.
• The GV Orbit project may be closed.
• GV Orbit Client may be closed.
• If the PC hosting the GV Orbit Client is running no other Grass Valley applications, then it 

too may be shut down (and disconnected from the network). 

If GV Orbit Client is re-started and the GV Orbit project is re-opened, then GV Orbit Client will 
auto-discover the devices and gather all the information it needs. GV Orbit Client will 
present all of the IP Routing project screens as usual, listing discovered devices and with IP 
configuration details filled out.

GV Orbit Control
The GV Orbit Control part of a GV Orbit system uses information from GV Orbit Client: It 
automatically and dynamically generates Logical sources and destinations from the IP 
Configuration information. 

For more information on GV Orbit Control, refer to the GV Orbit Control User Guide, see 
Related Documentation, on page 19.

Devices that Support GVOP
Devices that support GVOP include:

• IQ-UCP - Universal Compute Processor,
• IQ-MIX - 3G/HD/SD-SDI Multi-channel IP Transceiver,
• IQ-AMD - Multi-channel MADI to IP Interface
• Audio Live - Audio Router for Multi-stream IP Audio Processing.
• IPVU - IP-to-HDMI Monitoring Gateway,
• MV-821 - Multiviewer.

More than One IP Configuration
It is possible to have more than one IP Configuration in a GV Orbit project. 

More than one IP routing system can be ‘IP-configured’ in the same GV Orbit project by 
specifying a different GVOP domain and creating a GV Orbit IP Configuration (.net file) for 
each IP routing system. 

Note: Parameter values from the IP Configuration tool are use in GV Orbit 
Control but are not editable in GV Orbit Control; they are shown ‘grayed-
out’ in GV Orbit Control screens.

Recommend:Ensure GV Orbit Control is running in the GV Orbit system 
while the IP Configuration tool is being used and while any 
whole configuration IP end point records are deleted.
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Each IP Configuration must connect to different devices. An IP Configuration deals with 
devices that it can discover. Devices can be segregated by either:

• Devices being on separate IP networks.

(Requires two separate IP networks and GV Orbit Client’s host PC to have separate 
network connection to each IP network.)

• Devices being on separate GVOP Domains.

(This may use one IP network. It requires devices to be set up to be in one of two GVOP 
domains.)

Then create a new IP Configuration .net file for use with each other IP routing system. (See 
Create a New IP Configuration.)

IP Routing Networks and the IP Configuration Tool
This section presents some aspects of IP routing systems which are encountered in the IP 
Configuration tool screens.

IP Routing Redundancy - Fabric A and Fabric B
GV Orbit supports network redundancy. Two independent IP networks may be used for 
routing redundancy. These two media networks are referred to as ‘fabric A’ and ‘fabric B’. 

Within a device, a source flow is split into identical source flows, A and B. These are sent 
from the same source spigot and onto different networks (fabrics A and B). The flows travel 
independently through their respective networks. Both flow A and flow B arrive at the 
destination spigot of the destination device. The original IP signal is then re-formed from 
the data packets from fabric A or fabric B. 

Devices must connect to both fabrics and GV Orbit Client must also connect to both fabrics.

Device Control Networks
Devices typically have one or more media network connections (for example, A and B 
redundant) and possibly a control network connection.

Devices may be controlled either in-band or out-of-band: 
• In-band - This means control is done over the media network(s). 
• Out-of-band - This means there is a separate control network. 

) 

Switching at Destination
A traditional router switches source signals going to a destination. A Grass Valley IP routing 
system can do the same. In a Grass Valley IP routing system, switching is done at the 
destination spigot. This means that switching can be asynchronous to the underlying 
network fabric and the network system does not have to be media-aware.

Note: It is possible for a device to be controllable but to have no connection 
to media network(s).
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Switching is done from a current IP flow to a new IP flow in a ‘Break before Make’ or in a 
‘Make before Break’ way:

• Break before Make (BbM): The current IP flow is dropped and then a connection is 
made to a new IP flow. 

• Make before Break (MbB): While connection to a new IP flow is being made, extra 
connection bandwidth is momentarily required. The current IP flow is then dropped 
once the new connection is made.

Grass Valley IP devices derive timing information from the IP network for switching 
between signals. For example, switching is done on video frame boundaries and a Grass 
Valley device’s destination spigot will switch and can provide a continuous video signal 
input to the device: 

• BbM: continuous signal achieved with “repeat current video frame”. 
• MbB: video simply cuts seamlessly from the current to a new video signal.

In This Chapter ...
In the remaining part of this chapter, the steps required to get started with an IP 
Configuration are outlined. 

• Open the IP Configuration Tool, on page 800.
• IP Configuration Tool Screen, on page 804.

Importing data from a spreadsheet is described in:
• Import Preview Dialog and Spreadsheet Duplicate Scan Dialog, on page 809; and 
• Getting Started with Spreadsheet Import, on page 824.

The ability to over-ride some import checking and keep duplicate port names (GV Orbit 
Control mnemonics) is described in Allowing Duplicate Port Names on Import, on 
page 822.

Additionally, if a further IP Configuration is required, then Create a New IP Configuration, 
on page 797, describes creating a new configuration in a C&M project.

Create a New IP Configuration
A Control and Monitoring GV Orbit project (C&M project) has an existing default IP 
Configuration (default.net) that may be used.

If more than one IP Configuration is required in a project, then one or more further, new IP 
Configuration(s) can be created, as required, from the Project window in GV Orbit Client. 
They are created as separate .net file(s) in the project. 

A second IP configuration would need to be set up to look at a different set of devices, 
typically on a different GVOP domain.

To create a new IP Configuration file:

Note: For each device, ‘Break before Make’ or ‘Make before Break’ is set up 
on a ‘per destination spigot’ basis as part of the set up of each device; this is 
not set up in GV Orbit Client.
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1 In the Project window, expand the item for the currently-open project.

Fig. 18-1: New Network

2 Right-click on the ‘networks’ sub-folder item and select ‘New Network’.

The New Network File dialog is shown.

Fig. 18-2: New Network File Dialog

3 Enter a name for the new IP Configuration and click OK.

A new IP Configuration .net file is created in the Project window in the ‘networks’ sub-
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folder and is opened in the main screen area.

Fig. 18-3: New IP Configuration

Fig. 18-4: New IP Configuration Open in GV Orbit Client

4 Configure the IP Configuration by clicking on the Comms Setup button in the 
Properties box. See instructions in IP Configuration Tool Comms Setup, on page 802. 
Setup the IP Configuration up to look for devices on a different GVOP domain and/or 
on a different network.

New IP Configuration in the Project window and also open in GV Orbit Client
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Open the IP Configuration Tool

Prerequisites
Before performing IP Configuration, the following are required:

• A GV Orbit system.
• Each device must be configured with basic settings (such as valid IP addresses and sub-

nets, and on the same GVOP domain). 

• Each device must be powered on and connected to all the network(s) (that is to one or 
more media networks, and/or to a control network).

• GV Orbit Client running on a client PC with a Control and Monitoring GV Orbit project 
opened.

• A list of required configuration settings - multicast IP addresses, device names, spigot 
names etc. in a spreadsheet format for importing.

Procedure
In a configuration and monitoring project (C&M project) that is already set up on a GV Orbit 
system, to open the IP Configuration tool:

1 View the Routing Workflow screen.
2 Click on the ‘IP Configuration and Spreadsheet Import’ icon. See Figure 18-5.

An IP Configuration tab is opened. For a new project, the default tab name is 
‘default.net’. See Figure 18-6.

The IP Configuration tool requires setting up, see IP Configuration Tool Comms Setup, 

Note: Each device must be set up independently of GV Orbit Client via its 
usual control screen; it is set up as part of the configuration step for each 
device and also includes IP addresses for each of the device’s IP network 
ports. (Refer to the specific documentation for each device for this setting 
up.)

Note: The default GVOP domain ID number is 101. 
For a newly-created network, if there are any devices present on the 
default domain, then they will be shown in the ‘Devices’ tab.
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on page 802.

Fig. 18-5: IP Configuration and Spreadsheet Import Icon in the Routing Workflow Screen

Fig. 18-6: IP Configuration Editor Screen 

Devices tab Comms Setup button

Properties box

Project name in the Project window

IP Configuration name in 
Project window and on main tab

IP Configuration tool editor screen main area
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IP Configuration Tool Comms Setup
To initially set up the IP Configuration tool:

1 Click the Comms Setup button.

The Comms Setup dialog is shown.

Fig. 18-7: Comms Setup Dialog

2 In the Comms Setup dialog:
a) IP Routing Domain - The default IP Routing GVOP Domain for a GV Orbit system is 

‘101’ and should not need to be changed here if there is only one IP Configuration.
b) Routing System - The selected routing controller type should be ‘GV Orbit Control’ 

(‘GVOC’). 

This selects to work with the router controller of the GV Orbit system.
c) GVOC Domain - The default GVOC Domain for a GV Orbit system is ‘105’ and 

should not need to be changed here.
d) IP interfaces - Select the client PC network IP interfaces for the IP Configuration 

tool to use. 
This will depend on the network connections that the PC has. 

For example, in order for the IP Configuration tool to discover all devices on a 
GVOP Domain, the client PC may need connections to:
– both media network interfaces (A and B, for in-band control); and 
– the system’s control network (for out-of-band control). 
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These PC interfaces need to be selected.

3 Click OK. 

GV Orbit Client will discover IP End-points on devices and list them in the main screen 
area. See Figure 18-8.

IMPORTANT Do not enable more than four network interfaces.



804

IP Configuration GV Orbit Version 2.3.0
IP Configuration Tool Screen User Guide

Fig. 18-8: Listed Discovered Devices

In the main screen area:
4 Click on the Devices tab, if it is not already shown, to see the listed devices. See also IP 

Configuration of End Point Devices and Spreadsheet Import, on page 75.
5 Verify that all devices are shown listed in the Devices tab. 

The IP Configuration tool is ready.

IP Configuration Tool Screen
The IP Configuration tool comprises several tabbed screens and a Properties box. 

For a description of each tab in the IP Configuration tool screen and the Properties box, 
refer to the Orbit for IP Routing user manual.

Fig. 18-9: IP Configuration Tool Screen

IP Configuration Tabs
The IP Configuration tool tabs are presented from left to right in the order in which they 
are used when configuring an IP routing network system: configuration of and information 
about devices, spigots, flows, and router ports; and status and log information.

Tabs Properties box

Main Area

 Table 1: IP Configuration Tool Tabs

IP Configuration Tool Tab Description

Devices Shows discovered devices.
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For a description of each tab in the IP Configuration tool screen and the Properties box, 
refer to the Orbit for IP Routing user manual.

Columns

Sort Columns
In tables in the tabs, click on column headings to toggle sorting of row entries 
alphabetically in ascending or descending order (that is, A-to-Z or Z-to-A).

Spigots Connects spigots to router ports.

Src Flows Assigns multicast groups to source flows.

Dst Flows Assigns destination flows to multicast IP streams.

Router Src Ports Summarizes the router source ports.

Router Dst Ports Summarizes the router destination ports.

LLDP, LLDP A, 
LLDP B

Presents local link device information.

Routing Status Graphical presentation of routing.

Bandwidth Status Graphical presentation of device bandwidth usage.

Log Shows log messages.

 Table 1: IP Configuration Tool Tabs

IP Configuration Tool Tab Description
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Expand/Collapse Rows

Individual Row Items

Some table rows may be individually expanded and collapsed by clicking on the small 
triangular icon at the left hand side of each row. See Figure 18-10.

Fig. 18-10: Expand/Collapse Individual Row Items

Click the small triangle to collapse the row item.

Click the small triangle to expand the row item.

b) Expanded Row Item

a) Collapsed Row Item
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All Row Items

To expand or collapse all rows, use the Expand All and Collapse All icons. Figure 18-11.

Fig. 18-11: Expanding/Collapsing All Row Items

a) Expand/Collapse Controls

b) Collapsed

c) Expanded to One Level

d) Expanded to All Levels

• Click to collapse rows.
• Click to expand to one level.
• Click to expand to all levels.
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Editable Cells
Many of the tabs in the IP Configuration tool have similar features. Several tabs permit 
manual editing of some table cells. Table cells which may be edited are shown with a 
‘pencil’ edit icon when the cursor is hovering inside them. See Figure 18-12.

Fig. 18-12: Editable Cell and Pencil Edit Icon

To edit an editable table cell:
1 Click in the cell. 
2 Enter new text.
3 When new text has been entered:

• Press the Enter key to enter the new text. 

Or:
• To abort changes, click outside the cell to keep the original text.

Automatic Entry Checking
When a cell value is changed, a check is automatically carried out, checking for duplicate 
values and you are alerted. See Figure 18-13.

Fig. 18-13: Cell Text Entry Error
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Checking is done for uniqueness of:
• Device Name
• (Device) Short Name
• (Device) Host Name
• (Spigot) Port Name
• (Spigot) Short Name
• (Spigot) Port Number

Import Preview Dialog and Spreadsheet Duplicate Scan Dialog
This section describes the spreadsheet import options that there are for the IP 
Configuration tool in GV Orbit Client and which are shown in the Import Preview dialog 
and the accompanying Spreadsheet Duplicate Scan dialog:

In this section:
• Viewing the Dialogs, on page 809
• Spreadsheet Duplication Scan Dialog, on page 811

• Import Data Validation - Duplicate Scan, on page 811
• Resolving Duplicate Issues, on page 812
• Before Allowing Duplicate Port Names in an Import, on page 813

• Import Preview Dialog, on page 814
• Import Preview Dialog - Spreadsheet Section, on page 814
• Import Preview Dialog - Options Section, on page 820
• Import Preview Dialog - Preview of Device Changes, on page 821

Viewing the Dialogs
To see the Import Preview dialog and the Spreadsheet Duplicate Scan dialog:

1 In the Devices tab, click Import . See also IP Configuration of End Point Devices and 
Spreadsheet Import, on page 75.

2 Select the required spreadsheet and click Open.

The spreadsheet is opened and the resulting Import Preview dialog is shown. (See 
Figure 18-14.) And, automatically:

• the spreadsheet contents are automatically analyzed; 
• some basic checks are carried out; and
• the result of these checks is shown in a summary Spreadsheet Duplicate Scan 

dialog, which pops up. See Figure 18-15.

Notes

The duplicates checking that is carried out is insensitive to case.
For example, the duplicate checking will warn you that MVinput is the same 
as MVINPUT.

A short name must not be more than 8 characters long.
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Fig. 18-14: Import Preview Dialog

Fig. 18-15: Spreadsheet Duplication Dialog

If the Spreadsheet Duplication Scan Dialog shows that there are some issues when 
importing, then these must be resolved in the spreadsheet before importing can be done.

3 Correct any problem(s) in the spreadsheet and re-import the spreadsheet.
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See Import Data Validation - Duplicate Scan, on page 811 and Resolving Duplicate 
Issues, on page 812.)

If the Spreadsheet Duplication Scan dialog shows no issues, 
4 Close the Spreadsheet Duplicate Scan dialog. 

For a description of each of these dialogs, see:
• Spreadsheet Duplication Scan Dialog, on page 811; and 
• Import Preview Dialog, on page 814.

Spreadsheet Duplication Scan Dialog
A Spreadsheet Duplication Scan dialog is shown after the start of a spreadsheet import 
after an automatic Duplicate Scan check is carried out.

Fig. 18-16: Spreadsheet Duplication Dialog 

Import Data Validation - Duplicate Scan
A Duplicate Scan checks the imported IP Configuration data to ensure that the GV Orbit 
Control application does not receive incorrect or conflicting IP configuration data. The 
following are checked: 

• Duplicate IP addresses.
• Duplicate device names, short names and host names. 
• Duplicate router source port numbers, port names and short names.
• Duplicate router destination ports numbers, port names and short names.

Click View to see a list of the duplicate issues found.
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A short name must be unique and not be more than 8 characters long. Short names that 
are longer than 8 characters are truncated upon import and data validation, and then the 
truncated short names are checked to see if there is a duplicate with any other truncated 
short names. Any duplicates must be resolved before continuing. In a large network system, 
this check can help find typographical errors in the system set up.

The results of the checks are shown in the Spreadsheet Duplicate Scan dialog.

Resolving Duplicate Issues
If the Spreadsheet Duplication Scan dialog shows that there are some issues when 
importing: 

Inspect and correct each issue:
1 Click View beside the problem issue(s) in the dialog.

This lists the issues.
2 Select an issue item in the list.

More details about the issue are shown. See Figure 18-17.

Fig. 18-17: Inspecting Duplication Scan Issues

3 Correct the problem(s) in the spreadsheet by eliminating duplicate values.

Do this for each issue.

Finally, once all issues are addressed:
4 Close the Spreadsheet Duplicate Scan dialog and Cancel the Import Preview dialog.

This aborts the import.

Select an issue item to 
see details.

Click View to see a list of the duplicate issues found.
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5 Re-import the spreadsheet.

Before Allowing Duplicate Port Names in an Import
For Port Names, it is possible to override the checking and perform an import with 
duplicate Port Names, if required.

Before allowing duplicate Port Names when importing data:
1 Clear other issues that there might be from the duplicate scan.

This should leave only a duplicate ‘Port Name(s) alert’ in the Spreadsheet Duplicate 
Scan dialog that results from known Port Name duplicates that you want to allow.

2 Close the Spreadsheet Duplicate Scan dialog.

Then:
3 See Allowing Duplicate Port Names on Import, on page 822.

Note: The default behavior on importing new values from a spreadsheet is 
to not allow duplicate values. For user cases where duplicate Port Names, for 
some reason, are required, there is a mechanism for getting round this.

IMPORTANT With Allow Duplicate Port Names selected in the Import 
Preview dialog, duplicate Port Name values are allowed when 
importing. However, you should take care that such duplicate value 
entries will not impact their system.
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Import Preview Dialog

Fig. 18-18: Import Preview Dialog Anatomy

Import Preview Dialog - Spreadsheet Section
The Spreadsheet section of the Import Preview dialog contains:

• the facility to open the spreadsheet for editing; and 
• a spreadsheet summary, which summarizes information present in the worksheets of 

the selected spreadsheet.

Any issues with or differences in the selected spreadsheet compared to the current settings 
in the IP Configuration tool are indicated in the dialog. This provides a useful means of 
checking:

1 if the selected spreadsheet is the correct one before importing; 
2 if there are any issues with the spreadsheet; and 
3 any difference the spreadsheet contains compared to the currently-open IP 

Configuration of the open C&M project.

Click to Import

Spreadsheet section,
see Import Preview Dialog - Spreadsheet Section, on page 814.

Import Options section, 
see Import Preview Dialog - Options Section, on page 820.

Import Preview of Device Changes section, 
see Import Preview Dialog - Preview of Device Changes, on page 821.
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The Spreadsheet section of the dialog is shown in Figure 18-19 and it is described in 
Table 2.

Fig. 18-19: Import Preview Dialog - Spreadsheet Information

Selected spreadsheet file path and file name.
Click Open Spreadsheet to open the file in a spreadsheet editor (for example in 
Microsoft Excel).

Spreadsheet Summary of selected file, see Table 2.

Explanation of ‘Spreadsheet Summary’ column headings. See Table 2.

 Table 2: Spreadsheet Summary - Column Headings 

 Column Heading Description

Sheet Name of a worksheet in the spreadsheet file.

Total Records Number of row items in the worksheet.

Changed Number of row items that are different to current values.

Unchanged Number of row items that are the same as current values.

Offline Number of row items that match to a device that is off-line.
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Example Spreadsheet Summary Issues:

The ‘Spreadsheet Summary’ in the Import Preview dialog can indicate several issues with 
the form and the content of a spreadsheet-to-be-imported compared to the currently-
open IP Configuration. Some example spreadsheet issues are presented here.

Figure 18-20 shows an example ‘Spreadsheet Summary’. Each red item is caused by an issue 
in the selected spreadsheet, shown in Figure 18-21 to Figure 18-26.

Inapplicable Number of row items that are inconsistent with the currently 
open GV Orbit project IP Configuration:

• For a spigot row item: 
Spigot is set to the wrong mode, or it is a phantom.

Note: A phantom spigot has an entry in the routing system’s 
working port table but does not exist on the device.

• For a flow row item: 
Parent spigot is the wrong mode or its parent device is 

not on-line.

For example, 
a Grass Valley IQMIX IP modular card may have been re-
configured to have a different number of inputs and outputs (or 
number of destinations and sources).

Unmatched Number of row items not matched to any device. This means 
that either: 

• an item does not have a counterpart in the currently-open 
C&M project IP Configuration; or 

• an item is not found in the open project.

For example:
• a device may be temporarily off-line; or
• on a live routing system, the current routes to/from 

destination/source spigots will differ from any “snapshot” 
captured in a spreadsheet.

Invalid Number of row items that are malformed. Malformed items have 
missing values in one or more required fields.

Additional Information Provides additional information about work sheets.

 Table 2: Spreadsheet Summary - Column Headings  (continued)

 Column Heading Description
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Fig. 18-20: Example Spreadsheet Summary

Fig. 18-21: Example Spreadsheet Issues - a) An Unmatched New Device.

Six ‘invalid’ issues for Destination Ports, see Figure 18-23f.

261 unmatched issues for Destination Ports
- because the currently open IP Configuration is for a live IP

routing system and routes have been changed.

One unmatched issue on the Device Names worksheet, see Figure 18-23a.

Two unmatched issues for Source Ports, see Figure 18-23b.

Three unmatched issues for Destination Ports, see Figure 18-23c.

Four unmatched issues for Source Flows, see Figure 18-23d.

Five ‘inappropriate’ issues for Destination Ports, see Figure 18-23e.

New device row item
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Fig. 18-22: Example Spreadsheet Issues - b) Two Unmatched New Source Ports.

Fig. 18-23: Example Spreadsheet Issues - c) Three Unmatched New Destination Ports.

Fig. 18-24: Example Spreadsheet Issues - d) Four Unmatched New Source Flows.

New source port rows

New destination port rows

New source flow rows
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Fig. 18-25: Example Spreadsheet Issues - e) Five Inappropriate Destination Flow Row Items.

Fig. 18-26: Example Spreadsheet Issues - f) Six Invalid Destination Flow Row Items.

Source 
spigot 

indexes

The spigot index used here for a Destination spigot index 
is actually the index for a Source spigot on the device.

Row items are invalid - each does not have a GUID nor an IP Address entry.
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Import Preview Dialog - Options Section

Fig. 18-27: Import Preview Dialog - Options Section

Import Options

Import unchanged records:
• Select - Import and apply all spreadsheet records when importing the spreadsheet. 

(This forces an IP Configuration into a known state.)
• Deselect - Import and apply only changed records.

Allow Duplicate Port Names:
• Select - Allow duplicate port names to be imported.
• Deselect - Imports with duplicate port names are now allowed.

See Allowing Duplicate Port Names on Import, on page 822.

Import Functions

Click on an item to perform a checking action: 

Multicast Scan

Click to generate a full listing of the multicast groups comprising the IP flows in the IP 
Configuration. The check results are shown in a dialog. 
For more information, refer to the Orbit for IP Routing user manual.

Select the worksheets of the 
spreadsheet to import

Import Options Import Functions

IMPORTANT With Allow Duplicate Port Names selected in the Import 
Preview dialog, duplicate Port Name values are allowed when 
importing. However, you should take care that such duplicate value 
entries will not impact their system.



821

GV Orbit Version 2.3.0 IP Configuration
User Guide Import Preview Dialog

Subnet Scan

Click to check that device IP addresses are on specified network subnets. The check results 
are shown in a dialog.
For more information, refer to the Orbit for IP Routing user manual.

Duplicate Scan

Click to check for duplicate IP addresses, device names, port numbers/names etc. This 
check is automatically done before importing. The check results are shown in a dialog. See 
Import Data Validation - Duplicate Scan, on page 811.

Import Preview Dialog - Preview of Device Changes
The Import Preview dialog indicates the nature of changes that would occur in the IP 
Configuration if the spreadsheet were to be imported.

Fig. 18-28: Import Preview Dialog - Preview of Device Changes

Full previewed list of changed settings items, see Table 3.

Click Select All to select all preview items.

Click Deselect All to deselect all preview items.

 Table 3: Preview of Device Changes - Column Headings

Import Preview 
Column Headings Description

(First column)  Check box.

• Select - to select an item for importing.
• Deselect - to deselect an item for importing.

Device Device GUID.

Name Device name.

Name change ‘Yes’ - Device name has changed.
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Allowing Duplicate Port Names on Import
For Port Names, it is possible to override the checking and perform an import with 
duplicate Port Names, if required.

To allow duplicate Port Names when importing spreadsheet data:
1 First, clear other issues that there might be from the duplicate scan.

This should leave only a duplicate ‘Port Name(s) alert’ in the Spreadsheet Duplicate 
Scan dialog that results from known Port Name duplicates that you want to allow.

2 Close the Spreadsheet Duplicate Scan dialog.

Then, in the Import Preview dialog:
3 Select the Allow Duplicate Port Names option.

The Import button should become ungrayed-out. See Figure 18-29.

Source Port changes ‘NN’ - number of source ports that have settings changes,
where NN is an integer number.

Dest Port changes ‘NN’ - number of destination ports that have settings changes,
where NN is an integer number.

Source Flow changes ‘NN’ - number of source flows that have settings changes,
where NN is an integer number.

Dest Flow changes ‘NN’ - number of destination flows that have settings changes,
where NN is an integer number.

 Table 3: Preview of Device Changes - Column Headings (continued)

Import Preview 
Column Headings Description
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4 Click Import to begin the import.

Fig. 18-29: Allowing Duplicate Port Names when Importing from a Spreadsheet

IMPORTANT With Allow Duplicate Port Names selected in the Import 
Preview dialog, duplicate Port Name values are allowed when 
importing. However, you should take care that such duplicate value 
entries will not impact their system.
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Getting Started with Spreadsheet Import
The IP Configuration spreadsheet can be created from scratch. However, when getting 
started, it is often easier to first export a spreadsheet from the IP Configuration tool in 
GV Orbit Client. This ‘starting’ IP Configuration should have discovered all of the devices in 
the GV Orbit system. The resulting exported spreadsheet will then contain all of the 
discovered devices in the GV Orbit system.

The spreadsheet should be edited to add router port numbers, device and source port 
names, multicast address details etc. Finally, the spreadsheet is imported into the IP 
Configuration tool of GV Orbit Client, and its information is validated and then is passed to 
the rest of the GV Orbit system.

This section describes:
• Step 1: Exporting a Spreadsheet, on page 824.
• Step 2: Editing a Spreadsheet, on page 826.
• Step 3: Importing a Spreadsheet, on page 829.

See Appendix B, IP Configuration Spreadsheet Appendix, on page 839, for more 
information on the spreadsheet.

Step 1: Exporting a Spreadsheet
To export a spreadsheet which contains all discovered devices, in the Devices tab: See also 
IP Configuration of End Point Devices and Spreadsheet Import, on page 75.

1 Ensure that the filter text field is empty (see Figure 18-30).

Fig. 18-30: Devices Tab - Export Button

2 Check that all devices are listed in the tab.

Note: The ‘Export’ and ‘Import’ facility can be used to take a snapshot of 
settings and restore settings.

Filter text field

Export button

Listed devices
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3 Click the Export button.

A small dialog window appears.

Fig. 18-31: Export Dialog

4 Select ‘Include device GUIDs’.
5 Click Export.
6 Select a filename and location to save the spreadsheet in,

and click Save’

An exported spreadsheet is created
and a confirmation dialog is shown which lists how many records have been saved:

Fig. 18-32: Export Dialog (Export Completed)

7 Click Close.

The blank settings of the new project have been exported to a spreadsheet file (extension 
.xlsx).
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Spreadsheet Format
See Appendix B, IP Configuration Spreadsheet Appendix, on page 839 for more 
information on the spreadsheet.

Fig. 18-33: IP Configuration Spreadsheet

Step 2: Editing a Spreadsheet
The worksheets in the spreadsheet file comprise:

• Device Names
• Source Ports
• Destination Ports
• Source Flows
• Destination Flows

Instructions on editing the spreadsheet to set up initial device information follow. 
Worksheets must be edited to:

• set up friendly device names, short names and host names
(see Device Names Worksheet);

• set up an optional device descriptions (see Device Names Worksheet);
• set up user-defined traditional router port numbers and names 

(see Source Ports Worksheet and Destination Ports Worksheet);
• set up all possible potential sources (source flows) 

(see Source Flows Worksheet); and 
• clear any existing routes, if required

(see Destination Flows Worksheet (Clear Routes).
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Device Names Worksheet
On the ‘Device Names’ worksheet, for each device:

1 Enter a friendly name in the Device Name column. 
2 Enter a short, friendly device name in the Short Name column.
3 Enter a host name in the Host Name column. 
4 Enter a description in the Description column. 

Fig. 18-34: Enter Device Name

Source Ports Worksheet
On the ‘Source Ports’ worksheet, for each source port (device source spigot):

1 Enter the (traditional) router source port number in the Port Number column.
2 Enter the (traditional) router source port name in the Port Name column.
3 Enter a short source port name in the Short Name column.

Fig. 18-35: Enter Source Ports (Source Spigots) Details

Destination Ports Worksheet
On the ‘Destination Ports’ worksheet, for each source port (device source spigot):

Note: A Short Name must be unique and not be more than 8 characters 
long. Short names that are longer than 8 characters are truncated upon 
import and then are checked if there is a duplicate with other truncated short 
names.
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1 Enter the (traditional) router destination port number in the Port Number column.
2 Enter the (traditional) router destination port name in the Port Name column.
3 Enter a short destination port name in the Short Name column.

Fig. 18-36: Enter Destination Port (Spigot) Details

Source Flows Worksheet
On the ‘Source Flows’ worksheet, configure each source flow, edit the following columns:

1 Flow Enabled - Enter ‘Y’ to enable the source flow.
2 Multicast Address - Enter a multicast group IP address.
3 Dst RTP Port - Enter an IP port number. 

(To define which IP port a source flow should use at a destination spigot.) 
4 Src RTP Port - Enter an IP port number. 

(To define which IP port a source flow should use at its source spigot.) 

Fig. 18-37: Enter Source Flow Details

Note: A Short Name must be unique and not be more than 8 characters 
long. Short names that are longer than 8 characters are truncated upon 
import and then are checked if there is a duplicate with other truncated short 
names.
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Destination Flows Worksheet (Clear Routes)
For the initial setting up of the spreadsheet, all routes can be cleared with the spreadsheet. 
On the ‘Destination Flows’ worksheet, configure each destination flow:

1 In the Flow Type column, enter ‘None’.
2 Delete all entries in the following columns:

• Flow Enabled, 
• Multicast Address, 
• Source Address, 
• Dst RTP Port; and 
• Src RTP Port columns.

See Figure 18-38.

This will stop flows to all destinations, by clearing all routes.

Fig. 18-38: Destination Flows Worksheet AFTER editing.

Save
Spreadsheet editing is now finished. 

1 Save the spreadsheet file.

Step 3: Importing a Spreadsheet
The spreadsheet contains IP Configuration data. It is automatically validated when being 
imported into the GV Orbit Client. The data is used by the IP Configuration tool and 
automatically passed on to the GV Orbit Control application for use in its routing. 

CAUTION
Importing a spreadsheet into the IP Configuration is a potentially disruptive 
operation.
This is because it may affect all existing devices and routes. 
To try and prevent unintentional importing and disruption, GV Orbit Client 
alerts you to the risk of the operation and presents an overt, prompting 
authorization step to go through.
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The importing is presented below in the following steps:
• Step 3a: Import Preview, on page 830.
• Step 3b: Clearing Any Import Issues, on page 832.
• Step 3c: Import the Spreadsheet, on page 832.

Step 3a: Import Preview
To import the spreadsheet into the IP Configuration tool:

1 Select the Devices tab and click the Import button. See also IP Configuration of End 
Point Devices and Spreadsheet Import, on page 75.

Fig. 18-39: Devices Tab Import Button

2 Select the required spreadsheet file to import and click Open.

The spreadsheet is opened and its contents are initially read and compared to the 
current data values in the IP Configuration tool automatically. Some preliminary data 
checks are done, checking for the uniqueness of spreadsheet values. 
Note: The importing operation is NOT done yet.

An Import Preview dialog (see Figure 18-40) is then shown and if there are any issues 
found from the data checks, then a Spreadsheet Duplicate Scan dialog is also shown 
(see Figure 18-41), which reports any issues found from the data checking. 

If there are issues, then the Import button in the Import Preview dialog is grayed out, 
preventing imports. This will be un-grayed out when issues are cleared.

(See Import Preview Dialog and Spreadsheet Duplicate Scan Dialog, on page 809, for 

Note: The preliminary data value checking that is carried out upon 
spreadsheet import is insensitive to case.For example, the duplicate 
checking will warn you that ‘MVinput’ is the same as ‘MVINPUT’.
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more information about the dialog.)

Fig. 18-40: Import Preview Dialog

Note: For information on the import data validation, see Import Preview 
Dialog and Spreadsheet Duplicate Scan Dialog, on page 809 and Import 
Data Validation - Duplicate Scan, on page 811.

‘Sheets to Import’ section, 
select all options for ‘Getting Going’ for the 
first time.

Note: The Import button will be grayed out if there are 
any import issues (presented in the pop-up 
Spreadsheet Duplicate Scan dialog).
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Step 3b: Clearing Any Import Issues

Fig. 18-41: Spreadsheet Duplicate Scan Dialog.

If there are any issues shown in the Spreadsheet Duplicate Scan dialog, then:
1 Inspect each issue in the dialog.
2 Re-visit the spreadsheet and correct any issues.

(See Spreadsheet Duplication Scan Dialog, on page 811, and Resolving Duplicate 
Issues, on page 812.)

Finally:
3 Close the Spreadsheet Duplicate Scan dialog and Cancel the Import Preview dialog.

This aborts the import.
4 Re-import the spreadsheet.

Step 3c: Import the Spreadsheet
The Import button on the Import Preview dialog is:

• Grayed out when there are reported or unaccounted for import duplicate issues.
• Not grayed out when there are no issues or all issues are accounted for.

To import:

Note: The default behavior on importing new values from a spreadsheet is 
to not allow duplicate values. For user cases where duplicate Port Names are 
required for some reason, there is a mechanism for getting round this. See 
Before Allowing Duplicate Port Names in an Import, on page 813.

Note: This dialog is shown before any importing of spreadsheet 
information, and it warns of any potential import issues that there are.
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1 In the ‘Sheets to Import’ section of the Import Preview dialog, 
select the import options required. 
When ‘Getting Going’ for the first time, select all options.

2 Click Import.

The importing of the spreadsheet information begins. 
3 A High Risk Alert dialog is shown when importing a spreadsheet.

See Figure 18-42a, b and c.

.

Fig. 18-42: HIGH RISK Alert and Authorization:
a) HIGH RISK Alert; b) Enter User Password; c) Authorization Successful.

IMPORTANT
Importing is a potentially disruptive operation to any current IP routing 
being done by GV Orbit. 
When ‘getting started’ for the first time, no routing should be currently 
happening, it is alright to continue.

a) High risk operation alert message

b) Enter user project password

c) Authorization successful, press ‘Next’



834

IP Configuration GV Orbit Version 2.3.0
Step 3: Importing a Spreadsheet User Guide

4 Follow the on-screen instructions on the HIGH RISK dialogs to authorize the importing.

To abort the importing process, click Cancel on the HIGH RISK dialog.
To continue, press Next on the dialog.

Entry of the user password is required.
after which, to begin importing, press Next in the dialog. (Pressing Cancel aborts.)

The importing proceeds.
5 When the importing is complete, 

an Import summary dialog shows a summary of what configuration settings have been 
restored.

Fig. 18-43: Import Summary

6 Click OK.

The configuration in the spreadsheet has been imported into the IP Configuration tool in 
GV Orbit Client. The information is made available to GV Orbit Control for routing.

After import, in the IP Configuration tool:
• Devices will adopt the newly-set device names.
• Device ports will be mapped to the newly-defined router port numbers, with new port 

names.
• Device source spigots will be able to send out flows.
• Device destination spigots will be ready to receive flows.
• No flows will be routed.

CAUTION
Importing a spreadsheet into the IP Configuration is a potentially 
disruptive operation.
This is because it may affect all existing devices and routes. 
To try and prevent unintentional importing and disruption, GV Orbit Client 
alerts you to the risk of the operation and presents an overt, prompting 
authorization step to go through.

Note: Only settings for on-line devices are initially compared and then 
imported.
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GV Orbit C&M projects contain C&M project screens and XY Panel screens (see Chapter 13, 
Routing Control - XY Routing Panel, on page 591) which use on-screen widgets and 
‘behind-the-scenes’ GV Orbit Client Behaviours and Bindings. 

Routing type Behaviours and Bindings may be used with on-screen Button widgets etc. on 
XY Panel screens or soft control panels to synthesize a custom router control panel. 

These Routing Behaviours and Bindings are listed in Table A-1 and Table A-2 respectively. 

Routing Behaviours

Note:
It is recommended that an XY panel screen created through the XY Wizard is 
used as the basis of a custom routing panel. This may be edited in GV Orbit 
and customized as required.

 Table A-1: Routing Behaviours 

Behavior Parameters

Name,
(RollCall) Address,
+...

Description

When triggered on an GV Orbit C&M project XY panel screen...

BPX Source,
Destination

Routes a defined Source to a defined Destination.

(BPX, button per crosspoint)

Cancel Mode Cancels any selected Destination(s) and pre-selected 
Source(s).

Destination Destination,
Level

Provides access to information about a Destination, including 
its name, port number and the currently-routed Source.

Destination Button Index,
Destination,
Mode

Enables a button to act like a Destination selection button.

Destination Level 
Button

Index Enables a button to act like a Destination Level selection 
button.

Dialpad Index,
Sources,
Clear,
Delete

Enables a button widget to act like a Dial Pad button.

Dialup Tally Sources Allows the currently active Dialup value to be displayed (on a 
panel screen).
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Routing Bindings

Filter Sources Applies a filter to the router Sources or Destinations.

Load Panel Target Opens the GV Orbit Client Routing Panel in the client window 
or on a monitor display.

Page Page Sources,
Page Offset

Switches between router panel pages

Page Index Page Sources,
Index

Switches to a specific page index,

Page Tally Page Sources Allows the current page value to be displayed (on a panel 
screen).

Panel Lock Mode Toggles panel lock/unlock.

Protect - Protects a selected Destination.

Redo Button - Re-makes a route, used to implement a Redo button. 
(When placed on a panel schematic, enables Redo mode.)

Salvo Salvo Executes a salvo.

Source Button Index,
Source,
Mode

Selects a Source.

Source Level 
Button

Index Enables a button to act like a Source Level selection button.

Take Mode Router Take: Makes a route, used to implement a Take button. 
(When placed on a panel schematic, enables Take mode.)

Undo Button Undo Requires Take,
Undo Timeout

Undoes a route, used to implement an Undo button. 
(When placed on a panel schematic, enables Undo mode.)

 Table A-1: Routing Behaviours  (continued)

Behavior Parameters

Name,
(RollCall) Address,
+...

Description

When triggered on an GV Orbit C&M project XY panel screen...
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 Table A-2: Routing Bindings 

Binding Parameters

Name,
+...

Description

Binding binds a...

Panel Lock Source Behaviour,
Locked Caption,
Unlocked Caption

...Widget to Panel Lock function.

Router Button Source Behaviour,
Normal Style,
Preset Style,
Routed Style

...Routing Behaviour to a Button.
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Introduction
This appendix outlines the format of the IP Configuration spreadsheet used by GV Orbit 
Client.
Certain IP addresses are reserved by GV Orbit Control and cannot be used. Refer to the Release 
Notes for more information. See Related Documentation, on page 19.

All IP endpoint settings (device name, spigot and flow settings etc.) of an GV Orbit Client IP 
routing network configuration (IP Configuration) may be exported (saved) to a file or 
imported from a file. The file is a spreadsheet file and it may be created off-line from scratch; 
or an exported spreadsheet may be used and edited off-line (which is easier).

The exported file is in a spreadsheet format and can:
• be edited;
• provide a ‘template’ spreadsheet;
• be used during system set up; 
• be the primary source of information;
• be the Orbit project backup mechanism.

Import and Export Buttons
Exporting or importing is done in the Devices tab of the IP Configuration tool in GV Orbit 
Client. See also IP Configuration of End Point Devices and Spreadsheet Import, on page 75.

• Clicking on the Export or on the Import buttons in the tab’s tool bar. 

Note: It is recommended that an exported spreadsheet from your system is 
used as the basis for entering settings for your system.
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Fig. B-1: Devices Tab - Import and Export Buttons

Exported Spreadsheet File

Fig. B-2: IP Configuration Spreadsheet

The exported file is in an MS Office spreadsheet format (file extension .xlsx).
There are five tabbed work sheets in the file:

• Device Names Work Sheet
• Source Ports and Destination Ports Worksheets
• Source Flows and Destination Flows Worksheets

Each worksheet contains two sorts of data columns:
• Key Field columns - these list parameters which define a Device, a Spigot or a Flow. 

These fields simply report existing settings and should not be changed.
• Value Field columns - these hold user-defined values that may be changed in the 

spreadsheet.
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Thus, each worksheet row has Key Fields and Value Fields.

Device Names Work Sheet
Each row represents a Device. A Device is defined either by the device GUID or by the 
device IP address; the IP address can be either the primary (fabric A) or secondary (fabric B) 
address. If both the GUID and the IP address are present then the GUID is used to identify 
the device. 

Fig. B-3: Device Names Worksheet Example

In the Spreadsheet:
In the spreadsheet, the following fields are key value fields:

• Device Name (max 63 characters).
• Short Name (max 15 characters).
• Host Name (max 63 characters).
• Description (max 255 characters).

In the IP Configuration Tool:
In the IP Configuration tool, you can edit the following columns in the tool:

• Device Name.
• Short Name.
• Host Name.
• Description.

Key field columns Value Field columns

Each row represents a Device
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Source Ports and Destination Ports Worksheets
These two worksheets are similar. Each row represents a spigot on a device defined by the 
device GUID, or by the device IP address, or by the device name. On the device, a spigot is 
defined by a spigot number, Spigot Index.
If the GUID is present, it is used in preference to either the IP address or device name. 
If the IP address is present, it is used in preference to the device name.

Fig. B-4: Source Ports Worksheet Example

Fig. B-5: Destination Ports Worksheet Example

In the Spreadsheet:
In the spreadsheet, the following fields are key value fields:

• Port Number (integer).
• Port Name (max 63 characters).
• Short Name (max 9 characters, but 8 characters for an IPRA routing-controlled system).

In the IP Configuration Tool:
In the IP Configuration tool, you can edit the following columns in the tool:

• Port Name.
• Short Name.
• Port Number.

Each row represents a Source Spigot

Key field columns  Value field columns

Each row represents a Destination Spigot

Key field columns  Value field columns
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Source Flows and Destination Flows Worksheets
These two worksheets are similar.

Each row represents an IP flow on a device defined by the device GUID, or by the device IP 
address, or by the device name. On the device, a spigot is defined by a spigot number, 
Spigot Index.
If the GUID is present, it is used in preference to either the IP address or device name. 
If the IP address is present, it is used in preference to the device name.

Fig. B-6: Source Flows Worksheet Example

Note: Flow Index is for information only - created at Export and ignored 
during Import.

Value field columns

For information only

Key field columns

Each row represents a Source Flow
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Fig. B-7: Destination Flows Worksheet Example

In the Spreadsheet:
In the spreadsheet, the following fields are key value fields.

• Flow Enabled.
• Multicast Address.
• Source Address.
• Dst RTP Port.
• Src RTP Port.

In the IP Configuration Tool:
In the IP Configuration tool, you can edit the following columns in each tab of the tool:

• Flow Enabled.
• Multicast Group Address.
• Source IP Address.
• Dest RTP Port.
• Source RTP Port.

Value field columns

For information only

Key field columns

Each row represents a Destination Flow
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Example Spreadsheet

Fig. B-8: Device Names Worksheet

Fig. B-9: Source Ports Worksheet
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Fig. B-10: Destination Ports Worksheet

Fig. B-11: Source Flows Worksheet
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Fig. B-12: Destination Flows Worksheet
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The following Network Device Advance Control (NDAC) NP0017 commands are supported.

General commands

Device-based support
Note: We recommend to northbound control systems to use Device-base commands as 
gaps are properly supported.

The following set of NP0017 device-based commands for support of crosspoints and labels 
have been implemented in the NDAC. 

CommandId Name Handling

0x0000 300A Execute System Salvo Triggers a salvo created in GV Orbit Control by referring to it by the 
"external ID" of the salvo.

0x0000 310E Register For Data Changes Registers the client for changes to the labels within GV Orbit Control 
and notifies it with a '0x0000 310C Notify Mnemonic Change' when 
some labels are changed in GV Orbit Control.

 CommandId Name Handling

0x0000 3000 Take Source To 
Destination

Performs a crosspoint change

0x0000 3002 Lock, Protect and 
Release Device

User Id of command taken into account, when performing 
operation.
Apply LPR state on a specific input device and level, see “lock 
protect release level on device” command (0x00003002).
See also Setting a User ID for Lock, Protect, and Release with NDAC 
NP0016 / NP0017 Northbound Interfaces, on page 487.

0x0000 3004 Register for Changes to 
Device

Registers the client for changes to the port and notifies it with a 
'0x0000 300B Device Status Changed' when the crosspoint changes 
in GV Orbit Control.

0x0000 3006 Get Destination Status Returns the current crosspoint status.

0x0000 3008 Get Device LPR Status Returns the output's current lock/protect/release status.
If a user has an “external ID” value configured it is returned, 
otherwise 0 is returned.
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Details about device id and level numbers
• The Device ID fields used in the device-based commands are 1-based values. Meaning 

that Source Device ID 1 in a command matches the logical source with external id 1 in 
GV Orbit Control.

• The Virtual Level ID field used in the device-based commands are 1-based values. 
Meaning that Virtual Level ID 1 in a command matches the logical level with ID 1 (SDI) in 
GV Orbit Control.

Port-based support
GV Orbit Control supports the following set of NP0017 port-based commands in the NDAC. 

0x0000 3012 Get Mnemonics Allows client to retrieve the mnemonics for 'all devices', 'levels', 
'sources', 'destinations' and 'categories'.
Limited to 8 first characters of the “Short name” property.
Categories are not supported.

0x0000 3016 Device All Levels Take Performs a take between a source and destination on all the 
available levels.

0x0000 3017 Get Simple Device 
Status

Provides the input connected to a destination device.
Returns all levels including sub-levels of composite levels.

0x0000 3018 Get Device Levels Returns the levels associated to a device.
• Returns all levels including sub-levels of composite levels.
• Returns the levels with the right device id.

0x0000 3022 Get Extended 
Mnemonics

Returns associated device mnemonics. Only types 1,2,3 and 4 are 
handled.
No limit on name length.
This returns no category information.

0x0000 302B Get Contents For 
Category

This returns no category information.

0x8000 300B Device Output 
Changed Response

This is a response message sent back by clients after GV Orbit 
Control sends out a 0x0000 300B.
GV Orbit Control simply ignores these messages.

 CommandId Name Handling

CommandId Name Handling

0x0000 3001 Take Input To Output Performs a crosspoint change

0x0000 3003 Lock, Protect and 
Release Port

User Id of command taken into account, when performing operation. 
Apply LPR state on a specific input port and level, supports NP0017 
“lock protect release port” command (0x00003003).
See also Setting a User ID for Lock, Protect, and Release with NDAC 
NP0016 / NP0017 Northbound Interfaces, on page 487.

0x0000 3005 Register for Changes 
to Port

Registers the client for changes to the port and notifies it with a 
'0x0000 300C Physical Port Changed' when the crosspoint changes in 
GV Orbit Control.
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Details about port and level numbers
• The Input Port and Output Port fields used in the port-based commands are 0-based 

values. Meaning that Input Port 0 in a command matches the logical source with 
external id 1 in GV Orbit Control.

• The port numbers (external Id values) should be sequential in GV Orbit Control. That is, 
port-based commands do not work properly if there are gaps in the external IDs. 

• The Physical Level ID field used in the port-based commands are 1-based values. 
Meaning that Physical Level ID 1 in a command matches the logical level with ID 1 (SDI) 
in GV Orbit Control.

User ID and Lock, Protect, and Release
User ID is a concept found in some protocols such as NP0016 and NP0017. It allows a 
northbound controller to identify the user which is performing lock/protect or take 
operations. In turn GV Orbit Control, will try to match the provided user ID to one of its 
users by looking up the External Id parameter value and perform the operations internally 
using it. 

See also Setting a User ID for Lock, Protect, and Release with NDAC NP0016 / NP0017 
Northbound Interfaces, on page 487. 

NOTE: GVG NP and Probel SW-P-08 protocols do not have user ID concepts, so all their 
operations are performed as the GV Orbit Control admin user.

GV Orbit Control user external id configuration
NP0016 and NP0017 protocols provide the user ID for various operations. The user ID is 
defined as an unsigned integer value from 0 to 4294967295 but it's recommended to NOT 
use values beyond 2147483647 to avoid any conversion or any special handling of users ID 
in GV Orbit Control systems. If the recommendation cannot be applied, please contact 

0x0000 3007 Get Physical 
Crosspoint Status

Returns the current crosspoint status.

0x0000 3009 Get Physical LPR 
Status

Returns the output's current lock/protect/release status.
If a user has an “external ID” value configured it is returned, otherwise 0 
is returned.

0x0000 3014 Get Physical Level 
Dimensions

Returns the logical level ids and size for the area being controlled.

0x0000 3015 Get Mnemonic For 
Ports

Returns the first 8 characters of 'Short name' property for the requested 
input or output port.

0x0000 3025 Get Extended 
Mnemonics For Ports

Returns the full 'Short name' property for the requested input or 
output port. Not limited in length.

0x8000 300C Physical crosspoint 
status response.

This is a response message sent back by clients after GV Orbit Control 
sends out a 0x0000 300C.
GV Orbit Control simply ignores these messages.

CommandId Name Handling
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Grass Valley support for further details on how to configure those values in GV Orbit 
Control systems. See Grass Valley Technical Support, on page 862.

User IDs used by Northbound Control Systems

Troubleshooting
For troubleshooting, GV Orbit Control has GV Orbit Control audit.logs found on GV Orbit 
Admin web interface under Log Files that show the user name and its external ID, the 
northbound interface (for example, NP0017), type of commands (Device-based, Port-
based, etc.) and if the command was received from a panel. Refer to Log Files Task in the 
GV Orbit Admin Guide. See Related Documentation, on page 7. 

How to...

How to configure iControl or Kaleido to control GV Orbit Control using 
NP0017 device-id-based driver

1 Add and configure a physical router:
a Add the physical router in router manager or Xedit.
b Select the 'NVEP NV9000 - Device Takes (NP0017)' router protocol.
c Set the Connection type to: TCP/IP
d Enter the GV Orbit Control controller IP address.
e Set the TCP/IP port to 9193 + 'external id'. For example: if the area 'external id' in 

GV Orbit Control is '0' use port 9193, if area 'external id' in GV Orbit Control is '1' use 
port 9194.

f Add a physical level.
g Configure its size and enter any number in the 'Level or frame ID' field. Kaleido and 

iControl only do all 'level takes'.
The matrix size should be at least the 'amount of sources of the topology with the 
most sources' X 'amount of destinations of the topology with the most 
destinations' as shown in the GV Orbit Control Alias Editor of the area. If you intend 
to remove/add sources or destinations in GV Orbit Control you should make the 
router size bigger as 'NP0017 ID' aren't reused.

NDAC Client User ID

iControl - NP0017 device based 0
An iControl system property can 
be configured to change this.

iControl - NP0017 port based 0

iControl - NP0016 61441 (0xF001)

GV Orbit Routing service - NP0017 device based 0 or Control External Id 
parameter; see above.

Image Video - NP0017 device based 0
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2 Create a logical router:
a Set the size and add the logical level. 

The logical level can be a subset of all the physical inputs or outputs in GV Orbit 
Control. That way you can control only certain sources or destinations.

b Select the physical levels configured.
c Perform the auto-map of sources and destinations.
d Save.

3 Control GV Orbit Control using router matrix.

How to configure iTX to control GV Orbit Control using NP0017 device-id-
based driver

• Create a router in iTX and select the 'NV9000' driver.

How to configure NV9000 to control GV Orbit Control using NP0017 
device-id-based driver

• NV9000 doesn't support this mode of communication with a router controller.

How to configure iControl or Kaleido to control GV Orbit Control using 
NP0017 port-based driver

1 Add and configure a physical router:
a Add the physical router in router manager or Xedit.
b Select the 'NVEP NV9000 - Port Takes (NP0017)' router protocol.
c Set the Connection type to: TCP/IP
d Enter the GV Orbit Control controller IP address.
e Set the TCP/IP port to 9193 + 'external id'. For example: if the area 'external id' in 

GV Orbit Control is '0' use port 9193, if area 'external id' in GV Orbit Control is '1' use 
port 9194.

f Add a physical level.
g Configure its size and enter '1' in the 'Level or frame ID' field. 

The matrix size should be the total amount of source and destination 'External IDs' 
within the GV Orbit Control Alias Editor of the area.

h Add other levels as needed.
2 Create a logical router:

a Set the size and add the logical level. 
The logical level can be a subset of all the physical inputs or outputs in GV Orbit 
Control. That way you can control only certain sources or destinations.

b Select the physical levels configured.
c Perform the auto-map of sources and destinations.
d Save.

3 Control GV Orbit Control using router matrix.
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How to configure NV9000 to control GV Orbit Control using NP0017 port 
based driver

1 Configure the 'area id' in GV Orbit Control to '0'.
2 Access the SE-Utilities application.
3 Add a router:

a Go to Configuration > Routers and click the 'Add router' button.
b Enter a name for the router.
c Select 'NV Control System Ethernet' as the protocol
d Click next.
e Add a Physical Level and configure the level '#' value to match the GV Orbit Control 

logical level 'external Id' from within Area.
f Enter '0' for the 'Input Start' and 'Output Start'.

g Enter the number of GV Orbit Control inputs - 1 in 'Input End'
h Enter the number of GV Orbit Control outputs - 1 in the 'Output End'

4 Add a level set:
a Go to Configuration > Level Sets and click the 'add level set' button.
b Enter a name for the level set.
c Select a 'Virtual Level' value for 'display index' 1.
d Select a Physical level from the pull down.

5 Add devices:
a Go to Configuration > Devices and click 'Add Device' button.
b Enter a mnemonic, select a level set and optionally enter a description.
c Click the 'Next' button.
d In the 'Device Level Detail' section enter the input or output numbers used by the 

Device.
e Repeat to add more devices.

6 Apply the DB to the controller: 
a Go to System Management and select the NV9000 controller.
b Click the 'Write configuration to NV9000' button.
c Once the copying is done, click the 'Restart controller 1' button.

7 Control GV Orbit Control using SE-Utilities:
a Go to System Management > NV9000 controller > Routers and select the router 

representing GV Orbit Control. 
There is a bug in SE-Utilities when output 0 is used. It's status isn't displayed in the 
'Connections' table. If you wish to view the status of output 0, you can change the 
'Starting Output' value to 0 instead of 1, but you will loose the status of the last 
output. The 'Display Count' value cannot be higher than the last output number of 
the physical level, which is one less than the output count when using 0-based 
values.

b You can perform takes by using 0-based input and output values.
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DNorthbound Control through Sony LSM
(NS-BUS Router Matrix protocol)

GV Orbit Control system’s northbound interface has the ability to control crosspoints 
through Sony LSM (NS-BUS router matrix protocol).

With this integration, logical sources/destinations from GV Orbit Control systems, including 
those created for NMOS devices, are now available northbound to be used by Sony panels 
and commands received through NS-BUS router matrix protocol are handled.

LSM does not allow the configuration of the TCP port to which it connects to on an NS-BUS 
router device and uses 9720 by default. Because of this limitation, only one area of GV Orbit 
Control systems can be controlled. GV Orbit Control systems allow control of the area with 
the lowest external ID through the NS-BUS protocol.

When adding a GV Orbit Control system as an NS-BUS Device in the LSM configuration, the 
selected Protocol must be TCP and the Device Port Number value must be 8079. Device IP 
Address1 field should be the Virtual IP address of the GV Orbit Control system. Device IP 
Address2 field must be empty.

See Configuring a Controller Group, on page 179 for the Virtual IP address of the GV Orbit 
Control system.
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abcGlossary

Glossary of Terms
3G Proxy An ST-2110 video IP stream representing another video signal in a 

production system. The proxy has the same video and audio content as the 
signal it represents. The proxy’s video standard is ‘3G’. 

Alarm An indication that a component or device or module or unit within a facility 
is not operating at normal established parameters.

Alarm Acknowledgment An on-line, live action to notify other users that new alarms were raised in a 
facility. This is usually manually done by a user and is usually followed by 
actions to resolve cause of the alarms in question. Alarms in the system will 
flash when raised, or be in some alert state, until they are acknowledged.

Client Computer software that accesses services made available by a server. The 
server itself resides on a different piece of computer hardware. The client 
can be downloaded from the server on a local computer.

Client Domain A GVOP Domain used by the GV Orbit Client to interact with devices and 
services in a GV Orbit system.

Cluster Multiple devices grouped or merged together to increase the capacity of 
inputs, outputs, or processing power.

Clustered Multiviewer 
Project,

Clustered MV Project

A GV Orbit project type which defines one or more video walls served by a 
cluster of multiviewer devices.

Domain A group of devices on a network that are administered as a unit with 
common rules and procedures.

Dynamic Destination 
Assignment

A mode of operation of a Clustered Multiviewer project where video wall 
tiles are automatically assigned a router destination when a Room Layout 
changes, based on the needs of the currently-shown Room Layout. 
Dynamic assignment can apply to all tiles, or a sub-set of tiles on the video 
wall.

Fabric A combination of hardware and software that forms a network.

Fabric A & Fabric B Two identical network systems that form an IP media network with a 
redundant network topology.

GV Orbit Client Graphical client user application in a GV Orbit configuration, control and 
monitoring system. A user can run various projects in a client and can 
configure devices, control routing, and monitor systems. Graphical soft 
control and monitoring user panels can be designed and run. Graphical 
video walls can be designed for multiviewers.
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GV Orchestration Protocol, 
GVOP

The main messaging protocol used in GV Orbit configuration, control and 
monitoring systems. 

GVOP Domain A GV Orbit system employs GVOP Domains to segregate internal 
communications. The various GV Orbit services, system devices, and GV 
Orbit Client applications all communicate with one another; 
communications may be segregated by using GVOP Domains.

GVOP Domain ID A GV Orbit system employs GVOP Domains specified with a Domain ID 
number (1 to 252).

Head,
Head Display Output,
Multiviewer Output

A multiviewer output to be shown on a monitor display. The MV-821-IP 
multiviewer has up to 12 Head Display Outputs and offers these as signals 
on rear physical connectors and as full ST-2110 video IP streams.

Home Page First page (also known as ‘current home’ or ‘default home’) that is displayed 
by default when a site is opened, or by clicking a dedicated home button, 
in a site or panel. This page is usually set by you at configuration time.

Log Server Domain A GV Orbit Domain used by the Log Server Service to collect RollCall-
protocol device logging data.

Log Server Service A GV Orbit service which collects and collates logging information from 
RollCall-protocol devices for the GV Orbit system. The service typically 
provides logging data to the GV Orbit Monitoring Service.

MapView A control and monitoring GV Orbit project (C&M project) that contains 
custom screens to enable you to control and monitor a system. 

Media IP Network A high-capacity network dedicated to carrying high bit rate media.

Monitor Layout The grid of tiles on a monitor of a video wall and the tiles populated on the 
grid. This refers to video walls designed with the Room Editor tool in GV 
Orbit Client. 
‘Monitor Layout’ is analogous to ‘Wall Layout’ for video walls designed with 
the Wall Editor tool.

Monitor Wall, 
Video Wall

One or more monitor display screens arranged and configured to form one 
larger screen area.

Multiviewer A device that consolidates multiple video sources onto one or more head 
display outputs for ultimate display on monitor screens.

Multiviewer Input A video source routed into a multiviewer.

Multiviewer Output A multiviewer head display output. See ‘Head’.

Multiviewer Cluster,
MV Cluster

A cluster of multiviewer devices configured together and all acting 
together to serve one or more video walls. A cluster contains one or more 
MV-8 Series multiviewer devices.

MV Cluster Manager Service A GV Orbit service which enables a user to configure a cluster of MV-8 series 
multiviewers as a single multiviewing system, rather than as separate, 
individual multiviewer devices.

MV-8 Series Multiviewer A Grass Valley multiviewer series which includes router-integrated devices 
(for example, MV-831) and stand-alone devices (for example, MV-821-IP IP 
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multiviewer). All MV-8 Series multiviewers share the same core multiviewer 
functionality.

Network Map A tree view representation of system devices and services.

Network View A window that displays a network map. Various device operations can be 
carried out from this view, such as opening device configuration screens 
and device alarm history views.

NP0017 An established Grass Valley dedicated router control protocol. 

PiP ‘Picture-in-Picture’ and another word for a multiviewer video wall Tile.

Overall Alarm A type of virtual alarm that indicates the overall condition of a device or 
service. It is based on the combined state of constituent alarms and is often 
generated automatically by a monitoring system.

Relay Service A GV Orbit service which passes selected GVOP data between two GVOP 
Domains. For example, to an MV-821 multiviewer Domain.

Room A video wall comprising one or more monitors - for example, in a 
production room of a broadcast facility or OB truck. A Room is served by a 
cluster of multiviewers. A ‘Room’ is designed in the ‘Room Editor’ tool.

Room file,
.room file

A data file used by a GV Orbit Clustered MV project and which contains the 
definition of a Room video wall. This cannot be edited outside of GV Orbit 
Client. The Room file is usually referred to as the Room.

Room Design A design for a Room, a video wall, including monitor arrangement, tile 
layouts, source and destination assignments. A ‘Room Design’ is stored in 
a ‘Room File’ in a ‘Clustered MV’ project.

Room Editor An editing facility in GV Orbit Client enabling a video wall to be designed 
and edited in a GV Orbit Clustered MV project. 

Room Layout The grid of tiles on an entire video wall and the tiles populated on the grid. 
This refers to video walls designed with the Room Editor tool in GV orbit 
Client. 

Routing Domain A GVOP Domain used by the ‘Routing Service’ for routing control messages 
in a GV Orbit system.

Routing Service A GV Orbit service which provides a translation between dedicated routing 
protocols and the GV Orbit router controller for GV Orbit clients and other 
services. The service enables the state of all routes and routing levels to be 
saved as a snapshot. The service allows routes to be made from the GV Orbit 
Client and source and destination names to be known by GV Orbit Client.

Scaler An image re-sizing ‘engine’. Several are found within a multiviewer. For 
example, the MV-8 Series of multiviewers contains 48 ‘Scalers’, one per 
multiviewer input.

Spigot A logical connector on an IP media network. A spigot which sources 
(originates, transmits) an IP stream is a source spigot. One which receives an 
IP stream is a destination spigot.

Stream A flow of data, video, audio or metadata which arrives at or leaves a device 
through one of its ports.



860

Glossary

Tally A ‘Tally’ refers to a state of a production system. For example: “On Air”, “Iso”, 
or “Preview”.

Tally Routing The identity or label of the actual source that is routed to a destination 
(routed source).

Tile, 
PiP

(Multiviewer video wall context:) 
A rectangular area on a video wall screen, usually displaying video inputs 
and other supporting information. 
For example, a tile (or PiP) may display a video picture with audio bars and 
other related label and status information, including Tally information. 
Other information may be displayed in tiles. For example: time; images; or 
text.

Tile Grid The arrangement of tiles on a monitor of a video wall. A tile grid specifies 
the position of tiles. A tile grid is then populated with tiles of the required 
type/ configuration. The default is a video tile.

Topology The logical or physical arrangement of the various devices within a 
broadcast facility.

Video Wall, 
Monitor Wall

One or more monitor display screens arranged and configured to form one 
larger screen area.

Wall, A ‘Wall’ is the name given to a monitor wall that has been designed in the 
Wall Editor tool of GV Orbit Client (or Orbit Client). ‘

Wall Editor An editing facility in GV Orbit Client (and in Orbit Client) enabling a video 
wall to be designed and edited in a GV Orbit multiviewer project. The video 
wall is served by a single multiviewer.

Wall Layout The grid of tiles on a monitor of a video wall and the tiles populated on the 
grid. Typically, this refers to video walls designed with the Wall Editor tool.

Widget A graphical element that displays information or let a user interact with 
various tasks of a control system.
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@Contact Us

Grass Valley Technical Support
For technical assistance, contact our international support center, at
1-800-547-8949 (US and Canada) or +1 530 478 4148.

To obtain a local phone number for the support center nearest you, please consult the 
Contact Us section of Grass Valley’s website (www.grassvalley.com).

An on-line form for e-mail contact is also available from the website.

Corporate Head Office
Grass Valley
3499 Douglas-B.-Floreani
St-Laurent, Quebec H4S 2C6
Canada
Telephone: +1 514 333 1772
Fax: +1 514 333 9828
www.grassvalley.com

www.grassvalley.com
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